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API 文档

API概览
最近更新时间：2023-08-14 11:59:58

腾讯云数据万象服务（CI）API接口及说明如下：

开通服务

接口名称 说明

绑定数据万象服务
用于开通数据万象服务，需要绑定对象存储（Cloud Object Storage，

COS）上已有的存储桶。

查询数据万象服务 用于查询该 Bucket 是否已开通数据万象服务。

解绑数据万象服务
解绑开通数据万象服务的 Bucket（Bucket 及桶中文件会保留在对象存

储（Cloud Object Storage，COS））。

注意：

调用接口为存储桶开通数据万象，并未进行角色授权，可能会影响部分功能使用，如您首次开通数据万象，

建议您通过控制台进行操作，并完成角色授权，点击登录 数据万象控制台 。

存储桶配置

接口名称 说明

查询防盗链 用于查询 Bucket 中防盗链详情（黑白名单）。

设置防盗链 用于对存储桶添加防盗链（设置黑白名单）。

开通原图保护 对 Bucket 开通原图保护功能。

查询原图保护状态 用于查询原图保护功能是否开启。

关闭原图保护 用于关闭原图保护功能。

提交病毒检测任务
云查毒功能为异步请求方式，您可以通过本接口对云上的文件进行文件病毒

（例如木马病毒、蠕虫病毒等）检测。

查询病毒检测任务结果 用于查询一个病毒检测任务的状态或结果。

https://cloud.tencent.com/document/product/460/30108
https://cloud.tencent.com/document/product/460/30109
https://cloud.tencent.com/document/product/460/30110
https://console.cloud.tencent.com/ci
https://cloud.tencent.com/document/product/460/30115
https://cloud.tencent.com/document/product/460/30116
https://cloud.tencent.com/document/product/460/30121
https://cloud.tencent.com/document/product/460/30120
https://cloud.tencent.com/document/product/460/30122
https://cloud.tencent.com/document/product/460/63964
https://cloud.tencent.com/document/product/460/63965
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数据万象CI提供了一套便捷的 图片处理机制 ，通过这套机制可以对存储在对象存储 COS 中的图片进行一系列的图

片处理操作。

图片处理

功能分类 接口名称 说明

图片基础处理

 图片样式  
将基础图片处理操作设置为样式，用户可直接使用样式参数快

速对图片进行处理。

 基础图片处理  对图片进行裁剪、缩放、水印、获取信息等基础处理。

 图片基础压缩

（WebP）  
将图片转换为 webp 压缩图片格式。

 合成动图  将多张 jpg 或 png 格式的图片合成为一个 GIF 动图。

 获取原图  获取某些场景下的原图。

 图片明水印  为图片添加水印，支持添加 图片水印  与 文字水印  两种方式。

 图片高级压缩  将图片转换为 TPG 、AVIF、 HEIF 等高压缩比格式。

 图片Guetzli压缩  对 JPG 图片进行 Guetzli 画质无损压缩。

 图片盲水印  将水印以不可见的形式添加到图片中。

 异常图片检测  检测图片中是否隐含其他类型的可疑文件。

 海报合成任务  使用模板批量生成多类型成品海报。

 图片异步处理  提交与查询图片异步处理任务，并支持创建与更新模板。

异步服务队列配置
 查询队列  搜索图片处理队列。

 更新队列  更新图片处理队列。

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/53508
https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/60524
https://cloud.tencent.com/document/product/460/94310
https://cloud.tencent.com/document/product/460/90744
https://cloud.tencent.com/document/product/460/94572
https://cloud.tencent.com/document/product/460/6930
https://cloud.tencent.com/document/product/460/6951
https://cloud.tencent.com/document/product/460/53509
https://cloud.tencent.com/document/product/460/30093
https://cloud.tencent.com/document/product/460/19017
https://cloud.tencent.com/document/product/460/75997
https://cloud.tencent.com/document/product/460/82351
https://cloud.tencent.com/document/product/460/94573
https://cloud.tencent.com/document/product/460/79395
https://cloud.tencent.com/document/product/460/79396
https://cloud.tencent.com/document/product/460/76835
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数据万象提供了一套完善便捷的 媒体处理机制 ，通过这套机制可以对存储在对象存储 COS 中的媒体对象进行各类

型处理操作。

媒体处理

功能分类 接口名称 说明

服务配置

绑定媒体处理服务 授权媒体处理服务角色访问存储桶。

查询媒体处理服务 查询已经开通媒体处理功能的存储桶。

解绑媒体处理服务 关闭媒体处理服务并删除队列。

搜索媒体处理队列 搜索媒体处理队列。

更新媒体处理队列 更新媒体处理队列

同步服务

获取媒体信息 获取媒体文件的信息

获取媒体截图 获取媒体文件某个时间的截图

 读取私有 M3U8  用于获取私有 M3U8 ts 资源的下载授权。

异步服务 获取媒体信息 提交一个获取媒体信息任务，查看回调信息。

音视频转码
提交一个音视频转码任务，查看回调信息；并支持创建与更

新模板。

极速高清转码
提交一个极速高清转码任务，查看回调信息；并支持创建与

更新模板。

音视频转封装（音视频

分段）

提交一个音视频转封装任务，此任务支持分段，查看回调信

息。

音视频流分离 提交一个音视频流分离任务，查看回调信息。

音视频拼接
提交一个音视频拼接任务，查看回调信息；并支持创建与更

新模板。

精彩集锦
提交一个精彩集锦任务，查看回调信息；并支持创建与更新

模板。

视频截图
提交一个视频截图任务，查看回调信息；并支持创建与更新

模板。

画质增强
提交一个画质增强任务，查看回调信息；并支持创建与更新

模板。

视频明水印 提交一个视频明水印任务，查看回调信息；并支持创建与更

https://cloud.tencent.com/document/product/460/91669
https://cloud.tencent.com/document/product/460/72823
https://cloud.tencent.com/document/product/460/38914
https://cloud.tencent.com/document/product/460/79399
https://cloud.tencent.com/document/product/460/38913
https://cloud.tencent.com/document/product/460/42324
https://cloud.tencent.com/document/product/460/49284
https://cloud.tencent.com/document/product/460/38910
https://cloud.tencent.com/document/product/460/63738
https://cloud.tencent.com/document/product/460/94574
https://cloud.tencent.com/document/product/460/94575
https://cloud.tencent.com/document/product/460/94576
https://cloud.tencent.com/document/product/460/94577
https://cloud.tencent.com/document/product/460/94578
https://cloud.tencent.com/document/product/460/94580
https://cloud.tencent.com/document/product/460/94582
https://cloud.tencent.com/document/product/460/94583
https://cloud.tencent.com/document/product/460/94584
https://cloud.tencent.com/document/product/460/94586
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新模板。

视频标签 提交一个视频标签任务，查看回调信息。

视频质量评分 提交一个视频质量评分任务，查看回调信息。

视频转动图
提交一个视频转动图任务，查看回调信息；并支持创建与更

新模板。

数字水印 提交一个数字水印任务，查看回调信息。

提取数字水印 提交一个提取数字水印任务，查看回调信息。

视频拆条 提交一个视频拆条任务，查看回调信息。

智能封面
提交一个智能封面任务，查看回调信息；并支持创建与更新

模板。

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

内容审核

功能分类 说明

图片审核 图片审核功能支持同步、异步请求方式。

视频审核 视频审核功能为异步任务方式。

音频审核 音频审核功能为异步任务方式。

文本审核 文本文件审核为异步请求方式，文本内容审核为同步请求。

文档审核 文档审核功能为异步任务方式。

网页审核 网页审核功能为异步任务方式。

直播审核 直播流审核功能为异步任务方式。

内容识别

https://cloud.tencent.com/document/product/460/94587
https://cloud.tencent.com/document/product/460/94588
https://cloud.tencent.com/document/product/460/94589
https://cloud.tencent.com/document/product/460/94590
https://cloud.tencent.com/document/product/460/94591
https://cloud.tencent.com/document/product/460/94592
https://cloud.tencent.com/document/product/460/94593
https://cloud.tencent.com/document/product/460/76835
https://cloud.tencent.com/document/product/460/62382
https://cloud.tencent.com/document/product/460/47362
https://cloud.tencent.com/document/product/460/53395
https://cloud.tencent.com/document/product/460/56283
https://cloud.tencent.com/document/product/460/59379
https://cloud.tencent.com/document/product/460/63966
https://cloud.tencent.com/document/product/460/76258
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功能分类 接口名称 说明

服务配置 

 开通 AI 内容识别  开通 AI 内容识别服务并生成队列。

 查询 AI 内容识别  查询 AI 内容识别服务状态。

 查询队列  搜索 AI 内容识别队列。

 更新队列  更新 AI 内容识别队列。

同步服务  图片上色  对黑白图像进行上色。

 图像超分  对图像进行超分辨率处理，当前默认超分为宽高的2倍。

 图像增强  对图像进行增强处理。

 图像智能裁剪  对图像进行智能裁剪，支持持久化、云上处理及下载时处理。

 实时文字翻译  对文字块进行翻译。

 图像修复  检测并擦除图片中常见的标志,并对擦除部分进行智能修复。

  Logo识别  

对图片内电商 Logo 的识别，返回图片中 Logo 的名称、坐

标、置信度分值。返回图片中Logo的名称、坐标、置信度分

值。

 二维码识别  
识别图片中有效二维码的位置及内容，输出图像中二维码包含的

文本信息，并可对识别出的二维码添加马赛克。

 二维码生成  
根据用户指定的文本信息（URL 或文本），生成对应的二维码

或条形码。

 图片标签  
实现对 COS 存量数据的图片标签识别，返回图片中置信度较高

的主题标签。

 游戏场景识别  
实现游戏图片场景的识别，返回图片中置信度较高的游戏类别标

签。

 图片质量评分  
对图片文件进行检测，从多方面评估，最终给出综合可观的清晰

度评分和主观的美观度评分。

 人脸检测  检测图片中的人脸位置。

 人脸特效  提供人脸美颜、人像变换、人像分割功能。

 人体识别  识别并输出画面中人体，输出其位置（矩形框）和置信度。

 身份证识别  支持中国大陆居民二代身份证正反面所有字段的识别。

https://cloud.tencent.com/document/product/460/79593
https://cloud.tencent.com/document/product/460/79594
https://cloud.tencent.com/document/product/460/79394
https://cloud.tencent.com/document/product/460/79397
https://cloud.tencent.com/document/product/460/83794
https://cloud.tencent.com/document/product/460/83793
https://cloud.tencent.com/document/product/460/83792
https://cloud.tencent.com/document/product/460/83791
https://cloud.tencent.com/document/product/460/83547
https://cloud.tencent.com/document/product/460/79042
https://cloud.tencent.com/document/product/460/79736
https://cloud.tencent.com/document/product/460/37513
https://cloud.tencent.com/document/product/460/53491
https://cloud.tencent.com/document/product/460/39082
https://cloud.tencent.com/document/product/460/93153
https://cloud.tencent.com/document/product/460/63228
https://cloud.tencent.com/document/product/460/63223
https://cloud.tencent.com/document/product/460/47197
https://cloud.tencent.com/document/product/460/83196
https://cloud.tencent.com/document/product/460/48638
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 活体人脸核身  对录制的自拍视频进行活体检测，从而确认当前用户为真人。检

测为真人后，再判断该视频中的人与权威库的证件照是否属于同

一个人，实现用户身份信息核实。

 车辆车牌识别  
检测图片中的车辆，识别出车辆的品牌、颜色、位置、车牌位置

等信息。

 通用文字识别  将图片上的文字内容，智能识别为可编辑的文本。

 商品抠图  检测图片中的商品信息，生成只包含商品信息的图片。

 以图搜图  需开通以图搜图服务，通过添加图片，对图片进行搜索。

异步服务

 内容翻译  提交一个内容翻译任务，查看回调信息。

 词性分析  提交一个词性分析任务，查看回调信息。

 视频目标检测  
提交一个视频目标检测任务，查看回调信息；并支持创建与更新

模板。

 视频人像分割  提交一个视频人像分割任务，查看回调信息。

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

文档处理

功能分类 接口名称 说明

服务配置

 查询文档预览开通状

态  
用于查询已经开通文档预览功能的 Bucket。

 查询队列  用于查询文档转码队列。

 更新队列  用于更新文档转码队列

文档转码
 文档转码同步请求  

同步接口适用于百页内的PDF文件或预览少数页的情况，若文

件较大建议使用异步接口。

文档转码异步任务 提交、查询文档转码任务

文档转 

HTML

 文档转html同步请

求  

数据万象封装预览 JS SDK，只需要一条 URL 即可接入 

HTML 预览服务。

https://cloud.tencent.com/document/product/460/48641
https://cloud.tencent.com/document/product/460/63225
https://cloud.tencent.com/document/product/460/63227
https://cloud.tencent.com/document/product/460/79735
https://cloud.tencent.com/document/product/460/63898
https://cloud.tencent.com/document/product/460/94611
https://cloud.tencent.com/document/product/460/94612
https://cloud.tencent.com/document/product/460/94613
https://cloud.tencent.com/document/product/460/94614
https://cloud.tencent.com/document/product/460/76835
https://cloud.tencent.com/document/product/460/46945
https://cloud.tencent.com/document/product/460/46946
https://cloud.tencent.com/document/product/460/46947
https://cloud.tencent.com/document/product/460/47074
https://cloud.tencent.com/document/product/460/52518
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 文档转html高级用

法  

JS-SDK 提供了高级功能可直接对文档进行操作。

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

文件处理

功能分类 接口名称 说明

服务配置 

 开通文件处理服务  于开通文件处理服务。

 更新队列  用于更新文件处理的队列

 查询队列  用于搜索文件处理队列。

文件哈希值计

算 

 哈希值计算同步请

求  

以同步请求的方式进行文件哈希值计算，实时返回计算得到的哈

希值。

 提交哈希值计算任

务  

以提交任务的方式进行文件哈希值计算，异步返回计算得到的哈

希值。

文件解压      提交文件解压任务  
以提交任务的方式进行文件解压缩，异步返回压缩包内被解压出

来的文件。

压缩包预览
 压缩包预览同步请

求  

不解压文件的情况下预览压缩包内的内容，包含文件数量、名

称、文件时间等

 多文件打包压

缩  

 提交多文件打包压

缩任务  

将您的多个文件，打包为 zip 等压缩包格式，以提交任务的方式

进行多文件打包压缩，异步返回打包后的文件

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

智能语音

功能分类 接口名称 说明

https://cloud.tencent.com/document/product/460/59410
https://cloud.tencent.com/document/product/460/76835
https://cloud.tencent.com/document/product/460/86377
https://cloud.tencent.com/document/product/460/86420
https://cloud.tencent.com/document/product/460/86421
https://cloud.tencent.com/document/product/460/83084
https://cloud.tencent.com/document/product/460/83085
https://cloud.tencent.com/document/product/460/83794
https://cloud.tencent.com/document/product/460/93030
https://cloud.tencent.com/document/product/460/83091
https://cloud.tencent.com/document/product/460/76835
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工作流是指通过配置多个单任务操作组合对指定的上传文件进行自动化处理的过程。

批量任务处理是对指定的存量文件进行单任务处理或按照工作流中配置的操作自动化处理。

服务配置 查询语音识别开通

状态

用于查询存储桶是否已开通语音识别功能。

查询队列 用于查询语音识别队列。

更新队列 用于更新语音识别队列

音频降噪
 提交任务  以提交任务的方式进行音频降噪处理。

创建模板 创建音频降噪模板。

 人声分离
 提交任务  以提交任务的方式进行人声分类处理。

创建模板 创建音频降噪模板。

语音合成
 提交任务  以提交任务的方式进行语音合成处理。

创建模板 创建音频降噪模板。

 语音识别
 提交任务  以提交任务的方式进行语音识别处理。

创建模板 创建音频降噪模板。

听歌识曲 提交任务 以提交任务的方式进行听歌识曲处理。

注意：

异步服务均支持取消任务、删除模板、查询模板与批量任务；相关接口所有功能通用，具体请查看 任务与

工作流  。

任务与工作流

工作流接口

批量任务处理接口

功能分类 接口名称

工作流  创建工作流  

 查询工作流  

https://cloud.tencent.com/document/product/460/46232
https://cloud.tencent.com/document/product/460/46234
https://cloud.tencent.com/document/product/460/46235
https://cloud.tencent.com/document/product/460/76905
https://cloud.tencent.com/document/product/460/94315
https://cloud.tencent.com/document/product/460/76918
https://cloud.tencent.com/document/product/460/84500
https://cloud.tencent.com/document/product/460/84797
https://cloud.tencent.com/document/product/460/84499
https://cloud.tencent.com/document/product/460/78951
https://cloud.tencent.com/document/product/460/84498
https://cloud.tencent.com/document/product/460/84795
https://cloud.tencent.com/document/product/460/76835
https://cloud.tencent.com/document/product/460/76856
https://cloud.tencent.com/document/product/460/76857


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第21 共1950页

 删除工作流  

 更新工作流  

 测试工作流  

 工作流回调  

工作流实例
 获取工作流实例详情  

 获取工作流实例详情列表  

任务设置

 取消任务  

 提交多任务处理  

 查询指定任务  

 获取符合条件的任务列表  

模板设置
 删除模板  

 查询模板  

批量拉取任务

 触发任务（独立节点）  

 触发任务（工作流）  

 取消任务  

 查询任务  

 批量拉取任务  

说明：

创建任务、任务回调信息、创建模板、更新模板：各功能接口不同，请查看对应功能相关信息。

https://cloud.tencent.com/document/product/460/76860
https://cloud.tencent.com/document/product/460/76861
https://cloud.tencent.com/document/product/460/76864
https://cloud.tencent.com/document/product/460/80039
https://cloud.tencent.com/document/product/460/80044
https://cloud.tencent.com/document/product/460/80050
https://cloud.tencent.com/document/product/460/84803
https://cloud.tencent.com/document/product/460/84764
https://cloud.tencent.com/document/product/460/84765
https://cloud.tencent.com/document/product/460/84766
https://cloud.tencent.com/document/product/460/84738
https://cloud.tencent.com/document/product/460/84739
https://cloud.tencent.com/document/product/460/80155
https://cloud.tencent.com/document/product/460/76887
https://cloud.tencent.com/document/product/460/76892
https://cloud.tencent.com/document/product/460/76893
https://cloud.tencent.com/document/product/460/76894
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开通服务

绑定数据万象服务
最近更新时间：2023-06-07 17:07:09

用于开通数据万象服务，需要绑定对象存储（Cloud Object Storage，COS）上已有的存储桶。

开通后可使用数据万象基础图片处理接口、内容识别同步接口与内容审核接口，如使用其他能力，需进行单独绑定。

存储桶的其他功能如查询、修改等，请使用 COS 的 API 接口。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应的响应体为空。

功能描述

请求

请求示例

PUT / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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查询数据万象服务
最近更新时间：2023-06-07 17:07:16

用于查询该 Bucket 是否已开通数据万象服务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

节点信息如下：

功能描述

请求

请求示例

GET / HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<CIStatus>on</CIStatus>

节点名称（关键字） 描述

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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CIStatus on 与 off 两种状态
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解绑数据万象服务
最近更新时间：2023-06-07 17:07:21

解绑开通数据万象服务的 Bucket（Bucket 及桶中文件会保留在对象存储（Cloud Object Storage，

COS））。

当前接口仅支持解绑数据万象图片处理服务、内容识别同步服务与内容审核服务，其余能力解绑需单独处理。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应的响应体为空。

功能描述

请求

请求示例

PUT /?unbind HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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存储桶配置

查询防盗链
最近更新时间：2023-06-07 17:07:38

用于查询 Bucket 中防盗链详情（黑白名单）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

具体内容包括防盗链的种类并枚举所有地址 A。

功能描述

请求

请求示例

GET /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<Hotlink>

    <Status>on</Status>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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    <Type>white</Type>

    <Url>xxx</Url>

    <Url>xxx</Url>

</Hotlink>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第28 共1950页

设置防盗链
最近更新时间：2023-06-07 17:07:33

用于对存储桶添加防盗链（设置黑白名单）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体具体节点内容为：

具体内容描述如下：

功能描述

请求

请求示例

PUT /?hotlink HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Hotlink>

        <Url>xxxxx</Url>

        <Type>black</Type>

</Hotlink>>

名

称

父节

点
描述 类型

是否必

选

Url
Hotli

nk
域名地址

Contain

er
是

Ty Hotli 防盗链类型，white 为白名单，black 为黑名单，off 为关 String 是

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为空。

pe nk 闭

响应

响应头

响应体

实际案例

请求

PUT /?hotlink HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Wed, 18 Mar 2000 06:57:54 GMT

Authorization: XXXXXXXXXXXX

<Hotlink>

        <Url>www.example.com</Url>

        <Type>black</Type>

</Hotlink>

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Fri, 25 Feb 2017 04:10:22 GMT

Server: tencent-ci

x-cos-request-id: NTg3ZjFjMmJfOWIxZjRlXzZmNDhf****

https://cloud.tencent.com/document/product/460/42866
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开通原图保护
最近更新时间：2023-06-07 17:07:46

对 Bucket 开通原图保护功能。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应的响应体为空。

功能描述

请求

请求示例

PUT /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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查询原图保护状态
最近更新时间：2023-06-07 17:07:52

用于查询原图保护功能是否开启。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<OriginProtectStatus>on</OriginProtectStatus>

节点名称（关键字） 描述

OriginProtectStatus on 与 off 两种状态。

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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关闭原图保护
最近更新时间：2023-06-07 17:07:58

用于关闭原图保护功能。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应的响应体为空。

功能描述

请求

请求语法

DELETE /?origin-protect HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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云查毒接口

提交病毒检测任务
最近更新时间：2023-06-20 15:21:02

云查毒功能为异步请求方式，您可以通过本接口对云上的文件进行文件病毒（例如木马病毒、蠕虫病毒等）检测，然

后通过查询病毒检测结果接口，查询病毒检测的结果。

功能描述

费用说明

如果文件属于 COS 上的低频存储类型，调用检测会产生 COS 低频数据取回费用 。

不支持检测 COS 上的归档存储类型和深度归档存储类型的文件，此类型文件请先 恢复归档文件 。

限制说明

文件大小支持：文件 < 1GB。

文件支持格式：EXE、DLL、SCR、SYS、MSI、SWF、JAR、APPLETJAR、JS、VBS、HTML、

BAT、WSF、PS1、HTM、MHT、HTA、CHM、LNK、DOC、DOCX、DOCX、DOTX、DOCM、

DOTM、XLS、XLSX、XLSM、XLSB、XLTM、 XLTX、XLAM、PPT、PPTX、POTX、

PPSX、PPTM、POTM、PPSM、XML、RTF、PDF、ELF、 XML、MAC、VBE、3DMAX、ISO、

CPIO、RPM、XZ、DEB。

支持检测压缩文件，例如：zip、7z、rar4、rar5、inno、cab、autoit、nsis、gz、tar、iso、mime、

chm、jar、dmg、apk 等。

请求

请求示例

POST /virus/detect HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <Url></Url>

  </Input>

  <Conf>

    <DetectType>Virus</DetectType>

    <Callback></Callback>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 病毒检测的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要检测的文件信息。 Container 是

Conf Request 检测规则配置。 Container 是

节点

名称

（关

键

字）

父节点 描述
类

型

是

否

必

选

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Conf 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Obje

ct

Reque

st.Inpu

t

存储在 COS 存储桶中的病毒文件名称，例如在目录 test 中的文件 

virus.doc，则文件名称为 test/virus.doc。

注意：Object 和 Url 只能选择其中一种。

St

ri

n

g

是

Url

Reque

st.Inpu

t

病毒文件的链接地址，例如：

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/virus.doc

。

注意：Object 和 Url 只能选择其中一种。

St

ri

n

g

否

节点名称（关

键字）
父节点 描述

类

型

是

否

必

选

DetectTyp

e

Request.

Conf
检测的病毒类型，当前固定为：Virus。

Str

ing
是

Callback
Request.

Conf

检测结果回调通知到您设置的地址，支持以 http://  或

者 https://  开头的地址，例如：

http://www.callback.com 。

Str

ing
否

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

  </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 病毒检测返回的具体响应内容。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 病毒检测任务的详细信息。 Container

节点名称

（关键

字）

父节点 描述
类

型

JobId
Response.Job

sDetail
本次病毒检测任务的 ID。

Str

ing

State
Response.Job

sDetail

病毒检测任务的状态，值为 Submitted（已提交检测）、

Success（检测成功）、Failed（检测失败）、Auditing

（检测中）其中一个。

Str

ing

Creatio

nTime

Response.Job

sDetail
病毒检测任务的创建时间。

Str

ing

错误码

实际案例

请求

POST /virus/detect HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Object>a.doc</Object>

  </Input>

  <Conf>

    <DetectType>Virus</DetectType>

https://cloud.tencent.com/document/product/460/42867
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    <Callback>http://callback.com/</Callback>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>ssb1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-07-07T12:12:12+0800</CreationTime>

  </JobsDetail>

</Response>
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查询病毒检测任务结果
最近更新时间：2023-06-20 17:32:16

本接口用于查询一个病毒检测任务的状态或结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /virus/detect/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

  <JobsDetail>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

    <Code></Code>

    <Message></Message>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <Suggestion></Suggestion>

    <DetectDetail>

      <Result>  

        <FileName></FileName>

        <VirusName></VirusName>

      </Result>

      <Result>  

        <FileName></FileName>

        <VirusName></VirusName>

      </Result>

    </DetectDetail>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 病毒检测任务结果。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 病毒检测任务的详细信息。 Container

节点名称

（关键

字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义。 String

Messag

e

Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义。 String

JobId Response.J 本次病毒检测任务的 ID。 String
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Container 节点 DetectDetail 的内容：

Array 节点 Result 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

obsDetail

State
Response.J

obsDetail

病毒检测任务的状态，值为 Submitted（已提交检

测）、Success（检测成功）、Failed（检测失败）、

Auditing（检测中）其中一个。

String

Creatio

nTime

Response.J

obsDetail
病毒检测任务的创建时间。 String

Object
Response.J

obsDetail

检测的文件为存储在 COS 中的文件时，该字段表示本次

检测的文件名称。
String

Url
Response.J

obsDetail

检测的文件为一条文件链接时，该字段表示本次检测的文

件链接。
String

Sugges

tion

Response.J

obsDetail

该字段表示本次判定的检测结果，您可以根据该结果，进

行后续的操作；建议您按照业务所需，对不同的检测结果

进行相应处理。有效值：nomal（检测正常），block 

（检测到文件含有病毒）。

String

DetectD

etail

Response.J

obsDetail
本次检测的详细信息。

Contain

er Array

节点名称（关键

字）
父节点 描述

类

型

Result
Response.JobsDetail.Det

ectDetail

单个文件的检测结果，可能有多个结

果。

Arr

ay

节点名称

（关键字）
父节点 描述 类型

FileName
Response.JobsDetail.De

tectDetail.Result

检测的文件名称，如果是压缩文件，该字段表

示解压后内部的具体文件名。

Stri

ng

VirusNam

e

Response.JobsDetail.De

tectDetail.Result
检测到的病毒名称。

Stri

ng

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第42 共1950页

请求

GET /virus/detect/ssb1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <JobId>ss364c726b370211ec8fb35254008618d9</JobId>

    <State>Success</State>

    <CreationTime>2021-07-07T12:12:12+0800</CreationTime>

    <Object>a.doc</Object>

    <Suggestion>block</Suggestion>

    <DetectDetail>

      <Result>

        <FileName>xxx</FileName>

        <VirusName>Bk.YDWebShell.Php.Small.11100752</VirusName>

      </Result>

      <Result>

      <FileName>xxx</FileName>

        <VirusName>Bk.YDWebShell.Php.Small.11100752</VirusName>

      </Result>

      </DetectDetail>  

  </JobsDetail>

</Response>
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图片处理

图片处理机制介绍
最近更新时间：2023-06-14 11:50:30

数据万象提供了一套便捷的图片处理机制，通过这套机制可以对存储在对象存储 COS 中的图片进行一系列的图片

处理操作。

图片处理机制分为以下三种方式：

您可以通过在图片的 URL 后加上 图片处理参数 ，实现访问图片的时候同步获取到处理后的图片。

简介

方式 类别 说明

下载

时处

理

同步

处理
在图片的 URL 后加上 图片处理参数  

上传

时处

理

持久

化处

理

上传图片时，在请求包头部中加入 Pic-Operations 项并设置好相应的 图片处理参数  

云上

数据

处理

持久

化处

理

针对 COS 上已经存在的图片进行处理，处理方式与上传时处理类似，在请求包头部中

加入 Pic-Operations 项并设置好相应的 图片处理参数  

下载时处理

请求语法

GET /<ObjectKey>?<图片处理参数> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

示例

请求

GET /filename.jpg?imageMogr2/format/png HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/6924
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上传时处理功能可以帮助使用者在上传时实现图片处理。您只需要在请求包头部中加入 Pic-Operations 项并设置

好相应的 图片处理参数 ，就可在图片上传时实现相应的图片处理，并可将原图和处理结果存入到 COS。目前支持

32M以内的图片处理。

图片上传的请求包与 COS V5 简单上传文件接口一致，只在请求包头部增加图片处理参数。

Pic-Operations 为 json 格式的字符串，具体参数如下：

Authorization:XXXXXXXXXXXX

返回

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 565

Date: Fri, 10 Apr 2020 09:35:16 GMT

Last-Modified: Fri, 10 Apr 2020 09:35:05 GMT

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

上传时处理

请求语法

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

COS 简单上传文件接口，请参见 COS PUT Object  文档。

Authorization: Auth String（详情请参见 请求签名  文档）。

持久化处理的 QPS 限制为100，如您有更高需求请 联系我们 。

请求内容

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/37708
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 rules（json 数组）中每一项具体参数如下：

响应包体具体数据内容如下：

 UploadResult 节点内容：

 OriginalInfo 节点内容：

rules Arr

ay

否 处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数

名称
类型

是否

必选
描述

buck

et

Stri

ng
否

存储结果的目标存储桶名称，格式为 BucketName-APPID，如果不指

定的话默认保存到当前存储桶

fileid
Stri

ng
是

处理后文件的保存路径及名称。

当 fileid  与 ObjectKey  相同时，处理后的文件将覆盖原文件存储；不相

同时将分别存储原文件和处理后文件。名称规则说明：

1. 名称需要经过 URL 安全的 Base64 编码  

2. 以 /  开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 

p2 文件夹中存储了一个文件名为 test2.jpg 的文件

3. 不以 /  开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文

件名为 test2.jpg 的文件

4. 注意：请不要以 / 结尾，否则会产生空文件名

rule
Stri

ng
是

图片处理参数 ，若按指定样式处理，则以 style/  开头，后加样式名，如样

式名为 test ，则 rule 字段为 style/test

返回内容

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

ProcessResults Container 图片处理结果

节点名称 类型 描述

https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/6924
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 ImageInfo 节点内容：

 ProcessResults 节点内容：

 Object 节点内容：

Key String 原图文件名

Location String 图片路径

ImageInf

o

Containe

r
原图图片信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果图 ETag 信息）

节点名

称

类

型
描述

Forma

t

Str

ing
图片格式

Width Int 图片宽度

Height Int 图片高度

Quality Int 图片质量

Ave
Str

ing

图片主色调，格式为：0xRRGGBB （RR、GG、BB都是十六进制数，表示红、

绿、蓝三种颜色）

Orient

ation
Int

图片旋转角度，取值为1-8的整数：

1：旋转0°

2：水平翻转

3：旋转180°

4：垂直翻转

5：顺时针旋转90°+水平翻转

6：顺时针旋转90°

7：顺时针旋转90°+垂直翻转

8：逆时针旋转90°

Frame

Count
Int 图片的帧数。静态图为1，动图为对应的帧数.

节点名称 类型 描述

Object Container 每一个图片处理结果
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节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

ETag String 处理结果图 ETag 信息

FrameCount Int 图片的帧数。静态图为1，动图为对应的帧数.

示例

请求

PUT /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.png","rule":"imageMogr2/format/pn

Content-Length: 64

Object

{ [{

[ ]

返回

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

        <OriginalInfo>

            <Key>filename.jpg</Key>

            <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filename
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            <ETag>&quot 580cd6930444576523c25f86ce2af9b1fc2d5484&quot </ETag>

            <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

            </ImageInfo>

        </OriginalInfo>

        <ProcessResults>

            <Object>

                <Key>test.png</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.pn

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag>

                <FrameCount>1</FrameCount>

            </Object>

        </ProcessResults>

</UploadResult>

; ;

; ;

注意

上传时处理支持 COS V5 的分块上传功能，您在使用 COS V5 的 Complete Multipart Upload  接口

时只需在请求包头部中加入 Pic-Operations 项，即可实现图片处理。

POST /<ObjectKey>?uploadId=UploadId HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

COS 接口请参见 COS Complete Multipart Upload  文档。

云上数据处理

https://cloud.tencent.com/document/product/436/7742
https://cloud.tencent.com/document/product/436/7742
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对象存储的图片处理 API 能够对已存储在 COS 的图片进行相应处理操作，并将结果存入到 COS。

Pic-Operations 为 json 格式的字符串，具体参数如下：

 rules（json 数组）中每一项具体参数如下：

请求语法

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: <PicOperations>

请求内容

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数

名称

类

型

是否必

选
描述

buck

et

Str

ing
否

存储结果的目标 bucket 名称，形如 BucketName-APPID，如果不指

定的话默认保存到当前存储桶

fileid
Str

ing
是

处理后文件的保存路径及名称。

当 fileid  与 ObjectKey  相同时，处理后的文件将覆盖原文件存储；不相

同时将分别存储原文件和处理后文件。名称规则说明：

1. 名称需要经过 URL 安全的 Base64 编码

2. 以 / 开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 

文件夹中存储了一个文件名为 test2.jpg 的文件

3. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文

件名为 test2.jpg 的文件

4. 注意：请不要以 /  结尾，否则会产生空文件名

rule Str 是 处理参数，参见对象存储图片处理 API。若按指定样式处理，则以 style/  
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响应包体具体数据内容如下：

 UploadResult 节点内容：

 OriginalInfo 节点内容：

 ImageInfo 节点内容：

ing 开头，后加样式名，如样式名为 test ，则 rule 字段为 style/test

返回内容

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

ProcessResults Container 图片处理结果

节点名称 类型 描述

Key String 原图文件名

Location String 图片路径

ImageInf

o

Containe

r
原图图片信息

ETag String 原图 ETag 信息（若处理结果图覆盖原图则为结果图 ETag 信息）

节点名称 类型 描述

Format
Stri

ng
格式

Width Int 图片宽度

Height Int 图片高度

Quality Int 图片质量

Ave
Stri

ng

图片主色调，格式为：0xRRGGBB （RR、GG、BB都是十六进制数，表示

红、绿、蓝三种颜色）
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 ProcessResults 节点内容：

 Object 节点内容：

Orientation Int 图片旋转角度，取值为1-8的整数：

1：旋转0°

2：水平翻转

3：旋转180°

4：垂直翻转

5：顺时针旋转90°+水平翻转

6：顺时针旋转90°

7：顺时针旋转90°+垂直翻转

8：逆时针旋转90°

FrameCoun

t
Int 图片的帧数。静态图为1，动图为对应的帧数.

节点名称 类型 描述

Object Container 每一个图片处理结果

节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

ETag String 处理结果图 ETag 信息

FrameCount Int 图片的帧数。静态图为1，动图为对应的帧数

示例

请求

POST /filename.jpg?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com
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Date: Wed，18 Jan 2017 16:17:03 GMT

Authorization: XXXXXXXXXX

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.png","rule":"imageMogr2/format/pn

Content-Length: XX

{ [{

返回

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

            <OriginalInfo>

                <Key>filename.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/filenam

                <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag>

                <ImageInfo>

                    <Format>JPEG</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Quality>100</Quality>

                    <Ave>0xa18454</Ave>

                    <Orientation>1</Orientation>

                    <FrameCount>1</FrameCount>

                </ImageInfo>

            </OriginalInfo>

            <ProcessResults>

                <Object>

                    <Key>test.png</Key>

                    <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test

                    <Format>png</Format>

                    <Width>640</Width>

                    <Height>427</Height>

                    <Size>463092</Size>

                    <Quality>100</Quality>

                    <ETag>&quot eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c&quot </ETag

                    <FrameCount>1</FrameCount>

                </Object>

            </ProcessResults>

</UploadResult>

; ;

; ;
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图片样式

增加样式
最近更新时间：2023-06-19 16:47:01

该接口用于对某一个存储桶设置样式功能，设置样式后，可以方便地对图片进行统一的处理。

此接口仅使用公共请求头部，详情请参阅 公共请求头部  文档。

具体节点描述如下：

功能描述

说明

 Bucket 接口目前频控存在限制要求，写请求最多1qps，读请求最多10qps。

请求

请求示例

PUT /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>string</StyleName>

    <StyleBody>string</StyleBody>

</AddStyle>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 节点 AddStyle 的内容：

此接口仅返回公共响应头部，详情请参阅 公共响应头部  文档。

该响应体返回为空。

此接口无特殊错误信息，全部错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

AddStyle 无 待添加的样式信息 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

StyleName AddStyle 样式名称 string 是

StyleBody AddStyle 样式详情 string 是

响应

响应头

响应体

错误码

实际案例

请求

PUT /?style HTTP/1.1

Host: examplebucket-1250000000.pic.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

<?xml version="1.0" encoding="UTF-8" ?>

<AddStyle>

    <StyleName>style_name</StyleName>

    <StyleBody>imageMogr2/thumbnail/!50px</StyleBody>

</AddStyle>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/8523
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Date: Tue, 03 Apr 2019 09:06:16 GMT

x-cos-request-id: xxxxxxxxxxxxxxxxxx
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查询样式
最近更新时间：2023-06-05 15:08:21

用于查询该 Bucket 下已有的图片样式。若不使用请求体，则查询该 Bucket 下的全部图片样式，若使用请求体，

则查询请求体中指定的图片样式。

此接口仅使用公共请求头，详情请参见 公共请求头部  。

若不使用请求体，则查询该 Bucket 下的全部图片样式；若使用请求体，则查询请求体中指定的图片样式。

请求参数说明

功能描述

请求

请求示例

GET /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<GetStyle>

  <StyleName>string</StyleName>

  <StyleName>string</StyleName>

</GetStyle>

节点名称 父节点 描述 类型 是否必选

GetStyle 无 查询图片样式名称的容器。 Container 否

StyleName GetStyle 查询的图片样式名称。 String 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共响应头，详情请参见 公共响应头部  。

响应参数说明

响应

响应头

响应体

<StyleList>

  <StyleRule>

    <StyleName>string</StyleName>

    <StyleBody>string</StyleBody>

  </StyleRule>

  <StyleRule>

    <StyleName>string</StyleName>

    <StyleBody>string</StyleBody>

  </StyleRule>

</StyleList>

节点名称 父节点 描述 类型

StyleList 无 查询到的图片样式集合。 Container

StyleRule StyleList 图片样式名称和参数。 Container

StyleName StyleRule 图片样式名称。 String

StyleBody StyleRule 图片样式参数。 String

https://cloud.tencent.com/document/product/460/42866
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删除样式
最近更新时间：2023-06-05 15:08:05

用于删除指定的图片样式。

此接口仅使用公共请求头，详情请参见 公共请求头部  。

请求参数说明：

功能描述

请求

请求示例

DELETE /?style HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

<XML File>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<DeleteStyle>

  <StyleName>string</StyleName>

</DeleteStyle>

节点名称 父节点 描述 类型 是否必选

DeleteStyle 无 待删除样式名称容器 Container 是

StyleName DeleteStyle 待删除样式名称 String 是

响应

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共响应头，详情请参见 公共响应头部  。

该响应体返回为空。

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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基础图片处理

缩放
最近更新时间：2023-07-11 11:48:22

腾讯云数据万象通过 imageMogr2 接口提供图片缩放功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：默认支持处理 JPG/JPEG、BMP、GIF、PNG、WebP 格式，开通 图片高级压缩功能  后，可支

持AVIF、HEIF、TPG 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过9999像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/thumbnail/<imageSizeAndOffsetGeometry> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

https://cloud.tencent.com/document/product/460/47501
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操作名称：thumbnail。

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/thumbnail/<imageSizeAndOffsetGeometry>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当  fileid   与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理

后图片。

fileid   的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义
是否

必选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/thumbnail/! 指定图片的宽高为原图的 Scale% 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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<Scale>p

/thumbnail/!

<Scale>px
指定图片的宽为原图的 Scale%，高度不变 否

/thumbnail/!x<Sca

le>p
指定图片的高为原图的 Scale%，宽度不变 否

/thumbnail/<Width

>x
指定目标图片宽度为 Width，高度等比缩放 否

/thumbnail/x<Heig

ht>
指定目标图片高度为 Height，宽度等比缩放 否

/thumbnail/<Width

>x<Height>

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等

比缩放
否

/thumbnail/<Width

>x<Height>>

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等

比缩小，比例值为宽缩放比和高缩放比的较小值，如果目标宽（高）都

大于原图宽（高），则不变

否

/thumbnail/<Width

>x<Height><

限定缩略图的宽度和高度的最大值分别为 Width 和 Height，进行等

比放大，比例值为宽缩放比和高缩放比的较小值。如果目标宽（高）小

于原图宽（高），则不变

否

/thumbnail/!

<Width>x<Height

>r

限定缩略图的宽度和高度的最小值分别为 Width 和 Height，进行等

比缩放
否

/thumbnail/<Width

>x<Height>!

忽略原图宽高比例，指定图片宽度为 Width，高度为 Height，强行

缩放图片，可能导致目标图片变形
否

/thumbnail/<Area>

@
等比缩放图片，缩放后的图像，总像素数量不超过 Area 否

/pad/

将原图缩放为指定 Width 和 Height 的矩形内的最大图片，之后使用 

color 参数指定的颜色居中填充空白部分；取值0或1，0代表不使用 

pad 模式，1代表使用 pad 模式

否

/color/

填充颜色，缺省为白色，需设置为十六进制 RGB 格式（如 

#FF0000），详情参考 RGB 编码表 ，需经过 URL 安全的 

Base64 编码 ，默认值为 #FFFFFF

否

/ignore-error/1
当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败

的场景，会直接返回原图而不报错
否

说明：

https://www.rapidtables.com/web/color/RGB_Color.html
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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原图如下：

假设缩放图片宽高为原图50%，示例如下：

表格中的多个 thumbnail 参数，需至少选择一个，若选择了多个，仅会生效已选的第一个。

例如选择了两个参数：/thumbnail/!<Scale>p/!x<Scale>p

仅会生效!<Scale>p

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：缩放宽高

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t

https://cloud.tencent.com/document/product/460/18147
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最终效果如下：

假设缩放指定图片宽度为原图50%，高度不变，示例如下：

案例二：缩放宽度，高度不变

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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最终效果如下：

将原图缩放为600 x 600的矩形内的最大图片，并使用指定颜色填充空白部分，示例如下：

案例三：Pad 模式缩放

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例四：Pad 模式缩放并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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裁剪
最近更新时间：2023-04-20 09:59:58

腾讯云数据万象通过 imageMogr2 接口提供裁剪功能，包括普通裁剪、缩放裁剪、内切圆裁剪、圆角裁剪和人脸

智能裁剪。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过9999像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/cut/<width>x<height>x<dx>x<dy>

                           /crop/<imageSizeAndOffsetGeometry>

                           /iradius/<radius>

                           /rradius/<radius>

                           /scrop/<Width>x<Height> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cut/<width>x<height>x<dx>x<dy>

                       /crop/<imageSizeAndOffsetGeometry>

                       /iradius/<radius>

                       /rradius/<radius>

                       /scrop/<Width>x<Height>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
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操作名称：cut。

操作名称：crop。

在进行缩放裁剪操作时，您也可以使用 gravity 参数指定操作的起点位置，详见下文中 缩放裁剪操作示例 。

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectKe

y
对象文件名，例如 folder/sample.jpg。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回

原图而不报错

普通裁剪参数说明

参数 含义

<width> 指定目标图片的宽为 width

<height> 指定目标图片的高为 height

<dx> 相对于图片左上顶点水平向右偏移 dx

<dy> 相对于图片左上顶点水平向下偏移 dy

说明

 参数取值范围应大于0，小于原图宽高。

缩放裁剪参数说明

参数 含义

/crop/<Width>x 指定目标图片宽度为 Width，高度不变。Width 取值范围应大于0，小于原图宽度

/crop/x<Height

>
指定目标图片高度为 Height，宽度不变。Height 取值范围应大于0，小于原图高度

/crop/<Width>x

<Height>

指定目标图片宽度为 Width，高度为 Height 。Width 和 Height 取值范围都应大

于0，小于原图宽度/高度

https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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操作名称：iradius。

操作名称：rradius。

操作名称：scrop。

九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应远点为参照）。  

内切圆裁剪参数说明

参数 含义

/iradius/<r

adius>

内切圆裁剪功能，radius 是内切圆的半径，取值范围为大于0且小于原图最小边一半的整

数。内切圆的圆心为图片的中心。图片格式为 gif 时，不支持该参数。

处理后图片如果是PNG、WebP或BMP等支持透明通道的图片，那么图片非圆形区域的部

分将会以透明填充；如果是JPG图片，不支持透明通道，非圆形区域是以白色进行填充。

圆角裁剪参数说明

参数 含义

/rradius/<

radius>

圆角裁剪功能，radius 为图片圆角边缘的半径，取值范围为大于0且小于原图最小边一半的

整数。圆角与原图边缘相切。图片格式为 gif 时，不支持该参数。

处理后图片如果是PNG、WebP或BMP等支持透明通道的图片，那么图片非圆形区域的部

分将会以透明填充；如果是JPG图片，不支持透明通道，非圆形区域是以白色进行填充。

人脸智能裁剪参数说明

参数 含义

/scrop/<Width>x<H

eight>

基于图片中的人脸位置进行缩放裁剪。目标图片的宽度为 Width、高度为 

Height。

九宫格方位图
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相对于图片左上顶点水平向右平移100像素，垂直向下平移10像素，指定目标图片大小为600×600进行裁剪：

注意

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：普通裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c

https://cloud.tencent.com/document/product/460/18147
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原图如下：
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最终效果如下：

假设以中心点 center 为参考点，缩放裁剪至300×400，示例如下：

案例二：缩放裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c
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最终效果如下：

取半径为200，进行内切圆裁剪：

案例三：内切圆裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/i
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最终效果如下：

取半径为100，进行圆角裁剪：

案例四：圆角裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r
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最终效果如下：

基于图片中的人脸位置进行缩放裁剪，目标图片大小为100×600，示例如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例五：人脸智能裁剪

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

说明

如果图片中没有识别到人脸，则返回原图。

案例六：人脸智能裁剪并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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旋转
最近更新时间：2023-07-06 18:24:43

腾讯云数据万象通过 imageMogr2 接口提供旋转功能，包括普通旋转和自适应旋转。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：默认支持处理 JPG/JPEG、BMP、GIF、PNG、WebP 格式，开通 图片高级压缩功能  后，可支

持AVIF、HEIF、TPG 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口形式

1. 下载时处理

GET /<ObjectKey>?imageMogr2/rotate/<rotateDegree>

                           /auto-orient HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

注意

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/47501
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Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/rotate/<rotateDegree>

                       /auto-orient"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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顺时针旋转90度，示例如下：

最终效果如下：

ObjectKey 对象文件名，例如 folder/sample.jpg。

/rotate/<rotateDe

gree>
普通旋转：图片顺时针旋转角度，取值范围0 - 360，默认不旋转。

/auto-orient 自适应旋转：根据原图 EXIF 信息将图片自适应旋转回正。

/flip/<flip> 镜像翻转：flip 值为 vertical 表示垂直翻转，horizontal 表示水平翻转

/ignore-error/1
当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会

直接返回原图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：普通旋转

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r

https://cloud.tencent.com/document/product/460/18147
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：普通旋转并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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格式转换
最近更新时间：2023-06-05 15:08:49

腾讯云数据万象通过 imageMogr2 接口提供格式转换、渐进显示功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

gif、webp、tpg 等动图，支持互相转换。

jpg、png、bmp、webp、avif、tpg、heif 等静态图片，支持互相转换。

转换为avif、tpg、heif需先开通图片高级压缩服务，详情请查看 图片高级压缩 。

接口形式

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/<Format> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

           }]

}

https://cloud.tencent.com/document/product/460/47501
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3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/format/<Format>"

           }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片处理机制介绍 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码

处理参数说明

参数 含义
是否

必选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/format/<F

ormat>

有效值：jpg，bmp，gif，png，webp，heif，avif，tpg。

如需转换为avif、tpg、heif，请先开通图片高级压缩服务。
是

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，

会直接返回原图而不报错
否

实际案例

说明

https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147#.E4.B8.8A.E4.BC.A0.E6.97.B6.E5.A4.84.E7.90.86
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片处理机制介绍  文档并配置上传时处理或云上数据处理。

案例一：将 jpeg 格式的原图片转换为 png 格式

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/f

案例二：将 jpeg 格式的原图片转换为 png 格式并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
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质量变换
最近更新时间：2023-04-20 10:00:16

腾讯云数据万象通过 imageMogr2 接口对图片质量进行调节。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

说明

 该接口支持 jpg、webp、tpg、heif、avif 格式图片。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/quality/<Quality>

                           /rquality/<quality>

                           /lquality/<quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

  }]

}
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操作名称：quality。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/quality/<Quality>

                       /rquality/<quality>

                       /lquality/<quality>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg

/quality/<Q

uality>

图片的绝对质量，取值范围0 - 100，默认值为原图质量；取原图质量和指定质量的最小

值；<Quality>后面加“!”表示强制使用指定值，例如： 90!

/rquality/<

quality>

图片的相对质量，取值范围0 - 100，数值以原图质量为标准。例如原图质量为80，将 

rquality 设置为80后，得到处理结果图的图片质量为64（80x80%）

/lquality/<q 图片的最低质量，取值范围0 - 100，设置结果图的质量参数最小值

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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假设设置绝对质量为60，示例如下：

效果如下：

uality> 例如原图质量为85，将 lquality 设置为80后，处理结果图的图片质量为85

例如原图质量为60，将 lquality 设置为80后，处理结果图的图片质量会被提升至80

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回

原图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：设置绝对质量

http://examples-1251000004.picsh.myqcloud.com/sample.jpeg?imageMogr2/quality/60

https://cloud.tencent.com/document/product/460/18147
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假设设置相对质量为60，示例如下：

效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例二：设置相对质量

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/r

案例三：设置相对质量为60并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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渐进显示
最近更新时间：2023-02-15 14:40:30

腾讯云数据万象通过 imageMogr2 接口提供jpg图片的渐进显示功能。

功能概述

限制说明

支持格式：支持处理原图为 JPG、BMP、GIF、PNG、WebP、HEIF的格式，但渐进显示仅支持JPG图进

行显示，其他格式图片需搭配格式转换 format 参数将原图转换为JPG格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素。

接口示例

GET /<ObjectKey>?imageMogr2/interlace/<Mode> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

Object

Key
对象文件名，例如 folder/sample.gif。

/interla

ce/

输出为渐进式 jpg 格式。Mode 可为0或1。

该参数仅在输出图片格式为 jpg 格式时有效。如果输出非 jpg 图片格式，会忽略该参数，默认

值0。

0：表示不开启渐进式；

1：表示开启渐进式。

/ignore

-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回原图

而不报错。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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将原图格式为PNG的图片保存为JPG格式，并设置成渐进显示：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

实际案例

http://examples-125xxxxxx.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/form

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
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动图截帧
最近更新时间：2023-05-30 16:25:50

腾讯云数据万象通过 imageMogr2 接口提供动图截帧功能。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 GIF、WebP 格式。

体积限制：GIF 原图宽 x 高 x 帧数不超过2.5亿像素；WebP原图宽高不超过16383像素。

动图帧数限制：帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/cgif/<FrameNumber>

                           /egif/<FrameInterval> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第96 共1950页

      "fileid": "exampleobject",

      "rule": "imageMogr2/cgif/<FrameNumber>

                         /egif/<FrameInterval>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/cgif/<FrameNumber>

                         /egif/<FrameInterval>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.gif。

/frame/

动图截单帧（仅支持下载时处理）：可指定截取动图的第N帧，N取值为正整数

（1,2,3……），如果N大于动图的最大帧数，则取最后一帧。例如截取某动图的第1帧，则

参数为 /frame/1。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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对某GIF动图截取前10帧：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

/cgif/ 动图格式优化（截取型）：针对原图为 gif、webp 格式，对动图进行的优化，截帧降颜

色。分为以下两种情况：

FrameNumber=1，则按照默认帧数30处理，如果图片帧数大于该帧数则截取。

FrameNumber 取值(1,100]，则将图片压缩到指定帧数 （FrameNumber）。

/egif/

动图格式优化（抽帧型）：只针对原图为 gif、webp 格式，对动图进行的优化，进行降颜

色处理，并每隔一定帧数（FrameInterval）抽取目标帧进行输出。

FrameInterval 取值[1,10]。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回

原图而不报错。

注意

 cgif与egif参数同时传递时，优先处理cgif。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

http://examples-125xxxxxx.cos.ap-shanghai.myqcloud.com/sample.gif?imageMogr2/cgif/

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/460/18147
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高斯模糊
最近更新时间：2023-06-05 10:08:00

腾讯云数据万象通过 imageMogr2 接口对图片进行模糊处理。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/blur/<radius>x<sigma>  HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：blur。

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/blur/<radius>x<sigma>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

<radius> 模糊半径，取值范围为1 - 50

<sigma> 正态分布的标准差，必须大于0

/ignore- 当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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高斯模糊处理后效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

error/1 回原图而不报错

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可参见 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：模糊半径取8，sigma 值取5，进行高斯模糊处理

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/b

案例二：模糊半径取8，sigma 值取5，进行高斯模糊处理，并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第102 共1950页

亮度
最近更新时间：2023-04-20 10:00:26

腾讯云数据万象通过 imageMogr2 接口调节图片亮度。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/bright/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第103 共1950页

操作名称：bright。

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/bright/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectK

ey
对象文件名，例如 folder/sample.jpg。

/bright/<

value>

图片亮度调节功能，value 为亮度参数值，取值范围为[-100, 100]的整数。

取值＜0：降低图片亮度。

取值 = 0：不调整图片亮度。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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将图片亮度提高70，示例如下：

最终效果如下：

取值＞0：提高图片亮度。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回原

图而不报错。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：亮度调节

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/b

https://cloud.tencent.com/document/product/460/18147
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：亮度调节并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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对比度
最近更新时间：2023-04-20 10:00:34

对比度指一幅图像中明暗区域最亮的白和最暗的黑之间不同亮度层级的测量，即指一幅图像灰度反差的大小。腾讯云

数据万象通过 imageMogr2 接口调节图片对比度。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/contrast/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,
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操作名称：contrast。

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/contrast/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/contrast/<

value>

图片对比度调节功能，value 为对比度参数值，取值范围为[-100, 100]的整数。

取值＜0：降低图片对比度。

取值 = 0：不调整图片对比度。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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将图片对比度降低50，示例如下：

最终效果如下：

取值＞0：提高图片对比度。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回

原图而不报错。

实际案例

案例一：对比度调节

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/c

https://cloud.tencent.com/document/product/460/18147
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：对比度调节并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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锐化
最近更新时间：2023-04-20 10:00:38

腾讯云数据万象通过 imageMogr2 接口对图片进行锐化处理。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/sharpen/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：sharpen。

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/sharpen/<value>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/sharpen/<v

alue>

图片锐化功能，value 为锐化参数值，取值范围为10 - 300间的整数（推荐使用70）。

参数值越大，锐化效果越明显。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返

回原图而不报错。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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假设设置锐化参数为70，进行锐化处理，示例如下：

最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：锐化

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

案例二：锐化并携带私有文件签名

https://cloud.tencent.com/document/product/460/18147
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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灰度图
最近更新时间：2023-04-20 10:00:42

腾讯云数据万象通过 imageMogr2/grayscale 接口将图片设置为灰度图。

功能概述

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/grayscale/<value> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]

}
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操作名称：grayscale。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/grayscale/<value>"

  }]

}

说明

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/grayscale/<

value>

将图片设置为灰度图。

value 取值为0表示不改变图片。value 取值为1表示将图片变为灰度图。

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返

回原图而不报错。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/18147
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将图片变为灰度图，示例如下：

最终效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

案例一：转为灰度图

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/g

案例二：锐化并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明
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为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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获取图片基本信息
最近更新时间：2023-02-15 14:42:48

腾讯云数据万象通过 imageInfo 接口查询图片基本信息，包括格式、长、宽等。

操作名称：imageInfo。

功能概述

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

download_url?imageInfo

处理参数说明

请求参数

参数 含义

downloa

d_url

文件的访问链接，具体构成为<BucketName-APPID>.cos.

<Region>.myqcloud.com/<picture name>，

例如 examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg

响应参数

参数 含义

format 图片类型。例如 png、gif 等

width 图片的宽度。单位为像素（px）

height 图片的高度。单位为像素（px）
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

size 图片的大小。单位为 Bytes

md5 图片的 md5 值

frame_count 图片的帧数。静态图为1，动图为对应的帧数

bit_depth 图片的位深

vertical_dpi 图片的垂直分辨率

horizontal_dpi 图片的水平分辨率

实际案例

案例一：公有读

请求

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageInfo

响应

{"format": "jpeg", "width": "960", "height": "540", "size": "158421", "md5": "77a16fa70e2

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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获取图片 EXIF
最近更新时间：2023-02-15 14:42:52

EXIF（Exchangeable Image File）全称为可交换图像文件，可记录数码照片的拍摄参数、缩略图及其他属性

信息。腾讯云数据万象通过 exif 接口获取 EXIF 信息。

操作名称：exif。

功能概述

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

注意

 如图片无 exif 信息，将返回 {"error" : "no exif data"} 。

接口示例

GET /<ObjectKey>?exif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

实际案例

案例一：公有读
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?exif

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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获取图片主色调
最近更新时间：2023-02-15 14:42:56

腾讯云数据万象通过 imageAve 接口获取图片主色调信息。

操作名称：imageAve

功能概述

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?imageAve HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

实际案例

案例一：公有读

请求

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageAve

响应
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获取方式同上，仅增加签名部分，并与获取参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

{"RGB": "0x736246"}

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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去除元信息
最近更新时间：2023-04-20 10:01:07

腾讯云数据万象通过 imageMogr2 接口可去除图片元信息，包括 exif 信息。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/strip HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：strip。

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/strip"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  。

处理参数说明

参数 含义

ObjectKe

y
对象文件名，例如 folder/sample.jpg

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回

原图而不报错

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了防止未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：公有读

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/s

案例二：私有读、携带签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
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快速缩略模板
最近更新时间：2023-06-26 18:50:36

腾讯云数据万象通过 imageView2 接口提供常用图片处理模板。开发者根据业务需求，只需在下载 URL 后面附

加相应的参数，就可以生成相应的缩略图。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：默认支持处理 JPG/JPEG、BMP、GIF、PNG、WebP 格式，开通 图片高级压缩功能  后，可支

持AVIF、HEIF、TPG 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageView2/<mode>/w/<Width>

                                  /h/<Height>

                                  /format/<Format>

                                  /q/<Quality>

                                  /rq/<Quality>

                                  /lq/<Quality> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

注意

 质量变换参数仅针对 jpg 和 webp 格式图片。

https://cloud.tencent.com/document/product/460/47501
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2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageView2/<mode>/w/<Width>

                 /h/<Height>

                 /format/<Format>

                 /q/<Quality>

                 /rq/<Quality>

                 /lq/<Quality>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

https://cloud.tencent.com/document/product/436/7778
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通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  。

处理参数说明

参数 含义
是否

必选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/0/w/<LongEdge>/h/<S

hortEdge>

限定缩略图的长边最多为<LongEdge>，短边最多为

<ShortEdge>，进行等比缩放，不裁剪。如果只指定w参数则

表示限定长边（短边自适应），只指定h参数则表示限定短边

（长边自适应）。

当图片长宽相同时，默认长边为图片的高。

否

/1/w/<Width>/h/<Height

>

限定缩略图的宽高最小值。该操作会将图像等比缩放直至某一边

达到设定最小值，之后将另一边居中裁剪至设定值。若只指定一

边，则表示宽高相等的正方形。

例如，原图大小为1000x500，将参数设定为 ?

imageView2/1/w/500/h/400 后，图像会先等比缩放至

800x400，之后左右各裁剪150，得到500x400大小的图像

否

/2/w/<Width>/h/<Height

>

限定缩略图的宽高最大值。该操作会将图像等比缩放至宽高都小

于设定最大值。

例如，原图大小为 1000x500，将参数设定为 ?

imageView2/2/w/500/h/400 后，图像会等比缩放至

500x250。如果只指定一边，则另一边自适应

否

/3/w/<Width>/h/<Height

>

限定缩略图的宽高最小值。该操作会将图像等比缩放至宽高都大

于设定最小值。

例如，原图大小为 1000x500，将参数设定为 ?

imageView2/3/w/500/h/400 后，图像会等比缩放至

800x400。如果仅指定了一边的值，则另一边将默认设为相同

的值。

否

/4/w/<LongEdge>/h/<S

hortEdge>

限定缩略图的长边和短边的最小值分别为 LongEdge 和 

ShortEdge，进行等比压缩；如果只指定一边，代表另外一边

为同样的值

当图片长宽相同时，默认长边为图片的高。

否

/5/w/<LongEdge>/h/<S 限定缩略图的长边和短边的最大值分别为 LongEdge 和 否

https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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选用样式1，并限定缩略图的宽高最小值为400 × 600，绝对质量为85：

hortEdge> ShortEdge，进行等比压缩，居中裁剪；如果只指定一边，则

表示宽高相等的正方形；缩放后其中一边多余的部分会被裁剪

掉。

当图片长宽相同时，默认长边为图片的高。

/format/<Format>
目标缩略图的图片格式，Format 可为：jpg，bmp，gif，

png，webp，缺省为原图格式。
否

/q/<Quality>

图片质量，取值范围 0 - 100，默认值为原图质量；取原图质量

和指定质量的最小值；<Quality> 后面加!（注意为英文字

符），表示强制使用指定值。

否

/rq/<quality>

图片的相对质量，取值范围0 - 100，数值以原图质量为标准。

例如原图质量为80，将 rquality 设置为80后，得到处理结果图

的图片质量为64（80x80%）。

否

/lq/<quality>

图片的最低质量，取值范围0 - 100，设置结果图的质量参数最

小值。

例如，原图质量为85，将 lquality 设置为80后，处理结果图的

图片质量为85；

例如，原图质量为60，将 lquality 设置为80后，处理结果图的

图片质量会被提升至80。

否

/ignore-error/1
当处理参数中携带此参数时，针对文件过大、文件格式有误等外

部因素导致的处理失败的场景，会直接返回原图而不报错。
否

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：选用模板样式1

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageView2/1

https://cloud.tencent.com/document/product/460/18147
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缩略图效果如下：

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：选用模板样式1并携带私有签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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限制图片大小
最近更新时间：2023-03-13 14:12:18

腾讯云数据万象通过 imageMogr2/size-limit 接口可限制图片处理（例如缩放、压缩等）后的文件大小。

操作名称：size-limit。

功能概述

限制说明

支持格式：仅支持对处理后为 JPG 格式的图片限制大小。

体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过50000像素。

接口示例

GET /<ObjectKey>?imageMogr2/size-limit HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectK

ey
对象文件名，例如 folder/sample.jpg。

size-

limit

限制图片转换后的大小，支持以兆字节（m）和千字节（k）为单位

仅支持 JPG 格式的图片，可以用于限制处理后图片的大小

若在尾部加上 ! ，表示用处理后的图片大小与原图大小做比较，如果处理后的图片比原图

小，则返回处理后的图片，否则返回原图。例如：examplebucket-

1250000000.cos.ap-shanghai.myqcloud.com/picture.jpg?

imageMogr2/size-limit/15k!

建议搭配 strip  参数使用，去除图片的一些冗余信息，会有更好的效果。例如：

examplebucket-1250000000.cos.ap-

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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将 PNG 图片转换为 JPG 格式，并限制图片大小为15KB，示例如下：

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

shanghai.myqcloud.com/picture.png?imageMogr2/strip/format/jpg/size-

limit/15k!

/ignore-

error/1

当处理参数中携带此参数时，针对文件过大、参数超限等导致处理失败的场景，会直接返回原

图而不报错

实际案例

案例一：转换图片格式并限制大小

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/st

案例二：转换图片格式、限制大小并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.png?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第136 共1950页

管道操作符
最近更新时间：2023-02-09 10:36:27

腾讯云数据万象的管道操作符 | 能够实现对图片按顺序进行多种处理。用户可以通过管道操作符将多个处理参数分

隔开，从而实现在一次访问中按顺序对图片进行不同处理。处理图片原图大小不超过32MB、宽高不超过50000像

素且总像素不超过2.5亿像素，处理结果图宽高设置不超过50000像素；针对动图，原图宽 x 高 x 帧数不超过2.5

亿像素。

用户在图片 URL 链接后以样式分隔符 ? 与处理样式相连接，多个处理样式之间以管道操作符 | 分隔，样式按照先

后顺序执行，目前最多支持10层管道。

本次案例先将原图缩放为50%，然后在图的右下角添加“数据万象”的文字水印。

假设原图 URL 为：

功能概述

接口示例

实际案例

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg
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原图显示如下：  

首先增加缩放操作，则 URL 为：

图片显示如下：

使用管道操作符再添加文字水印的样式处理，则最终 URL 为：

案例一：对图片进行缩放并添加水印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t
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图片最终处理效果如下：  

处理方式同上，仅增加签名部分，并与处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?imageMogr2/t

案例二：使用管道操作符并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参考 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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支持字体列表
最近更新时间：2020-11-13 16:16:49

数据万象支持字体列表如下。

字体名称 支持语言

simfang仿宋.ttf 中/英

simhei黑体.ttf 中/英

simkai楷体.ttf 中/英

simsun宋体.ttc 中/英

STHeiti Light华文黑体.ttc 中/英

STHeiti Medium.ttc 中/英

幼圆.TTF 中/英

ahronbd.ttf 英文

arial.ttf 英文

ariblk.ttf 英文

Helvetica.dfont 英文

HelveticaNeue.dfont 英文
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合成动图
最近更新时间：2023-06-27 10:41:41

腾讯云数据万象通过 imageMogr2 接口提供合成功能，可将多张 jpg 或 png 格式的图片合成为一个 GIF 动图。

该功能支持以下处理方式：

该功能计入基础图片处理用量，其中处理用量按原图大小之和计算，例如使用了 10 张大小为 5MB 的 jpg 图片进

行合成动图，则统计用量计为 50MB。有关基础图片处理的定价，请查看 图片处理费用 。

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

动图合成接口目前仅适用于存储在 COS 上的图片。

支持合成的原图格式：jpg/jpeg、png。

支持的最大帧数：20。

支持的最大图片尺寸：1080*1080。

原图限制：大小不超过32MB，宽高不超过50000像素且总像素不超过2.5亿像素。

合成后的动图限制：宽 x 高 x 帧数不超过2.5亿像素。

计费说明

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/animate/duration/<duration>/images/<imageurl1>/<im

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

https://cloud.tencent.com/document/product/460/58117#3c009736-907d-4767-8fc8-a6d100c891bb
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PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/animate/duration/<duration>/images/<imageurl1>/<imageurl2

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "imageMogr2/animate/duration/<duration>/images/<imageurl1>/<imageurl2

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

当 fileid  与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码  

处理参数说明

参数 参数说明 是否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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以存储桶examples-125xxxxxx中的image-1.jpg为动图首帧，和同个存储桶内的image-2.jpg合成为一个间

隔50ms的动图。

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

必填

ObjectK

ey

COS中的文件名称，例如 folder/sample.jpg，在这里将作为合成后的动图第一

帧。
是

duration
GIF 动图的每帧间隔时间(单位: ms)，取值为大于 0 的整数。例如设置间隔为

10ms，则参数为/duration/10。
是

images

待合成的图片原图链接，最多可添加19个，需要经过 URL安全Base64编码 。

例如原图1的链接经过编码后的字符串为ahxxxxxxxxxmc，原图2的链接经过编

码后的字符串为wywxxxxxxxxjih，则参数

为/images/ahxxxxxxxxxmc/wywxxxxxxxxjih。

是

注意：

如果待合成的原图尺寸不相同，最终合成的动图将以第一帧的体积为标准，对所有图片进行等比缩放。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

http://examples-125xxxxxx.cos.ap-shanghai.myqcloud.com/image-1.jpg?imageMogr2/ani

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/18147
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获取原图
最近更新时间：2023-04-28 10:43:38

如果您开启了 图片原图功能 ，同时在某些场景下希望获取到原图，可通过本接口进行获取。

该接口无特殊请求头。

该接口无请求体。

该接口无特殊响应头。

功能概述

注意

该请求操作不支持匿名请求，必须携带签名。

请求

请求示例

GET /<ObjectKey>?ci-process=originImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

请求参数说明

参数 描述 类型
是否必

选

ci-

process

万象通用参数，需要获取原图的时，该参数固定为：

originImage

strin

g
是

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/460/6933#.E5.8E.9F.E5.9B.BE.E4.BF.9D.E6.8A.A4
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该接口的响应体为对象（文件）内容。

访问一张已开启了原图保护的存储桶中的图片，并携带获取原图参数：

响应体

实际案例

http://example-1250000000.cos.ap-chengdu.myqcloud.com/?ci-process=originImage&q-s

说明

<signature>  为签名部分，获取方式请参考 请求签名 ，计算的签名中需将处理参数 ci-process 也一并

签入。

https://cloud.tencent.com/document/product/436/7778
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图片基础压缩（WebP）
最近更新时间：2023-07-06 18:24:44

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

数据万象（Cloud Infinite，CI）  产品推出了 WebP 压缩功能，可将图片转换为 webp 压缩图片格式，其在压

缩方面相比 jpg 格式更优越。在相同图片质量的情况下，webp 格式图片要比 jpg 格式图片减小25%以上，可以适

配多终端使用场景。

数据万象通过 imageMogr2 接口提供 WebP 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、tpg、heif、avif 等格式图片转换为 webp 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

使用方式

下载时处理

上传时处理

云上数据处理

说明

WebP 压缩为付费服务，费用同基础图片处理，具体费用请参见 图片处理费用 。

图片转换为 WebP 格式后，部分浏览器无法读取 WebP 图片的 exif 信息，导致没有旋转。您可参见 

旋转  文档，增加 auto-orient 参数，对原图旋转后再进行压缩。

WebP 压缩默认继承原始图片的质量参数。您可参见 质量变换  文档，通过修改图片质量来调节压缩

率。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/webp HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/460/36542
https://cloud.tencent.com/document/product/460/36544
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Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/webp"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 webp。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 webp 格式，请求 URL 如下：

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for
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效果如下：

压缩率对比

格式 图片大小

png（原图） 1335.2KB

webp 65KB（压缩率95.13%）
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图片高级压缩

HEIF 压缩
最近更新时间：2023-06-05 15:07:44

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

数据万象（Cloud Infinite，CI）  产品推出了 HEIF 压缩功能，可将图片转换为 heif 格式，它具有超高的压缩

率，在图片质量相同的情况下，图片大小比 jpg 格式图片减小80%以上，iOS 系统已将 heif 图片作为相册默认格

式，Android P 系统已原生支持 heif。

使用 HEIF 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 图片高级压缩 。

数据万象通过 imageMogr2 接口提供 HEIF 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、webp、tpg、avif 等格式图片转换为 heif 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用方式

下载时处理

上传时处理

云上数据处理

说明

 HEIF 压缩为付费服务，计费项为图片高级压缩费用，具体费用请参见 图片处理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/heif HTTP/1.1

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/46821
https://cloud.tencent.com/document/product/460/58117
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Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/heif"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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假设原图格式为 png，图片大小为1335.2KB，如下图所示。 

将原图转换为 heif 格式，请求 URL 如下：

处理参数说明

参数 描述 是否必选

ObjectKey 对象文件名，例如 folder/sample.jpg。 是

/format/<Format> 压缩格式，此处为 heif。 是

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for
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压缩率对比

格式 图片大小

png（原图） 1335.2KB

heif 52.87KB（压缩率96.0%）
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TPG 压缩
最近更新时间：2022-09-19 15:01:44

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

数据万象（Cloud Infinite，CI）  产品推出了 TPG 压缩功能，可将图片转换为 tpg 格式，它是腾讯推出的自研

图片格式，能支持动图，目前 QQ 浏览器、QQ 空间等产品已默认支持 tpg 图片，在图片质量相同的情况下，图片

大小比 gif 格式图片减少90%以上，比 png 图片小50%以上。

数据万象通过 imageMogr2 接口提供 tpg 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、webp、heif、avif 等格式图片转换为 tpg 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用 TPG 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 设置图片高级压缩 。

TPG 是腾讯自研的图片格式，使用前请确认图片加载环境已支持 TPG 解码，腾讯云数据万象提供集成 TPG 

解码器的 iOS 、 Android 、 Windows  终端 SDK，可帮助您快速接入和使用 TPG。

使用方式

下载时处理

上传时处理

云上数据处理

说明

 TPG 压缩为付费服务，计费项为图片高级压缩费用，由数据万象收取，具体费用请参见数据万象 图片处

理费用 。

接口示例

1. 下载时处理

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/436/48981
https://cloud.tencent.com/document/product/460/47732
https://cloud.tencent.com/document/product/460/47737
https://main.qcloudimg.com/raw/851dd252378813d250eeca5ed55ffd36/TPG_win_SDK.zip
https://cloud.tencent.com/document/product/460/58117
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GET /<ObjectKey>?imageMogr2/format/tpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/tpg"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 tpg 格式，请求 URL 如下：

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 tpg。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。

https://cloud.tencent.com/document/product/460/41741
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压缩率对比

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for

格式 图片大小

png（原图） 1335.2KB

tpg 36.67KB（压缩率97.3%）
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AVIF 压缩
最近更新时间：2022-12-12 16:20:17

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

数据万象（Cloud Infinite，CI）  产品推出了 AVIF 压缩功能，可将图片转换为 avif 格式，avif 是基于 AV1 的

一种全新图片格式，在2020年2月由 Netflix 首次公布于众，目前已支持 Chrome、Firefox 等浏览器。

使用 AVIF 压缩，需要先开通存储桶的图片高级压缩功能，您需要在相应的存储桶配置页中通过开关按钮开启功

能，详情请参见 图片高级压缩 。

数据万象通过 imageMogr2 接口提供 avif 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：支持将 jpg、png、bmp、gif、webp、tpg、heif 等格式图片转换为 avif 格式。

体积限制：处理图片原图大小不超过32MB、宽高不超过30000像素且总像素不超过2.5亿像素，处理结果图宽

高设置不超过9999像素；针对动图，原图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

前提条件

使用方式

下载时处理

上传时处理

云上数据处理

说明

AVIF 压缩为付费服务，计费项为图片高级压缩费用，具体费用请参见 图片处理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/avif HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/46821
https://cloud.tencent.com/document/product/460/58117
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2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/avif"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第160 共1950页

假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将原图转换为 avif 格式，请求 URL 如下：

压缩率对比

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为 avif。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，请

使用上传时处理或云上数据处理方式。

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageMogr2/for

格式 图片大小
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png（原图） 1335.2KB

avif 62.8KB（压缩率95.3%）
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SVG 压缩
最近更新时间：2022-09-19 15:02:48

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

数据万象（Cloud Infinite，CI）  产品推出了 SVG 压缩功能，可以在不影响显示效果的情况下，通过一定的优化

算法删除 SVG 文件中的冗余信息，最终达到减少 SVG 文件体积的目的。

数据万象通过 imageMogr2 接口提供 SVG 压缩功能。

该功能支持以下的处理方式：

功能描述

限制说明

支持格式：仅支持将 svg 格式图片作为输入。

体积限制：处理图片原图大小不超过32MB。

使用方式

下载时处理

上传时处理

云上数据处理

说明

  SVG 压缩为付费服务，计费项为图片高级压缩费用，具体费用请参见 图片处理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?imageMogr2/format/svgc HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

https://cloud.tencent.com/document/product/460/6962
https://cloud.tencent.com/document/product/460/58117
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Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

说明

 Pic-Operations 为 json 格式的字符串，具体参数信息可参考 图片持久化处理 。

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

"is_pic_info": 1,

"rules": [{

    "fileid": "exampleobject",

    "rule": "imageMogr2/format/svgc"

}]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

ObjectKey 对象文件名，例如 folder/sample.jpg。

/format/<Format> 压缩格式，此处为svgc。

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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图片Guetzli 压缩

开通 Guetzli 压缩
最近更新时间：2023-03-07 09:51:51

对 Bucket 开通 Guetzli 压缩功能。

该 API 接口接受 PUT 请求。

该请求操作的实现使用公共请求头，了解公共请求头详情，请参阅 公共请求头部  章节。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

功能描述

请求

请求示例

PUT /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Guetzli 压缩目前暂不支持通过 COS 域名使用，请参考示例使用 pic 域名。

请求行

PUT /?guetzli HTTP/1.1

请求头

公共头部

非公共头部

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应使用公共响应头，了解公共响应头详情，请参阅 公共响应头部  章节。

该响应无特殊的响应头。

该响应体返回为空。

响应

响应头

公共响应头

特有响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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查询 Guetzli 状态
最近更新时间：2023-03-07 09:53:33

用于查询 Guetzli 压缩功能是否开启。

该 API 接口接受 GET 请求。

该请求操作的实现使用公共请求头，了解公共请求头详细请参见 公共请求头部  章节。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

功能描述

请求

请求语法

GET /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求行

GET /?guetzli HTTP/1.1

请求头

公共头部

非公共头部

请求体

响应

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应使用公共响应头，了解公共响应头详细请参见 公共响应头部  章节。

该响应无特殊的响应头。

拥有 on  与 off  两种状态。

响应头

公共响应头

特有响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<GuetzliStatus>on</GuetzliStatus>

https://cloud.tencent.com/document/product/460/42866
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关闭 Guetzli 压缩
最近更新时间：2023-03-07 09:53:44

用于关闭 Guetzli 压缩功能。

该 API 接口接受 DELETE 请求。

该请求操作的实现使用公共请求头，了解公共请求头详情，请参阅 公共请求头部  章节。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

功能描述

请求

请求语法

DELETE /?guetzli HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求行

DELETE /?guetzli HTTP/1.1

请求头

公共头部

非公共头部

请求体

响应

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应使用公共响应头，了解公共响应头详情，请参阅 公共响应头部  章节。

该响应无特殊的响应头。

该响应体返回为空。

响应头

公共响应头

特有响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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图片极智压缩

开通极智压缩
最近更新时间：2023-07-14 14:47:01

开通当前存储桶的图片极智压缩功能。

该请求操作无特殊的请求头部信息，使用的公共请求头，请参阅 公共请求头部 章节。

功能描述

请求

请求示例

PUT /?image-slim HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

公共头部

请求体

<ImageSlim>

    <SlimMode>Auto</SimMode>

    <Suffixs>

        <Suffix>jpg</Suffix>

        <Suffix>png</Suffix>

    </Suffixs>

</ImageSlim>

节点名 父节点 描述 类型 是否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应无特殊的响应头，仅使用公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

该响应体返回为空。

称 必填

Image

Slim
无 极智压缩配置信息。

Cont

ainer
是

SlimM

ode

ImageSli

m

极智压缩的使用模式，包含两种：

注意：支持同时开通两种模式，多个值通过逗号分隔。

API：开通极智压缩的 API 使用方式，开通后可在

图片下载时通过极智压缩参数对图片进行压缩；

Auto：开通极智压缩的自动使用方式，开通后无需

携带任何参数，存储桶内指定格式的图片将在访问时

自动进行极智压缩。

是 是

Suffixs
ImageSli

m

当SlimMode的值包含Auto时生效，用于指定需要自

动进行压缩的图片格式。

Cont

ainer
否

Suffix Suffixs 需要自动进行压缩的图片格式，可选值：jpg、png。
strin

g

否，

当

Sli

mM

ode

包含

Aut

o时

必填

响应

响应头

响应体

实际案例

请求

PUT /?image-slim HTTP/1.1

Host: examplebucket-1250000000.pic.ap-shanghai.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

<?xml version="1.0" encoding="UTF-8" ?>

https://cloud.tencent.com/document/product/436/7729
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<ImageSlim>

    <SlimMode>Auto,API</SimMode>

    <Suffixs>

        <Suffix>jpg</Suffix>

    </Suffixs>

</ImageSlim>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Date: Tue, 03 Apr 2019 09:06:16 GMT

x-cos-request-id: xxxxxxxxxxxxxxxxxx
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查询极智压缩状态
最近更新时间：2023-07-14 14:47:01

该接口用于查询图片极智压缩功能的状态。

该请求操作仅使用了公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

该请求的请求体为空。

该响应仅使用公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

功能描述

请求

请求示例

GET /?image-slim HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<?xml version="1.0" encoding="UTF-8" ?>

<ImageSlim>

    <Status>off</Status>

    <SlimMode>API</SimMode>

    <Suffixs>

        <Suffix>jpg</Suffix>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该接口支持json格式返回，当请求header指定 accept= application/json，响应体如下：

        <Suffix>png</Suffix>

    </Suffixs>

</ImageSlim>

参数说明

节点名

称（关

键字）

父节点 描述

Statu

s

Imag

eSlim

极智压缩的状态，包含值：

on：极智压缩已开启；

off：极智压缩已关闭。

SlimM

ode

Imag

eSlim

极智压缩的使用模式，包含两种：

API：开通极智压缩的 API 使用方式，开通后可在图片下载时通过极智压缩参数对

图片进行压缩；

Auto：开通极智压缩的自动使用方式，开通后无需携带任何参数，存储桶内指定格

式的图片将在访问时自动进行极智压缩。

Suffix

s

Imag

eSlim
当SlimMode的值包含Auto时返回，表示需要自动进行压缩的图片格式。

Suffix
Suffix

s
标识自动进行压缩的图片格式，包含值：jpg、png。

{

    "ImageSlim":{

        "Status":"on",

        "SlimMode":"Auto",

        "Suffixs":[

            {

                "Suffix":"jpg"

            },

            {

                "Suffix":"png"

            }

        ]

    }

}
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关闭极智压缩
最近更新时间：2023-07-14 14:47:01

该接口用于关闭图片极智压缩功能。

该请求操作仅使用公共请求头，了解公共请求头详情，请参阅 公共请求头部 章节。

该请求的请求体为空。

该响应仅使用公共响应头，了解公共响应头详情，请参阅 公共响应头部 章节。

该响应体返回为空。

功能描述

请求

请求语法

DELETE /?image-slim HTTP/1.1

Host: <BucketName-APPID>.pic.<Region>.myqcloud.com 

Date: GMT Date

Authorization: Auth String

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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通过API使用极智压缩
最近更新时间：2023-07-10 09:47:51

图片压缩指在图片质量保持不变的情况，尽可能的减小图片大小，以达到节省图片存储空间、减少图片访问流量、提

升图片访问速度的效果。

极智压缩通过智能判断图片的主观质量进行自动调节，在不改变图片原格式的基础上，使图片体积相比原图有显著的

降低，同时在视觉效果上可以最大程度贴近原图。

通过控制台或接口开通极智压缩 API 使用功能。

通过 imageSlim 参数在图片下载时处理。

功能描述

说明：

该功能为付费服务，具体费用请参见 图片处理费用 。

限制说明

支持压缩的图片格式：PNG、JPG、JPEG

支持使用极智压缩的存储桶地域：北京、上海。

使用前提

使用方式

接口示例

GET /<ObjectKey>?imageSlim HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

处理参数说明

参数 含义

https://cloud.tencent.com/document/product/460/58117
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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假设原图格式为 png，图片大小为1335.2KB，如下图所示： 

将图片进行极智压缩处理，请求 URL 如下：

ObjectKey 对象文件名，例如 folder/sample.jpg。

实际案例

http://example-1258125638.cos.ap-shanghai.myqcloud.com/sample.png?imageSlim
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效果如下：

压缩率对比

格式 图片大小

png（原图） 1335.2KB

png（极智压缩图） 549KB（压缩率58.88%）
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图片明水印

图片水印
最近更新时间：2023-07-27 11:27:57

腾讯云数据万象通过 watermark 接口提供图片水印处理功能。目前水印图片必须指定为已存储于数据万象中的图

片。

该功能支持以下处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，开通 图片高级压缩功能  后，可支持AVIF、

HEIF、TPG 格式的解码和处理操作。

静图体积限制：处理图片的原图及结果图的大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像

素。

WebP图片限制：处理图片原图及结果图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像

素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：不超过300帧。

说明

图片水印为付费服务，费用同基础图片处理，具体费用请参见 图片处理费用 。

一张图片上，最多添加10张不同的图片水印。

不支持添加动图作为水印。

接口示例

1. 下载时处理

GET /<ObjectKey>?watermark/1/image/<encodedURL>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /blogo/<type> HTTP/1.1

https://cloud.tencent.com/document/product/460/47501
https://cloud.tencent.com/document/product/460/58117
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Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                     /gravity/<gravity>

                     /dx/<dx>

                     /dy/<dy>

                     /blogo/<type>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/1/image/<encodedURL>

                     /gravity/<gravity>

                     /dx/<dx>

                     /dy/<dy>
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操作名称：watermark，数字1，表示水印类型为图片水印。

                     /blogo/<type>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息可参见 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid  的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义 是否必选

ObjectK

ey
对象文件名，例如 folder/sample.jpg。 是

/image/

水印图片的链接，需要经过 URL 安全的 Base64 编码 。例如，水印图片

为： 

http://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/shuiyin_2.png

，则该处编码后的字符串为 

aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3MuYX

Atc2hhbmdoYWkubXlxY2xvdWQuY29tL3NodWl5aW5fMi5wbmc

与/imag

e_key/

参数二选

一

/image_

key/

如果您在添加水印时不希望暴露水印所在的图片地址，可使用该参数。

该参数表示存储桶中水印图片所在的路径及名称，需要经过 URL 安全的 

Base64 编码 。例如，水印图片在本存储桶中的路径及名称为：

 image/shuiyin_2.png

则该处编码后的字符串为  

aW1hZ2Uvc2h1aXlpbl8yLnBuZw

与/imag

e/参数二

选一

/gravity/ 图片水印位置，九宫格位置（ 参考九宫格方位图  ），默认值 SouthEast 否

/dx/ 水平（横轴）边距，单位为像素，缺省值为0 否

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0 否

/blogo/ 水印图适配功能，适用于水印图尺寸过大的场景（如水印墙）。共有两种类 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/6930#.E4.B9.9D.E5.AE.AB.E6.A0.BC.E6.96.B9.E4.BD.8D.E5.9B.BE
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九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应原点为参照）。  

型：

当 blogo 设置为1时，水印图会被缩放至与原图相似大小后添加

当 blogo 设置为2时，水印图会被直接裁剪至与原图相似大小后添加

/scatype

/

根据原图的大小，缩放调整水印图的大小：

当 scatype 设置为1时，按原图的宽缩放

当 scatype 设置为2时，按原图的高缩放

当 scatype 设置为3时，按原图的整体面积缩放

否

/spcent/

与 scatype 搭配使用：

当 scatype 设置为1时，该有效值为[1,1000]，单位为千分比

当 scatype 设置为2时，该有效值为[1,1000]，单位为千分比

当 scatype 设置为3时，该有效值为[1,250]，单位为千分比。示例：

http://examples-1251000004.cos.ap-

shanghai.myqcloud.com/sample.jpeg?

watermark/1/image/xxxxxxx/scatype/3/spcent/250

否

/dissolve

/
图片水印的透明度，取值为1 - 100，默认90（90%不透明度） 否

/batch/
平铺水印功能，可将图片水印平铺至整张图片。值为1时，表示开启平铺水印功

能
否

/degree/
当 batch 值为1时生效。图片水印的旋转角度设置，取值范围为0 - 360，默

认0
否

注意

 指定的水印图片必须同时满足如下3个条件：  

水印图片与原图片必须位于同一个存储桶下。

水印图片链接需使用 COS 域名（不能使用 CDN 加速域名，例如 

examplebucket-1250000000.file.myqcloud.com/shuiyin_2.png  不可用 ），且需保证水印图可

访问（如果水印图读取权限为私有，则需要携带有效签名）。

水印图片链接必须以 http:// 开始，不能省略 HTTP 头，也不能填 HTTPS 头，例如 

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png ，

https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/shuiyin_2.png  为非法

的水印 URL。

九宫格方位图
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说明

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：添加图片水印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/i

https://cloud.tencent.com/document/product/460/18147
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添加图片水印后效果如下：

案例二：添加图片水印并设置平铺、透明度

https://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/1/
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添加图片水印并设置旋转45度平铺、透明度为40%后，效果如下： 

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例三：添加图片水印并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

 <signature>为签名部分，获取方式请参考 请求签名 。

注意事项

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith
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文字水印
最近更新时间：2023-07-27 11:27:57

腾讯云数据万象通过 watermark 接口提供实时文字水印处理功能。

该功能支持以下的处理方式：

功能概述

下载时处理

上传时处理

云上数据处理

限制说明

支持格式：支持处理 JPG、BMP、GIF、PNG、WebP 格式，并且支持 HEIF 格式的解码和处理操作。

静图体积限制：处理图片原图大小不超过32MB、宽高不超过50000像素且总像素不超过2.5亿像素，处理结果

图宽高设置不超过50000像素。

WebP图片限制：处理图片原图大小不超过32MB、宽高不超过16383像素且总像素不超过2.5亿像素，处理结

果图宽高设置不超过16383像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

说明：

文字水印为付费服务，费用同基础图片处理，具体费用请参见 图片处理费用 。

接口示例

1. 下载时处理

GET /<ObjectKey>?watermark/2/text/<encodedText>

                            /font/<encodedFont>

                            /fontsize/<fontSize>

                            /fill/<encodedColor>

                            /dissolve/<dissolve>

                            /gravity/<gravity>

                            /dx/<dx>

                            /dy/<dy>

                            /batch/<type>

                            /degree/<degree>

                            /shadow/<shadow> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

https://cloud.tencent.com/document/product/460/58117
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Date: <GMT Date>

Authorization: <Auth String>

说明

 请忽略上面的空格与换行符。

2. 上传时处理

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

3. 云上数据处理

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

{

  "is_pic_info": 1,

  "rules": [{
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操作名称：watermark，数字2，表示水印类型为文字水印。

      "fileid": "exampleobject",

      "rule": "watermark/2/text/<encodedText>

                        /font/<encodedFont>

                        /fontsize/<fontSize>

                        /fill/<encodedColor>

                        /dissolve/<dissolve>

                        /gravity/<gravity>

                        /dx/<dx>

                        /dy/<dy>

                        /batch/<type>

                        /degree/<degree>

                        /shadow/<shadow>"

  }]

}

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

Pic-Operations 为 json 格式的字符串，具体参数信息请参见 图片持久化处理 。

当 fileid 与 ObjectKey  相同时，处理后的图片将覆盖原图存储；不相同时将分别存储原图和处理后

图片。

fileid   的值需要经过 URL 安全的 Base64 编码 。

处理参数说明

参数 含义
是否

必选

Obje

ctKe

y

对象文件名，例如 folder/sample.jpg 是

/text/ 水印内容，需要经过 URL 安全的 Base64 编码  是

/font/
水印字体，需要经过 URL 安全的 Base64 编码 ，默认值 tahoma.ttf 。水印字体列

表请参见 支持字体列表  
否

/font

size/

水印文字字体大小，单位为磅，缺省值13。如需按照原图片的大小比例缩放文字水印，

请将文字水印转换为 PNG 图片，并参见 图片水印  文档进行配置
否

/fill/ 字体颜色，缺省为灰色，需设置为十六进制 RGB 格式（例如 #FF0000），详情请参 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/19568
https://cloud.tencent.com/document/product/460/6930
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九宫格方位图可为图片的多种操作提供位置参考。红点为各区域位置的原点（通过 gravity 参数选定各区域后位移

操作会以相应原点为参照）。

见 RGB 编码表 ，需经过 URL 安全的 Base64 编码 ，默认值为 #3D3D3D

/diss

olve/
文字透明度，取值1 - 100 ，默认90（90%不透明度） 否

/grav

ity/
文字水印位置，九宫格位置（ 参见九宫格方位图 ），默认值 SouthEast 否

/dx/ 水平（横轴）边距，单位为像素，缺省值为0 否

/dy/ 垂直（纵轴）边距，单位为像素，默认值为0 否

/batc

h/
平铺水印功能，可将文字水印平铺至整张图片。值为1时，表示开启平铺水印功能 否

/spa

cing/

平铺模式下的水平、垂直间距相对文字水印贴图的宽高百分比，范围为[0,100]，默认

10
否

/degr

ee/
当 batch 值为1时生效。文字水印的旋转角度设置，取值范围为0 - 360，默认0 否

/sha

dow/
文字阴影效果，有效值为[0,100]，默认为0，表示无阴影 否

/scat

ype/

根据原图的大小，缩放调整文字水印的大小：

当 scatype 设置为1时，按原图的宽缩放

当 scatype 设置为2时，按原图的高缩放

当 scatype 设置为3时，按原图的整体面积缩放

否

/spc

ent/

与 scatype 搭配使用：

当 scatype 设置为1时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为2时，该有效值为[1, 1000]，单位为千分比

当 scatype 设置为3时，该有效值为[1, 250]，单位为千分比

否

九宫格方位图

https://www.rapidtables.com/web/color/RGB_Color.html
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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注意

当 gravity 参数设置为 center 时，dx、dy 参数无效。

当 gravity 参数设置为 north 或 south 时，dx 参数无效（水印会水平居中）。

当 gravity 参数设置为 west 或 east 时，dy 参数无效（水印会垂直居中）。

实际案例

说明

 本篇文档中的实际案例仅包含下载时处理，该类处理不会保存处理后的图片至存储桶。如有保存需求，您

可查阅 图片持久化处理  文档并配置上传时处理或云上数据处理。

案例一：添加文字水印

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?watermark/2/t

https://cloud.tencent.com/document/product/460/18147
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添加文字水印后，效果如下：

处理方式同上，仅增加签名部分，并与图片处理参数以“&”连接，示例如下：

为了避免未授权人员通过访问不携带处理参数的链接实现访问和下载原图的情况，您可同时将处理参数签入到请求签

名中，处理参数整体是参数的 key，value 为空，如下是简单的示例（仅做样式参考，可能已经过期无法直接访

问），详细计算方法请参见 请求签名 。

案例二：添加文字水印并携带私有文件签名

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature>  为签名部分，获取方式请参见 请求签名 。

注意事项

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

https://cloud.tencent.com/document/product/436/14114
https://cloud.tencent.com/document/product/436/7778
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图片盲水印
最近更新时间：2023-05-25 14:50:03

盲水印功能是指将水印以不可见的形式添加到图片中，这样的水印不会影响图片的观感，同时也保证了图片的原创

性。当发现图片被盗取后，您可以通过 提取盲水印 ，将不可见的水印提取出来，验证图片的归属。 

通过该 API 接口，您可以：

数据万象提供的盲水印功能拥有图片半盲水印、图片全盲水印和文字盲水印三种类型：

盲水印是付费服务，使用时需在相应存储桶配置页中通过开关开通服务。数据万象在每个账户首次产生该服务用量

后，将发放一个用量为6000次，有效期为2个月的免费额度资源包，超出用量或资源包到期后将正常计费。具体费

用请参见 图片处理费用 。

简介

在上传时为图片添加盲水印、提取盲水印

对 COS 上的图片添加盲水印、提取盲水印

在下载时为图片添加盲水印（不支持下载时提取盲水印）

水印类型 特性 适用场景

图片半盲水印

（type1）
抗攻击性强，但提取水印需原图

小图（640px x 640px以下）

使用

图片全盲水印

（type2）

提取方便，提取水印仅需水印图，无需对比

原图
批量添加，批量校验

文字盲水印

（type3）
可直接将文字信息添加至图片中 终端信息添加

说明

暂不支持为动图（例如 GIF 图片）添加盲水印。

使用盲水印功能，水印图的宽高不得超过原图的1/8。

为保证盲水印效果，水印图请选用黑底白色图片。

文字盲水印当前支持数字[0 - 9]及英文大小写[A - Z,a - z]。

盲水印可抵抗裁剪、涂抹、变色等多种图片盗取攻击，防盗效果与原图大小及攻击程度相关。如需详细

咨询请 提交工单 。

盲水印已支持数据万象所有地域，详情请查看 地域与域名 。

适用场景

https://cloud.tencent.com/document/product/460/19017#.E6.8F.90.E5.8F.96.E7.9B.B2.E6.B0.B4.E5.8D.B0
https://cloud.tencent.com/document/product/460/58117#.E7.9B.B2.E6.B0.B4.E5.8D.B0.E8.B4.B9.E7.94.A8
https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/460/31066
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您可对图片资源增加图片半盲水印，在发现恶意攻击方盗取您的资源后将疑似被盗取图取回，并与相应原图进行盲水

印提取操作，若能够得到有效水印图即可证明资源归属。

为解决部分用户使用其他用户资源重复上传相同信息的问题（如房产图、汽车图、商品图等），您可在用户上传图片

资源前先进行图片全盲水印提取，若提取到水印图信息则证明该图片来自之前已有资源，并进行相应操作（如提醒用

户请勿重复上传资源）；若不存在图片全盲水印则添加图片全盲水印，保护图片资源不被其他用户下载后重复上传。

对于内部分享的图片资源，您可通过文字盲水印将访问方的信息在请求图片时添加至图片中，当资源泄露后可通过流

传出的资源图提取出盲水印，进而得到泄露方信息。

图片上传时添加盲水印的请求包与 PUT Object  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用盲水印参数即可。

此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

鉴权追责

上传查重

资源防泄露

添加盲水印

请求一：上传时添加盲水印

请求示例

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

Object Content[ ]

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

参数名

称

描述 类

型

是否

必选

https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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rules（json 数组）中每一项具体参数如下：

使用盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

示例参数说明如下：

is_pic

_info
是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认为0

In

t
否

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填则

不进行图片处理

Ar

ra

y

否

参数名称 描述 类型
是否

必选

bucket
存储结果的目标存储桶名称，格式为：BucketName-APPID，如果

不指定的话默认保存到当前存储桶

Stri

ng
否

fileid

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 

p2 文件夹中存储了一个文件名为 test2.jpg 的文件。

2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一

个文件名为 test2.jpg 的文件。

3. 注意：请不要以 / 结尾，否则会产生空文件名。

Stri

ng
是

rule
处理参数，可参见图片处理 API。 若按指定样式处理，则以 style/  开

头，后加样式名，如样式名为“test”，则 rule 字段为 style/test

Stri

ng
是

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

参数

名称
描述 类型

是否

必选

type
盲水印类型，有效值：1为图片半盲水印；2为图片全盲水印；3为文字盲水

印
Int 是

imag

e

盲水印图片地址，需要经过 URL 安全的  Base64 编码。 当 type 为1或2

时必填，type 为3时无效。 指定的水印图片必须同时满足如下条件：

1. 盲水印图片与原图片必须位于同一个存储桶下；

2. URL 必须以 http://  开始，不能省略 http 头，也不能填 https 头，

Stri

ng

否
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此接口无请求参数。

此接口请求的请求体为需要添加盲水印的原文件（图片）内容。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体具体数据内容如下：

UploadResult 节点内容： 

OriginalInfo 节点内容：

例如以下地址为非法水印地址：

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

text
盲水印文字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，

type 为1或2时无效。

Stri

ng
否

level
只对图片全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值

为1，level 值越大则图片受影响程度越大、盲水印效果越好。
Int 否

请求参数

请求体

响应

响应头

响应体

参数名称 描述 类型

UploadResult 原图信息 Container

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图片处理结果 Container

节点名称 描述 类型

Key 原图文件名 String

https://cloud.tencent.com/document/product/460/42866
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ImageInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

Location 图片路径 String

ImageInfo 原图图片信息 Container

节点名称 描述 类型

Format 格式 String

Width 图片宽度 Int

Height 图片高度 Int

Quality 图片质量 Int

Ave 图片主色调 String

Orientation 图片旋转角度 Int

节点名称 描述 类型

Object 每一个图片处理结果 Container

节点名称 描述 类型

Key 文件名 String

Location 图片路径 String

Format 图片格式 String

Width 图片宽度 Int

Height 图片高度 Int

Size 图片大小 Int

Quality 图片质量 Int

实际案例

请求
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PUT /exampleobject HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

Content-Length: 64

Object Content

{

[{

}]

}

[ ]

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                   <Format>png</Format>
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图片下载时添加盲水印与添加普通水印操作相同，只需在图片访问链接后使用 watermark 参数即可。

请求参数说明如下：

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>

注意

请求体的 [Object Content] 字段为原图的图片内容(二进制字符串)，请求头 Pic-Operations 的 

rule 字段中，imageUrl 为水印图片的地址。

响应体的 ProcessResults 中的 Location 字段为处理后已经携带盲水印的图片的地址。

请求二：下载时添加盲水印

请求示例

GET /<ObjectKey>?watermark/3/type/<type>/image/<imageUrl>/text/<text> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

请求参数

参数 描述
类

型

是否

必选

Objec

tKey
对象文件名，例如 folder/sample.jpg。

Str

ing
是

type
盲水印类型，有效值：1为图片半盲水印；2为图片全盲水印；3为文字盲水

印
Int 是

image 盲水印图片地址，需要经过 URL 安全的 Base64 编码。 当 type 为1或2

时必填，type 为3时无效。 指定的水印图片必须同时满足如下条件：

1. 盲水印图片与原图片必须位于同一个存储桶下；

2. 2. URL 必须以 http:// 开始，不能省略 http 头，也不能填 https 头，

例如以下地址为非法水印地址：

examplebucket-1250000000.cos.ap-

Str

ing

否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第200 共1950页

通过 API 能够对已存储在 COS 的图片进行添加盲水印的操作，并将结果存入到 COS。

此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

shanghai.myqcloud.com/watermark.png 

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

text
盲水印文字，需要经过 URL 安全的 Base64 编码。 当 type 为3时必

填，type 为1或2时无效。

Str

ing
否

level
只对图片全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值

为1，level 值越大则图片受影响程度越大、盲水印效果越好。
Int 否

实际案例

https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/sample.jpeg?waterm

请求三：对 COS 上的图片添加盲水印

请求示例

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

参数名

称
描述

类

型

是否

必选

is_pic

_info
是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认为0

In

t
否

rules 处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填则

不进行图片处理

Ar

ra

否

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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rules（json 数组）中每一项具体参数如下：

使用盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

示例参数说明如下：

y

参数

名称
描述

类

型

是否

必选

buck

et

存储结果的目标存储桶名称，格式为：BucketName-APPID，如果不指

定的话默认保存到当前存储桶

Str

ing
否

fileid

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以 / 开头为绝对路径，例如 fileid 值为/p2/test2.jpg时，表示在p2文件

夹中存储了一个文件名为 test2.jpg 的文件。

2. 不以 / 开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在p1

文件夹中新建了一个p2文件夹，然后在p2文件夹中存储了一个文件名为 

test2.jpg 的文件。

3. 注意：请不要以 /  结尾，否则会产生空文件名。

Str

ing
是

rule
处理参数，可参见图片处理 API。 若按指定样式处理，则以 style/  开头，

后加样式名，如样式名为“test”，则 rule 字段为 style/test

Str

ing
是

watermark/3/type/<type>/image/<imageUrl>/text/<text>/level/<level>

参数 描述
类

型

是否

必选

typ

e
盲水印类型，有效值：1为图片半盲水印；2为图片全盲水印；3为文字盲水印 Int 是

ima

ge

盲水印图片地址，需要经过 URL 安全的 Base64 编码。当 type 为1或2时

必填，type 为3时无效。指定的水印图片必须同时满足如下条件：

1. 盲水印图片与原图片必须位于同一个存储桶下。

2. URL 必须以 http://  开始，不能省略 http 头，也不能填 https 头，例如

以下地址为非法水印地址：

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

Str

ing
否
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此接口无请求参数。

此接口无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体具体数据内容如下：

UploadResult 节点内容： 

OriginalInfo 节点内容： 

ImageInfo 节点内容： 

text 盲水印文字，需要经过 URL 安全的 Base64 编码。当 type 为3时必填，

type 为1或2时无效。

Str

ing

否

leve

l

只对图片全盲水印（type=2）有效。level 的取值范围为{1,2,3}，默认值为

1，level 值越大则图片受影响程度越大、盲水印效果越好。
Int 否

请求参数

请求体

响应

响应头

响应体

参数名称 描述 类型

UploadResult 原图信息 Container

参数名称 描述 类型

OriginalInfo 原图信息 Container

ProcessResults 图片处理结果 Container

节点名称 描述 类型

Key 原图文件名 String

Location 图片路径 String

ImageInfo 原图图片信息 Container

https://cloud.tencent.com/document/product/436/7729
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ProcessResults 节点内容：

Object 节点内容：

节点名称 描述 类型

Format 格式 String

Width 图片宽度 Int

Height 图片高度 Int

Quality 图片质量 Int

Ave 图片主色调 String

Orientation 图片旋转角度 Int

节点名称 描述 类型

Object 每一个图片处理结果 Container

节点名称 描述 类型

Key 文件名 String

Location 图片路径 String

Format 图片格式 String

Width 图片宽度 Int

Height 图片高度 Int

Size 图片大小 Int

Quality 图片质量 Int

实际案例

请求

POST /exampleobject?image_process HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX
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Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject",

        "rule": "watermark/3/type/1/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

Content-Length: 64

{

[{

}]

}

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

          <OriginalInfo>

              <Key>exampleobject</Key>

              <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampl

              <ImageInfo>

                   <Format>JPEG</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Quality>100</Quality>

                   <Ave>0xa18454</Ave>

                   <Orientation>1</Orientation>

              </ImageInfo>

          </OriginalInfo>

          <ProcessResults>

              <Object>

                   <Key>exampleobject</Key>

                   <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exam

                   <Format>png</Format>

                   <Width>640</Width>

                   <Height>427</Height>

                   <Size>463092</Size>

                   <Quality>100</Quality>

              </Object>

          </ProcessResults>

</UploadResult>
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上传图片并提取盲水印的请求包与 PUT Object  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用提取盲水印参数（watermark/4）即可。

此接口使用公共请求头部，详情请参见 公共请求头部  文档。

请求包头部增加图片处理参数 Pic-Operations，Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

提取盲水印

请求一：上传时提取盲水印

请求示例

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization:XXXXXXXXXXXX

Pic-Operations: <PicOperations>

Object Content[ ]

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

参数名

称
描述

类

型

是否

必选

is_pic

_info
是否返回原图信息。0表示不返回原图信息，1表示返回原图信息，默认为0

In

t
否

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填则

不进行图片处理

Ar

ra

y

否

参数名

称
描述 类型

是否

必选

bucke

t

存储结果的目标存储桶名称，格式为：BucketName-APPID，如果不

指定的话默认保存到当前存储桶

Stri

ng
否

https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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提取盲水印需在 rule 中添加水印图参数（watermark），示例格式如下：

示例参数说明如下：

此接口无请求参数。

fileid 处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以 / 开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 

文件夹中存储了一个文件名为 test2.jpg 的文件。

2. 不以 /  开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文

件名为 test2.jpg 的文件。

3. 注意：请不要以 /  结尾，否则会产生空文件名。

Stri

ng

是

rule
处理参数，请参见图片处理 API。 若按指定样式处理，则以 style/  开

头，后加样式名，如样式名为“test”，则 rule 字段为 style/test

Stri

ng
是

watermark/4/type/<type>/image/<imageUrl>

参数 描述 类型
是否

必选

typ

e

盲水印类型，有效值：1为图片半盲水印；2为图片全盲水印；3为文字盲水

印，必须跟添加盲水印时的 type 类型一致
Int 是

ima

ge

图片地址，根据 type 值填写：

image 需要经过 URL 安全的 Base64 编码，指定的图片必须同时满足如

下条件：

1. 图片与存在水印的图片必须位于同一个对象存储桶下。

2. URL 必须以  http:// 开始，不能省略 http 头，也不能填 https 头，例

如以下地址为非法水印地址：

当 type 为1，则 image 必填，且为原图图片地址

当 type 为2，则 image 必填，且为水印图地址

当 type 为3，则 image 无需填写（无效）

examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png 

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/watermark.png

Stri

ng
否

请求参数
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此接口请求的请求体为图片内容。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体的 UploadResult.ProcessResults.Object 字段中新增 WatermarkStatus 字段，当盲水印提取的请

求体中 type 参数为2时携带 WatermarkStatus 参数，其他情况不返回该参数。

请求体

响应

响应头

响应体

参数
父节

点
描述

类

型

Watermar

kStatus

Obj

ect

当 type 为2时返回该字段，表示提取到图片全盲水印的可信度。具体

为0-100的数字，75分以上表示确定有盲水印，60-75表示疑似有盲

水印，60以下可认为未提取到盲水印

Int

实际案例

请求

PUT /exampleobject1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations:

    "is_pic_info": 1,

    "rules": 

        "fileid": "exampleobject2",

        "rule": "watermark/4/type/2/image/aHR0cDovL2V4YW1wbGVzLTEyNTEwMDAwMDQu

    

Content-Length: 64

Object Content

{

[{

}]

}

[ ]

响应

https://cloud.tencent.com/document/product/436/7729
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

          <Key>exampleobject1</Key>

          <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/exampleo

          <ImageInfo>

                <Format>JPEG</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Quality>100</Quality>

                <Ave>0xa18454</Ave>

                <Orientation>1</Orientation>

                <FrameCount>1</FrameCount>

          </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

          <Object>

                <Key>exampleobject2</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/examp

                <Format>png</Format>

                <Width>640</Width>

                <Height>427</Height>

                <Size>463092</Size>

                <Quality>100</Quality>

                <FrameCount>1</FrameCount>

                <WatermarkStatus>86</WatermarkStatus>

          </Object>

      </ProcessResults>

</UploadResult>

注意

对于 type 值为1的请求，请求头 Pic-Operations 的 rule 字段中，imageUrl 为未添加盲水印的原

图地址；对于 type 值为2的请求，包头 Pic-Operations 的 rule 字段中，imageUrl 为水印图的地

址。

响应体 ProcessResults 字段的 url 为提取出来的水印图地址。
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对 COS 上的图片提取盲水印的请求包与 云上数据处理  接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations 并使用提取盲水印参数（watermark/4）即可。

请求二：对 COS 上的图片提取盲水印

https://cloud.tencent.com/document/product/436/54050#.E4.BA.91.E4.B8.8A.E6.95.B0.E6.8D.AE.E5.A4.84.E7.90.86
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异常图片检测

异常图片检测同步请求
最近更新时间：2023-08-04 14:45:42

腾讯云数据万象通过 ImageInspect 接口检测图片中是否隐含其他类型的可疑文件。

操作名称：ImageInspect。

功能概述

注意：

异常图片检测功能为收费项，由数据万象收取，详细的计费说明请参见数据万象 图片处理费用 。

限制说明

支持格式：JPG/JPEG、PNG、BMP、GIF，以及纯TS视频流（更改为任意后缀）。

静态图体积限制：可检测的原图大小不超过32MB，宽高不超过50000像素且总像素不超过2.5亿像素。

动图体积限制：原图及处理图宽 x 高 x 帧数不超过2.5亿像素。

动图帧数限制：gif 帧数限300帧。

接口示例

GET /<ObjectKey>?ci-process=ImageInspect HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

处理参数说明

请求参数

参数 含义 类型 是否必选

ObjectKey 对象文件名，例如 folder/sample.jpg String 是

响应参数

参数 含义 类型

picSize 检测的原图大小，单位为 Bytes Strin

https://cloud.tencent.com/document/product/460/58117
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该接口需要携带签名进行使用，签名与检测参数以“&”连接，示例如下：

g

picType 检测的原图类型。例如 jpg、png 等
Strin

g

suspicious
是否检测到图片格式以外的文件。false 为正常图片文件，true 表示含有其

他格式的可疑文件

Bool

ean

suspiciousBe

ginByte
检测到的可疑文件的起始字节位置，单位为 Bytes

Strin

g

suspiciousEn

dByte
检测到的可疑文件的末尾字节位置，单位为 Bytes

Strin

g

suspiciousSi

ze
检测到的可疑文件的大小

Strin

g

suspiciousTy

pe
检测到的可疑文件的类型，例如 MPEG-TS

Strin

g

实际案例

http://examples-1251000004.cos.ap-shanghai.myqcloud.com/sample.jpeg?q-sign-algorith

说明

<signature> 为签名部分，需要将检测参数也签入签名中，获取方式请参考 请求签名 。

https://cloud.tencent.com/document/product/436/7778
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异常图片检测异步任务

提交任务
最近更新时间：2023-08-17 17:55:43

提交一个异常图片检测任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>ImageInspect</Tag>

    <Input>

        <Object>input/test.png</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型  的具体数据描述如下：

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：ImageInspect

Stri

ng
是

Input
Req

uest
待操作的文件信息

Con

tain

er

是

Operation
Req

uest
操作规则

Con

tain

er

否

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Stri

ng
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型

Stri

ng
否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Stri

ng
否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig 

Con

tain

er

否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 ImageInspect 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

UserData Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng

否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Stri

ng
否

ImageInsp

ect

Request.

Operation
该任务的参数

Con

tain

er

否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

AutoProce

ss

Request.Operation

.ImageInspect

是否开启识别到图片异常后自动对图片进

行如移动到其他目录、设置为私有权限、

删除等动作。取值：true/false，默认为

false

St

ri

n

g

否

ProcessTy

pe

Request.Operation

.ImageInspect

指定检测到异常图片后的处理动作

BackupObject：将图片移动 

abnormal_images_backup下，

该目录由后台自动创建

SwitchObjectToPrivate：将图片

权限设置为私有

DeleteObject：删除图片

默认值：BackupObject

当 AutoProcess 为 true 时，该参数

生效

St

ri

n

g

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>cda071f3af9e011ed8f900133752da9af</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p3a3b198088e74b76b31d553a77b656be</QueueId>

        <Tag>ImageInspect</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.png</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code Response.J

obsDetail

错误码，只有 State 为 Failed 时有意义 Stri

ng
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Container 节点 Input 的内容：

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：ImageInspect

Stri

ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

Container 节点 ImageInspectResult 的内容：

Container 节点 ProcessResult 的内容：

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetail.O

peration
透传用户信息 String

JobLevel
Response.JobsDetail.O

peration
任务优先级 String

ImageInspect
Response.JobsDetail.O

peration

同请求中的 

Request.Operation.ImageIns

pect

Contai

ner

ImageInspect

Result

Response.JobsDetail.O

peration

异常图片检测结果，任务未完成时不

返回

Contai

ner

节点名称（关

键字）
父节点 描述 类型

State
Response.JobsDetail.Operatio

n.ImageInspectResult

当前节点的任务状态，为 

Success、Failed 其中一个

Stri

ng

Code
Response.JobsDetail.Operatio

n.ImageInspectResult

错误码，只有 State 为 Failed 时

有意义

Stri

ng

Message
Response.JobsDetail.Operatio

n.ImageInspectResult

错误描述，只有 State 为 Failed 

时有意义

Stri

ng

InputObjec

tName

Response.JobsDetail.Operatio

n.ImageInspectResult
当前节点的输入对象名

Stri

ng

InputObjec

tUrl

Response.JobsDetail.Operatio

n.ImageInspectResult
当前节点的输入对象Url

Stri

ng

ProcessRe

sult

Response.JobsDetail.Operatio

n.ImageInspectResult
当前节点的处理结果详情

Con

tain

er

节点名称（关 父节点 描述 类型
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Container 节点 AutoProcessResult 的内容：

键字）

PicSize

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测的原图大小，单位为 Bytes Int

PicType

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测的原图类型。例如 jpg、png 

等

Stri

ng

Suspicious

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

是否检测到图片格式以外的文件。

false 为正常图片文件，true 表示

含有其他格式的可疑文件

Stri

ng

Suspicious

BeginByte

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测到的可疑文件的起始字节位

置，单位为 Bytes
Int

Suspicious

EndByte

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测到的可疑文件的末尾字节位

置，单位为 Bytes
Int

Suspicious

Size

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测到的可疑文件的大小 Int

Suspicious

Type

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测到的可疑文件的类型，例如 

MPEG-TS

Stri

ng

AutoProces

sResult

Response.JobsDetail.Operatio

n.ImageInspectResult.Process

Result

检测到为可疑文件后的图片自动处

理结果

Con

tain

er

节点名称（关

键字）
父节点 描述

类

型

Code

Response.JobsDetail.Operation

.ImageInspectResult.ProcessR

esult.AutoProcessResult

自动处理结果的错误码，为 

Success、Failed 其中一个

Str

ing

Message

Response.JobsDetail.Operation

.ImageInspectResult.ProcessR

esult.AutoProcessResult

自动处理结果的错误信息，当State

为Failed时有效

Str

ing



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第219 共1950页

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

错误码

实际案例

请求：

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>ImageInspect</Tag>

    <Input>

        <Object>input/test.png</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>cda071f3af9e011ed8f900133752da9af</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

https://cloud.tencent.com/document/product/460/42867
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        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ImageInspect</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.png</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第221 共1950页

任务回调
最近更新时间：2023-08-04 16:46:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-05-24T11:12:44+0800</CreationTime>

        <EndTime>2023-05-24T11:12:45+0800</EndTime>

        <Input>

                <BucketId>test-1253960000</BucketId>

                <Object>test.png</Object>

                <Region>ap-chongqing</Region>

        </Input>

        <JobId>cda071f3af9e011ed8f900133752da9af</JobId>

        <Message/>

        <Operation>

            <ImageInspectResult>

                <Code>Success</Code>

                <InputObjectName>test.png</InputObjectName>

                <InputObjectUrl>https://.cos.ap-chongqing.myqcloud.com/test.png</InputObje

                <Message/>

                <ProcessResult>

                    <PicSize>304491</PicSize>

                    <PicType>png</PicType>

                    <Suspicious>true</Suspicious>

                    <SuspiciousBeginByte>119</SuspiciousBeginByte>

                    <SuspiciousEndByte>304490</SuspiciousEndByte>

                    <SuspiciousSize>304372</SuspiciousSize>

                    <SuspiciousType>MPEG-TS</SuspiciousType>

                    <AutoProcessResult>

                        <Code>Success</Code>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

                        <Message>Success</Message>

                    </AutoProcessResult>

                </ProcessResult>

                <State>Success</State>

            </ImageInspectResult>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p3a3b198088e74b76b31d553a77b656be</QueueId>

        <StartTime>2023-05-24T11:12:45+0800</StartTime>

        <State>Success</State>

        <Tag>ImageInspect</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respons

e
固定值，为 TaskFinish String

JobsDetail
Respons

e

同提交异常图片检测任务接口中的 

Response.JobsDetail  

Container 

数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.Cos

Headers
自定义 Header 的名称

Strin

g

Value
Response.JobsDetail.Input.Cos

Headers
自定义 Header 的值

Strin

g

https://cloud.tencent.com/document/product/460/95980#JobsDetail
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Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-05-24T11:12:44+0800</CreationTime>

        <EndTime>2023-05-24T11:12:45+0800</EndTime>

        <Input>

                <BucketId>test-1253960000</BucketId>

                <Object>test.png</Object>

                <Region>ap-chongqing</Region>

        </Input>

        <JobId>cda071f3af9e011ed8f900133752da9af</JobId>

        <Message/>

        <Operation>

            <ImageInspectResult>

                <Code>Success</Code>

                <InputObjectName>test.png</InputObjectName>

                <InputObjectUrl>https://test-1253960000.cos.ap-chongqing.myqcloud.com/tes

                <Message/>

                <ProcessResult>

                    <PicSize>304491</PicSize>

                    <PicType>png</PicType>

                    <Suspicious>true</Suspicious>

                    <SuspiciousBeginByte>119</SuspiciousBeginByte>

                    <SuspiciousEndByte>304490</SuspiciousEndByte>

                    <SuspiciousSize>304372</SuspiciousSize>

                    <SuspiciousType>MPEG-TS</SuspiciousType>

                    <AutoProcessResult>

                        <Code>Success</Code>
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                        <Message>Success</Message>

                    </AutoProcessResult>

                </ProcessResult>

                <State>Success</State>

            </ImageInspectResult>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p3a3b198088e74b76b31d553a77b656be</QueueId>

        <StartTime>2023-05-24T11:12:45+0800</StartTime>

        <State>Success</State>

        <Tag>ImageInspect</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"  

    "JobsDetail": 

        

            "Code": "Success"  

            "CreationTime": "2023-05-24T14:24:07+0800"  

            "EndTime": "2023-05-24T14:24:08+0800"  

            "Input": 

                "BucketId": "testpic-1253960000"  

                "Object": "test.png"  

                "Region": "ap-chongqing"

             

            "JobId": "c966a67d0f9fb11eda05029775a03955f"  

            "Message": ""  

            "Operation": 

                "ImageInspectResult": 

                    

                        "Code": "Success"  

                        "InputObjectName": "test.png"  

                        "InputObjectUrl": "https://testpic-1253960000.cos.ap-chongqing.myqcloud

                        "Message": ""  

                        "ProcessResult": 

                            "PicSize": 304491  

                            "PicType": "png"  

                            "Suspicious": true  

                            "SuspiciousBeginByte": 119  

                            "SuspiciousEndByte": 304490  

{

,

[

{

,

,

,

{

,

,

},

,

,

{

[

{

,

,

,

{

,

,

,

,

,
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                            "SuspiciousSize": 304372  

                            "SuspiciousType": "MPEG-TS"

                         

                        "State": "Success"

                    

                 

                "JobLevel": "0"  

             

            "QueueId": "p3a3b198088e74b76b31d553a77b656be"  

            "StartTime": "2023-05-24T14:24:08+0800"  

            "State": "Success"  

            "Tag": "ImageInspect"

        

    

,

},

}

],

,

},

,

,

,

}

]

}
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图片异步处理

提交任务
最近更新时间：2023-06-20 17:32:21

提交一个图片处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是

否

必

选

Tag
Req

uest
创建任务的 Tag：PicProcess

Strin

g
是

Input
Req

uest
待操作的文件信息

Cont

ainer
是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Strin

g
否

CallBack

Type

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列

的回调类型

Strin

g
否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBack

MqConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Operation 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

节点名

称（关

键字）

父节点 描述 类型

是

否

必

选

Templ

ateId

Request.Opera

tion
模板 ID

Strin

g
否

PicPr

ocess

Request.Opera

tion

该任务的参数，同创建图片处理模板接口中的 

Request.PicProcess  

Cont

ainer
否

Outpu

t

Request.Opera

tion
结果输出配置

Cont

ainer
是

User

Data

Request.Opera

tion

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Strin

g
否

JobLe

vel

Request.Opera

tion

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Strin

g
否

注意

优先使用 TemplateId，无 TemplateId 时使用 PicProcess。

节点名称（关键字） 父节点 描述 类型 是否必选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket
Request.Operation.Out

put
存储结果的存储桶

Strin

g
是

Object
Request.Operation.Out

put
结果文件的名字

Strin

g
是

响应

响应头

https://cloud.tencent.com/document/product/460/84735#PicProcess
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 JobsDetail 的内容：

Container 节点 Input 的内容：

JobsDetail Response 任务的详细信息 Container

节点名称（关

键字）
父节点 描述 类型

Code
Response.Jo

bsDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.Jo

bsDetail
新创建任务的 ID String

Tag
Response.Jo

bsDetail
新创建任务的 Tag：PicProcess String

State
Response.Jo

bsDetail

任务的状态，为 Submitted、Running、

Success、Failed、Pause、Cancel 其中一个
String

CreationTi

me

Response.Jo

bsDetail
任务的创建时间 String

StartTime
Response.Jo

bsDetail
任务的开始时间 String

EndTime
Response.Jo

bsDetail
任务的结束时间 String

QueueId
Response.Jo

bsDetail
任务所属的队列 ID String

Input
Response.Jo

bsDetail
该任务的输入资源地址

Conta

iner

Operation
Response.Jo

bsDetail
该任务的规则

Conta

iner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第231 共1950页

Container 节点 Operation 的内容：

Container 节点 PicProcessResult 的内容： 

同 图片持久化处理  接口中的 UploadResult 节点。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail.O

peration
任务的模板 ID String

TemplateNa

me

Response.JobsDetail.O

peration

任务的模板名称, 当 TemplateId 存

在时返回
String

PicProcess
Response.JobsDetail.O

peration

同请求中的 

Request.Operation.PicProcess

Contai

ner

Output
Response.JobsDetail.O

peration

同请求中的 

Request.Operation.Output

Contai

ner

PicProcessR

esult

Response.JobsDetail.O

peration

图片处理后输出图片的信息，没有时不

返回

Contai

ner

UserData
Response.JobsDetail.O

peration
透传用户信息 String

错误码

实际案例

请求1：使用图片处理模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

https://cloud.tencent.com/document/product/460/18147
https://cloud.tencent.com/document/product/460/42867
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        <Object>input/deer.jpg</Object>

    <Operation>

        <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>
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                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用图片处理处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Input>

        <Object>input/deer.jpg</Object>

    <Operation>

         <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第234 共1950页

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PicProcess</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcess>

                <IsPicInfo>true</IsPicInfo>

                <ProcessRule>imageMogr2/rotate/90</ProcessRule>

            </PicProcess>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-02-07 14:08:52

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交图片处理任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

节点名称（关键

字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/84793#jobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>
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                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>

            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>2022-07-18T15:16:44+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>
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                <Key>Content-Type</Key>

                <Value>image/jpeg</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1024</Value>

            </CosHeaders>

        </Input>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PicProcessResult>

                <ObjectName>output/out.jpg</ObjectName>

                <OriginalInfo>

                    <Etag>"d5a491cd3d8d071e3212c3478e8e35a1"</Etag>

                    <ImageInfo>

                        <Ave>0xc64847</Ave>

                        <Format>JPEG</Format>

                        <Height>417</Height>

                        <Orientation>0</Orientation>

                        <Quality>68</Quality>

                        <Width>500</Width>

                    </ImageInfo>

                </OriginalInfo>

                <ProcessResult>

                    <Etag/>

                    <Format>JPEG</Format>

                    <Height>500</Height>

                    <Quality>68</Quality>

                    <Size>24911</Size>

                    <Width>417</Width>

                </ProcessResult>
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            </PicProcessResult>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my PicProcess job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <StartTime>2022-07-18T15:16:44+0800</StartTime>

        <State>Success</State>

        <Tag>PicProcess</Tag>

        <Workflow>

            <Name>PicProcess_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-07-18T15:16:43+0800",

        "EndTime": "2022-07-18T15:16:44+0800",

        "Input": {

            "BucketId": "test-1234567890",

            "Object": "input/deer.jpg",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "image/jpeg"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {
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                    "Key": "Size",

                    "Value": "1024"

                }

            ]

        },

        "JobId": "c93984788066911ed89ed352d4d9d2084",

        "Operation": {

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "output/out.jpg",

                "Region": "ap-chongqing"

            },

            "PicProcessResult": {

                "ObjectName": "output/out.jpg",

                "OriginalInfo": {

                    "Etag": "\"d5a491cd3d8d071e3212c3478e8e35a1\"",

                    "ImageInfo": {

                        "Ave": "0xc64847",

                        "Format": "JPEG",

                        "Height": "417",

                        "Orientation": "0",

                        "Quality": "68",

                        "Width": "500"

                    }

                },

                "ProcessResult": {

                    "Format": "JPEG",

                    "Height": "500",

                    "Quality": "68",

                    "Size": "24911",

                    "Width": "417"

                }

            },

            "TemplateId": "t10461fe2bd5a649db9022452ec71e0381",

            "TemplateName": "test",

            "UserData": "This is my PicProcess job.",

            "JobLevel": 0,

        },

        "QueueId": "p2911917386e148639319e13c285cc774",

        "StartTime": "2022-07-18T15:16:44+0800",

        "State": "Success",

        "Tag": "PicProcess",

        "Workflow": {

            "Name": "PicProcess_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",
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            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模板
最近更新时间：2023-08-17 11:05:43

创建图片处理模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

 

 

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Container 类型 Request 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Tag
Reque

st
模板类型：PicProcess String 是

Name
Reque

st

模板名称，仅支持中文、英文、数

字、_、-和*，长度不超过 64
String 是

PicProcess
Reque

st
图片处理参数

Containe

r
是

Container 类型PicProcess 的具体数据描述如下：

节点名称（关

键字）
父节点 描述 类型

默认

值

是否必

选

IsPicInfo
Request.Pic

Process

是否返回原图信息，取值 

true/false

Strin

g
false 否

ProcessRul

e

Request.Pic

Process

图片处理规则

基础图片处理参见 基础图片处

理 文档

图片压缩参见 图片压缩  文档

盲水印参见 盲水印  文档

Strin

g
无 是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/44879
https://cloud.tencent.com/document/product/436/60450
https://cloud.tencent.com/document/product/436/46782
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具体的数据内容如下：

 

 

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606hgd52148c4ab182ffds5163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Container 节点 Response 的内容：

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Container 节点 Template 的内容：

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa

te
模板 ID String

Name
Response.Templa

te
模板名称 String

BucketId
Response.Templa

te
模板所属存储桶 String

Category
Response.Templa

te
模板属性，Custom 或者 Official String

Tag
Response.Templa

te
模板类型，PicProcess String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UpdateTime Response.Templa

te

更新时间 String

CreateTime
Response.Templa

te
创建时间 String

PicProcess
Response.Templa

te

同请求体中的 

Request.PicProcess

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

https://cloud.tencent.com/document/product/460/42867
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        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-06-20 17:32:26

更新图片处理模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建图片处理模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建图片处理模板接口的 Response  Container

错误码

实际案例

请求

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84735
https://cloud.tencent.com/document/product/460/84735
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>PicProcess</Tag>

    <Name>TemplateName</Name>

    <PicProcess>

        <IsPicInfo>true</IsPicInfo>

        <ProcessRule>imageMogr2/rotate/90</ProcessRule>

    </PicProcess>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>PicProcess</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <PicProcess>

            <IsPicInfo>true</IsPicInfo>

            <ProcessRule>imageMogr2/rotate/90</ProcessRule>

        </PicProcess>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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海报合成任务

海报合成模板接口

查询模板接口

查询海报模板
最近更新时间：2023-03-20 17:59:53

查询海报合成模板接口。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /posterproduction/template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <Template>

        <TemplateId>A</TemplateId>

        <Height></Height>

        <Width></Width>

        <Name></Name>

        <Thumb></Thumb>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关

键字）
父节点 描述 类型

RequestId
Respo

nse
请求的唯一 ID String

Template
Respo

nse

模板具体可替换参数，该 Container 中的参数根据具体模板

中可替换的参数返回

Contai

ner

错误码

实际案例

请求

GET /posterproduction/template/62e27c0cd73bf6bb0e903721 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <TemplateId>62e27c0cd73bf6bb0e903721</TemplateId>

        <width>1280</width>,

        <height>720</height>

        <name>央视频下载观看1<name>

        <thumb>https://static.taishan.qq.com/xrdnest/psd/e9c62e867425f9188f86a319b1fd

    </Template>

</Response>
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批量拉取海报模板
最近更新时间：2022-12-22 10:07:37

查询海报合成模板列表接口。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

参数的具体内容如下：

功能描述

请求

请求示例

GET /posterproduction/template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求体

请求参数

节点名称（关

键字）

父

节

点

描述 类型
必

选

pageNumb

er
无 第几页，默认值:1

Inte

ger
否

pageSize 无 每页个数，默认值:10
Inte

ger
否

categoryId 无 Stri 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

s 模板分类ID，支持传入多个，以 , 符号分割字符串 ng

type 无
Official(系统预设模板)，Custom(自定义模板)，All(所有模

板)，默认值: Custom

Stri

ng
否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>A</TemplateId>

        <Height></Height>

        <Width></Width>

        <Name></Name>

        <Thumb></Thumb>

    </TemplateList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
模板总数 Int

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

PageNumber Respons

e

当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

TemplateList
Respons

e

模板数组，Container中参数为模板具体参

数

Container 数

组

错误码

实际案例

请求

GET /posterproduction/template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>62e27c0cd73bf6bb0e903721</TemplateId>

        <width>1280</width>,

        <height>720</height>

        <name>央视频下载观看1<name>

        <thumb>https://static.taishan.qq.com/xrdnest/psd/e9c62e867425f9188f86a319b1fd

    </TemplateList>

https://cloud.tencent.com/document/product/460/42867
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    <TemplateList>

        <TemplateId>62e279bad73bf6bb0e903707</TemplateId>

        <width>1125</width>,

        <height>1125</height>

        <name>0点折上折<name>

        <thumb>https://static.taishan.qq.com/xrdnest/psd/e9c62e867425f9188f86a319b1fd

    </TemplateList>

</Response>
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删除模板接口
最近更新时间：2023-03-23 10:51:15

删除模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

功能描述

请求

请求实例

DELETE /posterproduction/template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

公共头部

非公共头部

请求体

响应

响应头

公共响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
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该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

特有响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TemplateId>A</TemplateId>

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TemplateId Response 被删除的模板的 ID String

错误码

实际案例

请求

DELETE /posterproduction/template/t143ae6e040af6431aa772c9ec3f0a3f36 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/460/42867
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Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=

<Response>

    <RequestId>NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=</RequestId>

    <TemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</TemplateId>

<Response>
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上传文件解析模板接口
最近更新时间：2023-03-23 10:51:19

解析保存 PSD 文件模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求实例

POST /posterproduction/template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

公共头部

非公共头部

请求体

<Request>

    <Input>

        <Object></Object>

    </Input>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据d描述如下：

该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应无特殊的响应头。

    <Name></Name>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键

字）
父节点 描述 类型

必

选

Input
Reque

st
输入参数

Contain

er
是

Name
Reque

st
模板名称 String 是

CategoryIds
Reque

st
模板分类 ID，支持传入多个，以 ,  符号分割

字符串
String 否

节点名称（关键

字）
父节点 描述 类型

必

选

默认

值

限

制

Object
Request.In

put

COS 桶中 PSD 文件，大小限

制100M

Stri

ng
是 无 无

响应

响应头

公共响应头

特有响应头

响应体

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第263 共1950页

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Template 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <RequestId></RequestId>

    <Template>

        <Info>

            <Backgroud></Backgroud>

            <EXPIRY></EXPIRY>

            <MM></MM>

            <YY></YY>

            <base></base>

        </Info>

        <TemplateId></TemplateId>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求 ID Container

Template Response 解析出的 PSD 文件的具体内容 Container

节点名称（关键字） 父节点 描述 类型

Info Response 模板内容 Container

TemplateId Response 模板 ID String

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
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请求

POST /posterproduction/template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Input>

        <Object>demo.psd</Object>

    </Input>

    <Name></Name>

    <CategoryIds>61849dcf18044201b378f699,61849dcf18044201b378f69b</CategoryId

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=</RequestId>

    <Template>

        <Info>

            <Background>https://background.png</Background>

            <EXPIRY>EXPIRY</EXPIRY>

            <MM>MM</MM>

            <YY>YY</YY>

            <base>https://example.png</base>

        </Info>

        <TemplateId>634f9a1a412c273727f440fd</TemplateId>

    </Template>

</Response>
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海报合成任务接口

查询海报合成任务

查询海报合成任务
最近更新时间：2023-03-07 09:41:54

查询指定的任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /pic_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参考 图片处理  

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

  <JobsDetail>

  </JobsDetail>

  <NonExistJobIds></NonExistJobIds>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons

e
任务的详细信息

Containe

r

NonExistJobIds
Respons

e

查询的 ID 中不存在任务，所有任务都存在时不返

回
String

错误码

实际案例

请求

GET /pic_jobs/c93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

https://cloud.tencent.com/document/product/460/77012#jobsDetail
https://cloud.tencent.com/document/product/460/42867
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Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PosterProduction</Tag>

        <Operation>

            <PosterProduction>

                <TemplateId>6324349b569067d4d11a2c2c</TemplateId>

                <Info>

                    <Background>https://static.taishan.qq.com/xrdnest/pstemplate/assets/e96c

                    <EXPIRY>EXPIRY</EXPIRY>

                    <MM>MM</MM>

                    <YY>YY</YY>

                    <base>https://static.taishan.qq.com/xrdnest/pstemplate/assets/ba20649807

                </Info>

            </PosterProduction>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.png</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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批量拉取海报合成任务
最近更新时间：2023-03-07 09:41:09

拉取符合条件的任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

参数的具体内容如下：

功能描述

请求

请求示例

GET /pic_jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

节点名称（关键

字）

父节

点
描述 类型

是否必

选

queueId 无 拉取该队列 ID 下的任务
Strin

g
是

tag 无 任务的 Tag
Strin

g
是

workflowId 无 触发该任务的工作流ID Strin 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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tag 支持以下几种类型:

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

g

inventoryTrig

gerJobId
无 触发该任务的存量触发任务ID

Strin

g
否

inputObject 无 该任务的输入文件名，暂仅支持精确匹配
Strin

g
否

orderByTime 无 Desc 或者 Asc。默认为 Desc
Strin

g
否

nextToken 无 请求的上下文，用于翻页。上次返回的值
Strin

g
否

size 无 拉取的最大任务数。默认为10。最大为100
Integ

er
否

states 无
拉取该状态的任务，以 , 分割，支持多状态：All、

Submitted、Running、Success、Failed、

Pause、Cancel。默认为 All

Strin

g
否

startCreation

Time
无

拉取创建时间大于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z ，示例：2001-

01-01T00:00:00+0800

Strin

g
否

endCreationT

ime
无

拉取创建时间小于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z ，示例：2001-

01-01T23:59:59+0800

Strin

g
否

任务类型 tag

图片处理 PicProcess

图片处理 PosterProduction

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <JobsDetail>

        .

    </JobsDetail>

    <NextToken></NextToken>

</Response>

..

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container数组

NextToken Response 翻页的上下文 Token String

图片处理

错误码

实际案例

请求

GET /pic_jobs?queueId=p2911917386e148639319e13c285cc774&tag=PicProcess HTTP/1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/77012#jobsDetail
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Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PosterProduction</Tag>

        <Operation>

            <PosterProduction>

                <TemplateId>6324349b569067d4d11a2c2c</TemplateId>

                <Info>

                    <Background>https://static.taishan.qq.com/xrdnest/pstemplate/assets/e96c

                    <EXPIRY>EXPIRY</EXPIRY>

                    <MM>MM</MM>

                    <YY>YY</YY>

                    <base>https://static.taishan.qq.com/xrdnest/pstemplate/assets/ba20649807

                </Info>

            </PosterProduction>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.png</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第272 共1950页

        <Tag>PosterProduction</Tag>

        <Operation>

            <PosterProduction>

                <TemplateId>6324349b569067d4d11a2c2c</TemplateId>

                <Info>

                    <Background>https://static.taishan.qq.com/xrdnest/pstemplate/assets/e96c

                    <EXPIRY>EXPIRY</EXPIRY>

                    <MM>MM</MM>

                    <YY>YY</YY>

                    <base>https://static.taishan.qq.com/xrdnest/pstemplate/assets/ba20649807

                </Info>

            </PosterProduction>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.png</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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取消海报合成任务
最近更新时间：2023-06-19 16:47:02

取消一个任务，只有未执行的任务才可以被取消。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无响应体。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

功能描述

请求

请求示例

PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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实际案例

请求

PUT /jobs/c93984788066911ed89ed352d4d9d2084?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=
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提交海报合成任务
最近更新时间：2023-06-21 16:50:53

提交一个图片处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /pic_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>PosterProduction</Tag>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <PosterProduction>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Info>

                <main>https://test-123456789.cos.ap-chongqing.myqcloud.com/demo.jpg</m

                <text_main>demo</text_main>

            </Info>

        </PosterProduction>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键

字）

父节

点
描述 类型

是否

必选

Tag
Requ

est
创建任务的 Tag：PicProcess

Strin

g
是

Input
Requ

est
待操作的媒体信息

Cont

ainer
是

Operation
Requ

est
操作规则

Cont

ainer
是

QueueId
Requ

est
任务所在的队列 ID

Strin

g
否

CallBackFor

mat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式

Strin

g
否

CallBackTyp

e

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级

高于队列的回调类型

Strin

g
否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackMq Requ 任务回调TDMQ配置，当 CallBackType 为 Cont 否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 PosterProduction 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

Config est TDMQ 时必填。详情见 CallBackMqConfig ainer

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 媒体文件名 String 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

PosterPro

duction

Request.Op

eration
指定该任务的参数

Conta

iner
否

Output
Request.Op

eration
结果输出地址

Conta

iner
是

UserData
Request.Op

eration

透传用户信息, 可打印的 ASCII 码, 长度不超

过1024
String 否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0
String 否

节点名

称（关

键字）

父节点 描述 类型
是否

必选

Templ

ateId

Request.Operation.Post

erProduction
海报合成任务模板 ID String 是

Info
Request.Operation.Post

erProduction

模板可替换信息，同 查询海报合成

模板接口  中的 

Response.Template ，Info 中

的图片 URL 需要保证可访问，如有

特殊字符需要 URLencode

Conta

iner
是

节点名称（关键字） 父节点 描述 类型
是否

必选

Region Request.Operation.Out 存储桶的地域 String 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/82386
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

put

Bucket
Request.Operation.Out

put
存储结果的存储桶 String 是

Object
Request.Operation.Out

put
结果文件的名字 String 是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PosterProduction</Tag>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <PosterProduction>

                <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            </PosterProduction>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

节点名称

（关键字）
父节点 描述 类型

Code
Response.Jo

bsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.Jo

bsDetail
新创建任务的 ID

Strin

g

Tag
Response.Jo

bsDetail
新创建任务的 Tag：PicProcess

Strin

g

State
Response.Jo

bsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Strin

g

CreationT

ime

Response.Jo

bsDetail
任务的创建时间

Strin

g

StartTime
Response.Jo

bsDetail
任务的开始时间

Strin

g

EndTime
Response.Jo

bsDetail
任务的结束时间

Strin

g

QueueId
Response.Jo

bsDetail
任务所属的队列 ID

Strin

g

Input
Response.Jo

bsDetail
该任务的输入资源地址

Cont

ainer
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Container 节点 PosterProdcution 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Operation Response.Jo

bsDetail

该任务的规则 Cont

ainer

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail.

Operation
任务的模板 ID String

TemplateNam

e

Response.JobsDetail.

Operation

任务的模板名称, 当 TemplateId 存在

时返回
String

PosterProduct

ion

Response.JobsDetail.

Operation
海报合成参数

Conta

iner

Output
Response.JobsDetail.

Operation

同请求中的 

Request.Operation.Output

Conta

iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

节点名称（关键

字）
父节点 描述 类型

是否必

选

TemplateId
Request.Operation.PosterPr

oduction

海报合成任务模板 

ID

Stri

ng
否

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
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请求1：使用图片处理模板 ID

POST /pic_jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>PosterProduction</Tag>

    <Operation>

        <PosterProduction>

            <TemplateId>6324349b569067d4d11a2c2c</TemplateId>

            <Info>

                <Background>https://static.taishan.qq.com/xrdnest/pstemplate/assets/e96c14

                <EXPIRY>EXPIRY</EXPIRY>

                <MM>MM</MM>

                <YY>YY</YY>

                <base>https://static.taishan.qq.com/xrdnest/pstemplate/assets/ba206498074a

            </Info>

        </PosterProduction>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.jpg</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8z****

<Response>
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>c93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>PosterProduction</Tag>

        <Operation>

            <PosterProduction>

                <TemplateId>6324349b569067d4d11a2c2c</TemplateId>

                <Info>

                    <Background>https://static.taishan.qq.com/xrdnest/pstemplate/assets/e96c

                    <EXPIRY>EXPIRY</EXPIRY>

                    <MM>MM</MM>

                    <YY>YY</YY>

                    <base>https://static.taishan.qq.com/xrdnest/pstemplate/assets/ba20649807

                </Info>

            </PosterProduction>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/out.png</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t10461fe2bd5a649db9022452ec71e0381</TemplateId>

            <TemplateName>test</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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异步服务和队列配置

开通图片处理（异步）服务
最近更新时间：2023-08-01 16:46:27

本接口用于开通图片处理（异步）服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /picbucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 PicBucket 的内容：

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <PicBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </PicBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

PicBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.PicBucket 存储桶 ID String

Name Response.PicBucket 存储桶名称，同 BucketId String

Region Response.PicBucket 所在的地域 String

CreateTime Response.PicBucket 创建时间 String

实际案例

请求

POST /picbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <PicBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </PicBucket>

</Response>
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查询图片处理（异步）服务
最近更新时间：2023-08-01 16:46:27

本接口用于查询已经开通图片处理（异步）功能的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /picbucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述

默

认

值

是否

必填

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域

以“,”分隔字符串，详情请参见 地域与域名  
无 否

bucketNam

es
存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 无 否

bucketNam 存储桶名称前缀，前缀搜索 无 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第287 共1950页

此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

e

pageNumb

er
第几页 1 否

pageSize 每页个数，大于0且小于等于100 的整数 10 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <PicBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </PicBucketList>

    <PicBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </PicBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 PicBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码 文档。

RequestId Respon

se

请求的唯一 ID String

TotalCount
Respon

se
开通图片处理（异步）服务的 Bucket 总数 Int

PageNumber
Respon

se
当前页数，同请求中的 pageNumber Int

PageSize
Respon

se
每页个数，同请求中的 pageSize Int

PicBucketList
Respon

se
异步图片处理 Bucket 详情

Contain

er 数组

节点名称（关

键字）
父节点 描述 类型

BucketId
Response.PicBucke

tList
存储桶 ID

Strin

g

Name
Response.PicBucke

tList
存储桶名称，同 BucketId

Strin

g

Region
Response.PicBucke

tList
所在的地域

Strin

g

CreateTime
Response.PicBucke

tList
创建时间

Strin

g

错误码

实际案例

请求

GET /picbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2021 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <PicBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </PicBucketList>

    <PicBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </PicBucketList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第290 共1950页

关闭图片处理（异步）服务
最近更新时间：2023-08-01 16:46:27

本接口用于关闭图片处理（异步）服务并删除队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /picbucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

BucketName Response 存储桶名称 String

错误码

实际案例

请求

DELETE /picbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42867
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</Response>
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查询图片处理（异步）队列
最近更新时间：2023-08-01 16:46:22

本接口用于查询图片处理（异步）队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /picqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述

类

型

是否

必选

queueIds 队列 ID，以“,”符号分割字符串
Str

ing
否

state

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度执行，队列内的所有作

业状态维持在暂停状态，已经执行中的任务不受影响

Str

ing
否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

具体的数据内容如下：

pageNumb

er

第几页，默认值1 Str

ing

否

pageSize 每页个数，默认值10
Str

ing
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
队列总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

QueueList
Respons

e
队列数组

Container 数

组

NonExistPIDs
Respons

e
不存在的队列 ID 列表 String 数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi

st
队列名字 String

State
Response.QueueLi

st
当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi

st
队列最大长度 Int

MaxConcurrent
Response.QueueLi

st
当前队列最大并行执行的任务数 Int

Category Response.QueueLi

st

队列类型 String
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UpdateTime
Response.QueueLi

st
更新时间 String

CreateTime
Response.QueueLi

st
创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.Notify

Config
回调地址 String

State
Response.QueueList.Notify

Config
开关状态 String

Type
Response.QueueList.Notify

Config
回调类型 String

Event
Response.QueueList.Notify

Config
回调事件 String

ResultFormat
Response.QueueList.Notify

Config
回调类型 String

MqMode
Response.QueueList.Notify

Config
TDMQ 使用模式 String

MqRegion
Response.QueueList.Notify

Config
TDMQ 所属园区 String

MqName
Response.QueueList.Notify

Config
TDMQ 主题名称 String

错误码

实际案例

请求

GET /picqueue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>PicProcessing</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>
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更新图片处理（异步）队列
最近更新时间：2023-08-01 16:46:22

本接口用于更新图片处理（异步）的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /picqueue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值
限

制

Request 无 保存结果的容器
Contain

er
是 无 无

节点名称（关

键字）

父节

点
描述 类型

默

认

值

是否

必选

Name
Req

uest

队列名称，仅支持中文、英文、数字、_、-和

*，长度不超过 128

Strin

g
无 是

State
Req

uest

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度

执行，队列内的所有作业状态维持在暂停状

态，已经执行中的任务不受影响

Strin

g
无 是

NotifyConf

ig

Req

uest
回调配置

Cont

ainer
无 是

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否必选

State
Request.No

tifyConfig

回调开关

Off

On

Str

ing
Off 否

Event
Request.No

tifyConfig

回调事件

TaskFinish：任务完成

WorkflowFinish：工作流

完成

Str

ing
无

当 State=On 

时，必选

ResultFor

mat

Request.No

tifyConfig

回调格式

XML

JSON

Str

ing

XM

L

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Type
Request.No

tifyConfig

回调类型

Url

TDMQ

Str

ing
无

当 State=On 

时，必选

Url
Request.No

tifyConfig
回调地址，不能为内网地址。

Str

ing
无

当 

State=On，

且 Type=Url 

时，必选

MqMode
Request.No

tifyConfig

TDMQ 使用模式

Topic：主题订阅

Queue: 队列服务

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

MqRegion
Request.No

tifyConfig

TDMQ 所属园区，目前支持园

区 sh（上海）、bj（北京）、

gz（广州）、cd（成都）、hk

（中国香港）

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

MqName
Request.No

tifyConfig
TDMQ 主题名称

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>PicProcessing</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键字） 父节点 描述 类型

QueueId
Response.Queu

e
队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu

e
当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu

e

回调配置，同 

Request.NotifyConfig

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxSize Response.Queu

e

队列最大长度 Int

MaxConcurrent
Response.Queu

e
当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /file_queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-pic</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-pic</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>PicProcessing</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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媒体处理

媒体处理机制介绍
最近更新时间：2023-06-21 16:50:53

数据万象提供了一套完善便捷的媒体处理机制，通过这套机制可以对存储在对象存储 COS 中的媒体对象进行各类

型处理操作。

媒体处理机制分为以下几种方式：

您可以在每次提交媒体处理任务时，灵活地配置 媒体处理任务所需参数 。

简介

方式 类别 说明

通过裸参数提交任务
持久化处

理

提交媒体处理任务，并在提交任务时设置好 媒体处理任务所需参

数 。

通过模板设置提交任

务

持久化处

理

于提交媒体处理任务前设置好处理模板，并在提交任务 选择所需模

板 。

工作流处理
持久化处

理

可将不同的任务类型组合成为工作流，将工作流设置好并开启工作流

后，上传 COS 后的文件会 自动触发工作流处理流程 。

批量处理
持久化处

理

针对 COS 上已经存在的数据进行批量处理，处理方式与提交任务类

似，确认需要处理的数据范围与处理类型后 提交批量任务 。

同步任务 同步处理 在媒体对象的 URL 后加上 媒体处理参数 。

通过裸参数提交任务

说明

 通过裸参数提交任务时不需要设置模板。

请求语法

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/76856
https://cloud.tencent.com/document/product/460/80155
https://cloud.tencent.com/document/product/460/49283
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<body>

请求示例：通过裸参数提交音视频转码任务

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

            <AudioMixArray>
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                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>
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            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

返回

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>
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        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>
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                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>
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通过设置模板  能帮助您简化操作，设置模板后，您后期在业务中可以多次复用，帮助您提升处理效率。

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

通过模板设置提交任务

请求语法

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

请求示例：设置模板后提交音视频转码任务

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/84733
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Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>
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返回内容

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>
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工作流可将不同任务节点进行组合以适配您的业务，您将文件上传 COS 时可 自动触发工作流处理 ，并将结果存入

到 COS。

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

工作流处理

请求语法

POST /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

请求示例：对于输入的视频进行截图和转码处理。转码后, 同时转封装和生成智能封面, 最

后做图片处理。

POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

https://cloud.tencent.com/document/product/460/76856
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Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>
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                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

{ }

{ }

{ }
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

{ }

返回内容

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>
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                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

{ }
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批量任务处理可对已上传 COS 的历史文件进行单任务类型处理或按照工作流中配置的操作自动化处理，您可指定

处理的数据范围后 提交批量任务 。

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

{ }

{ }

{ }

批量处理

请求语法

https://cloud.tencent.com/document/product/460/76843
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POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

请求示例：提交一个音视频转码批量任务

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

返回
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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您可以通过在媒体文件的 URL 后加上 媒体处理参数，实现访问视频文件的时候 同步获取视频截帧  、封面等功

能。

同步任务

请求示例1：通过 GET 请求方式

https://<BucketName-APPID>.cos.<Region>.myqcloud.com/for-test.mp4?ci-process=sna

请求示例2：通过 URL 地址添加参数方式

GET /<ObjectKey>?ci-process=snapshot&time=1&format=jpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

https://cloud.tencent.com/document/product/460/49283
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媒体处理接口列表
最近更新时间：2023-07-12 16:55:02

任务是一个抽象的概念，媒体处理包含多种类型的任务，如转码任务、截图任务、媒体信息任务等。

在一个任务中，包含3个关键信息：输入、输出和参数。输入和输出设置任务执行时的输入文件以及执行后的目标文

件，参数则用来设置执行具体功能的详细配置。

任务包含同步模式和异步模式：

任务接口

同步任务：用户侧同步提交待处理任务。

异步任务：任务按提交顺序和优先级进入媒体处理队列中排队。

功能 任务接口

基础处理

音视频转码 提交音视频转码任务

极速高清转码 提交极速高清任务

视频转动图 提交视频转动图任务

视频截帧 提交视频截帧任务

音视频转封装（分段） 提交转封装任务

音视频拼接 提交视频拼接任务

视频水印 视频明水印

获取媒体信息 提交获取媒体信息任务

画质增强

画质增强（包含超分辨率、插

帧、色彩增强等功能）

提交画质增强任务

视频质量评分 提交质量评分任务

版权保护 数字水印 提交添加数字水印任务

智能编辑

视频标签 提交视频标签任务

精彩集锦 提交精彩集锦任务

智能封面 提交智能封面任务

智能语音 音频降噪 提交音频降噪任务

https://cloud.tencent.com/document/product/460/76913
https://cloud.tencent.com/document/product/460/78248
https://cloud.tencent.com/document/product/460/76900
https://cloud.tencent.com/document/product/460/76910
https://cloud.tencent.com/document/product/460/76908
https://cloud.tencent.com/document/product/460/76901
https://cloud.tencent.com/document/product/460/76904
https://cloud.tencent.com/document/product/460/84775
https://cloud.tencent.com/document/product/460/76906
https://cloud.tencent.com/document/product/460/76902
https://cloud.tencent.com/document/product/460/76917
https://cloud.tencent.com/document/product/460/76915
https://cloud.tencent.com/document/product/460/76909
https://cloud.tencent.com/document/product/460/76905
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针对媒体处理功能（例如音视频转码、音视频拼接、视频截帧和视频转动图等），您需要在数据万象创建任务或工作

流时，指定使用的模板，模板页为您提供了系统预设模板，您也可根据自身业务需求自定义模板，媒体处理模板接口

请参见 媒体处理模板 。

媒体处理中的工作流是指通过配置多个单任务操作组合对指定的上传文件进行自动化处理的过程，工作流调用请参见 

工作流接口 。

批量任务处理是对指定的存量文件进行单任务处理或按照工作流中配置的操作自动化处理，调用请参见 批量数据处

理接口 。

人声分离 提交人声分离任务

语音合成 提交语音合成任务

语音识别 提交语音识别任务

同步任务

视频截图 获取媒体截图任务

获取媒体信息 获取媒体信息任务

私有m3u8 读取m3u8任务  

模板接口

工作流接口

批量任务处理接口

https://cloud.tencent.com/document/product/460/46490
https://cloud.tencent.com/document/product/460/76838
https://cloud.tencent.com/document/product/460/76843
https://cloud.tencent.com/document/product/460/76918
https://cloud.tencent.com/document/product/460/76914
https://cloud.tencent.com/document/product/460/78951
https://cloud.tencent.com/document/product/460/49283
https://cloud.tencent.com/document/product/460/49284
https://cloud.tencent.com/document/product/460/63738
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服务和队列配置

开通媒体处理服务
最近更新时间：2023-08-01 15:45:52

本接口用于开通媒体处理服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 MediaBucket 的内容：

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <MediaBucket>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>

节点名称（关键

字）
父节点 描述 类型

Response 无 保存结果的容器
Contain

er

节点名称（关键

字）
父节点 描述 类型

RequestId
Respon

se
请求的唯一 ID

Strin

g

MediaBucket
Respon

se
媒体 Bucket 详情

Cont

ainer

节点名称（关键

字）
父节点 描述 类型

BucketId
Response.MediaBu

cket
存储桶 ID

Strin

g

Name
Response.MediaBu

cket
存储桶名称，同 BucketId

Strin

g

Region
Response.MediaBu

cket
所在的地域

Strin

g

CreateTime
Response.MediaBu

cket
创建时间

Strin

g

错误码
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该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

POST /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <MediaBucket>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucket>

</Response>

https://cloud.tencent.com/document/product/460/42867
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查询媒体处理服务
最近更新时间：2023-08-01 16:46:22

本接口用于查询已经开通媒体处理处理功能的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /mediabucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述

默

认

值

是否

必选

region

s

地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域以“,”分

隔字符串，详情请参见 地域与域名  
无 否

bucket

Names
存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 无 否

bucket 存储桶名称前缀，前缀搜索 无 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Name

pageN

umber
第几页 1 否

pageSi

ze
每页个数，大于 0且小于等于 100 的整数 10 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucketList>

    <MediaBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </MediaBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 MediaBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

字）

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
媒体 Bucket 总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

MediaBucketL

ist

Respons

e
媒体 Bucket 列表

Contain

er 数组

节点名称（关键

字）
父节点 描述 类型

BucketId
Response.Medi

aBucketList
存储桶 ID

Strin

g

Name
Response.Medi

aBucketList
存储桶名称，同 BucketId

Strin

g

Region
Response.Medi

aBucketList
所在的地域

Strin

g

CreateTime
Response.Medi

aBucketList
创建时间

Strin

g

错误码

实际案例

请求

GET /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2021 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </MediaBucketList>

    <MediaBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </MediaBucketList>

</Response>
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关闭媒体处理服务
最近更新时间：2023-08-01 15:45:53

本接口用于关闭媒体处理服务并删除队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /mediabucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-123456789</BucketName>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

BucketName Response 存储桶名称 String

错误码

实际案例

请求

DELETE /mediabucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-123456789</BucketName>

https://cloud.tencent.com/document/product/460/42867
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</Response>
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搜索媒体处理队列
最近更新时间：2023-08-01 16:46:22

本接口用于查询媒体处理队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述 类型

是否

必选

queueIds 队列 ID，支持搜索多个，以“,”符号分割字符串，最多填10个。
Stri

ng
否

state

1. Active 表示队列内的作业会被媒体处理服务调度执行

2. Paused 表示队列暂停，作业不再会被媒体处理调度执行，队列内

的所有作业状态维持在暂停状态，已经执行中的任务不受影响

Stri

ng
否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

category 1. CateAll：所有类型

2. Transcoding：媒体处理队列

3. SpeedTranscoding：媒体处理倍速转码队列

4. 默认为 Transcoding

Stri

ng

否

pageNumb

er
第几页，默认值1

Stri

ng
否

pageSize 每页个数，默认值10
Stri

ng
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respon

se
请求的唯一 ID String

TotalCount
Respon

se
队列总数 Int

PageNumber
Respon

se
当前页数，同请求中的 pageNumber Int

PageSize
Respon

se
每页个数，同请求中的 pageSize Int
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Container 节点 QueueList 的内容：

Container 节点 NotifyConfig 的内容：

QueueList Respon

se

队列数组 Container 

数组

NonExistPIDs
Respon

se
不存在的队列 ID 列表 String 数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi

st
队列名字 String

State
Response.QueueLi

st
当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi

st
队列最大长度 Int

MaxConcurrent
Response.QueueLi

st
当前队列最大并行执行的任务数 Int

Category
Response.QueueLi

st
队列类型 String

UpdateTime
Response.QueueLi

st
更新时间 String

CreateTime
Response.QueueLi

st
创建时间 String

节点名称（关键字） 父节点 描述 类型

Url
Response.QueueList

.NotifyConfig
回调地址 String

State
Response.QueueList

.NotifyConfig
开关状态，On 或者 Off String

Type Response.QueueList 回调类型，Url String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

.NotifyConfig

Event
Response.QueueList

.NotifyConfig

任务完成：TaskFinish；

工作流完成：WorkflowFinish
String

ResultFormat
Response.QueueList

.NotifyConfig
回调类型，XML 或者 JSON String

MqRegion
Response.QueueList

.NotifyConfig
TDMQ 所属园区 String

MqMode
Response.QueueList

.NotifyConfig
TDMQ 使用模式 String

MqName
Response.QueueList

.NotifyConfig
TDMQ 主题名称 String

错误码

实际案例

请求1：搜索指定队列

GET /queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x

<Response>

    <RequestId>NjJmMzJjNDFfOTBmYTUwNjRfNjQ5NF8x</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

https://cloud.tencent.com/document/product/460/42867
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        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>

请求2：查询队列列表

GET /queue?pageSize=10&pageNumber=1&category=CateAll HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x

<Response>

    <RequestId>NjJmMzI5MmRfOTBmYTUwNjRfNjcwM18x</RequestId>

    <TotalCount>2</TotalCount>
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    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>queue-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Transcoding</Category>

    </QueueList>

    <QueueList>

        <QueueId>pbf17a810dce74c18a641b663aede6803</QueueId>

        <Name>queue-speed-transcoding-process-1</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>SpeedTranscoding</Category>

    </QueueList>

</Response>
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更新媒体处理队列
最近更新时间：2023-08-01 16:46:22

本接口用于更新媒体处理的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型
是否必

选

Request 无 保存结果的容器 Container 是

节点名称（关键

字）
父节点 描述 类型

是否

必选

默

认

值

Name Request
队列名称，仅支持中文、英文、数字、

_、-和*，长度不超过 128

Stri

ng
是 无

State Request

1. Active 表示队列内的作业会被媒

体处理服务调度执行

2. Paused 表示队列暂停，作业不再

会被媒体处理调度执行，队列内的

所有作业状态维持在暂停状态，已

经执行中的任务不受影响

Stri

ng
是 无

NotifyConfig Request 回调配置

Con

tain

er

是 无

节点名称（关键

字）
父节点 描述

类

型
是否必选

默认

值

State
Request.NotifyC

onfig

回调开关

Off

On

Str

ing
否 Off

Event
Request.NotifyC

onfig

回调事件

TaskFinish：

任务完成

WorkflowFini

sh：工作流完

成

Str

ing

当 State=On 

时，必选
无
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

ResultFormat Request.NotifyC

onfig

回调格式

XML

JSON

Str

ing

否 XM

L

Type
Request.NotifyC

onfig

回调类型

Url

TDMQ

Str

ing

当 State=On 

时，必选
无

Url
Request.NotifyC

onfig

回调地址，不能为

内网地址。

Str

ing

当 

State=On，

且 Type=Url 

时，必选

无

MqMode
Request.NotifyC

onfig

TDMQ 使用模式

Topic：主题订

阅

Queue: 队列

服务

Str

ing

当 

State=On，

且 

Type=TDMQ 

时，必选

无

MqRegion
Request.NotifyC

onfig

TDMQ 所属园

区，目前支持园区 

sh（上海）、bj

（北京）、gz（广

州）、cd（成

都）、hk（中国香

港）

Str

ing

当 

State=On，

且 

Type=TDMQ 

时，必选

无

MqName
Request.NotifyC

onfig
TDMQ 主题名称

Str

ing

当 

State=On，

且 

Type=TDMQ 

时，必选

无

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>Transcoding</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键

字）
父节点 描述 类型

QueueId
Response.Que

ue
队列 ID String

Name Response.Que

ue

队列名字 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

State
Response.Que

ue
当前状态，Active 或者 Paused String

NotifyConfig
Response.Que

ue
回调配置，同 Request.NotifyConfig

Contain

er

MaxSize
Response.Que

ue
队列最大长度 Int

MaxConcurrent
Response.Que

ue
当前队列最大并行执行的任务数 Int

Category
Response.Que

ue
队列类型 String

UpdateTime
Response.Que

ue
更新时间 String

CreateTime
Response.Que

ue
创建时间 String

错误码

实际案例

请求

PUT /queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-Media</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-Media</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>Transcoding</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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获取媒体信息

获取媒体信息同步请求
最近更新时间：2023-07-18 19:12:42

GetMediainfo 接口用于获取媒体文件的信息。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

参数说明如下：

该请求无请求体。

功能描述

请求

请求示例

GET /<ObjectKey>?ci-process=videoinfo HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

为存储桶对象。

请求头

请求参数

节点名称（关键

字）
父节点 描述 类型 是否必选

ci-process 无 操作类型，固定使用 videoinfo String 是

请求体

响应

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应头

响应体

<Response>

      <MediaInfo>

         <Stream>

            <Video>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

                <CodecTag></CodecTag>

                <ColorPrimaries></ColorPrimaries>

                <ColorRange></ColorRange>

                <ColorTransfer></ColorTransfer>

                <Profile></Profile>

                <Width></Width>

                <Height></Height>

                <HasBFrame></HasBFrame>

                <RefFrames></RefFrames>

                <Sar></Sar>

                <Dar></Dar>

                <PixFormat></PixFormat>

                <FieldOrder></FieldOrder>

                <Level></Level>

                <Fps></Fps>

                <AvgFps></AvgFps>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <NumFrames></NumFrames>

                <Language></Language>

            </Video>

            <Audio>

                <Index></Index>

                <CodecName></CodecName>

                <CodecLongName></CodecLongName>

                <CodecTimeBase></CodecTimeBase>

                <CodecTagString></CodecTagString>

https://cloud.tencent.com/document/product/436/7729
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                <CodecTag></CodecTag>

                <SampleFmt></SampleFmt>

                <SampleRate></SampleRate>

                <Channel></Channel>

                <ChannelLayout></ChannelLayout>

                <Timebase></Timebase>

                <StartTime></StartTime>

                <Duration></Duration>

                <Bitrate></Bitrate>

                <Language></Language>

            </Audio>

            <Subtitle>

                <Index></Index>

                <Language></Language>

            </Subtitle>

         </Stream>

         <Format>

            <NumStream></NumStream>

            <NumProgram></NumProgram>

            <FormatName></FormatName>

            <FormatLongName></FormatLongName>

            <StartTime></StartTime>

            <Duration></Duration>

            <Bitrate></Bitrate>

            <Size></Size>

         </Format>

      </MediaInfo>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

MediaInfo Response 媒体的详细信息 Container

MediaInfo

节点名称（关键字） 父节点 描述 类型
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Container 节点 Stream 的内容：

Container 节点 Format 的内容（某字段未获取到有效值时不返回）：

Container 节点 Video 的内容（某字段未获取到有效值时不返回）：

Format Response.MediaInfo 格式信息 Container

Stream Response.MediaInfo 流信息 Container

节点名称（关键字） 父节点 描述 类型

Video Response.MediaInfo.Stream 视频信息
Container 

数组

Audio Response.MediaInfo.Stream 音频信息
Container 

数组

Subtitle Response.MediaInfo.Stream 字幕信息
Container 

数组

节点名称（关键

字）
父节点 描述 类型

NumStream
Response.MediaInfo.F

ormat

Stream（包含 Video、

Audio、Subtitle）的数量
String

NumProgram
Response.MediaInfo.F

ormat
节目的数量 String

FormatName
Response.MediaInfo.F

ormat
容器格式名字 String

FormatLongN

ame

Response.MediaInfo.F

ormat
容器格式的详细名字 String

StartTime
Response.MediaInfo.F

ormat
起始时间，单位为秒 String

Duration
Response.MediaInfo.F

ormat
时长，单位为秒 String

Bitrate
Response.MediaInfo.F

ormat
比特率，单位为 kbps String

Size
Response.MediaInfo.F

ormat
大小，单位为 Byte String
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节点名称（关键

字）

父节点 描述 类型

Index
Response.MediaInfo.Strea

m.Video
该流的编号 String

CodecName
Response.MediaInfo.Strea

m.Video
编解码格式名字 String

CodecLongNa

me

Response.MediaInfo.Strea

m.Video
编解码格式的详细名字 String

CodecTimeBa

se

Response.MediaInfo.Strea

m.Video
编码时基 String

CodecTagStri

ng

Response.MediaInfo.Strea

m.Video
编码标签名 String

CodecTag
Response.MediaInfo.Strea

m.Video
编码标签 String

ColorPrimarie

s

Response.MediaInfo.Strea

m.Video
色原 String

ColorRange
Response.MediaInfo.Strea

m.Video
色彩范围 String

ColorTransfer
Response.MediaInfo.Strea

m.Video
色彩通道 String

Profile
Response.MediaInfo.Strea

m.Video
视频编码档位 String

Height
Response.MediaInfo.Strea

m.Video
视频高，单位 px String

Width
Response.MediaInfo.Strea

m.Video
视频宽，单位 px String

HasBFrame
Response.MediaInfo.Strea

m.Video

是否有B帧。1表示有，0表示

无
String

RefFrames
Response.MediaInfo.Strea

m.Video
视频编码的参考帧个数 String

Sar
Response.MediaInfo.Strea

m.Video
采样宽高比 String
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Container 节点 Audio 的内容（某字段未获取到有效值时不返回）：

Dar Response.MediaInfo.Strea

m.Video

显示宽高比 String

PixFormat
Response.MediaInfo.Strea

m.Video
像素格式 String

FieldOrder
Response.MediaInfo.Strea

m.Video
场的顺序 String

Level
Response.MediaInfo.Strea

m.Video
视频编码等级 String

Fps
Response.MediaInfo.Strea

m.Video
视频帧率 String

AvgFps
Response.MediaInfo.Strea

m.Video
平均帧率 String

Timebase
Response.MediaInfo.Strea

m.Video
时基 String

StartTime
Response.MediaInfo.Strea

m.Video
视频开始时间，单位为秒 String

Duration
Response.MediaInfo.Strea

m.Video
视频时长，单位为秒 String

Bitrate
Response.MediaInfo.Strea

m.Video
比特率，单位为 kbps String

NumFrames
Response.MediaInfo.Strea

m.Video
总帧数 String

Language
Response.MediaInfo.Strea

m.Video
语言 String

节点名称（关键

字）
父节点 描述 类型

Index
Response.MediaInfo.Strea

m.Audio
该流的编号 String

CodecName
Response.MediaInfo.Strea

m.Audio
编解码格式名字 String

CodecLongNa Response.MediaInfo.Strea 编解码格式的详细名字 String
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Container 节点 Subtitle 的内容：

me m.Audio

CodecTimeBas

e

Response.MediaInfo.Strea

m.Audio
编码时基 String

CodecTagStrin

g

Response.MediaInfo.Strea

m.Audio
编码标签名 String

CodecTag
Response.MediaInfo.Strea

m.Audio
编码标签 String

SampleFmt
Response.MediaInfo.Strea

m.Audio
采样格式 String

SampleRate
Response.MediaInfo.Strea

m.Audio
采样率 String

Channel
Response.MediaInfo.Strea

m.Audio
通道数量 String

ChannelLayout
Response.MediaInfo.Strea

m.Audio
通道格式 String

Timebase
Response.MediaInfo.Strea

m.Audio
时基 String

StartTime
Response.MediaInfo.Strea

m.Audio
音频开始时间，单位秒 String

Duration
Response.MediaInfo.Strea

m.Audio
音频时长，单位秒 String

Bitrate
Response.MediaInfo.Strea

m.Audio
比特率，单位 kbps String

Language
Response.MediaInfo.Strea

m.Audio
语言 String

节点名称（关键

字）
父节点 描述 类型

Index
Response.MediaInfo.Strea

m.Subtitle
该流的编号 String

Language
Response.MediaInfo.Strea

m.Subtitle
语言，und 表示无查询结果 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

GET /for-test.mp4?ci-process=videoinfo HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <MediaInfo>

        <Format>

            <Bitrate>1014.950000</Bitrate>

            <Duration>10.125000</Duration>

            <FormatLongName>QuickTime / MOV</FormatLongName>

            <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

            <NumProgram>0</NumProgram>

            <NumStream>2</NumStream>

            <Size>1284547</Size>

            <StartTime>0.000000</StartTime>

        </Format>

        <Stream>

            <Audio>

                <Bitrate>70.451000</Bitrate>

                <Channel>1</Channel>

                <ChannelLayout>mono</ChannelLayout>

                <CodecLongName>AAC Advanced Audio Coding </CodecLongName>

                <CodecName>aac</CodecName>

( )

https://cloud.tencent.com/document/product/436/53983
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                <CodecTag>0x6134706d</CodecTag>

                <CodecTagString>mp4a</CodecTagString>

                <CodecTimeBase>1/44100</CodecTimeBase>

                <Duration>0.440294</Duration>

                <Index>1</Index>

                <Language>und</Language>

                <SampleFmt>fltp</SampleFmt>

                <SampleRate>44100</SampleRate>

                <StartTime>0.000000</StartTime>

                <Timebase>1/44100</Timebase>

            </Audio>

            <Subtitle/>

            <Video>

                <AvgFps>24/1</AvgFps>

                <Bitrate>938.164000</Bitrate>

                <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLongNa

                <CodecName>h264</CodecName>

                <CodecTag>0x31637661</CodecTag>

                <CodecTagString>avc1</CodecTagString>

                <CodecTimeBase>1/12288</CodecTimeBase>

                <ColorPrimaries>unknown</ColorPrimaries>

                <ColorRange>unknown</ColorRange>

                <ColorTransfer>unknown</ColorTransfer>

                <Dar>40:53</Dar>

                <Duration>0.124416</Duration>

                <Fps>24.500000</Fps>

                <HasBFrame>2</HasBFrame>

                <Height>1280</Height>

                <Index>0</Index>

                <Language>und</Language>

                <Level>32</Level>

                <NumFrames>243</NumFrames>

                <PixFormat>yuv420p</PixFormat>

                <Profile>High</Profile>

                <RefFrames>1</RefFrames>

                <Sar>25600:25599</Sar>

                <StartTime>0.000000</StartTime>

                <Timebase>1/12288</Timebase>

                <Width>966</Width>

            </Video>

        </Stream>

    </MediaInfo>

</Response>
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获取媒体信息异步任务

提交任务
最近更新时间：2023-08-01 16:46:23

提交一个获取媒体信息任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型  的具体数据描述如下：

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Reque

st
创建任务的 Tag：MediaInfo

Strin

g
是

Input
Reque

st
待操作的文件信息

Cont

ainer
是

Operation
Reque

st
操作规则

Cont

ainer
是

CallBackF

ormat

Reque

st

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式

Strin

g
否

CallBackT

ype

Reque

st

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型

Strin

g
否

CallBack
Reque

st

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM

qConfig

Reque

st

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Cont

ainer
否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

UserData
Request.Op

eration

透传用户信息，可打印的 ASCII 码，长度不

超过1024

Strin

g
否

JobLevel Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0

Strin

g

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

节点名称（关

键字）
父节点 描述 类型

是否

必选

Object
Request.In

put
文件路径 String 是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点  的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：MediaInfo

Stri

ng

State
Response.J

obsDetail

任务的状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Input Response.J

obsDetail

该任务的输入资源地址 Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键字） 父节点 描述 类型

MediaInfo
Response.JobsDetail.

Operation

输出文件的媒体信息，详见  

MediaInfo ，任务未完成时不返回

Conta

iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

JobLevel
Response.JobsDetail.

Operation
任务优先级 String

错误码

实际案例

请求：

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
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    <Tag>MediaInfo</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>MediaInfo</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respon
se

固定值，为 TaskFinish String

JobsDetail
Respon

se

同提交获取媒体信息任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键
字）

父节点 描述 类型

Key
Response.JobsDetail.Input.C
osHeaders

自定义 Header 的名称
Stri
ng

Value
Response.JobsDetail.Input.C

osHeaders
自定义 Header 的值

Stri

ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

https://cloud.tencent.com/document/product/460/84776#JobsDetail
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Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:45:14+0800</CreationTime>

        <EndTime>2022-06-30T18:45:15+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jb976c9e0f86111ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>
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                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <UserData>This is my MediaInfo job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:45:15+0800</StartTime>

        <State>Success</State>

        <Tag>MediaInfo</Tag>

    </JobsDetail>

</Response>
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案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T18:45:14+0800"

        "EndTime": "2022-06-30T18:45:15+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "jb976c9e0f86111ec9452c1c27f56a659"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "834.736000"

                    "Duration": "13.654000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "1424687"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "104.047000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "13.653311"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

{
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                        "AvgFps": "25.000000"

                        "Bitrate": "763.774000"

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10"

                        "CodecName": "h264"

                        "CodecTag": "0x31637661"

                        "CodecTagString": "avc1"

                        "CodecTimeBase": "1/12800"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

                        "Duration": "12.960000"

                        "Fps": "25.000000"

                        "HasBFrame": "0"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "10"

                        "NumFrames": "324"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "544"

                    

                

            

            "UserData": "This is my MediaInfo job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T18:45:15+0800"

        "State": "Success"

        "Tag": "MediaInfo"

    

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,
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,
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获取媒体截帧
最近更新时间：2023-07-20 18:09:01

GetSnapshot 接口用于获取媒体文件某个时间的截图。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

参数说明如下：

功能描述

请求示例

1. 通过 GET 请求方式

GET /<ObjectKey>?ci-process=snapshot&time=1&format=jpg HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

2. 通过 URL 地址添加参数方式

https://<BucketName-APPID>.cos.<Region>.myqcloud.com/for-test.mp4?ci-process=sna

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

ObjectKey 为存储桶对象。

此接口为同步模式，异步模式请参考 截图任务 。

请求头

请求参数

参数名称 描述 类型
是否必

选

ci-
process

操作类型，固定使用 snapshot String 是

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/84780
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该请求无请求体。

该响应包含公共响应头，详情请参见 公共响应头部  文档。

该响应体为截图文件内容。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

time 截图的时间点，单位为秒 float 是

width 截图的宽。默认为0 Int 否

height 截图的高。默认为0 Int 否

format 截图的格式，支持 jpg 和 png，默认 jpg String 否

rotate

图片旋转方式
auto：按视频旋转信息进行自动旋转

off：不旋转

默认值为 auto

String 否

mode

截帧方式

keyframe：截取指定时间点之前的最近的一个关键帧

exactframe：截取指定时间点的帧

默认值为 exactframe

String 否

说明：

当 width 和 height 都为0时，表示使用视频的宽高。如果单个为0，则以另外一个值按视频宽高比例自动

适应。

请求体

响应

响应头

响应体

错误码

实际案例

请求1 通过 GET 请求方式

GET /for-test.mp4?ci-process=snapshot&time=1.5 HTTP/1.1

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/53983
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Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

请求2 通过 URL 地址添加参数方式

https://examplebucket-1250000000.cos.ap-beijing.myqcloud.com/for-test.mp4?ci-process

响应

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<图片内容>
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读取私有 M3U8

获取私有 m3u8
最近更新时间：2023-07-20 18:09:02

GetPrivateM3U8 接口用于获取私有 M3U8 ts 资源的下载授权。（此方式通过对象存储转发请求至数据万

象）。

参数的具体内容如下：

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

GET /<ObjectKey>?ci-process=pm3u8&expires= HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

ObjectKey 为存储桶对象。

请求参数

参数名称 描述 类型 是否必选

ci-
process

操作类型，固定使用 pm3u8
Strin
g

是

expires
私有 ts 资源 url 下载凭证的相对有效期，单位为秒，范围为

[3600，43200]

Strin

g
是

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为 m3u8 的内容，其中的 ts 为可下载的链接。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

错误码

实际案例

请求

GET /for-test.pm3u8?ci-process=pm3u8&expires=3600 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Mar 2016 09:45:46 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/x-mpegURL

Content-Length: 266005

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

#EXTM3U

#EXT-X-VERSION:3

#EXT-X-TARGETDURATION:11

#EXT-X-MEDIA-SEQUENCE:0

#EXT-X-KEY:METHOD=AES-128,URI="http://website.com/aes.key?Ciphertext=xxxxx&KMS

#EXTINF:11.333333,

test-00000.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.416667,

test-00001.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.375000,

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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test-00002.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:11.291667,

test-00003.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:3.500000,

test-00004.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXT-X-ENDLIST
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更新 HLS 解密 Token
最近更新时间：2023-07-20 18:09:02

ModifyM3U8Token 接口用于在加密 M3U8 的 key uri 中增加 Token。

参数的具体内容如下：

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

请求

请求示例

GET /modifym3u8token?object=&token= HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

说明

 Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

节点名称（关键

字）
描述 类型

是否必

选

object M3U8 文件的对象名 String 是

token
需要嵌入 M3U8 key uri中的 token，长度小于2048个 

UTF-8字符。
String 是

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体为添加 token 的 m3u8 文件内容。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

#EXTM3U

#EXT-X-VERSION:3

#EXT-X-TARGETDURATION:11

#EXT-X-MEDIA-SEQUENCE:0

#EXT-X-KEY:METHOD=AES-128,URI="http://website.com/aes.key?Ciphertext=xxxxx&KMS

#EXTINF:11.333333,

test-00000.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.416667,

test-00001.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.375000,

test-00002.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:11.291667,

test-00003.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:3.500000,

test-00004.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXT-X-ENDLIST

错误码

实际案例

请求

GET /modifym3u8token?expires=3600&object=test.m3u8&token=abc HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-type: application/xml

响应

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第378 共1950页

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Fri, 10 Mar 2016 09:45:46 GMT

Server: tencent-ci

x-ci-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZm****

#EXTM3U

#EXT-X-VERSION:3

#EXT-X-TARGETDURATION:11

#EXT-X-MEDIA-SEQUENCE:0

#EXT-X-KEY:METHOD=AES-128,URI="http://website.com/aes.key?Ciphertext=xxxxx&KMS

#EXTINF:11.333333,

test-00000.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.416667,

test-00001.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:9.375000,

test-00002.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:11.291667,

test-00003.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXTINF:3.500000,

test-00004.ts?q-sign-algorithm=sha1&q-ak=&q-sign-time=&q-key-time=&q-header-list=

#EXT-X-ENDLIST
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视频 DNA

提交视频 DNA 任务
最近更新时间：2023-08-09 17:33:03

提交一个视频 DNA 任务，视频 DNA 任务可实现视频入库、视频查重、视频出库操作。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体。

功能描述

注意：

视频 DNA 计费标准与视频标签一致，根据视频处理时长计费，例：入库时长为10分钟的视频，查重时

长为5分钟的视频，费用为：10*0.05元/分钟+5*0.05元/分钟=0.75元，详情见 按量计费（后付

费） 。

使用视频DNA需提前创建视频 DNA 库，点击 提交工单  创建 DNA 库。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://console.cloud.tencent.com/workorder/category?level1_id=141&level2_id=635&source=0&data_title=T-Sec-%E4%B8%BB%E6%9C%BA%E5%AE%89%E5%85%A8&step=1
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

<Request>

    <Tag>DNA</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DnaConfig>

            <RuleType>GetFingerPrint</RuleType>

            <DnaDbId>Db0fafe624fec211edbdc852540083a8ba</DnaDbId>

        </DnaConfig>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型
是否必
选

Request 无 保存请求的容器
Contai

ner
是

节点名称（关
键字）

父节
点

描述 类型
是否
必选

Tag
Req

uest
创建任务的 Tag：DNA

Strin

g
是

Input
Req

uest
待操作的文件信息

Cont

ainer
是

Operation
Req
uest

操作规则
Cont
ainer

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Strin

g
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型

Strin

g
否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 DnaConfig 的具体数据描述如下：

CallBack Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g

否

CallBackM

qConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig 

Cont

ainer
否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

Object
Reques

t.Input

输入文件路径，目前输入视频只支持 mp4 格式，视频

长度小于1800s

Str

ing
是

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

DnaConfig
Request.Op
eration

视频 DNA 任务参数
Cont
ainer

是

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2。级别越大

任务优先级越高，默认为0

Strin

g
否

UserData
Request.Op

eration
透传用户信息

Strin

g
否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

RuleType
Request.Operati
on.DnaConfig

DNA 任务类型

GetFingerPrint：视频存入 DNA 库
获取视频指纹，并进行查重

FindSimilarVideo：视频查重，不会
存入 DNA 库 

DeleteFingerPrint：从 DNA 库中
删除视频

Str
ing

是

DnaDbId
Request.Operati

on.DnaConfig
DNA 库 ID

Str

ing
是

VideoId
Request.Operati

on.DnaConfig

视频唯一 ID，当 RuleType 为 

DeleteVideoPrint 时生效且必选

Str

ing
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message>SUCCESS</Message>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>        

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DNA</Tag>

        <Operation>

            <DNAResult>

                <Detection>

                    <Audio>

                        <Similar>100</Similar>

                    </Audio>

                    <Duration>10</Duration>

                    <MatchDetail>

                        <MatchEndTime>9</MatchEndTime>

                        <MatchStartTime>0</MatchStartTime>

                        <SrcEndTime>9</SrcEndTime>

                        <SrcStartTime>0</SrcStartTime>

                    </MatchDetail>

                    <Similar>100</Similar>

                    <SimilarDuration>10</SimilarDuration>

                    <VideoId>dv2b162b7d005011eeb67352540083a8ba</VideoId>

                </Detection>

                <Detection>

                    <Audio>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                        <Similar>100</Similar>

                    </Audio>

                    <Duration>10</Duration>

                    <MatchDetail>

                        <MatchEndTime>9</MatchEndTime>

                        <MatchStartTime>0</MatchStartTime>

                        <SrcEndTime>9</SrcEndTime>

                        <SrcStartTime>0</SrcStartTime>

                    </MatchDetail>

                    <Similar>100</Similar>

                    <SimilarDuration>10</SimilarDuration>

                    <VideoId>dv9fb4b5d3004d11eeb67352540083a8ba</VideoId>

                </Detection>

                <Duration>10</Duration>

                <VideoId>dvef8cd08e006511eeb67352540083a8ba</VideoId>

            </DNAResult>

            <DnaConfig>

                <DnaDbId>Db0fafe624fec211edbdc852540083a8ba</DnaDbId>

                <RuleType>FindSimilarVideo</RuleType>

            </DnaConfig>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g
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Container 节点 Input 的内容：

Message Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义 Strin
g

JobId
Response.J

obsDetail
创建任务的 ID

Strin

g

Tag
Response.J

obsDetail
创建任务的 Tag：DNA

Strin

g

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Strin

g

CreationTi

me

Response.J

obsDetail
任务的创建时间

Strin

g

StartTime
Response.J
obsDetail

任务的开始时间
Strin
g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Strin

g

Input
Response.J
obsDetail

该任务的输入资源地址
Cont
ainer

Operation
Response.J

obsDetail
该任务的规则

Cont

ainer

节点名称（关键

字）
父节点 描述

类

型

Region Response.JobsDetail.Input 存储桶的地域
Str
ing

Bucket Response.JobsDetail.Input 存储结果的存储桶
Str

ing

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

Container 节点 DnaResult 的内容：

Container 节点 Detection 的内容：

Object Response.JobsDetail.Input 输出结果的文件名 Str

ing

节点名称（关
键字）

父节点 描述 类型

DnaConfig
Response.JobsDet

ail.Operation

同请求中的 

Request.Operation.DnaConfig

Conta

iner

DnaResult
Response.JobsDet

ail.Operation
DNA 任务结果，任务未完成时不返回

Conta

iner

UserData
Response.JobsDet
ail.Operation

透传用户信息 String

JobLevel
Response.JobsDet

ail.Operation
任务优先级 String

节点名称（关
键字）

父节点 描述 类型

VideoId
Response.JobsDetail.Op
eration.DnaResult

输入视频的唯一标识 ID String

Duration
Response.JobsDetail.Op

eration.DnaResult
输入视频的时长，单位秒 Integer

Detection
Response.JobsDetail.Op
eration.DnaResult

相似视频详情
Contain
er 数组

节点名称（关
键字）

父节点 描述 类型

VideoId
Response.JobsDetail.Operatio

n.DnaResult.Detection
匹配视频的 VideoId String

Similar
Response.JobsDetail.Operatio
n.DnaResult.Detection

相似度 Integer

SimilarDurat
ion

Response.JobsDetail.Operatio
n.DnaResult.Detection

相似片段时长 Integer
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Container 节点 MatchDetail 的内容：

Container 节点 Audio 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

Duration
Response.JobsDetail.Operatio

n.DnaResult.Detection
视频时长 Integer

MatchDetail
Response.JobsDetail.Operatio
n.DnaResult.Detection

匹配详情
Contain
er 数组

Audio
Response.JobsDetail.Operatio
n.DnaResult.Detection

音频相似详情
Contain
er

节点名称（关

键字）
父节点 描述 类型

MatchStart
Time

Response.JobsDetail.Operation.DnaRe
sult.Detection.MatchDetail

相似视频匹配的开始时
间，单位秒

Integ
er

MatchEndT
ime

Response.JobsDetail.Operation.DnaRe
sult.Detection.MatchDetail

相似视频匹配的结束时
间，单位秒

Integ
er

SrcStartTi

me

Response.JobsDetail.Operation.DnaRe

sult.Detection.MatchDetail

源视频匹配的开始时

间，单位秒

Integ

er

SrcEndTim
e

Response.JobsDetail.Operation.DnaRe
sult.Detection.MatchDetail

源视频匹配的结束时
间，单位秒

Integ
er

节点名称（关

键字）
父节点 描述 类型

Similar
Response.JobsDetail.Operation.DnaRe

sult.Detection.Audio
音频相似度

Inte

ger

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

https://cloud.tencent.com/document/product/460/42867
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Content-Type: application/xml

<Request>

    <Tag>DNA</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DnaConfig>

            <RuleType>GetFingerPrint</RuleType>

            <DnaDbId>Db0fafe624fec211edbdc852540083a8ba</DnaDbId>

        </DnaConfig>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DNA</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>
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        </Input>

        <Operation>

            <DNAResult>

                <Detection>

                    <Audio>

                        <Similar>100</Similar>

                    </Audio>

                    <Duration>10</Duration>

                    <MatchDetail>

                        <MatchEndTime>9</MatchEndTime>

                        <MatchStartTime>0</MatchStartTime>

                        <SrcEndTime>9</SrcEndTime>

                        <SrcStartTime>0</SrcStartTime>

                    </MatchDetail>

                    <Similar>100</Similar>

                    <SimilarDuration>10</SimilarDuration>

                    <VideoId>dv2b162b7d005011eeb67352540083a8ba</VideoId>

                </Detection>

                <Detection>

                    <Audio>

                        <Similar>100</Similar>

                    </Audio>

                    <Duration>10</Duration>

                    <MatchDetail>

                        <MatchEndTime>9</MatchEndTime>

                        <MatchStartTime>0</MatchStartTime>

                        <SrcEndTime>9</SrcEndTime>

                        <SrcStartTime>0</SrcStartTime>

                    </MatchDetail>

                    <Similar>100</Similar>

                    <SimilarDuration>10</SimilarDuration>

                    <VideoId>dv9fb4b5d3004d11eeb67352540083a8ba</VideoId>

                </Detection>

                <Duration>10</Duration>

                <VideoId>dvef8cd08e006511eeb67352540083a8ba</VideoId>

            </DNAResult>

            <DnaConfig>

                <DnaDbId>Db0fafe624fec211edbdc852540083a8ba</DnaDbId>

                <RuleType>GetFingerPrint</RuleType>

            </DnaConfig>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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获取 DNA 库中文件列表
最近更新时间：2023-08-09 17:33:04

查询 DNA 库内文件列表。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

参数的具体内容如下：

该请求无请求体。

功能描述

请求

请求示例

GET /dnadb_files HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名称 描述 是否必选

object 文件名 否

dnaDbId DNA 库 ID 否

pageNumber 第几页，默认值:1 否

pageSize 每页个数，默认值:10，最大值 100 否

请求体

响应

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <DNADbFiles>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <VideoId>xxx</VideoId>

        <Object>input/test1.mp4</Object>

        <ETag>&quot;3a64323ae8ed5633c02fc96def134b92-23&quot;</ETag>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbFiles>

    <DNADbFiles>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <VideoId>xxx</VideoId>

        <Object>input/test2.mp4</Object>

        <ETag>&quot;234f8b0b58874328039ac66352820cc8&quot;</ETag>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbFiles>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 DNADbConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

RequestId Respons

e

请求的唯一 ID String

TotalCount
Respons
e

文件总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

DNADbFiles
Respons
e

文件的详细信息
Container 数
组

节点名称（关键字） 父节点 描述 类型

BucketId Response.DNADbConfig 存储桶 ID String

Region Response.DNADbConfig 存储桶所在园区 String

DNADbId Response.DNADbConfig DNA 库 ID String

VideoId Response.DNADbConfig 文件唯一标识符 String

Object Response.DNADbConfig 文件名 String

ETag Response.DNADbConfig 文件 ETag String

UpdateTime Response.DNADbConfig 文件更新时间 String

CreateTime Response.DNADbConfig 文件创建时间 String

错误码

实际案例

GET /dnadb_filesHTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <DNADbFiles>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <VideoId>xxx</VideoId>

        <Object>input/test1.mp4</Object>

        <ETag>&quot;3a64323ae8ed5633c02fc96def134b92-23&quot;</ETag>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbFiles>

    <DNADbFiles>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <VideoId>xxx</VideoId>

        <Object>input/test2.mp4</Object>

        <ETag>&quot;234f8b0b58874328039ac66352820cc8&quot;</ETag>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbFiles>

</Response>
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查询 DNA 库列表
最近更新时间：2023-08-09 17:33:04

获取 DNA 库列表

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

参数的具体内容如下：

该请求无请求体。

功能描述

请求

请求示例

GET /dnadb HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名称 描述 是否必选

ids DNA库 ID，支持以 , 符号分割字符串，最多填 20 个 否

pageNumber 第几页，默认值:1 否

pageSize 每页个数，默认值:10, 最大值 100 否

请求体

响应

响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <DNADbConfig>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <DNADbName>测试1</DNADbName>

        <Capacity>10000</Capacity>

        <Description>这是测试库1</Description>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbConfig>

    <DNADbConfig>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx2</DNADbId>

        <DNADbName>测试2</DNADbName>

        <Capacity>10000</Capacity>

        <Description>这是测试库2</Description>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-25T17:21:20+0800</UpdateTime>

    </DNADbConfig>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

    <NonExistIDs>C</NonExistIDs>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 DNADbConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

RequestId Respon
se

请求的唯一 ID String

TotalCount
Respon

se
库总数 Int

PageNumber
Respon
se

当前页数，同请求中的 pageNumber Int

PageSize
Respon
se

每页个数，同请求中的 pageSize Int

DNADbConfig
Respon

se
库的详细信息

Container 

数组

NonExistIDs
Respon
se

查询的 ID 中不存在的库，所有 ID 都存在时不返
回

String 数组

节点名称（关键字） 父节点 描述 类型

BucketId Response.DNADbConfig 存储桶 ID String

Region Response.DNADbConfig 存储桶所在园区 String

DNADbId Response.DNADbConfig DNA 库 ID String

DNADbName Response.DNADbConfig DNA 库名称 String

Capacity Response.DNADbConfig DNA 库容量 Int

Description Response.DNADbConfig DNA 库描述 String

UpdateTime Response.DNADbConfig DNA 更新时间 String

CreateTime Response.DNADbConfig DNA 创建时间 String

错误码

实际案例

GET /dnadb?ids=xxx1,xxx2,A,B,C HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

https://cloud.tencent.com/document/product/460/42867
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Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <DNADbConfig>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx1</DNADbId>

        <DNADbName>测试1</DNADbName>

        <Capacity>10000</Capacity>

        <Description>这是测试库1</Description>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-31T16:15:20+0800</UpdateTime>

    </DNADbConfig>

    <DNADbConfig>

        <BucketId>test-1234567890</BucketId>

        <Region>ap-chongqing</Region>

        <DNADbId>xxx2</DNADbId>

        <DNADbName>测试2</DNADbName>

        <Capacity>10000</Capacity>

        <Description>这是测试库2</Description>

        <CreateTime>2023-06-05T11:35:24+0800</CreateTime>

        <UpdateTime>2023-06-25T17:21:20+0800</UpdateTime>

    </DNADbConfig>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

    <NonExistIDs>C</NonExistIDs>

</Response>
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音视频转码

提交任务
最近更新时间：2023-08-01 16:46:23

提交一个转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点

描述 类型 是

否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

必

选

Tag
Req

uest
创建任务的Tag：Transcode

Stri

ng
是

Input
Req
uest

待操作的文件信息
Con
tain

er

是

Operation
Req
uest

操作规则
Con
tain

er

是

QueueTy

pe

Req

uest

任务所在的队列类型，限制为 SpeedTranscoding, 表示

为开启倍速转码

Stri

ng
否

CallBackF
ormat

Req
uest

任务回调格式，JSON 或 XML，默认 XML，优先级高于
队列的回调格式

Stri
ng

否

CallBack
Type

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队列
的回调类型

Stri
ng

否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 时，

表示队列的回调地址不产生回调

Stri

ng
否

CallBack
MqConfig

Req
uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时必
填。详情见 CallBackMqConfig

Con
tain

er

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateId
Request.
Operation

转码模板 ID String 否

Transcode
Request.
Operation

转码模板参数
Contai
ner

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Transcode 的具体数据描述如下：

Watermark
TemplateId

Request.
Operation

水印模板 ID，可以传多个水印模板 ID，最多
传3个

String 
数组

否

Watermark
Request.

Operation

水印模板参数，同创建水印模板接口中的 

Request.Watermark  ，最多传3个

Contai

ner 数

组

否

RemoveWa
termark

Request.
Operation

去除水印参数,  H265、AV1编码暂不支持该
参数

Contai
ner

否

Subtitles
Request.

Operation

字幕参数，H265、AV1编码和非mkv封装暂

不支持该参数

Contai

ner
否

DigitalWate

rmark

Request.

Operation
数字水印参数，详情见 DigitalWatermark  

Contai

ner
否

Output
Request.
Operation

结果输出配置
Contai
ner

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超

过1024
String 否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大

任务优先级越高，默认为0
String 否

说明

转码参数必须设置，可以通过 TemplateId 或 Transcode 设置， TemplateId 优先级更高。

水印参数可选，可以通过 WatermarkTemplateId 或 Watermark 设置，

WatermarkTemplateId 优先级更高。

节点名称（关

键字）
父节点 描述 类型

是否

必选

TimeInterv

al

Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.TimeInterval  

Contain

er
否

Container
Request.Operati
on.Transcode

同创建转码模板接口中的 
Request.Container  

Contain
er

否

Video
Request.Operati
on.Transcode

同创建转码模板接口中的 
Request.Video  

Contain
er

否

Audio Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.Audio  

Contain

er

否

https://cloud.tencent.com/document/product/460/84725#Watermark
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
https://cloud.tencent.com/document/product/460/84733#TimeInterval
https://cloud.tencent.com/document/product/460/84733#Container
https://cloud.tencent.com/document/product/460/84733#Video
https://cloud.tencent.com/document/product/460/84733#Audio
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Container 类型 RemoveWatermark 的具体数据描述如下：

Container 类型 Subtitles 的具体数据描述如下：

Container 类型 Subtitle 的具体数据描述如下：

TransConfi
g

Request.Operati
on.Transcode

同创建转码模板接口中的 
Request.TransConfig  

Contain
er

否

AudioMix
Request.Operati
on.Transcode

混音参数，详情见 AudioMix  
Contain
er

否

AudioMixAr

ray

Request.Operati

on.Transcode
混音参数数组，最多同时传2个

Contain

er 数组
否

说明

不传 Video，相当于删除视频信息。不传 Audio，相当于删除音频信息。Video 和 Audio 不可以同

时不传。

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix  。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Dx
Request.Operation.Re

moveWatermark

距离左上角原点 x 偏移，范围为

[1, 4096]

str

ing
是

Dy
Request.Operation.Re
moveWatermark

距离左上角原点 y 偏移，范围为
[1, 4096]

str
ing

是

Width
Request.Operation.Re

moveWatermark
宽，范围为[1, 4096]

str

ing
是

Height
Request.Operation.Re

moveWatermark
高，范围为[1, 4096]

str

ing
是

节点名称（关键字） 父节点 描述 类型
是否
必选

Subtitle
Request.Operation.Subtitl

es
字幕参数 Container数组 是

https://cloud.tencent.com/document/product/460/84733#TransConfig
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否
必选

Url
Request.Operation.Subtitles.

Subtitle

同 bucket 的字幕地

址，需要 encode

stri

ng
是

节点名称（关键字） 父节点 描述 类型 是否必选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket
Request.Operation.Out
put

存储结果的存储桶
Strin
g

是

Object
Request.Operation.Out

put
输出结果的文件名

Strin

g
是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

https://cloud.tencent.com/document/product/460/42866
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        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称

（关键字）
父节点 描述 类型

Code
Response.

JobsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.
JobsDetail

错误描述，只有 State 为 Failed 时有意义
Strin
g

JobId
Response.

JobsDetail
新创建任务的 ID

Strin

g

Tag
Response.

JobsDetail
新创建任务的 Tag：Transcode

Strin

g

State
Response.

JobsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变为

暂停状态

Cancel：任务被取消执行

Strin

g

Progress
Response.

JobsDetail
任务进度百分比，范围为[0, 100]

Strin

g

CreationT
ime

Response.
JobsDetail

任务的创建时间
Strin
g

StartTime Response. 任务的开始时间 Strin
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

JobsDetail g

EndTime
Response.

JobsDetail
任务的结束时间

Strin

g

QueueId
Response.
JobsDetail

任务所属的 队列 ID  
Strin
g

Input
Response.

JobsDetail
该任务的输入资源地址

Cont

ainer

Operation
Response.

JobsDetail
该任务的规则

Cont

ainer

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDeta
il.Operation

任务的模板 ID String

TemplateNa
me

Response.JobsDeta
il.Operation

任务的模板名称, 当 TemplateId 存在
时返回

String

Transcode
Response.JobsDeta

il.Operation

同请求中的 

Request.Operation.Transcode

Contain

er

Watermark
Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.Watermark

Contain
er 数组

WatermarkTe

mplateId

Response.JobsDeta

il.Operation

同请求中的 
Request.Operation.WatermarkT

emplateId 

String 数

组

RemoveWate
rmark

Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.RemoveWat

ermark

Contain
er

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Output
Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.Output

Contain
er

MediaInfo
Response.JobsDeta
il.Operation

输出文件的媒体信息，详见 
MediaInfo ，任务未完成时不返回

Contain
er

MediaResult
Response.JobsDeta

il.Operation

输出文件的基本信息，详见 

MediaResult  ，任务未完成时不返回

Contain

er

DigitalWater
mark

Response.JobsDeta
il.Operation

同请求中的 

Request.Operation.DigitalWater
mark

Contain
er

UserData
Response.JobsDeta

il.Operation

同请求中的 

Request.Operation.UserData
String

JobLevel
Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.JobLevel

String

错误码

实际案例

请求1：使用转码模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>
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        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>
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            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用转码处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>
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                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>
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        </Watermark>

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Subtitles>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

            </Subtitle>

            <Subtitle>

                <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

            </Subtitle>

        </Subtitles>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

                <AudioMixArray>
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                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>
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                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Subtitles>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test1.srt</Url>

                </Subtitle>

                <Subtitle>

                    <Url>https://test-xxx.cos.ap-chongqing.myqcloud.com/test2.srt</Url>

                </Subtitle>

            </Subtitles>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 18:10:32

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>
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                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交转码任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键
字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/84790#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key Response.JobsDetail.Input.Co

sHeaders

自定义 Header 的名称 Stri

ng

Value
Response.JobsDetail.Input.Co

sHeaders
自定义 Header 的值

Stri

ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>
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                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>
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                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>
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            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>
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                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/transcode.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/transcode.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.${ext}</Object>
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                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <UserData>This is my Transcode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T15:29:42+0800"

        "EndTime": "2022-06-30T15:30:08+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

{
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                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j68427030f84611ecb8546d80f2baf56f"

        "Message": "success"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Duration": "13"

                    "NumStream": "1"

                    "Size": "1909389"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "128000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "13.653"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "50.000"

                        "Bitrate": "1031968"

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)"

                        "CodecName": "hevc"

                        "CodecTag": "0x31637668"

                        "CodecTagString": "hvc1"

                        "CodecTimeBase": "1/50"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

},
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                        "Duration": "12.960"

                        "FieldOrder": "Unknown"

                        "Fps": "50/1"

                        "HasBFrame": "4"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "4"

                        "NumFrames": "648"

                        "PixFormat": "hvc1"

                        "Profile": "Main"

                        "RefFrames": "1"

                        "Rotation": "0"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "540"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "2db78d168edf2f883adce89a1b4ca033"

                        "ObjectName": "output/transcode.mp4"

                    

                    "ObjectName": "output/transcode.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/transcode.${ext}"

                "Region": "ap-chongqing"

            

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c"

            "TemplateName": "trans_993874"

            "UserData": "This is my Transcode job."

            "JobLevel": 0

        

        "Progress": "100"

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T15:29:42+0800"

        "State": "Success"

        "Tag": "Transcode"
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        "Workflow": 

            "Name": "Transcode_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-07-24 14:18:43

创建音视频转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>
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具体数据描述如下：

Container 类型  的具体数据描述如下：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键字）
父节
点

描述 类型
是否
必选

Tag

Req

ues
t

模板类型：Transcode String 是

Name

Req

ues
t

模板名称，仅支持中文、英文、数字、_、-和

*，长度不超过 64
String 是

Container
Req
ues

t

容器格式
Contain

er
是

Video
Req
ues

t

视频信息
Contain
er

否

TimeInterval

Req

ues
t

时间区间
Contain
er

否

Audio

Req

ues
t

音频信息
Contain

er
否

TransConfig

Req

ues

t

转码配置
Contain

er
否

AudioMix
Req
ues

t

混音参数，详情见 AudioMix  
Contain

er
否

AudioMixArray Req 混音参数，最多同时传2个 Contain 否

https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型  的具体数据描述如下：

Container 类型 ClipConfig 的具体数据描述如下：

设定 container，音频视频支持的格式如下表所示：

ues

t

er 数组

说明：

不传 Video，相当于删除视频信息。不传 Audio，相当于删除音频信息。Video 和 Audio 不可以同

时不传。

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix  。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

Container

节点名称（关键
字）

父节点 描述 类型 是否必选

Format
Request.Co

ntainer
封装格式：取值见下表

Strin

g
是

ClipConfig
Request.Co
ntainer

分片配置，当 format 为 hls 和 
dash 时有效

Cont
ainer

否

节点名称（关键
字）

父节点 描述 类型 是否必选

Duration
Request.Container.Clip

Config

分片时长，默认

5s

Strin

g
否

Container Audio Codecs Video Codecs

mp4/hls/mkv aac、mp3 H.264、H.265、AV1

ts/flv/avi/mov aac、mp3 H.264

dash aac H.264

WebM Vorbis、opus VP8、VP9、AV1

aac aac 不支持

mp3 mp3 不支持

https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型  的具体数据描述如下：

flac flac 不支持

amr amr 不支持

adts aac 不支持

m4a aac 不支持

wav pcm_s16le 不支持

Video

节点名称（关
键字）

父节点 描述
类
型

默认值
是否
必选

Codec
Reques

t.Video

编解码格式
H.264

H.265

VP8

VP9

AV1

Str

ing

H.264

当 Format 为 

WebM 时，为 
VP8

否

Width
Reques
t.Video

宽
值范围：[128, 4096]

单位：px

若只设置 Width 时，按照

视频原始比例计算 
Height 

必须为偶数

Str
ing

视频原始宽度 否

Height
Reques
t.Video

高
值范围：[128, 4096]

单位：px

若只设置 Height 时，按

照视频原始比例计算 
Width

必须为偶数

Str
ing

视频原始高度 否

Fps
Reques
t.Video

帧率
值范围：(0, 60]

单位：fps 

Str
ing

无 否

Remove Reques 是否删除视频流，取值 true Str false 否
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t.Video 或 false。 ing

Profile
Reques

t.Video

编码级别

仅H.264支持此参数

支持 baseline、main、

high、auto

当 Pixfmt 为 auto 时，

参数值将被设置为 auto

baseline：适合移动设备

main：适合标准分辨率设
备

high：适合高分辨率设备

Str

ing
high 否

Bitrate
Reques
t.Video

视频输出文件的码率
值范围：[10, 50000], 单

位：Kbps

设置为 auto 表示自适应

码率

Str
ing

无 否

Crf
Reques
t.Video

码率-质量控制因子
值范围：(0, 51]

如果设置了 Crf，则 
Bitrate 的设置失效

当 Bitrate 为空时，默认
为25 

Str
ing

无 否

Gop
Reques

t.Video

关键帧间最大帧数，值范围：

[1, 100000]

Str

ing
无 否

Preset
Reques
t.Video

视频算法器预置

H.264 支持该参数，取值 
veryfast、fast、

medium、slow、
slower

VP8 支持该参数，取值 
good、realtime

AV1 支持该参数，取值 
universal、medium

H.265 和 VP9 不支持该

参数

Str
ing

当 Codec 为 
H.264 时，为 

medium

当 Codec 为 

VP8 时，为 
good

否

Bufsize Reques

t.Video

缓冲区大小

值范围：[1000, 128000]

Str

ing

无 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第434 共1950页

单位：Kb

Codec 为 VP8/VP9时不

支持此参数

Maxrate
Reques
t.Video

视频码率峰值
值范围：[10, 50000]

单位：Kbps

Codec 为 VP8/VP9 时

不支持此参数

Str
ing

无 否

Pixfmt
Reques

t.Video

视频颜色格式

H.264支持：yuv420p、
yuv422p、yuv444p、

yuvj420p、yuvj422p、
yuvj444p、auto

H.265支持：yuv420p、
yuv420p10le、auto

Codec 为 
VP8/VP9/AV1 时不支持

此参数

Str

ing
无 否

LongShort

Mode

Reques

t.Video

长短边自适应，取值 true或 
false。Codec 为 

VP8/VP9/AV1 时不支持此
参数。

Str

ing
false 否

Rotate
Reques

t.Video

旋转角度
值范围：[0, 360)

单位：度 

Str

ing
无 否

Roi
Reques
t.Video

Roi 强度
取值为 none、low、

medium、high

Codec 为 VP8/VP9 时

不支持此参数

Str
ing

none 否

Crop Reques
t.Video

自由裁剪
自定义裁切: 

width:height:left:top。
示例:1280:800:0:140

width和height的值需要
大于0，left和top的值需

要大于等于0

Str
ing

无 否
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

Codec 为 H.265/AV1 

时不支持此参数。

开启自适应编码时, 不支持

此参数。

开启roi时, 不支持此参
数。

Interlaced
Reques
t.Video

开启隔行扫描
false/true

Codec 为 H.265/AV1 
时不支持此参数。

开启自适应码率时, 不支持

此参数。

开启roi时, 不支持此参

数。

Str
ing

false 否

TimeInterval

节点名称（关
键字）

父节点 描述 类型 默认值
是否
必选

Start
Request.Ti
meInterval

开始时间
[0 视频时长]

单位为秒

支持 float 格式，执行精度精确

到毫秒

Stri
ng

0 否

Duration
Request.Ti
meInterval

持续时间
[0 视频时长]

单位为秒

支持 float 格式，执行精度精确

到毫秒

Stri
ng

视频原
始时长

否

Audio

节点名称（关

键字）
父节点 描述

类

型
默认值

是否

必选

Codec Reques

t.Audio

编解码格式，取值 aac、mp3、

flac、amr、Vorbis、opus、

pcm_s16le

Str

ing

aac

当 

format 

为 

WebM 

否
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时，为 

Vorbis

当 

format 

为 wav 

时，为 

pcm_s

16le

Samplerat

e

Reques

t.Audio

采样率

单位：Hz 

可选 8000、11025、12000、

16000、22050、24000、

32000、44100、48000、

88200、96000 

不同的封装，mp3 支持不同的采

样率，如下表所示

当 Codec 设置为 amr 时，只支

持8000 

当 Codec 设置为 opus 时，支持

8000，16000，24000，

48000 

Str

ing

44100

当 

Codec 

为 

opus 

时，默

认值为

48000

否

Bitrate
Reques

t.Audio

原始音频码率

单位：Kbps 

值范围：[8，1000] 

Str

ing
无 否

Channels
Reques

t.Audio

声道数

当 Codec 设置为 aac/flac，支

持1、2、4、5、6、8

当 Codec 设置为 mp3/opus 

时，支持1、2 

当 Codec 设置为 Vorbis 时，只

支持2 

当 Codec 设置为 amr，只支持1 

当 Codec 设置为 pcm_s16le 

时，只支持1、2   

当封装格式为 dash 时，不支持8 

 

Str

ing
无 否

Remove
Reques

t.Audio

是否删除源音频流，取值 true、

false

Str

ing
false 否
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Audio.Codec 采样率支持情况，如下表所示：

SampleFor

mat

Reques

t.Audio

采样位宽

当 Codec 设置为 aac，支持 

fltp 

当 Codec 设置为 mp3，支持 

fltp、s16p、s32p 

当 Codec 设置为 flac，支持

s16、s32、s16p、s32p 

当 Codec 设置为 amr，支持

s16、s16p

当 Codec 设置为 opus，支持

s16 

当 Codec 设置为 pcm_s16le，

支持s16 

当 Codec 设置为 Vorbis，支持 

fltp 

当 Video.Codec 为 H.265 

时，此参数无效 

Str

ing

无 否

说明

 Y 表示支持这种采样率，N 表示不支持。

Audio.Code
c      

aac      amr      
fla
c      

opu
s      

Vorb
is      

pcm_s16le      mp3   

8000 Y Y Y Y Y Y 封装不同，支

持不同
11025 Y N Y N Y Y

12000 Y N Y N Y Y

16000 Y N Y Y Y Y

22050 Y N Y N Y Y

24000 Y N Y Y Y Y

32000 Y N Y N Y Y

44100 Y N Y N Y Y

48000 Y N Y Y Y Y

88200 Y N Y N Y Y
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当 Audio.Codec 为 mp3 时，Container.Format 的采样率兼容情况如下所示：

Container 类型  的具体数据描述如下：

96000 Y N Y N Y Y

封装格式/音频采
样率

8

0
0

0

11

02
5

12

00
0

16

00
0

22

05
0

24

00
0

32

00
0

44

10
0

48

00
0

88

20
0

96

00
0

flv N N N N Y N N Y N N N

mp4 N N N Y Y Y Y Y Y N N

hls/ts/mp3/m

kv/avi/mov
Y Y Y Y Y Y Y Y Y N N

TransConfig

节点名称（关键

字）
父节点 描述 类型

默

认

值

是否

必选

AdjDarMeth

od

Request.Tr

ansConfig

分辨率调整方式

取值 scale、crop、pad、none

当输出视频的宽高比与原视频不等

时，根据此参数做分辨率的相应调

整

Stri

ng

n

o

n

e

否

IsCheckRes

o

Request.Tr

ansConfig

是否检查分辨率，取值 true、false

当为 false 时，按照配置参数转码 
Stri

ng

fa

ls

e

否

ResoAdjMet

hod

Request.Tr

ansConfig

分辨率调整方式

当 IsCheckReso 为 true 时生

效，取值0、1；

0 表示使用原视频分辨率；

1 表示返回转码失败

Stri

ng
0 否

IsCheckVide

oBitrate

Request.Tr

ansConfig

是否检查视频码率，取值 true、

false

当为 false 时，按照配置参数转码

Stri

ng

fa

ls

e

否

VideoBitrate

AdjMethod

Request.Tr

ansConfig

视频码率调整方式

IsCheckVideoBitrate 为 true 

Stri

ng

0 否
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时生效，取值0、1；

当输出视频码率大于原视频码率

时，0表示使用原视频码率；1表示

返回转码失败

IsCheckAudi

oBitrate

Request.Tr

ansConfig

是否检查音频码率，取值 true、

false

当为 false 时，按照配置参数转码 

Stri

ng

fa

ls

e

否

AudioBitrate

AdjMethod

Request.Tr

ansConfig

音频码率调整方式

IsCheckAudioBitrate 为 true 

时生效，取值0、1；

当输出音频码率大于原音频码率

时，0表示使用原音频码率；1表示

返回转码失败

Stri

ng
0 否

IsCheckVide

oFps

Request.Tr

ansConfig

是否检查视频帧率，取值 true、

false

当为 false 时，按照配置参数转码

Stri

ng

fa

ls

e

否

VideoFpsAdj

Method

Request.Tr

ansConfig

视频帧率调整方式

IsCheckVideoFps 为 true 时

生效，取值0、1；

当输出视频帧率大于原视频帧率

时，0表示使用原视频帧率；1表示

返回转码失败

Stri

ng
0 否

DeleteMetad

ata

Request.Tr

ansConfig

是否删除文件中的 MetaData 信息，

取值 true、false

Stri

ng

fa

ls

e

否

IsHdr2Sdr
Request.Tr

ansConfig

是否开启 HDR 转 SDR，取值 

true、false

Stri

ng

fa

ls

e

否

TranscodeIn

dex

Request.Tr

ansConfig

指定处理的流编号，对应媒体信息中的 

Response.MediaInfo.Stream.Vi

deo.Index 和 

Response.MediaInfo.Stream.A

udio.Index，详见 获取媒体信息接

口

Stri

ng
无 否

HlsEncrypt
Request.Tr

ansConfig
hls 加密配置

Con

tain

er

无 否

https://cloud.tencent.com/document/product/460/49284#MediaInfo
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AdjDarMethod 参数图示：

Container 类型 HlsEncrypt 的具体数据描述如下：

DashEncrypt Request.Tr

ansConfig

dash 加密配置 Con

tain

er

无 否

节点名称

（关键字）
父节点 描述

类

型

默
认

值

是否

必选

IsHlsEnc

rypt

Request.TransCon

fig.HlsEncrypt

是否开启 HLS 加密，取值 true、
false

当 Container.Format 为 hls 
时支持加密

St
ri

n
g

fal

se
否

UriKey Request.TransCon HLS 加密的 key St 无 否
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Container 类型 DashEncrypt 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

fig.HlsEncrypt 当 IsHlsEncrypt 为 true 时，
该参数才有意义

ri
n

g

节点名称
（关键

字）

父节点 描述
类

型

默
认

值

是否

必选

IsEncryp

t

Request.TransConfi

g.DashEncrypt

是否开启 DASH 加密，取值 
true、false

当 Container.Format 为 
dash 时支持加密

Str

ing

fal

se
否

UriKey
Request.TransConfi

g.DashEncrypt

DASH 加密的 key

当 IsEncrypt 为 true 时，

该参数才有意义

Str

ing
无 否

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

https://cloud.tencent.com/document/product/460/42866
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            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templat
e

模板 ID String

Name
Response.Templat
e

模板名称 String

BucketId
Response.Templat

e
模板所属存储桶 String

Category
Response.Templat
e

模板属性，Custom 或者 Official String

Tag
Response.Templat
e

模板类型，Transcode String

UpdateTime
Response.Templat

e
更新时间 String

CreateTime
Response.Templat

e
创建时间 String

TransTpl Response.Templat 详细的模板参数 Containe
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Container节点TransTpl的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

e r

节点名称（关键字） 父节点 描述 类型

TimeInterval
Response.Template.T

ransTpl

同请求体中的 

Request.TimeInterval

Containe

r

Container
Response.Template.T
ransTpl

同请求体中的 
Request.Container

Containe
r

Video
Response.Template.T

ransTpl
同请求体中的 Request.Video

Containe

r

Audio
Response.Template.T

ransTpl
同请求体中的 Request.Audio

Containe

r

TransConfig
Response.Template.T
ransTpl

同请求体中的 
Request.TransConfig

Containe
r

AudioMix
Response.Template.T

ransTpl

同请求体中的 

Request.AudioMix

Containe

r

AudioMixArray
Response.Template.T

ransTpl

同请求体中的 

Request.AudioMixArray

Containe

r 数组

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

https://cloud.tencent.com/document/product/460/42867
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    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>
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            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>
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            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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创建模板 转码pro（广电专业格式）
最近更新时间：2023-08-01 16:46:23

创建音视频转码 pro 模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

说明：

此功能为广电专业格式转码，可处理 Apple Prores、Sony XAVC 等格式。

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关

键字）

父节

点
描述 类型

是否必

选

Tag
Req
uest

模板类型：TranscodePro String 是

Name
Req

uest

模板名称 仅支持中文、英文、数字、_、-和* ，长度

不超过 64
String 是

Container
Req

uest
容器格式

Conta

iner
是

Video
Req
uest

视频信息
Conta
iner

是
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Container 类型  的具体数据描述如下：

设定 container，音频视频支持的编解码格式如下表：

Container 类型  的具体数据描述如下：

TimeInterv

al

Req

uest

时间区间 Conta

iner

否

Audio
Req
uest

音频信息，不传 Audio，相当于删除音频信息
Conta
iner

否

TransConf
ig

Req
uest

转码配置
Conta
iner

否

Container

节点名称（关键

字）
父节点 描述 类型

是否必

选

Format
Request.Contain
er

封装格式：有效值为 mxf、
mov、mkv

String 是

Container Audio Codecs Video Codecs

mxf pcm_s24le xavc

mov、mkv aac、mp3 apple_prores

Video

节点名称（关键
字）

父节点 描述
类
型

是否
必选

默认
值

Codec
Request.
Video

编解码格式，支持 xavc、
apple_prores

Str
ing

是 无

Profile
Request.

Video
视频算法器预置，取值范围见下表

Str

ing
是 无

Width
Request.
Video

宽，取值范围见下表
Str
ing

是 无

Height
Request.
Video

高，取值范围见下表
Str
ing

是 无

Interlaced
Request.

Video
场模式，取值范围见下表

Str

ing
是 无

Fps
Request.
Video

帧率，取值范围见下表
Str
ing

是 无
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当 Video.Codec 为 xavc 时：

Bitrate Request.
Video

视频输出文件的码率，取值范围见下表 Str
ing

否 无

Rotate
Request.
Video

旋转角度

值范围：[0, 360)

单位：度

Str
ing

否 无

注意：

1、'-' 表示留空。

2、码率可选值与帧率可选值序号对应。

Profile
Wi
dth

Hei
ght

Interl
aced

Fps Bitrate(单位:kbps)

XAVC-

HD_intra_420_10bit_cla
ss50

14
40

10
80

true

1、25

2、
30000/10

01

-

XAVC-

HD_intra_420_10bit_cla
ss50

14
40

10
80

false

1、25

2、
24000/10

01
3、

30000/10
01

-

XAVC-

HD_intra_422_10bit_cla
ss100

12

80

72

0
false

1、50

2、

60000/10
01

-

XAVC-
HD_intra_422_10bit_cla

ss100

19
20

10
80

true

1、25

2、
30000/10

01

-

XAVC-
HD_intra_422_10bit_cla

ss100

19
20

10
80

false 1、25
2、50

3、

24000/10
01

-



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第452 共1950页

4、

30000/10
01

5、
60000/10

01

XAVC-
HD_intra_422_10bit_cla

ss200

19

20

10

80
true

1、25
2、

30000/10

01

-

XAVC-
HD_intra_422_10bit_cla

ss200

19
20

10
80

false

1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

01

-

XAVC-

4K_intra_422_10bit_cla
ss100

20

48

10

80
false

1、25

2、50
3、

24000/10
01

4、
30000/10

01
5、

60000/10
01

-

XAVC-
4K_intra_422_10bit_cla

ss300

38
40

21
60

false 1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

-
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01

XAVC-
4K_intra_422_10bit_cla

ss300

40
96

21
60

false

1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

01

-

XAVC-

4K_intra_422_10bit_cla
ss480

38

40

21

60
false

1、25

2、50
3、

24000/10
01

4、
30000/10

01
5、

60000/10
01

-

XAVC-
4K_intra_422_10bit_cla

ss480

40

96

21

60
false

1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

01

-

XAVC-

4K_intra_422_10bit

20

48

10

80

false 1、25

2、50
3、

24000/10
01

4、
30000/10

01

1、93000

2、185000
3、89000

4、111000
5、222000
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5、
60000/10

01

XAVC-

4K_intra_422_10bit

38

40

21

60
false

1、25

2、50
3、

24000/10
01

4、
30000/10

01
5、

60000/10
01

1、250000或400000
2、500000或

800000
3、240000或

384000
4、300000或

480000
5、600000或

960000

XAVC-
4K_intra_422_10bit

40
96

21
60

false

1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

01

1、250000或400000

2、500000或
800000

3、240000或
384000

4、300000或
480000

5、600000或
960000

XAVC-HD_422_10bit
12
80

72
0

false

1、50

2、
60000/10

01

1、50000
2、50000

XAVC-HD_422_10bit
19

20

10

80
true

1、25
2、

30000/10
01

1、25000或35000或
50000

2、25000或35000或
50000

XAVC-HD_422_10bit 19
20

10
80

false 1、25
2、50

3、
24000/10

01
4、

30000/10
01

1、25000或35000或
50000

2、35000或50000
3、25000或35000或

50000
4、25000或35000或

50000
5、35000或50000



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第455 共1950页

当 Video.Codec 为 apple_prores 时：

5、

60000/10
01

XAVC-4K_422_10bit
38

40

21

60
false

1、25
2、50

3、
24000/10

01
4、

30000/10
01

5、
60000/10

01

1、100000或140000
或200000

2、140000或200000
3、100000或140000

或200000

4、100000或140000
或200000

5、140000或200000

XAVC-4K_420_8bit
38
40

21
60

false

1、25

2、50
3、

24000/10
01

4、
30000/10

01
5、

60000/10
01

1、188000
2、300000

3、188000
4、188000

5、300000

Profile

1.ProRes_422_Proxy
2.ProRes_422_LT

3.ProRes_422
4.ProRes_422_HQ

5.ProRes_4444
6.ProRes_4444_XQ

7.ProRes_4444_alpha
8.ProRes_4444_XQ_alpha

W
id

th

H

ei
g

ht

Interl
aced

Fps Bitrate(单位:kbps)
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7
2

0

4
8

6

false 1、24000/1001
2、30000/1001

取值范围:[2000,3000000]

7

2
0

4

8
6

true 1、60000/1001 取值范围:[2000,3000000]

7

2
0

5

7
6

false 1、25 取值范围:[2000,3000000]

7

2
0

5

7
6

true 1、50 取值范围:[2000,3000000]

9

6
0

7

2
0

false

1、25
2、50

3、24000/1001
4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

12

8
0

7

2
0

false

1、25
2、50

3、24000/1001
4、30000/1001

5、60000/1001

取值范围:[2000,3000000]

12

8
0

10

8
0

false
1、24000/1001
2、30000/1001

取值范围:[2000,3000000]

12

8
0

10

8
0

true 1、60000/1001 取值范围:[2000,3000000]

14
4

0

10
8

0

false
1、24000/1001
2、25

3、30000/1001

取值范围:[2000,3000000]

14
4

0

10
8

0

true
1、50
2、60000/1001

取值范围:[2000,3000000]

19

2
0

10

8
0

false 1、25

2、50
3、24000/1001

取值范围:[2000,3000000]
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4、30000/1001

5、60000/1001

19
2

0

10
8

0

true
1、50
2、60000/1001

取值范围:[2000,3000000]

2
0

4
8

10
8

0

false

1、25

2、50
3、24000/1001

4、30000/1001
5、60000/1001

取值范围:[2000,3000000]

2

0
4

8

15
5

6

false

1、25 

2、50 
3、24000/1001 

4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

3

8
4

0

21

6
0

false

1、25 
2、50 

3、24000/1001 
4、30000/1001 

5、60000/1001

取值范围:[2000,3000000]

4
0

9
6

21

6
0

false

1、25 
2、50 

3、24000/1001 
4、30000/1001 

5、60000/1001

取值范围:[2000,3000000]

51
2

0

2
7

0

0

false

1、25 

2、50 
3、24000/1001 

4、30000/1001 
5、60000/1001

取值范围:[2000,3000000]

61
4

4

3

2
4

0

false

1、25 

2、50 
3、24000/1001 

4、30000/1001 

5、60000/1001

取值范围:[2000,3000000]

81
9

2

4
3

2
0

false 1、25 
2、50 

3、24000/1001 

取值范围:[2000,3000000]
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Container 类型  的具体数据描述如下：

Container 类型 的具体数据描述如下：

Container 类型  的具体数据描述如下：

4、30000/1001 
5、60000/1001

TimeInterval

节点名称（关
键字）

父节点 描述
类
型

默认值
是否
必选

Start
Request.Ti
meInterval

开始时间

[0， 视频时长] 

单位为秒 

支持 float 格式，执行精度精确到
毫秒

St

ri
n

g

0 否

Duration
Request.Ti
meInterval

持续时间

[0， 视频时长]

单位为秒 

支持 float 格式，执行精度精确到
毫秒

St

ri
n

g

视频原
始时长

否

Audio 

节点名称（关

键字）
父节点 描述

类

型

默

认
值

是否

必选

Codec
Request.

Audio
编解码格式，pcm_s24le、aac、mp3

Str

ing
无 是

Remove
Request.

Audio
是否删除源音频流，取值 true、false

Str

ing

fal

se
否

TransConfig

节点名称（关键

字）
父节点 描述 类型

默
认

值

是否

必选

AdjDarMeth

od

Request.Tr

ansConfig

分辨率调整方式
取值 scale、crop、pad、none

当输出视频的宽高比与原视频不等
时，根据此参数做分辨率的相应调

整

Stri

ng

n
o

n
e

否
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IsCheckRes

o

Request.Tr

ansConfig

是否检查分辨率，取值 true、false

当为 false 时，按照配置参数转码 

Stri

ng

fa

ls
e

否

ResoAdjMet

hod

Request.Tr

ansConfig

分辨率调整方式

当 IsCheckReso 为 true 时生
效，取值0、1；

0 表示使用原视频分辨率；

1 表示返回转码失败

Stri

ng
0 否

IsCheckVide
oBitrate

Request.Tr
ansConfig

是否检查视频码率，取值 true、

false
当为 false 时，按照配置参数转码

Stri
ng

fa

ls
e

否

VideoBitrate

AdjMethod

Request.Tr

ansConfig

视频码率调整方式

IsCheckVideoBitrate 为 true 
时生效，取值0、1；

当输出视频码率大于原视频码率
时，0表示使用原视频码率；1表示

返回转码失败

Stri

ng
0 否

IsCheckAudi
oBitrate

Request.Tr
ansConfig

是否检查音频码率，取值 true、
false

当为 false 时，按照配置参数转码 

Stri
ng

fa
ls

e

否

AudioBitrate

AdjMethod

Request.Tr

ansConfig

音频码率调整方式

IsCheckAudioBitrate 为 true 
时生效，取值0、1；

当输出音频码率大于原音频码率
时，0表示使用原音频码率；1表示

返回转码失败

Stri

ng
0 否

IsCheckVide

oFps

Request.Tr

ansConfig

是否检查视频帧率，取值 true、
false

当为 false 时，按照配置参数转码

Stri

ng

fa
ls

e

否

VideoFpsAdj
Method

Request.Tr
ansConfig

视频帧率调整方式
IsCheckVideoFps 为 true 时

生效，取值0、1；

当输出视频帧率大于原视频帧率

时，0表示使用原视频帧率；1表示
返回转码失败

Stri
ng

0 否

DeleteMetad

ata

Request.Tr

ansConfig

是否删除文件中的 MetaData 信息，

取值 true、false

Stri

ng

fa

ls

否
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AdjDarMethod 参数图示：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

e

IsHdr2Sdr
Request.Tr

ansConfig

是否开启 HDR 转 SDR，取值 

true、false

Stri

ng

fa
ls

e

否

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第461 共1950页

具体的数据内容如下：

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container
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Container 节点  的内容：

Container 节点  的内容：

Response

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templ

ate
模板 ID String

Name
Response.Templ

ate
模板名称 String

BucketId
Response.Templ
ate

模板所属存储桶 String

Category
Response.Templ

ate
模板属性，Custom 或者 Official String

Tag
Response.Templ

ate
模板类型，TranscodePro String

UpdateTime
Response.Templ
ate

更新时间 String

CreateTime
Response.Templ
ate

创建时间 String

TransProTpl
Response.Templ

ate
详细的模板参数

Contain

er

TransProTpl

节点名称（关
键字）

父节点 描述 类型

TimeInterv

al

Response.Template

.TransProTpl
同请求体中的 Request.TimeInterval

Contain

er

Container
Response.Template

.TransProTpl
同请求体中的 Request.Container

Contain

er

Video
Response.Template
.TransProTpl

同请求体中的 Request.Video
Contain
er

Audio
Response.Template

.TransProTpl
同请求体中的 Request.Audio

Contain

er

TransConf

ig

Response.Template

.TransProTpl
同请求体中的 Request.TransConfig

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第464 共1950页

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransProTpl>

            <Container>

                <Format>mxf</Format>

            </Container>

            <Video>

                <Codec>xavc</Codec>

                <Profile>XAVC-HD_422_10bit</Profile>

                <Width>1920</Width>

                <Height>1080</Height>

                <Interlaced>true</Interlaced>

                <Fps>30000/1001</Fps>

                <Bitrate>50000</Bitrate>

            </Video>

            <Audio>

                <Codec>pcm_s24le</Codec>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransProTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-01 15:45:53

更新音视频转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建转码模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>

            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84733#Request


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第469 共1950页

具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建转码模板接口的 Response  Container

错误码

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84733#Response
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实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Preset>medium</Preset>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>
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            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>Transcode</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mp4</Format>

        </Container>

        <Video>
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            <Codec>H.264</Codec>

            <Profile>high</Profile>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Fps>30</Fps>

            <Preset>medium</Preset>

        </Video>

        <Audio>

            <Codec>aac</Codec>

            <Samplerate>44100</Samplerate>

            <Bitrate>128</Bitrate>

            <Channels>4</Channels>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>
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                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板 转码 pro
最近更新时间：2023-08-01 16:46:23

更新音视频转码 pro 模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字）
父节
点

描述 类型 必选

Request 无 同创建转码 Pro 模板接口的 Request  
Containe

r
是

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84732#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建转码 Pro 模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84732#Response
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Content-Type: application/xml

<Request>

    <Tag>TranscodePro</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mxf</Format>

    </Container>

    <Video>

        <Codec>xavc</Codec>

        <Profile>XAVC-HD_422_10bit</Profile>

        <Width>1920</Width>

        <Height>1080</Height>

        <Interlaced>true</Interlaced>

        <Fps>30000/1001</Fps>

        <Bitrate>50000</Bitrate>

    </Video>

    <Audio>

        <Codec>pcm_s24le</Codec>

    </Audio>

    <TransConfig>

        <AdjDarMethod>scale</AdjDarMethod>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>
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        <Tag>TranscodePro</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Container>

            <Format>mxf</Format>

        </Container>

        <Video>

            <Codec>xavc</Codec>

            <Profile>XAVC-HD_422_10bit</Profile>

            <Width>1920</Width>

            <Height>1080</Height>

            <Interlaced>true</Interlaced>

            <Fps>30000/1001</Fps>

            <Bitrate>50000</Bitrate>

        </Video>

        <Audio>

            <Codec>pcm_s24le</Codec>

        </Audio>

        <TransConfig>

            <AdjDarMethod>scale</AdjDarMethod>

            <IsCheckReso>false</IsCheckReso>

            <ResoAdjMethod>1</ResoAdjMethod>

        </TransConfig>

        <TimeInterval>

            <Start>0</Start>

            <Duration>60</Duration>

        </TimeInterval>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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极速高清转码

提交任务
最近更新时间：2023-08-01 16:46:23

提交一个极速高清转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Requ

est
创建任务的Tag：Transcode String 是

Input
Requ
est

待操作的文件信息
Conta
iner

是

Operation
Requ

est
操作规则

Conta

iner
是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式
String 否

CallBackT
ype

Requ
est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高
于队列的回调类型

String 否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

CallBack Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

String 否

CallBackM
qConfig

Requ
est

任务回调TDMQ配置，当 CallBackType 为 
TDMQ 时必填。详情见 CallBackMqConfig

Conta
iner

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关键
字）

父节点 描述 类型
是否
必选

TemplateId
Request.

Operation
模板 ID, 此处需要传入极速高清模板 ID String 是

WatermarkT

emplateId

Request.

Operation

水印模板 ID，可以传多个水印模板 ID，最多

传3个

String 

数组
否

Watermark
Request.
Operation

水印模板参数，同创建水印模板接口中的
Request.Watermark ，最多传3个

Contain
er 数组

否

DigitalWater

mark

Request.

Operation

数字水印参数，详情见 

DigitalWatermark  

Contain

er
否

Output
Request.

Operation
结果输出配置

Contain

er
是

UserData
Request.
Operation

透传用户信息，可打印的 ASCII 码，长度不
超过1024

String 否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0
String 否

说明

水印参数可选，可以通过 WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 

优先级更高。

节点名称（关键字） 父节点 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84725#Watermark
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Region Request.Operation.Out
put

存储桶的地域 Strin
g

是

Bucket
Request.Operation.Out

put
存储结果的存储桶

Strin

g
是

Object
Request.Operation.Out

put
输出结果的文件名

Strin

g
是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第483 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义
Strin
g
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Container 节点 Input 的内容：

JobId Response.J

obsDetail

新创建任务的 ID Strin

g

Tag
Response.J

obsDetail
新创建任务的 Tag：Transcode

Strin

g

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Strin

g

Progress
Response.J

obsDetail
任务进度百分比，范围为[0, 100]

Strin

g

CreationT
ime

Response.J
obsDetail

任务的创建时间
Strin
g

StartTime
Response.J
obsDetail

任务的开始时间
Strin
g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

QueueId
Response.J
obsDetail

任务所属的 队列 ID  
Strin
g

Input
Response.J
obsDetail

该任务的输入资源地址
Cont
ainer

Operation
Response.J

obsDetail
该任务的规则

Cont

ainer

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键
字）

父节点 描述 类型

TemplateId
Response.JobsDetail
.Operation

任务的模板 ID String

TemplateNa

me

Response.JobsDetail

.Operation
任务的模板名称 String

Watermark
Response.JobsDetail
.Operation

同请求中的 
Request.Operation.Watermark

Contain
er 数组

WatermarkTe

mplateId

Response.JobsDetail

.Operation

同请求中的 
Request.Operation.Watermark

TemplateId

String 数

组

Output
Response.JobsDetail
.Operation

同请求中的 
Request.Operation.Output

Contain
er

MediaInfo
Response.JobsDetail
.Operation

输出文件的媒体信息，任务未完成时不
返回，详见 MediaInfo  

Contain
er

MediaResult
Response.JobsDetail

.Operation

输出文件的基本信息，任务未完成时不

返回，详见 MediaResult  

Contain

er

DigitalWater
mark

Response.JobsDetail
.Operation

同请求中的 
Request.Operation.DigitalWater

mark

Contain
er

UserData
Response.JobsDetail

.Operation
透传用户信息 String

JobLevel
Response.JobsDetail
.Operation

任务优先级 String

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>
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        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>
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                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respon

se
固定值，为 TaskFinish String

JobsDetail
Respon

se

同提交极速高清转码任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键
字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/84777#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key
Response.JobsDetail.Input.Co

sHeaders
自定义 Header 的名称

Stri

ng

Value
Response.JobsDetail.Input.Co
sHeaders

自定义 Header 的值
Stri
ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>
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                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>
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                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>
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            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>
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                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/high_speed.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/high_speed.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/high_speed.${ext}</Object>
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                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>high_993874</TemplateName>

            <UserData>This is my HighSpeedHd job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <Progress>100</Progress>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Transcode</Tag>

        <Workflow>

            <Name>Transcode_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T15:29:42+0800"

        "EndTime": "2022-06-30T15:30:08+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

{
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,

,

,

{

,

,
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{

,
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                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j68427030f84611ecb8546d80f2baf56f"

        "Message": "success"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Duration": "13"

                    "NumStream": "1"

                    "Size": "1909389"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "128000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "13.653"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "50.000"

                        "Bitrate": "1031968"

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)"

                        "CodecName": "hevc"

                        "CodecTag": "0x31637668"

                        "CodecTagString": "hvc1"

                        "CodecTimeBase": "1/50"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

},

{

,

}

]
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                        "Duration": "12.960"

                        "FieldOrder": "Unknown"

                        "Fps": "50/1"

                        "HasBFrame": "4"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "4"

                        "NumFrames": "648"

                        "PixFormat": "hvc1"

                        "Profile": "Main"

                        "RefFrames": "1"

                        "Rotation": "0"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "540"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "2db78d168edf2f883adce89a1b4ca033"

                        "ObjectName": "output/high_speed.mp4"

                    

                    "ObjectName": "output/high_speed.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/high_speed.${ext}"

                "Region": "ap-chongqing"

            

            "TemplateId": "t1995d523e42df4c5e858f244b4174360c"

            "TemplateName": "high_993874"

            "UserData": "This is my HighSpeedHd job."

            "JobLevel": 0

        

        "Progress": "100"

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T15:29:42+0800"

        "State": "Success"

        "Tag": "Transcode"

,
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        "Workflow": 

            "Name": "HighSpeedHd_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-07-24 14:18:43

创建极速高清转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

        <Fps>30</Fps>

        <Bufsize>1000</Bufsize>

        <Maxrate>10</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键

字）

父节

点
描述 类型

是否必

选

Tag
Requ
est

模板类型: HighSpeedHd String 是

Name
Requ
est

模板名称。仅支持中文、英文、数字、_、-和
*，长度不超过 64

String 是

Container
Requ

est
容器格式

Conta

iner
是

Video
Requ
est

视频信息
Conta
iner

是

TimeInterval Requ 时间区间 Conta 否
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Container 类型  的具体数据描述如下：

Container 类型 ClipConfig 的具体数据描述如下：

设定 container，音频视频支持的格式如下表：

Container 类型  的具体数据描述如下：

est iner

Audio
Requ

est
音频信息

Conta

iner
否

TransConfig
Requ
est

转码配置
Conta
iner

否

说明：

不传 Audio，相当于删除音频信息。

Container

节点名称（关键字） 父节点 描述 类型
是否必
选

Format
Request.Cont
ainer

封装格式: mp4，flv，hls，
mkv

String 是

ClipConfig
Request.Cont

ainer

分片配置, 当Format为hls时

有效

Contain

er
否

节点名称（关键字） 父节点 描述 类型 是否必选

Duration
Request.Container.ClipCo

nfig
分片时长, 默认5s

Strin

g
否

Container Audio Codecs Video Codecs

mp4/hls/mkv AAC、MP3 H.264、H.265

flv AAC、MP3 H.264

Video

节点名称（关
键字）

父节点 描述 类型 默认值
是否
必选

Codec Request.
Video

编解码格式
H.264

Stri
ng

H.264 否
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H.265

Width
Request.

Video

宽

值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频原
始比例计算 Height

必须为偶数

Stri

ng

视频原始

宽度
否

Height
Request.
Video

高
值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频

原始比例计算

Width  

必须为偶数

Stri
ng

视频原始
高度

否

Fps
Request.
Video

帧率
值范围：(0，60]

单位：fps

Stri
ng

无 否

Profile
Request.
Video

编码级别
支持 baseline、main、high

baseline：适合移动设备；

main：适合标准分辨率设备；

 high：适合高分辨率设备;

仅H.264支持此参数。

Stri
ng

high 否

Bitrate
Request.
Video

视频输出文件的码率

值范围：[10，50000],单位：
Kbps 

auto 表示自适应码率

Stri
ng

无 否

Crf
Request.

Video

码率-质量控制因子
值范围：(0，51]

如果设置了 Crf，则 Bitrate 的
设置失效

当 Bitrate 为空时，默认为25

Stri

ng
无 否

Gop
Request.
Video

关键帧间最大帧数，值范围：[0, 
100000]

Stri
ng

无 否

Preset Request. 视频算法器预置 Stri medium 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第504 共1950页

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

Video 仅H.264支持该参数

取值 veryfast、fast、

medium、slow、slower

ng

Bufsize
Request.
Video

缓冲区大小
值范围：[1000，128000]

单位：Kb

Stri
ng

无 否

Maxrate
Request.
Video

视频码率峰值
值范围：[10，50000]

单位：Kbps

Stri
ng

无 否

Pixfmt
Request.

Video

视频颜色格式
H.264支持：yuv420p、auto 

H.265支持：yuv420p、
yuv420p10le、auto

Stri

ng
无 否

Rotate
Request.

Video

旋转角度

值范围：[0, 360)

单位：度

Stri

ng
无 否

Roi
Request.
Video

Roi 强度，取值 none、low、
medium、high

Stri
ng

none 否

TimeInterval

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否

必选

Start
Request.Ti

meInterval

开始时间
[0 视频时长] 

单位为秒 

支持 float 格式，执行精度精确到毫秒

St
ri

n
g

无 否

Duration
Request.Ti
meInterval

持续时间

[0 视频时长] 

单位为秒 

支持 float 格式，执行精度精确到毫秒

St

ri
n

g

无 否

Audio



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第505 共1950页

Container 类型  的具体数据描述如下：

节点名称（关

键字）

父节点 描述 类

型

默

认
值

是否

必选

Codec
Request

.Audio
编解码格式，取值 aac、mp3

Stri

ng

a

a

c

否

Samplerat
e

Request
.Audio

采样率
单位：Hz

可选 11025、22050、32000、
44100、48000、96000

不同的封装，mp3 支持不同的采样率，如
下表所示

Stri
ng

4

41
0

0

否

Bitrate
Request
.Audio

原始音频码率

单位：Kbps

值范围：[8，1000]

Stri
ng

无 否

Channels
Request
.Audio

声道数

当 Codec 设置为 aac，支持1、2、4、
5、6、8

当 Codec 设置为 mp3，支持1、2

Stri
ng

无 否

Remove
Request
.Audio

是否删除源音频流，取值 true、false
Stri
ng

fa
ls

e

否

说明

 Y 表示支持这种采样率，N 表示不支持。

封装格式/音频采样率 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/mkv Y Y Y Y Y N

TransConfig

节点名称（关键
字）

父节点 描述 类型 默
认

是否
必选
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值

AdjDarMeth

od

Request.Tr

ansConfig

分辨率调整方式
取值 scale、crop、pad、none

当输出视频的宽高比与原视频不等
时，根据此参数做分辨率的相应调

整

Stri

ng

n
o

n
e

否

IsCheckRes
o

Request.Tr
ansConfig

是否检查分辨率，取值 true、false
当为 false 时，按照配置参数转码 

Stri
ng

fa
ls

e

否

ResoAdjMet

hod

Request.Tr

ansConfig

分辨率调整方式

当 IsCheckReso 为 true 时生
效，取值0、1；

0 表示使用原视频分辨率；

1 表示返回转码失败

Stri

ng
0 否

IsCheckVide
oBitrate

Request.Tr
ansConfig

是否检查视频码率，取值 true、

false
当为 false 时，按照配置参数转码

Stri
ng

fa

ls
e

否

VideoBitrate

AdjMethod

Request.Tr

ansConfig

视频码率调整方式

IsCheckVideoBitrate 为 true 
时生效，取值0、1；

当输出视频码率大于原视频码率
时，0表示使用原视频码率；1表示

返回转码失败

Stri

ng
0 否

IsCheckAudi
oBitrate

Request.Tr
ansConfig

是否检查音频码率，取值 true、
false

当为 false 时，按照配置参数转码 

Stri
ng

fa
ls

e

否

AudioBitrate
AdjMethod

Request.Tr
ansConfig

音频码率调整方式

IsCheckAudioBitrate 为 true 
时生效，取值0、1；

当输出音频码率大于原音频码率

时，0表示使用原音频码率；1表示

返回转码失败

Stri
ng

0 否

IsCheckVide

oFps

Request.Tr

ansConfig

是否检查视频帧率，取值 true、
false

当为 false 时，按照配置参数转码

Stri

ng

fa
ls

e

否

VideoFpsAdj Request.Tr 视频帧率调整方式 Stri 0 否
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AdjDarMethod 参数图示：

Method ansConfig IsCheckVideoFps 为 true 时

生效，取值0、1；

当输出视频帧率大于原视频帧率

时，0表示使用原视频帧率；1表示
返回转码失败

ng

DeleteMetad
ata

Request.Tr
ansConfig

是否删除文件中的 MetaData 信息，
取值 true、false

Stri
ng

fa

ls
e

否

IsHdr2Sdr
Request.Tr

ansConfig

是否开启 HDR 转 SDR，取值 

true、false

Stri

ng

fa

ls
e

否

HlsEncrypt
Request.Tr

ansConfig
hls 加密配置

Con
tain

er

无 无
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Container 类型 HlsEncrypt 的具体数据描述如下：

节点名称
（关键字）

父节点 描述
类
型

是否
必选

默

认
值

IsHlsEncr

ypt

Request.TransConf

ig.HlsEncrypt

是否开启HLS加密，取值 

true/false

Str

ing
否

fa

ls
e

UriKey
Request.TransConf

ig.HlsEncrypt

HLS加密的key，当
IsHlsEncrypt为true时, 该参数

才有意义

Str

ing
否 无

响应
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>1000</Bufsize>

                <Maxrate>10</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa
te

模板 ID String

Name
Response.Templa
te

模板名称 String

BucketId
Response.Templa

te
模板所属存储桶 String

Category
Response.Templa
te

模板属性，Custom 或者 Official String

Tag
Response.Templa
te

模板类型，HighSpeedHd String

UpdateTime
Response.Templa

te
更新时间 String

CreateTime
Response.Templa
te

创建时间 String

HighSpeedHd
Response.Templa
te

详细的模板参数
Contain
er



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第511 共1950页

Container 节点 HighSpeedHd 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键
字）

父节点 描述 类型

TimeInterval
Response.Template.HighS

peedHd

同请求体中的 

Request.TimeInterval

Contai

ner

Container
Response.Template.HighS

peedHd

同请求体中的 

Request.Container

Contai

ner

Video
Response.Template.HighS
peedHd

同请求体中的 Request.Video
Contai
ner

Audio
Response.Template.HighS

peedHd
同请求体中的 Request.Audio

Contai

ner

TransConfig
Response.Template.HighS

peedHd

同请求体中的 

Request.TransConfig

Contai

ner

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>1000</Bufsize>

https://cloud.tencent.com/document/product/460/42867
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        <Maxrate>10</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>
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                <Fps>30</Fps>

                <Bufsize>1000</Bufsize>

                <Maxrate>10</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-10 18:13:42

更新极速高清转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建极速高清模板接口的 Request  
Contain
er

是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84723#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建极速高清模板接口的 Response  Container

错误码

实际案例

请求

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84723#Response
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PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>HighSpeedHd</Tag>

    <Name>TemplateName</Name>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Profile>high</Profile>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

        <Bufsize>0</Bufsize>

        <Maxrate>0</Maxrate>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </Audio>

    <TransConfig>

        <IsCheckReso>false</IsCheckReso>

        <ResoAdjMethod>1</ResoAdjMethod>

    </TransConfig>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT
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Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>HighSpeedHd</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <HighSpeedHd>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Bufsize>0</Bufsize>

                <Maxrate>0</Maxrate>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </HighSpeedHd>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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闲时转码

提交任务
最近更新时间：2023-06-20 17:32:17

提交一个闲时转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Reques
t

创建任务的Tag：Transcode String 是

Input
Reques
t

待操作的文件信息
Contai
ner

是

Operation
Reques

t
操作规则

Contai

ner
是

CallBackFo
rmat

Reques
t

任务回调格式，JSON 或 XML，默认 XML，
优先级高于队列的回调格式

String 否

CallBackTy
pe

Reques
t

任务回调类型，Url 或 TDMQ，默认 Url，优先
级高于队列的回调类型

String 否
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 Transcode 的具体数据描述如下：

CallBack Reques
t

任务回调地址，优先级高于队列的回调地址。设
置为 no 时，表示队列的回调地址不产生回调

String 否

CallBackMq
Config

Reques
t

任务回调TDMQ配置，当 CallBackType 为 
TDMQ 时必填。详情见 CallBackMqConfig

Contai
ner

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

节点名称（关键

字）
父节点 描述 类型

是否

必选

TemplateId
Request.Op

eration
转码模板 ID String 否

Transcode
Request.Op
eration

转码模板参数
Contain
er

否

RemoveWat

ermark

Request.Op

eration

去除水印参数, H265、AV1编码暂不支持

该参数

Contain

er
否

Output
Request.Op

eration
结果输出配置

Contain

er
是

UserData
Request.Op
eration

透传用户信息, 可打印的 ASCII 码, 长度不
超过1024

String 否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别

越大任务优先级越高，默认为0
String 否

FreeTransc

ode

Request.Op

eration
闲时转码标记位, true/false String 否

说明

 对于转码参数，优先使用优先使用 TemplateId，无 TemplateId 时使用 Transcode；对于水印参

数，可以使用 WatermarkTemplateId 或 Watermark 设置，WatermarkTemplateId 优先级更

高。

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Container 的具体数据描述如下：

设定 container，音频视频支持的格式如下表所示：

Container 类型 Video 的具体数据描述如下：

节点名称（关键

字）

父节点 描述 类型 必

选

限制

Container
Request.Operation.

Transcode

容器

格式

Cont

ainer
是 无

Video
Request.Operation.
Transcode

视频
信息

Cont
ainer

否
不传 Video，相当于删除
视频信息

TimeInterval
Request.Operation.

Transcode

时间

区间

Cont

ainer
否 无

Audio
Request.Operation.

Transcode

音频

信息

Cont

ainer
否

不传 Audio，相当于删除

音频信息

TransConfig
Request.Operation.
Transcode

转码
配置

Cont
ainer

否 无

说明

 Video 和 Audio 不支持同时不传。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Format
Request.Operation.Transcod

e.Container

封装格式：取值见下

表

Stri

ng
是

Container Audio Codecs Video Codecs

mp4 aac、mp3 H.264、H.265、AV1

hls aac、mp3 H.264、H.265

flv aac、mp3 H.264

mp3 mp3 不支持

flac flac 不支持

m4a aac 不支持
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节点
名称

（关
键

字）

父节点 描述 类
型

是否
必选

默认值 限制

Cod

ec

Request.O
peration.Tr

anscode.V
ideo

编解码

格式

Str

ing
否 H.264

H.264

H.265

AV1

Fps

Request.O
peration.Tr

anscode.V
ideo

帧率
Str

ing
否 无

值范围：(0, 60]

单位：fps 

Bitr
ate

Request.O

peration.Tr
anscode.V

ideo

视频输

出文件
的码率

Str
ing

否 无
值范围：[128, 35000]

单位：Kbps

Widt

h

Request.O
peration.Tr

anscode.V
ideo

宽
Str

ing
否

视频原

始宽度

值范围：[128, 4096]

单位：px

若只设置 Width 时，按照
视频原始比例计算 Height

必须为偶数

Hei

ght

Request.O
peration.Tr

anscode.V
ideo

高
Str

ing
否

视频原

始高度

值范围：[128, 4096]

单位：px

若只设置 Height 时，按照
视频原始比例计算 Width

必须为偶数

Gop

Request.O
peration.Tr

anscode.V
ideo

关键帧
间最大

帧数

Str

ing
否 无 值范围：[1, 100000]

Crf

Request.O

peration.Tr
anscode.V

ideo

码率-

质量控
制因子

Str
ing

否 无

值范围：(0, 51]

如果设置了 Crf，则 

Bitrate 的设置失效

当 Bitrate 为空时，默认为

25 
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Container 类型 Audio 的具体数据描述如下：

Container 类型 TimeInterval 的具体数据描述如下：

Re

mov
e

Request.O

peration.Tr
anscode.V

ideo

是否删

除视频
流

Str

ing

否 false true、false, 不可以与 

Audio.Remove 同时为true

节点名
称（关

键字）

父节点 描述 类型

是
否

必
选

默认

值
限制

Code
c

Request.Operation.Tr
anscode.Audio

编解码
格式

Strin
g

否 aac
aac、mp3、
flac

Bitrat
e

Request.Operation.Tr
anscode.Audio

原始音
频码率

Strin
g

否 无

单位：Kbps 

值范围：[26，
256]

Sampl

erate

Request.Operation.Tr

anscode.Audio
采样率

Strin

g
否

441

00
44100

Chan
nels

Request.Operation.Tr
anscode.Audio

声道数
Strin
g

否 2 1、2

Remo

ve

Request.Operation.Tr

anscode.Audio

是否删

除源音
频流

Strin

g
否

fals

e

true、false，不
可以与 

Video.Remove 
同时为true

节点名

称（关
键字）

父节点 描述
类
型

是

否
必

选

默

认
值

限制

Start
Request.Operatio
n.Transcode.TimeI

nterval

开始

时间

Str

ing
否 0

[0 视频时长] 

单位为秒

支持 float 格式，执行精
度精确到毫秒

Durati

on

Request.Operatio

n.Transcode.TimeI

nterval

持续

时间

Str

ing

否 视

频

原

[0 视频时长] 

单位为秒 

支持 float 格式，执行精
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Container 类型 TransConfig 的具体数据描述如下：

Container 类型 RemoveWatermark 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

始
时

长

度精确到毫秒 

节点名称（关键

字）
父节点

描

述

类

型

是
否

必
选

默
认

值

限制

AdjDarMeth

od

Request.Oper
ation.Transco

de.TransConf
ig

分

辨

率
调

整
方

式

Str

ing
否 无

scale(拉伸)、pad(黑边

填充)

当输出视频的宽高比与原

视频不等时，根据此参数
做分辨率的相应调整

节点名称（关键
字）

父节点 描述
类
型

必
选

Dx
Request.Operation.Remo

veWatermark

距离左上角原点 x 偏移，范围为

[1, 4096]

stri

ng
是

Dy
Request.Operation.Remo

veWatermark

距离左上角原点 y 偏移，范围为

[1, 4096]

stri

ng
是

Width
Request.Operation.Remo
veWatermark

宽，范围为[1, 4096]
stri
ng

是

Height
Request.Operation.Remo

veWatermark
高，范围为[1, 4096]

stri

ng
是

节点名称（关键字） 父节点 描述 类型 是否必选

Region
Request.Operation.Ou

tput
存储桶的地域

Strin

g
是

Bucket
Request.Operation.Ou
tput

存储结果的存储桶
Strin
g

是
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Object Request.Operation.Ou

tput

输出结果的文件名 Strin

g

是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

节点名称（关键
字）

父节点 描述 类型

Code
Response.Job

sDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.Job

sDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.Job
sDetail

新创建任务的 ID String

Tag
Response.Job

sDetail
新创建任务的 Tag：Transcode String

State
Response.Job

sDetail

任务的状态，为 Submitted、Running、

Success、Failed、Pause、Cancel 其中一个
String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Progress Response.Job
sDetail

任务进度百分比，只有在State为 Submitted、
Running、Success、Pause 时有意义，范围

为[0, 100]

String

CreationTime
Response.Job
sDetail

任务的创建时间 String

StartTime
Response.Job
sDetail

任务的开始时间 String

EndTime
Response.Job

sDetail
任务的结束时间 String

QueueId
Response.Job
sDetail

任务所属的队列 ID String

Input
Response.Job
sDetail

该任务的输入资源地址
Conta
iner

Operation
Response.Job

sDetail
该任务的规则

Conta

iner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetai

l.Operation
任务的模板 ID String

TemplateNa
me

Response.JobsDetai
l.Operation

任务的模板名称, 当 TemplateId 存在
时返回

String

Transcode
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Transcode

Containe

r

Watermark Response.JobsDetai 同请求中的 Containe
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Container 节点 MediaInfo 的内容： 

同 GenerateMediaInfo  接口中的 Response.MediaInfo 节点。

Container 节点 MediaResult 的内容： 

详情见 MediaResult  。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

l.Operation Request.Operation.Watermark r 数组

RemoveWate

rmark

Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.RemoveWat

ermark

Containe

r

WatermarkTe
mplateId

Response.JobsDetai
l.Operation

水印模板 ID
String 数
组

Output
Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.Output

Containe

r

MediaInfo
Response.JobsDetai

l.Operation

输出文件的媒体信息，任务未完成时不

返回

Containe

r

MediaResult
Response.JobsDetai
l.Operation

输出文件的基本信息，任务未完成时不
返回

Containe
r

DigitalWater

mark

Response.JobsDetai

l.Operation

同请求中的 

Request.Operation.DigitalWater
mark

Containe

r

UserData
Response.JobsDetai
l.Operation

透传用户信息 String

JobLevel
Response.JobsDetai

l.Operation
任务优先级 String

错误码

实际案例

请求1：使用转码模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/38935
https://cloud.tencent.com/document/product/460/78927#MediaResult
https://cloud.tencent.com/document/product/460/42867
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<Request>

    <Tag>Transcode</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>
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        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>trans_993874</TemplateName>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用转码处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Transcode</Tag>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第532 共1950页

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Transcode>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>
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                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <RemoveWatermark>

            <Dx>150</Dx>

            <Dy>150</Dy>

            <Width>75</Width>

            <Height>75</Height>

        </RemoveWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>
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            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Profile>high</Profile>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                    <Preset>medium</Preset>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <TransConfig>

                    <AdjDarMethod>scale</AdjDarMethod>

                    <IsCheckReso>false</IsCheckReso>

                    <ResoAdjMethod>1</ResoAdjMethod>

                </TransConfig>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Transcode>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType></FontType>
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                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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音视频转封装（音视频分段）

提交任务
最近更新时间：2023-08-14 17:01:43

提交一个转封装（或音视频分段）任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>mp4</Format>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out-${number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Requ
est

创建任务的 Tag：Segment
Stri
ng

是

Input
Requ

est
待操作的文件信息

Con
tain

er

是

Operation
Requ
est

操作规则
Con
tain

er

是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Stri

ng
否

CallBackT
ype

Requ
est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于
队列的回调类型

Stri
ng

否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Segment 的具体数据描述如下：

CallBack Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Stri

ng

否

CallBackM
qConfig

Requ
est

任务回调TDMQ配置，当 CallBackType 为 TDMQ 
时必填。详情见 CallBackMqConfig

Con
tain

er

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

Segment
Request.
Operation

转封装参数
Con
tain

er

是

Output
Request.
Operation

结果输出配置
Con
tain

er

是

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Stri

ng
否

节点名称
（关键

字）

父节点 描述 类型
是否

必选

Format
Request.Operati
on.Segment

封装格式，支持 aac、mp3、flac、
mp4、ts、mkv、avi、hls、m3u8

Strin
g

是

Duration
Request.Operati
on.Segment

转封装时长
单位：秒

不小于5的整数

不设置 Duration 时，表示只转封装格式

不分段

Strin
g

否

Transco
deIndex

Request.Operati
on.Segment

处理的流编号，对应媒体信息中的 
Response.MediaInfo.Stream.Video.I

Strin
g

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 HlsEncrypt 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

ndex  和 

Response.MediaInfo.Stream.Audio.I

ndex，详见 获取媒体信息接口  

HlsEncry
pt

Request.Operati
on.Segment

hls 加密配置,当封装格式为 hls 和 m3u8 时
生效

Cont
ainer

否

StartTim
e

Request.Operati
on.Segment

开始时间

取值范围： [0,视频时长]，默认值为0

单位为秒

支持 float 格式，执行精度精确到毫秒

Strin
g

否

EndTime
Request.Operati

on.Segment

结束时间
取值范围：[0, 视频时长]，默认值为视频

结束时间

单位为秒

支持 float 格式，执行精度精确到毫秒

Strin

g
否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

IsHlsEncry
pt

Request.Operati

on.Segment.Hls
Encrypt

是否开启 HLS 加密，取值 true/false，默
认值 false

St

ri
n

g

否

UriKey
Request.Operati
on.Segment.Hls

Encrypt

HLS 加密的 key，当 IsHlsEncrypt 为 
true 时，该参数才有意义

St

ri
n

g

否

节点名
称（关

键字）

父节点 描述
类
型

是否
必选

Regio

n

Request.Oper

ation.Output
存储桶的地域

Str

ing
是

Buck
et

Request.Oper
ation.Output

存储结果的存储桶
Str
ing

是

https://cloud.tencent.com/document/product/460/49284#MediaInfo
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Objec
t

Request.Oper
ation.Output

输出结果的文件名，如果设置了 Duration，且 
Format 不为 HLS 或 m3u8 时，文件名必须包含 

${number} 参数作为自定义转封装后每一小段音/视
频流的输出序号

Str
ing

是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

${number} 产物索引，从0开始计数

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>mp4</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${number}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag Response.J
obsDetail

新创建任务的 Tag：Segment Stri
ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

Stri
ng

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的队列 ID
Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关

键字）
父节点 描述 类型

Segment Response.JobsDe 同请求中的 Request.Operation.Segment Contai
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

tail.Operation ner

Output
Response.JobsDe

tail.Operation
同请求中的 Request.Operation.Output

Contai

ner

MediaInfo
Response.JobsDe

tail.Operation

转码输出视频的信息，任务未完成时不返回，详

见 MediaInfo  

Contai

ner

MediaRes
ult

Response.JobsDe
tail.Operation

输出文件的基本信息，任务未完成时不返回，详
见 MediaResult  

Contai
ner

UserData
Response.JobsDe

tail.Operation
透传用户信息 String

JobLevel
Response.JobsDe

tail.Operation
任务优先级 String

错误码

实际案例

请求1：mp4转封装

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mkv</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>mp4</Format>

            <Duration>15</Duration>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/out-${number}</Object>

        </Output>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/demo.mkv</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>mp4</Format>

                <Duration>15</Duration>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out-${number}</Object>

            </Output>

            <UserData>This is my data.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>

请求2：hls转封装并加密

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Segment</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Segment>

            <Format>mp4</Format>

            <Duration>5</Duration>

            <HlsEncrypt>

                <IsHlsEncrypt>true</IsHlsEncrypt>

                <UriKey>test-key</UriKey>

            </HlsEncrypt>

        </Segment>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/out-${number}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Segment</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Segment>

                <Format>mp4</Format>

                <Duration>5</Duration>

                <HlsEncrypt>

                    <IsHlsEncrypt>true</IsHlsEncrypt>

                    <UriKey>test-key</UriKey>

                </HlsEncrypt>

            </Segment>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <CallBack>http://callback.demo.com</CallBack>

        <CallBackFormat>JSON<CallBackFormat>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>
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                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交转封装任务接口中的 

Response.JobsDetail  

Contain

er 数组

https://cloud.tencent.com/document/product/460/84789#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>
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                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>
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                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>

                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>
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                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>
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        <CreationTime>2022-06-30T19:14:31+0800</CreationTime>

        <EndTime>2022-06-30T19:14:36+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>jd0c0da74f86511ec8a5a87e016101404</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>2629.749000</Bitrate>

                    <Duration>215.680000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>70898041</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>
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                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2369.296000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>59a4edd95c6ddca43277d82cf33edc0d</Md5>
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                        <ObjectName>output/segment-0</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7fdacd7f2e2dbdc1dc3ccc00f96893b5</Md5>

                        <ObjectName>output/segment-1</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4c377ddb6f65021f6741dbd45bbff654</Md5>

                        <ObjectName>output/segment-2</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>59317dbc9db6d4d6fb723e3005809c01</Md5>

                        <ObjectName>output/segment-3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a81091e57005eece211b5f60bfbddea1</Md5>

                        <ObjectName>output/segment-4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>7b87e88264a983a06b17558c8a3a2bd8</Md5>

                        <ObjectName>output/segment-5</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>607b2abc29ed11ad1d2f678b594c6ffa</Md5>

                        <ObjectName>output/segment-6</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>4fe2d33dc9d08a5ea9d5d6db0f724008</Md5>

                        <ObjectName>output/segment-7</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>a84dd4f738ce81f4e3da55b393b2fae4</Md5>

                        <ObjectName>output/segment-8</ObjectName>

                    </Md5Info>

                    <ObjectName>0</ObjectName>

                    <ObjectName>1</ObjectName>

                    <ObjectName>2</ObjectName>

                    <ObjectName>3</ObjectName>

                    <ObjectName>4</ObjectName>

                    <ObjectName>5</ObjectName>

                    <ObjectName>6</ObjectName>

                    <ObjectName>7</ObjectName>

                    <ObjectName>8</ObjectName>

                    <ObjectPrefix>output/segment-</ObjectPrefix>

                    <Region>ap-chongqing</Region>
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                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/segment-${number}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <Segment>

                <Duration>25</Duration>

                <Format>mp4</Format>

                <HlsEncrypt>

                    <IsHlsEncrypt>false</IsHlsEncrypt>

                    <UriKey/>

                </HlsEncrypt>

            </Segment>

            <UserData>This is my Segment job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:14:32+0800</StartTime>

        <State>Success</State>

        <Tag>Segment</Tag>

        <Workflow>

            <Name>Segment_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:14:31+0800"

        "EndTime": "2022-06-30T19:14:36+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

{

,

[{

,

,

,

{

,

,

,

[{
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                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "jd0c0da74f86511ec8a5a87e016101404"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "2629.749000"

                    "Duration": "215.680000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "70898041"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "256.000000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/48000"

                        "Duration": "215.637000"

                        "Index": "1"

                        "Language": "eng"

                        "SampleFmt": "fltp"

                        "SampleRate": "48000"

,

},

{

,

},

{

,

},

{

,

}

]

},

,

{

{

{

,

,

,

,

,

,

,

},

{

[{

,

,

,

,

,

,

,

,

,

,

,

,

,
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                        "StartTime": "0.000000"

                        "Timebase": "1/48000"

                    

                    "Video": 

                        "AvgFps": "24.000000"

                        "Bitrate": "2369.296000"

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10"

                        "CodecName": "h264"

                        "CodecTag": "0x31637661"

                        "CodecTagString": "avc1"

                        "CodecTimeBase": "1/12288"

                        "ColorPrimaries": "unknown"

                        "ColorRange": "unknown"

                        "ColorTransfer": "unknown"

                        "Duration": "215.583333"

                        "Fps": "24.000000"

                        "HasBFrame": "2"

                        "Height": "1080"

                        "Index": "0"

                        "Language": "und"

                        "Level": "40"

                        "NumFrames": "5174"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.000000"

                        "Timebase": "1/12288"

                        "Width": "1920"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                            "Md5": "59a4edd95c6ddca43277d82cf33edc0d"

                            "ObjectName": "output/segment-0"

                        

                        

                            "Md5": "7fdacd7f2e2dbdc1dc3ccc00f96893b5"

                            "ObjectName": "output/segment-1"

                        

                        

                            "Md5": "4c377ddb6f65021f6741dbd45bbff654"

,

}],

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}]

}

},

{

{

,

[{

,

},

{

,

},

{

,
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                            "ObjectName": "output/segment-2"

                        

                        

                            "Md5": "59317dbc9db6d4d6fb723e3005809c01"

                            "ObjectName": "output/segment-3"

                        

                        

                            "Md5": "a81091e57005eece211b5f60bfbddea1"

                            "ObjectName": "output/segment-4"

                        

                        

                            "Md5": "7b87e88264a983a06b17558c8a3a2bd8"

                            "ObjectName": "output/segment-5"

                        

                        

                            "Md5": "607b2abc29ed11ad1d2f678b594c6ffa"

                            "ObjectName": "output/segment-6"

                        

                        

                            "Md5": "4fe2d33dc9d08a5ea9d5d6db0f724008"

                            "ObjectName": "output/segment-7"

                        

                        

                            "Md5": "a84dd4f738ce81f4e3da55b393b2fae4"

                            "ObjectName": "output/segment-8"

                        

                    

                    "ObjectName": 

                        "0"

                        "1"

                        "2"

                        "3"

                        "4"

                        "5"

                        "6"

                        "7"

                        "8"

                    

                    "ObjectPrefix": "output/segment-"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/segment-${number}"

},

{

,

},

{

,

},

{

,

},

{

,

},

{

,

},

{

,

}

],

[

,

,

,

,

,

,

,

,

],

,

}

},

{

,

,
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                "Region": "ap-chongqing"

            

            "Segment": 

                "Duration": "25"

                "Format": "mp4"

                "HlsEncrypt": 

                    "IsHlsEncrypt": "false"

                

            

            "UserData": "This is my Segment job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T19:14:32+0800"

        "State": "Success"

        "Tag": "Segment"

        "Workflow": 

            "Name": "Segment_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

},

{

,

,

{

}

},

,

},

,

,

,

,

{

,

,

,

}

}]

}
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音视频流分离

提交任务
最近更新时间：2023-08-01 16:46:23

提交一个音视频流分离任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：StreamExtract

Strin

g
是

Input
Req
uest

待操作的文件信息
Cont
ainer

是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBack

Format

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Strin

g
否

CallBack
Type

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队
列的回调类型

Strin
g

否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

Container 类型 StreamExtract 的具体数据描述如下：

CallBack
MqConfig

Req
uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时
必填。详情见 CallBackMqConfig

Cont
ainer

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

Output
Request.

Operation
结果输出配置

Con

tain
er

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng
否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Stri

ng
否

节点名称（关键
字）

父节点 描述 类型
是否
必选

Region
Request.Operatio

n.Output
存储桶的地域 String 是

Bucket
Request.Operatio

n.Output
存储结果的存储桶 String 是

StreamExtrac
t

Request.Operatio
n.Output

结果文件配置信息，最多支持10
个流配置

Contain
er 数组

是

节点

名称
（关

键
字）

父节点 描述
类
型

是

否
必

选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Inde

x

Request.Operation.Out

put.StreamExtract

流的编号，对应媒体信息中的 

Response.MediaInfo.Stream.
Video.Index和

Response.MediaInfo.Stream.Audio.In
dex，详见 获取媒体信息接口 ，当输入媒体

格式为 mxf 格式时，只支持提取 video 流

Str

ing

是

Obje

ct

Request.Operation.Out

put.StreamExtract
结果输出文件名

Str

ing
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/49284#MediaInfo
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>  

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称（关键

字）
父节点 描述 类型

Code
Response.Jo
bsDetail

错误码，只有 State 为 Failed 时有意义 String

Message
Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.Jo

bsDetail
新创建任务的 ID String

Tag
Response.Jo
bsDetail

新创建任务的 Tag：StreamExtract String

State Response.Jo
bsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任

String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

务会变为暂停状态

Cancel：任务被取消执行

CreationTim
e

Response.Jo
bsDetail

任务的创建时间 String

StartTime
Response.Jo

bsDetail
任务的开始时间 String

EndTime
Response.Jo
bsDetail

任务的结束时间 String

QueueId
Response.Jo
bsDetail

任务所属的 队列 ID  String

Input
Response.Jo

bsDetail
该任务的输入资源地址

Conta

iner

Operation
Response.Jo
bsDetail

该任务的规则
Conta
iner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关

键字）
父节点 描述 类型

Output
Response.JobsDe
tail.Operation

同请求中的 Request.Operation.Output
Cont
ainer

MediaResul

t

Response.JobsDe

tail.Operation

输出文件的基本信息，任务未完成时不返回，详情

见 MediaResult  

Cont

ainer

UserData
Response.JobsDe

tail.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDe
tail.Operation

任务优先级
Strin
g

https://cloud.tencent.com/document/product/460/46487
https://cloud.tencent.com/document/product/460/78927#MediaResult
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>StreamExtract</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <StreamExtract>

                <Index>0</Index>

                <Object>output/out0.mp4</Object>

            </StreamExtract>

            <StreamExtract>

                <Index>1</Index>

                <Object>output/out1.mp4</Object>

            </StreamExtract>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

https://cloud.tencent.com/document/product/460/42867
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Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>StreamExtract</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交流分离任务接口中的 
Response.JobsDetail  

Contain
er数组

https://cloud.tencent.com/document/product/460/84787#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:27:39+0800</CreationTime>

        <EndTime>2022-06-30T19:27:42+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ja66d6204f86711ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>e8c802ed78ba7f4c6a2fb5144cba7cbc</Md5>

                        <ObjectName>output/out0.mp4</ObjectName>

                    </Md5Info>
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                    <Md5Info>

                        <Md5>f5883c1380524eecd1a925657ab17b4c</Md5>

                        <ObjectName>output/out1.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out0.mp4</ObjectName>

                    <ObjectName>output/out1.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Region>ap-chongqing</Region>

                <StreamExtract>

                    <Index>0</Index>

                    <Output>output/out0.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>1</Index>

                    <Output>output/out1.mp4</Output>

                </StreamExtract>

                <StreamExtract>

                    <Index>2</Index>

                    <Output>output/out2.mp4</Output>

                </StreamExtract>

            </Output>

            <UserData>This is my StreamExtract job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:27:40+0800</StartTime>

        <State>Success</State>

        <Tag>StreamExtract</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:27:39+0800"

        "EndTime": "2022-06-30T19:27:42+0800"

{

,

[{

,

,

,
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        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "ja66d6204f86711ec9ca1073b78d316d3"

        "Operation": 

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                            "Md5": "e8c802ed78ba7f4c6a2fb5144cba7cbc"

                            "ObjectName": "output/out0.mp4"

                        

                        

                            "Md5": "f5883c1380524eecd1a925657ab17b4c"

                            "ObjectName": "output/out1.mp4"

                        

                    

                    "ObjectName": 

                        "output/out0.mp4"

                        "output/out1.mp4"

                    

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Region": "ap-chongqing"

                "StreamExtract": 

                        "Index": "0"

                        "Output": "output/out0.mp4"

                    

                    

                        "Index": "1"

                        "Output": "output/out1.mp4"

                    

                    

                        "Index": "2"

                        "Output": "output/out2.mp4"

                    

                

            

            "UserData": "This is my StreamExtract job."

            "JobLevel": 0

{

,

,

},

,

{

{

{

,

[{

,

},

{

,

}

],

[

,

],

}

},

{

,

,

[{

,

},

{

,

},

{

,

}

]

},

,
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        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T19:27:40+0800"

        "State": "Success"

        "Tag": "StreamExtract"

    

},

,

,

,

}]

}
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音视频拼接

提交任务
最近更新时间：2023-08-01 16:46:23

提交一个拼接任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req
ues

t

创建任务的 Tag：Concat
Stri
ng

是

Input
Req
ues

t

待操作的文件信息
Con
tain

er

否

Operation

Req

ues
t

操作规则

Con

tain
er

是

CallBackF

ormat

Req

ues
t

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Stri

ng
否

CallBackT

ype

Req
ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型

Stri

ng
否

CallBack
Req
ues

t

任务回调地址，优先级高于队列的回调地址。设置为 no 
时，表示队列的回调地址不产生回调

Stri
ng

否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 ConcatTemplate 的具体数据描述如下：

CallBackM
qConfig

Req
ues

t

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时
必填。详情见 CallBackMqConfig

Con
tain

er

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

TemplateI
d

Request.
Operation

拼接模板 ID
Stri
ng

否

ConcatTe

mplate

Request.

Operation
拼接参数

Con

tain
er

否

Output
Request.

Operation
结果输出配置

Con

tain

er

是

JobLevel
Request.
Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务
优先级越高，默认为0

Stri
ng

否

注意

拼接参数必须设置，可以通过 TemplateId 或 ConcatTemplate 设置， TemplateId 优先级更高。

节点名称

（关键字）
父节点 描述 类型

默认

值

是否

必选

ConcatF
ragment

Request.O

peration.C
oncatTem

plate

拼接节点，支持多个文件，按照文件
顺序拼接

Contain
er 数组

无 否

Audio Request.O
peration.C

音频参数，同创建拼接模板接口中的 
Request.ConcatTemplate.A

udio  

Contain
er

无 否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84730#Audio
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Container 类型 ConcatFragment 的具体数据描述如下：

oncatTem

plate

Video

Request.O
peration.C

oncatTem
plate

视频参数，同创建拼接模板接口中的 

Request.ConcatTemplate.Vi

deo  

Contain

er
无 否

Containe

r

Request.O

peration.C

oncatTem
plate

封装格式，同创建拼接模板接口中的 

Request.ConcatTemplate.Co
ntainer  

Contain

er
无 是

AudioMi
x

Request.O

peration.C
oncatTem

plate

混音参数，详情见 AudioMix  
Contain
er

无 否

AudioMi
xArray

Request.O
peration.Tr

anscode

混音参数数组，最多同时传2个
Contain
er 数组

无 否

Index

Request.O

peration.C
oncatTem

plate

Input 节点位于 
ConcatFragment 序列索引，不

能大于 ConcatFragment 长度

String 0 否

DirectCo

ncat

Request.O
peration.C

oncatTem
plate

简单拼接方式（不转码直接拼接），
其他的视频和音频参数失效，取值 

true/false

String false 否

说明

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix  。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

节点名称（关

键字）
父节点 描述

类

型

默认

值

是否

必选

Url Request.O

peration.

同 bucket 对象地址，需要 urlEncode St

ri

无 是

https://cloud.tencent.com/document/product/460/84730#Video
https://cloud.tencent.com/document/product/460/84730#Container
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

ConcatTe

mplate.

ConcatFra
gment

n

g

FragmentI

ndex

Request.O

peration.
ConcatTe

mplate.
ConcatFra

gment

拼接对象的索引位置，大于等于0的整数

St
ri

n
g

0 否

StartTime

Request.O
peration.

ConcatTe
mplate.

ConcatFra
gment

开始时间

[0, 视频时长]

单位为秒 

当

Request.Operation.ConcatTem
plate.DirectConcat 为 true 时不

生效

St

ri
n

g

视频
开始

否

EndTime

Request.O
peration.

ConcatTe
mplate.

ConcatFra
gment

结束时间

[0, 视频时长]

单位为秒 

当 

Request.Operation.ConcatTem

plate.DirectConcat 为 true 时不
生效

St

ri
n

g

视频
结束

否

节点名称（关键字） 父节点 描述 类型 是否必选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket
Request.Operation.Out
put

存储结果的存储桶
Strin
g

是

Object
Request.Operation.Out

put
输出结果的文件名

Strin

g
是

通配符 含义
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点  的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J
obsDetail

新创建任务的 Tag：Concat
Stri
ng

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

Stri
ng

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

QueueId Response.J
obsDetail

任务所属的 队列 ID  Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关

键字）
父节点 描述 类型

TemplateId
Response.JobsDet
ail.Operation

任务的模板 ID
Strin
g

TemplateN
ame

Response.JobsDet
ail.Operation

任务的模板名称, 当 TemplateId 存在时返回
Strin
g

ConcatTem

plate

Response.JobsDet

ail.Operation

同请求中的 

Request.Operation.ConcatTemplate

Cont

ainer

Output
Response.JobsDet
ail.Operation

同请求中的 Request.Operation.Output
Cont
ainer

MediaInfo
Response.JobsDet
ail.Operation

输出文件的媒体信息，任务未完成时不返回，详
见 MediaInfo  

Cont
ainer

MediaResul

t

Response.JobsDet

ail.Operation

输出文件的基本信息，任务未完成时不返回，详

见 MediaResult  

Cont

ainer

UserData
Response.JobsDet
ail.Operation

透传用户信息
Strin
g

JobLevel Response.JobsDet 任务优先级 Strin

https://cloud.tencent.com/document/product/460/46487
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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常见的错误信息请参见 错误码  文档。

ail.Operation g

错误码

实际案例

请求1：使用拼接模板 ID

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

https://cloud.tencent.com/document/product/460/42867
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x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>concat_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用拼接参数

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Input>
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        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ConcatTemplate>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4</Url>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</Url>

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height>720</Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>
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                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>
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            <ConcatTemplate>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4</Ur

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</Url

                </ConcatFragment>

                <Audio>

                    <Codec>mp3</Codec>

                </Audio>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height>720</Height>

                    <Fps>30</Fps>

                </Video>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>
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                </AudioMixArray>

                <Index>1</Index>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求3：多文件拼接

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-123456789.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Operation>

        <ConcatTemplate>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4</Url>

                <FragmentIndex>0</FragmentIndex>

                <StartTime>0</StartTime>

                <EndTime>6</EndTime>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle.mp4</Ur

                <FragmentIndex>1</FragmentIndex>

            </ConcatFragment>

            <ConcatFragment>

                <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</Url>

                <FragmentIndex>2</FragmentIndex>

                <StartTime>5</StartTime>

                <EndTime>10</EndTime>

            </ConcatFragment>

            <Container>
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                <Format>mp4</Format>

            </Container>

        </ConcatTemplate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c5d</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Concat</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ConcatTemplate>

                <ConcatFragment>
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                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/start.mp4</Ur

                    <StartTime>0</StartTime>

                    <EndTime>6</EndTime>

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/middle.mp4</

                </ConcatFragment>

                <ConcatFragment>

                    <Url>http://test-123456789.cos.ap-chongqing.myqcloud.com/end.mp4</Url

                    <StartTime>5</StartTime>

                    <EndTime>10</EndTime>

                </ConcatFragment>

                <Container>

                    <Format>mp4</Format>

                </Container>

            </ConcatTemplate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:42

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>
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具体的数据内容如下：

Container 节点 Response 的内容：

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交拼接任务接口中的 

Response.JobsDetail  

Contain

er 数组

https://cloud.tencent.com/document/product/460/84788#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosHe
aders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosHe

aders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>
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                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>
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                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:33:07+0800</CreationTime>

        <EndTime>2022-06-30T18:33:20+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j07f6263af86011ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>830.482000</Bitrate>

                    <Duration>70.413000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>7309593</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>32.020000</Bitrate>

                        <Channel>2</Channel>
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                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>70.412857</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.990016</AvgFps>

                        <Bitrate>803.112000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Dar>4:3</Dar>

                        <Duration>69.779778</Duration>

                        <Fps>15.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>32</Level>

                        <NumFrames>1046</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <Sar>1:1</Sar>

                        <StartTime>0.046000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>
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            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>96322f8638d38480683e069e6b2ba1e9</Md5>

                        <ObjectName>output/concat.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/concat.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/concat.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

            <TemplateName>template_name3544697</TemplateName>

            <UserData>This is my Concat job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:33:08+0800</StartTime>

        <State>Success</State>

        <Tag>Concat</Tag>

        <Workflow>

            <Name>Concat_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T18:33:07+0800"

        "EndTime": "2022-06-30T18:33:20+0800"

{

,

[{

,

,

,
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        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j07f6263af86011ecbdf419856486c0ab"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "830.482000"

                    "Duration": "70.413000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "7309593"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "32.020000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

{

,

,

,

[{

,

},

{

,

},

{

,

},

{

,

}

]

},

,

{

{

{

,

,

,

,

,

,

,

},

{

[{

,

,

,

,

,

,

,

,
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                        "Duration": "70.412857"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "14.990016"

                        "Bitrate": "803.112000"

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10"

                        "CodecName": "h264"

                        "CodecTag": "0x31637661"

                        "CodecTagString": "avc1"

                        "CodecTimeBase": "1/90000"

                        "ColorPrimaries": "unknown"

                        "ColorRange": "unknown"

                        "ColorTransfer": "unknown"

                        "Dar": "4:3"

                        "Duration": "69.779778"

                        "Fps": "15.000000"

                        "HasBFrame": "2"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "32"

                        "NumFrames": "1046"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "Sar": "1:1"

                        "StartTime": "0.046000"

                        "Timebase": "1/90000"

                        "Width": "1280"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "96322f8638d38480683e069e6b2ba1e9"

                        "ObjectName": "output/concat.mp4"

,
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,
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                    "ObjectName": "output/concat.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/concat.${ext}"

                "Region": "ap-chongqing"

            

            "TemplateId": "t140325e8918ac423da53b7d78dbbab564"

            "TemplateName": "template_name3544697"

            "UserData": "This is my Concat job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T18:33:08+0800"

        "State": "Success"

        "Tag": "Concat"

        "Workflow": 

            "Name": "Concat_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

}],

[ ],

}

},

{

,
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},
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创建模板
最近更新时间：2023-08-01 16:46:24

创建音视频拼接模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求实例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

公共头部

非公共头部

请求体

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

    </ConcatTemplate>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键
字）

父节点 描述 类型
必
选

Tag
Reque

st
模板类型：Concat String 是

Name
Reque
st

模板名称仅支持中文、英文、数字、_、-和
*，长度不超过 64

String 是

ConcatTemplat
e

Reque
st

拼接模板
Contain
er

是

ConcatTemplate

节点名称（关

键字）
父节点 描述 类型 默认值

是否

必选

ConcatFra
gment

Request.Conc
atTemplate

拼接节点
Contain
er 数组

无 是

Audio
Request.Conc
atTemplate

音频参数
Contain
er

媒体原
始值

否

Video
Request.Conc

atTemplate
视频参数

Contain

er

媒体原

始值
否

Container
Request.Conc
atTemplate

封装格式
Contain
er

无 是

AudioMix Request.Conc 混音参数，详情见 Contain 无 否
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Container 数组 类型  的具体数据描述如下：

atTemplate AudioMix  er

AudioMixA
rray

Request.Conc
atTemplate

混音参数，最多同时传2个
Contain
er 数组

无 否

DirectCon
cat

Request.Conc
atTemplate

只拼接不转码，取值 true/ 
false

String false 否

SceneCha

ngeInfo

Request.Conc

atTemplate
转场参数

Contain

er
无 否

说明

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix 。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

ConcatFragment

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否

必选

Url
Request.ConcatTemplat

e.ConcatFragment
拼接对象地址

St
ri

n
g

无 是

Mode
Request.ConcatTemplat

e.ConcatFragment

节点类型

Start：开头

End：结尾

St
ri

n
g

无 是

StartTime
Request.ConcatTemplat

e.ConcatFragment

开始时间，单位为秒, 支

持float格式，执行精度
精确到毫秒，当

Request.ConcatTem
plate.DirectConcat 

为 true 时不生效

St
ri

n
g

无 否

EndTime Request.ConcatTemplat

e.ConcatFragment

结束时间，单位为秒, 支

持float格式，执行精度
精确到毫秒，当 

Request.ConcatTem
plate.DirectConcat 

为 true 时不生效

St

ri
n

g

无 否

https://cloud.tencent.com/document/product/460/78927#AudioMix
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Container 类型  的具体数据描述如下：

Y 表示支持这种采样率，N 表示不支持。

Container 类型  的具体数据描述如下：

Audio

节点名称（关
键字）

父节点 描述
类
型

默认值
是否
必选

Codec
Request.ConcatTe

mplate.Audio

编解码格式，取值 aac、

mp3

St

ri

n
g

无 是

Samplerat
e

Request.ConcatTe
mplate.Audio

采样率

单位：Hz

可选 11025、22050、

32000、44100、
48000、96000

不同的封装，mp3 支持
不同的采样率，如下表

所示

St

ri
n

g

文件原采
样率

否

Bitrate
Request.ConcatTe

mplate.Audio

音频码率
单位：Kbps

值范围：[8，1000]

St
ri

n
g

文件原音

频码率
否

Channels
Request.ConcatTe
mplate.Audio

声道数
当 Codec 设置为 

aac，支持1、2、4、
5、6、8

当 Codec 设置为 
mp3，支持1、2

St

ri
n

g

文件原声
道数

否

封装格式/音频采样率 11025 22050 32000 44100 48000 96000

mp3 Y Y Y Y Y N

Container

节点名称（关键

字）
父节点 描述 类型

是否

必选

Format
Request.ConcatTempla
te.Container

封装格式：mp4，flv，hls，
ts, mp3, aac

Stri
ng

是
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Container 类型  的具体数据描述如下：Video

节点名称（关
键字）

父节点 描述
类
型

默认值
是否
必选

Codec
Request.ConcatTe

mplate.Video
编解码格式，取值H.264

Str

ing
H.264 是

Width
Request.ConcatTe

mplate.Video

宽
值范围：[128，

4096]

单位：px

若只设置 Width 时，
按照视频原始比例计

算 Height

必须为偶数

Str

ing

视频原

始宽度
否

Height
Request.ConcatTe
mplate.Video

高

值范围：[128，
4096]

单位：px

若只设置 Height 时，

按照视频原始比例计
算 Width

必须为偶数

Str
ing

视频原
始高度

否

Fps
Request.ConcatTe
mplate.Video

帧率
值范围：(0，60]

单位：fps

Str
ing

视频原
始帧率

否

Bitrate
Request.ConcatTe

mplate.Video

视频输出文件的码率
值范围：[10，

50000]

单位：Kbps  

Str

ing

视频原

始码率
否

Crf
Request.ConcatTe

mplate.Video

码率-质量控制因子

值范围：(0, 51]

如果设置了 Crf，则 

Bitrate 的设置失效

当 Bitrate 为空时，

默认为25 

Str

ing

视频原

始码率
否

Remove Request.ConcatTe

mplate.Video

是否删除视频流，取值 

true、false

Str

ing

false 否
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Container 类型  的具体数据描述如下：

该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Rotate
Request.ConcatTe

mplate.Video

旋转角度
值范围：[0, 360)

单位：度

Str

ing
无 否

SceneChangeInfo

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否必选

Mode

Request.Conc

atTemplate.Sc

eneChangeInf
o

转场模式
Default：不添加转场特

效

FADE：淡入淡出

GRADIENT：渐变

St

ri

n
g

无 是

Time

Request.Conc
atTemplate.Sc

eneChangeInf
o

转场时长
单位：秒(s)

取值范围：(0, 5]，支持小数

St
ri

n
g

3

单位：秒(s)

取值范围：

(0, 5]，支
持小数

响应

响应头

公共响应头

特有响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

https://cloud.tencent.com/document/product/460/42866
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        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templ
ate

模板 ID String

Name
Response.Templ

ate
模板名称 String

BucketId
Response.Templ

ate
模板所属存储桶 String

Category
Response.Templ
ate

模板属性，Custom 或者 Official String

Tag
Response.Templ

ate
模板类型，Concat String

UpdateTime Response.Templ 更新时间 String
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该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

ate

CreateTime
Response.Templ

ate
创建时间 String

ConcatTemplate
Response.Templ

ate

同请求体中的 

Request.ConcatTemplate

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Concat</Tag>

   <Name>TemplateName</Name>

   <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

https://cloud.tencent.com/document/product/460/42867
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        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

   </ConcatTemplate>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>
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    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>
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            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-18 15:28:02

更新音视频拼接模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求实例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

公共头部

非公共头部

请求体

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>
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具体数据描述如下：

该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

    </ConcatTemplate>

</Request>

节点名称（关键字） 父节点 描述 类型

Request 无 同创建拼接模板接口的 Request  Container

响应

响应头

公共响应头

特有响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

            </ConcatFragment>

            <Audio>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84730#Request
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                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>
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具体的数据内容如下：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建拼接模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Concat</Tag>

    <Name>TemplateName</Name>

    <ConcatTemplate>

        <ConcatFragment>

            <Mode>Start</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

        </ConcatFragment>

        <ConcatFragment>

            <Mode>End</Mode>

            <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

        </ConcatFragment>

        <Audio>

            <Codec>mp3</Codec>

            <Samplerate></Samplerate>

            <Bitrate></Bitrate>

            <Channels></Channels>

        </Audio>

        <Video>

            <Codec>H.264</Codec>

            <Bitrate>1000</Bitrate>

            <Width>1280</Width>

            <Height></Height>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84730#Response
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            <Fps>30</Fps>

        </Video>

        <Container>

            <Format>mp4</Format>

        </Container>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

        <AudioMixArray>

            <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</Aud

            <MixMode>Once</MixMode>

            <Replace>true</Replace>

            <EffectConfig>

                <EnableStartFadein>true</EnableStartFadein>

                <StartFadeinTime>3</StartFadeinTime>

                <EnableEndFadeout>false</EnableEndFadeout>

                <EndFadeoutTime>0</EndFadeoutTime>

                <EnableBgmFade>true</EnableBgmFade>

                <BgmFadeTime>1.7</BgmFadeTime>

            </EffectConfig>

        </AudioMixArray>

    </ConcatTemplate>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=
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<Response>

    <RequestId>NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Concat</Tag>

        <Name>TemplateName</Name>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/start.mp4</Url>

            </ConcatFragment>

            <ConcatFragment>

                <Mode>End</Mode>

                <Url>http://bucket-1250000000.cos.ap-beijing.myqcloud.com/end.mp4</Url>

            </ConcatFragment>

            <Audio>

                <Codec>mp3</Codec>

                <Samplerate></Samplerate>

                <Bitrate></Bitrate>

                <Channels></Channels>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

                <Fps>30</Fps>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>
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                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </ConcatTemplate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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精彩集锦

提交任务
最近更新时间：2023-08-01 16:46:24

提交一个精彩集锦任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关
键字）

父节
点

描述 类型
是否
必选

Tag
Req

uest
创建任务的 Tag：VideoMontage String 是

Input
Req
uest

待操作的文件信息
Conta
iner

是

Operation
Req
uest

操作规则
Conta
iner

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式
String 否

CallBackT
ype

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于
队列的回调类型

String 否

CallBack
Req
uest

任务回调地址，优先级高于队列的回调地址。设置为 
no 时，表示队列的回调地址不产生回调

String 否

CallBackM

qConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Conta

iner
否

节点名称（关 父节点 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 VideoMontage 的具体数据描述如下：

键字）

Object

Reque

st.Inpu
t

同存储桶文件路径
Stri

ng
否

Url

Reque

st.Inpu

t

支持公网下载的Url
Stri

ng
否

说明：

Url 与 Object 不可同时为空，且当两者都传入时，优先使用Object

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

TemplateI

d

Request.Op

eration
模板 ID

Strin

g
否

VideoMont

age

Request.Op

eration
精彩集锦模板参数

Cont

ainer
否

Output
Request.Op
eration

结果输出配置
Cont
ainer

是

UserData
Request.Op

eration

透传用户信息，可打印的 ASCII 码，长度不超

过1024

Strin

g
否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越大

任务优先级越高，默认为0

Strin

g
否

注意

精彩集锦参数必须设置，可以通过 TemplateId 或 VideoMontage 设置， TemplateId 优先级更高。

节点名称
（关键

字）

父节点 描述 类型
是否

必选

TimeInt
erval

Request.Operatio
n.Transcode

同创建精彩集锦模板接口中的 
Request.TimeInterval  

Contain
er

否

https://cloud.tencent.com/document/product/460/84724#TimeInterval
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

Contain
er

Request.Operatio
n.Transcode

同创建精彩集锦模板接口中的 
Request.Container  

Contain
er

是

Video
Request.Operatio

n.Transcode

同创建精彩集锦模板接口中的 

Request.Video  

Contain

er
是

Audio
Request.Operatio
n.Transcode

同创建精彩集锦模板接口中的 
Request.Audio  

Contain
er

否

Scene
Request.Operatio
n.Transcode

同创建精彩集锦模板接口中的 
Request.Scene  

String 否

AudioMi

x

Request.Operatio

n.Transcode
混音参数，详情见 AudioMix  

Contain

er 数组
否

AudioMi
xArray

Request.Operatio
n.Transcode

混音参数数组，最多同时传2个
Contain
er 数组

否

说明

不传 Video，相当于删除视频信息。不传 Audio，相当于删除音频信息。Video 和 Audio 不可以同

时不传。

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix  。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.Outp
ut

存储桶的地域
Stri
ng

是

Bucket
Request.Operation.Outp

ut
存储结果的存储桶

Stri

ng
是

Object
Request.Operation.Outp

ut
输出结果的文件名

Stri

ng
是

通配符 含义

${ext} 封装格式

https://cloud.tencent.com/document/product/460/84724#Container
https://cloud.tencent.com/document/product/460/84724#Video
https://cloud.tencent.com/document/product/460/84724#Audio
https://cloud.tencent.com/document/product/460/84724#Request
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMix
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

${jobid} 任务 Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点  的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J
obsDetail

新创建任务的 Tag：VideoMontage
Stri
ng

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

Stri
ng

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId Response.J
obsDetail

任务所属的 队列 ID  Stri
ng

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关

键字）
父节点 描述 类型

TemplateI
d

Response.JobsDe
tail.Operation

任务的模板 ID String

TemplateN
ame

Response.JobsDe
tail.Operation

任务的模板名称, 当 TemplateId 存在时返回 String

VideoMont

age

Response.JobsDe

tail.Operation

同请求中的 

Request.Operation.VideoMontage

Conta

iner

Output
Response.JobsDe
tail.Operation

同请求中的 Request.Operation.Output
Conta
iner

MediaInfo
Response.JobsDe
tail.Operation

转码输出视频的信息，任务未完成时不返回，详
见 MediaInfo  

Conta
iner

MediaRes

ult

Response.JobsDe

tail.Operation

输出文件的基本信息，任务未完成时不返回，详

见 MediaResult  

Conta

iner

UserData
Response.JobsDe

tail.Operation
透传用户信息 String

JobLevel
Response.JobsDe
tail.Operation

任务优先级 String

https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

案例一：使用精彩集锦模板 ID

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

https://cloud.tencent.com/document/product/460/42867
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>videomontage_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

案例二：使用精彩集锦处理参数

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第636 共1950页

    <Operation>

        <VideoMontage>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Height></Height>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <Duration>15</Duration>

        </VideoMontage>
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        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoMontage</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoMontage>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>
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                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Height></Height>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <AudioMixArray>

                    <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3<

                    <MixMode>Once</MixMode>

                    <Replace>true</Replace>

                    <EffectConfig>

                        <EnableStartFadein>true</EnableStartFadein>

                        <StartFadeinTime>3</StartFadeinTime>

                        <EnableEndFadeout>false</EnableEndFadeout>

                        <EndFadeoutTime>0</EndFadeoutTime>

                        <EnableBgmFade>true</EnableBgmFade>

                        <BgmFadeTime>1.7</BgmFadeTime>

                    </EffectConfig>

                </AudioMixArray>

                <Duration>15</Duration>

            </VideoMontage>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-09 17:33:02

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交精彩集锦任务接口中的 

Response.JobsDetail  
Container 数组

https://cloud.tencent.com/document/product/460/84778#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>

        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>
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                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>
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                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:55:05+0800</CreationTime>
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        <EndTime>2022-06-30T19:55:19+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7b0dfbe2f86b11ec995acf5cffaf6664</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>14044.868000</Bitrate>

                    <Duration>2.067000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>3628843</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>126.400000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>
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                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>2.066576</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>14664.836000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/90000</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>1.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>41</Level>

                        <NumFrames>49</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.086000</StartTime>

                        <Timebase>1/90000</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>6080b31ea94defa6c19cc4def539a291</Md5>

                        <ObjectName>output/videoMontage.mp4</ObjectName>
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                    </Md5Info>

                    <ObjectName>output/videoMontage.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/videoMontage.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t164ac18da8bdc403fa27ac4b077a962a1</TemplateId>

            <TemplateName>videoMontage</TemplateName>

            <UserData>This is my VideoMontage job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

        <StartTime>2022-06-30T19:55:05+0800</StartTime>

        <State>Success</State>

        <Tag>VideoMontage</Tag>

        <Workflow>

            <Name>VideoMontage_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:55:05+0800"

        "EndTime": "2022-06-30T19:55:19+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

{

,

[{

,

,

,

{

,

,

,

[{

,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第649 共1950页

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j7b0dfbe2f86b11ec995acf5cffaf6664"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "14044.868000"

                    "Duration": "2.067000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "3628843"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "126.400000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "2.066576"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

},

{

,

},

{

,

},

{

,

}

]
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,

},

{

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第650 共1950页

                    

                    "Video": 

                        "AvgFps": "25.000000"

                        "Bitrate": "14664.836000"

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10"

                        "CodecName": "h264"

                        "CodecTag": "0x31637661"

                        "CodecTagString": "avc1"

                        "CodecTimeBase": "1/90000"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

                        "Duration": "1.960000"

                        "Fps": "25.000000"

                        "HasBFrame": "2"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "41"

                        "NumFrames": "49"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.086000"

                        "Timebase": "1/90000"

                        "Width": "544"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "6080b31ea94defa6c19cc4def539a291"

                        "ObjectName": "output/videoMontage.mp4"

                    

                    "ObjectName": "output/videoMontage.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/videoMontage.${ext}"

                "Region": "ap-chongqing"

}],

[{

,

,

,

,

,

,

,

,

,

,

,

,
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,

,

,

,

,

,

,

,

,
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}

},

{

{

,

[{

,

}],
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}
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            "TemplateId": "t164ac18da8bdc403fa27ac4b077a962a1"

            "TemplateName": "videoMontage"

            "UserData": "This is my VideoMontage job."

            "JobLevel": 0

        

        "QueueId": "p09d709939fef48a0a5c247ef39d90cec"

        "StartTime": "2022-06-30T19:55:05+0800"

        "State": "Success"

        "Tag": "VideoMontage"

        "Workflow": 

            "Name": "VideoMontage_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

},

,

,

,

},

,

,

,

,

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-07-24 14:18:44

创建精彩集锦模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

Request

节点名称（关

键字）

父节

点
描述 类型

是否

必选

默
认

值

Tag
Req
uest

模板类型: VideoMontage String 是 无

Name
Req

uest

模板名称，仅支持中文、英文、数字、_、-

和*，长度不超过 64
String 是 无

Duration
Req

uest

集锦时长

默认自动分析时长

单位为秒

支持 float 格式，执行精度精确到毫秒

String 否 无

Container
Req
uest

容器格式
Contain
er

是 无

Video
Req

uest
视频信息

Contain

er
是 无

Audio
Req
uest

音频信息
Contain
er

否 无

Scene
Req

uest

精彩集锦场景

Video：普通视频

Soccer： 足球
String 否

Vi
d

e
o

AudioMix
Req

uest
混音参数，详情见 AudioMix  

Contain

er
否 无

AudioMixA

rray

Req

uest
混音参数数组，最多同时传2个

Contain

er 数组
否 无

说明

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix 。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

Container

https://cloud.tencent.com/document/product/460/78927#AudioMix
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设定 container，音频视频支持的格式如下表：

Container 类型  的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必
选

Format
Request.Contai
ner

封装格式: mp4、flv、hls、ts、
mkv

Stri
ng

是

Container Audio Codecs Video Codecs

mp4/ts/hls/mkv AAC、MP3 H.264、H.265

flv AAC、MP3 H.264

Video

节点名称（关
键字）

父节点 描述
类
型

默认值
是否
必选

Codec
Reques
t.Video

编解码格式，取值H.264、H.265

St

ri
n

g

H.264 否

Width
Reques
t.Video

宽

值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频原始比

例计算 Height

必须为偶数

St

ri
n

g

视频原
始宽度

否

Height
Reques

t.Video

高

值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频原始比
例计算 Width

必须为偶数

St
ri

n
g

视频原

始高度
否

Fps
Reques

t.Video

帧率
值范围：(0，60]

单位：fps

St
ri

n
g

无 否

Bitrate Reques
t.Video

视频输出文件的码率
值范围：[10，50000]

St
ri

无 否
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Container 类型  的具体数据描述如下：

单位：Kbps n

g

Crf
Reques

t.Video

码率-质量控制因子

值范围：(0, 51]

如果设置了 Crf，则 Bitrate 的设置

失效

当 Bitrate 为空时，默认为25

St
ri

n
g

无 否

Rotate
Reques
t.Video

旋转角度
值范围：[0, 360)

单位：度

St

ri
n

g

无 否

Audio

节点名称

（关键字）
父节点 描述 类型

默
认

值

是否

必选

Codec
Reques
t.Audio

编解码格式，取值 aac、mp3
Stri
ng

a
a

c

否

Samplera

te

Reques

t.Audio

采样率

单位：Hz

可选 11025、22050、32000、

44100、48000、96000

不同的封装，mp3 支持不同的采样率，如

下表所示

Stri

ng

4

41

0
0

否

Bitrate
Reques

t.Audio

原始音频码率
单位：Kbps

值范围：[8，1000]

Stri

ng
无 否

Channels
Reques

t.Audio

声道数
当 Codec 设置为 aac，支持1、2、4、

5、6、8

当 Codec 设置为 mp3，支持1、2

Stri

ng
无 否

Remove
Reques

t.Audio
是否删除音频流，取值 true、false

Stri

ng

fa

ls
e

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

说明

 Y 表示支持这种采样率，N 表示不支持。

封装格式/音频采样率 11025 22050 32000 44100 48000 96000

flv N Y N Y N N

mp4 N Y Y Y Y N

hls/ts/mkv Y Y Y Y Y N

响应

响应头

响应体

<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa
te

模板 ID String
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Container节点  的内容：

Name Response.Templa
te

模板名称 String

BucketId
Response.Templa

te
模板所属存储桶 String

Category
Response.Templa
te

模板属性，Custom 或者 Official String

Tag
Response.Templa
te

模板类型，VideoMontage String

UpdateTime
Response.Templa

te
更新时间 String

CreateTime
Response.Templa
te

创建时间 String

VideoMontage
Response.Templa
te

详细的模板参数
Contain
er

VideoMontage

节点名称（关键字） 父节点 描述

Duration
Response.Template.VideoMon
tage

同请求体中的 Request.Duration

TimeInterval
Response.Template.VideoMon

tage

同请求体中的 

Request.TimeInterval

Container
Response.Template.VideoMon

tage
同请求体中的 Request.Container

Video
Response.Template.VideoMon
tage

同请求体中的 Request.Video

Audio
Response.Template.VideoMon
tage

同请求体中的 Request.Audio

Scene
Response.Template.VideoMon

tage
同请求体中的 Request.Scene

AudioMix
Response.Template.VideoMon
tage

同请求体中的 Request.AudioMix

AudioMixArray Response.Template.VideoMon 同请求体中的 
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

tage Request.AudioMixArray

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

https://cloud.tencent.com/document/product/460/42867
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            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>
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                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-01 16:46:24

更新精彩集锦模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

节点名称（关键
字）

父节点 描述 类型
是否必
选

Request 无 同创建精彩集锦模板接口的 Request  
Contai

ner
是

https://cloud.tencent.com/document/product/460/84724#Request
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

            </AudioMixArray>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建精彩集锦模板接口的 Response  
Contain

er

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoMontage</Tag>

    <Name>TemplateName</Name>

    <Duration>10.5</Duration>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84724#Response
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    <Container>

        <Format>mp4</Format>

    </Container>

    <Video>

        <Codec>H.264</Codec>

        <Bitrate>1000</Bitrate>

        <Width>1280</Width>

        <Fps>30</Fps>

    </Video>

    <Audio>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

        <Remove>false</Remove>

    </Audio>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

    <AudioMixArray>

        <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</AudioS

        <MixMode>Once</MixMode>

        <Replace>true</Replace>

        <EffectConfig>

            <EnableStartFadein>true</EnableStartFadein>

            <StartFadeinTime>3</StartFadeinTime>

            <EnableEndFadeout>false</EnableEndFadeout>

            <EndFadeoutTime>0</EndFadeoutTime>

            <EnableBgmFade>true</EnableBgmFade>

            <BgmFadeTime>1.7</BgmFadeTime>

        </EffectConfig>

    </AudioMixArray>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>VideoMontage</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VideoMontage>

            <Duration>10.5</Duration>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

                <Remove>false</Remove>

            </Audio>

            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix1.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>
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            <AudioMixArray>

                <AudioSource>https://test-xxx.cos.ap-chongqing.myqcloud.com/mix2.mp3</A

                <MixMode>Once</MixMode>

                <Replace>true</Replace>

                <EffectConfig>

                    <EnableStartFadein>true</EnableStartFadein>

                    <StartFadeinTime>3</StartFadeinTime>

                    <EnableEndFadeout>false</EnableEndFadeout>

                    <EndFadeoutTime>0</EndFadeoutTime>

                    <EnableBgmFade>true</EnableBgmFade>

                    <BgmFadeTime>1.7</BgmFadeTime>

                </EffectConfig>

            </AudioMixArray>

        </VideoMontage>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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视频截帧

提交任务
最近更新时间：2023-08-01 16:46:24

提交一个截帧任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

说明：

支持的视频编码格式：H264、H265、VP8、VP9、AV1等。

支持的视频封装格式：avi、mp4、mkv、mov、webm、flv、hls、ts、dash、3GP等。

视频截帧任务并发任务默认限制为10QPS。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${number}.jpg</Object>

            <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节点 描述 类型
是否
必选

Tag
Requ

est
创建任务的 Tag：Snapshot String 是

Input
Requ

est
待操作的文件信息

Contai

ner
是

Operation
Requ
est

操作规则
Contai
ner

是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式
String 否

CallBack

Type

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型
String 否

CallBack Requ 任务回调地址，优先级高于队列的回调地址。设置为 String 否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

est no 时，表示队列的回调地址不产生回调

CallBack

MqConfig

Requ

est

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Contai

ner
否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateI
d

Request.
Operation

截帧模板 ID
Stri
ng

否

Snapshot
Request.

Operation

该任务的参数，同创建截帧模板接口中的 

Request.Snapshot  

Con

tain
er

否

Output
Request.

Operation
结果输出配置

Con
tain

er

是

UserData
Request.
Operation

透传用户信息，可打印的 ASCII 码，长度不超过
1024

Stri
ng

否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Stri

ng
否

注意

截帧参数必须设置，可以通过 TemplateId 或 Snapshot 设置， TemplateId 优先级更高。

节点名称

（关键字）
父节点 描述

类

型

是否

必选

Region
Request.Operati
on.Output

存储桶的地域
Str
ing

是

Bucket Request.Operati

on.Output

存储结果的存储桶 Str

ing

是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84727#Snapshot
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Request.Operation.Output.Object 和 Request.Operation.Output.SpriteObject 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Object
Request.Operati

on.Output

结果文件的名字。当有多个输出文件时必须

包含 ${number} 通配符

Str

ing
否

SpriteObj
ect

Request.Operati
on.Output

雪碧图的名字。当有多个输出文件时必须包
含 ${number} 通配符。仅支持 jpg 格式

Str
ing

否

通配符 含义

${ext} 封装格式

${jobid} 任务Id

${number} 产物索引，从0开始计数

${time} 截帧时间点（单位：毫秒）

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J
obsDetail

新创建任务的 Tag：Snapshot
Stri
ng

State Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Stri

ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的 队列 ID  
Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail.O

peration
任务的模板 ID String

TemplateNa
me

Response.JobsDetail.O
peration

任务的模板名称, 当 TemplateId 存在
时返回

String

Snapshot Response.JobsDetail.O 同请求中的 Contai

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

peration Request.Operation.Snapshot ner

Output
Response.JobsDetail.O
peration

同请求中的 
Request.Operation.Output

Contai
ner

MediaResult
Response.JobsDetail.O
peration

输出文件的基本信息，任务未完成时不
返回，详见 MediaResult  

Contai
ner

UserData
Response.JobsDetail.O

peration
透传用户信息 String

JobLevel
Response.JobsDetail.O
peration

任务优先级 String

错误码

实际案例

请求1：使用截帧模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${number}.jpg</Object>

            <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/78927#MediaResult
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</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>snapshot_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用截帧处理参数
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POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Snapshot>

            <BlackLevel>0</BlackLevel>

            <Count>10</Count>

            <IsCheckBlack>false</IsCheckBlack>

            <IsCheckCount>false</IsCheckCount>

            <Mode>Interval</Mode>

            <PixelBlackThreshold>0</PixelBlackThreshold>

            <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Azure</Color>

                <Columns>3</Columns>

                <Lines>2</Lines>

            </SpriteSnapshotConfig>

            <Start>1</Start>

            <TimeInterval>2</TimeInterval>

        </Snapshot>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/snapshot-${number}.jpg</Object>

            <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK
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Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Snapshot</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Snapshot>

                <BlackLevel>0</BlackLevel>

                <Count>10</Count>

                <IsCheckBlack>false</IsCheckBlack>

                <IsCheckCount>false</IsCheckCount>

                <Mode>Interval</Mode>

                <PixelBlackThreshold>0</PixelBlackThreshold>

                <SnapshotOutMode>SnapshotAndSprite</SnapshotOutMode>

                <SpriteSnapshotConfig>

                    <Color>Azure</Color>

                    <Columns>3</Columns>

                    <Lines>2</Lines>

                </SpriteSnapshotConfig>

                <Start>1</Start>

                <TimeInterval>2</TimeInterval>

            </Snapshot>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>
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            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-09 17:33:02

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交截图任务接口中的 

Response.JobsDetail  

Contain

er 数组

https://cloud.tencent.com/document/product/460/84780#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>
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                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>

                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

    </JobsDetail>

</Response>
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案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:25:11+0800</CreationTime>

        <EndTime>2022-06-30T19:25:14+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j4e431ba0f86711ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>0.jpg</ObjectName>
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                    <ObjectName>1.jpg</ObjectName>

                    <ObjectName>2.jpg</ObjectName>

                    <ObjectName>3.jpg</ObjectName>

                    <ObjectName>4.jpg</ObjectName>

                    <ObjectName>5.jpg</ObjectName>

                    <ObjectPrefix>output/snapshot-</ObjectPrefix>

                    <Region>ap-chongqing</Region>

                    <SpriteOutputFile>

                        <Bucket>test-123456789</Bucket>

                        <Md5Info/>

                        <ObjectName>0.jpg</ObjectName>

                        <ObjectPrefix>output/sprite-</ObjectPrefix>

                        <Region>ap-chongqing</Region>

                    </SpriteOutputFile>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/snapshot-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

                <SpriteObject>output/sprite-${number}.jpg</SpriteObject>

            </Output>

            <TemplateId>t1f16e1dfbdc9ds4105b31632d45710642a</TemplateId>

            <TemplateName>template_snapshot</TemplateName>

            <UserData>This is my Snapshot job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:25:12+0800</StartTime>

        <State>Success</State>

        <Tag>Snapshot</Tag>

        <Workflow>

            <Name>Snapshot_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

{

,
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    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:25:11+0800"

        "EndTime": "2022-06-30T19:25:14+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j4e431ba0f86711ecb8546d80f2baf56f"

        "Operation": 

            "MediaInfo": 

                "Stream": 

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "ObjectName": 

                        "0.jpg"

                        "1.jpg"

                        "2.jpg"

                        "3.jpg"

                        "4.jpg"

                        "5.jpg"

                    

                    "ObjectPrefix": "output/snapshot-"

[{

,

,

,

{

,

,

,
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,
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{
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{
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{

,

}

]

},

,

{

{

{
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                    "Region": "ap-chongqing"

                    "SpriteOutputFile": 

                        "Bucket": "test-123456789"

                        "ObjectName": "0.jpg"

                        "ObjectPrefix": "output/sprite-"

                        "Region": "ap-chongqing"

                    

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/snapshot-${number}.jpg"

                "Region": "ap-chongqing"

                "SpriteObject": "output/sprite-${number}.jpg"

            

            "TemplateId": "t1f16e1dfbdc9ds4105b31632d45710642a"

            "TemplateName": "template_snapshot"

            "UserData": "This is my Snapshot job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T19:25:12+0800"

        "State": "Success"

        "Tag": "Snapshot"

        "Workflow": 

            "Name": "Snapshot_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

,

{

,

[ ],

,

}

}

},

{

,

,

,
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,

,
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创建模板
最近更新时间：2023-08-08 14:20:52

创建视频截图模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键

字）
父节点 描述 类型

是否必

选

Tag
Requ

est
模板类型：Snapshot String 是

Name
Requ
est

模板名称，仅支持中文、英文、数字、_、-和
*，长度不超过 64

String 是

Snapshot
Requ

est
截图参数

Contai

ner
是

Snapshot

节点名称（关

键字）
父节点 描述 类型 默认值

是否

必选

Mode Request.
Snapshot

截图模式
值范围：{Interval, Average, 

KeyFrame}

Interval 表示间隔模式，

Start，TimeInterval，
Count参数生效。当设置 

Count，未设置 
TimeInterval 时，表示截取所

有帧，共Count张图片

Average 表示平均模式，

Start，Count参数生效。表示

Stri
ng

Interva
l

否
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从Start开始到视频结束，按平

均间隔截取共Count张图片

KeyFrame 表示关键帧模式

Start
Request.

Snapshot

开始时间

[0 视频时长] 

单位为秒 

支持 float 格式，执行精度精确

到毫秒

Stri

ng
0 否

TimeInterva

l

Request.

Snapshot

截图时间间隔

(0 3600] 

单位为秒 

支持 float 格式，执行精度精确

到毫秒

Stri

ng
无 否

Count
Request.

Snapshot
截图数量，取值范围 (0，10000]

Stri

ng
无 是

Width
Request.
Snapshot

宽
值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频

原始比例计算 Height

Stri
ng

视频原
始宽度

否

Height
Request.
Snapshot

高
值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频

原始比例计算 Width

Stri
ng

视频原
始高度

否

CIParam
Request.
Snapshot

截图图片处理参数，参考  图片处理  
Stri
ng

无 否

IsCheckCo
unt

Request.
Snapshot

是否强制检查截图个数。使用自定义

间隔模式截图时，视频时长不够截取
Count 个截图，可以转为平均截图

模式截取 Count 个截图

Stri
ng

false 否

IsCheckBla

ck

Request.

Snapshot

是否开启黑屏检测，取值 true、

false

Stri

ng
false 否

BlackLevel Request.
Snapshot

截图黑屏检测参数
当 IsCheckBlack=true 时有

Stri
ng

空 否

https://cloud.tencent.com/document/product/460/36540
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Container 类型 Snapshot.SpriteSnapshotConfig 的具体数据描述如下：

效

值参考范围[30，100]，表示黑
色像素的占比值，值越小，黑色

占比越小

Start>0，参数设置无效，不做

过滤黑屏

Start =0 参数有效，截帧的开

始时间为第一帧非黑屏开始

PixelBlackT

hreshold

Request.

Snapshot

截图黑屏检测参数
当 IsCheckBlack=true 时有

效

判断像素点是否为黑色点的阈

值，取值范围：[0，255]

Stri

ng
空 否

SnapshotO
utMode

Request.
Snapshot

截图输出模式参数

OnlySnapshot：仅输出截图
模式

OnlySprite：仅输出雪碧图模

式

SnapshotAndSprite：输出

截图与雪碧图模式

Stri
ng

OnlySn
apshot

否

SpriteSnap
shotConfig

Request.
Snapshot

雪碧图输出配置

Con

tain
er

无 否

节点名称（关

键字）
父节点 描述

类

型

默认

值

是否

必选

CellWidth
Request.Snapshot.Spri
teSnapshotConfig

单图宽度
值范围：[8，4096]

单位：px

Str
ing

截图
宽度

否

CellHeight
Request.Snapshot.Spri
teSnapshotConfig

单图高度
值范围：[8，4096]

单位：px

Str
ing

截图
高度

否

Padding
Request.Snapshot.Spri
teSnapshotConfig

雪碧图内边距大小
值范围：[0，1024]

单位：px

Str
ing

0 否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Margin Request.Snapshot.Spri
teSnapshotConfig

雪碧图外边距大小
值范围：[0，1024]

单位：px

Str
ing

0 否

Color
Request.Snapshot.Spri
teSnapshotConfig

背景颜色，支持颜色详
见 FFmpeg  

Str
ing

无 是

Columns
Request.Snapshot.Spri
teSnapshotConfig

雪碧图列数，值范围：
[1，10000]

Str
ing

无 是

Lines
Request.Snapshot.Spri

teSnapshotConfig

雪碧图行数，值范围：

[1，10000]

Str

ing
无 是

ScaleMeth
od

Request.Snapshot.Spri
teSnapshotConfig

雪碧图缩放模式
DirectScale: 指定

宽高缩放

MaxWHScaleAn

dPad: 指定最大宽
高缩放填充

MaxWHScale: 指
定最大宽高缩放

主动设置 
CellWidth 和

CellHeight 时生效

Str
ing

Dire
ctSc

ale

否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

https://cloud.tencent.com/document/product/460/42866
https://www.ffmpeg.org/ffmpeg-utils.html#color-syntax
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存结果的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

Tag
Respon
se

模板类型，Snapshot String

Name
Respon

se
模板名字 String

TemplateId
Respon

se
模板 ID String

UpdateTime
Respon
se

更新时间 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

CreateTime Respon

se

创建时间 String

Snapshot
Respon

se
详细的模板参数，同 Request.Snapshot

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

https://cloud.tencent.com/document/product/460/42867
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Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=</RequestId>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-14 18:07:21

更新视频截图模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建截图模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84727#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建截图模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Snapshot</Tag>

    <Name>TemplateName</Name>

    <Snapshot>

        <Mode>Interval</Mode>

        <Width>1280</Width>

        <Height>960</Height>

        <Start>0</Start>

        <TimeInterval>0.5</TimeInterval>

        <Count>10</Count>

        <SnapshotOutMode>OnlySprite</SnapshotOutMode>

        <SpriteSnapshotConfig>

            <Color>Aquamarine</Color>

            <Columns>3</Columns>

            <Lines>3</Lines>

        </SpriteSnapshotConfig>

    </Snapshot>

</Request>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84727#Response
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>Snapshot</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Snapshot>

            <Mode>Interval</Mode>

            <Width>1280</Width>

            <Height>960</Height>

            <Start>0</Start>

            <TimeInterval>0.5</TimeInterval>

            <Count>10</Count>

            <SnapshotOutMode>OnlySprite</SnapshotOutMode>

            <SpriteSnapshotConfig>

                <Color>Aquamarine</Color>

                <Columns>3</Columns>

                <Lines>3</Lines>

            </SpriteSnapshotConfig>

        </Snapshot>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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画质增强

提交任务
最近更新时间：2023-08-01 16:46:24

提交一个画质增强任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器
Containe
r

是

节点名称

（关键字）

父节

点
描述 类型

是否

必选

Tag
Req
uest

创建任务的 Tag：VideoEnhance
Strin
g

是

Input
Req
uest

待操作的文件信息
Cont
ainer

是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBack
Format

Req
uest

任务回调格式，JSON 或 XML，默认 XML，优先级高
于队列的回调格式

Strin
g

否

CallBack
Type

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队
列的回调类型

Strin
g

否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

CallBack Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g

否

CallBack
MqConfig

Req
uest

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 
时必填。详情见 CallBackMqConfig

Cont
ainer

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object
Request.Inpu

t
文件路径 String 是

Operation

节点名称（关键
字）

父节点 描述 类型

是

否
必

选

TemplateId
Request.Op
eration

画质增强模板 ID String 否

VideoEnhan

ce

Request.Op

eration

画质增强模板参数，同创建画质增强模板接

口中的 Request.VideoEnhance  

Containe

r
否

WatermarkT

emplateId

Request.Op

eration

水印模板 ID，可以传多个水印模板 ID，最

多传3个

String 数

组
否

Watermark
Request.Op
eration

水印模板参数，同创建水印模板接口中的 
Request.Watermark ，最多传3个

Containe
r 数组

否

DigitalWater

mark

Request.Op

eration

数字水印参数，详情见 

DigitalWatermark  

Containe

r
否

Output
Request.Op

eration
结果输出配置

Containe

r
是

UserData
Request.Op
eration

透传用户信息，可打印的 ASCII 码，长度
不超过1024

String 否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别

越大任务优先级越高，默认为0
String 否

说明

画质增强参数必须设置，可以通过 TemplateId 或 VideoEnhance 设置， TemplateId 优先级更

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84722#VideoEnhance
https://cloud.tencent.com/document/product/460/84725#Watermark
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

高。

水印参数可选，可以通过 WatermarkTemplateId 或 Watermark 设置，

WatermarkTemplateId 优先级更高。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.O
utput

存储桶的地域 String 是

Bucket
Request.Operation.O

utput
存储结果的存储桶 String 是

Object
Request.Operation.O

utput
输出结果的文件名 String 是

通配符 含义

${ext} 封装格式

${jobid} 任务 ID

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

              <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

              <TemplateName>VideoEnhance_demo</TemplateName>

              <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTe

              <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</Watermark

              <DigitalWatermark>

                  <Type>Text</Type>

                  <Message>123456789ab</Message>

                  <State>Running</State>

                  <Version>V1</Version>

                  <IgnoreError>false</IgnoreError>

              </DigitalWatermark>

              <Output>

                  <Region>ap-chongqing</Region>

                  <Bucket>test-123456789</Bucket>

                  <Object>output/out.${ext}</Object>

              </Output>

              <UserData>This is my data.</UserData>

              <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail
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Container 节点 Input 的内容：

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Strin
g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

Tag
Response.J
obsDetail

新创建任务的 Tag：VideoEnhance
Strin
g

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会
变为暂停状态

Cancel：任务被取消执行

Strin
g

Progress
Response.J
obsDetail

任务进度百分比，范围为[0, 100]
Strin
g

CreationTi

me

Response.J

obsDetail
任务的创建时间

Strin

g

StartTime
Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J
obsDetail

任务的结束时间
Strin
g

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Strin

g

Input
Response.J

obsDetail
该任务的输入资源地址

Cont

ainer

Operation
Response.J
obsDetail

该任务的规则
Cont
ainer

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail
.Operation

任务的模板 ID String

TemplateNa

me

Response.JobsDetail

.Operation

任务的模板名称, 当 TemplateId 存在

时返回
String

VideoEnhanc
e

Response.JobsDetail
.Operation

同请求中的 

Request.Operation.VideoEnhan
ce

Contain
er

Watermark
Response.JobsDetail

.Operation

同请求中的 

Request.Operation.Watermark

Contain

er 数组

WatermarkTe
mplateId

Response.JobsDetail
.Operation

同请求中的 
Request.Operation.Watermark

TemplateId

String 数
组

Output
Response.JobsDetail

.Operation

同请求中的 

Request.Operation.Output

Contain

er

MediaInfo
Response.JobsDetail
.Operation

输出文件的媒体信息，任务未完成时不
返回，详见 MediaInfo  

Contain
er

MediaResult
Response.JobsDetail

.Operation

输出文件的基本信息，任务未完成时不

返回，详见 MediaResult  

Contain

er

DigitalWater
mark

Response.JobsDetail
.Operation

同请求中的 

Request.Operation.DigitalWater
mark

Contain
er

UserData
Response.JobsDetail

.Operation
透传用户信息 String

JobLevel Response.JobsDetail 任务优先级 String

https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

.Operation

错误码

实际案例

请求1：使用超分辨率模板 ID

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>test.${ext}</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplat

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

        <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTem

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>VideoEnhance_demo</TemplateName>

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

            <WatermarkTemplateId>t12a74d11687d444deba8a6cc52051ac27</WatermarkTe

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>
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    </JobsDetail>

</Response>

请求2：使用超分辨率处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Input>

        <Object>test.${ext}</Object>

    </Input>

    <Operation>

        <VideoEnhance>

            <Transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>
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            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>        

        </VideoEnhance>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoEnhance</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

           <VideoEnhance>

                <Transcode>

                    <Container>

                        <Format>mp4</Format>

                    </Container>

                    <Video>

                        <Codec>H.264</Codec>

                        <Bitrate>1000</Bitrate>

                        <Width>1280</Width>

                        <Fps>30</Fps>

                    </Video>

                    <Audio>

                        <Codec>aac</Codec>

                        <Samplerate>44100</Samplerate>

                        <Bitrate>128</Bitrate>

                        <Channels>4</Channels>

                    </Audio>

                </Transcode>

                <SuperResolution>
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                    <Resolution>sdtohd</Resolution>

                    <EnableScaleUp>true</EnableScaleUp>

                    <Version>Enhance</Version>

                </SuperResolution>

                <ColorEnhance>

                    <Contrast>50</Contrast>

                    <Correction>100</Correction>

                    <Saturation>100</Saturation>

                </ColorEnhance>

                <MsSharpen>

                    <SharpenLevel>5</SharpenLevel>

                </MsSharpen>

                <SDRtoHDR>

                    <HdrMode>HDR10</HdrMode>

                </SDRtoHDR>        

            </VideoEnhance>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <DigitalWatermark>

                <State>Running</State>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>
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                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第717 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Resp
onse

固定值，为 TaskFinish String

JobsDetail
Resp
onse

同提交画质增强任务接口中的 
Response.JobsDetail  

Container 数组

https://cloud.tencent.com/document/product/460/84775#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.C
osHeaders

自定义 Header 的名称
Stri
ng

Value
Response.JobsDetail.Input.C
osHeaders

自定义 Header 的值
Stri
ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>
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                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>
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                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T20:02:17+0800</CreationTime>

        <EndTime>2022-06-30T20:02:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j7d0eafdaf86c11ecbdf419856486c0ab</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>10269.090000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>17526771</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.726000</Bitrate>

                        <Channel>2</Channel>
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                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.652993</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.922840</AvgFps>

                        <Bitrate>10674.365000</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31766568</CodecTag>

                        <CodecTagString>hev1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <FieldOrder>progressive</FieldOrder>

                        <Fps>25.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>93</Level>

                        <NumFrames>323</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>
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            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>a825aa6c59371509995a47b570c29297</Md5>

                        <ObjectName>output/video-process.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/video-process.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/video-process.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f4ac18da8bdc403fa27ac4bfn77a62a1</TemplateId>

            <TemplateName>VideoEnhance_12654</TemplateName>

            <UserData>This is my VideoEnhance job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T20:02:18+0800</StartTime>

        <State>Success</State>

        <Progress>100</Progress>

        <Tag>VideoEnhance</Tag>

        <Workflow>

            <Name>VideoEnhance_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T20:02:17+0800"

        "EndTime": "2022-06-30T20:02:34+0800"

{

,

[{

,

,

,
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        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j7d0eafdaf86c11ecbdf419856486c0ab"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "10269.090000"

                    "Duration": "13.654000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "17526771"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "128.726000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

{

,

,

,

[{

,

},

{

,

},

{

,

},

{

,

}

]

},

,

{

{

{

,

,

,

,

,

,

,

},

{

[{

,

,

,

,

,

,

,

,
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                        "Duration": "13.652993"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "24.922840"

                        "Bitrate": "10674.365000"

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)"

                        "CodecName": "hevc"

                        "CodecTag": "0x31766568"

                        "CodecTagString": "hev1"

                        "CodecTimeBase": "1/12800"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

                        "Duration": "12.960000"

                        "FieldOrder": "progressive"

                        "Fps": "25.000000"

                        "HasBFrame": "2"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "93"

                        "NumFrames": "323"

                        "PixFormat": "yuv420p"

                        "Profile": "Main"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "544"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "a825aa6c59371509995a47b570c29297"

                        "ObjectName": "output/video-process.mp4"

                    

,

,

,

,

,

,

}],

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}]

}

},

{

{

,

[{

,

}],
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                    "ObjectName": "output/video-process.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/video-process.${ext}"

                "Region": "ap-chongqing"

            

            "TemplateId": "t1f4ac18da8bdc403fa27ac4bfn77a62a1"

            "TemplateName": "VideoEnhance_12654"

            "UserData": "This is my VideoEnhance job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T20:02:18+0800"

        "State": "Success"

        "Progress": "100"

        "Tag": "VideoEnhance"

        "Workflow": 

            "Name": "VideoEnhance_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

[ ],

}

},

{

,

,

},

,

,

,

},

,

,

,

,

,

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-08-18 15:28:02

创建画质增强模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast>50</Contrast>

            <Correction>100</Correction>

            <Saturation>100</Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel>5</SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

        <FrameEnhance>

            <FrameDoubling>true</FrameDoubling>

        </FrameEnhance>

    </VideoEnhance>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关

键字）

父节

点
描述 类型

默

认
值

是否

必选
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

Tag Req

uest

模板类型： VideoEnhance Stri

ng

无 是

Name
Req

uest

模板名称：仅支持中文、英文、数字、_、-和*，

长度不超过 64

Stri

ng
无 是

VideoEnha
nce

Req
uest

画质增强参数
Con
tain

er

无 是

VideoEnhance

节点名称

（关键字）
父节点 描述 类型

默认

值
是否必选

Transcod

e

Request.Vide

oEnhance
转码参数

Contai

ner
无 是

SuperRes
olution

Request.Vide
oEnhance

超分辨率参数
Contai
ner

无 否

SDRtoHD

R

Request.Vide

oEnhance
SDR to HDR 参数

Contai

ner
无 否

ColorEnha

nce

Request.Vide

oEnhance
色彩增强参数

Contai

ner
无 否

MsSharpe
n

Request.Vide
oEnhance

细节增强参数
Contai
ner

无 否

FrameEnh

ance

Request.Fram

eEnhance
帧率增强参数

Contai

ner
无 否

说明

SuperResolution、 SDRtoHDR、 ColorEnhance、 MsSharpen、FrameEnhance 不能同时

为空。

Transcode

节点名称（关

键字）
父节点 描述 类型

默认

值

是否

必选

Container Request.VideoEnha 容器格式 Cont 无 是
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

nce.Transcode ainer

Video
Request.VideoEnha
nce.Transcode

视频信息
Cont
ainer

无 是

Audio
Request.VideoEnha

nce.Transcode

音频信息，不传 Audio，

相当于删除音频信息

Cont

ainer
无 否

Container

节点名称（关键
字）

父节点 描述 类型 是否必选

Format Request.Container 封装格式:  mp4/webm String 是

Video

节点名
称（关

键字）

父节点 描述
类
型

默认值
是否
必选

Code

c

Request.VideoEnhance.

Transcode.Video

编解码格式

H.264

H.265

VP8 

VP9

St
ri

n

g

H.264，当 
Format 为 

WebM 时，为 

VP8

否

Width
Request.VideoEnhance.

Transcode.Video

宽

值范围：[128, 
4096]

单位：px

若只设置 
Width 时，按

照视频原始比例

计算 Height 

必须为偶数

St

ri

n
g

当 

Request.Vide

oEnhance.Su

perResolutio
n 参数为空时，

默认值为视频原

始宽度

当 
Request.Vide

oEnhance.Su

perResolutio

n 参数不为空
时，默认值为视

频原始宽度两倍

否

Heigh Request.VideoEnhance. 高 St 当 否
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Container 类型  的具体数据描述如下：

t Transcode.Video 值范围：[128, 

4096]

单位：px

若只设置 
Height 时，按

照视频原始比例

计算 Width

必须为偶数

ri

n

g

Request.Vi

deoEnhan

ce.SuperR

esolution 
参数为空时，

默认值为视频

原始高度

当
Request.Vi

deoEnhan

ce.SuperR

esolution 
参数不为空

时，默认值为

视频原始高度

两倍

Fps
Request.VideoEnhance.

Transcode.Video

帧率

值范围：(0, 

60]

单位：fps

St

ri

n

g

无 否

Audio

节点名称（关

键字）
父节点 描述

类

型
默认值

是否

必选

Codec
Request.VideoEnhance.

Transcode.Audio

编解码格式，取值 

aac、mp3、

Vorbis、opus

St

ri

n

g

aac，
当 

format 

为 

WebM 
时，为 

Vorbis

否

Samplerat

e

Request.VideoEnhance.

Transcode.Audio

采样率

单位：Hz 

可选 8000、

11025、

12000、

16000、
22050、

24000、

32000、

St

ri
n

g

44100

，当 
Codec 

为 

opus 

时，默
认值为

48000

否
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设定 container，音频视频支持的格式如下表所示：

Container 类型  的具体数据描述如下：

44100、
48000、

88200、96000

不同的封装，

mp3 支持不同的
采样率，如下表所

示

当 Codec 设置

为 amr 时，只支
持8000

当 Codec 设置

为 opus 时，仅

支持8000，
16000，

24000，48000

Bitrate
Request.VideoEnhance.

Transcode.Audio

原始音频码率
单位：Kbps

值范围：[8，

1000]

St
ri

n

g

无 否

Channels
Request.VideoEnhance.

Transcode.Audio
声道数

St

ri

n

g

无 否

Container Audio Codecs Video Codecs

mp4 aac、mp3 H.264、H.265

WebM Vorbis、opus VP8、VP9

ColorEnhance

节点名称（关
键字）

父节点 描述
类
型

默
认

值

是否
必选

Contrast Request.VideoEnhanc

e.ColorEnhance

对比度

值范围：[0, 100]

auto（表示自动分析）

St

ri
n

g

无 是
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

Correction
Request.VideoEnhanc

e.ColorEnhance

色彩校正
值范围：[0, 1000]

auto（表示自动分析）

St
ri

n

g

无 是

Saturation
Request.VideoEnhanc

e.ColorEnhance

饱和度

值范围：[0, 300]

auto（表示自动分析）

St
ri

n

g

无 是

MsSharpen

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否

必选

SharpenLe

vel

Request.VideoEnhanc

e.MsSharpen

增强等级
值范围：[0, 10]

auto（表示自动分析）

St
ri

n

g

无 是

SuperResolution

节点名称（关
键字）

父节点 描述
类
型

默
认

值

是否
必选

Resolution
Request.VideoEnhance.
SuperResolution

分辨率选项

sdtohd：标清到超清

hdto4k：高清到4K

St

ri
n

g

无 是

EnableSca

leUp

Request.VideoEnhance.

SuperResolution

自动缩放开关，取值 

true、false

St
ri

n

g

fal

se
否

Version
Request.VideoEnhance.

SuperResolution

版本

Base：基础版

Enhance：增强版

St
ri

n

g

Ba

se
否
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据, 包含完整节点数据的内容展示如下：

SDRtoHDR

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

HdrMode
Request.VideoEnhan
ce.SDRtoHDR

HDR 标准

HLG

HDR10

Str
ing

无

H

L

G

H
D

R1

0

FrameEnhance

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否

必选

FrameDoub

ling

Request.VideoEnhance.Fr

ameEnhance

是否开启插帧，取值 

true、false

St
ri

n

g

fa
ls

e

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <FrameEnhance>

                <FrameDoubling>true</FrameDoubling>

            </FrameEnhance>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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Container 节点  的内容：

Container 节点  的内容：

Container 节点 VideoEnhance 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa

te
模板 ID String

Name
Response.Templa
te

模板名称 String

BucketId
Response.Templa

te
模板所属存储桶 String

Category
Response.Templa

te
模板属性，Custom 或者 Official String

Tag
Response.Templa
te

模板类型，SuperResolution String

UpdateTime
Response.Templa

te
更新时间 String

CreateTime
Response.Templa

te
创建时间 String

VideoEnhance
Response.Templa
te

详细的模板参数
Contain
er

节点名称（关键

字）
父节点 描述 类型
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Transcode Response.Template.Vi
deoEnhance

同请求体中的 
Request.Transcode

Contai
ner

SuperResolutio

n

Response.Template.Vi

deoEnhance

同请求体中的 

Request.SuperResolution

Contai

ner

SDRtoHDR
Response.Template.Vi

deoEnhance

同请求体中的 

Request.SDRtoHDR

Contai

ner

ColorEnhance
Response.Template.Vi
deoEnhance

同请求体中的 
Request.ColorEnhance

Contai
ner

MsSharpen
Response.Template.Vi

deoEnhance

同请求体中的 

Request.MsSharpen

Contai

ner

FrameEnhance
Response.Template.Vi

deoEnhance

同请求体中的 

Request.FrameEnhance

Contai

ner

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

https://cloud.tencent.com/document/product/460/42867
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            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast>50</Contrast>

            <Correction>100</Correction>

            <Saturation>100</Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel>5</SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

        <FrameEnhance>

            <FrameDoubling>true</FrameDoubling>

        </FrameEnhance>

    </VideoEnhance>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>
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        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast>50</Contrast>

                <Correction>100</Correction>

                <Saturation>100</Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel>5</SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

            <FrameEnhance>

                <FrameDoubling>true</FrameDoubling>

            </FrameEnhance>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-08 17:34:10

更新画质增强模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId>  HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据, 包含完整节点数据的内容展示如下：

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建画质增强模板接口的 Request  
Contain

er
是

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84722#Request
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>

                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建画质增强模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoEnhance</Tag>

    <Name>TemplateName</Name>

    <VideoEnhance>

        <Transcode>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

        </Transcode>

        <SuperResolution>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84722#Response
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            <Resolution>sdtohd</Resolution>

            <EnableScaleUp>true</EnableScaleUp>

            <Version>Enhance</Version>

        </SuperResolution>

        <ColorEnhance>

            <Contrast></Contrast>

            <Correction></Correction>

            <Saturation></Saturation>

        </ColorEnhance>

        <MsSharpen>

            <SharpenLevel></SharpenLevel>

        </MsSharpen>

        <SDRtoHDR>

            <HdrMode>HDR10</HdrMode>

        </SDRtoHDR>

    </VideoEnhance>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>VideoEnhance</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoEnhance> 

            <transcode>

                <Container>

                    <Format>mp4</Format>

                </Container>

                <Video>

                    <Codec>H.264</Codec>

                    <Bitrate>1000</Bitrate>
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                    <Width>1280</Width>

                    <Fps>30</Fps>

                </Video>

                <Audio>

                    <Codec>aac</Codec>

                    <Samplerate>44100</Samplerate>

                    <Bitrate>128</Bitrate>

                    <Channels>4</Channels>

                </Audio>

            </Transcode>

            <SuperResolution>

                <Resolution>sdtohd</Resolution>

                <EnableScaleUp>true</EnableScaleUp>

                <Version>Enhance</Version>

            </SuperResolution>

            <ColorEnhance>

                <Contrast></Contrast>

                <Correction></Correction>

                <Saturation></Saturation>

            </ColorEnhance>

            <MsSharpen>

                <SharpenLevel></SharpenLevel>

            </MsSharpen>

            <SDRtoHDR>

                <HdrMode>HDR10</HdrMode>

            </SDRtoHDR>

        </VideoEnhance>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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视频明水印
提交任务
最近更新时间：2023-08-11 18:10:32

提交一个视频明水印任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

说明：

视频明水印为付费服务，费用同音视频转码，具体费用请参见 媒体处理费用 。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Watermark</Tag>

    <Input>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/58120#9f3ec255-b086-48aa-b92d-ce5240a36fb5
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关
键字）

父节点 描述 类型
是否
必选

Tag
Requ

est
创建任务的Tag：Watermark String 是

Input
Requ

est
待操作的文件信息

Contai

ner
是

Operation
Requ
est

操作规则
Contai
ner

是

CallBackFo

rmat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式
String 否

CallBackTy

pe

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级

高于队列的回调类型
String 否

CallBack
Requ
est

任务回调地址，优先级高于队列的回调地址。设置为 
no 时，表示队列的回调地址不产生回调

String 否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

CallBackM

qConfig

Requ

est

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Contai

ner

否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 待处理的文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

Watermark

TemplateId

Request.

Operation

水印模板 ID，可以传多个水印模板 ID ，最多

传3个

String 

数组
否

Watermark
Request.

Operation

水印模板参数，同创建水印模板接口中的 

Request.Watermark ，最多传3个

Contai

ner 数

组

否

Output
Request.

Operation
结果输出配置

Contai

ner
是

UserData
Request.
Operation

透传用户信息，可打印的 ASCII 码，长度不超
过1024。

String 否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大

任务优先级越高，默认为0
String 否

说明

水印参数必须设置，可以通过 WatermarkTemplateId 或 Watermark 设置，

WatermarkTemplateId 优先级更高。

节点名称（关

键字）
父节点 描述 类型

是否必

选

Region Request.Operation.Output 存储桶的地域
Stri

ng
是

Bucket Request.Operation.Output 存储结果的存储桶
Stri

ng
是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84725#Watermark
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Object Request.Operation.Output 输出结果的文件名 Stri

ng

是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Watermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 
数组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.Job

sDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.Job

sDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.Job
sDetail

新创建任务的 ID String

Tag
Response.Job

sDetail
新创建任务的 Tag：Watermark String

State
Response.Job

sDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任

务会变为暂停状态

Cancel：任务被取消执行

String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

CreationTi

me

Response.Job

sDetail

任务的创建时间 String

StartTime
Response.Job

sDetail
任务的开始时间 String

EndTime
Response.Job

sDetail
任务的结束时间 String

QueueId
Response.Job

sDetail
任务所属的 队列 ID String

Input
Response.Job

sDetail
该任务的输入资源地址

Contai

ner

Operation
Response.Job

sDetail
该任务的规则

Contai

ner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域
Strin

g

Bucket Response.JobsDetail.Input 存储结果的存储桶
Strin

g

Object Response.JobsDetail.Input 源文件路径
Strin

g

节点名称（关

键字）
父节点 描述 类型

WatermarkT

emplateId

Response.JobsDe

tail.Operation

同请求中的 
Request.Operation.WatermarkTempl

ateId

String 

数组

Watermark
Response.JobsDe
tail.Operation

同请求中的 
Request.Operation.Watermark

Contain
er 数组

Output
Response.JobsDe

tail.Operation
同请求中的 Request.Operation.Output

Contain

er

MediaInfo Response.JobsDe 输出文件的媒体信息， 任务未完成时不返回， Contain
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

tail.Operation 详见 MediaInfo  er

MediaResult
Response.JobsDe
tail.Operation

输出文件的基本信息，任务未完成时不返回，
详见 MediaResult  

Contain
er

UserData
Response.JobsDe

tail.Operation
透传用户信息 String

JobLevel
Response.JobsDe

tail.Operation
任务优先级 String

错误码

实际案例

请求1：使用水印模板id

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Watermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTemp

        <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTemp

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:11+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Watermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用水印参数

POST /jobs HTTP/1.1
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Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Watermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <Watermark>

            <Type>Image</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Image>

                <Url>http://test-1234567890.ci.ap-chongqing.myqcloud.com/shuiyin_2.png</U

                <Mode>Proportion</Mode>

                <Width>10</Width>

                <Height></Height>

                <Transparency>100</Transparency>

            </Image>

        </Watermark>

        <Output>

            <Region>ap-chongqing</Region>
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            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Watermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Watermark>

                <Type>Text</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>
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                <EndTime>100.5</EndTime>

                <Text>

                    <Text>水印内容</Text>

                    <FontSize>30</FontSize>

                    <FontType>simfang.ttf</FontType>

                    <FontColor>0xRRGGBB</FontColor>

                    <Transparency>30</Transparency>

                </Text>

            </Watermark>

            <Watermark>

                <Type>Image</Type>

                <LocMode>Absolute</LocMode>

                <Dx>128</Dx>

                <Dy>128</Dy>

                <Pos>TopRight</Pos>

                <StartTime>0</StartTime>

                <EndTime>100.5</EndTime>

                <Image>

                    <Url>http://test-1234567890.ci.ap-chongqing.myqcloud.com/shuiyin_2.png<

                    <Mode>Proportion</Mode>

                    <Width>10</Width>

                    <Height></Height>

                    <Transparency>100</Transparency>

                </Image>

            </Watermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>
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                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/Watermark.mp4</ObjectName>

                    </Md5Info>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectName>output/Watermark.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/Watermark.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <UserData>This is my Watermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Watermark</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo
nse

固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交视频明水印接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/84781#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key Response.JobsDetail.Input.CosH
eaders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>
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                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>
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                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/Watermark.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/Watermark.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/Watermark.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <UserData>This is my Watermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Watermark</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:30:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>
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            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <Message>success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>
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                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/Watermark.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/Watermark.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/Watermark.mp4</Object>
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                <Region>ap-chongqing</Region>

            </Output>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <UserData>This is my Watermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:42+0800</StartTime>

        <State>Success</State>

        <Tag>Watermark</Tag>

        <Workflow>

            <Name>Watermark_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T15:29:42+0800"

        "EndTime": "2022-06-30T15:30:08+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

{

,

[{

,

,

,

{

,

,

,

[{

,

},

{

,

},

{

,
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                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j68427030f84611ecb8546d80f2baf56f"

        "Message": "success"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Duration": "13"

                    "NumStream": "1"

                    "Size": "1909389"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "128000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "13.653"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "50.000"

                        "Bitrate": "1031968"

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)"

                        "CodecName": "hevc"

                        "CodecTag": "0x31637668"

                        "CodecTagString": "hvc1"

                        "CodecTimeBase": "1/50"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

},

{

,

}

]

},

,

,

{

{

{

,

,

},

{

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}],

[{

,

,

,

,

,

,

,

,

,

,
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                        "Duration": "12.960"

                        "FieldOrder": "Unknown"

                        "Fps": "50/1"

                        "HasBFrame": "4"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

                        "Level": "4"

                        "NumFrames": "648"

                        "PixFormat": "hvc1"

                        "Profile": "Main"

                        "RefFrames": "1"

                        "Rotation": "0"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "540"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "2db78d168edf2f883adce89a1b4ca033"

                        "ObjectName": "output/Watermark.mp4"

                    

                    "ObjectName": "output/Watermark.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/Watermark.mp4"

                "Region": "ap-chongqing"

            

            "WatermarkTemplateId": 

                "t1318c5f428d474afba1797f84091cbe22"

                "t1318c5f428d474afba1797f84091cbe23"

                "t1318c5f428d474afba1797f84091cbe24"

            

            "UserData": "This is my Watermark job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T15:29:42+0800"

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}]

}

},

{

{

,

[{

,

}],

[ ],

}

},

{

,

,

},

[

,

,

],

,

},

,

,
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        "State": "Success"

        "Tag": "Watermark"

        "Workflow": 

            "Name": "Watermark_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

,

,

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-07-24 14:18:45

创建明水印模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

        <EndTime>100.5</EndTime>

        <Text>

            <Text>水印内容</Text>

            <FontSize>30</FontSize>

            <FontType>simfang.ttf</FontType>

            <FontColor>0x000000</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Image</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Image>

            <Url>http://test-1234567890.ci.ap-chongqing.myqcloud.com/shuiyin_2.png</Url>

            <Mode>Proportion</Mode>

            <Width>10</Width>

            <Height></Height>

            <Transparency>100</Transparency>

        </Image>

    </Watermark>

</Request>

节点名称（关键字） 父节点 描述 类型

Request 无 保存请求的容器 Container

Request

节点名称（关

键字）
父节点 描述 类型

必

选

Tag
Requ
est

模板类型: Watermark String 是
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Container 类型  的具体数据描述如下：

Name Requ

est

模板名称，仅支持中文、英文、数字、_、-和*，长度

不超过 64

String 是

Watermark
Requ

est
水印信息

Conta

iner
是

Watermark

节点名称（关

键字）
父节点 描述 类型

默认

值

是否

必选

Type
Request.W

atermark

水印类型

Text：文字水印

Image：图片水印

Strin

g
无 是

Pos
Request.W

atermark

基准位置

TopRight

TopLeft

BottomRight

BottomLeft

Left

Right

Top

Bottom

Center

Strin

g
无 是

LocMode
Request.W

atermark

偏移方式

Relativity：按比例

Absolute：固定位置

Strin

g
无 是

Dx Request.W

atermark

水平偏移

在图片水印中，如果 

Background 为 true，当 

locMode 为 Relativity 时，
为%，值范围：[-300 0]；当 

locMode 为 Absolute 时，为 

px，值范围：[-4096 0]。

在图片水印中，如果 
Background 为 false，当 

locMode 为 Relativity 时，

为%，值范围：[0 100]；当 

locMode 为 Absolute 时，为 

px，值范围：[0 4096]。

Strin

g

无 是
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在文字水印中，当 locMode 为 

Relativity 时，为%，值范围：

[0 100]；当 locMode 为 
Absolute 时，为 px，值范围：

[0 4096]。

当Pos为Top、Bottom和

Center时，该参数无效。

Dy
Request.W

atermark

垂直偏移

在图片水印中，如果 

Background 为 true，当 
locMode 为 Relativity 时，

为%，值范围：[-300 0]；当 

locMode 为 Absolute 时，为 

px，值范围：[-4096 0]。

在图片水印中，如果 
Background 为 false，当 

locMode 为 Relativity 时，

为%，值范围：[0 100]；当 

locMode 为 Absolute 时，为 
px，值范围：[0 4096]。

在文字水印中，当 locMode 为 

Relativity 时，为%，值范围：

[0 100]；当 locMode 为 
Absolute 时，为 px，值范围：

[0 4096]。

当Pos为Left、Right和Center

时，该参数无效。

Strin

g
无 是

StartTime
Request.W
atermark

水印开始时间

[0，视频时长] 

 单位为秒 

支持 float 格式，执行精度精确到

毫秒

Strin
g

0 否

EndTime
Request.W

atermark

水印结束时间
[0，视频时长] 

单位为秒 

支持 float 格式，执行精度精确到

毫秒

Strin

g

视频

结束

时间

否

SlideConfi

g

Request.W

atermark

水印滑动配置，配置该参数后水印位

移设置不生效，极速高清/H265转码

暂时不支持该参数

Cont

ainer

无 否
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Container 类型 SlideConfig 的具体数据描述如下：

Container 类型 Image 的具体数据描述如下：

Image
Request.W

atermark
图片水印节点

Cont

ainer
无 否

Text
Request.W
atermark

文本水印节点
Cont
ainer

无 否

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

SlideMode

Request.W

atermark.Sl

ideConfig

滑动模式

Default: 默认不开启

ScrollFromLeft: 从左到右滚动

若设置了ScrollFromLeft模式，则
Watermark.Pos参数不生效

St

ri

n

g

无 是

XSlideSpe
ed

Request.W

atermark.Sl
ideConfig

横向滑动速度，取值范围：[0,10]内的整数

St

ri
n

g

0 否

YSlideSpe
ed

Request.W
atermark.Sl

ideConfig

纵向滑动速度，取值范围：[0,10]内的整数

St

ri
n

g

0 否

节点名称（关

键字）
父节点 描述 类型

默

认

值

是否

必选

Url

Request.W

atermark.

Image

水印图地址(需要 Urlencode 后传入) String 无 是

Mode

Request.W

atermark.

Image

尺寸模式

Original：原有尺寸 

Proportion：按比例

Fixed：固定大小

String 无 是

Width Request.W

atermark.

宽

当 Mode 为 Original 时，不支持

String 无 否
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Image 设置水印图宽度 

当 Mode 为 Proportion，单位

为%，背景图值范围：[100 300]；

前景图值范围：[1 100]，相对于视

频宽，最大不超过4096px

当 Mode 为 Fixed，单位为 px，

值范围：[8，4096]

若只设置 Width 时，按照水印图比

例计算 Height

Height

Request.W

atermark.

Image

高

当 Mode 为 Original 时，不支持

设置水印图高度 

当 Mode 为 Proportion，单位

为%，背景图值范围：[100 300]；

前景图值范围：[1 100]，相对于视

频高，最大不超过4096px

当 Mode 为 Fixed，单位为 px，

值范围：[8，4096]

若只设置 Height 时，按照水印图比

例计算 Width

String 无 否

Transpare

ncy

Request.W

atermark.

Image

透明度，值范围：[1 100]，单位% String 无 是

Backgroun

d

Request.W

atermark.

Image

是否背景图，取值 true、false String

fa

ls

e

否
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水印位置说明：

Container 类型 Text 的具体数据描述如下：

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

FontSize
Request.Water

mark.Text

字体大小，值范围：[5 100]，单位 

px

St

ri

n

g

无 是

FontType
Request.Water

mark.Text
字体类型，参考下表

St

ri

n

g

无 是
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Text 的 FontType 具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

FontColor Request.Water

mark.Text

字体颜色，格式：0xRRGGBB St

ri
n

g

无 是

Transparen
cy

Request.Water
mark.Text

透明度，值范围：[1 100]，单位%

St

ri
n

g

无 是

Text
Request.Water

mark.Text

水印内容，长度不超过64个字符，

仅支持中文、英文、数字、_、-和*

St
ri

n

g

无 是

字体名称 支持的语言 描述

simfang.ttf 中/英 仿宋

simhei.ttf 中/英 黑体

simkai.ttf 中/英 楷体

simsun.ttc 中/英 宋体

STHeiti-Light.ttc 中/英 华文黑体

STHeiti-Medium.ttc 中/英 华文黑体中

youyuan.TTF 中/英 幼圆

ariblk.ttf 英 无

arial.ttf 英 无

ahronbd.ttf 英 无

Helvetica.dfont 英 无

HelveticaNeue.dfont 英 无

响应

响应头

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点  的内容：

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0x000000</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container
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Container 节点  的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa

te
模板 ID String

Name
Response.Templa

te
模板名称 String

BucketId
Response.Templa
te

模板所属存储桶 String

Category
Response.Templa

te
模板属性，Custom 或者 Official String

Tag
Response.Templa

te
模板类型，VideoProcess String

UpdateTime
Response.Templa
te

更新时间 String

CreateTime
Response.Templa

te
创建时间 String

Watermark
Response.Templa

te

同请求体中的 

Request.Watermark

Contain

er

错误码

实际案例

请求1（文本水印）

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

https://cloud.tencent.com/document/product/460/42867
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   <Watermark>

      <Type>Text</Type>

      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Text>

        <Text>水印内容</Text>

        <FontSize>30</FontSize>

        <FontType>simfang.ttf</FontType>

        <FontColor>0x000000</FontColor>

        <Transparency>30</Transparency>

      </Text>

   </Watermark>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>
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            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType>simfang.ttf</FontType>

                <FontColor>0x000000</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

   </Template>

</Response>

请求2（图片水印）

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

   <Tag>Watermark</Tag>

   <Name>TemplateName</Name>

   <Watermark>

      <Type>Image</Type>

      <LocMode>Absolute</LocMode>

      <Dx>128</Dx>

      <Dy>128</Dy>

      <Pos>TopRight</Pos>

      <StartTime>0</StartTime>

      <EndTime>100.5</EndTime>

      <Image>

        <Url>http://test-1234567890.ci.ap-chongqing.myqcloud.com/shuiyin_2.png</Url>

        <Mode>Proportion</Mode>

        <Width>10</Width>

        <Height>10</Height>

        <Transparency>30</Transparency>

      </Image>

   </Watermark>

</Request>

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <Watermark>

            <Type>Image</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Image>

                <Url>http://test-1234567890.ci.ap-chongqing.myqcloud.com/shuiyin_2.png</U

                <Mode>Proportion</Mode>

                <Width>10</Width>

                <Height>10</Height>

                <Transparency>30</Transparency>

            </Image>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-08 17:34:10

更新明水印模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <EndTime>100.5</EndTime>

        <Text>

            <Text>水印内容</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建水印模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84725#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建水印模板接口的 Response  
Containe

r

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Watermark</Tag>

    <Name>TemplateName</Name>

    <Watermark>

        <Type>Text</Type>

        <LocMode>Absolute</LocMode>

        <Dx>128</Dx>

        <Dy>128</Dy>

        <Pos>TopRight</Pos>

        <StartTime>0</StartTime>

        <EndTime>100.5</EndTime>

        <Text>

            <Text>水印内容</Text>

            <FontSize>30</FontSize>

            <FontType></FontType>

            <FontColor>0xRRGGBB</FontColor>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84725#Response
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            <Transparency>30</Transparency>

        </Text>

    </Watermark>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Tag>Watermark</Tag>

        <Name>TemplateName</Name>

        <Watermark>

            <Type>Text</Type>

            <LocMode>Absolute</LocMode>

            <Dx>128</Dx>

            <Dy>128</Dy>

            <Pos>TopRight</Pos>

            <StartTime>0</StartTime>

            <EndTime>100.5</EndTime>

            <Text>

                <Text>水印内容</Text>

                <FontSize>30</FontSize>

                <FontType></FontType>

                <FontColor>0xRRGGBB</FontColor>

                <Transparency>30</Transparency>

            </Text>

        </Watermark>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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视频标签
提交任务
最近更新时间：2023-08-01 16:46:24

提交一个视频标签任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：VideoTag

Strin

g
是

Input
Req

uest
待操作的文件信息

Cont

ainer
是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Strin

g
否

CallBack

Type

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型

Strin

g
否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBack

MqConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig

Cont

ainer
否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

Object Reques 执行视频标签任务的文件路径，目前支持 mp4、avi、 St 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 VideoTag 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

t.Input mkv、wmv、rmvb、flv、mov 封装格式，视频时长

超过30min的视频请 提交工单  处理

ri

n

g

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

VideoTag
Request.Ope

ration
任务参数

Conta

iner
是

JobLevel
Request.Ope
ration

任务优先级，级别限制：0 、1 、2。级别
越大任务优先级越高，默认为0

String 否

UserData
Request.Ope

ration
透传用户信息 String 否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Scenario

Request.O

peration.Vi

deoTag

场景类型，可选择视频标签的运用场景，不同的运

用场景使用的算法、输入输出等都会有所差异。当

前版本只支持  Stream 场景

stri

ng
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

https://cloud.tencent.com/document/product/460/42866
https://console.cloud.tencent.com/workorder/category


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第790 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J
obsDetail

新创建任务的 Tag：VideoTag
Stri
ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

State Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的 队列 ID  
Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region
Response.JobsDetail.Inpu

t
存储桶的地域 String

Bucket
Response.JobsDetail.Inpu

t
存储结果的存储桶 String

Object
Response.JobsDetail.Inpu

t
输出结果的文件名 String

节点名称（关键
字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/46487
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Container 节点 VideoTagResult 的内容：

Container 节点 StreamData 的内容：

Container 节点 Data 的内容：

VideoTag
Response.JobsDetail.O

peration

同请求中的 

Request.Operation.VideoTag

Contai

ner

VideoTagResu

lt

Response.JobsDetail.O

peration

视频标签分析结果,任务未完成时不

返回

Contai

ner

UserData
Response.JobsDetail.O
peration

透传用户信息 String

JobLevel
Response.JobsDetail.O

peration
任务优先级 String

节点名称（关键

字）
父节点 描述 类型

StreamData
Response.JobsDetail.Operation.

VideoTagResult

Stream 场景下视频标签任

务的结果

Conta

iner

节点名称（关

键字）
父节点 描述 类型

Data
Response.JobsDetail.Operation.Vid

eoTagResult.StreamData

Stream 场景视频标签任务

的结果列表

Con

tain

er

SubErrCo

de

Response.JobsDetail.Operation.Vid

eoTagResult.StreamData

算法状态码，成功为0，非0

异常

Stri

ng

SubErrMs
g

Response.JobsDetail.Operation.Vid
eoTagResult.StreamData

算法错误描述，成功为 ok , 
不成功返回对应错误

Stri
ng

节点名称（关

键字）
父节点 描述 类型

Tags
Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data

视频标签、视频分

类信息

Contain

er

PersonTag

s

Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data
人物标签信息

Contain

er 数组
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Container 节点 Tags （视频标签）的内容：

Container 节点 Tags （视频分类）的内容：

Container 节点 PersonTags 的内容：

PlaceTags Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data

场景标签信息 Contain

er 数组

ActionTags
Response.JobsDetail.Operation.VideoT
agResult.StreamData.Data

动作标签信息
Contain
er 数组

ObjectTags
Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data
物体标签信息

Contain

er 数组

节点名称（关

键字）
父节点 描述

类

型

Tag
Response.JobsDetail.Operation.VideoTag

Result.StreamData.Data.Tags
标签名称

St

ri

n
g

TagCls
Response.JobsDetail.Operation.VideoTag

Result.StreamData.Data.Tags
标签分类名称

St

ri

n
g

Confidenc

e

Response.JobsDetail.Operation.VideoTag

Result.StreamData.Data.Tags

标签模型预测分数，取

值范围[0,1]

Fl

o
at

节点名称（关

键字）
父节点 描述

类

型

Tag
Response.JobsDetail.Operation.VideoTag
Result.StreamData.Data.Tags

视频分类名称

St

ri
n

g

Confidenc
e

Response.JobsDetail.Operation.VideoTag
Result.StreamData.Data.Tags

标签模型预测分数，取
值范围[0,1]

Fl
o

at

节点名称（关

键字）
父节点 描述 类型
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Container 节点 DetailPerSecond 的内容：

Container 节点 BBox 的内容：

Name Response.JobsDetail.Operation.Video
TagResult.StreamData.Data.PersonTa

gs

人物名字 String

Confidenc

e

Response.JobsDetail.Operation.Video
TagResult.StreamData.Data.PersonTa

gs

标签模型预测分数 Float

Count
Response.JobsDetail.Operation.Video
TagResult.StreamData.Data.PersonTa

gs

任务出现频次 String

DetailPerS
econd

Response.JobsDetail.Operation.Video

TagResult.StreamData.Data.PersonTa
gs

具体识别到人物出现
的位置和时间信息

Contain
er 数组

节点名称（关

键字）
父节点 描述 类型

TimeStam
p

Response.JobsDetail.Operation.VideoT
agResult.StreamData.Data.PersonTags

.DetailPerSecond

出现时间，单位为秒 String

Confidenc
e

Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data.PersonTags
.DetailPerSecond

标签模型预测分数 Float

BBox

Response.JobsDetail.Operation.VideoT

agResult.StreamData.Data.PersonTags
.DetailPerSecond

左上角为原点，物体

的相对坐标

Contain

er 数组

节点名称（关

键字）
父节点 描述 类型

X1

Response.JobsDetail.Operation.VideoTagRes

ult.StreamData.Data.PersonTags.DetailPerSec
ond.BBox

坐标X1的相对位
置

Stri
ng

Y1

Response.JobsDetail.Operation.VideoTagRes

ult.StreamData.Data.PersonTags.DetailPerSec
ond.BBox

坐标Y1的相对位

置

Stri

ng

X2 Response.JobsDetail.Operation.VideoTagRes 坐标X2的相对位 Stri
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Container 节点 PlaceTags 的内容：

Container 节点 ActionTags 的内容：

ult.StreamData.Data.PersonTags.DetailPerSec
ond.BBox

置 ng

Y2

Response.JobsDetail.Operation.VideoTagRes

ult.StreamData.Data.PersonTags.DetailPerSec

ond.BBox

坐标Y2的相对位

置

Stri

ng

节点名称（关
键字）

父节点 描述 类型

Tags
Response.JobsDetail.Opera
tion.VideoTagResult.Stream

Data.Data.PlaceTags

视频场景标签信息，可能不返回，内

容同 
Response.JobsDetail.Operat

ion.VideoTagResult.StreamD

ata.Data.Tags

Contai
ner 数

组

StartTime
Response.JobsDetail.Opera
tion.VideoTagResult.Stream

Data.Data.PlaceTags

片段起始时间，单位为秒 String

EndTime
Response.JobsDetail.Opera
tion.VideoTagResult.Stream

Data.Data.PlaceTags

片段结束时间，单位为秒 String

StartIndex

Response.JobsDetail.Opera

tion.VideoTagResult.Stream
Data.Data.PlaceTags

片段起始帧数 String

EndIndex

Response.JobsDetail.Opera

tion.VideoTagResult.Stream
Data.Data.PlaceTags

片段结束帧数 String

ClipFrame

Result

Response.JobsDetail.Opera

tion.VideoTagResult.Stream

Data.Data.PlaceTags

单帧识别结果top1 String

节点名称（关
键字）

父节点 描述 类型

Tags Response.JobsDetail.Opera

tion.VideoTagResult.Strea
mData.Data.ActionTags

视频动作标签信息，可能不返回，

内容同 
Response.JobsDetail.Operat

Contain

er 数组
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Container 节点 ObjectTags 的内容：

Container 节点 Object 的内容：

ion.VideoTagResult.Stream

Data.Data.Tags

StartTime

Response.JobsDetail.Opera

tion.VideoTagResult.Strea

mData.Data.ActionTags

片段起始时间，单位为秒 String

EndTime

Response.JobsDetail.Opera

tion.VideoTagResult.Strea

mData.Data.ActionTags

片段结束时间，单位为秒 String

节点名称（关

键字）
父节点 描述 类型

Objects

Response.JobsDetail.Opera

tion.VideoTagResult.Strea

mData.Data.ObjectTags

视频物体标签信息，可能不返回，

内容同 

Response.JobsDetail.Operat

ion.VideoTagResult.Stream
Data.Data.Tags

Contain

er 数组

TimeStam

p

Response.JobsDetail.Opera

tion.VideoTagResult.Strea
mData.Data.ObjectTags

识别物体时间戳，单位为秒 String

节点名称（关

键字）
父节点 描述 类型

Name

Response.JobsDetail.Opera

tion.VideoTagResult.Stream
Data.Data.ObjectTags.Obje

cts

物体名称 string

Confidenc

e

Response.JobsDetail.Opera
tion.VideoTagResult.Stream

Data.Data.ObjectTags.Obje

cts

标签模型预测分数，取值范围[0,1] Float

BBox Response.JobsDetail.Opera
tion.VideoTagResult.Stream

Data.Data.ObjectTags.Obje

cts

左上角为原点，物体的相对坐标，
内容同 

Response.JobsDetail.Opera

tion.VideoTagResult.Stream

Contain
er 数组
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Data.Data.PersonTags.Deta

ilPerSecond.BBox

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoTag</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTag>

            <Scenario>Stream</Scenario>

        </VideoTag>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

https://cloud.tencent.com/document/product/460/42867
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTag</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第799 共1950页

回调信息
最近更新时间：2023-08-10 18:13:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <JobLevel>0</JobLevel>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>说话</Tag>

                                <TagCls>说话</TagCls>

                            </Tags>

                        </ActionTags>
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                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>电脑键盘</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.59</ClipFrameResult>

                            <ClipFrameResult>办公室:0.54</ClipFrameResult>

                            <ClipFrameResult>办公室:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.43</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <ClipFrameResult>办公室:0.29</ClipFrameResult>

                            <ClipFrameResult>办公室:0.15</ClipFrameResult>

                            <ClipFrameResult>娱乐场:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>办公室</Tag>

                                <TagCls>办公</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>超市/便利店/商店</Tag>

                                <TagCls>商业</TagCls>

                            </Tags>
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                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>其他:0.09</ClipFrameResult>

                            <ClipFrameResult>其他:0.21</ClipFrameResult>

                            <ClipFrameResult>其他:0.19</ClipFrameResult>

                            <ClipFrameResult>天空:0.28</ClipFrameResult>

                            <ClipFrameResult>天空:0.25</ClipFrameResult>

                            <ClipFrameResult>其他:0.30</ClipFrameResult>

                            <ClipFrameResult>其他:0.28</ClipFrameResult>

                            <ClipFrameResult>其他:0.49</ClipFrameResult>

                            <ClipFrameResult>其他:0.56</ClipFrameResult>

                            <ClipFrameResult>其他:0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>其他</Tag>

                                <TagCls>其他</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>天空</Tag>

                                <TagCls>自然/户外</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA类-王者荣耀</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>游戏</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>办公室</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>超市/便利店/商店</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

EventName
Respo
nse

固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交视频标签接口中的 

Response.JobsDetail  
Container数组

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.Co
sHeaders

自定义 Header 的名称
Stri
ng

Value
Response.JobsDetail.Input.Co

sHeaders
自定义 Header 的值

Stri

ng

https://cloud.tencent.com/document/product/460/84779#JobsDetail
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节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:05:48+0800</CreationTime>

        <EndTime>2022-07-01T10:06:02+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j535b10a4f8e211ec9452c1c27f56a659</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my VideoTag job.</UserData>

            <JobLevel>0</JobLevel>

            <VideoTag>

                <Scenario>Stream</Scenario>

            </VideoTag>

            <VideoTagResult>

                <StreamData>

                    <Data>

                        <ActionTags>

                            <EndTime>11</EndTime>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.421531</Confidence>

                                <Tag>说话</Tag>

                                <TagCls>说话</TagCls>

                            </Tags>

                        </ActionTags>
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                        <ActionTags>

                            <EndTime>12.88</EndTime>

                            <StartTime>11.04</StartTime>

                            <Tags/>

                        </ActionTags>

                        <ObjectTags>

                            <Objects>

                                <BBox>

                                    <X1>0.10181817412376404</X1>

                                    <X2>0.8069194555282593</X2>

                                    <Y1>0.6880248785018921</Y1>

                                    <Y2>0.8779844045639038</Y2>

                                </BBox>

                                <Confidence>0.808393</Confidence>

                                <Name>电脑键盘</Name>

                            </Objects>

                            <TimeStamp>11</TimeStamp>

                        </ObjectTags>

                        <PersonTags/>

                        <PlaceTags>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.55</ClipFrameResult>

                            <ClipFrameResult>办公室:0.59</ClipFrameResult>

                            <ClipFrameResult>办公室:0.54</ClipFrameResult>

                            <ClipFrameResult>办公室:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.43</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <ClipFrameResult>办公室:0.29</ClipFrameResult>

                            <ClipFrameResult>办公室:0.15</ClipFrameResult>

                            <ClipFrameResult>娱乐场:0.42</ClipFrameResult>

                            <ClipFrameResult>办公室:0.33</ClipFrameResult>

                            <EndIndex>275</EndIndex>

                            <EndTime>11</EndTime>

                            <StartIndex>0</StartIndex>

                            <StartTime>0</StartTime>

                            <Tags>

                                <Confidence>0.591724</Confidence>

                                <Tag>办公室</Tag>

                                <TagCls>办公</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.175342</Confidence>

                                <Tag>超市/便利店/商店</Tag>

                                <TagCls>商业</TagCls>

                            </Tags>
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                        </PlaceTags>

                        <PlaceTags>

                            <ClipFrameResult>其他:0.09</ClipFrameResult>

                            <ClipFrameResult>其他:0.21</ClipFrameResult>

                            <ClipFrameResult>其他:0.19</ClipFrameResult>

                            <ClipFrameResult>天空:0.28</ClipFrameResult>

                            <ClipFrameResult>天空:0.25</ClipFrameResult>

                            <ClipFrameResult>其他:0.30</ClipFrameResult>

                            <ClipFrameResult>其他:0.28</ClipFrameResult>

                            <ClipFrameResult>其他:0.49</ClipFrameResult>

                            <ClipFrameResult>其他:0.56</ClipFrameResult>

                            <ClipFrameResult>其他:0.58</ClipFrameResult>

                            <EndIndex>322</EndIndex>

                            <EndTime>12.88</EndTime>

                            <StartIndex>276</StartIndex>

                            <StartTime>11.04</StartTime>

                            <Tags>

                                <Confidence>0.581444</Confidence>

                                <Tag>其他</Tag>

                                <TagCls>其他</TagCls>

                            </Tags>

                            <Tags>

                                <Confidence>0.283301</Confidence>

                                <Tag>天空</Tag>

                                <TagCls>自然/户外</TagCls>

                            </Tags>

                        </PlaceTags>

                        <Tags>

                            <Confidence>0.355083</Confidence>

                            <Tag>MOBA类-王者荣耀</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.587103</Confidence>

                            <Tag>游戏</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.544651</Confidence>

                            <Tag>办公室</Tag>

                        </Tags>

                        <Tags>

                            <Confidence>0.182886</Confidence>

                            <Tag>超市/便利店/商店</Tag>

                        </Tags>

                    </Data>

                    <SubErrCode>0</SubErrCode>
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                    <SubErrMsg>ok</SubErrMsg>

                </StreamData>

            </VideoTagResult>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:05:50+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTag</Tag>

        <VideoTag/>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-07-01T10:05:48+0800"

        "EndTime": "2022-07-01T10:06:02+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "j535b10a4f8e211ec9452c1c27f56a659"

        "Message": "Success"

        "Operation": 

            "UserData": "This is my VideoTag job."

            "JobLevel": 0

            "VideoTag": 

                "Scenario": "Stream"

            

            "VideoTagResult": 

                "StreamData": 

                    "Data": 

                        "ActionTags": 

                                "EndTime": "11"

                                "StartTime": "0"

                                "Tags": 

                                    "Confidence": "0.421531"

                                    "Tag": "说话"

                                    "TagCls": "说话"

                                

{

,

[{

,

,

,

{

,

,

},

,

,

{

,

,

{

},

{

{

{

[{

,

,

{

,

,

}
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                                "EndTime": "12.88"

                                "StartTime": "11.04"

                            

                        

                        "ObjectTags": 

                            "Objects": 

                                "BBox": 

                                    "X1": "0.10181817412376404"

                                    "X2": "0.8069194555282593"

                                    "Y1": "0.6880248785018921"

                                    "Y2": "0.8779844045639038"

                                

                                "Confidence": "0.808393"

                                "Name": "电脑键盘"

                            

                            "TimeStamp": "11"

                        

                        "PlaceTags": 

                                "ClipFrameResult": 

                                    "办公室:0.55"

                                    "办公室:0.55"

                                    "办公室:0.59"

                                    "办公室:0.54"

                                    "办公室:0.42"

                                    "办公室:0.43"

                                    "办公室:0.33"

                                    "办公室:0.29"

                                    "办公室:0.15"

                                    "娱乐场:0.42"

                                    "办公室:0.33"

                                

                                "EndIndex": "275"

                                "EndTime": "11"

                                "StartIndex": "0"

                                "StartTime": "0"

                                "Tags": 

                                        "Confidence": "0.591724"

                                        "Tag": "办公室"

                                        "TagCls": "办公"

                                    

                                    

                                        "Confidence": "0.175342"

                                        "Tag": "超市/便利店/商店"

},

{

,

}

],

{

{

{

,

,

,

},

,

},

},

[{

[

,

,

,

,

,

,

,

,

,

,

],

,

,

,

,

[{

,

,

},

{

,

,
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                                        "TagCls": "商业"

                                    

                                

                            

                            

                                "ClipFrameResult": 

                                    "其他:0.09"

                                    "其他:0.21"

                                    "其他:0.19"

                                    "天空:0.28"

                                    "天空:0.25"

                                    "其他:0.30"

                                    "其他:0.28"

                                    "其他:0.49"

                                    "其他:0.56"

                                    "其他:0.58"

                                

                                "EndIndex": "322"

                                "EndTime": "12.88"

                                "StartIndex": "276"

                                "StartTime": "11.04"

                                "Tags": 

                                        "Confidence": "0.581444"

                                        "Tag": "其他"

                                        "TagCls": "其他"

                                    

                                    

                                        "Confidence": "0.283301"

                                        "Tag": "天空"

                                        "TagCls": "自然/户外"

                                    

                                

                            

                        

                        "Tags": 

                                "Confidence": "0.355083"

                                "Tag": "MOBA类-王者荣耀"

                            

                            

                                "Confidence": "0.587103"

                                "Tag": "游戏"

                            

                            

                                "Confidence": "0.544651"

                                "Tag": "办公室"

}

]

},

{

[

,

,

,

,

,

,

,

,

,

],

,

,

,

,

[{

,

,

},

{

,

,

}

]

}

],

[{

,

},

{

,

},

{

,
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                                "Confidence": "0.182886"

                                "Tag": "超市/便利店/商店"

                            

                        

                    

                    "SubErrCode": "0"

                    "SubErrMsg": "ok"

                

            

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-07-01T10:05:50+0800"

        "State": "Success"

        "Tag": "VideoTag"

    

},

{

,

}

]

},

,

}

}

},

,

,

,

}]

}
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视频质量评分
提交任务
最近更新时间：2023-08-01 16:46:24

提交一个视频质量分析任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <QualityEstimateConfig>

            <Rotate>90</Rotate>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Mode>vqaPlus</Mode>

        </QualityEstimateConfig>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：QualityEstimate String 是

Input
Req
uest

待操作的文件信息
Conta
iner

是

Operation
Req

uest
操作规则

Conta

iner
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式
String 否

CallBackT
ype

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于
队列的回调类型

String 否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调
String 否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig

Conta

iner
否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Operation

节点名称（关键

字）
父节点 描述 类型

是否

必选

QualityEstim

ateConfig

Request.Op

eration
质量评分配置

Con

tain

er

否

UserData
Request.Op

eration

透传用户信息，可打印的 ASCII 码 ，长度不超

过1024

Stri

ng
否

JobLevel
Request.Op
eration

任务优先级，级别限制：0 、1 、2 。级别越大
任务优先级越高，默认为0

Stri
ng

否

Operation

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

Rotate
Request.Operation.Qual

ityEstimateConfig

旋转角度，只支持 0，

90，180，270

St

ri

n

g

0 否

Mode
Request.Operation.Qual
ityEstimateConfig

分析模式

general: 普通分析, 只

返回视频质量分数

vqaPlus: 返回更详细
的分析结果

设置为vqaPlus时，

Rotate 参数无效

St

ri
n

g

ge

ne
ral

否

响应

响应头

响应体

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <QualityEstimateConfig>

                <Rotate>90</Rotate>

                <Mode>vqaPlus</Mode>

            </QualityEstimateConfig>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng
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Container 节点 Input 的内容：

Message Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义 Stri
ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：QualityEstimate

Stri

ng

State
Response.J

obsDetail

任任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J
obsDetail

任务的开始时间
Stri
ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J
obsDetail

该任务的输入资源地址
Con
tain

er

Operation
Response.J
obsDetail

该任务的规则

Con

tain
er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

Container 节点 QualityEstimate 的内容：

Container 节点 QualityEstimate 的内容：

Container 节点 DetailedResult 的内容：

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

MediaInfo
Response.JobsDet

ail.Operation

输出视频的信息，任务未完成时不返回，

详见 MediaInfo  

Contai

ner

QualityEstimat
e

Response.JobsDet
ail.Operation

视频分析结果，任务未完成时不返回
Contai
ner

UserData
Response.JobsDet

ail.Operation
透传用户信息 String

节点名称（关

键字）
父节点 描述 类型

Score
Response.JobsDetail.Oper

ation.QualityEstimate

视频质量得分，满分为10分，达到6

分就可以认为视频质量良好
String

VqaPlusR

esult

Response.JobsDetail.Oper

ation.QualityEstimate
模式为 vqaPlus 时的分析结果

Conta

iner

节点名称（关

键字）
父节点 描述 类型

NoAudio
Response.JobsDetail.Opera
tion.QualityEstimate.VqaPlu

sResult

无音频 bool

NoVideo
Response.JobsDetail.Opera
tion.QualityEstimate.VqaPlu

sResult

无视频 bool

DetailedRe
sult

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu
sResult

详细的分析结果,

Contai

ner 数
组

https://cloud.tencent.com/document/product/460/49284#MediaInfo
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Container 节点 Items 的内容：

节点名称

（关键字）

父节点 描述 类型

Type

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu

sResult.DetailedResult

异常项，取值范围：

Jitter: 抖动

Blur: 模糊

LowLighting: 低光照

HighLighting: 过曝

CrashScreen: 花屏

BlackWhiteEdge: 黑白边

SolidColorScreen: 纯色屏

Noise: 噪点

Mosaic: 马赛克

QRCode: 二维码

AppletCode: 小程序码

BarCode: 条形码

LowVoice: 低音

HighVoice: 爆音

NoVoice: 静音

LowEvaluation: 无参考打分

低于阈值

String

Items

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu

sResult.DetailedResult

异常项信息。
Contain

e r数组

节点名称（关

键字）
父节点 描述 类型

Confidenc

e

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu

sResult.DetailedResult.Item
s

置信度，取值范围是 0 到 100。某

些场景下该字段可能不返回。

Intege

r

StartTime

Offset

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu

sResult.DetailedResult.Item
s

出现的起始时间，单位：秒 Float

EndTimeO

ffset

Response.JobsDetail.Opera

tion.QualityEstimate.VqaPlu

出现的结束时间，单位：秒 Float
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

sResult.DetailedResult.Item

s

AreaCoord

Set

Response.JobsDetail.Opera
tion.QualityEstimate.VqaPlu

sResult.DetailedResult.Item

s

区域坐标(px)，即左上角坐标、右下

角坐标

Intege

r 数组

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>QualityEstimate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <QualityEstimateConfig>

            <Rotate>90</Rotate>

            <Mode>vqaPlus</Mode>

        </QualityEstimateConfig>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第818 共1950页

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>QualityEstimate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <QualityEstimateConfig>

                <Rotate>90</Rotate>

                <Mode>vqaPlus</Mode>

            </QualityEstimateConfig>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>
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具体的数据内容如下：

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>

                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container
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Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字）
父节
点

描述 类型

EventName
Resp

onse
固定值，为 TaskFinish String

JobsDetail
Resp

onse

同提交视频质量分析任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:06:27+0800</CreationTime>

https://cloud.tencent.com/document/product/460/84783#JobsDetail
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        <EndTime>2022-06-30T19:06:34+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>jb01fe2f2f86411ec9ca1073b78d316d3</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>834736</Bitrate>

                    <Duration>13.654</Duration>

                    <NumStream>1</NumStream>

                    <Size>1424687</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104047</Bitrate>

                        <Channel>2</Channel>

                        <CodecName>aac</CodecName>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000</AvgFps>

                        <Bitrate>763774</Bitrate>

                        <CodecName>h264</CodecName>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <Fps>25.000</Fps>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Level>1.000</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <Rotation>0</Rotation>

                        <StartTime>0.000</StartTime>

                        <Timebase>1/12800</Timebase>
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                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile/>

            </MediaResult>

            <QualityEstimate>

                <Score>6.460358</Score>

            </QualityEstimate>

            <UserData>This is my QualityEstimate job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:06:28+0800</StartTime>

        <State>Success</State>

        <Tag>QualityEstimate</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:06:27+0800"

        "EndTime": "2022-06-30T19:06:34+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "jb01fe2f2f86411ec9ca1073b78d316d3"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "834736"

                    "Duration": "13.654"

                    "NumStream": "1"

                    "Size": "1424687"

                

                "Stream": 

                    "Audio": 

{

,

[{

,

,

,

{

,

,

},

,

{

{

{

,

,

,

},

{

[{
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                        "Bitrate": "104047"

                        "Channel": "2"

                        "CodecName": "aac"

                        "Duration": "13.653"

                        "Index": "1"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                    

                    "Video": 

                        "AvgFps": "25.000"

                        "Bitrate": "763774"

                        "CodecName": "h264"

                        "ColorPrimaries": "unknown"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

                        "Duration": "12.960"

                        "Fps": "25.000"

                        "Height": "960"

                        "Index": "0"

                        "Level": "1.000"

                        "NumFrames": "324"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "Rotation": "0"

                        "StartTime": "0.000"

                        "Timebase": "1/12800"

                        "Width": "544"

                    

                

            

            "MediaResult": 

            

            "QualityEstimate": 

                "Score": "6.460358"

            

            "UserData": "This is my QualityEstimate job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T19:06:28+0800"

        "State": "Success"

        "Tag": "QualityEstimate"

    

,

,

,

,

,

,

}],

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}]

}

},

{

},

{

},

,

},

,

,

,

}]

}
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视频转动图

提交任务
最近更新时间：2023-08-01 16:46:25

提交一个动图任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型  的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型
是否必

选

Request 无 保存请求的容器
Contai
ner

是

Request

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req
uest

创建任务的 Tag：Animation
Stri
ng

是

Input
Req

uest
待操作的文件信息

Con

tain

er

是

Operation
Req

uest
操作规则

Con

tain

er

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Stri

ng
否

CallBackT
ype

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队
列的回调类型

Stri
ng

否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Stri

ng
否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Con

tain

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 Animation 的具体数据描述如下：

er

节点名称（关键字） 父节点 描述 类型
是否必
选

Object
Request.Inpu

t
文件路径 String 是

节点名称（关键

字）
父节点 描述 类型

是否

必选

TemplateId
Request.O

peration
视频转动图模板 ID

Stri

ng
否

Animation
Request.O

peration
视频转动图参数

Con

tain

er

否

Output
Request.O

peration
结果输出配置

Con
tain

er

是

UserData
Request.O
peration

透传用户信息，可打印的 ASCII 码，长度不超
过1024

Stri
ng

否

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级别越大

任务优先级越高，默认为0

Stri

ng
否

注意

视频转动图参数必须设置，可以通过 TemplateId 或 Animation 设置， TemplateId 优先级更高。

节点名称（关

键字）
父节点 描述 类型

是否

必选

Container
Request.Operati

on.Animation

同创建动图模板接口中的 

Request.Container  

Con

tain

er

否

Video Request.Operati 同创建动图模板接口中的 Con 否

https://cloud.tencent.com/document/product/460/84729#Container
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Container 类型 Output 的具体数据描述如下：

Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

on.Animation Request.Video  tain

er

TimeInterv

al

Request.Operati

on.Animation

同创建动图模板接口中的 

Request.TimeInterval  

Con

tain

er

否

节点名称（关键字） 父节点 描述 类型 是否必选

Region Request.Operation.Output 存储桶的地域 String 是

Bucket Request.Operation.Output 存储结果的存储桶 String 是

Object Request.Operation.Output 输出结果的文件名 String 是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84729#Video
https://cloud.tencent.com/document/product/460/84729#TimeInterval
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器
Containe
r

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Contain

er 数组

JobsDetail

节点名称（关键
字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId Response.J
obsDetail

新创建任务的 ID Stri
ng
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Container 节点 Input 的内容：

Tag
Response.J

obsDetail
新创建任务的 Tag：Animation

Stri

ng

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会

变为暂停状态

Cancel：任务被取消执行

Stri
ng

CreationTim

e

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键字） 父节点 描述
类

型

Region
Response.JobsDetail.Inpu

t
存储桶的地域

Str

ing

Bucket
Response.JobsDetail.Inpu

t
存储结果的存储桶

Str

ing

Object
Response.JobsDetail.Inpu

t
输出结果的文件名

Str

ing

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

使用动图模板 ID

节点名称（关

键字）
父节点 描述 类型

TemplateId
Response.JobsDet

ail.Operation
任务的模板 ID

Strin

g

TemplateN
ame

Response.JobsDet
ail.Operation

任务的模板名称, 当 TemplateId 存在时返回
Strin
g

Animation
Response.JobsDet

ail.Operation
同请求中的 Request.Operation.Animation

Cont

ainer

Output
Response.JobsDet

ail.Operation
同请求中的 Request.Operation.Output

Cont

ainer

MediaInfo
Response.JobsDet
ail.Operation

输出文件的媒体信息，任务未完成时不返回，详
见 MediaInfo  

Cont
ainer

MediaResul

t

Response.JobsDet

ail.Operation

输出文件的基本信息，任务未完成时不返回，详

见 MediaResult  

Cont

ainer

UserData
Response.JobsDet

ail.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDet
ail.Operation

任务优先级
Strin
g

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第834 共1950页

使用动图处理参数

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Animation>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </Animation>
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        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j229ed9e2f60c11ec8525e36307395bf9</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Animation</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Animation>

                <Container>

                    <Format>gif</Format>

                </Container>

                <Video>
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                    <Codec>gif</Codec>

                    <Width>1280</Width>

                    <Height>960</Height>

                    <Fps>15</Fps>

                    <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

                </Video>

                <TimeInterval>

                    <Start>0</Start>

                    <Duration>60</Duration>

                </TimeInterval>

            </Animation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 18:10:32

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</Form

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)</Cod
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                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Resp

onse
固定值，为 TaskFinish String

JobsDetail
Resp

onse

同提交动图任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

https://cloud.tencent.com/document/product/460/84784#JobsDetail
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Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</Form

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>

                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)</Cod

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>
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                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>97624.424000</Bitrate>

                    <Duration>0.870000</Duration>

                    <FormatLongName>CompuServe Graphics Interchange Format (GIF)</Form

                    <FormatName>gif</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>10616656</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video>
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                        <AvgFps>14.666667</AvgFps>

                        <CodecLongName>CompuServe GIF (Graphics Interchange Format)</Cod

                        <CodecName>gif</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/100</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>0.870000</Duration>

                        <Fps>15.083333</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>2258</Height>

                        <Index>0</Index>

                        <Level>-99</Level>

                        <NumFrames>7</NumFrames>

                        <PixFormat>bgra</PixFormat>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/100</Timebase>

                        <Width>1280</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                        <ObjectName>output/animation.gif</ObjectName>

                    </Md5Info>

                    <ObjectName>output/animation.gif</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>template_name1512456</TemplateName>

            <UserData>This is my Animation job.</UserData>
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            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>Animation</Tag>

        <Workflow>

            <Name>Animation_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T15:29:42+0800"

        "EndTime": "2022-06-30T15:29:48+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

{

,

[{

,

,

,

{

,

,

,

[{

,

},

{

,

},

{

,

},

{

,

}

]
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        "JobId": "j682b9662f84611ecb8546d80f2baf56f"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "97624.424000"

                    "Duration": "0.870000"

                    "FormatLongName": "CompuServe Graphics Interchange Format (GIF)"

                    "FormatName": "gif"

                    "NumProgram": "0"

                    "NumStream": "1"

                    "Size": "10616656"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Video": 

                        "AvgFps": "14.666667"

                        "CodecLongName": "CompuServe GIF (Graphics Interchange Format)"

                        "CodecName": "gif"

                        "CodecTag": "0x0000"

                        "CodecTagString": "[0][0][0][0]"

                        "CodecTimeBase": "1/100"

                        "ColorPrimaries": "unknown"

                        "ColorRange": "unknown"

                        "ColorTransfer": "unknown"

                        "Duration": "0.870000"

                        "Fps": "15.083333"

                        "HasBFrame": "0"

                        "Height": "2258"

                        "Index": "0"

                        "Level": "-99"

                        "NumFrames": "7"

                        "PixFormat": "bgra"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.000000"

                        "Timebase": "1/100"

                        "Width": "1280"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

},

,

{

{

{

,

,

,

,

,

,

,

},

{

{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}

}

},

{

{

,

[{
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                        "Md5": "3df1f845d2ffd20a525a93ec40014d90"

                        "ObjectName": "output/animation.gif"

                    

                    "ObjectName": "output/animation.gif"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/animation.${ext}"

                "Region": "ap-chongqing"

            

            "TemplateId": "t1f16e1dfbdc994105b31292d45710642a"

            "TemplateName": "template_name1512456"

            "UserData": "This is my Animation job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T15:29:43+0800"

        "State": "Success"

        "Tag": "Animation"

        "Workflow": 

            "Name": "Animation_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

,

}],

[ ],

}

},

{

,

,

},

,

,

,

},

,

,

,

,

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-07-25 09:06:34

创建视频转动图模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Request 节点  的具体数据描述如下：

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关
键字）

父节
点

描述 类型
是否必
选

Tag
Req

uest
模板类型：Animation String 是

Name
Req

uest

模板名称仅支持中文、英文、数字、_、-和*，长

度不超过 64
String 是

Container
Req
uest

容器格式
Contai
ner

是

Video
Req

uest
视频信息

Contai

ner
否

TimeInterv

al

Req

uest
时间区间

Contai

ner
否

Container

节点名称（关

键字）
父节点 描述

类

型

默认

值

是否

必选

Format
Request.

Container
封装格式：gif，hgif，webp  

St
ri

n

g

无 是
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Request 节点  的具体数据描述如下：

说明：

hgif 为高质量 gif，即清晰度比较高的 gif 格式图

Video

节点名称（关键字） 父节点 描述
类
型

默认
值

是否
必选

Codec
Reques

t.Video
编解码格式，取值 gif,、webp

Str

ing
无 是

Width
Reques

t.Video

宽

值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频原

始比例计算 Height

Str

ing

视频

原始
宽度

否

Height
Reques

t.Video

高
值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频原

始比例计算 Width

Str

ing

视频

原始

高度

否

Fps
Reques
t.Video

帧率

值范围：(0，60]

单位：fps

如果不设置，那么播放速度按照原

来的时间戳。这里设置 fps 为动图

的播放帧率

Str
ing

视频

原始
帧率

否

AnimateOnlyKe

epKeyFrame

Reques

t.Video

动图只保留关键帧

true ：

AnimateTimeIntervalOfFra

me 和 

AnimateFramesPerSecond 
无效

false：

AnimateTimeIntervalOfFra

me  和 
AnimateFramesPerSecond 

必填

Str

ing

fals

e
否

AnimateTimeInt Reques 动图抽帧间隔时间 Str 无 否
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Request 节点  的具体数据描述如下：

该响应包含公共响应头，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

ervalOfFrame t.Video 取值范围：（0，视频时长 ]

若设置 

TimeInterval.Duration，则小
于该值

ing

AnimateFrames

PerSecond

Reques

t.Video

每秒抽帧帧数，取值范围：（0，视频

帧率）

Str

ing
无 否

Quality
Reques

t.Video

相对质量

取值范围： [1, 100)

webp 图像质量设定生效，gif 没

有质量参数

Str

ing
无 否

TimeInterval

节点名称（关
键字）

父节点 描述
类
型

默认
值

是否
必选

Start
Request.Tim

eInterval

开始时间

 [0 视频时长] 

单位为秒 

支持 float 格式，执行精度精确到毫

秒

St
ri

n

g

0 否

Duration
Request.Tim

eInterval

持续时间

[0 视频时长] 

单位为秒 

支持 float 格式，执行精度精确到毫
秒

St

ri

n

g

视频

时长
否

响应

响应头

响应体

<Response>

    <Template>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

TemplateId Response 模板 ID String

Name Response 模板名字 String

BucketId Response 模板所属存储桶 String

Category Response 模板属性，Custom 或者 Official String

Tag Response 模板 Tag String

UpdateTime Response 更新时间 String
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Container 节点   的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

CreateTime Response 创建时间 String

TransTpl Response 详细的模板参数 Container

TransTpl

节点名称（关

键字）
父节点 描述 类型

Container Request 同请求体中的  Request.Container
Contai
ner

Video Request 同请求体中的  Request.Video
Contai

ner

TimeInterv

al
Request 同请求体中的  Request.TimeInterval

Contai

ner

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <Container>

       <Format>gif</Format>

    </Container>

    <Video>

       <Codec>gif</Codec>

       <Width>1280</Width>

       <Height></Height>

       <Fps>15</Fps>

       <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

https://cloud.tencent.com/document/product/460/42867
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       <Start>0</Start>

       <Duration>60</Duration>

    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYz****=

<Response>

    <Template>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Tag>Animation</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>gif</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>true</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-08 17:34:10

更新视频转动图模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>

        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

    </TimeInterval>

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建动图模板接口的 Request  Container 是

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>Animation</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>gif</Codec>

                <Width>1280</Width>

                <Height></Height>

                <Fps>15</Fps>

                <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

            </Video>

            <TimeInterval>

                <Start>0</Start>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84729#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建动图模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1f16e1dfbdc994105b31292d45710642a HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <Container>

        <Format>gif</Format>

    </Container>

    <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

    </Video>

    <TimeInterval>

        <Start>0</Start>

        <Duration>60</Duration>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84729#Response
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    </TimeInterval>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Tag>Animation</Tag>

    <Name>TemplateName</Name>

    <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

    <TransTpl>

      <Container>

         <Format>mp4</Format>

      </Container>

      <Video>

        <Codec>gif</Codec>

        <Width>1280</Width>

        <Height></Height>

        <Fps>15</Fps>

        <AnimateOnlyKeepKeyFrame>false</AnimateOnlyKeepKeyFrame>

      </Video>

      <TimeInterval>

         <Start>0</Start>

         <Duration>60</Duration>

      </TimeInterval>

   </TransTpl>

   <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

   <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

</Response>
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数字水印
提交任务
最近更新时间：2023-08-01 16:46:25

提交一个添加数字水印任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第859 共1950页

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Message>123456789ab</Message>

            <Version>V1</Version>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关
键字）

父节
点

描述 类型
是否
必选

Tag
Req

uest
创建任务的 Tag：DigitalWatermark

Strin

g
是

Input
Req

uest
待操作的文件信息

Cont

ainer
是

Operation
Req
uest

操作规则
Cont
ainer

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Strin

g
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型

Strin

g
否

CallBack
Req
uest

任务回调地址，优先级高于队列的回调地址。设置为 no 
时，表示队列的回调地址不产生回调

Strin
g

否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig

Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

Output
Request.
Operation

结果输出配置

Con

tain
er

是

DigitalWat
ermark

Request.
Operation

数字水印配置，详情见  DigitalWatermark  

Con

tain
er

是

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务

优先级越高，默认为0

Stri

ng
否

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng
否

节点名称（关键字） 父节点 描述 类型
是否

必选

Region
Request.Operatio

n.Output
存储桶的地域

Strin

g
是

Bucket
Request.Operatio

n.Output
存储结果的存储桶

Strin

g
是

Object
Request.Operatio

n.Output
输出结果的文件名

Strin

g
是

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/78927#DigitalWatermark
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型
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Container 节点  的内容：

JobsDetail Response 任务的详细信息 Container 数
组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J
obsDetail

新创建任务的 ID
Stri
ng

Tag
Response.J

obsDetail
新创建任务的 Tag：DigitalWatermark

Stri

ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的 队列 ID  
Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的操作规则

Con

tain

er

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

Output
Response.JobsDetail.
Operation

同请求中的 
Request.Operation.Output

Conta
iner

DigitalWater

mark

Response.JobsDetail.

Operation

同请求中的 

Request.Operation.DigitalWaterm
ark

Conta

iner

MediaInfo
Response.JobsDetail.

Operation

输出文件的媒体信息，任务未完成时不返

回，详见 MediaInfo  

Conta

iner

MediaResult
Response.JobsDetail.

Operation

输出文件的基本信息，任务未完成时不返

回，详见 MediaResult  

Conta

iner

UserData
Response.JobsDetail.
Operation

透传用户信息 String

JobLevel
Response.JobsDetail.

Operation
任务优先级 String

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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<Request>

    <Tag>DigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <DigitalWatermark>

            <Type>Text</Type>

            <Message>123456789ab</Message>

            <Version>V1</Version>

            <IgnoreError>false</IgnoreError>

        </DigitalWatermark>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>
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        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>DigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 18:10:32

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>
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                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>

                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第868 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Resp
onse

固定值，为 TaskFinish String

JobsDetail
Resp

onse

同提交数字水印任务接口中的 

Response.JobsDetail  
Container 数组

https://cloud.tencent.com/document/product/460/84785#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的名
称

Strin
g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:37:37+0800</CreationTime>

        <EndTime>2022-06-30T18:39:08+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ja8de3b46f86011ec9452c1c27f56a659</JobId>

        <Message/>

        <Operation>

            <DigitalWatermark>

                <Message>123456789ab</Message>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第870 共1950页

                <Type>Text</Type>

                <Version>V1</Version>

            </DigitalWatermark>

            <MediaInfo>

                <Format>

                    <Bitrate>2533.526000</Bitrate>

                    <Duration>215.638000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>68290577</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>256.050000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/48000</CodecTimeBase>

                        <Duration>215.637000</Duration>

                        <Index>1</Index>

                        <Language>eng</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>48000</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/48000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>24.000000</AvgFps>

                        <Bitrate>2272.528000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12288</CodecTimeBase>

                        <ColorPrimaries>unknown</ColorPrimaries>

                        <ColorRange>unknown</ColorRange>

                        <ColorTransfer>unknown</ColorTransfer>

                        <Duration>215.583333</Duration>
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                        <Fps>24.000000</Fps>

                        <HasBFrame>2</HasBFrame>

                        <Height>1080</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>40</Level>

                        <NumFrames>5174</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12288</Timebase>

                        <Width>1920</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>043221daee3f4e15ff13f42329f15eb1</Md5>

                        <ObjectName>output/digital.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/digital.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/digital.mp4</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my DigitalWatermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:37:38+0800</StartTime>

        <State>Success</State>

        <SubTag>DigitalWatermark</SubTag>

        <Tag>DigitalWatermark</Tag>

    </JobsDetail>

</Response>
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案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T18:37:37+0800"

        "EndTime": "2022-06-30T18:39:08+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "ja8de3b46f86011ec9452c1c27f56a659"

        "Operation": 

            "DigitalWatermark": 

                "Message": "123456789ab"

                "Type": "Text"

                "Version": "V1"

            

            "MediaInfo": 

                "Format": 

                    "Bitrate": "2533.526000"

                    "Duration": "215.638000"

                    "FormatLongName": "QuickTime / MOV"

                    "FormatName": "mov,mp4,m4a,3gp,3g2,mj2"

                    "NumProgram": "0"

                    "NumStream": "2"

                    "Size": "68290577"

                    "StartTime": "0.000000"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "256.050000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/48000"

                        "Duration": "215.637000"

                        "Index": "1"

                        "Language": "eng"

                        "SampleFmt": "fltp"

{
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,
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,
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                        "SampleRate": "48000"

                        "StartTime": "0.000000"

                        "Timebase": "1/48000"

                    

                    "Video": 

                        "AvgFps": "24.000000"

                        "Bitrate": "2272.528000"

                        "CodecLongName": "H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10"

                        "CodecName": "h264"

                        "CodecTag": "0x31637661"

                        "CodecTagString": "avc1"

                        "CodecTimeBase": "1/12288"

                        "ColorPrimaries": "unknown"

                        "ColorRange": "unknown"

                        "ColorTransfer": "unknown"

                        "Duration": "215.583333"

                        "Fps": "24.000000"

                        "HasBFrame": "2"

                        "Height": "1080"

                        "Index": "0"

                        "Language": "und"

                        "Level": "40"

                        "NumFrames": "5174"

                        "PixFormat": "yuv420p"

                        "Profile": "High"

                        "RefFrames": "1"

                        "Rotation": "0.000000"

                        "StartTime": "0.000000"

                        "Timebase": "1/12288"

                        "Width": "1920"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "043221daee3f4e15ff13f42329f15eb1"

                        "ObjectName": "output/digital.mp4"

                    

                    "ObjectName": "output/digital.mp4"

                    "Region": "ap-chongqing"

                

            

            "Output": 

,

,

}],

[{
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}]

}
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{

{

,
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}],

[ ],

}

},

{
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                "Bucket": "test-123456789"

                "Object": "output/digital.mp4"

                "Region": "ap-chongqing"

            

            "UserData": "This is my DigitalWatermark job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T18:37:38+0800"

        "State": "Success"

        "SubTag": "DigitalWatermark"

        "Tag": "DigitalWatermark"

    

,

,

},

,

},

,

,

,

,

}]

}
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提取数字水印

提交任务
最近更新时间：2023-08-01 16:46:25

提交一个提取数字水印任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ExtractDigitalWatermark>

            <Type>Text</Type>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关
键字）

父节
点

描述 类型
是否
必选

Tag

Req

ues
t

创建任务的 Tag：ExtractDigitalWatermark String 是

Input

Req

ues

t

待操作的文件信息
Conta

iner
是

Operation

Req

ues

t

操作规则
Conta

iner
是

CallBackF

ormat

Req

ues

t

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式
String 否

CallBackT

ype

Req

ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型
String 否

CallBack

Req

ues

t

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调
String 否

CallBackM
qConfig

Req
ues

任务回调TDMQ配置，当 CallBackType 为 TDMQ 
时必填。详情见 CallBackMqConfig

Conta
iner

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 ExtractDigitalWatermark 的具体数据类型描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

t

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关键

字）
父节点 描述 类型

是否

必选

ExtractDigital

Watermark

Request.O

peration
提取数字水印配置

Cont

ainer
是

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0

Strin

g
否

UserData
Request.O
peration

透传用户信息，可打印的 ASCII 码，长度不
超过1024

Strin
g

否

节点名称（关键

字）
父节点 描述 类型

是否必

选

限

制

Type
Request.Operation.ExtractDigita
lWatermark

水印类
型

Stri
ng

是
T
e

xt

Version
Request.Operation.ExtractDigita
lWatermark

水印版
本

Stri
ng

是
V
1

响应

响应头

响应体

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第878 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Message Response.J

obsDetail

错误描述，只有 State 为 Failed 时有意义 Stri

ng

JobId
Response.J
obsDetail

新创建任务的 ID
Stri
ng

Tag
Response.J

obsDetail
新创建任务的 Tag：ExtractDigitalWatermark

Stri

ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的 队列 ID  
Stri
ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的操作规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

https://cloud.tencent.com/document/product/460/46487
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Container 类型 ExtractDigitalWatermark 的具体数据类型描述如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

ExtractDigitalWaterm

ark

Response.JobsDetail.Operatio

n
数字水印配置 Container

UserData
Response.JobsDetail.Operatio

n
透传用户信息 String

JobLevel
Response.JobsDetail.Operatio
n

任务优先级 String

节点名称（关键

字）
父节点 描述

类

型

Message
Response.JobsDetail.Operation.Extrac

tDigitalWatermark

提取出的数字水印字符串

信息

stri

ng

Type
Response.JobsDetail.Operation.Extrac

tDigitalWatermark
水印类型

Str

ing

Version
Response.JobsDetail.Operation.Extrac

tDigitalWatermark
水印版本

Str

ing

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>ExtractDigitalWatermark</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <ExtractDigitalWatermark>

https://cloud.tencent.com/document/product/460/42867
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            <Type>Text</Type>

            <Version>V1</Version>

        </ExtractDigitalWatermark>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>ExtractDigitalWatermark</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <ExtractDigitalWatermark>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>
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    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 18:10:32

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

具体的数据内容如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>
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Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交提取数字水印任务接口中的 

Response.JobsDetail  

Contain

er 数组

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.

CosHeaders
自定义 Header 的名称

Stri

ng

Value
Response.JobsDetail.Input.

CosHeaders
自定义 Header 的值

Stri

ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

https://cloud.tencent.com/document/product/460/84786#JobsDetail
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    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:42:20+0800</CreationTime>

        <EndTime>2022-06-30T18:42:54+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>output/digital.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j515a494af86111ecb8546d80f2baf56f</JobId>

        <Message>done</Message>

        <Operation>

            <ExtractDigitalWatermark>

                <Message>123456789ab</Message>

                <Type>Text</Type>

                <Version>V1</Version>

            </ExtractDigitalWatermark>

            <UserData>This is my ExtractDigitalWatermark job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:42:21+0800</StartTime>

        <State>Success</State>

        <Tag>ExtractDigitalWatermark</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T18:42:20+0800"

        "EndTime": "2022-06-30T18:42:54+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "output/digital.mp4"

            "Region": "ap-chongqing"

        

        "JobId": "j515a494af86111ecb8546d80f2baf56f"

        "Message": "done"

        "Operation": 

            "ExtractDigitalWatermark": 

{

,

[{

,

,

,

{

,

,

},

,

,

{

{
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                "Message": "123456789ab"

                "Type": "Text"

                "Version": "V1"

            

            "UserData": "This is my ExtractDigitalWatermark job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T18:42:21+0800"

        "State": "Success"

        "Tag": "ExtractDigitalWatermark"

    

,

,

},

,

},

,

,

,

}]

}
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视频拆条
提交任务
最近更新时间：2023-08-01 15:45:53

提交一个视频拆条任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SplitVideoParts</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <SplitVideoParts>

            <Mode>SHOTDETECT</Mode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

        </SplitVideoParts>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req
ues

t

创建任务的 Tag：SplitVideoParts
Stri
ng

是

Input
Req
ues

t

待操作的对象信息
Con
tain

er

是

Operation

Req

ues
t

操作规则

Con

tain
er

是

CallBackF

ormat

Req

ues
t

任务回调格式，JSON 或 XML，默认 XML，优先级高于

队列的回调格式

Stri

ng
否

CallBackT

ype

Req

ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型

Stri

ng
否

CallBack

Req

ues

t

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Stri

ng
否

CallBackM

qConfig

Req

ues

t

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig

Con

tain

er

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 SplitVideoParts 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

SplitVideo
Parts

Request.
Operation

视频拆条配置

Con

tain
er

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng
否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2。级别越大任务

优先级越高，默认为0

Stri

ng
否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Mode
Request.Operation.S

plitVideoParts

拆条模式，当前只支持 

SHOTDETECT (分镜拆分)

St

ri

n

g

是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SplitVideoParts</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SplitVideoParts>

                <Mode>SHOTDETECT</Mode>

            </SplitVideoParts>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义
Stri
ng

JobId Response.J 新创建任务的 ID Stri
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Container 节点 Operation 的内容：

obsDetail ng

Tag
Response.J

obsDetail
新创建任务的 Tag：SegmentVideoBody

Stri

ng

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J
obsDetail

任务的开始时间
Stri
ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J
obsDetail

同请求中的 Request.Input 节点
Con
tain

er

Operation
Response.J
obsDetail

该任务的规则

Con

tain
er

节点名称（关键

字）
父节点 描述 类型

SplitVideoPar
ts

Response.JobsDetail.
Operation

同请求中的 
Request.Operation.SplitVideoPar

ts

Conta
iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

https://cloud.tencent.com/document/product/460/46487
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Container 节点 SplitVideoInfoResult 的内容：

Container 节点 TimeInfo 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

JobLevel Response.JobsDetail.

Operation

任务优先级 String

SplitVideoInf

oResult

Response.JobsDetail.

Operation
输出拆条后的信息，任务未完成时不返回

Conta

iner

节点名称（关键

字）
父节点 描述 类型

TimeInfo
Response.JobsDetail.Operation.S

plitVideoInfoResult
各片段详情

Container 

数组

节点名称（关键

字）
父节点 描述 类型

Index
Response.JobsDetail.Operation.Split
VideoInfoResult.TimeInfo

片段索引 String

PartBegin
Response.JobsDetail.Operation.Split

VideoInfoResult.TimeInfo
片段起始时间 String

PartEnd
Response.JobsDetail.Operation.Split

VideoInfoResult.TimeInfo
片段结束时间 String

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SplitVideoParts</Tag>

    <Input>

        <Object>input/test.mp4</Object>

https://cloud.tencent.com/document/product/460/42867
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    </Input>

    <Operation>

        <SplitVideoParts>

            <Mode>SHOTDETECT</Mode>

        </SplitVideoParts>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SplitVideoParts</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SplitVideoParts>

                <Mode>SHOTDETECT</Mode>

            </SplitVideoParts>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>
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        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 18:10:32

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-05-06T16:04:13+0800</CreationTime>

        <EndTime>2023-05-06T16:04:41+0800</EndTime>

        <Input>

            <BucketId>testpic-1253960454</BucketId>

            <Object>test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j96ca39faebe411eda9b5*********</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <SplitVideoInfoResult>

                <TimeInfo>

                    <Index>0</Index>

                    <PartBegin>0.000000</PartBegin>

                    <PartEnd>5.320000</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>1</Index>

                    <PartBegin>5.320000</PartBegin>

                    <PartEnd>13.280000</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>2</Index>

                    <PartBegin>13.280000</PartBegin>

                    <PartEnd>16.799999</PartEnd>

                </TimeInfo>
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                <TimeInfo>

                    <Index>3</Index>

                    <PartBegin>16.799999</PartBegin>

                    <PartEnd>20.040001</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>4</Index>

                    <PartBegin>20.040001</PartBegin>

                    <PartEnd>24.440001</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>5</Index>

                    <PartBegin>24.440001</PartBegin>

                    <PartEnd>104.400002</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>6</Index>

                    <PartBegin>104.400002</PartBegin>

                    <PartEnd>105.480003</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>7</Index>

                    <PartBegin>105.480003</PartBegin>

                    <PartEnd>123.120003</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>8</Index>

                    <PartBegin>123.120003</PartBegin>

                    <PartEnd>134.600006</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>9</Index>

                    <PartBegin>134.600006</PartBegin>

                    <PartEnd>137.479996</PartEnd>

                </TimeInfo>

            </SplitVideoInfoResult>

            <SplitVideoParts>

                    <Mode>SHOTDETECT</Mode>

            </SplitVideoParts>

        </Operation>

        <QueueId>p5f30ea2dad4443a08d53c6e2351ca31e</QueueId>

        <StartTime>2023-05-06T16:04:14+0800</StartTime>

        <State>Success</State>

        <Tag>SplitVideoParts</Tag>

    </JobsDetail>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键
字）

父节点 描述 类型

EventName
Respon

se
固定值，为 TaskFinish String

JobsDetail
Respon

se
同提交视频拆条接口中的 Response.JobsDetail  

Contain

er 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

https://cloud.tencent.com/document/product/460/90888#JobsDetail
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案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-05-06T16:04:13+0800</CreationTime>

        <EndTime>2023-05-06T16:04:41+0800</EndTime>

        <Input>

            <BucketId>testpic-1253960454</BucketId>

            <Object>test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j96ca39faebe411eda9b5*********</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <SplitVideoInfoResult>

                <TimeInfo>

                    <Index>0</Index>

                    <PartBegin>0.000000</PartBegin>

                    <PartEnd>5.320000</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>1</Index>

                    <PartBegin>5.320000</PartBegin>

                    <PartEnd>13.280000</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>2</Index>

                    <PartBegin>13.280000</PartBegin>

                    <PartEnd>16.799999</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>3</Index>

                    <PartBegin>16.799999</PartBegin>

                    <PartEnd>20.040001</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>4</Index>

                    <PartBegin>20.040001</PartBegin>

                    <PartEnd>24.440001</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>5</Index>
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                    <PartBegin>24.440001</PartBegin>

                    <PartEnd>104.400002</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>6</Index>

                    <PartBegin>104.400002</PartBegin>

                    <PartEnd>105.480003</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>7</Index>

                    <PartBegin>105.480003</PartBegin>

                    <PartEnd>123.120003</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>8</Index>

                    <PartBegin>123.120003</PartBegin>

                    <PartEnd>134.600006</PartEnd>

                </TimeInfo>

                <TimeInfo>

                    <Index>9</Index>

                    <PartBegin>134.600006</PartBegin>

                    <PartEnd>137.479996</PartEnd>

                </TimeInfo>

            </SplitVideoInfoResult>

            <SplitVideoParts>

                    <Mode>SHOTDETECT</Mode>

            </SplitVideoParts>

        </Operation>

        <QueueId>p5f30ea2dad4443a08d53c6e2351ca31e</QueueId>

        <StartTime>2023-05-06T16:04:14+0800</StartTime>

        <State>Success</State>

        <Tag>SplitVideoParts</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

    "EventName":"TaskFinish"

    "JobsDetail":

        

            "Code":"Success"

            "CreationTime":"2023-05-08T14:53:35+0800"

{

,

[

{

,

,
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            "EndTime":"2023-05-08T14:54:01+0800"

            "Input":

                "BucketId":"testpic-1253960454"

                "Object":"test.mp4"

                "Region":"ap-chongqing"

            

            "JobId":"j0d7759e6ed6d11edb28***********"

            "Message":""

            "Operation":

                "JobLevel":"0"

                "SplitVideoInfoResult":

                    "TimeInfo":

                        

                            "Index":"0"

                            "PartBegin":"0.000000"

                            "PartEnd":"5.320000"

                        

                        

                            "Index":"1"

                            "PartBegin":"5.320000"

                            "PartEnd":"13.280000"

                        

                        

                            "Index":"2"

                            "PartBegin":"13.280000"

                            "PartEnd":"16.799999"

                        

                        

                            "Index":"3"

                            "PartBegin":"16.799999"

                            "PartEnd":"20.040001"

                        

                        

                            "Index":"4"

                            "PartBegin":"20.040001"

                            "PartEnd":"24.440001"

                        

                        

                            "Index":"5"

                            "PartBegin":"24.440001"

                            "PartEnd":"104.400002"

                        

                        

                            "Index":"6"

                            "PartBegin":"104.400002"

,

{

,

,

},

,

,

{

,

{

[

{

,

,

},

{

,

,

},

{

,

,

},

{

,

,

},

{

,

,

},

{

,

,

},

{

,

,
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                            "PartEnd":"105.480003"

                        

                        

                            "Index":"7"

                            "PartBegin":"105.480003"

                            "PartEnd":"123.120003"

                        

                        

                            "Index":"8"

                            "PartBegin":"123.120003"

                            "PartEnd":"134.600006"

                        

                        

                            "Index":"9"

                            "PartBegin":"134.600006"

                            "PartEnd":"137.479996"

                        

                    

                

                "SplitVideoParts":

                    "Mode":"SHOTDETECT"

                

            

            "QueueId":"p5f30ea2dad4443a08d5*********"

            "StartTime":"2023-05-08T14:53:36+0800"

            "State":"Success"

            "Tag":"SplitVideoParts"

        

    

},

{

,

,

},

{

,

,

},

{

,

,

},

]

},

{

}

},

,

,

,

}

]

}
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智能封面
提交任务
最近更新时间：2023-08-11 18:10:33

提交一个智能封面任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称
（关键字）

父节
点

描述 类型
是否必
选

Tag
Req

uest
创建任务的 Tag：SmartCover

Strin

g
是

Input
Req

uest
待操作的文件信息

Cont

ainer
是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式

Strin

g
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型

Strin

g
否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBack

MqConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Cont

ainer
否

节点名称（关键字） 父节点 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateI

d

Request.

Operation
智能封面模板id

Stri

ng
否

SmartCov

er

Request.

Operation

智能封面参数, 同创建智能封面模板接口中的 

Request.SmartCover  

Con

tain

er

否

Output
Request.

Operation
结果输出配置

Con

tain

er

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng
否

JobLevel
Request.
Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务
优先级越高，默认为 0

Stri
ng

否

说明

 智能封面参数必须设置，可以通过 TemplateId 或 SmartCover 设置， TemplateId 优先级更高。

节点名称（关
键字）

父节点 描述
类
型

是否
必选

Region
Request.Oper
ation.Output

存储桶的地域

St

ri
n

g

是

Bucket
Request.Oper
ation.Output

存储结果的存储桶

St

ri
n

g

是

Object Request.Oper
ation.Output

输出结果的文件名，当有多个输出文件时必须包
含 ${number} 通配符

St
ri

是

https://cloud.tencent.com/document/product/460/84734#SmartCover
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

n
g

通配符 含义

${ext} 封装格式

${jobid} 任务Id

${number} 产物索引，从0开始计数

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

            </Output>   

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State为 Failed 时有意义

Stri

ng

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义
Stri
ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：SmartCover

Stri

ng

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

CreationTi

me

Response.J

obsDetail

任务的创建时间 Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J

obsDetail
该任务的输入资源地址

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键
字）

父节点 描述 类型

SmartCover
Response.JobsDetail.

Operation

同请求中的 

Request.Operation.SmartCover
String

Output
Response.JobsDetail.

Operation

同请求中的 

Request.Operation.Output

Conta

iner

MediaResult
Response.JobsDetail.
Operation

输出文件的基本信息，任务未完成时不
返回，详见 MediaResult  

Conta
iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

JobLevel
Response.JobsDetail.

Operation
任务优先级 String

https://cloud.tencent.com/document/product/460/46487
https://cloud.tencent.com/document/product/460/78927#MediaResult
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求1：使用智能封面模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

https://cloud.tencent.com/document/product/460/42867
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t16567cd58ade9411d952283873123b9b1</TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用智能封面参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <SmartCover>

            <Format>jpg</Format>
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            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${number}.jpg</Object>

        </Output>   

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>SmartCover</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>
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            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

            </Output>   

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel> 

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-17 17:55:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交智能封面任务接口中的 

Response.JobsDetail  

Contain

er 数组

https://cloud.tencent.com/document/product/460/84791#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH
eaders

自定义 Header 的值
Strin
g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>
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            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T15:29:42+0800</CreationTime>

        <EndTime>2022-06-30T15:29:48+0800</EndTime>
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        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp4</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio/>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info/>

                    <ObjectName>output/smartcover-0.jpg</ObjectName>

                    <ObjectName>output/smartcover-1.jpg</ObjectName>

                    <ObjectName>output/smartcover-2.jpg</ObjectName>

                    <ObjectName>output/smartcover-3.jpg</ObjectName>

                    <ObjectName>output/smartcover-4.jpg</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>
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            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${number}.jpg</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SmartCover>

                <Count>5</Count>

                <DeleteDuplicates>false</DeleteDuplicates>

                <Format>jpg</Format>

                <Height>960</Height>

                <Width>1280</Width>

            </SmartCover>

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T15:29:43+0800</StartTime>

        <State>Success</State>

        <Tag>SmartCover</Tag>

        <Workflow>

            <Name>SmartCover_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T15:29:42+0800"

        "EndTime": "2022-06-30T15:29:48+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp4"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp4"

                

{
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,
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{
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},
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                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1424687"

                

            

        

        "JobId": "j6842765cf84611ecb8546d80f2baf56f"

        "Operation": 

            "MediaInfo": 

                "Stream": 

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "ObjectName": 

                        "output/smartcover-0.jpg"

                        "output/smartcover-1.jpg"

                        "output/smartcover-2.jpg"

                        "output/smartcover-3.jpg"

                        "output/smartcover-4.jpg"

                    

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/smartcover-${number}.jpg"

                "Region": "ap-chongqing"

            

            "SmartCover": 

                "Count": "5"

                "DeleteDuplicates": "false"

                "Format": "jpg"

                "Height": "960"

                "Width": "1280"

{

,

},

{

,

},

{

,

}

]
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{
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            "UserData": "This is my SmartCover job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T15:29:43+0800"

        "State": "Success"

        "Tag": "SmartCover"

        "Workflow": 

            "Name": "SmartCover_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

},

,

},

,

,

,

,

{

,

,

,

}

}]

}
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创建模板
最近更新时间：2023-08-01 15:45:53

创建智能封面模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键
字）

父节点 描述 类型
是否必
选

Tag
Requ

est
模板类型：SmartCover String 是

Name
Requ

est

模板名称，仅支持中文、英文、数字、_、-和

*，长度不超过 64
String 是

SmartCover
Requ
est

智能封面参数
Contai
ner

是

SmartCover

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

Format
Request.S

martCover
图片格式，支持 jpg、png  、webp

St

ri

n

g

jp

g
否

Width
Request.S
martCover

宽

值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频原始比例

计算 Height

St

ri
n

g

视

频

原
始

宽

度

否

Height Request.S
martCover

高
值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频原始比

St
ri

n

g

视
频

原

始

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

例计算 Width 高

度

Count
Request.S

martCover
截图数量，取值范围 [1,10]

St
ri

n

g

3 否

DeleteDup

licates

Request.S

martCover
封面去重，取值 true/false

St

ri

n

g

fa

ls

e

否

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点  的内容如下：

Container 节点  的内容如下

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

RequestId 无 请求的唯一 ID Container

Template

节点名称（关键

字）
父节点 描述 类型

Tag
Response.Te
mplate

模板类型，SmartCover String

Name
Response.Te

mplate
模板名字 String

BucketId
Response.Te

mplate
模板所属存储桶 String

Category
Response.Te
mplate

模板属性，Custom 或者 Official String

TemplateId
Response.Te

mplate
模板 ID String

UpdateTime
Response.Te

mplate
更新时间 String

CreateTime
Response.Te
mplate

创建时间 String

SmartCover
Response.Te

mplate

详细的模板参数，同请求体 

Request.SmartCover 说明

Contai

ner

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <RequestId>NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=</RequestId>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>
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            <Count>10</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-11 17:56:15

更新智能封面模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建智能封面模板接口的 Request  
Containe

r
是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建智能封面模板接口的 Response  Container

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84734#Request
https://cloud.tencent.com/document/product/460/84734#Response
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SmartCover</Tag>

    <Name>TemplateName</Name>

    <SmartCover>

        <Format>jpg</Format>

        <Width>1280</Width>

        <Height>960</Height>

        <Count>10</Count>

        <DeleteDuplicates>true</DeleteDuplicates>

    </SmartCover>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>SmartCover</Tag>

        <Name>TemplateName</Name>

        <TemplateId>t1f43110a08702470b8fa75894629501fa</TemplateId>

https://cloud.tencent.com/document/product/460/42867
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        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SmartCover>

            <Width>1280</Width>

            <Height>960</Height>

            <Format>jpg</Format>

            <Count>5</Count>

            <DeleteDuplicates>false</DeleteDuplicates>

        </SmartCover>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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视频合成
提交任务
最近更新时间：2023-08-18 15:28:01

提交一个视频合成任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoSynthesis</Tag>

    <Operation>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplat

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

        <VideoSynthesis>

            <KeepAudioTrack>false</KeepAudioTrack>

            <SpliceInfo>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

                <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/car.mp4<

                <Width>640</Width>

            </SpliceInfo>

            <SpliceInfo>

                <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/game.mp4

                <X>700</X>

                <Width>640</Width>

                <Height>960</Height>

            </SpliceInfo>

        </VideoSynthesis>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：VideoSynthesis

Strin

g
是

Input
Req
uest

待操作的文件信息
Cont
ainer

是

Operation
Req

uest
操作规则

Cont

ainer
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Strin

g
否

CallBackT Req 任务回调类型，Url 或 TDMQ，默认 Url，优先级高于 Strin 否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

ype uest 队列的回调类型 g

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig 

Cont

ainer
否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

VideoSynth

esis

Request.

Operation
视频合成模板参数

Contain

er
是

Transcode

TemplateId

Request.

Operation
转码模板 ID String 否

Transcode
Request.
Operation

转码模板参数
Contain
er

否

Watermark

TemplateId

Request.

Operation

水印模板 ID，可以传多个水印模板 ID，最多

传3个

String 

数组
否

Watermark
Request.

Operation

水印模板参数，同创建水印模板接口中的  

Request.Watermark ，最多传3个

Contain

er 数组
否

Output
Request.
Operation

结果输出配置
Contain
er

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不

超过1024
String 否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0
String 否

说明：

转码参数必须设置，可以通过 TranscodeTemplateId 或 Transcode 设置， 

TranscodeTemplateId 优先级更高。

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
https://cloud.tencent.com/document/product/460/84725#Watermark
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Container 类型 VideoSynthesis 的具体数据描述如下：

Container 类型 SpliceInfo 的具体数据描述如下：

水印参数可选，可以通过 WatermarkTemplateId 或 Watermark 设置，

WatermarkTemplateId 优先级更高。

节点名称（关

键字）
父节点 描述 类型

是否

必选

KeepAudio
Track

Request.Operation.
VideoSynthesis

是否保留源视频音轨，取值 
true/false，默认值 false

String 否

SpliceInfo
Request.Operation.

VideoSynthesis
待合成的视频

Contain

er 数组
是

节点名称（关
键字）

父节点 描述
类
型

是否
必选

Url

Request.Operation.V

ideoSynthesis.SpliceI
nfo

同 bucket 的视频文件地址

St

ri

n
g

是

X

Request.Operation.V

ideoSynthesis.SpliceI
nfo

该视频在画面中的横坐标，默认值 0

St

ri
n

g

否

Y
Request.Operation.V
ideoSynthesis.SpliceI

nfo

该视频在画面中的纵坐标，默认值 0

St

ri
n

g

否

Width

Request.Operation.V

ideoSynthesis.SpliceI

nfo

该视频在画面中的宽，默认原视频宽

St
ri

n

g

否

Height

Request.Operation.V

ideoSynthesis.SpliceI

nfo

该视频在画面中的高,默认原视频高

St

ri

n

g

否

Name Request.Operation.V

ideoSynthesis.SpliceI

该视频流的自定义名称, 长度不超过64

个字符，仅支持中文、英文、数字、

St

ri

否
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Container 类型 Transcode 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

nfo _、-和* n

g

节点名称（关
键字）

父节点 描述 类型
是否
必选

TimeInterv

al

Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.TimeInterval  

Contain

er
否

Container
Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.Container  

Contain

er
否

Video
Request.Operati
on.Transcode

同创建转码模板接口中的 
Request.Video  

Contain
er

否

Audio
Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.Audio  

Contain

er
否

TransConf

ig

Request.Operati

on.Transcode

同创建转码模板接口中的 

Request.TransConfig  

Contain

er
否

AudioMix
Request.Operati
on.Transcode

混音参数，详情见 AudioMix  
Contain
er

否

AudioMixA

rray

Request.Operati

on.Transcode
混音参数数组，最多同时传2个

Contain

er 数组
否

说明：

不传 Video，相当于删除视频信息。不传 Audio，相当于删除音频信息。Video 和 Audio 不可以同

时不传。

AudioMix 和 AudioMixArray  在 Audio.Remove 为 false 时生效。

AudioMixArray 是一个数组，每一个子项内容同 AudioMix  。AudioMix 优先级更高，设置 

AudioMix 时，AudioMixArray 无效。

节点名称（关键字） 父节点 描述 类型
是否
必选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket Request.Operation.Out 存储结果的存储桶 Strin 是

https://cloud.tencent.com/document/product/460/84733#TimeInterval
https://cloud.tencent.com/document/product/460/84733#Container
https://cloud.tencent.com/document/product/460/84733#Video
https://cloud.tencent.com/document/product/460/84733#Audio
https://cloud.tencent.com/document/product/460/84733#TransConfig
https://cloud.tencent.com/document/product/460/78927#AudioMix
https://cloud.tencent.com/document/product/460/78927#AudioMix
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Request.Operation.Output.Object 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

put g

Object
Request.Operation.Out
put

输出结果的文件名
Strin
g

是

通配符 含义

${ext} 封装格式

${jobid} 任务Id

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoSynthesis</Tag>

        <Operation>

            <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemp

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

            <VideoSynthesis>

                <KeepAudioTrack>false</KeepAudioTrack>

                <SpliceInfo>

                    <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/car.mp4

                    <Width>640</Width>

                </SpliceInfo>

                <SpliceInfo>

                    <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/game.m

                    <X>700</X>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

                    <Width>640</Width>

                    <Height>960</Height>

                </SpliceInfo>

            </VideoSynthesis>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义
Stri
ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：VideoSynthesis

Stri

ng

State Response.J 任务状态 Stri



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第937 共1950页

Container 节点 Input 的内容：

Container 节点 Operation 的内容：

obsDetail Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会

变为暂停状态

Cancel：任务被取消执行

ng

Progress
Response.J

obsDetail

任务进度百分比，只有在State为 Submitted、

Running、Success、Pause 时有意义，范围为[0, 

100]

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J
obsDetail

任务的开始时间
Stri
ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J
obsDetail

该任务的输入资源地址

Con

tain
er

Operation
Response.J

obsDetail
该任务的规则

Con

tain
er

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

VideoSynthe

sis

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.VideoSynthe

sis

Contain

er

TranscodeTe

mplateId

Response.JobsDetail

.Operation

同请求中的 
Request.Operation.TranscodeT

emplateId

String

Transcode
Response.JobsDetail
.Operation

同请求中的 
Request.Operation.Transcode

Contain
er

Watermark
Response.JobsDetail

.Operation

同请求中的 

Request.Operation.Watermark

Contain

er 数组

WatermarkTe

mplateId

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.WatermarkT

emplateId

String 

数组

Output
Response.JobsDetail

.Operation

同请求中的 

Request.Operation.Output

Contain

er

MediaInfo
Response.JobsDetail

.Operation

输出文件的媒体信息，任务未完成时不

返回，详见 MediaInfo  

Contain

er

MediaResult
Response.JobsDetail

.Operation

输出文件的基本信息，任务未完成时不

返回，详见 MediaResult  

Contain

er

DigitalWater

mark

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.DigitalWater

mark

Contain

er

UserData
Response.JobsDetail
.Operation

透传用户信息 String

JobLevel
Response.JobsDetail

.Operation
任务优先级 String

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoSynthesis</Tag>

    <Operation>

        <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemplat

        <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTemp

        <VideoSynthesis>

            <KeepAudioTrack>false</KeepAudioTrack>

            <SpliceInfo>

                <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/car.mp4<

                <Width>640</Width>

            </SpliceInfo>

            <SpliceInfo>

                <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/game.mp4

                <X>700</X>

                <Width>640</Width>

                <Height>960</Height>

            </SpliceInfo>

        </VideoSynthesis>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.${ext}</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>je8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoSynthesis</Tag>

        <Operation>

            <TranscodeTemplateId>t160606b9752148c4absdfaf2f55163b1f</TranscodeTemp

            <WatermarkTemplateId>t146d70eb241c44c63b6efc1cc93ccfc5d</WatermarkTem

            <VideoSynthesis>

                <KeepAudioTrack>false</KeepAudioTrack>

                <SpliceInfo>

                    <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/car.mp4

                    <Width>640</Width>

                </SpliceInfo>

                <SpliceInfo>

                    <Url>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/game.m

                    <X>700</X>

                    <Width>640</Width>

                    <Height>960</Height>

                </SpliceInfo>

            </VideoSynthesis>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.${ext}</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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内容审核

图片审核
图片单次审核
最近更新时间：2023-06-27 10:41:42

图片审核功能支持同步、异步请求方式，您可以通过本接口对图片文件进行内容审核。该接口属于 GET 请求。

该接口支持情况如下：

功能描述

注意

支持审核腾讯云 COS 上的图片文件。

支持审核第三方云存储厂商的图片 URL。

支持审核本地图片文件，需要先进行 base64编码。审核本地图片文件请调用 图片批量审核接口 。

支持对 COS 上的图片文件或链接进行检测，通过深度学习技术，识别可能令人反感、不安全或不适宜的违规图

片内容。

支持对 GIF 图进行截帧审核。

支持识别多种违规场景，包括：低俗、违法违规、色情、广告等场景。

支持多种物体检测（实体、广告台标、二维码等）及图片中文本的 OCR 文本识别。

支持根据不同的业务场景 配置自定义的审核策略 。

支持用户通过配置自定义风险库，打击自定义的违规内容。

费用说明

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1张图片，计2次审核费用。

调用接口会产生 图片审核费用  和 COS 读请求费用 。

如果图片为 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的文件，如果需要审核此类型文件，请先 恢复归档文

件 。

审核第三方云存储厂商的图片 URL 时，将产生所在云厂商的下行流量费用。

限制说明

图片文件大小支持：支持审核32MB以下的图片。对于大小超过5MB的图片，您需要在调用请求时，使用 

large-image-detect 参数。

https://cloud.tencent.com/document/product/436/63593
https://cloud.tencent.com/document/product/436/55206
https://cloud.tencent.com/document/product/436/58965#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

具体参数如下：

图片文件分辨率支持：建议分辨率大于256x256，否则可能会影响识别效果。

图片文件支持格式：PNG、JPG/JPEG、BMP、GIF、WEBP 、HEIF/HEIC格式。

接口默认并发数量：100。

图片文件链接支持的传输协议：HTTP、HTTPS。

调用接口需携带签名，具体规则请参见 请求签名  文档。

推荐使用 SDK

请求

请求示例

GET /<ObjectKey>?ci-process=sensitive-content-recognition&detect-url=<detect-url>&in

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名称 描述 类型

是

否

必

选

ObjectKey

COS 存储桶中的图片文件名称，COS 存储桶由 Host  指定，例如

在北京的 examplebucket-1250000000存储桶中的目录 test 下

的文件 img.jpg，则 Host  填写 examplebucket-

1250000000.cos.ap-beijing.myqcloud.com， ObjectKey  

填写 test/img.jpg。

Strin
g

否

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求的请求体为空。

ci-process 标识数据处理功能的字段，内容审核的值为：sensitive-content-
recognition。

Strin
g

是

biz-type

表示审核策略的唯一标识，您可以通过控制台上的审核策略页面，配置

您希望审核的场景，如涉黄、广告、违法违规等，配置指引： 设置公
共审核策略 。您可以在控制台上获取到 biz-type。biz-type 填写

时，此条审核请求将按照该审核策略中配置的场景进行审核。biz-

type 不填写时，将自动使用默认的审核策略。

Strin
g

否

detect-url

您可以通过填写 detect-url  审核任意公网可访问的图片链接不填写 

detect-url  时，后台会默认审核 ObjectKey  填写了 detect-url  

时，后台会审核 detect-url  链接，无需再填写 ObjectKey  ，

detect-url  示例：http://www.example.com/abc.jpg。

Strin

g
否

interval
审核 GIF 动图时，可使用该参数进行截帧配置，代表截帧的间隔。例

如值设为5，则表示从第1帧开始截取，每隔5帧截取一帧，默认值5。
Int 否

max-frames
针对 GIF 动图审核的最大截帧数量，需大于0。例如值设为5，则表示
最大截取5帧，默认值为5。

Int 否

large-

image-
detect

对于超过大小限制的图片是否进行压缩后再审核，取值为： 0（不压

缩），1（压缩）。默认为0。注：压缩最大支持32MB的图片，且会

收取图片压缩费用。对于 GIF 等动态图过大时，压缩时间较长，可能
会导致审核超时失败。

Int 否

dataid 图片标识，该字段在结果中返回原始内容，长度限制为512字节。
Strin

g
否

async
是否异步进行审核，取值 0：同步返回结果，1：异步进行审核，默认

为0。
Int 否

callback

审核结果（Detail版本）以回调形式发送至您的回调地址，异步审核

时生效，支持以 http://  或者 https://  开头的地址，例如： 

http://www.callback.com 。

Strin

g
否

注意

通过 ObjectKey 进行审核为内网操作，不会产生额外的外网流量。

通过 detect-url 进行审核，会产生图片所在源站对应的外网流量。

请求体

响应

https://cloud.tencent.com/document/product/460/56345
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应包体具体数据内容如下：

异步审核返回的RecognitionResult 节点内容：

响应头

响应体

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

      <Result>1</Result>

      <Label>Porn</Label>

      <SubLabel>SexBehavior</SubLabel>

      <Score>90</Score>

      <PornInfo>

          <Code>0</Code>

          <Msg>OK</Msg>

          <HitFlag>1</HitFlag>

          <Label>xxx</Label>

          <SubLabel>SexBehavior</SubLabel>

          <Score>100</Score>

          <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

              <X></X>

              <Y></Y>

              <Width></Width>

              <Height></Height>

              <Rotate></Rotate>

            </Location>

          </OcrResults>

      </PornInfo>

</RecognitionResult>

参数名称 类型 描述

RecognitionResult Container 图片审核结果。

参数名称 类型 描述

DataId String 图片标识，审核结果会返回原始内容，长度限制为512字节。

https://cloud.tencent.com/document/product/460/42866
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同步审核返回的RecognitionResult 节点内容：

JobId String 图片审核任务的 ID。

State String 审核任务的状态，值为Submitted（已提交审核）。

Object String 存储在 COS 桶中的图片名称，创建任务使用 ObjectKey 时返回。

Url String 图片文件的链接地址，创建任务使用 detect-url 时返回。

参数名称 类型 描述

DataId String 图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId String 图片审核任务的 ID。

State String 审核任务的状态，值为 Success（审核成功）。

Object String 存储在 COS 桶中的图片名称，创建任务使用 ObjectKey 时返回。

Url String 图片文件的链接地址，创建任务使用 detect-url 时返回。

Compressio

nResult
Int 图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Result Int
该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建
议您按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正

常），1 （判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Label String

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐
的审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返

回值：Normal 表示正常，Porn 表示色情，Ads 表示广告，以及其他不

安全或不适宜的类型。

Category String
该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，

表示色情标签中的性感类别。

SubLabel String 该图命中的二级标签结果。

Score Int

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信

息例如：色情 99，则表明该内容非常有可能属于色情内容。

Text String 该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

PornInfo
Contai

ner
审核场景为涉黄的审核结果信息。
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审核信息（PornInfo、AdsInfo）中包含如下内容：

Container 节点 LibResults 的内容：

AdsInfo Contai

ner

审核场景为广告引导的审核结果信息。

参数名

称
类型 描述

Code Int 错误码，0为正确，其他数字对应相应错误。详情请参见 错误码 。

Msg String 具体错误信息，如正常则为 OK。

HitFla
g

Int
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的
违规内容。2：疑似为当前场景的违规内容。

Score Int

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高），越高代表该内容越有可能属于当前返回审核信
息。其中0 - 60分表示图片正常，61 - 90分表示图片疑似敏感，91 - 100

分表示图片确定敏感。例如：色情 99，表明该内容非常有可能属于色情内

容。

Label String
该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字
等）。

Categ

ory
String

该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，表示

色情标签中的性感类别。

SubL

abel
String

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标

签。注意：该字段可能返回空，表示未命中具体的子标签。

OcrR
esults

Container 
Array

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键
词等信息，有相关违规内容时返回。

LibRe

sults

Container 

Array

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字

段不返回。

参数
名称

类型 描述

Ima

geI

d

Stri

ng
该字段表示命中的风险库中的图片样本 ID。

Sco

re

Inte

ger

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第947 共1950页

Container 节点 OcrResults 的内容：

Container 节点 Location 的内容：

Container 节点 ObjectResults 的内容：

可能命中库中的色情样本。

参数
名称

类型 描述

Text String 图片 OCR 文本识别出的具体文本内容。

Key

word

s

String 

Array
在当前审核场景下命中的关键词。

Loca
tion

Containe
r

该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角
度），以方便快速定位识别文字的相关信息。

名

称

类

型
描述

X
Flo
at

该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一确
定检测框的大小和位置。

Y
Flo

at

该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一确

定检测框的大小和位置。

Wi

dth

Flo

at

该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数可唯

一确定检测框的大小和位置。

Hei
ght

Flo
at

该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数可唯
一确定检测框的大小和位置。

Ro

tat

e

Flo

at

该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框的

具体位置；取值：0-360（角度制），方向为逆时针旋转。

名称 类型 描述

Na

me

Strin

g
该标签用于返回所识别出的实体名称，例如人名。

Loc

atio

n

Cont

ainer

该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角度），以方

便快速定位相关信息。
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实际案例

请求1：同步图片审核

GET /picture.jpg?ci-process=sensitive-content-recognition&interval=0&max-frames=1&b

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

      <CompressionResult>0</CompressionResult>

      <Result>1</Result>

      <Label>Porn</Label>

      <SubLabel>SexBehavior</SubLabel>

      <Score>95</Score>

      <PornInfo>

          <Code>0</Code>

          <Msg>OK</Msg>

          <HitFlag>1</HitFlag>

          <Label>xxx</Label>

          <SubLabel>SexBehavior</SubLabel>

          <Score>95</Score>

      </PornInfo>

</RecognitionResult>

请求2：异步图片审核

GET /picture.jpg?ci-process=sensitive-content-recognition&biz-type=***&async=1&callba

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX
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响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

      <JobId>xxxxxxxxxxxxxxx</JobId>

</RecognitionResult>
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图片批量审核
最近更新时间：2023-07-10 15:44:31

图片批量审核接口支持同步、异步请求方式，您可以通过本接口对多个图片文件进行内容审核。该接口属于 POST 

请求。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

支持审核腾讯云 COS 上的图片文件。

支持审核第三方云存储厂商的图片 URL。

支持审核加密数据，如有需要，请 联系服务人员  咨询。

支持根据不同的业务场景 配置自定义的审核策略 。

限制说明

图片文件大小支持：支持审核32MB以下的图片。对于大小超过5MB的图片，您需要在调用请求时，使用 

large-image-detect 参数。

单次请求图片数量不可超过100张。

图片文件分辨率支持：建议分辨率大于256x256，否则可能会影响识别效果。

图片文件支持格式：PNG、JPG/JPEG、BMP、GIF、WEBP、HEIF/HEIC 格式。

接口默认并发数量：100。

图片文件链接支持的传输协议：HTTP、HTTPS。

调用接口需携带签名，具体规则请参见 请求签名  文档。

推荐使用 SDK

请求

请求示例

POST /image/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

      <DataId></DataId>

      <Url></Url>

      <Object></Object>

      <Content></Content>

      <Interval></Interval>

      <MaxFrames></MaxFrames>

      <LargeImageDetect></LargeImageDetect>

      <UserInfo>

        <TokenId></TokenId>

      </UserInfo>

    </Input>

    <Input>

      <DataId></DataId>

      <Url></Url>

      <Object></Object>

      <Content></Content>

      <Interval></Interval>

      <MaxFrames></MaxFrames>

    </Input>

    <Conf>

      <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

      <Async></Async>

      <Callback></Callback>

      <Freeze>

        <PornScore></PornScore>

      </Freeze>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下，使用其中一种：

    </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 图片批量审核的具体配置项。
Contain

er
是

节点名称（关键
字）

父节
点

描述 类型
是否
必选

Input
Requ

est

需要审核的内容，如有多个图片，请传入多个 

Input 结构。

Container 

Array
是

Conf
Requ

est
审核规则配置。 Container 是

节点名

称（关

键字）

父节点 描述 类型
是否

必选

Object
Request.I

nput

存储在 COS 存储桶中的图片文件名称，例如在目录 

test 中的文件 image.jpg，则文件名称为 

test/image.jpg。Content，Object 和 Url 只能选
择其中一种，传入多个时仅一个生效，按 Content，

Object， Url 顺序。

Strin

g
否

Url
Request.I

nput

图片文件的链接地址，例如 http://a-

1250000.cos.ap-
shanghai.myqcloud.com/image.jpg。

Content，Object 和 Url 只能选择其中一种，传入

多个时仅一个生效，按 Content，Object， Url 顺

序。

Strin

g
否

Conte

nt

Request.I

nput

图片文件的内容，需要先经过 base64 编码。

Content，Object 和 Url 只能选择其中一种，传入

多个时仅一个生效，按 Content，Object， Url 顺

序。

Strin

g
否

Interva Request.I 截帧频率，GIF 图检测专用，默认值为5，表示从第一 Int 否
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Container 节点 UserInfo 的内容：

Container 类型 Conf 的具体数据描述如下：

l nput 帧（包含）开始每隔5帧截取一帧。

MaxFr

ames

Request.I

nput

最大截帧数量，GIF 图检测专用，默认值为5，表示只

截取 GIF 的5帧图片进行审核，必须大于0。
Int 否

DataId
Request.I
nput

图片标识，该字段在结果中返回原始内容，长度限制为
512字节。

Strin
g

否

LargeI

mageD

etect

Request.I

nput

对于超过大小限制的图片是否进行压缩后再审核，取值

为： 0（不压缩），1（压缩）。默认为0。注：压缩

最大支持32M的图片，且会收取压缩费用。

Int 否

UserIn

fo

Request.I

nput
用户业务字段。

Cont

ainer
否

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。 String 否

Nickname 一般用于表示昵称信息，长度不超过128字节。 String 否

DeviceId 一般用于表示设备信息，长度不超过128字节。 String 否

AppId
一般用于表示 App 的唯一标识，长度不超过128字

节。
String 否

Room 一般用于表示房间号信息，长度不超过128字节。 String 否

IP 一般用于表示 IP 地址信息，长度不超过128字节。 String 否

Type 一般用于表示业务类型，长度不超过128字节。 String 否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128

字节。
String 否

Gender 一般用于表示性别信息，长度不超过128字节。 String 否

Level 一般用于表示等级信息，长度不超过128字节。 String 否

Role 一般用于表示角色信息，长度不超过128字节。 String 否

节点
名称

父节点 描述 类型 是否
必选



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第954 共1950页

Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员 咨询。

（关

键
字）

BizT
ype

Request.C
onf

表示审核策略的唯一标识，您可以通过控制台上的审核

策略页面，配置您希望审核的场景，如涉黄、广告、违

法违规等，配置指引： 设置公共审核策略 。您可以在
控制台上获取到 BizType。BizType 填写时，此条

审核请求将按照该审核策略中配置的场景进行审核。

BizType 不填写时，将自动使用默认的审核策略。

String 否

Asyn

c

Request.C

onf

是否异步进行审核，0：同步返回结果，1：异步进行

审核。默认值为 0。

Integ

er
否

Callb
ack

Request.C
onf

审核结果（Detail版本）以回调形式发送至您的回调地

址，异步审核时生效，支持以 http://  或者 

https://  开头的地址，例如：

http://www.callback.com 。

String 否

Free

ze

Request.C

onf

可通过该字段，设置根据审核结果给出的不同分值，对

图片进行自动冻结，仅当 input  中审核的图片为 

object  时有效。

Conta

iner
否

节点名称

（关键
字）

父节点 描述 类型

是

否

必
选

PornSc

ore

Request.

Conf.Fre
eze

取值为[0,100]，表示当色情审核结果大于或等于该分数

时，自动进行冻结操作。不填写则表示不自动冻结，默认
值为空。

Integ

er
否

AdsSco

re

Request.

Conf.Fre

eze

取值为[0,100]，表示当广告审核结果大于或等于该分数

时，自动进行冻结操作。不填写则表示不自动冻结，默认

值为空。

Integ

er
否

注意

通过 Object 进行审核为内网操作，不会产生额外的外网流量。

通过 Url 进行审核，会产生图片所在源站对应的外网流量。

https://cloud.tencent.com/online-service?from=ticket-tab
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应包体具体数据内容如下：

Container 节点 Response 的内容：

异步审核结果的 JobsDetail 节点内容如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <DataId></DataId>

    <Url></Url>

    <PornInfo>

      <HitFlag>1</HitFlag>

      <Score>100</Score>

      <Category>xxx</Category>

      <SubLabel>xxx</SubLabel>

    </PornInfo>

  </JobsDetail>

  <JobsDetail>

    <Code>InvalidArgument</Code>

    <Message>Param MaxFrames is illegal</Message>

    <DataId></DataId>

  </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述

Response Container 图片批量审核返回的具体响应内容。

参数名称 类型 描述

JobsD

etail

Container 

Array
图片审核的结果

Reque
stId

String
每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 ID 
能更快地协助定位问题。

https://cloud.tencent.com/document/product/460/42866
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同步审核结果的 JobsDetail 节点内容如下：

节点名称（关键

字）

类型 描述

Code
Stri
ng

错误码，只有失败时返回。详情请查看 错误码列表 。

Message
Stri

ng
错误描述，只有失败时返回。

DataId
Stri

ng
图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId
Stri
ng

本次审核任务的 ID。

State
Stri

ng

审核任务的状态，值为 Submitted（已提交审核）、Failed（审核失败）

其中一个。

Object
Stri

ng
存储在 COS 存储桶中的图片文件名称，创建任务使用 Object 时返回。

Url
Stri
ng

图片文件的链接地址，创建任务使用Url时返回。

参数名

称

类

型
描述

Code

S

tr
in

g

错误码，只有失败时返回。详情请查看 错误码列表 。

Mess

age

S
tr

in

g

错误描述，只有失败时返回。

DataI

d

S
tr

in

g

图片标识，审核结果会返回原始内容，长度限制为512字节。

JobId S

tr

本次审核任务的 ID。

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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in
g

State

S

tr
in

g

审核任务的状态，值为 Success（审核成功）、Failed（审核失败）其中一个。

Objec
t

S

tr
in

g

存储在 COS 存储桶中的图片文件名称，创建任务使用Object时返回。

Url

S
tr

in

g

图片文件的链接地址，创建任务使用Url时返回。

Com

press

ionRe
sult

I
n

t

e

g
e

r

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Label

S
tr

in

g

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，
建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告等。

Resul

t

I
n

t

e

g
e

r

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务

所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

Scor

e

I
n

t

e

g

e
r

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表明该内容

非常有可能属于色情内容。
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Cate

gory

S

tr
in

g

该图命中的审核类别结果。

SubL

abel

S
tr

in

g

该图命中的二级标签结果。

Text

S
tr

in

g

该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

PornI
nfo

C

o

n

t
ai

n

e

r

审核场景为涉黄的审核结果信息。

AdsIn
fo

C

o

n

t
ai

n

e

r

审核场景为广告引导的审核结果信息。

UserI
nfo

C

o

n

t
ai

n

e

r

请求中设置的 UserInfo 原样返回。

ListIn

fo

C

o

n
t

ai

账号黑白名单结果。
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审核信息（PornInfo、AdsInfo等）中的内容如下：

n

e

r

Forbi
dStat

e

I

n

t
e

g

e

r

若您在请求时设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结。

参
数

名

称

类型 描述

C
od

e

Inte

ger
单个审核场景的错误码，0为成功，其他为失败。详情请参见 错误码 。

M
sg

Stri
ng

具体错误信息，如正常则为 OK。

Hi

tFl

ag

Inte

ger

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Sc

or

e

Inte

ger

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表该内容越有可能属于当前返回审核信息例如：色情 99，则表明该内容

非常有可能属于色情内容。

La

be

l

Stri

ng
该图的结果标签（为综合标签，可能为 SubLabel，可能为人物名字等）。

C

at

eg

or
y

Stri

ng
该字段为 Label  的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中

的性感类别。

Su

bL

Stri

ng

该图的二级标签结果。

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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Container 节点 LibResults 的内容：

OcrResults 的内容如下：

ab

el

O
cr

Re

su

lts

Con
tain

er 

Arra

y

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果等信息，

有相关违规内容时返回。

Li

bR

es
ult

s

Con

tain

er 
Arra

y

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段不返回。

节点

名称

（关

键
字）

类

型
描述

Imag
eId

S

tr
in

g

该字段表示命中的风险库中的图片样本 ID。

Scor

e

I

n
t

e

g

e
r

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，则表明该数据非常有

可能命中库中的色情样本。

节点名称（关键字） 类型 描述

Text String 有敏感信息的 Ocr 文本内容。

Keywords String Array 该段内容中的敏感文字。

Location Container 该段文字在图片中的位置信息。
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ObjectResults 的内容如下：

Location 的内容如下：

UserInfo 的内容（与请求中的UserInfo一致）：

节点名称（关键字） 类型 描述

Name String 敏感内容的字称。

Location Container 该内容在图片中的位置信息。

节点名称（关键字） 类型 描述

X Float 相对于原点（图片左上角）的 X 坐标。

Y Float 相对于原点（图片左上角）的 Y 坐标。

Height Float 敏感区域的高度。

Width Float 敏感区域的宽度。

Rotate Float 敏感区域的旋转角度。

节点名称（关键字） 描述 类型
是否

必选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin
g

否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin
g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。 Strin
g

否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin
g

否

节点名称（关键字） 类型 描述

ListResults Container Array 命中的所有名单结果。

节点名称（关键字） 类型 描述

ListType
Intege
r

命中的名单类型，取值为0（白名单）和1（黑名单）。

ListName String 命中的名单名称。

Entity String 命中了名单中的哪条内容。

实际案例

请求

POST /image/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Object>a.jpg</Object>

  </Input>

  <Input>

    <Url>http://exsample.com/b.jpg</Url>

  </Input>
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  <Conf>

    <BizType>b81d45f94xxxxxxxxa9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

    <JobsDetail>

        <JobId>xxxxxxxxxx</JobId>

        <CompressionResult>0</CompressionResult>

        <Object>a.jpg</Object>

        <Label>Porn</Label>

        <Result>1</Result>

        <Score>100</Score>

        <SubLabel>xxx</SubLabel>

        <PornInfo>

            <Code>0</Code>

            <Msg>OK</Msg>

            <HitFlag>1</HitFlag>

            <Score>100</Score>

            <Label>xxx</Label>

            <SubLabel>xxx</SubLabel>

        </PornInfo>

    </JobsDetail>

    <JobsDetail>

        <JobId>yyyyyyyyyy</JobId>

        <CompressionResult>0</CompressionResult>

        <Url>http://exsample.com/b.jpg</Url>

        <Label>Porn</Label>

        <Result>1</Result>

        <Score>100</Score>

        <SubLabel>xxx</SubLabel>

        <PornInfo>

            <Code>0</Code>

            <Msg>OK</Msg>

            <HitFlag>1</HitFlag>
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            <Score>100</Score>

            <Label>xxx</Label>

            <SubLabel>xxx</SubLabel>

        </PornInfo>

    </JobsDetail>

    <RequestId>xxxxxxxxxxx</RequestId>

</Response>
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查询图片审核任务结果
最近更新时间：2023-05-06 18:06:29

本接口用于主动查询指定的图片审核任务结果。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 图片审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /image/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <Label></Label>

    <Result>1</Result>

    <PornInfo>

        <HitFlag>1</HitFlag>

        <Label>xxx</Label>

        <SubLabel>SexBehavior</SubLabel>

        <Score>100</Score>

        <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

                <X></X>

                <Y></Y>

                <Width></Width>

                <Height></Height>

                <Rotate></Rotate>

            </Location>

        </OcrResults>

    </PornInfo>

    <AdsInfo>

        <HitFlag>1</HitFlag>

        <Label>xxx</Label>

        <SubLabel>SexBehavior</SubLabel>

        <Score>100</Score>

        <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

                <X></X>

                <Y></Y>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

                <Width></Width>

                <Height></Height>

                <Rotate></Rotate>

            </Location>

        </OcrResults>

    </AdsInfo>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

参数名称 类型 描述

Response Container 审核任务结果。

参数名称 类型 描述

JobsDe

tail

Contai

ner
任务的详细信息。

Reques

tId
String

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题时，该 ID 能更

快地协助定位问题。

参数名

称

类

型
描述

Code

S

tr

in

g

错误码，只有 State 为 Failed 时返回。详情请参见 错误码列表 。

Mess

age

S

tr

in

g

错误描述，只有 State 为 Failed 时返回。

DataI

d

S

tr

in
g

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。您可以使

用该字段对待审核的数据进行唯一业务标识。

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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JobId S

tr
in

g

本次审核任务的 ID

State

S

tr
in

g

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed
（审核失败）、Auditing（审核中）其中一个。

Creat

ionTi

me

S
tr

in

g

审核任务的创建时间。

Objec

t

S

tr

in

g

本次审核的文件名称，创建任务使用 Object 时返回。

Url

S

tr

in

g

本次审核的文件链接，创建任务使用 Url 时返回。

Com

press
ionRe

sult

I

n

t

e
g

e

r

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

Text

S

tr

in

g

该图里的文字内容（OCR），当审核策略开启文本内容检测时返回。

Label

S

tr

in

g

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，

建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正常，

Porn：色情，Ads：广告等。

Resul

t

I

n

t
e

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务

所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。
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g

e

r

Cate

gory

S

tr

in
g

该图命中的审核类别结果。

SubL

abel

S

tr

in
g

该图命中的二级标签结果。

PornI

nfo

C

o
n

t

ai

n

e
r

审核场景为涉黄的审核结果信息。

AdsIn

fo

C

o
n

t

ai

n
e

r

审核场景为广告引导的审核结果信息。

UserI

nfo

C

o
n

t

ai

n
e

r

用户业务字段。创建任务时未设置 UserInfo 则无此字段。

ListIn
fo

C
o

n

t

ai

n

账号黑白名单结果。
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JobsDetail中Container节点PornInfo，AdsInfo的内容：

e

r

Forbi

dStat

e

I
n

t

e

g
e

r

若您在请求时设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，

2：已转移文件。

参

数

名

称

类

型
描述

H

it

Fl
a

g

In

te

g
er

用于返回该审核场景的审核结果，返回值：0：正常1：确认为当前场景的违规内容2：疑似为

当前场景的违规内容。

S

c
o

r

e

In
te

g

er

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最
高），越高代表该内容越有可能属于当前返回审核信息。其中0 - 60分表示图片正常，61 - 

90分表示图片疑似敏感，91 - 100分表示图片确定敏感。例如：色情 99，表明该内容非常有

可能属于色情内容。

L

a

b

el

St

ri

n

g

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。

C

a

t

e
g

o

r

y

St

ri
n

g

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为空，表示
未命中或暂无相关的类别。

S

u

St

ri

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。注意：该字段

可能返回空，表示未命中具体的子标签。
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Container 节点 LibResults 的内容：

b
L

a

b

el

n
g

O

c

r
R

e

s

ul
t

s

C

o

nt
ai

n

er 

A
rr

a

y

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键词等信息，有相

关违规内容时返回。

Li

b

R

e
s

ul

t

s

C
o

nt

ai

n
er 

A

rr

a
y

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段不返回。

参

数

名

称

类

型
描述

I

m

a

g
eI

d

S

tr

in
g

该字段表示命中的风险库中的图片样本 ID。

S

c
o

I

n
t

e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 ），越

高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可能命中库中
的色情样本。
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Container 节点 OcrResults 的内容：

Container 节点 Location 的内容：

r
e

g
e

r

参数名

称
类型 描述

Text String 图片 OCR 文本识别出的具体文本内容。

Key

word

s

String 

Array
在当前审核场景下命中的关键词。

Loca

tion

Contai

ner

该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

名

称

类

型
描述

X

Fl

o

a

t

该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一确定

检测框的大小和位置。

Y

Fl

o

a

t

该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一确定

检测框的大小和位置。

Wi

dt

h

Fl

o

a
t

该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数可唯一

确定检测框的大小和位置。

H

ei

gh
t

Fl

o

a
t

该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数可唯一

确定检测框的大小和位置。

R

ot
at

e

Fl

o
a

t

该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框的具

体位置；取值：0-360（角度制），方向为逆时针旋转。
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Container 节点 ObjectResults 的内容：

Container 节点 UserInfo 的内容：

名称 类型 描述

Nam

e
String 该标签用于返回所识别出的实体名称，例如人名。

Locat

ion

Contai

ner

该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角度），以

方便快速定位相关信息。

节点名称（关键

字）
描述 类型

是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin
g

否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin
g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI
d

一般用于表示接收消息的用户账号，长度不超过128字
节。

Strin
g

否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。 Strin
g

否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

节点名称（关键字） 类型 描述

ListResults Container Array 命中的所有名单结果。

节点名称（关键字） 类型 描述

ListType Integer 命中的名单类型，取值为0（白名单）和1（黑名单）。

ListName String 命中的名单名称。

Entity String 命中了名单中的哪条内容。

实际案例

请求

GET /image/auditing/iab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <JobId>iab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Success</State>

        <CreationTime>2021-05-21T10:44:32+08:00</CreationTime>

        <Object>example.jpg</Object>

        <Label>Ads</Label>

        <Result>1</Result>

        <AdsInfo>
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            <HitFlag>1</HitFlag>

            <Label>xxx</Label>

            <SubLabel>SexBehavior</SubLabel>

            <Score>100</Score>

            <OcrResults>

                <Text></Text>

                <Keywords></Keywords>

                <Location>

                    <X></X>

                    <Y></Y>

                    <Width></Width>

                    <Height></Height>

                    <Rotate></Rotate>

                </Location>

            </OcrResults>

        </AdsInfo>

    </JobsDetail>

    <RequestId></RequestId>

</Response>
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图片审核回调内容
最近更新时间：2022-08-03 14:55:19

若您配置了审核回调地址，在图片审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data 的具体内容如下：

   "code": 0,

   "data": 

       "forbidden_status": 0,

       "event": "ReviewImage",

       "porn_info": 

           "hit_flag": 0,

           "label": "",

           "score": 9

       ,

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "https://examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.jpg",

       "cos_headers": 

           "x-cos-meta-xx": "xx"

       

   ,

   "message": "Test request when setting callback url"

{

{

{

}

{

}

}

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容

审核错误码 。

Integ

er
是

messa

ge
错误描述。

Strin

g
是

data 图片审核结果的详细信息。
Obje
ct

是

参数

名称
描述

类

型

是

否

必

选

trac

e_id

唯一 ID 标识。 S

tr

in
g

是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

url 被审核图片的完整 URL 链接。

S

tr

in
g

是

eve
nt

触发的事件，此处固定为 ReviewImage。

S

tr
in

g

是

res

ult

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照

业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为

违规敏感文件），2（疑似敏感，建议人工复核）。

I

n
t

e

g

e
r

是

forb
idde

n_s

tatu

s

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，2：

已转移文件。

I

n
t

e

g

e

r

是

cos

_he

ade
rs

资源上传时设置的自定义 header 内容，若未设置则不返回。

O

bj

e
c

t

否

por

n_in

fo

审核场景为涉黄的审核结果信息。

O
bj

e

c

t

否

ads

_inf

o

审核场景为广告引导的审核结果信息。

O

bj

e

c
t

否
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

参

数

名

称

描述 类

型

是

否

必

选

hi

t

_
fl

a

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。
2：疑似为当前场景的违规内容。

I

n

t

e
g

e

r

是

s

c

o
r

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信

度最高 ），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图

片属于正常，[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色
情 99，表明该内容非常有可能属于色情内容。

I

n

t

e
g

e

r

是

la

b

el

命中的标签名称。

S
tr

in

g

是

详细回调（Detail）

{

  "EventName": "ReviewImage",

  "JobsDetail": {

    "JobId": "xxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Url": "https://examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.jpg",

    "Label": "Normal",

    "Result": 0,

    "Score": 0,

    "Category": "",

    "SubLabel": "",

    "Text": "",
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具体的数据内容如下：

JobsDetail 的具体内容如下：

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息 Object

EventName 任务的类型，为 ReviewImage String

节
点

名

称

（

关
键

字

）

描述
类

型

Co

de

错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。 S

tr

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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in

g

Me

ss

ag
e

错误描述，只有 State 为 Failed 时返回。

S

tr

in
g

Jo

bId
审核任务的 ID。

S

tr

in
g

St
ate

审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、Failed（审
核失败）、Auditing（审核中）其中一个。

S

tr
in

g

Cr

eat
ion

Ti

me

审核任务的创建时间。

S
tr

in

g

Co

mp

res

sio
nR

es

ult

图片是否被压缩处理，值为 0（未压缩），1（正常压缩）。

I

n

t

e
g

e

r

Ob

jec

t

被审核的图片文件名称。创建任务使用 Object 时返回。

S
tr

in

g

Url 被审核的图片文件链接。创建任务使用 Url 时返回。

S

tr

in

g

La

bel

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结果，建议

您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：正常，Porn：色

情，Ads：广告，以及其他不安全或不适宜的类型。

S

tr

in

g
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Re

sul

t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业务所

需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

I

n

t
e

g

e

r

Sc
or

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最

高 ），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属于正
常，[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，则表明

该内容非常有可能属于色情内容。

I

n

t
e

g

e

r

Ca

teg

ory

该字段为 Label 的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中的性

感类别。

S

tr

in

g

Su

bL

ab
el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签

S

tr

in
g

Te

xt
图片 OCR 文本识别出的具体文本内容，当审核策略开启 OCR 内容检测时返回。

S

tr

in
g

Po
rnI

nfo

审核场景为涉黄的审核结果信息。

O

bj
e

c

t

Ad

sIn

fo

审核场景为广告引导的审核结果信息。

O
bj

e

c

t

Bu

ck

etI
d

审核操作所属的存储桶名称。 S

tr

in
g



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第984 共1950页

PornInfo，AdsInfo 的具体内容如下：

Re

gio
n

存储桶所在的地域。

S

tr

in
g

Fo
rbi

dS

tat

e

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻结，1：已被冻结，2：已转移文

件。

I

n
t

e

g

e

r

Co

sH

ea
de

rs

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 结构，key 

为自定义 Header 的名称，value 为内容。

O

bj

e
c

t

节

点

名
称

（

关

键

字
）

描述
类

型

Hi

tF
la

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内容。2：疑
似为当前场景的违规内容。

In

te
g

er

S

c
or

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]分可以认为图片属于正常，
[61,90]分表示图片疑似敏感，[91,100]分表示图片为敏感的。例如：色情 99，表明该内容

非常有可能属于色情内容。

In

te
g

er

L
a

b

el

该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字等）。

St
ri

n

g
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Container 节点 LibResults 的内容：

C

at

e

g
or

y

该字段为 Label 的子集，表示审核命中的具体审核类别。例如 Sexy，表示色情标签中的性

感类别。

St

ri

n

g

S

u
b

L

a

b
el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

St

ri

n

g

O

cr

R
e

s

ul

ts

该字段表示 OCR 文本识别的详细检测结果，包括文本识别结果、命中的关键词等信息，有相

关违规内容时返回。

A
rr

a

y

Li

b
R

e

s

ul
ts

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

C

o

nt
ai

n

er 

A

rr
a

y

节点

名称

（关
键

字）

描述
类
型

Imag

eId
该字段表示命中的风险库中的图片样本 ID。

S
tr

in

g
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OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

Scor
e

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 
），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常有可

能命中库中的色情样本。

I
n

t

e

g
e

r

节点名称

（关键字）
描述

类

型

Text 图片 OCR 文本识别出的具体文本内容。
Str
ing

Keyword

s
在当前审核场景下命中的关键词。

Arr

ay

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Ob

jec

t

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，例如人名。
Stri

ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Obj

ect

节点名称

（关键

字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Fl

o

a

t

Y 该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯 Fl
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一确定检测框的大小和位置。 o

a
t

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数
可唯一确定检测框的大小和位置。

Fl

o
a

t

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数
可唯一确定检测框的大小和位置。

Fl

o
a

t

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Fl
o

a

t

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewImage",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },

       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.jpg",

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）
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{

  "EventName": "ReviewImage",

  "JobsDetail": {

    "JobId": "xxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "CompressionResult": 0,

    "Object": "1.jpg",

    "Label": "Normal",

    "Result": 0,

    "Score": 0,

    "Category": "",

    "SubLabel": "",

    "Text": "",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": "",

      "Category": "",

      "SubLabel": ""

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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图片审核结果反馈
最近更新时间：2022-07-06 17:56:18

您可通过本接口反馈与预期不符的审核结果，例如色情图片被审核判定为正常或正常图片被判定为色情时可通过该接

口直接反馈。

本接口不会直接修改审核结果，您反馈的错误审核结果将在后台进行确认，并在后续的审核任务中生效。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

推荐使用 SDK

请求

请求示例

POST /report/badcase HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <ContentType></ContentType>

    <JobId></JobId>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

    <ModerationTime></ModerationTime>

    <Url></Url>

    <SuggestedLabel></SuggestedLabel>

    <Label></Label>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 反馈审核错误的具体参数 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

ContentTyp

e

Requ

est

需要反馈的数据类型，反馈图片错误样本，取值为

2。

Integ

er
是

Url
Requ

est

图片类型的样本，需要填写图片的 url 链接，

ContentType 为2时必填。
String 否

Label
Requ

est
数据万象审核判定的审核结果标签，例如 Porn。 String 是

SuggestedL

abel

Requ

est

您自己期望的正确审核结果的标签，例如期望是正

常，则填 Normal。
String 是

JobId
Requ

est

该数据样本对应的审核任务 ID，有助于定位审核记

录。
String 否

Moderation

Time

Requ

est

该数据样本之前审核的时间，有助于定位审核记

录。 格式为 2021-08-07T12:12:12+08:00
String 否

响应

响应头

响应体

<Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 返回的具体响应内容 Container

节点名称（关

键字）
父节点 描述

类

型

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题

Str

ing

错误码

实际案例

请求

POST /report/badcase HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1********&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 66

Content-Type: application/xml

<Request>

    <ContentType>1</ContentType>

    <Url>http://www.example.com/abc.jpg</Url>

    <Label>Porn</Label>

    <SuggestedLabel>Normal</SuggestedLabel>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 May 2022 12:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第993 共1950页

视频审核
提交视频审核任务
最近更新时间：2023-08-14 17:01:44

本接口用于提交一个视频审核任务。视频审核功能为异步任务方式，您可以通过提交视频审核任务审核您的视频文

件，然后通过 查询视频审核任务接口  或 视频审核回调  查询审核结果。

该接口支持情况如下：

视频的审核分为视频画面审核、视频截帧、视频声音审核，其中：

功能描述

说明

支持审核腾讯云 COS 上的视频文件。

支持审核第三方云存储厂商的视频 URL。

支持审核加密数据，如有需要，请 联系服务人员  咨询。

支持对视频文件进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别及音频

审核四个维度，通过深度学习技术，识别视频中的违规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询视频审核任务结果接口  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

支持用户 自定义配置黑白图片库 ，打击自定义违规内容。

费用说明

视频画面审核：基于视频截帧能力，通过视频截帧将视频截取为多张图片进行审核，审核费用与图片审核一致。

视频截帧：会产生相应的 视频截帧费用 。

视频声音审核：将视频声音分离出来进行音频审核，审核费用与音频审核一致。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个视频，计2次审核费用。

调用接口会产生 图片审核费用 、 音频审核费用  和 COS 读请求费用 。

如果音频文件属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的音频，如果需要审核此类型音频，请先 恢复归档文

件 。

限制说明

视频文件大小支持：文件 < 5GB。

https://cloud.tencent.com/document/product/436/47317
https://cloud.tencent.com/document/product/436/60768
https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/46926
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/59080
https://cloud.tencent.com/document/product/460/58120
https://cloud.tencent.com/document/product/460/58119#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/460/58119#.E9.9F.B3.E9.A2.91.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

视频文件支持格式：flv、mkv、mp4 、rmvb、avi、wmv、3gp、mov、m3u8、m4v 等。

接口默认并发数量：10。

支持用户配置审核视频画面或视频声音。

推荐使用 SDK

请求

请求示例

POST /video/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <DataId></DataId>

  </Input>

  <Conf>

    <Snapshot>

        <Mode>Interval</Mode>

        <TimeInterval></TimeInterval>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

        <Count></Count>

    </Snapshot>

    <Callback></Callback>

    <BizType></BizType>

    <DetectContent></DetectContent>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 视频审核的具体配置项。
Containe
r

是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的视频。 Container 是

Conf Request 审核规则配置。 Container 是

节点名
称（关

键字）

父节点 描述 类型
是否

必选

Object
Request.I
nput

当前 COS 存储桶中的视频文件名称，例如在目录 test 
中的文件 video.mp4，则文件名称为 

test/video.mp4。

Strin
g

否

Url
Request.I
nput

视频文件的链接地址，例如 http://examplebucket-

1250000000.cos.ap-
shanghai.myqcloud.com/test.mp4。Object 和 

Url 只能选择其中一种。

Strin
g

否

DataId
Request.I
nput

该字段在审核结果中会返回原始内容，长度限制为512
字节。您可以使用该字段对待审核的数据进行唯一业务

标识。

Strin
g

否

UserIn

fo

Request.I

nput
用户业务字段。

Cont

ainer
否
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Container 类型 Conf 的具体数据描述如下：

节点名称（关键
字）

父节点 描述
类
型

是否必
选

TokenId
Request.Input.

UserInfo

用户业务 TokenId，长度不超过128字

节。

Str

ing
否

Nickname
Request.Input.

UserInfo

用户业务 Nickname，长度不超过128

字节。

Str

ing
否

DeviceId
Request.Input.
UserInfo

用户业务 DeviceId，长度不超过128字
节。

Str
ing

否

AppId
Request.Input.

UserInfo

用户业务 AppId，长度不超过128字

节。

Str

ing
否

Room
Request.Input.

UserInfo

用户业务 Room，长度不超过128字

节。

Str

ing
否

IP
Request.Input.
UserInfo

用户业务 IP，长度不超过128字节。
Str
ing

否

Type
Request.Input.

UserInfo
用户业务 Type，长度不超过128字节。

Str

ing
否

ReceiveToke

nId

Request.Input.

UserInfo

用户业务 ReceiveTokenId，长度不

超过128字节。

Str

ing
否

Gender
Request.Input.
UserInfo

用户业务 Gender，长度不超过128字
节。

Str
ing

否

Level
Request.Input.

UserInfo

用户业务 Level，长度不超过128字

节。

Str

ing
否

Role
Request.Input.

UserInfo
用户业务 Role，长度不超过128字节。

Str

ing
否

节点名称

（关键字）
父节点 描述 类型

是否必

选

BizType Request

.Conf

表示审核策略的唯一标识，您可以通过控制台上的

审核策略页面，配置您希望审核的场景，如色情、

广告、违法违规等，配置指引： 设置公共审核策

略 。您可以在控制台上获取到 BizType。

BizType 填写时，此条审核请求将按照该审核策

Strin

g

否

https://cloud.tencent.com/document/product/460/56345
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Container 类型 Snapshot 的具体数据描述如下：

略中配置的场景进行审核。BizType 不填写时，

将自动使用默认的审核策略。

Snapshot
Request

.Conf

视频画面的审核通过视频截帧能力截取出一定量的

截图，通过对截图逐一审核而实现的，该参数用于

指定视频截帧的配置。

Cont

ainer
是

Callback
Request

.Conf
回调地址，以 http://  或者 https://  开头的地

址。

Strin

g
否

Callback
Version

Request
.Conf

回调内容的结构，有效值：Simple（回调内容包
含基本信息）、Detail（回调内容包含详细信

息）。默认为 Simple。

Strin
g

否

DetectCo
ntent

Request
.Conf

用于指定是否审核视频声音，当值为0时：表示只

审核视频画面截图；值为1时：表示同时审核视频画
面截图和视频声音。默认值为0。

Integ
er

否

Callback

Type

Request

.Conf

回调片段类型，有效值：1（回调全部截帧和音频片

段）、2（回调违规截帧和音频片段）。默认为 1。

Integ

er
否

Freeze
Request

.Conf

自动冻结配置项，可配置指定审核分数的结果进行

自动冻结。

Cont

ainer
否

节点名

称（关

键字）

父节点 描述
类

型

是否

必选

Mode
Request.Conf
.Snapshot

表示视频的截帧模式，有效值：Interval、

Average、Fps。

Interval 表示间隔模式：每间隔 TimeInterval 
秒截取一帧；当设置 Count，未设置 

TimeInterval 时，表示截取所有帧，共 Count 

帧。

Average 表示平均模式：选择该模式时 
TimeInterval 参数不生效，需要结合 Count 参

数使用，表示整个视频，按平均间隔截取共 

Count 张图片。

Fps 表示固定帧率模式：选择该模式时， 
TimeInterval 参数表示每秒截取多少帧，未设

置 TimeInterval 时，表示截取所有帧，Count 

表示共截取多少帧。

Str
ing

否

Count Request.Conf 视频截帧数量，范围为(0, 10000]。 Int 是
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员  咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

.Snapshot eg

er

TimeIn

terval

Request.Conf

.Snapshot

视频截帧频率，范围为(0, 60]，单位为秒，支持 

float 格式，执行精度精确到毫秒。

Flo

at
否

节点名

称（关

键字）

父节点 描述
类

型
是否必选

PornS

core

Request.Con

f.Freeze

取值为[0,100]，表示当色情审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

Int

eg

er

否

AdsSc

ore

Request.Con

f.Freeze

取值为[0,100]，表示当广告审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

Int

eg

er

否

响应

响应头

响应体

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Response 无 视频审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetail
Respo
nse

视频审核任务的详细信息。
Contain
er

RequestId
Respo

nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到

问题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键字）
父节点 描述 类型

DataId
Response.Jo

bsDetail
请求中添加的唯一业务标识。 String

JobId
Response.Jo
bsDetail

本次视频审核任务的 ID。 String

State
Response.Jo
bsDetail

视频审核任务的状态，值为 Submitted（已提交审

核）、Snapshoting（视频截帧中）、Success（审
核成功）、Failed（审核失败）、Auditing（审核

中）其中一个。

String

CreationTi
me

Response.Jo
bsDetail

视频审核任务的创建时间。 String

错误码

实际案例

请求

POST /video/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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<Request>

  <Input>

    <Object>a.mp4</Object>

    <DataId>123-fdrsg-123</DataID>

  </Input>

  <Conf>

    <Snapshot>

        <Mode>Interval</Mode>

        <TimeInterval>50</TimeInterval>

        <Count>100</Count>

    </Snapshot>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

    <DetectContent>1</DetectContent>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询视频审核任务结果
最近更新时间：2023-06-21 10:22:01

本接口用于主动查询指定的视频审核任务结果。视频审核功能为异步任务方式，您可以通过提交视频审核任务审核您

的视频文件，然后通过查询视频审核任务接口查询审核结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 视频审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /video/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <SnapshotCount></SnapshotCount>

    <Result>1</Result>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <Snapshot>

        <Url></Url>

        <Text></Text>

        <SnapshotTime></SnapshotTime>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <SubLabel></SubLabel>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <Url></Url>

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

    </AudioSection>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 视频审核的全部结果信息。 Container

节点名称（关

键字）

父节

点
描述 类型

JobsDetail
Resp

onse
视频审核任务的详细信息。

Contai

ner

RequestId
Resp
onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题
时，该 ID 能更快地协助定位问题。

String

节点

名称

（关

父节点 描述 类型
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键

字）

Cod
e

Response.J
obsDetail

错误码，只有 State 为 Failed 时返回。详情请查看 错误码列
表 。

String

Mes

sage

Response.J

obsDetail
错误描述，只有 State 为 Failed 时返回。 String

Data

Id

Response.J

obsDetail

提交任务时设置了 DataId 参数时返回，返回原始内容，长度限

制为512字节。您可以使用该字段对待审核的数据进行唯一业务

标识。

String

JobI
d

Response.J
obsDetail

视频审核任务的 ID。 String

Stat

e

Response.J

obsDetail

视频审核任务的状态，值为 Submitted（已提交审核）、

Snapshoting（视频截帧中）、Success（审核成功）、
Failed（审核失败）、Auditing（审核中）其中一个。

String

Crea

tionT
ime

Response.J

obsDetail
视频审核任务的创建时间。 String

Obje

ct

Response.J

obsDetail
本次审核的文件名称，创建任务使用 Object 时返回。 String

Url
Response.J

obsDetail
本次审核的文件链接，创建任务使用 Url 时返回。 String

Snap

shot
Cou

nt

Response.J
obsDetail

视频截图的总数量。 String

Labe

l

Response.J

obsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表
示模型推荐的审核结果，建议您按照业务所需，对不同违规类型

与建议值进行处理。 返回值：Normal：正常，Porn：色情，

Ads：广告，以及其他不安全或不适宜的类型。

String

Resu

lt

Response.J

obsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进行后续

的操作；建议您按照业务所需，对不同的审核结果进行相应处

理。有效值：0（审核正常），1 （判定为违规敏感文件），2

（疑似敏感，建议人工复核）。

Integ

er

Porn

Info

Response.J

obsDetail
审核场景为色情的审核结果信息。

Conta

iner

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 Snapshot 的内容：

AdsI
nfo

Response.J
obsDetail

审核场景为广告的审核结果信息。 Conta
iner

Snap

shot

Response.J

obsDetail
该字段用于返回视频中视频画面截图审核的结果。

Conta

iner 
Array

Audi

oSec

tion

Response.J

obsDetail

该字段用于返回视频中视频声音审核的结果。如果未检测音频，

则不返回。

Conta

iner  

Array

User

Info

Response.J

obsDetail
用户业务字段。创建任务未设置 UserInfo 时无此字段。

Conta

iner

ListI

nfo

Response.J

obsDetail
账号黑白名单结果。

Conta

iner

Forbi

dSta
te

Response.J
obsDetail

若您设置了自动冻结，该字段表示图片的冻结状态。0：未冻
结，1：已被冻结，2：已转移文件。

Integ
er

节点名称

（关键

字）

父节点 描述 类型

HitFlag
Response.Jobs

Detail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。

1：确认为当前场景的违规内容。2：疑似为当前场景的

违规内容。

Inte

ger

Count
Response.Jobs
Detail.*Info

命中该审核分类的截图张数。
Inte
ger

节点

名称

（关

键
字）

父节点 描述 类型

Url
Response.JobsD

etail.Snapshot

视频截图的访问地址，您可以通过该地址查看该截图内容，

地址格式为标准 URL 格式。注意：每次查看数据的有效期

为2小时，2小时后如还需查看，请重新发起查询请求。

Strin

g

Sna Response.JobsD 该字段用于返回当前截图位于视频中的时间，单位为毫秒。 Integ
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Container 节点 PornInfo，AdsInfo 的内容：

psh

otTi
me

etail.Snapshot 例如5000（视频开始后5000毫秒）。审核直播流时，该字

段返回当前截图的时间戳，单位为毫秒。例如
1649387157000。

er

Tex

t

Response.JobsD

etail.Snapshot

该字段用于返回当前截图的图片 OCR 文本识别的检测结

果，仅在审核策略开启文本内容检测时返回。

Strin

g

Lab

el

Response.JobsD

etail.AudioSectio

n

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对不

同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告，以及其他不安全或不适宜的类
型。

Strin

g

Sub

Lab
el

Response.JobsD

etail.AudioSectio
n

该字段表示审核命中的具体子标签。注意：该字段可能返回

空。

Strin

g

Res

ult

Response.JobsD

etail.AudioSectio
n

该字段表示本次判定的审核结果，您可以根据该结果，进行

后续的操作；建议您按照业务所需，对不同的审核结果进行

相应处理。有效值：0（审核正常），1 （判定为违规敏感文
件），2（疑似敏感，建议人工复核）。

Integ

er

Por

nInf
o

Response.JobsD

etail.Snapshot
审核场景为色情的审核结果信息。

Cont

ainer

AdsI

nfo

Response.JobsD

etail.Snapshot
审核场景为广告的审核结果信息。

Cont

ainer

节点名

称（关
键字）

父节点 描述 类型

HitFlag

Response

.JobsDet
ail.Snaps

hot.*Info

用于返回该审核场景的审核结果，返回值：0：正常。1：确认
为当前场景的违规内容。2：疑似为当前场景的违规内容。

Integer

Score

Response
.JobsDet

ail.Snaps

hot.*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0（置
信度最低）-100（置信度最高 ），越高代表该内容越有可能

属于当前返回的审核信息。例如：色情 99，则表明该内容非常

有可能属于色情内容。

Integer

Label Response
.JobsDet

该字段表示该截图的综合结果标签（可能为 SubLabel，可能
为人物名字等）。

String
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ail.Snaps

hot.*Info

Categ

ory

Response

.JobsDet

ail.Snaps

hot.*Info

该字段为 Label  的子集，表示审核命中的具体审核类别。例

如 Sexy，表示色情标签中的性感类别。
String

SubLa

bel

Response

.JobsDet

ail.Snaps

hot.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签。注意：该字段可能返回空，表示未命

中具体的子标签。

String

OcrRe

sults

Response

.JobsDet

ail.Snaps
hot.*Info

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信

息、文本识别结果等信息，有相关违规内容时返回。

Contain

er 

Array

LibRes
ults

Response

.JobsDet
ail.Snaps

hot.*Info

该字段用于返回基于风险库识别的结果。注意：未命中风险库
中样本时，此字段不返回。

Contain

er 
Array

节点

名称

（关

键
字）

父节点 描述
类

型

Imag
eId

Response.JobsDetail.Snaps
hot.*Info.LibResults

该字段表示命中的风险库中的图片样本 ID。

St

ri
n

g

Scor

e

Response.JobsDetail.Snaps

hot.*Info.LibResults

该字段用于返回当前标签下的置信度，取值范

围：0（置信度最低）-100（置信度最高 ），越
高代表当前的图片越有可能命中库中的样本；

如：色情 99，则表明该数据非常有可能命中库中

的色情样本。

In
te

g

er

节点名

称（关

父节点 描述 类型
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ObjectResults 的具体内容如下：

Location 的具体内容如下：

键字）

Text
Response.JobsDetail.Snaps

hot.*Info.OcrResults
图片 OCR 文本识别出的具体文本内容。 String

Keywo

rds

Response.JobsDetail.Snaps

hot.*Info.OcrResults
在当前审核场景下命中的关键词。

String 

Array

Locati

on

Response.JobsDetail.Snaps

hot.*Info.OcrResults

该参数用于返回 OCR 检测框在图片中的

位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信

息。

Conta

iner

节点名称

（关键
字）

父节点 描述 类型

Name
Response.JobsDetail.Snapsho

t.*Info.ObjectResults

该标签用于返回所识别出的实体名称，

例如人名。

Strin

g

Locatio

n

Response.JobsDetail.Snapsho

t.*Info.ObjectResults

该参数用于返回检测结果在图片中的位

置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Cont

ainer

节点名称

（关键
字）

描述
类
型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Flo

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Flo

at

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参
数可唯一确定检测框的大小和位置。

Flo
at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测

框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Flo

at
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Container 节点 AudioSection 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

节点名称

（关键
字）

父节点 描述 类型

Url

Response.J

obsDetail.A

udioSection

视频声音片段的访问地址，您可以通过该地址获取该声音片段

的内容，地址格式为标准 URL 格式。注意：每次查看数据的

有效期为2小时，2小时后如还需查看，请重新发起查询请求。

Stri

ng

Text

Response.J

obsDetail.A

udioSection

该字段用于返回当前视频声音的 ASR 文本识别的检测结果。
Stri

ng

OffsetTi

me

Response.J

obsDetail.A

udioSection

该字段用于返回当前声音片段位于视频中的时间，单位为毫

秒，例如5000（视频开始后5000毫秒）。审核直播流时，该

字段返回当前声音片段的时间戳，单位为毫秒，例如

1649387157000。

Inte

ger

Duration

Response.J

obsDetail.A

udioSection

当前视频声音片段的时长，单位毫秒。
Inte

ger

Label

Response.J

obsDetail.S

napshot

该字段用于返回检测结果中所对应的优先级最高的恶意标签，

表示模型推荐的审核结果，建议您按照业务所需，对不同违规

类型与建议值进行处理。 返回值：Normal：正常，Porn：

色情，Ads：广告，以及其他不安全或不适宜的类型。

Stri

ng

Result

Response.J

obsDetail.S

napshot

该字段表示本次判定的审核结果，您可以根据该结果，进行后

续的操作；建议您按照业务所需，对不同的审核结果进行相应

处理。有效值：0（审核正常），1 （判定为违规敏感文件），
2（疑似敏感，建议人工复核）。

Inte

ger

PornInfo

Response.J

obsDetail.A
udioSection

审核场景为色情的审核结果信息。

Con

tain
er

AdsInfo

Response.J

obsDetail.A

udioSection

审核场景为广告的审核结果信息。

Con

tain

er

节点
名称

（关

父节点 描述 类型
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

键
字）

HitFl

ag

Response.JobsDetail.

AudioSection.*Info

用于返回该审核场景的审核结果，返回值：0：正

常。1：确认为当前场景的违规内容。2：疑似为

当前场景的违规内容。

String

Scor

e

Response.JobsDetail.

AudioSection.*Info

该字段表示审核结果命中审核信息的置信度，取

值范围：0（置信度最低）-100（置信度最高 

），越高代表该内容越有可能属于当前返回审核
信息例如：色情 99，则表明该内容非常有可能属

于色情内容。

String

Cate
gory

Response.JobsDetail.
AudioSection.*Info

该字段为 Label  的子集，表示审核命中的具体

审核类别。例如 Sexy，表示色情标签中的性感

类别。

String

SubL

abel

Response.JobsDetail.

AudioSection.*Info

该字段表示审核命中的具体子标签。注意：该字

段可能返回空。
String

Key

word

s

Response.JobsDetail.

AudioSection.*Info
在当前审核场景下命中的关键词，没有时不返回

String 

Array

LibR

esult

s

Response.JobsDetail.

AudioSection.*Info

该字段用于返回基于风险库识别的结果。注意：

未命中风险库中样本时，此字段不返回。

Contain

er 

Array

节点名称

（关键
字）

父节点 描述 类型

LibType
Response.JobsDetail.AudioS

ection.*Info.LibResults

命中的风险库类型，取值为1（预设黑

白库）和2（自定义风险库）。

Integ

er

LibName
Response.JobsDetail.AudioS

ection.*Info.LibResults
命中的风险库名称。 String

Keyword

s

Response.JobsDetail.AudioS

ection.*Info.LibResults

命中的库中关键词。该参数可能会有
多个返回值，代表命中的多个关键

词。

String 

Array

节点名称（关键 描述 类型 是否必
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

字） 选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键
字）

父节点 描述 类型

ListResults
Response.JobsDetail.ListIn

fo

命中的所有名单结

果。

Container 

Array

节点名称（关

键字）
父节点 描述

类

型



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1012 共1950页

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

ListType Response.JobsDetail.ListI

nfo.ListResults

命中的名单类型，取值为0（白名单）和1

（黑名单）。

Int

eg

er

ListName
Response.JobsDetail.ListI

nfo.ListResults
命中的名单名称。

Str

ing

Entity
Response.JobsDetail.ListI
nfo.ListResults

命中了名单中的哪条内容。
Str
ing

错误码

实际案例

请求

GET /video/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Object>a.mp4</Object>

    <SnapshotCount>1</SnapshotCount>

    <Label>Normal</Label>

    <Result>0</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

https://cloud.tencent.com/document/product/460/42867
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    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <Snapshot>

        <Url>http://examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/0.jpg</U

        <SnapshotTime>0</SnapshotTime>

        <Text>哈哈</Text>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>0</OffsetTime>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </AudioSection>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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视频审核回调内容
最近更新时间：2022-11-15 14:37:00

若您配置了审核回调地址，在视频审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

data 的具体内容如下：

回调内容说明

简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名
称

描述 类型
是否必
选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容审

核错误码 。

Inte

ger
是

mess

age
错误描述。

Stri

ng
是

data 视频审核结果的详细信息。
Obj
ect

是

参数名称 描述 类型 是否必

选

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

trace_id
请求的 ID，如果是接口创建的异步任务，则为接口返回的 

JobId。
String 是

url 被审核视频的完整 URL 链接。 String 是

event 触发的事件，此处固定为 ReviewVideo。 String 是

result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的

操作；建议您按照业务所需，对不同的审核结果进行相应处理。有

效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏

感，建议人工复核）。

Integ

er
是

forbidden

_status

若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，

1：已被冻结，2：已转移文件。

Integ

er
是

cos_head

ers
资源上传时设置的自定义 header 内容，若未设置则不返回。

Objec

t
否

porn_info 审核场景为涉黄的审核结果信息。
Objec

t
否

ads_info 审核场景为广告引导的审核结果信息。
Objec

t
否

data_id
提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制

为512字节。
String 否

参数名

称
描述 类型

是否

必选

hit_fl
ag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景
的违规内容。2：疑似为当前场景的违规内容。

Integ
er

是

label 命中的标签名称，目前为空。
Strin

g
是

count 命中该审核分类的敏感截图张数。
Integ

er
是

详细回调（Detail）
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{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "",

        "Text": "",

        "SnapshotTime": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,
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具体的数据内容如下：

JobsDetail 的具体内容如下：

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewVideo 。 String

节点名称（关

键字）
描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。
Stri

ng

Message 错误描述，只有 State 为 Failed 时返回。
Stri
ng

JobId 审核任务的 ID。
Stri

ng

DataId 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。
Stri

ng

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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State 视频审核任务的状态，值为 Submitted（已提交审核）、Snapshoting（截
图中）、Success（审核成功）、Failed（审核失败）、Auditing（审核

中）其中一个。

Stri
ng

CreationTi
me

视频审核任务的创建时间。
Stri
ng

Object 被审核的视频文件的名称，创建任务使用 Object 时返回。
Stri

ng

Url 本次审核的文件链接，创建任务使用 Url 时返回。
Stri

ng

SnapshotC
ount

视频截图的总数量。直播流状态为 Auditing 的回调中该字段为本次回调包含的
截图数量。

Inte
ger

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：

Normal：正常，Porn：色情，Ads：广告。

Stri

ng

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

PornInfo 审核场景为涉黄的审核结果信息。
Obj

ect

AdsInfo 审核场景为广告引导的审核结果信息。
Obj
ect

Snapshot 该字段用于返回视频中视频画面截图审核的结果。
Arr

ay

AudioSecti

on
该字段用于返回视频中视频声音审核的结果。如果未检测音频，则不返回。

Arr

ay

BucketId 创建的审核任务所属的存储桶名称。
Stri
ng

Region 存储桶所在的地域。
Stri

ng

ForbidState
若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，1：已被冻

结，2：已转移文件。

Inte

ger

CosHeader
s

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 
结构，key 为自定义 Header 的名称，value 为内容。

Obj
ect



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1020 共1950页

PornInfo，AdsInfo 的具体内容如下：

Snapshot 的具体内容如下：

UserInfo 用户业务字段。创建任务时未设置 UserInfo 则无此字段。 Obj

ect

Type 审核类型，直播流审核返回 live_video。
Stri

ng

ListInfo 账号黑白名单结果。
Obj

ect

节点名称（关

键字）
描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规
内容。2：疑似为当前场景的违规内容。

Inte
ger

Count 命中该审核分类的截图张数。
Inte

ger

节点名称
（关键字）

描述 类型

Url

视频截图的访问地址，您可以通过该地址查看该截图内容，地址格式为标准 URL 

格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Stri

ng

Snapshot

Time

该字段用于返回当前截图位于视频中的时间，单位为毫秒。例如5000（视频开始

后5000毫秒）。审核直播流时，该字段返回当前截图的时间戳，单位为毫秒。例

如1649387157000。

Inte

ger

Text
该字段用于返回当前截图的图片 OCR 文本识别的检测结果，仅在审核策略开启

文本内容检测时返回。

Stri

ng

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核
结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：

Normal：正常，Porn：色情，Ads：广告。

Stri

ng

Result
该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按
照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判

定为违规敏感文件），2（疑似敏感，建议人工复核）。

Inte
ger

PornInfo 审核场景为涉黄的审核结果信息。
Obj

ect



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1021 共1950页

Snapshot 中 PornInfo，AdsInfo 的具体内容如下：

Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

AdsInfo 审核场景为广告引导的审核结果信息。 Obj

ect

节点名

称（关
键字）

描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Integer

Label
该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字
等）。

String

Categ

ory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可

能为空，表示未命中或暂无相关的类别。
String

SubLa

bel

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标

签。

注意：该字段可能返回空，表示未命中具体的子标签。

String

OcrRe

sults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结

果等信息，有相关违规内容时返回。
Array

LibRes
ults

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字段
不返回。

Object 
Array

节点名

称（关

键字）

描述 类型

ImageI
d

该字段表示命中的风险库中的图片样本 ID。
Stri
ng

Score

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最

高 ），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据
非常有可能命中库中的色情样本。

Inte

ger

节点名称 描述 类型
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ObjectResults 的具体内容如下：

Location 的具体内容如下：

AudioSection 的具体内容如下：

（关键字）

Text 图片 OCR 文本识别出的具体文本内容。
Strin
g

Keywords 在当前审核场景下命中的关键词。
Arra

y

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Obje

ct

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，如人名。
Strin
g

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Obje

ct

节点名称
（关键

字）

描述 类型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数

可唯一确定检测框的大小和位置。
Float

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数

可唯一确定检测框的大小和位置。
Float

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩

余参数可唯一确定检测框的大小和位置。
Float

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩

余参数可唯一确定检测框的大小和位置。
Float

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定

检测框的具体位置；取值：0-360（角度制），方向为逆时针旋转。
Float

节点名

称（关

描述 类型
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AudioSection 中 PornInfo，AdsInfo 的具体内容如下：

键字）

Url

视频声音片段的访问地址，您可以通过该地址获取该声音片段的内容，地址格式为标

准 URL 格式。
注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Strin

g

Text 该字段用于返回当前视频声音的 ASR 文本识别的检测结果。
Strin

g

Offset

Time

该字段用于返回当前声音片段位于视频中的时间，单位为毫秒，例如5000（视频开

始后5000毫秒）。审核直播流时，该字段返回当前声音片段的时间戳，单位为毫

秒，例如1649387157000。

Integ

er

Durati

on
当前视频声音片段的时长，单位毫秒。

Integ

er

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：
正常，Porn：色情，Ads：广告。

Strin
g

Result 供参考的识别结果，0（正常），1（敏感），2（疑似敏感）。
Integ

er

PornIn

fo
审核场景为涉黄的审核结果信息。

Obje

ct

AdsInf
o

审核场景为广告引导的审核结果信息。
Obje
ct

节点名

称（关

键字）

描述 类型

HitFla

g
是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信
息。例如：色情99，表明该内容非常有可能属于色情内容。

Integer

Categ

ory

该字段表示命中的审核类别。

注意：该字段可能返回空。
String

Keywo

rds
在当前审核场景下命中的关键词，没有时不返回。 Array
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Container 节点 LibResults 的内容：

UserInfo 的内容：

LibRes
ults

该字段用于返回基于风险库识别的结果。
注意：未命中风险库中样本时，此字段不返回。

Containe
r Array

节点名称（关键

字）
描述 类型

LibType 命中的风险库类型，取值为1（预设黑白库）和2（自定义风险库）。 Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键字） 描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。 Strin 否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

g

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。
Intege

r

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "vxzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/video.mp

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}
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案例二：详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Object": "1.mp4",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "https://video-1250000000.cos.ap-chongqing.myqcloud.com/test/0.jpg",

        "Text": "",

        "SnapshotTime": 41,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",

        "Text": "",
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        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1028 共1950页

音频审核

提交音频审核任务
最近更新时间：2023-06-27 10:41:43

本接口用于提交一个音频审核任务。音频审核功能为异步任务方式，您可以通过提交音频审核任务审核您的音频文

件，然后通过 查询音频审核任务接口  或 音频审核回调  查询审核结果。

该接口支持情况如下：

功能描述

说明

支持审核腾讯云 COS 上的音频文件。

支持审核第三方云存储厂商的音频 URL。

支持对音频文件进行自动检测，从 ASR 语音文本识别、色情呻吟两个维度，通过深度学习技术识别音频中的违

规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询音频审核任务结果接口  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个音频，计2次审核费用。

调用接口会产生 音频审核费用  和 COS 读请求费用 。

如果音频属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的音频，如果需要审核此类型音频，请先 恢复归档文

件 。

限制说明

音频文件大小支持：文件 < 600MB。

音频文件时长支持：**< 3小时**。

音频码率类型支持：128Kbps - 256Kbps。

音频文件支持格式：mp3、wav、aac、flac、amr、3gp、m4a、wma、ogg、ape。

接口默认并发数量：10。

音频文件内容语言支持：普通话、英语、粤语。

当输入为视频文件时，支持分离视频文件音轨，并对音频内容进行独立审核。

https://cloud.tencent.com/document/product/436/54064
https://cloud.tencent.com/document/product/436/60769
https://cloud.tencent.com/document/product/460/53396
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/460/58119#.E9.9F.B3.E9.A2.91.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

推荐使用 SDK

请求

请求示例

POST /audio/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

        <Object></Object>

        <Url></Url>

        <DataId></DataId>

    </Input>

    <Conf>

        <Callback></Callback>

        <BizType></BizType>

    </Conf>

</Request>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 音频审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

节点名称

（关键

字）

父节点 描述 类型

是
否

必

选

Object

Reque

st.Inpu

t

存储在 COS 存储桶中的音频文件名称，例如在目录 test 中

的文件 audio.mp3，则文件名称为 test/audio.mp3。

Object 和 Url 只能选择其中一种。

Strin

g
否

Url

Reque

st.Inpu

t

音频文件的链接地址，例如 http://examplebucket-
1250000000.cos.ap-

shanghai.myqcloud.com/audio.mp3。Object 和 

Url 只能选择其中一种。

Strin

g
否

DataId

Reque

st.Inpu

t

该字段在审核结果中会返回原始内容，长度限制为512字节。

您可以使用该字段对待审核的数据进行唯一业务标识。

Strin

g
否

UserInf

o

Reque
st.Inpu

t

用户业务字段。
Cont

ainer
否

节点名称（关

键字）
父节点 描述 类型

是否

必选

TokenId
Request.Input.Use

rInfo

用户业务 TokenId，长度不超过

128字节。
String 否

Nickname
Request.Input.Use

rInfo

用户业务 Nickname，长度不超过

128字节。
String 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1031 共1950页

Container 类型 Conf 的具体数据描述如下：

DeviceId Request.Input.Use

rInfo

用户业务 DeviceId，长度不超过

128字节。

String 否

AppId
Request.Input.Use

rInfo

用户业务 AppId，长度不超过128字

节。
String 否

Room
Request.Input.Use
rInfo

用户业务 Room，长度不超过128字
节。

String 否

IP
Request.Input.Use

rInfo
用户业务 IP，长度不超过128字节。 String 否

Type
Request.Input.Use

rInfo

用户业务 Type，长度不超过128字

节。
String 否

ReceiveTok
enId

Request.Input.Use
rInfo

用户业务 ReceiveTokenId，长度
不超过128字节。

String 否

Gender
Request.Input.Use

rInfo

用户业务 Gender，长度不超过128

字节。
String 否

Level
Request.Input.Use

rInfo

用户业务 Level，长度不超过128字

节。
String 否

Role
Request.Input.Use

rInfo

用户业务 Role，长度不超过128字

节。
String 否

节点名称（关
键字）

父节点 描述 类型
是否
必选

BizType
Request.

Conf

表示审核策略的唯一标识，您可以通过控制台上的审

核策略页面，配置您希望审核的场景，如色情、广告
等，配置指引： 设置公共审核策略 。您可以在控制

台上获取到 BizType。BizType 填写时，此条审

核请求将按照该审核策略中配置的场景进行审核。

BizType 不填写时，将自动使用默认的审核策略。

Strin

g
否

Callback
Request.

Conf

审核结果以回调形式发送至您的回调地址，支持以 

http://  或者 https://  开头的地址，例如：

http://www.callback.com 。

Strin

g
否

CallbackV

ersion

Request.

Conf

回调内容的结构，有效值：Simple（回调内容包含

基本信息）、Detail（回调内容包含详细信息）。默

认为 Simple。

strin

g
否
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

CallbackT

ype

Request.

Conf

回调片段类型，有效值：1（回调全部音频片段）、

2（回调违规音频片段）。默认为 1。

Integ

er

否

Freeze
Request.

Conf

可通过该字段，设置根据审核结果给出的不同分值，

对音频文件进行自动冻结，仅当 input 中审核的音

频为 object 时有效。

Cont

ainer
否

节点名称

（关键字）
父节点 描述

类

型

是否

必选

PornSco

re

Request.Con

f.Freeze

取值为[0,100]，表示当色情审核结果大于或等于该

分数时，自动进行冻结操作。不填写则表示不自动

冻结，默认值为空。

Int

eg

er

否

AdsScor

e

Request.Con

f.Freeze

取值为[0,100]，表示当广告审核结果大于或等于该
分数时，自动进行冻结操作。不填写则表示不自动

冻结，默认值为空。

Int
eg

er

否

响应

响应头

响应体

<Response>

    <JobsDetail>

        <DataId></DataId>

        <JobId></JobId>

        <State></State>

        <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Response 无 音频审核返回的具体响应内容。 Container

节点名称（关

键字）
父节点 描述 类型

JobsDetail
Respo

nse
音频审核任务的详细信息。

Contain

er

RequestId
Respo

nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到

问题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键
字）

父节点 描述 类型

DataId
Response.Jo

bsDetail
请求中添加的唯一业务标识。

Stri

ng

JobId
Response.Jo

bsDetail
本次音频审核任务的 ID。

Stri

ng

State
Response.Jo
bsDetail

音频审核任务的状态，值为 Submitted（已提交审核）、
Success（审核成功）、Failed（审核失败）、Auditing

（审核中）其中一个。

Stri
ng

Creatio

nTime

Response.Jo

bsDetail
音频审核任务的创建时间。

Stri

ng

错误码

实际案例

请求

POST /audio/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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<Request>

    <Input>

        <Object>a.mp3</Object>

        <DataId>123-fdrsg-123</DataID>

    </Input>

    <Conf>

        <DetectType>Porn,Ads</DetectType>

        <Callback>http://callback.com/</Callback>

    </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询音频审核任务结果
最近更新时间：2023-06-20 15:10:36

本接口用于查询一个音频审核任务的状态或结果。

对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 音频审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /audio/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型
是否必

选

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <Result>1</Result>

    <AudioText></AudioText>

    <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

        <Label></Label>

    </PornInfo>

    <Section>

        <Url>https://cos.ap-guangzhou.myqcloud.com/0.mp3</Url>

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 音频审核任务结果。 Container

节点名称（关

键字）
父节点 描述 类型

JobsDetail
Respon

se
音频审核任务的详细信息。

Contai

ner

RequestId
Respon
se

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到
问题时，该 ID 能更快地协助定位问题。

String

节点名称

（关键

字）

父节点 描述 类型

Code
Response.Jo

bsDetail

错误码，只有 State 为 Failed 时返回。详情请查看 错

误码列表 。
String

Messag

e

Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时返回。 String

DataId
Response.Jo

bsDetail

该字段在审核结果中会返回原始内容，长度限制为512字

节。您可以使用该字段对待审核的数据进行唯一业务标

识。

String

JobId
Response.Jo

bsDetail
本次音频审核任务的 ID。 String

State
Response.Jo

bsDetail

音频审核任务的状态，值为 Submitted（已提交审
核）、Success（审核成功）、Failed（审核失败）、

Auditing（审核中）其中一个。

String

Creation
Time

Response.Jo
bsDetail

音频审核任务的创建时间。 String

Object
Response.Jo

bsDetail

审核的音频文件为存储在 COS 中的文件时，该字段表示

本次审核的音频文件名称。
String

Url
Response.Jo

bsDetail

审核的音频文件为一条文件链接时，该字段表示本次审核

的音频文件链接。
String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo 的内容：

Label Response.Jo

bsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对

不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告，以及其他不安全或不适

宜的类型。

String

Result
Response.Jo

bsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进

行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违
规敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

AudioTe

xt

Response.Jo

bsDetail
该字段用于返回音频文件中已识别的对应文本内容。 String

PornInfo
Response.Jo

bsDetail
审核场景为色情的审核结果信息。

Contai

ner

AdsInfo
Response.Jo
bsDetail

审核场景为广告的审核结果信息。
Contai
ner

Section
Response.Jo

bsDetail

当音频过长时，会对音频进行分段，该字段用于返回音频

片段的审核结果，主要包括开始时间和音频审核的相应结

果。

Contai

ner 

Array

UserInfo
Response.Jo

bsDetail
用户业务字段。创建任务未设置 UserInfo 时无此字段。

Contai

ner

ListInfo
Response.Jo

bsDetail
账号黑白名单结果。

Contai

ner

ForbidSt

ate

Response.Jo

bsDetail

若您设置了自动冻结，该字段表示音频文件的冻结状态。

0：未冻结，1：已被冻结，2：已转移文件。

Intege

r

节点名
称（关

键字）

父节点 描述 类型

HitFla
g

Response.JobsDet
ail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。
1：确认为当前场景的违规内容。2：疑似为当前场景

的违规内容。

Integ
er

Score
Response.JobsDet
ail.*Info

该字段表示审核结果命中审核信息的置信度，取值范

围：0（置信度最低）-100（置信度最高 ），越高代
表该内容越有可能属于当前返回审核信息。例如：色情 

99，表明该内容非常有可能属于色情内容。

Integ
er
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Container 节点 Section 的内容：

Label Response.JobsDet
ail.*Info

本次审核的综合结果标签，如果命中了敏感的关键词，
该字段返回对应的关键词。

String

Categ

ory

Response.JobsDet

ail.*Info

该字段表示审核命中的具体审核类别。注意：该字段可

能返回空。
String

SubL

abel

Response.JobsDet

ail.*Info

该字段表示审核命中的具体子标签。注意：该字段可能

返回空。
String

节点名称

（关键

字）

父节点 描述 类型

Url
Response.JobsDet

ail.Section

当前音频片段的访问地址，您可以通过该地址获取

该音频片段的内容，地址格式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如

还需查看，请重新发起查询请求。

String

Text
Response.JobsDet

ail.Section

该字段用于返回当前音频片段的 ASR 文本识别的

检测结果。
String

OffsetTi

me

Response.JobsDet

ail.Section

该字段用于返回当前音频片段位于总音频中的时

间，单位为毫秒，例如5000（音频开始后5000毫

秒）。

Integ

er

Duration
Response.JobsDet
ail.Section

当前音频片段的时长，单位毫秒。
Integ
er

Label
Response.JobsDet
ail.Section

该字段用于返回检测结果中所对应的优先级最高的

恶意标签，表示模型推荐的审核结果，建议您按照
业务所需，对不同违规类型与建议值进行处理。 返

回值：Normal：正常，Porn：色情，Ads：广

告，以及其他不安全或不适宜的类型。

String

SubLabe
l

Response.JobsDet
ail

该字段表示审核命中的具体子标签。注意：该字段
可能返回空。

String

Result
Response.JobsDet
ail.Section

该字段表示本次判定的审核结果，您可以根据该结

果，进行后续的操作；建议您按照业务所需，对不
同的审核结果进行相应处理。有效值：0（审核正

常），1 （判定为违规敏感文件），2（疑似敏感，

建议人工复核）。

Integ
er

PornInfo
Response.JobsDet

ail.Section
审核场景为色情的审核结果信息。

Conta

iner
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 LibResults 的内容：

AdsInfo Response.JobsDet

ail.Section

审核场景为广告的审核结果信息。 Conta

iner

节点名
称（关

键字）

父节点 描述 类型

HitFla
g

Response.JobsDetail.
Section.*Info

用于返回该审核场景的审核结果，返回值：
0：正常。1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Integer

Score
Response.JobsDetail.

Section.*Info

该字段表示审核结果命中审核信息的置信

度，取值范围：0（置信度最低）-100（置
信度最高 ），越高代表该内容越有可能属于

当前返回审核信息。例如：色情 99，表明该

内容非常有可能属于色情内容。

Integer

Categ

ory

Response.JobsDetail.

Section.*Info

该字段为 Label  的子集，表示审核命中的

具体审核类别。例如 Sexy，表示色情标签

中的性感类别。

String

Keyw
ords

Response.JobsDetail.
Section.*Info

本次审核命中的敏感关键词，没有时不返
回。

String 
Array

LibRe

sults

Response.JobsDetail.

Section.*Info

该字段用于返回基于风险库识别的结果。注

意：未命中风险库中样本时，此字段不返
回。

Container 

Array

节点名称

（关键

字）

父节点 描述 类型

LibType
Response.JobsDetail.Secti
on.*Info.LibResults

命中的风险库类型，取值为1（预设风
险库）和2（自定义风险库）。

Integer

LibName
Response.JobsDetail.Secti

on.*Info.LibResults
命中的风险库名称。 String

Keyword

s

Response.JobsDetail.Secti

on.*Info.LibResults

命中的库中关键词。该参数可能会有

多个返回值，代表命中的多个关键

词。

String 

Array
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Container 节点 UserInfo 的内容：

Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

节点名称（关键字） 描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin
g

否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。
Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin
g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 父节点 描述 类型

ListResults
Response.JobsDetail.ListI
nfo

命中的所有名单结果。
Container 
Array
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键

字）

父节点 描述 类型

ListType
Response.JobsDetail.ListInf
o.ListResults

命中的名单类型，取值为0（白名
单）和1（黑名单）。

Integ
er

ListName
Response.JobsDetail.ListInf

o.ListResults
命中的名单名称。

Strin

g

Entity
Response.JobsDetail.ListInf

o.ListResults
命中了名单中的哪条内容。

Strin

g

错误码

实际案例

请求

GET /audio/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>aab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Object>a.mp3</Object>

    <Result>1</Result>

    <AudioText>wc xx</AudioText>

    <PornInfo>

        <HitFlag>1</HitFlag>

https://cloud.tencent.com/document/product/460/42867
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        <Score>91</Score>

        <Label>xx</Label>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

        <Label></Label>

    </AdsInfo>

    <Section>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>0</OffsetTime>

        <PornInfo>

            <HitFlag>1</HitFlag>

            <Score>91</Score>

            <Keywords>xx</Keywords>

            <Keywords>wc</Keywords>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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音频审核回调内容
最近更新时间：2022-11-15 14:39:09

若您配置了审核回调地址，在音频审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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具体的数据内容如下：

data的具体内容如下：

回调内容说明

简洁回调（Simple）

{

   "code": 0,

   "data": {

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_audio",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容审

核错误码 。

Inte

ger
是

mess

age
错误描述。

Stri

ng
是

data 音频审核结果的详细信息。
Obj

ect
是

参数名称 描述 类型
是否
必选

trace_id
请求的 ID，如果是接口创建的异步任务，则为接口返回的 

JobId。
String 是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

url 被审核音频的完整 URL 链接。 String 是

event 触发的事件，此处固定为 ReviewAudio。 String 是

result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的

操作；建议您按照业务所需，对不同的审核结果进行相应处理。有

效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏

感，建议人工复核）。

Integ

er
是

forbidden_

status

若您设置了自动冻结，该字段表示音频的冻结状态。0：未冻结，

1：已被冻结，2：已转移文件。

Integ

er
是

cos_head
ers

资源上传时设置的自定义 header 内容，如果未设置则不返回。
Objec
t

否

porn_info 审核场景为涉黄的审核结果信息。
Objec

t
否

ads_info 审核场景为广告引导的审核结果信息。
Objec

t
否

data_id
提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制
为512字节。

String 否

参数

名称
描述 类型

是否

必选

hit_fl
ag

是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。
Integ
er

是

scor

e

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核

信息。例如：色情 99，表明该内容非常有可能属于色情内容。

Integ

er
是

label
本次审核的结果标签，如果命中了敏感的关键词，该字段返回对应的关键

词。

Strin

g
是

详细回调（Detail）

{

  "EventName": "ReviewAudio",

  "JobsDetail": {
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具体的数据内容如下：

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "AudioText": "       ",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "Section": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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JobsDetail 的具体内容如下：

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息 Object

EventName 任务的类型，为 ReviewAudio String

节点名称（关
键字）

描述 类型

Code 错误码，只有 State为 Failed 时返回。详情请查看 错误码列表 。
Stri

ng

Message 错误描述，只有 State 为 Failed 时返回。
Stri

ng

JobId 本次音频审核任务的 ID。
Stri
ng

DataId 提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。
Stri

ng

State
音频审核任务的状态，值为 Submitted（已提交审核）、Success（审核成

功）、Failed（审核失败）、Auditing（审核中）其中一个。

Stri

ng

CreationTi
me

音频审核任务的创建时间。
Stri
ng

Object 本次审核的音频文件名称，创建任务使用 Object 时返回。
Stri

ng

Url 本次审核的音频文件链接，创建任务使用 Url 时返回。
Stri

ng

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审
核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告。

Stri
ng

SubLabel 该字段表示审核命中的具体子标签。注意：该字段可能返回空。
Stri

ng

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

AudioText 该字段用于返回音频文件识别出的对应文本内容。 Stri

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1049 共1950页

PornInfo，AdsInfo 的具体内容如下：

ng

PornInfo 审核场景为涉黄的审核结果信息。
Obj

ect

AdsInfo 审核场景为广告引导的审核结果信息。
Obj
ect

Section
当音频过长时，会对音频进行分段，该字段用于返回音频片段的审核结果，主要

包括开始时间和音频审核的相应结果。

Arr

ay

BucketId 创建的音频审核任务所属的存储桶名称。
Stri

ng

Region 存储桶所在的地域。
Stri
ng

ForbidStat

e

若您设置了自动冻结，该字段表示音频的冻结状态。0：未冻结，1：已被冻结，

2：已转移文件。

Inte

ger

CosHeade

rs

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 

结构，key 为自定义 Header 的名称，value 为内容。

Obj

ect

UserInfo 用户业务字段，创建任务未设置 UserInfo 时无此字段。
Obj

ect

ListInfo 账号黑白名单结果。
Obj

ect

节点名称（关

键字）
描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违

规内容。2：疑似为当前场景的违规内容。

Integ

er

Score 本次审核的结果分数，分数越高表示越敏感。
Integ
er

Category 该字段表示审核命中的具体审核类别。注意：该字段可能返回空。
Strin

g

SubLabel 该字段表示审核命中的具体子标签。注意：该字段可能返回空。
Strin

g

Label 本次审核的综合结果标签，如果命中了敏感关键词，该字段返回对应的关键词。
Strin
g
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Section 的具体内容如下：

Section 中的 PornInfo，AdsInfo 的具体内容如下：

节点名

称（关

键字）

描述 类型

Url

当前音频片段的访问地址，您可以通过该地址获取该音频片段的内容，地址格式为标准 

URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

Stri

ng

Text 该字段用于返回当前音频片段的 ASR 文本识别的检测结果。
Stri
ng

Offset

Time

该字段用于返回当前音频片段位于总音频中的时间，单位为毫秒，例如5000（音频开

始后5000毫秒）。

Inte

ger

Durati

on
当前音频片段的时长，单位毫秒。

Inte

ger

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结
果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：

正常，Porn：色情，Ads：广告。

Stri

ng

SubL
abel

该字段表示审核命中的具体子标签。注意：该字段可能返回空。
Stri
ng

Resul

t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

PornI

nfo
审核场景为涉黄的审核结果信息。

Obj

ect

AdsIn

fo
审核场景为广告引导的审核结果信息。

Obj

ect

节点名

称（关

键字）

描述 类型

HitFla

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内

容。2：疑似为当前场景的违规内容。

Integ

er

Score 该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100
（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情

Integ
er
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Container 节点 LibResults 的内容：

UserInfo 的内容：

99，表明该内容非常有可能属于色情内容。

Categ

ory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能为

空，表示未命中或暂无相关的类别。

Strin

g

Keywo

rds
本次审核命中的敏感关键词，没有时不返回。

Arra

y

LibRes

ults

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Cont

ainer 

Arra

y

节点名称（关键

字）
描述 类型

LibType 命中的风险库类型，取值为1（预设黑白库）和2（自定义风险库）。 Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri

ng
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否

Room 一般用于表示房间号信息，长度不超过128字节。
Stri

ng
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

Type 一般用于表示业务类型，长度不超过128字节。 Stri

ng

否

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。
Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri

ng
否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。
Intege

r

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewAudio",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "score": 9

       },
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       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/music.mp

       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewAudio",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:08+08:00",

    "Object": "1.mp3",

    "Result": 0,

    "AudioText": "       ",

    "PornInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Score": 0,

      "Label": ""

    },

    "Section": [

      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0
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        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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文本审核
文本文件审核
最近更新时间：2023-06-27 15:00:22

本接口用于进行文本文件审核，为异步请求方式，您可以通过本接口提交审核任务，然后通过查询文本审核任务接口

查询审核结果。

该接口支持情况如下：

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

支持审核腾讯云 COS 上的文本文件（仅支持 UTF8 编码和 GBK 编码的内容）。

支持审核第三方云存储厂商的文本文件 URL（仅支持 UTF8 编码和 GBK 编码的内容）。

支持设置回调地址 Callback 获取检测结果，或通过 查询文本审核任务结果接口  主动轮询获取审核结

果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

每个审核场景单独计费，例如您选择审核色情、广告两种场景，则审核1个文本，计2次审核费用。

调用接口会产生 文本审核费用  和 COS 读请求费用 。

如果文本属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的文本，如果需要审核此类型文本，请先 恢复归档文

件 。

限制说明

大小限制：文件不能超过1MB。

文件格式限制：无后缀限制，文件的内容需要是 UTF8 编码和 GBK 编码的。

接口默认并发数量：10。

字数限制：每 10000 个字符算一次，超出部分按多条计费。

语言支持：目前支持中文、中英混合、阿拉伯数字的检测。

推荐使用 SDK

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/56284
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/460/58119#.E6.96.87.E6.9C.AC.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

请求

请求示例

POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Object></Object>

    <Url></Url>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>

      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文本审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

节点名

称（关

键字）

父节点 描述 类型

是

否

必
选

Objec

t

Request.

Input

当前 COS 存储桶中的文本文件名称，例如在目录 test 中

的文件 test.txt，则文件名称为 test/test.txt，文本文件

仅支持 UTF8 编码和 GBK 编码的内容，且文件大小不得
超过1MB。

String 否

Url
Request.

Input

文本文件的完整链接，例如：

https://www.test.com/test.txt 。
String 否

DataI

d

Request.

Input

该字段在审核结果中会返回原始内容，长度限制为512字

节。您可以使用该字段对待审核的数据进行唯一业务标识。
String 否

UserI
nfo

Request.
Input

用户业务字段。
Conta
iner

否

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin
g

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否
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Container 类型 Conf 的具体数据描述如下：

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。 Strin
g

否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin
g

否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin
g

否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关

键字）
父节点 描述 类型

是否

必选

BizType
Request.
Conf

表示审核策略的唯一标识，您可以通过控制台上

的审核策略页面，配置您希望审核的场景，如色

情、广告、违法等，配置指引： 设置公共审核
策略 。您可以在控制台上获取到 BizType。

BizType 填写时，此条审核请求将按照该审核

策略中配置的场景进行审核。BizType 不填写

时，将自动使用默认的审核策略。

String 否

Callback
Request.

Conf

审核结果可以回调形式发送至您的回调地址，支

持以 http://  或者 https://  开头的地址，例

如： http://www.callback.com 。当 Input 

使用 Content 时，该参数不生效，结果会直接
返回。

String 否

CallbackV

ersion

Request.

Conf

回调内容的结构，有效值：Simple（回调内容

包含基本信息）、Detail（回调内容包含详细信
息）。默认为 Simple。

String 否
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员  咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

CallbackT

ype

Request.

Conf

回调片段类型，有效值：1（回调全部文本片

段）、2（回调违规文本片段）。默认为 1。

Integ

er

否

Freeze
Request.

Conf

可通过该字段，设置根据审核结果给出的不同分

值，对文本文件进行自动冻结，仅当 input  中

审核的文本为 object  时有效。

Conta

iner
否

节点名称
（关键

字）

父节点 描述 类型

是
否

必

选

PornSc

ore

Request.Conf

.Freeze

取值为[0,100]，表示当色情审核结果大于或等于
该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

Integ

er
否

AdsSco
re

Request.Conf
.Freeze

取值为[0,100]，表示当广告审核结果大于或等于
该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

Integ
er

否

IllegalS
core

Request.Conf
.Freeze

取值为[0,100]，表示当违法审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自
动冻结，默认值为空。

Integ
er

否

AbuseS

core

Request.Conf

.Freeze

取值为[0,100]，表示当谩骂审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自
动冻结，默认值为空。

Integ

er
否

响应

响应头

响应体

<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1060 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    <State></State>

    <CreationTime></CreationTime>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文本审核返回的具体响应内容。 Container

节点名称
（关键字）

父节点 描述 类型

JobsDetail
Respo

nse
文本审核任务的详细信息。

Contain

er

RequestId
Respo

nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问

题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述 类型

DataId
Response.Job

sDetail
请求中添加的唯一业务标识。

Stri

ng

JobId
Response.Job
sDetail

本次文本审核任务的 ID。
Stri
ng

State
Response.Job

sDetail

文本审核任务的状态，值为 Submitted（已提交审核）、

Success（审核成功）、Failed（审核失败）、Auditing
（审核中）其中一个。

Stri

ng

Creatio

nTime

Response.Job

sDetail
文本审核任务的创建时间。

Stri

ng

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Object>a.txt</Object>

    <DataId>123-fdrsg-123</DataID>

  </Input>

  <Conf>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

     <DataId>123-fdrsg-123</DataID>

     <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

     <State>Submitted</State>

     <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文本内容审核
最近更新时间：2023-06-27 15:00:22

本接口用于进行文本内容的直接审核，请求方式为同步请求。

该接口的支持情况如下：

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

说明

直接审核纯文本信息，需要先经过 base64 编码（仅支持 UTF8 编码）。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

每个审核场景单独计费，例如您选择审核色情、广告两种场景，则审核1条文本，计2次审核费用。

限制说明

长度限制：当审核的内容为纯文本信息，需要先经过 base64 编码，文本编码前的原文长度不能超过10000个 

UTF8 编码字符。

文本审核语言支持：目前支持中文、中英混合、阿拉伯数字的检测。

接口默认并发数量：100。

推荐使用 SDK

请求

请求示例

POST /text/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/56345
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Content></Content>

    <DataId></DataId>

  </Input>

  <Conf>

    <Callback></Callback>

    <CallbackVersion></CallbackVersion>

    <CallbackType></CallbackType>

    <BizType></BizType>

    <Freeze>

      <PornScore></PornScore>

    </Freeze>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文本审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 节点 UserInfo 的内容：

节点

名称
（关

键

字）

父节点 描述 类型 是否

必选

Cont

ent

Request.

Input

当传入的内容为纯文本信息，需要先经过 base64 编
码，文本编码前的原文长度不能超过 10000 个 UTF8 

编码字符。若超出长度限制，接口将会报错。

注意：目前支持中文、中英混合、阿拉伯数字的检测与

审核。如有其他语言需要，请 联系我们 。

String 否

Data

Id

Request.

Input

该字段在审核结果中会返回原始内容，长度限制为512

字节。您可以使用该字段对待审核的数据进行唯一业务

标识。

String 否

User

Info

Request.

Input
用户业务字段。

Contai

ner
否

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。
Strin

g
否

https://console.cloud.tencent.com/workorder/category?level1_id=83&level2_id=86&source=14&data_title=%E6%95%B0%E6%8D%AE%E4%B8%87%E8%B1%A1%20CI&step=1
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Container 类型 Conf 的具体数据描述如下：

Container 类型 Freeze 的具体数据描述如下：

Gender 一般用于表示性别信息，长度不超过128字节。 Strin

g

否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称
（关键字）

父节点 描述 类型
是否
必选

BizType
Request.

Conf

表示审核策略的唯一标识，您可以通过控制台上的

审核策略页面，配置您希望审核的场景，如色情、
广告、违法等，配置指引： 设置公共审核策略 。您

可以在控制台上获取到 BizType。BizType 填写

时，此条审核请求将按照该审核策略中配置的场景

进行审核。BizType 不填写时，将自动使用默认的

审核策略。

String 否

Callback
Request.

Conf

审核结果可以回调形式发送至您的回调地址，支持

以 http://  或者 https://  开头的地址，例如：

http://www.callback.com 。当 Input 使用 

Content 时，该参数不生效，结果会直接返回。

String 否

CallbackV

ersion

Request.

Conf

回调内容的结构，有效值：Simple（回调内容包含

基本信息）、Detail（回调内容包含详细信息）。
默认为 Simple。

String 否

CallbackT

ype

Request.

Conf

回调片段类型，有效值：1（回调全部文本片段）、

2（回调违规文本片段）。默认为 1。

Integ

er
否

Freeze
Request.

Conf

可通过该字段，设置根据审核结果给出的不同分

值，对文本文件进行自动冻结，仅当 input  中审

核的文本为 object 时有效。

Conta

iner
否

节点名称
（关键

字）

父节点 描述 类型

是

否
必

选

PornSc Request.Conf 取值为[0,100]，表示当色情审核结果大于或等于 Integ 否
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其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

ore .Freeze 该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

er

AdsSco
re

Request.Conf
.Freeze

取值为[0,100]，表示当广告审核结果大于或等于
该分数时，自动进行冻结操作。不填写则表示不自

动冻结，默认值为空。

Integ
er

否

IllegalS
core

Request.Conf
.Freeze

取值为[0,100]，表示当违法审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自
动冻结，默认值为空。

Integ
er

否

AbuseS

core

Request.Conf

.Freeze

取值为[0,100]，表示当谩骂审核结果大于或等于

该分数时，自动进行冻结操作。不填写则表示不自
动冻结，默认值为空。

Integ

er
否

响应

响应头

响应体

<Response>

  <JobsDetail>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Code>Success</Code>

    <Message>Success</Message>

    <SectionCount></SectionCount>

    <Result>1</Result>

    <PornInfo>

      <HitFlag></HitFlag>

      <Count></Count>

    </PornInfo>

    <Section>

      <StartByte></StartByte>

      <PornInfo>

        <HitFlag></HitFlag>

        <Score></Score>

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

        <Keywords></Keywords>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文本审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetail
Respon

se
文本审核的详细信息。

Contai

ner

RequestId
Respon
se

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问
题时，该 ID 能更快地协助定位问题。

String

节点名

称（关

键字）

父节点 描述 类型

Code
Response.Jo

bsDetail

错误码，只有 State 为 Failed 时返回，详情请查看 错误

码列表 。
String

DataId
Response.Jo

bsDetail
请求中添加的唯一业务标识。 String

Messa

ge

Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时返回。 String

JobId
Response.Jo
bsDetail

本次文本审核的任务ID。 String

Creati

onTim
e

Response.Jo

bsDetail
文本审核的创建时间。 String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

State Response.Jo

bsDetail

文本审核的状态，值为 Success（审核成功）或者 Failed

（审核失败）。

String

Conte

nt

Response.Jo

bsDetail
文本内容的 Base64 编码。 String

Label
Response.Jo

bsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对不

同违规类型与建议值进行处理。 返回值：Normal：正常，

Porn：色情，Ads：广告，以及其他不安全或不适宜的类

型。

String

Result
Response.Jo

bsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进行

后续的操作；建议您按照业务所需，对不同的审核结果进行

相应处理。有效值：0（审核正常），1 （判定为违规敏感文
件），2（疑似敏感，建议人工复核）。

Integ

er

Sectio

nCoun
t

Response.Jo

bsDetail
审核的文本内容分片数，固定为1。

Integ

er

PornIn

fo

Response.Jo

bsDetail
审核场景为色情的审核结果信息。

Conta

iner

AdsInf

o

Response.Jo

bsDetail
审核场景为广告的审核结果信息。

Conta

iner

IllegalI
nfo

Response.Jo
bsDetail

审核场景为违法的审核结果信息。
Conta
iner

AbuseI

nfo

Response.Jo

bsDetail
审核场景为谩骂的审核结果信息。

Conta

iner

Sectio

n

Response.Jo

bsDetail
文本审核的具体结果信息。

Conta

iner 

Array

UserIn
fo

Response.Jo
bsDetail

用户业务字段。
Conta
iner

ListInf

o

Response.Jo

bsDetail
账号黑白名单结果。

Conta

iner

节点名称
（关键

父节点 描述 类型
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Container 节点 Section 的内容：

字）

HitFlag
Response.Jobs

Detail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。
1：确认为当前场景的违规内容。2：疑似为当前场景的

违规内容。

Integ

er

Count
Response.Jobs
Detail.*Info

命中该审核分类的分片数。
Integ
er

节点名称

（关键

字）

父节点 描述 类型

StartBy

te

Resp
onse.

Jobs

Detail

.Secti
on

该分片位于文本中的起始位置信息（即10代表第11个utf8文字）。

从0开始。

Integ

er

Label

Resp

onse.
Jobs

Detail

.Secti

on

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模
型推荐的审核结果，建议您按照业务所需，对不同违规类型与建议值

进行处理。 返回值：Normal：正常，Porn：色情，Ads：广告，

以及其他不安全或不适宜的类型。

String

Result

Resp

onse.

Jobs

Detail
.Secti

on

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操

作；建议您按照业务所需，对不同的审核结果进行相应处理。有效

值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建
议人工复核）。

Integ

er

PornInf

o

Resp

onse.
Jobs

Detail

.Secti

on

审核场景为色情的审核结果信息。
Conta

iner

AdsInfo Resp

onse.

Jobs
Detail

审核场景为广告的审核结果信息。 Conta

iner



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1070 共1950页

Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

Container 节点 LibResults 的内容：

.Secti

on

IllegalIn

fo

Resp
onse.

Jobs

Detail

.Secti
on

审核场景为违法的审核结果信息。
Conta

iner

AbuseI

nfo

Resp

onse.
Jobs

Detail

.Secti

on

审核场景为谩骂的审核结果信息。
Conta

iner

节点名

称（关
键字）

父节点 描述 类型

HitFlag

Response.J

obsDetail.Se
ction.*Info

用于返回该审核场景的审核结果，返回值：0：正常。1：

确认为当前场景的违规内容。2：疑似为当前场景的违规内
容。

Integer

Score

Response.J

obsDetail.Se

ction.*Info

该分片中审核的结果分数，分数越高表示越敏感。 Integer

Keywo

rds

Response.J

obsDetail.Se

ction.*Info

在当前审核场景下命中的关键词，多关键词以 , 分隔。 String

LibRes

ults

Response.J

obsDetail.Se

ction.*Info

该字段用于返回基于风险库识别的结果。注意：未命中风

险库中样本时，此字段不返回。

Contain

er Array

SubLa

bel

Response.J

obsDetail.Se

ction.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签。注意：该字段可能返回空，表示

未命中具体的子标签

String

节点名称 父节点 描述 类型
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Container 节点 UserInfo 的内容：

（关键字）

LibType

Response.JobsDetail.

Section.*Info.LibResult
s

命中的风险库类型，取值为1（预设黑白

库）和2（自定义风险库）。
Integer

LibName

Response.JobsDetail.

Section.*Info.LibResult

s

命中的风险库名称。 String

Keyword

s

Response.JobsDetail.

Section.*Info.LibResult

s

命中的库中关键词。该参数可能会有多个返

回值，代表命中的多个关键词。

String 

Array

节点名称（关键字） 描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri

ng
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri

ng
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否

Room 一般用于表示房间号信息，长度不超过128字节。
Stri

ng
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否

Type 一般用于表示业务类型，长度不超过128字节。
Stri

ng
否

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。
Stri

ng
否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri

ng
否

Level 一般用于表示等级信息，长度不超过128字节。 Stri

ng

否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Role 一般用于表示角色信息，长度不超过128字节。
Stri

ng
否

节点名称（关键字） 父节点 描述 类型

ListResults
Response.JobsDetail.ListI

nfo
命中的所有名单结果。

Container 

Array

节点名称（关
键字）

父节点 描述 类型

ListType
Response.JobsDetail.ListIn

fo.ListResults

命中的名单类型，取值为0（白名单）

和1（黑名单）。

Integ

er

ListName
Response.JobsDetail.ListIn

fo.ListResults
命中的名单名称。

Strin

g

Entity
Response.JobsDetail.ListIn
fo.ListResults

命中了名单中的哪条内容。
Strin
g

错误码

实际案例

请求

POST /text/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Content>54uZ5Ye75omL</Content>

  </Input>

  <Conf>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <Content>54uZ5Ye75omL</Content>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>2</Result>

    <PornInfo>

      <HitFlag>0</HitFlag>

      <Count>0</Count>

    </PornInfo>

    <Section>

      <StartByte>0</StartByte>

      <Label>Illegal</Label>

      <Result>2</Result>

      <PornInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

        <Keywords/>

      </PornInfo>

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1074 共1950页

查询文本审核任务结果
最近更新时间：2023-06-21 10:22:02

DescribeAuditingTextJob 接口用于查询指定的文本审核任务。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口， 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 文本审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /text/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Object></Object>

    <SectionCount></SectionCount>

    <Result>1</Result>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <IllegalInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </IllegalInfo>

    <AbuseInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AbuseInfo>

    </Section>

        <StartByte></StartByte>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>

    </Section>

        <StartByte></StartByte>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型
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Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

Response 无 保存结果的容器。 Container

节点名称（关
键字）

父节点 描述 类型

JobsDetail
Respon

se
任务的详细信息。

Conta

iner

RequestId
Respon

se

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问

题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述 类型

Code
Response.Job

sDetail

错误码，只有 State 为 Failed 时返回，详情请查看 错

误码列表 。
String

Messag
e

Response.Job
sDetail

错误描述，只有 State 为 Failed 时返回。 String

DataId
Response.Job

sDetail

该字段在审核结果中会返回原始内容，长度限制为512字

节。您可以使用该字段对待审核的数据进行唯一业务标
识。

String

JobId
Response.Job

sDetail
本次审核任务的 ID。 String

State
Response.Job

sDetail

任务的状态，值为 Submitted（已提交审核）、

Success（审核成功）、Failed（审核失败）、

Auditing（审核中）其中一个。

String

Creatio

nTime

Response.Job

sDetail
任务的创建时间。 String

Object
Response.Job

sDetail
审核的对象名称，当创建任务使用 Object 时返回。 String

Content
Response.Job

sDetail

文本内容的 Base64 编码。当创建任务使用 Content 

时返回。
String

Section

Count

Response.Job

sDetail

文本审核会将文本进行分段送审，每10000个 utf8 编码

字符分一段，该参数表示分段的数量。

Intege

r

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo 的内容：

Label Response.Job

sDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对
不同违规类型与建议值进行处理。 返回值：Normal：

正常，Porn：色情，Ads：广告，以及其他不安全或不

适宜的类型。

String

Result
Response.Job

sDetail

该字段表示本次判定的审核结果，您可以根据该结果，进

行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违

规敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

PornInf

o

Response.Job

sDetail
审核场景为色情的审核结果信息。

Contai

ner

AdsInfo
Response.Job
sDetail

审核场景为广告的审核结果信息。
Contai
ner

IllegalIn

fo

Response.Job

sDetail
审核场景为违法的审核结果信息。

Contai

ner

AbuseI

nfo

Response.Job

sDetail
审核场景为谩骂的审核结果信息。

Contai

ner

Section
Response.Job
sDetail

具体文本分片的审核结果信息。
Contai
ner 

Array

UserInf

o

Response.Job

sDetail
用户业务字段。

Contai

ner

ListInfo
Response.Job

sDetail
账号黑白名单结果。

Contai

ner

ForbidS

tate

Response.Job

sDetail

若您设置了自动冻结，该字段表示文本文件的冻结状态。

0：未冻结，1：已被冻结，2：已转移文件。

Intege

r

节点名称

（关键

字）

父节点 描述 类型

HitFlag
Response.Jobs

Detail.*Info

用于返回该审核场景的审核结果，返回值：0：正常。

1：确认为当前场景的违规内容。2：疑似为当前场景的

违规内容。

Strin

g

Count Response.Jobs 命中该审核分类的分片数。 Integ
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Container 节点 Section 的内容：

Container 节点 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的内容：

Detail.*Info er

节点名称

（关键

字）

父节点 描述 类型

StartByt

e

Response.JobsDe

tail.Section

该分片位于文本中的起始位置信息（即10代表第11

个utf8文字）。从0开始。

Integ

er

Label
Response.JobsDe

tail.Section

该字段用于返回检测结果中所对应的优先级最高的恶
意标签，表示模型推荐的审核结果，建议您按照业务

所需，对不同违规类型与建议值进行处理。 返回

值：Normal：正常，Porn：色情，Ads：广告，

以及其他不安全或不适宜的类型。

String

Result
Response.JobsDe

tail.Section

该字段表示本次判定的审核结果，您可以根据该结

果，进行后续的操作；建议您按照业务所需，对不同

的审核结果进行相应处理。有效值：0（审核正
常），1 （判定为违规敏感文件），2（疑似敏感，

建议人工复核）。

Integ

er

PornInfo
Response.JobsDe

tail.Section
审核场景为色情的审核结果信息。

Conta

iner

AdsInfo
Response.JobsDe

tail.Section
审核场景为广告的审核结果信息。

Conta

iner

IllegalInf

o

Response.JobsDe

tail.Section
审核场景为违法的审核结果信息。

Conta

iner

AbuseInf

o

Response.JobsDe

tail.Section
审核场景为谩骂的审核结果信息。

Conta

iner

节点名
称（关

键字）

父节点 描述 类型

HitFla
g

Response.JobsDetail
.*Info

用于返回该审核场景的审核结果，返回值：0：
正常。1：确认为当前场景的违规内容。2：疑似

为当前场景的违规内容。

String

Score Response.JobsDetail

.Section.*Info

该分片中审核的结果分数，分数越高表示越敏

感。

Integer
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

Keyw

ords

Response.JobsDetail

.Section.*Info
在当前审核场景下命中的关键词，多关键词以 ,

分隔。
String

LibRe

sults

Response.JobsDetail

.Section.*Info

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Contain

er Array

SubL
abel

Response.JobsDetail
.Section.*Info

该字段表示审核命中的具体子标签，例如：

Porn 下的 SexBehavior 子标签。
注意：该字段可能返回空，表示未命中具体的子

标签。

String

节点名称

（关键字）
父节点 描述 类型

LibType

Response.JobsDetail.

Section.*Info.LibResult

s

命中的风险库类型，取值为1（预设风险库）

和2（自定义风险库）。

Integ

er

LibName
Response.JobsDetail.
Section.*Info.LibResult

s

命中的风险库名称。
Strin

g

Keywords
Response.JobsDetail.
Section.*Info.LibResult

s

命中的库中关键词。该参数可能会有多个返回

值，代表命中的多个关键词。

Strin
g 

Arra

y

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Stri

ng
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Stri
ng

否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Stri

ng
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Stri

ng
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

Room 一般用于表示房间号信息，长度不超过128字节。 Stri

ng

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Stri

ng
否

Type 一般用于表示业务类型，长度不超过128字节。
Stri

ng
否

ReceiveTokenId 一般用于表示接收消息的用户账号，长度不超过128字节。
Stri
ng

否

Gender 一般用于表示性别信息，长度不超过128字节。
Stri

ng
否

Level 一般用于表示等级信息，长度不超过128字节。
Stri

ng
否

Role 一般用于表示角色信息，长度不超过128字节。
Stri
ng

否

节点名称（关键字） 父节点 描述 类型

ListResults
Response.JobsDetail.ListI

nfo
命中的所有名单结果。

Container 

Array

节点名称（关
键字）

父节点 描述 类型

ListType
Response.JobsDetail.ListI

nfo.ListResults

命中的名单类型，取值为0（白名单）

和1（黑名单）。

Integ

er

ListName
Response.JobsDetail.ListI

nfo.ListResults
命中的名单名称。

Strin

g

Entity
Response.JobsDetail.ListI
nfo.ListResults

命中了名单中的哪条内容。
Strin
g

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
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请求

GET /text/auditing/stb1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>st78925397b9de11eba532525400946f76</JobId>

    <State>Success</State>

    <CreationTime>2021-05-21T10:44:32+08:00</CreationTime>

    <Object>test.txt</Object>

    <SectionCount>1</SectionCount>

    <Label>Illegal</Label>

    <Result>1</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <IllegalInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </IllegalInfo>

    <AbuseInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AbuseInfo>

    <Section>
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        <StartByte>0</StartByte>

        <Label>Illegal</Label>

        <Result>1</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </AdsInfo>

        <IllegalInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </IllegalInfo>

        <AbuseInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Keywords></Keywords>

        </AbuseInfo>

    </Section>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文本审核回调内容
最近更新时间：2022-08-03 15:01:34

若您配置了审核回调地址，在文本审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

data的具体内容如下：

回调内容说明

简洁回调（Simple）

{

   "code": 0,

   "data": {

       "forbidden_status": 0,

       "event": "ReviewText",

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名

称
描述 类型

是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内容审
核错误码 。

Integ
er

是

mess

age
错误描述。

Strin

g
是

data 文本审核结果的详细信息。
Obje

ct
是

参数名称 描述 类型 是否

必选

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

trace_id
唯一 ID 标识。如果是通过接口创建的异步任务，则为接口返回的 

JobId。
String 是

url 被审核文本的完整 URL 链接。 String 是

event 触发的事件，此处固定为 ReviewText。 String 是

result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的

操作；建议您按照业务所需，对不同的审核结果进行相应处理。有
效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏

感，建议人工复核）。

Integ
er

是

forbidden

_status

若您设置了自动冻结，该字段表示文本的冻结状态。0：未冻结，

1：已被冻结，2：已转移文件。

Integ

er
是

cos_head

ers
资源上传时设置的自定义 header 内容，若未设置则不返回。

Objec

t
否

porn_info 审核场景为涉黄的审核结果信息。
Objec

t
否

ads_info 审核场景为广告引导的审核结果信息。
Objec

t
否

abuse_inf

o
审核场景为谩骂的审核结果信息。

Objec

t
否

illegal_inf

o
审核场景为违法的审核结果信息。

Objec

t
否

data_id
提交任务时设置了DataId参数时返回，返回原始内容，长度限制为

512字节。
String 否

参数
名称

描述 类型
是否
必选

hit_

flag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的

违规内容。2：疑似为当前场景的违规内容。

Integ

er
是

labe

l
命中的关键字。

Strin

g
是

cou
nt

命中该审核分类的敏感文本段数。
Integ
er

是
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

详细回调（Detail）

{

  "EventName": "ReviewText",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",

    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SectionCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "IllegalInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AbuseInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Section": [

      {

        "StartByte": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "IllegalInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""
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具体的数据内容如下：

JobsDetail 的具体内容如下：

        },

        "AbuseInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

    ],

    "BucketId": "",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewText 。 String

节点名称

（关键

字）

描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。 String

Messag

e
错误描述，只有 State 为 Failed 时返回。 String

JobId 本次文本审核任务的 ID。 String

DataId 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。 String

State 审核任务的状态，值为 Submitted（已提交审核）、Success（审核成 String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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功）、Failed（审核失败）、Auditing（审核中）其中一个。

Creation
Time

审核任务的创建时间。 String

Object 被审核的文本文件的名称，创建任务使用 Object 时返回。 String

Content 本次审核的文本内容的 Base64编码，当创建任务使用 Content 时返回。 String

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，Illegal：违法，Abuse：谩

骂。

String

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

IllegalInf

o
审核场景为违法的审核结果信息。 Object

AbuseInf
o

审核场景为谩骂的审核结果信息。 Object

Section

Count

文本审核会将文本进行分段送审，每10000个 utf8 编码字符分一段，该参数表

示分段的数量。

Intege

r

Section 文本内容每一段的审核结果。 Array

BucketI

d
创建的审核任务所属的存储桶名称。 String

Region 存储桶所在的地域。 String

ForbidSt

ate

若您设置了自动冻结，该字段表示文本的冻结状态。0：未冻结，1：已被冻

结，2：已转移文件。

Intege

r

CosHea

ders

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 

结构，key 为自定义 Header 的名称，value 为内容。
Object

UserInfo 用户业务字段。
Contai
ner

ListInfo 账号黑白名单结果。 Contai

ner
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PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的具体内容如下：

Section 的具体内容如下：

Section 中的 PornInfo，AdsInfo，IllegalInfo，AbuseInfo 的具体内容如下：

节点名称（关
键字）

描述 类型

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违

规内容。2：疑似为当前场景的违规内容。

Integ

er

Count 命中该审核分类的文本段数。
Integ

er

节点名

称（关

键字）

描述 类型

Start

Byte
该分片位于文本中的起始位置信息（即10代表第11个utf8文字）。从0开始。

Inte

ger

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结
果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：

正常，Porn：色情，Ads：广告，Illegal：违法，Abuse：谩骂。

Stri

ng

Resul
t

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业
务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Inte
ger

PornI

nfo
审核场景为涉黄的审核结果信息。

Obj

ect

AdsIn

fo
审核场景为广告引导的审核结果信息。

Obj

ect

Illegal

Info
审核场景为违法的审核结果信息。

Obj

ect

Abus

eInfo
审核场景为谩骂的审核结果信息。

Obj

ect

节点名称
（关键

字）

描述 类型
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

HitFlag 用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景
的违规内容。2：疑似为当前场景的违规内容。

Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信
息。通常[0,60]分可以认为图片属于正常，[61,90]分表示图片疑似敏感，

[91,100]分表示图片为敏感的。例如：色情 99，则表明该内容非常有可能

属于色情内容。

Integer

Keyword
s

在当前审核场景下命中的关键词，多关键词以 , 分割。 String

LibResul

ts

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此

字段不返回。

Container 

Array

SubLabe

l

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子

标签。注意：该字段可能返回空，表示未命中具体的子标签。
String

节点名称（关键

字）
描述 类型

LibType 命中的风险库类型，取值为1（预设黑白库）和2（自定义风险库）。 Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin
g

否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin
g

否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1092 共1950页

Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

Room 一般用于表示房间号信息，长度不超过128字节。 Strin

g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewText",

       "forbidden_status": 0,
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       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "ixzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.txt",

       "cos_headers": {

           "x-cos-meta-id": "xxxxxx"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewText",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:08+08:00",

    "Object": "1.txt",

    "Label": "Normal",

    "Result": 0,

    "SectionCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Section": [

      {

        "StartByte": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""
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        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}
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文本审核结果反馈
最近更新时间：2022-07-06 17:57:15

您可通过本接口反馈与预期不符的审核结果，例如色情文本被审核判定为正常或正常文本被判定为色情时可通过该接

口直接反馈。

本接口不会直接修改审核结果，您反馈的错误审核结果将在后台进行确认，并在后续的审核任务中生效。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

推荐使用 SDK

请求

请求示例

POST /report/badcase HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <ContentType></ContentType>

    <JobId></JobId>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

    <ModerationTime></ModerationTime>

    <Text></Text>

    <SuggestedLabel></SuggestedLabel>

    <Label></Label>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 反馈审核错误的具体参数 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

ContentTy
pe

Reque
st

需要反馈的数据类型，错误文本样本取值为1。
Integ
er

是

Text
Reque

st

文本类型的样本，需要填写 base64 的文本内容，

ContentType 为1时必填。

Strin

g
否

Label
Reque

st
数据万象审核判定的审核结果标签，例如 Porn。

Strin

g
是

Suggested
Label

Reque
st

您自己期望的正确审核结果的标签，例如期望是正
常，则填 Normal。

Strin
g

是

JobId
Reque

st

该数据样本对应的审核任务 ID，有助于定位审核记

录。

Strin

g
否

Moderatio

nTime

Reque

st

该数据样本之前审核的时间，有助于定位审核记录。 

格式为 2021-08-07T12:12:12+08:00

Strin

g
否

响应

响应头

响应体

<Response>

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1097 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 返回的具体响应内容 Container

节点名称（关

键字）
父节点 描述 类型

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题

时，该 ID 能更快地协助定位问题

Stri

ng

错误码

实际案例

请求

POST /report/badcase HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1********&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 66

Content-Type: application/xml

<Request>

    <ContentType>1</ContentType>

    <Text>6L+Z5piv5Li65LuA5LmI</Text>

    <Label>Porn</Label>

    <SuggestedLabel>Normal</SuggestedLabel>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 May 2022 12:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文档审核

提交文档审核任务
最近更新时间：2023-06-27 15:00:23

本接口用于提交一个文档审核任务。文档审核功能为异步任务方式，您可以通过提交文档审核任务审核您的文档文

件，然后通过 查询文档审核任务接口  或 文档审核回调  查询审核结果。

文档审核费用包含：

功能描述

说明

支持审核腾讯云 COS 上的文档文件。

支持审核第三方云存储厂商的文档 URL。

支持对文档文件进行自动检测，通过将文档页面转换截图，从 OCR 文本识别、图像识别维度，利用深度学习技

术，识别文档中的违规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询文档审核任务结果接口  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

费用说明

文档页面审核：基于文档转图片能力，将文档按页面转换为多张图片进行审核，再通过图片 OCR 技术识别其中

的文字内容，审核费用与图片审核一致。

文档转图片：会产生相应的 文档转图片费用 。

每个审核场景单独计费，例如您选择审核色情、广告两种场景，则审核1篇文档，计2次审核费用。

调用接口会产生 图片审核费用 和 COS 读请求费用 。

如果文档文件属于 COS 上的低频存储类型，调用审核会产生 COS 低频数据取回费用 。

不支持审核 COS 上的归档存储类型和深度归档存储类型的文档，如果需要审核此类型文档，请先 恢复归档文

件 。

限制说明

接口默认并发数量：10。

大小页数限制：文档大小限制在200MB之内，页数限制在5000页之内。

目前支持审核的文档文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

https://cloud.tencent.com/document/product/460/59383
https://cloud.tencent.com/document/product/460/62385
https://cloud.tencent.com/document/product/460/59383
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/460/58121#.E6.96.87.E6.A1.A3.E5.A4.84.E7.90.86.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/460/58119#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
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数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。（表格文件，一张表可能

分割为多页转换，生成多张图片）

PDF 文件。

其他格式文件：txt、log、htm、html、lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 

prg、 cmd、 rtf、 xml。

推荐使用 SDK

请求

请求示例

POST /document/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

      <Input>

         <Url></Url>

         <Type></Type>

         <DataId></DataId>

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

      </Input>

      <Conf>

         <Callback></Callback>

         <BizType></BizType>

      </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 文档审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的内容。 Container 是

Conf Request 审核规则配置。 Container 是

节点名称

（关键

字）

父节点 描述 类型
是否

必选

Object
Request.I

nput

存储在 COS 存储桶中的文件名称，例如在目录 

test 中的文件 test.doc，则文件名称为 

test/test.doc。Object 和 Url 只能选择其中一

种。

String 否

Url
Request.I

nput

文档文件的链接地址，例如 

http://www.example.com/doctest.doc，

Object 和 Url 只能选择其中一种。

String 否

Type
Request.I

nput

指定文档文件的类型，如未指定则默认以文件的后缀

为类型。

如果文件没有后缀，该字段必须指定，否则会审核失

败。例如：doc、docx、ppt、pptx 等。

String 否

DataId
Request.I

nput

该字段在审核结果中会返回原始内容，长度限制为

512字节。您可以使用该字段对待审核的数据进行唯

一业务标识。

String 否

UserInf Request.I 用户业务字段。 Conta 否



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1102 共1950页

Container 节点 UserInfo 的内容：

Container 类型 Conf 的具体数据描述如下：

o nput iner

节点名称（关键

字）
父节点 描述

类

型

是否

必选

TokenId
Request.Input.

UserInfo

用户业务 TokenId，长度不超过128字

节。

Str

ing
否

Nickname
Request.Input.
UserInfo

用户业务 Nickname，长度不超过128
字节。

Str
ing

否

DeviceId
Request.Input.

UserInfo

用户业务 DeviceId，长度不超过128字

节。

Str

ing
否

AppId
Request.Input.

UserInfo

用户业务 AppId，长度不超过128字

节。

Str

ing
否

Room
Request.Input.
UserInfo

用户业务 Room，长度不超过128字
节。

Str
ing

否

IP
Request.Input.

UserInfo
用户业务 IP，长度不超过128字节。

Str

ing
否

Type
Request.Input.

UserInfo
用户业务 Type，长度不超过128字节。

Str

ing
否

ReceiveToke
nId

Request.Input.
UserInfo

用户业务 ReceiveTokenId，长度不超
过128字节。

Str
ing

否

Gender
Request.Input.

UserInfo

用户业务 Gender，长度不超过128字

节。

Str

ing
否

Level
Request.Input.

UserInfo
用户业务 Level，长度不超过128字节。

Str

ing
否

Role
Request.Input.
UserInfo

用户业务 Role，长度不超过128字节。
Str
ing

否

节点名称

（关键字）
父节点 描述 类型

是否

必选

BizType Request.

Conf

表示审核策略的唯一标识，您可以通过控制台上的审

核策略页面，配置您希望审核的场景，如色情、广

Strin

g

否
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Container 类型 Freeze 的具体数据描述如下：

其他审核场景的冻结参数，请 联系服务人员 咨询。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

告、违法违规等，配置指引： 设置公共审核策略 。

您可以在控制台上获取到 BizType。BizType 填写

时，此条审核请求将按照该审核策略中配置的场景进
行审核。

BizType 不填写时，将自动使用默认的审核策略。

Callback
Request.
Conf

审核结果可以回调形式发送至您的回调地址，支持以 

http://  或者 https://  开头的地址，例如：

http://www.callback.com 。

Strin
g

否

Callback

Type

Request.

Conf

回调片段类型，有效值：1（回调全部分页）、2（回

调违规分页）。默认为 1。

Integ

er
否

Freeze
Request.

Conf

可通过该字段，设置根据审核结果给出的不同分值，

对文档进行自动冻结。仅当 input  中审核的文档为 

object  时有效。

Cont

ainer
否

节点名称
（关键

字）

父节点 描述 类型
是否

必选

PornSc
ore

Request.Conf.
Freeze

取值为[0,100]，表示当色情审核结果大于或等
于该分数时，自动进行冻结操作。不填写则表示

不自动冻结，默认值为空。

Inte
ger

否

AdsSco
re

Request.Conf.
Freeze

取值为[0,100]，表示当广告审核结果大于或等

于该分数时，自动进行冻结操作。不填写则表示
不自动冻结，默认值为空。

Inte
ger

否

响应

响应头

响应体

<Request>

    <JobsDetail>

       <DataId></DataId>

https://cloud.tencent.com/online-service?from=ticket-tab
https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1104 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

       <JobId></JobId>

       <State></State>

       <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Request>

节点名称（关键字） 父节点 描述 类型

Response 无 提交文档审核任务返回的具体响应内容。 Container

节点名称（关
键字）

父节点 描述 类型

JobsDetail
Respo

nse
文档审核任务的详细信息。

Conta

iner

RequestId
Respo

nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问

题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述 类型

DataId
Response.Jo

bsDetail
请求中添加的唯一业务标识。

Strin

g

JobId
Response.Jo
bsDetail

本次文档审核任务的 ID。
Strin
g

State
Response.Jo

bsDetail

文档审核任务的状态，值为 Submitted（已提交审核）、

Success（审核成功）、Failed（审核失败）、Auditing
（审核中）其中一个。

Strin

g

Creatio

nTime

Response.Jo

bsDetail
文档审核任务的创建时间。

Strin

g

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

POST /document/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

      <Input>

         <Url>http://www.example.com/doctest.doc</Url>

         <DataId>123-fdrsg-123</DataID>

      </Input>

      <Conf>

         <DetectType>Porn,Ads</DetectType>

         <Callback></Callback>

         <BizType>b81d45f94b91a683255e9a9506f4****</BizType>

      </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <DataId>123-fdrsg-123</DataID>

        <JobId>vab1ca9fc8a3ed11ea834c52540086****</JobId>

        <State>Submitted</State>

        <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询文档审核任务结果
最近更新时间：2023-06-20 17:32:13

本接口用于查询指定的文档审核任务结果。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 文档审核任务结果保存时效为1个月，您可通过本接口查询近1个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /document/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <JobsDetail>

      <JobId>aab1ca9fc8a3ed11ea834c525400863904</JobId>

      <State>Success</State>

      <Code>Success</Code>

      <Message>Success</Message>

      <DataId></DataId>

      <Suggestion>1</Suggestion>

      <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

      <Url>http://www.test.com/123</Url>

      <PageCount>3</PageCount>

      <Labels>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Score>96</Score>

        </PornInfo>

      </Labels>

      <PageSegment>

        <Results>

          <Url></Url>

          <Text></Text>

          <PageNumber>1</PageNumber>

          <SheetNumber>1</SheetNumber>

          <PornInfo>

            <HitFlag></HitFlag>

            <SubLabel></SubLabel>

            <Score></Score>

            <OcrResults>

              <Text></Text>

              <Keywords></Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

      </PageSegment>

    </JobsDetail>

    <RequestId></RequestId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 文档审核的全部信息。 Container

节点名称（关
键字）

父节点 描述 类型

JobsDetail
Respo

nse
文档审核任务的详细信息。

Contai

ner

RequestId
Respo

nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问

题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail

错误码，只有 State 为 Failed 时返回，详情请查看 错

误码列表 。
String

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时返回。 String

DataId
Response.J

obsDetail

该字段在审核结果中会返回原始内容，长度限制为512字

节。您可以使用该字段对待审核的数据进行唯一业务标

识。

String

JobId
Response.J

obsDetail
文档审核任务的 ID。 String

State
Response.J

obsDetail

任务的状态，值为 Submitted（已提交审核）、
Success（审核成功）、Failed（审核失败）、

Auditing（审核中）其中一个。

String

Suggestio

n

Response.J

obsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进
行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

Label Response.J 该字段用于返回检测结果中所对应的优先级最高的恶意标 String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 Labels 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

obsDetail 签，表示模型推荐的审核结果，建议您按照业务所需，对

不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告，以及其他不安全或不适

宜的类型。

CreationT

ime

Response.J

obsDetail
任务的创建时间。 String

Object
Response.J
obsDetail

审核的文件为存储在 COS 中的文件时，该字段表示本次
审核的文件名称。

String

Url
Response.J

obsDetail
审核的文件链接，创建任务使用 Url 时返回。 String

PageCou

nt

Response.J

obsDetail

文档审核会将文档转换为图片进行审核，该字段表示转换

的图片总数量。

Intege

r

Labels
Response.J
obsDetail

该字段用于返回命中的审核场景及对应的结果。
Contai
ner

PageSeg

ment

Response.J

obsDetail
文档转换为图片后，具体每张图片的审核结果信息。

Contai

ner

UserInfo
Response.J

obsDetail

用户业务字段。创建任务时未设置 UserInfo 则无此字

段。

Contai

ner

ListInfo
Response.J
obsDetail

账号黑白名单结果。
Contai
ner

ForbidSta

te

Response.J

obsDetail

若您设置了自动冻结，该字段表示文档的冻结状态。0：

未冻结，1：已被冻结，2：已转移文件。

Intege

r

节点名称（关键字） 父节点 描述 类型

PornInfo
Response.JobsDetail.L

abels

审核场景为色情的审核结果信

息。

Contain

er

AdsInfo
Response.JobsDetail.L
abels

审核场景为广告的审核结果信
息。

Contain
er

节点名

称（关

键字）

父节点 描述 类型
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Container 节点 PageSegment 的内容：

Container 节点 Results 的内容：

HitFla
g

Response.JobsDetail.
Labels.*Info

用于返回该审核场景的审核结果，返回值：0：正常
1：确认为当前场景的违规内容2：疑似为当前场景的

违规内容。

Inte
ger

Score
Response.JobsDetail.

Labels.*Info

该字段表示审核结果命中审核信息的置信度，取值范
围：0（置信度最低）-100（置信度最高 ），越高代

表该内容越有可能属于当前返回审核信息。例如：色

情 99，表明该内容非常有可能属于色情内容。

Inte

ger

节点名称（关

键字）
父节点 描述 类型

Results
Response.JobsDetail.Pag

eSegment

文档转换为图片后，每张图片

的详细审核结果信息。

Container 

Array

节点名称

（关键字）
父节点 描述 类型

Url

Response.Jo

bsDetail.Pag

eSegment.R

esults

文档转换成图片后，您可以通过该地址查看该图片内

容，地址格式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需

查看，请重新发起查询请求。

String

Text

Response.Jo

bsDetail.Pag

eSegment.R

esults

该字段用于返回当前图片 OCR 文本识别的检测结果，

仅在审核策略开启文本内容检测时返回。
String

PageNum

ber

Response.Jo

bsDetail.Pag

eSegment.R
esults

该图片的页码，通常是文档的页码。 Integer

SheetNu

mber

Response.Jo

bsDetail.Pag

eSegment.R
esults

如果审核的为表格文件，该字段表示表格内的 Sheet 

页码。
Integer

Label Response.Jo

bsDetail.Pag
eSegment.R

esults

该字段用于返回检测结果中所对应的优先级最高的恶意

标签，表示模型推荐的审核结果，建议您按照业务所
需，对不同违规类型与建议值进行处理。返回值：

String
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Container 节点 PornInfo，AdsInfo 的内容：

Normal：正常，Porn：色情，Ads：广告，以及其

他不安全或不适宜的类型。

Suggesti

on

Response.Jo

bsDetail.Pag

eSegment.R
esults

该字段表示本次判定的审核结果，您可以根据该结果，

进行后续的操作；建议您按照业务所需，对不同的审核

结果进行相应处理。有效值：0（审核正常），1 （判
定为违规敏感文件），2（疑似敏感，建议人工复

核）。

Integer

PornInfo

Response.Jo
bsDetail.Pag

eSegment.R

esults

审核场景为色情的审核结果信息。
Contain

er

AdsInfo

Response.Jo
bsDetail.Pag

eSegment.R

esults

审核场景为广告的审核结果信息。
Contain

er

节点名

称（关
键字）

父节点 描述 类型

HitFlag

Response.Jo

bsDetail.Pag

eSegment.Re
sults.*Info

用于返回该审核场景的审核结果，返回值：0：正常1：

确认为当前场景的违规内容2：疑似为当前场景的违规
内容。

Integer

Categ
ory

Response.Jo

bsDetail.Pag
eSegment.Re

sults.*Info

表示命中的具体审核类别。例如 Sexy，表示色情标签

中的性感类别。该字段可能为空，表示未命中或暂无相
关的类别。

注意：该字段可能返回空。

String

SubLa
bel

Response.Jo

bsDetail.Pag
eSegment.Re

sults.*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 
SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。

String

Score

Response.Jo
bsDetail.Pag

eSegment.Re

sults.*Info

该字段表示审核结果命中审核信息的置信度，取值范
围：0（置信度最低）-100（置信度最高 ），越高代表

该内容越有可能属于当前返回审核信息。例如：色情 

99，表明该内容非常有可能属于色情内容。

Integer

OcrRe

sults

Response.Jo

bsDetail.Pag

该字段表示 OCR 文本识别的详细检测结果，包括文本

坐标信息、文本识别结果等信息，有相关违规内容时返

Container 

Array
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Container 节点 LibResults 的内容：

Container 节点 OcrResults 的内容：

ObjectResults 的具体内容如下：

eSegment.Re

sults.*Info

回。

LibRes

ults

Response.Jo

bsDetail.Pag

eSegment.Re

sults.*Info

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Container 

Array

节点
名称

（关

键

字）

父节点 描述 类型

Imag

eId

Response.Jobs

Detail.PageSeg

ment.Results.*In

fo.LibResults

该字段表示命中的风险库中的图片样本 ID。
Stri

ng

Scor

e

Response.Jobs

Detail.PageSeg

ment.Results.*In
fo.LibResults

该字段用于返回当前标签下的置信度，取值范围：0（置信度

最低）-100（置信度最高 ），越高代表当前的图片越有可能

命中库中的样本；如：色情 99，则表明该数据非常有可能命
中库中的色情样本。

Inte

ger

节点名

称（关

键字）

父节点 描述 类型

Text
Response.JobsDetail.
PageSegment.Results.

*Info.OcrResults

图片 OCR 文本识别出的具体文本内容。 String

Keywo
rds

Response.JobsDetail.
PageSegment.Results.

*Info.OcrResults

在当前审核场景下命中的关键词。
String 
Array

Locati
on

Response.JobsDetail.

PageSegment.Results.
*Info.OcrResults

该参数用于返回 OCR 检测框在图片中的位置

（左上角 xy 坐标、长宽、旋转角度），以方
便快速定位识别文字的相关信息。

Contain
er
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Location 的具体内容如下：

Container 节点 UserInfo 的内容：

节点名称

（关键

字）

父节点 描述 类型

Name

Response.JobsDetail.Pag

eSegment.Results.*Info.

ObjectResults

该标签用于返回所识别出的实体名称，例如

人名。
String

Locatio

n

Response.JobsDetail.Pag

eSegment.Results.*Info.

ObjectResults

该参数用于返回检测结果在图片中的位置

（左上角 xy 坐标、长宽、旋转角度），以

方便快速定位相关信息。

Contai

ner

节点名称

（关键字）
描述

类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Fl

o

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可

唯一确定检测框的大小和位置。

Fl

o

at

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余

参数可唯一确定检测框的大小和位置。

Fl

o

at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余

参数可唯一确定检测框的大小和位置。

Fl
o

at

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检
测框的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Fl
o

at

节点名称（关键字） 描述 类型
是否必

选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin
g

否

Nickname 一般用于表示昵称信息，长度不超过128字节。 Strin

g

否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin

g
否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin
g

否

Room 一般用于表示房间号信息，长度不超过128字节。
Strin

g
否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin
g

否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin
g

否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 父节点 描述 类型

ListResults
Response.JobsDetail.ListI

nfo
命中的所有名单结果。

Container 

Array

节点名称（关键

字）
父节点 描述 类型

ListType
Response.JobsDetail.ListInfo.

ListResults

命中的名单类型，取值为0（白名

单）和1（黑名单）。

Inte

ger

ListName
Response.JobsDetail.ListInfo.

ListResults
命中的名单名称。

Stri

ng

Entity Response.JobsDetail.ListInfo.

ListResults

命中了名单中的哪条内容。 Stri

ng
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此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

错误码

实际案例

请求

GET /document/auditing/stb1ca9fc8a34c525400863904**** HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

      <JobId>stb1ca9fc8a34c525400863904****</JobId>

      <State>Success</State>

      <Suggestion>1</Suggestion>

      <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

      <Url>http://www.test.com/123.doc</Url>

      <PageCount>3</PageCount>

      <Labels>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Score>96</Score>

        </PornInfo>

      </Labels>

      <PageSegment>

        <Results>

          <Url>https://examplebucket-1250000000.cos.ap-nanjing.myqcloud.com/audit-1.jp

          <Text>哈哈哈，您好</Text>

          <PageNumber>1</PageNumber>

          <PornInfo>

            <HitFlag>0</HitFlag>

            <SubLabel>sex</SubLabel>

https://cloud.tencent.com/document/product/460/42867
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            <Score>0</Score>

            <OcrResults>

              <Text>哈哈哈，您好</Text>

              <Keywords>您好</Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

        <Results>

          <Url>https://examplebucket-1250000000.cos.ap-nanjing.myqcloud.com/audit-2.jp

          <Text>哈哈哈，您好</Text>

          <PageNumber>1</PageNumber>

          <PornInfo>

            <HitFlag>0</HitFlag>

            <SubLabel>sex</SubLabel>

            <Score>0</Score>

            <OcrResults>

              <Text>哈哈哈，您好</Text>

              <Keywords>您好</Keywords>

            </OcrResults>

          </PornInfo>

        </Results>

      </PageSegment>

    </JobsDetail>

    <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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文档审核回调内容
最近更新时间：2022-10-17 16:14:41

若您配置了审核回调地址，在文档审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

功能描述

回调内容说明
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该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

{

  "EventName": "ReviewDocument",

  "JobsDetail": {

    "JobId": "6666666666666666666666666666666666",

    "State": "Success",

    "CreationTime": "",

    "Url": "",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "PageSegment": {

      "Results": [

      {

        "Url": "",

        "Text": "",

        "PageNumber": 0,

        "SheetNumber": 0,

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

          "OcrResults": [{

            "Text": "",

            "Keywords":["",""],

            "Location": {

              "X": 0,

              "Y": 0,

              "Width": 0,

              "Height": 0,

              "Rotate": 0

            }
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具体的数据内容如下：

JobsDetail 的内容如下：

          }]

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "666666"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewDocument 。 String

节点名称
（关键字）

描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。 String

Message 错误描述，只有 State 为 Failed 时返回。 String

JobId 审核任务的 ID。 String

DataId 提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。 String

State
审核任务的状态，值为 Submitted（已提交审核）、Success（审核成

功）、Failed（审核失败）、Auditing（审核中）其中一个。
String

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告。

String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Labels 的内容如下：

Labels 中 PornInfo，AdsInfo 的内容如下：

Suggesti
on

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您
按照业务所需，对不同的审核结果进行相应处理。 有效值：0（审核正常），1 

（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Integ
er

CreationT
ime

审核任务的创建时间。 String

Object 审核的文件为存储在 COS 中的文件时，该字段表示本次审核的文件名称。 String

Url 审核的文件链接，创建任务使用Url时返回。 String

PageCou

nt
文档审核会将文档转换为图片进行审核，该字段表示转换的图片总数量。

Integ

er

Labels 该字段用于返回命中的审核场景及对应的结果。
Objec
t

PageSeg

ment
文档转换为图片后，具体每张图片的审核结果信息。

Objec

t

ForbidSta

te

若您设置了自动冻结，该字段表示文档的冻结状态。0：未冻结，1：已被冻

结，2：已转移文件。

Integ

er

CosHead
ers

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。map 
结构，key 为自定义 Header 的名称，value 为内容。

Objec
t

UserInfo 用户业务字段。创建任务时未设置UserInfo则无此字段。
Objec

t

ListInfo 账号黑白名单结果。
Conta

iner

节点名称（关键字） 描述 类型

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点名

称（关

键字）

描述 类型

HitFla 用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内 Integ
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PageSegment 的内容如下：

Results 的内容如下：

Results 中 PornInfo，AdsInfo 的内容如下：

g 容。2：疑似为当前场景的违规内容。 er

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 

99，表明该内容非常有可能属于色情内容。

Integ

er

节点名称（关键字） 描述 类型

Results 文档转换为图片后，每张图片的详细审核结果信息。 Array

节点名称（关
键字）

描述 类型

Url

文档转换成图片后，您可以通过该地址查看该图片内容，地址格式为标准 

URL 格式。注意：每次查看数据的有效期为2小时，2小时后如还需查看，
请重新发起查询请求。

String

Text
该字段用于返回当前图片 OCR 文本识别的检测结果，仅在审核策略开启文

本内容检测时返回。
String

PageNumb

er
该图片的页码，通常是文档的页码。

Intege

r

SheetNum
ber

如果审核的为表格文件，该字段表示表格内的 Sheet 页码。
Intege
r

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐

的审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。返

回值：Normal：正常，Porn：色情，Ads：广告。

String

Suggestion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建

议您按照业务所需，对不同的审核结果进行相应处理。有效值：0（审核正

常），1 （判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Intege

r

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点名

称（关
键字）

描述 类型
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

HitFla

g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景

的违规内容。2：疑似为当前场景的违规内容。
Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信

息。通常[0,60]分可以认为图片属于正常，[61,90]分表示图片疑似敏感，

[91,100]分表示图片为敏感的。例如：色情 99，则表明该内容非常有可能
属于色情内容。

Integer

Categ

ory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字

段可能为空，表示未命中或暂无相关的类别。
String

SubLa

bel

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子

标签。注意：该字段可能返回空，表示未命中具体的子标签。
String

OcrRe
sults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别
结果等信息，有相关违规内容时返回。

Array

LibRes

ults

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此

字段不返回。

Container 

Array

节点名
称（关

键字）

描述 类型

ImageI

d
该字段表示命中的风险库中的图片样本 ID。

Strin

g

Score

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度

最高 ），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数

据非常有可能命中库中的色情样本。

Integ

er

节点名称（关
键字）

描述 类型

Text 图片 OCR 文本识别出的具体文本内容。 String

Keywords 在当前审核场景下命中的关键词。 Array

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转

角度），以方便快速定位识别文字的相关信息。

Objec

t
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ObjectResults 的具体内容如下：

Location 的具体内容如下：

UserInfo 的内容：

节点名称（关

键字）
描述 类型

Name 该标签用于返回所识别出的实体名称，例如人名。
Stri

ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Obj

ect

节点名称

（关键字）
描述 类型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参
数可唯一确定检测框的大小和位置。

Float

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参

数可唯一确定检测框的大小和位置。
Float

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合

剩余参数可唯一确定检测框的大小和位置。
Float

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合
剩余参数可唯一确定检测框的大小和位置。

Float

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确

定检测框的具体位置；取值：0-360（角度制），方向为逆时针旋转。
Float

节点名称（关键
字）

描述 类型
是否必
选

TokenId 一般用于表示账号信息，长度不超过128字节。
Strin

g
否

Nickname 一般用于表示昵称信息，长度不超过128字节。
Strin

g
否

DeviceId 一般用于表示设备信息，长度不超过128字节。
Strin
g

否

AppId 一般用于表示 App 的唯一标识，长度不超过128字节。
Strin

g
否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

Room 一般用于表示房间号信息，长度不超过128字节。 Strin

g

否

IP 一般用于表示 IP 地址信息，长度不超过128字节。
Strin

g
否

Type 一般用于表示业务类型，长度不超过128字节。
Strin

g
否

ReceiveTokenI

d

一般用于表示接收消息的用户账号，长度不超过128字

节。

Strin

g
否

Gender 一般用于表示性别信息，长度不超过128字节。
Strin

g
否

Level 一般用于表示等级信息，长度不超过128字节。
Strin

g
否

Role 一般用于表示角色信息，长度不超过128字节。
Strin

g
否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

{

  "EventName": "ReviewDocument",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "http://test.com/test.doc",
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    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "PageSegment": {

      "Results": [

      {

        "Url": "http://audit-125000000.cos.ap-chongqing.myqcloud.com/1.jpg",

        "Text": "",

        "PageNumber": 1,

        "SheetNumber": 0,

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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网页审核
提交网页审核任务
最近更新时间：2023-06-27 15:00:23

本接口用于提交一个网页审核任务。网页审核功能为异步任务方式，您可以通过提交网页审核任务审核您的网页，然

后通过 查询网页审核任务接口  或 网页审核回调  查询审核结果。

该接口支持情况如下：

网页的审核分为网页画面审核、网页文字审核，其中：

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

功能描述

支持对网页文件进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别几个维

度，通过深度学习技术，识别网页中的违规内容。

支持识别多种违规场景，包括：色情、违法、广告等场景。

费用说明

网页画面审核：通过爬取网页内图片的方式，将爬取的多张图片进行审核，审核费用与图片审核一致。

网页文本审核：将网页内的文本分离出来进行文本审核，审核费用与文本审核一致。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个网页，计2次审核费用。

调用接口会产生 图片审核费用 、 文本审核费用  和 COS 请求费用 。

限制说明

接口默认并发数量：10。

推荐使用 SDK

请求

请求示例

POST /webpage/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/63970
https://cloud.tencent.com/document/product/460/65808
https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/58119#.E5.9B.BE.E7.89.87.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/460/58119#.E6.96.87.E6.9C.AC.E5.AE.A1.E6.A0.B8.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

  <Input>

    <Url></Url>

        <DataId></DataId>

        <UserInfo></UserInfo>

  </Input>

  <Conf>

    <Biztype></Biztype>

    <Callback></Callback>

    <ReturnHighlightHtml>true</ReturnHighlightHtml>

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 网页审核的具体配置项。 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 需要审核的网页信息。 Container 是

Conf Request 审核规则配置。 Container 是

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 节点 UserInfo 的内容：

节点名称

（关键

字）

父节点 描述 类型 是

否

必

选

Url
Request.In

put

网页文件的链接地址，例如 

http://www.test.com 。
String 是

DataId
Request.In

put

该字段在审核结果中会返回原始内容，长度限制为

512字节。您可以使用该字段对待审核的数据进行唯

一业务标识。

String 否

UserInfo
Request.In
put

用户业务字段。
Conta
iner

否

节点名称（关键

字）
父节点 描述 类型

是否

必选

TokenId
Request.Input.
UserInfo

一般用于表示账号信息，长度不超过128
字节。

Strin
g

否

Nickname
Request.Input.

UserInfo

一般用于表示昵称信息，长度不超过128

字节。

Strin

g
否

DeviceId
Request.Input.

UserInfo

一般用于表示设备信息，长度不超过128

字节。

Strin

g
否

AppId
Request.Input.
UserInfo

一般用于表示 App 的唯一标识，长度不
超过128字节。

Strin
g

否

Room
Request.Input.

UserInfo

一般用于表示房间号信息，长度不超过

128字节。

Strin

g
否

IP
Request.Input.

UserInfo

一般用于表示 IP 地址信息，长度不超过

128字节。

Strin

g
否

Type
Request.Input.

UserInfo

一般用于表示业务类型，长度不超过128

字节。

Strin

g
否

ReceiveTok

enId

Request.Input.

UserInfo

一般用于表示接收消息的用户账号，长

度不超过128字节。

Strin

g
否

Gender
Request.Input.

UserInfo

一般用于表示性别信息，长度不超过128

字节。

Strin

g
否

Level Request.Input. 一般用于表示等级信息，长度不超过128 Strin 否
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Container 类型 Conf 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

UserInfo 字节。 g

Role
Request.Input.

UserInfo

一般用于表示角色信息，长度不超过128

字节。

Strin

g
否

节点名称（关键

字）
父节点 描述 类型

是否

必选

BizType
Request.
Conf

表示审核策略的唯一标识，您可以通过控制台上

的审核策略页面，配置您希望审核的场景，如涉

黄、广告、违法违规等。您可以在控制台上获取

到 BizType。BizType 填写时，此条审核请
求将按照该审核策略中配置的场景进行审核。

BizType 不填写时，将自动使用默认的审核策

略。

Strin
g

否

DetectType
Request.

Conf

（该参数后续不再维护，请使用BizType参

数）审核的场景类型，有效值：Porn（涉

黄）、Ads（广告）等，可以传入多种类型，

不同类型以逗号分隔，例如：Porn,Ads。如您
有更多场景的审核需要，请使用 BizType 参

数。

Strin

g
否

Callback
Request.

Conf
回调地址，以 http:// 或者 https:// 开头的地

址。

Strin

g
否

ReturnHighlig

htHtml

Request.

Conf

指定是否需要高亮展示网页内的违规文本，查询

及回调结果时会根据此参数决定是否返回高亮展

示的 html 内容。取值为 true 或者 false，默
认为 false。

Bool

ean
否

响应

响应头

响应体

<Response>

    <JobsDetail>

      <JobId></JobId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 网页审核返回的具体响应内容。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 网页审核任务的详细信息。 Container

节点名称

（关键

字）

父节点 描述
类

型

DataId
Response.Job

sDetail
请求中添加的 DataId 字段。

Str

ing

JobId
Response.Job
sDetail

本次网页审核任务的 ID。
Str
ing

State
Response.Job

sDetail

网页审核任务的状态，值为 Submitted（已提交审核）、

Success（审核成功）、Failed（审核失败）、Auditing
（审核中）其中一个

Str

ing

Creation

Time

Response.Job

sDetail
网页审核任务的创建时间。

Str

ing

错误码

实际案例

请求

POST /webpage/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

https://cloud.tencent.com/document/product/460/42867
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Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Input>

    <Url>http://test.com</Url>

  </Input>

  <Conf>

    <ReturnHighlightHtml>true</ReturnHighlightHtml>

    <DetectType>Porn,Ads</DetectType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <CreationTime>2021-11-09T09:55:53+08:00</CreationTime>

        <JobId>sh2c1260a4410011eca1f1525400276c76</JobId>

        <State>Submitted</State>

        <Url>http://test.com</Url>

    </JobsDetail>

    <RequestId>NjE4OWQ1Mjlf*****MzQ0OF85</RequestId>

</Response>
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查询网页审核任务结果
最近更新时间：2023-06-20 17:32:13

本接口用于主动查询指定的网页审核任务结果。网页审核功能为异步任务方式，您可以通过提交网页审核任务审核您

的网页文件，然后通过查询网页审核任务接口查询审核结果。

数据万象 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能描述

说明

 网页审核任务结果保存时效为3个月，您可通过本接口查询近3个月的审核结果。

推荐使用 SDK

请求

请求示例

GET /webpage/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/47727
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

<Response>

  <JobsDetail>

    <JobId></JobId>

    <State>Success</State>

    <Code>Success</Code>

    <Message>Success</Message>

    <Suggestion>1</Suggestion>

    <CreationTime></CreationTime>

    <Url></Url>

    <PageCount>3</PageCount>

    <Labels>

      <PornInfo>

        <HitFlag>1</HitFlag>

        <Score>96</Score>

      </PornInfo>

    </Labels>

    <ImageResults>

      <Results>

        <Url></Url>

        <Text></Text>

        <PornInfo>

          <HitFlag></HitFlag>

          <SubLabel></SubLabel>

          <Score></Score>

          <OcrResults>

            <Text></Text>

            <Keywords></Keywords>

            <Location>

              <X></X>

              <Y></Y>

              <Width></Width>

              <Height></Height>

              <Rotate></Rotate>

            </Location>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

          </OcrResults>

        </PornInfo>

      </Results>

    </ImageResults>

    <TextResults>

      <Results>

        <Text></Text>

        <PornInfo>

          <HitFlag></HitFlag>

          <Score></Score>

          <Keywords></Keywords>

        </PornInfo>

      </Results>

    </TextResults>

  </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 网页审核的全部结果信息。 Container

节点名称（关
键字）

父节点 描述 类型

JobsDetail
Respon

se
网页审核任务的详细信息。

Conta

iner

RequestId
Respon

se

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问

题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述 类型

Code
Response.Jo

bsDetail

错误码，只有 State 为 Failed 时返回，详情请查看 错

误码列表 。
String

Messag

e

Response.Jo

bsDetail
错误描述，只有 State 为 Failed 时返回。 String

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1135 共1950页

JobId Response.Jo

bsDetail

网页审核任务的 ID。 String

DataId
Response.Jo

bsDetail

提交任务时设置了 DataId 参数时返回，返回原始内容，

长度限制为512字节。您可以使用该字段对待审核的数据

进行唯一业务标识。

String

State
Response.Jo

bsDetail

网页审核任务的状态，值为 Submitted（已提交审

核）、Success（审核成功）、Failed（审核失败）、

Auditing（审核中）其中一个。

String

Creation

Time

Response.Jo

bsDetail
网页审核任务的创建时间。 String

Url
Response.Jo
bsDetail

本次审核的文件链接，创建任务使用 Url 时返回。 String

Labels
Response.Jo
bsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对

不同违规类型与建议值进行处理。 返回值：Normal：正
常，Porn：色情，Ads：广告，以及其他不安全或不适

宜的类型。

Conta
iner

Suggesti

on

Response.Jo

bsDetail

该字段表示本次判定的审核结果，您可以根据该结果，进
行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Integ

er

Label
Response.Jo

bsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对

不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告等。

String

PageCo

unt

Response.Jo

bsDetail

网页审核会将网页中的图片链接和文本分开送审，该字段

表示送审的链接和文本总数量。

Integ

er

ImageRe
sults

Response.Jo
bsDetail

网页内图片的审核结果。
Conta
iner

TextRes

ults

Response.Jo

bsDetail
网页内文字的审核结果。

Conta

iner

Highlight

Html

Response.Jo

bsDetail

对违规关键字高亮处理的Html网页内容，请求内容指定 

ReturnHighlightHtml 时返回。
String

UserInfo
Response.Jo
bsDetail

用户业务字段。创建任务未设置 UserInfo 时无此字段。
Conta
iner
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Container 节点 Labels 的内容：

Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 ImageResults 的内容：

ListInfo Response.Jo

bsDetail

账号黑白名单结果。 Conta

iner

节点名称（关键字） 父节点 描述 类型

PornInfo
Response.JobsDetai

l.Labels
审核场景为涉黄的审核结果信息。

Contain

er

AdsInfo
Response.JobsDetai
l.Labels

审核场景为广告引导的审核结果信
息。

Contain
er

节

点

名

称

（
关

键

字

）

父节点 描述 类型

Hit

Fla
g

Response.JobsDet

ail.Labels.*Info

Response.JobsDetail.Labels.*Inf

o

用于返回该审核场景的审

核结果，返回值：0：正

常1：确认为当前场景的
违规内容2：疑似为当前

场景的违规内容。

Sc

ore

Response.JobsDet

ail.Labels.*Info

该字段表示审核结果命中审核信息的置

信度，取值范围：0（置信度最
低）-100（置信度最高 ），越高代表

该内容越有可能属于当前返回审核信息

例如：色情 99，则表明该内容非常有可

能属于色情内容。

Integer

节点名称
（关键字）

父节点 描述 类型

Results
Response.JobsDeta

il.ImageResults

网页内图片审核的结果，审核多张图片将返

回多个 Results 。

Contain

er Array



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1137 共1950页

Container 节点 Results 的内容：

Container 节点 PornInfo，AdsInfo的内容：

节点名称
（关键

字）

父节点 描述 类型

Url

Response.J

obsDetail.I
mageResul

ts.Results

网页中图片审核，被审核图片的访问地址，您可以通过该地
址查看图片，地址格式为标准 URL 格式。

String

Text

Response.J
obsDetail.I

mageResul

ts.Results

该字段用于返回当前图片的 OCR 文本识别的检测结果，仅

在审核策略开启文本内容检测时返回。
String

Label

Response.J
obsDetail.I

mageResul

ts.Results

该字段用于返回检测结果中所对应的优先级最高的恶意标
签，表示模型推荐的审核结果，建议您按照业务所需，对不

同违规类型与建议值进行处理。返回值：Normal：正常，

Porn：色情，Ads：广告。

String

Sugges

tion

Response.J

obsDetail.I

mageResul

ts.Results

该字段表示本次判定的审核结果，您可以根据该结果，进行

后续的操作；建议您按照业务所需，对不同的审核结果进行

相应处理。有效值：0（审核正常），1 （判定为违规敏感文

件），2（疑似敏感，建议人工复核）。

Intege

r

PornInf

o

Response.J

obsDetail.I

mageResul

ts.Results

审核场景为涉黄的审核结果信息。
Contai

ner

AdsInfo

Response.J

obsDetail.I

mageResul
ts.Results

审核场景为广告引导的审核结果信息。
Contai

ner

节点名

称（关

键字）

父节点 描述 类型

HitFla
g

Response.JobsDe
tail.ImageResults.

Results.*Info

Response.JobsDetail.Labels.*I
nfo

用于返回该审核场景的审
核结果，返回值：0：正

常1：确认为当前场景的
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Container 节点 LibResults 的内容：

违规内容2：疑似为当前

场景的违规内容。

Score

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段表示审核结果命中审核信息的
置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代

表该内容越有可能属于当前返回审核

信息。例如：色情 99，则表明该内容

非常有可能属于色情内容。

Integer

Categ

ory

Response.JobsDe

tail.ImageResults.

Results.*Info

表示命中的具体审核类别。例如 

Sexy，表示色情标签中的性感类别。

该字段可能为空，表示未命中或暂无
相关的类别。

String

SubL
abel

Response.JobsDe

tail.ImageResults.
Results.*Info

该字段表示审核命中的具体子标签，

例如：Porn 下的 SexBehavior 子

标签。
注意：该字段可能返回空，表示未命

中具体的子标签。

String

OcrR

esults

Response.JobsDe
tail.ImageResults.

Results.*Info

该字段表示 OCR 文本识别的详细检
测结果，包括文本坐标信息、文本识

别结果等信息，有相关违规内容时返

回。

Container Array

LibRe

sults

Response.JobsDe

tail.ImageResults.

Results.*Info

该字段用于返回基于风险库识别的结

果。

注意：未命中风险库中样本时，此字

段不返回。

Container Array

节点名

称（关
键字）

父节点 描述
类
型

Image

Id

Response.JobsDetail.Ima

geResults.Results.*Info.Li
bResults

该字段表示命中的风险库中的图片样本 ID。
Str

ing

Score

Response.JobsDetail.Ima

geResults.Results.*Info.Li
bResults

该字段用于返回当前标签下的置信度，取值范围：

0（置信度最低）-100（置信度最高 ），越高代

表当前的图片越有可能命中库中的样本。例如：色
情 99，表明该数据非常有可能命中库中的色情样

本。

Int

eg
er
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Container 节点 OcrResults 的内容：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

节点名

称（关

键字）

父节点 描述 类型

Text

Response.JobsDetail.Image

Results.Results.*Info.OcrRe

sults

图片 OCR 文本识别出的具体文本内容。 String

Keyw

ords

Response.JobsDetail.Image

Results.Results.*Info.OcrRe

sults

在当前审核场景下命中的关键词。
String 

Array

Locati

on

Response.JobsDetail.Image

Results.Results.*Info.OcrRe

sults

该参数用于返回 OCR 检测框在图片中的

位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信

息。

Conta

iner

节点名
称（关

键字）

父节点 描述 类型

Name

Response.JobsDetail.ImageRe

sults.Results.*Info.ObjectResult
s

该标签用于返回所识别出的实体名称，
例如人名。

Strin
g

Locati

on

Response.JobsDetail.ImageRe

sults.Results.*Info.ObjectResult
s

该参数用于返回检测结果在图片中的位

置（左上角 xy 坐标、长宽、旋转角
度），以方便快速定位相关信息。

Cont

ainer

节点名

称（关

键字）

描述
类

型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一

确定检测框的大小和位置。

Fl
o

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一
确定检测框的大小和位置。

Fl
o

at
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Container 节点 TextResults 的内容：

Container 节点 Results 的内容：

Height 该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o
at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Fl

o
at

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框

的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Fl

o

at

节点名称
（关键字）

父节点 描述 类型

Results
Response.JobsD

etail.TextResults

网页内文本审核的结果，审核多条文本将返回多

个 Results 。

Container 

Array

节点
名称

（关

键

字）

父节点 描述 类型

Tex

t

Response.JobsDet

ail.TextResults.Res

ults

网页文本将进行分段送审，每10000个 utf8 编码字符分

一段，该参数返回本段文本内容。

Strin

g

Lab

el

Response.JobsDet

ail.TextResults.Res

ults

该字段用于返回检测结果中所对应的优先级最高的恶意标

签，表示模型推荐的审核结果，建议您按照业务所需，对

不同违规类型与建议值进行处理。 返回值：Normal：正

常，Porn：色情，Ads：广告。

Strin

g

Sug

gest

ion

Response.JobsDet

ail.TextResults.Res

ults

该字段表示本次判定的审核结果，您可以根据该结果，进

行后续的操作；建议您按照业务所需，对不同的审核结果

进行相应处理。有效值：0（审核正常），1 （判定为违

规敏感文件），2（疑似敏感，建议人工复核）。

Integ

er

Por

nInf

o

Response.JobsDet

ail.TextResults.Res

ults

审核场景为涉黄的审核结果信息。
Cont

ainer
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

AdsI

nfo

Response.JobsDet

ail.TextResults.Res

ults

审核场景为广告引导的审核结果信息。 Cont

ainer

节点
名称

（关

键

字）

父节点 描述 类型

HitFl

ag

Response.JobsDetail.

TextResults.Results.*I

nfo

用于返回该审核场景的审核结果，返回值：0：

正常1：确认为当前场景的违规内容2：疑似为当

前场景的违规内容。

Integer

Scor

e

Response.JobsDetail.

TextResults.Results.*I

nfo

该字段表示审核结果命中审核信息的置信度，取

值范围：0（置信度最低）-100（置信度最高 

），越高代表该内容越有可能属于当前返回审核

信息。

Integer

Key

word

s

Response.JobsDetail.

TextResults.Results.*I

nfo

在当前审核场景下命中的关键词，多关键词以

``,`` 分隔。
String

LibR

esult

s

Response.JobsDetail.

TextResults.Results.*I

nfo

该字段用于返回基于风险库识别的结果。注意：

未命中风险库中样本时，此字段不返回。

Contain

er Array

节点名称

（关键字）
父节点 描述 类型

LibType
Response.JobsDetail.TextRe

sults.Results.*Info.LibResults

命中的风险库类型，取值为1（预

设黑白库）和2（自定义风险

库）。

Integer

LibName
Response.JobsDetail.TextRe

sults.Results.*Info.LibResults
命中的风险库名称。 String

Keywords
Response.JobsDetail.TextRe
sults.Results.*Info.LibResults

命中的库中关键词。该参数可能会
有多个返回值，代表命中的多个关

键词。

String 
Array
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

节点名称

（关键字）

父节点 描述 类型 是否

必选

TokenId
Request.Input.
UserInfo

一般用于表示账号信息，长度不超过128字
节。

Stri
ng

否

Nickname
Request.Input.

UserInfo

一般用于表示昵称信息，长度不超过128字

节。

Stri

ng
否

DeviceId
Request.Input.

UserInfo

一般用于表示设备信息，长度不超过128字

节。

Stri

ng
否

AppId
Request.Input.
UserInfo

一般用于表示 App 的唯一标识，长度不超
过128字节。

Stri
ng

否

Room
Request.Input.

UserInfo

一般用于表示房间号信息，长度不超过128

字节。

Stri

ng
否

IP
Request.Input.

UserInfo

一般用于表示 IP 地址信息，长度不超过128

字节。

Stri

ng
否

Type
Request.Input.
UserInfo

一般用于表示业务类型，长度不超过128字
节。

Stri
ng

否

ReceiveT

okenId

Request.Input.

UserInfo

一般用于表示接收消息的用户账号，长度不

超过128字节。

Stri

ng
否

Gender
Request.Input.

UserInfo

一般用于表示性别信息，长度不超过128字

节。

Stri

ng
否

Level
Request.Input.
UserInfo

一般用于表示等级信息，长度不超过128字
节。

Stri
ng

否

Role
Request.Input.

UserInfo

一般用于表示角色信息，长度不超过128字

节。

Stri

ng
否

节点名称（关键字） 父节点 描述 类型

ListResults
Response.JobsDetail.ListI

nfo

命中的所有名单结

果。

Container 

Array

节点名称（关键

字）
父节点 描述 类型
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

ListType Response.JobsDetail.ListInf

o.ListResults

命中的名单类型，取值为0（白名

单）和1（黑名单）。

Integ

er

ListName
Response.JobsDetail.ListInf
o.ListResults

命中的名单名称。 String

Entity
Response.JobsDetail.ListInf

o.ListResults
命中了名单中的哪条内容。 String

错误码

实际案例

请求

GET /webpage/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Tue, 09 Nov 2021 01:56:09 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <CreationTime>2021-11-09T10:03:32+08:00</CreationTime>

    <HighlightHtml>xxxxx</HighlightHtml>

    <ImageResults>

      <Results>

        <AdsInfo>

          <HitFlag>0</HitFlag>

          <Score>0</Score>

          <SubLabel/>

        </AdsInfo>

        <Label>Porn</Label>

        <PornInfo>

https://cloud.tencent.com/document/product/460/42867
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          <HitFlag>1</HitFlag>

          <Score>99</Score>

          <SubLabel>ACGPorn</SubLabel>

        </PornInfo>

        <Suggestion>1</Suggestion>

        <Text>xxxxxxx</Text>

        <Url>xxxxxx</Url>

      </Results>

    </ImageResults>

    <JobId>sh3dba0967410111eca1f1525400276c76</JobId>

    <Label>Porn</Label>

    <Labels>

      <AdsInfo>

        <HitFlag>0</HitFlag>

        <Score>0</Score>

      </AdsInfo>

      <PornInfo>

        <HitFlag>1</HitFlag>

        <Score>99</Score>

      </PornInfo>

    </Labels>

    <PageCount>2</PageCount>

    <State>Success</State>

    <Suggestion>1</Suggestion>

    <TextResults>

      <Results>

        <AdsInfo>

          <HitFlag>0</HitFlag>

          <Keywords/>

          <Score>0</Score>

        </AdsInfo>

        <Label>Porn</Label>

        <PornInfo>

          <HitFlag>1</HitFlag>

          <Keywords>xxxx</Keywords>

          <Score>98</Score>

        </PornInfo>

        <Suggestion>1</Suggestion>

        <Text>xxxx</Text>

      </Results>

    </TextResults>

    <Url>https://xxxx</Url>

  </JobsDetail>

  <RequestId>NjE4OWQ3MDNfY****RfMzQ0OF9h</RequestId>

</Response>
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网页审核回调内容
最近更新时间：2022-10-17 16:19:45

若您配置了审核回调地址，在网页审核结束后，后台会将审核结果以 json 形式回调至您的回调地址。您可以通过回

调内容，进行后续的文件处理操作。

功能描述
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该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

{

  "EventName": "ReviewHtml",

  "JobsDetail": {

    "JobId": "6666666666666666666666666666666666",

    "State": "Success",

    "CreationTime": "",

    "Url": "",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 1,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "ImageResults": {

      "Results": [

      {

        "Url": "",

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

          "OcrResults": [{

            "Text": "",

            "Keywords":["",""],

            "Location": {

              "X": 0,

              "Y": 0,

              "Width": 0,

              "Height": 0,
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具体的数据内容如下：

              "Rotate": 0

            }

          }]

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "TextResults": {

      "Results": [

      {

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "666666"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object
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JobsDetail 的内容如下：

EventName 任务的类型，为 ReviewHtml 。 String

节点名称
（关键字）

描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。
Strin

g

Message 错误描述，只有 State 为 Failed 时返回。
Strin

g

JobId 审核任务的 ID。
Strin
g

DataId
提交任务时设置了 DataId 参数时返回，返回原始内容，长度限制为512字节。

您可以使用该字段对待审核的数据进行唯一业务标识。

Strin

g

State
审核任务的状态，值为 Submitted（已提交审核）、Success（审核成功）、

Failed（审核失败）、Auditing（审核中）其中一个。

Strin

g

Label
该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审
核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告等。

Strin
g

Suggestio
n

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。 有效值：0（审核正常），1 
（判定为违规敏感文件），2（疑似敏感，建议人工复核）。

Integ
er

CreationT

ime
审核任务的创建时间。

Strin

g

Url 审核的网页链接，创建任务使用 Url 时返回。
Strin

g

PageCou
nt

网页审核会将网页中的图片链接和文本分开送审，该字段表示送审的链接和文本
总数量。

Integ
er

Labels 该字段用于返回命中的审核场景及对应的结果。
Obje

ct

ImageRes

ults
网页内图片的审核结果。

Obje

ct

TextResu
lts

网页内文字的审核结果。
Obje
ct

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Labels 的内容如下：

Labels 中 PornInfo，AdsInfo 的内容如下：

ImageResults 的内容如下：

Results 的内容如下：

Highlight

Html

对违规关键字高亮处理的 HTML 网页内容，请求内容指定 

ReturnHighlightHtml 时返回。

Strin

g

UserInfo 用户业务字段。当创建任务时未设置 UserInfo 则无此字段。
Obje

ct

ListInfo 账号黑白名单结果。
Cont
ainer

节点名称（关键字） 描述 类型

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点名
称（关

键字）

描述 类型

HitFla
g

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规内
容。2：疑似为当前场景的违规内容。

Inte
ger

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100（置

信度最高 ），越高代表该内容越有可能属于当前返回审核信息。例如：色情 99，表

明该内容非常有可能属于色情内容。

Inte

ger

节点名称（关键字） 描述 类型

Results 网页内图片审核的结果。 Array

节点名

称（关

键字）

描述 类型

Url
网页中图片审核，被审核图片的访问地址，您可以通过该地址查看图片，地址格式为标

准 URL 格式。

Stri

ng

Text 该字段用于返回当前图片的 OCR 文本识别的检测结果，仅在审核策略开启文本内容检
测时返回。

Stri
ng
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Results 中 PornInfo，AdsInfo 的内容如下：

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。返回值：Normal：正
常，Porn：色情，Ads：广告。

Stri

ng

Sugg

estion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

PornI

nfo
审核场景为涉黄的审核结果信息。

Obj

ect

AdsIn

fo
审核场景为广告引导的审核结果信息。

Obj

ect

节点

名称

（关

键
字）

描述 类型

HitF

lag

用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违规

内容。2：疑似为当前场景的违规内容。
Integer

Sco

re

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息。通常[0,60]

分可以认为图片属于正常，[61,90]分表示图片疑似敏感，[91,100]分表示图片为

敏感的。例如：色情 99，表明该内容非常有可能属于色情内容。

Integer

Cat

ego

ry

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段可能

为空，表示未命中或暂无相关的类别。
String

Sub

Lab

el

该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标签。

注意：该字段可能返回空，表示未命中具体的子标签。
String

Ocr

Res

ults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别结果

等信息，有相关违规内容时返回。
Array

Lib

Res

ults

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Container 

Array
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

节点名

称（关
键字）

描述
类
型

ImageI

d
该字段表示命中的风险库中的图片样本 ID。

Str

ing

Score

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100（置信度最高 

），越高代表当前的图片越有可能命中库中的样本。例如：色情 99，表明该数据非常

有可能命中库中的色情样本。

Int

eg

er

节点名称

（关键字）
描述 类型

Text 图片 OCR 文本识别出的具体文本内容。
Stri

ng

Keywords 在当前审核场景下命中的关键词。
Arr

ay

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位识别文字的相关信息。

Obj

ect

节点名称（关
键字）

描述
类
型

Name 该标签用于返回所识别出的实体名称，例如人名。
Str

ing

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角

度），以方便快速定位相关信息。

Ob

jec

t

节点名

称（关
键字）

描述
类

型

X 该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯一 Flo
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TextResults 的具体内容如下：

Results 的具体内容如下：

PornInfo，AdsInfo 的具体内容如下：

确定检测框的大小和位置。 at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯一

确定检测框的大小和位置。

Flo

at

Heigh

t

该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Flo

at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参数

可唯一确定检测框的大小和位置。

Flo

at

Rotat

e

该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测框

的具体位置；取值：0-360（角度制），方向为逆时针旋转。

Flo

at

节点名称（关键字） 描述 类型

Results 网页内文本审核的结果。 Array

节点名
称（关

键字）

描述 类型

Text
网页文本将进行分段送审，每10000个 utf8 编码字符分一段，该参数返回本段文本内
容。

Stri
ng

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审核结

果，建议您按照业务所需，对不同违规类型与建议值进行处理。 返回值：Normal：
正常，Porn：色情，Ads：广告。

Stri

ng

Sugg

estion

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您按照业

务所需，对不同的审核结果进行相应处理。有效值：0（审核正常），1 （判定为违规

敏感文件），2（疑似敏感，建议人工复核）。

Inte

ger

PornI

nfo
审核场景为涉黄的审核结果信息。

Obj

ect

AdsIn

fo
审核场景为广告引导的审核结果信息。

Obj

ect

节点名称

（关键

描述 类型
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

字）

HitFlag
用于返回该审核场景的审核结果，返回值：0：正常。1：确认为当前场景的违

规内容。2：疑似为当前场景的违规内容。
Integer

Score
该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最
低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信

息。

Integer

Keywor

ds
在当前审核场景下命中的关键词，多关键词以 , 分割。 String

LibRes

ults

该字段用于返回基于风险库识别的结果。

注意：未命中风险库中样本时，此字段不返回。

Contain

er Array

节点名称（关键

字）
描述 类型

LibType 命中的风险库类型，取值为1（预设黑白库）和2（自定义风险库）。 Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多个关

键词。

String 

Array

节点名称（关键

字）
父节点 描述

类

型

是否

必选

TokenId
Request.Input.

UserInfo

一般用于表示账号信息，长度不超过128字

节。

St

ri

n

g

否

Nickname
Request.Input.

UserInfo

一般用于表示昵称信息，长度不超过128字

节。

St

ri

n

g

否

DeviceId
Request.Input.

UserInfo

一般用于表示设备信息，长度不超过128字

节。

St

ri

n

g

否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

AppId Request.Input.

UserInfo

一般用于表示 App 的唯一标识，长度不超过

128字节。

St

ri
n

g

否

Room
Request.Input.
UserInfo

一般用于表示房间号信息，长度不超过128字
节。

St

ri
n

g

否

IP
Request.Input.

UserInfo

一般用于表示 IP 地址信息，长度不超过128

字节。

St
ri

n

g

否

Type
Request.Input.

UserInfo

一般用于表示业务类型，长度不超过128字

节。

St
ri

n

g

否

ReceiveTok

enId

Request.Input.

UserInfo

一般用于表示接收消息的用户账号，长度不超

过128字节。

St

ri

n

g

否

Gender
Request.Input.

UserInfo

一般用于表示性别信息，长度不超过128字

节。

St

ri

n

g

否

Level
Request.Input.

UserInfo

一般用于表示等级信息，长度不超过128字

节。

St

ri

n
g

否

Role
Request.Input.

UserInfo

一般用于表示角色信息，长度不超过128字

节。

St

ri

n
g

否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array
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节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。
Intege
r

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

{

  "EventName": "ReviewHtml",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "http://test.com/test.html",

    "Label": "Normal",

    "Suggestion": 0,

    "PageCount": 2,

    "Labels": {

      "PornInfo": {

        "HitFlag": 0,

        "Score": 0

      },

      "AdsInfo": {

        "HitFlag": 0,

        "Score": 0

      }

    },

    "ImageResults": {

      "Results": [

      {

        "Url": "http://xxx.xxx.com/a.jpg",

        "Text": "",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "SubLabel": "",

        },

        "AdsInfo": {

          "HitFlag": 0,
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          "Score": 0,

          "SubLabel": ""

        }

      }

      ]

    },

    "TextResults": {

      "Results": [

      {

        "Text": "xxxxxxx",

        "Label": "Normal",

        "Suggestion": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Keywords": ""

        }

      }

      ]

    },

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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直播审核

提交直播审核任务
最近更新时间：2023-06-26 18:50:37

本接口用于提交一个直播流审核任务。直播流审核功能为异步任务方式，您可以通过提交直播流审核任务审核您的直

播流，然后通过查询直播流审核任务接口查询审核结果。

该接口支持情况如下：

直播流的审核分为直播画面审核、直播声音审核，其中：

功能描述

说明

支持审核视频直播，例如娱乐直播、线上授课等场景。

支持审核语音直播，例如语音聊天房、在线会议等场景。

支持对直播流进行自动检测，从 OCR 文本识别、物体检测（实体、广告台标、二维码等）、图像识别及音频审

核四个维度，通过深度学习技术，识别直播流中的违规内容。

支持设置回调地址 Callback 获取检测结果，或通过 查询直播审核任务结果  主动轮询获取审核结果详情。

支持识别多种违规场景，包括：色情、违法、广告等场景。

支持根据不同的业务场景 配置自定义的审核策略 。

支持用户 自定义配置风险库 ，打击自定义违规内容。

费用说明

直播画面审核：通过直播流截帧将直播流截取为多张图片进行审核。

直播声音审核：将直播流声音分离出来进行音频审核。

每个审核场景单独计费，例如您选择审核涉黄、广告两种场景，则审核1个直播流，计2次审核费用。

调用接口会产生 直播审核费用 。

说明

 直播审核不会产生截帧费用，已合并至审核费用中。

限制说明

直播流时长支持：5小时以内。

直播流分辨率支持：最大支持1920x1080 (1080p)。

接口默认并发数量：10。

https://cloud.tencent.com/document/product/436/76264
https://cloud.tencent.com/document/product/460/56345
https://cloud.tencent.com/document/product/436/59080
https://cloud.tencent.com/document/product/436/58965#.E7.9B.B4.E6.92.AD.E5.AE.A1.E6.A0.B8.E5.AE.9A.E4.BB.B7
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对象存储 SDK 提供了完整的 Demo、自动集成、计算签名等能力。您可通过 SDK 方便快捷地调用接口。 点此查

看 SDK 文档 。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

支持的直播流媒体协议：rmtp、hls、http、https 等主流协议。

默认并发审核路数限制：10路，超过并发审核路数，接口会返回错误。

推荐使用 SDK

请求

请求示例

POST /video/auditing HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

<Request>

  <Type>live_video</Type>

  <Input>

    <Url></Url>

    <DataId></DataId>

  </Input>

  <Conf>

    <BizType></BizType>

    <Callback></Callback>

    <CallbackType></CallbackType>

https://cloud.tencent.com/document/product/436/6474
https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 节点 UserInfo 的内容：

  </Conf>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 直播流审核的具体配置项。 Container 是

节点名称（关键

字）
父节点 描述 类型

是否必

选

Type
Requ
est

审核的任务类型，直播流审核固定为 
live_video。

String 是

Input
Requ

est
包含需要审核的直播流信息。

Contai

ner
是

Conf
Requ

est
包含审核规则的配置信息。

Contai

ner
是

StorageConf
Requ
est

包含直播流转存的配置信息。
Contai
ner

否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Url
Request

.Input

需要审核的直播流播放地址，例如 

rtmp://example.com/live/123。

Str

ing
是

DataId
Request
.Input

该字段在审核结果中会返回原始内容，长度限制为512字
节。您可以使用该字段对待审核的数据进行唯一业务标识。

Str
ing

否

UserInf

o

Request

.Input
自定义字段，可用于辅助行为数据分析。

Co

nta

ine
r

否
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Container 类型 Conf 的具体数据描述如下：

节点名称（关

键字）

父节点 描述 类

型

是否

必选

TokenId
Request.Input
.UserInfo

一般用于表示账号信息，长度不超过128字
节。

Str
ing

否

Nickname
Request.Input

.UserInfo

一般用于表示昵称信息，长度不超过128字

节。

Str

ing
否

DeviceId
Request.Input

.UserInfo

一般用于表示设备信息，长度不超过128字

节。

Str

ing
否

AppId
Request.Input
.UserInfo

一般用于表示 App 的唯一标识，长度不超过
128字节。

Str
ing

否

Room
Request.Input

.UserInfo

一般用于表示房间号信息，长度不超过128

字节。

Str

ing
否

IP
Request.Input

.UserInfo

一般用于表示 IP 地址信息，长度不超过128

字节。

Str

ing
否

Type
Request.Input
.UserInfo

一般用于表示业务类型，长度不超过128字
节。

Str
ing

否

ReceiveTok

enId

Request.Input

.UserInfo

一般用于表示接收消息的用户账号，长度不

超过128字节。

Str

ing
否

Gender
Request.Input

.UserInfo

一般用于表示性别信息，长度不超过128字

节。

Str

ing
否

Level
Request.Input
.UserInfo

一般用于表示等级信息，长度不超过128字
节。

Str
ing

否

Role
Request.Input

.UserInfo

一般用于表示角色信息，长度不超过128字

节。

Str

ing
否

节点
名称

（关

键

字）

父节点 描述
类

型

是否

必选

BizT

ype

Request.

Conf

表示审核策略的唯一标识，您可以通过控制台上的审核策略页

面，配置您希望审核的场景，例如涉黄、广告、违法违规等，

配置指引： 设置审核策略 。您可以在控制台上获取到 

BizType。BizType 填写时，此条审核请求将按照该审核策

Str

ing

是
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Container 类型 StorageConf 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

略中配置的场景进行审核。BizType 不填写时，将自动使用

默认的审核策略。

Call

bac
k

Request.
Conf

回调地址，以 http:// 或者 https:// 开头的地址。
Str
ing

否

Call

bac
kTy

pe

Request.
Conf

回调片段类型，有效值：1（回调全部截帧和音频片段）、2
（仅回调违规截帧和音频片段）。默认为 1。

Int

eg
er

否

节点

名称

（关
键

字）

父节点 描述
类

型

是否

必选

Pat

h

Reque
st.Stor

ageCo

nf

表示直播流所要转存的路径，直播流的 ts 文件和 m3u8 文件将

保存在本桶该目录下。m3u8 文件保存文件名为 
Path/{$JobId}.m3u8，ts 文件的保存文件名为 

Path/{$JobId}-{$Realtime}.ts，其中 Realtime 为17位

年月日时分秒毫秒 时间。

Str

ing
否

响应

响应头

响应体

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <State></State>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 直播流审核返回的具体响应内容。 Container

节点名称（关
键字）

父节点 描述 类型

JobsDetail
Resp

onse
直播流审核任务的详细信息。 Container

RequestId
Resp

onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到

问题时，该 ID 能更快地协助定位问题。
String

节点名称

（关键

字）

父节点 描述
类

型

DataId
Response.J

obsDetail
请求中添加的唯一业务标识。

Str

ing

JobId
Response.J
obsDetail

本次直播流审核任务的 ID。
Str
ing

State
Response.J

obsDetail

直播流审核任务的状态，值为 Submitted（已提交审核）、

Success（审核成功）、Failed（审核失败）、Auditing
（审核中）其中一个。

Str

ing

Creatio

nTime

Response.J

obsDetail
直播流审核任务的创建时间。

Str

ing

错误码

实际案例

请求

POST /video/auditing HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

https://cloud.tencent.com/document/product/460/42867
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Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

  <Type>live_video</Type>

  <Input>

    <Url>rtmp://example.com/live/123</Url>

    <DataId>123-fdrsg-123</DataID>

  </Input>

  <Conf>

    <Callback>http://callback.com/</Callback>

    <BizType>b81d45f94b91a683255e9a9506f45a11</BizType>

  </Conf>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Submitted</State>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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取消直播审核任务
最近更新时间：2022-07-04 11:09:57

本接口用于取消一个在进行中的直播审核任务，成功取消后将返回已终止任务的 JobID。

默认接口请求频率限制：20次/秒。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

限制说明

请求

请求示例

POST /video/cancel_auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

<body>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

    <JobsDetail>

      <DataId></DataId>

      <JobId></JobId>

      <CreationTime></CreationTime>

    </JobsDetail>

    <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 直播审核返回的具体响应内容。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetail
Resp

onse
直播流审核任务的详细信息。

Conta

iner

RequestId
Resp
onse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问题
时，该 ID 能更快地协助定位问题。

String

节点名称（关键字） 父节点 描述 类型

DataId Response.JobsDetail 请求中添加的唯一业务标识。 String

JobId Response.JobsDetail 本次直播审核任务的 ID。 String

CreationTime Response.JobsDetail 直播审核任务的创建时间。 String

错误码

实际案例

请求

POST /video/cancel_auditing/<jobId> HTTP/1.1

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1167 共1950页

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <DataId>123-fdrsg-123</DataID>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <CreationTime>2021-08-07T12:12:12+0800</CreationTime>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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查询直播审核任务结果
最近更新时间：2023-05-06 18:10:13

本接口用于主动查询指定的直播审核任务结果。直播审核功能为异步任务方式，您可以通过提交直播审核任务审核您

的直播流，然后通过查询直播审核任务接口轮询获取审核结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

功能描述

请求

请求示例

GET /video/auditing/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 数据万象授权粒度详情  文档。

请求头

请求体

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交审核任务的响应中获取。 String 是

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

<Response>

  <JobsDetail>

    <Code>Success</Code>

    <Message>Success</Message>

    <DataId></DataId>

    <JobId></JobId>

    <State></State>

    <CreationTime></CreationTime>

    <Type>live_video</Tpye>

    <SnapshotCount></SnapshotCount>

    <Result>1</Result>

    <Label></Label>

    <PornInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag></HitFlag>

        <Count></Count>

    </AdsInfo>

    <Snapshot>

        <Url></Url>

        <Text></Text>

        <Label></Label>

        <Result>1</Result>

        <SnapshotTime></SnapshotTime>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <Category></Category>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Label></Label>

            <Category></Category>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <Url></Url>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1170 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

          <OffsetTime>0</OffsetTime>

          <Duration>3000</Duration>

        <Text>哈哈哈</Text>

        <Label></Label>

        <Result>1</Result>

        <PornInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Category></Category>

            <Keywords></Keywords>

        </PornInfo>

        <AdsInfo>

            <HitFlag></HitFlag>

            <Score></Score>

            <Category></Category>

            <Keywords></Keywords>

        </AdsInfo>

    </AudioSection>

  </JobsDetail>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 直播审核的全部结果信息。 Container

节点名称

（关键字）
父节点 描述 类型

JobsDetail
Respo

nse
直播审核任务的详细信息。

Contain

er

RequestId
Respo
nse

每次请求发送时，服务端将会自动为请求生成一个 ID，遇到问
题时，该 ID 能更快地协助定位问题。

String

节点名称

（关键

字）

父节点 描述 类型
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Code Response.J

obsDetail

错误码，只有 State 为 Failed 时返回。详情请查看 错

误码列表 。

String

Messag
e

Response.J
obsDetail

错误描述，只有 State 为 Failed 时返回。 String

DataId
Response.J

obsDetail

提交任务时设置了 DataId 参数时返回，返回原始内

容，长度限制为512字节。您可以使用该字段对待审核的
数据进行唯一业务标识。

String

JobId
Response.J

obsDetail
直播审核任务的 ID。 String

State
Response.J

obsDetail

直播审核任务的状态，值为 Submitted（已提交审

核）、Success（审核成功）、Failed（审核失

败）、Auditing（审核中）其中一个。

String

Creatio
nTime

Response.J
obsDetail

直播审核任务的创建时间。 String

Snapsh

otCount

Response.J

obsDetail

当审核的直播包含视频流时，该字段表示直播截图的总

数量。
String

Label
Response.J

obsDetail

该字段用于返回检测结果中所对应的优先级最高的恶意

标签，表示模型推荐的审核结果，建议您按照业务所

需，对不同违规类型与建议值进行处理。 返回值：
Normal：正常，Porn：色情，Ads：广告，以及其他

不安全或不适宜的类型。

String

Result
Response.J

obsDetail

该字段表示本次判定的审核结果，您可以根据该结果，

进行后续的操作；建议您按照业务所需，对不同的审核
结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感内容），

2（疑似敏感内容，建议人工复核）。

Integer

PornInf

o

Response.J

obsDetail
审核场景为涉黄的审核结果信息。

Containe

r

AdsInfo
Response.J

obsDetail
审核场景为广告引导的审核结果信息。

Containe

r

Snapsh

ot

Response.J

obsDetail
该字段用于返回直播中画面截图审核的结果。

Containe

r Array

AudioS

ection

Response.J

obsDetail

当审核的直播包含音频流时，该字段用于返回直播中声

音审核的结果。如果未检测音频，则不返回。

Containe

r  Array

UserInf Response.J 用户业务字段。创建任务未设置 UserInfo 时无此字 Containe

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 Snapshot 的内容：

o obsDetail 段。 r

Type
Response.J

obsDetail
审核类型，直播审核固定为 live_video。 String

节点名称（关键

字）
父节点 描述 类型

HitFlag
Response.JobsD

etail.*Info

是否命中该审核分类，0表示未命中，1表示命中，

2表示疑似。

Inte

ger

Count
Response.JobsD
etail.*Info

命中该审核分类的截图张数。
Inte
ger

节点名称

（关键字）
父节点 描述 类型

Url
Response.JobsD

etail.Snapshot

直播截图的访问地址，您可以通过该地址查看该截图

内容，地址格式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还

需查看，请重新发起查询请求。

Strin

g

Snapshot

Time

Response.JobsD

etail.Snapshot

该字段返回当前截图的时间戳，单位为毫秒。例如

1649387157000。

Integ

er

Text
Response.JobsD

etail.Snapshot

该字段用于返回当前截图的图片 OCR 文本识别的检

测结果，仅在审核策略开启文本内容检测时返回。

Strin

g

Label
Response.JobsD

etail.Snapshot

该字段用于返回检测结果中所对应的优先级最高的恶

意标签，表示模型推荐的审核结果，建议您按照业务

所需，对不同违规类型与建议值进行处理。 返回值：

Normal：正常，Porn：色情，Ads：广告，以及

其他不安全或不适宜的类型。

Strin

g

Result
Response.JobsD

etail.Snapshot

该字段表示本次判定的审核结果，您可以根据该结

果，进行后续的操作；建议您按照业务所需，对不同

的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感内

容），2（疑似敏感内容，建议人工复核）。

Integ

er

PornInfo
Response.JobsD

etail.Snapshot
审核场景为涉黄的审核结果信息。

Cont

ainer
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Container 节点 PornInfo，AdsInfo 的内容：

Container 节点 LibResults 的内容：

AdsInfo Response.JobsD

etail.Snapshot

审核场景为广告引导的审核结果信息。 Cont

ainer

节点名

称（关

键字）

父节点 描述 类型

HitFla

g

Response.
JobsDetail

.Snapshot.

*Info

是否命中该审核分类，0表示未命中，1表示命中，2表示疑

似。
Integer

Score

Response.

JobsDetail

.Snapshot.

*Info

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高 ），越高代表该内容越有

可能属于当前返回的审核信息。

例如：色情 99，则表明该内容非常有可能属于色情内容。

Integer

Label

Response.

JobsDetail

.Snapshot.

*Info

该字段表示该截图的综合结果标签（可能为 SubLabel，可

能为人物名字等）。
String

Categ

ory

Response.

JobsDetail

.Snapshot.
*Info

该字段表示命中的审核类别。

注意：该字段可能返回空。
String

SubL

abel

Response.

JobsDetail

.Snapshot.
*Info

该字段表示审核命中的具体子标签，例如：Porn 下的 

SexBehavior 子标签。
注意：该字段可能返回空，表示未命中具体的子标签。

String

OcrR
esults

Response.

JobsDetail
.Snapshot.

*Info

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信
息、文本识别结果等信息，有相关违规内容时返回。

Contain
er Array

LibRe
sults

Response.

JobsDetail
.Snapshot.

*Info

该字段用于返回基于风险库识别的结果。
注意：未命中风险库中样本时，此字段不返回。

Contain
er Array
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OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

节点

名称
（关

键

字）

父节点 描述 类

型

Imag

eId

Response.Jobs
Detail.Snapsho

t.*Info.LibResul

ts

该字段表示命中的风险库中的图片样本 ID。
Str

ing

Scor

e

Response.Jobs

Detail.Snapsho

t.*Info.LibResul

ts

该字段用于返回当前标签下的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表当前的图片越有可能命中

库中的样本；如：色情 99，则表明该数据非常有可能命中库中

的色情样本。

Int

eg

er

节点名称
（关键

字）

父节点 描述 类型

Text

Response.Jobs

Detail.Snapshot.
*Info.OcrResults

图片 OCR 文本识别出的具体文本内容。 String

Keywo

rds

Response.Jobs

Detail.Snapshot.
*Info.OcrResults

在当前审核场景下命中的关键词。
String 

Array

Locati

on

Response.Jobs

Detail.Snapshot.

*Info.OcrResults

该参数用于返回 OCR 检测框在图片中的位置（左上角 

xy 坐标、长宽、旋转角度），以方便快速定位识别文字

的相关信息。

Conta

iner

节点名称
（关键

字）

父节点 描述 类型

Name
Response.JobsDetail
.Snapshot.*Info.Obje

ctResults

该标签用于返回所识别出的实体名称，例如人名。
Strin
g

Locatio

n

Response.JobsDetail

.Snapshot.*Info.Obje

该参数用于返回检测结果在图片中的位置（左上角 

xy 坐标、长宽、旋转角度），以方便快速定位相关

Cont

ainer
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Location 的具体内容如下：

Container 节点 AudioSection 的内容：

ctResults 信息。

节点名

称（关

键字）

描述 类型

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参数可唯

一确定检测框的大小和位置。

Flo

at

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参数可唯
一确定检测框的大小和位置。

Flo
at

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合剩余参

数可唯一确定检测框的大小和位置。

Flo

at

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确定检测
框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。

Flo
at

节点

名称

（关

键
字）

父节点 描述 类型

Url

Respons

e.JobsD

etail.Aud
ioSectio

n

直播声音片段的访问地址，您可以通过该地址获取该声音片段的内容，

地址格式为标准 URL 格式。
注意：每次查看数据的有效期为2小时，2小时后如还需查看，请重新

发起查询请求。

Stri
ng

Text

Respons
e.JobsD

etail.Aud

ioSectio

n

该字段用于返回当前直播声音片段的 ASR 文本识别的检测结果。
Stri

ng

Offse

tTim

e

Respons

e.JobsD

etail.Aud

该字段返回当前声音片段的时间戳，单位为毫秒，例如

1649387157000。

Inte

ger
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Container 节点 PornInfo，AdsInfo 的内容：

ioSectio

n

Dura

tion

Respons
e.JobsD

etail.Aud

ioSectio

n

当前声音片段的长度，单位毫秒。
Inte

ger

Labe

l

Respons

e.JobsD

etail.Sna

pshot

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型

推荐的审核结果，建议您按照业务所需，对不同违规类型与建议值进行

处理。 返回值：Normal：正常，Porn：色情，Ads：广告，以及其

他不安全或不适宜的类型。

Stri

ng

Resu

lt

Respons

e.JobsD

etail.Sna
pshot

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操

作；建议您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感内容），2（疑似敏感内
容，建议人工复核）。

Inte

ger

PornI
nfo

Respons

e.JobsD

etail.Aud
ioSectio

n

审核场景为涉黄的审核结果信息。

Con

tain
er

AdsI

nfo

Respons
e.JobsD

etail.Aud

ioSectio

n

审核场景为广告引导的审核结果信息。

Con

tain

er

节点

名称
（关

键

字）

父节点 描述 类型

HitFl

ag

Response.J

obsDetail.Au

dioSection.*I

nfo

是否命中该审核分类，0表示未命中，1表示命中，2表示疑

似。
String

Scor

e

Response.J

obsDetail.Au

该字段表示审核结果命中审核信息的置信度，取值范围：0

（置信度最低）-100（置信度最高 ），越高代表该内容越

有可能属于当前返回审核信息

String
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Container 节点 LibResults 的内容：

Container 节点 UserInfo 的内容：

dioSection.*I
nfo

例如：色情 99，则表明该内容非常有可能属于色情内容。

Cate
gory

Response.J

obsDetail.Au
dioSection.*I

nfo

该字段表示命中的审核类别。
注意：该字段可能返回空。

String

Key
word

s

Response.J

obsDetail.Au
dioSection.*I

nfo

在当前审核场景下命中的关键词，没有时不返回。
String 
Array

LibR
esult

s

Response.J
obsDetail.Au

dioSection.*I

nfo

该字段用于返回基于风险库识别的结果。注意：未命中风险

库中样本时，此字段不返回。

Contain

er Array

节点名称

（关键
字）

父节点 描述 类型

LibType

Response.JobsDetail.Au

dioSection.*Info.LibResul

ts

命中的风险库类型，取值为1（预设风险

库）和2（自定义风险库）。
Integer

LibName

Response.JobsDetail.Au

dioSection.*Info.LibResul

ts

命中的风险库名称。 String

Keyword

s

Response.JobsDetail.Au

dioSection.*Info.LibResul

ts

命中的库中关键词。该参数可能会有多个

返回值，代表命中的多个关键词。

String 

Array

节点名称（关键

字）
父节点 描述

类

型

是否

必选

TokenId
Request.Input.

UserInfo

一般用于表示账号信息，长度不超过128字

节。

St

ri

n
g

否

Nickname Request.Input. 一般用于表示昵称信息，长度不超过128字 St 否
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UserInfo 节。 ri

n
g

DeviceId
Request.Input.
UserInfo

一般用于表示设备信息，长度不超过128字
节。

St

ri
n

g

否

AppId
Request.Input.

UserInfo

一般用于表示 App 的唯一标识，长度不超过

128字节。

St
ri

n

g

否

Room
Request.Input.

UserInfo

一般用于表示房间号信息，长度不超过128字

节。

St
ri

n

g

否

IP
Request.Input.

UserInfo

一般用于表示 IP 地址信息，长度不超过128

字节。

St

ri

n

g

否

Type
Request.Input.

UserInfo

一般用于表示业务类型，长度不超过128字

节。

St

ri

n

g

否

ReceiveTok

enId

Request.Input.

UserInfo

一般用于表示接收消息的用户账号，长度不超

过128字节。

St

ri

n
g

否

Gender
Request.Input.

UserInfo

一般用于表示性别信息，长度不超过128字

节。

St

ri

n
g

否

Level
Request.Input.
UserInfo

一般用于表示等级信息，长度不超过128字
节。

St

ri
n

g

否

Role Request.Input.

UserInfo

一般用于表示角色信息，长度不超过128字

节。

St

ri

否
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

n

g

错误码

实际案例

请求

GET /video/auditing/vab1ca9fc8a3ed11ea834c525400863904 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <JobsDetail>

    <JobId>vab1ca9fc8a3ed11ea834c525400863904</JobId>

    <State>Success</State>

    <CreationTime>2019-07-07T12:12:12+0800</CreationTime>

    <Type>live_video</Tpye>

    <SnapshotCount>1</SnapshotCount>

    <Label>Normal</Label>

    <Result>0</Result>

    <PornInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </PornInfo>

    <AdsInfo>

        <HitFlag>0</HitFlag>

        <Count>0</Count>

    </AdsInfo>

    <Snapshot>

https://cloud.tencent.com/document/product/460/42867
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        <Url>http://examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/0.jpg</U

        <SnapshotTime>1649387157000</SnapshotTime>

        <Text>哈哈</Text>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </PornInfo>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

            <Label></Label>

            <SubLabel></SubLabel>

        </AdsInfo>

    </Snapshot>

    <AudioSection>

        <AdsInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </AdsInfo>

        <Duration>30000</Duration>

        <OffsetTime>1649387157000</OffsetTime>

        <Label>Normal</Label>

        <Result>0</Result>

        <PornInfo>

            <HitFlag>0</HitFlag>

            <Score>0</Score>

        </PornInfo>

        <Text>wc xx</Text>

        <Url>https://auditing-1250000000.cos.ap-guangzhou.myqcloud.com/q9MhdztF/0.m

    </AudioSection>

  </JobsDetail>

  <RequestId>xxxxxxxxxxxxxx</RequestId>

</Response>
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直播审核回调内容
最近更新时间：2022-10-18 14:19:20

若您配置了审核回调地址，在直播审核结束后，后台会将审核结果以 JSON 形式回调至您的回调地址。您可以通过

回调内容进行后续的处理操作。

回调内容分为简洁回调（Simple）和详细回调（Detail）。

功能描述
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回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Simple  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

回调内容说明

简洁回调（Simple）
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具体的数据内容如下：

data 的具体内容如下：

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "test_trace_id",

       "url": "test_url",

       "cos_headers": {

           "x-cos-meta-xx": "xx"

       }

   },

   "message": "Test request when setting callback url"

}

参数名称 描述 类型
是否必

选

code
错误码，值为0时表示审核成功，非0表示审核失败。详情请查看 内
容审核错误码 。

Integ
er

是

messa

ge
错误描述。

Strin

g
是

data 直播审核结果的详细信息。
Obje

ct
是

参数名称 描述 类型
是否必

选

trace_id
请求的 ID，如果是接口创建的异步任务，则为接口返回的 

JobId。
String 是

url 被审核直播的直播地址。 String 是

event 触发的事件，此处固定为 ReviewVideo。 String 是

https://cloud.tencent.com/document/product/460/8523#.E5.86.85.E5.AE.B9.E5.AE.A1.E6.A0.B8.E9.94.99.E8.AF.AF.E7.A0.81
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xx_info 的具体内容如下：

回调通知为 HTTP 的 POST 方法，含有 X-Ci-Content-Version: Detail  的头部。

该响应体返回为 application/json 数据，包含完整节点数据的内容展示如下：

result 该字段表示本次判定的审核结果，您可以根据该结果，进行后

续的操作；建议您按照业务所需，对不同的审核结果进行相应
处理。

有效值：0（审核正常），1 （判定为违规敏感的内容），2

（疑似敏感，建议人工复核）。

Intege

r

是

forbidden_
status

若您设置了自动冻结，该字段表示冻结状态。直播审核不涉及
该字段，默认为0：未冻结。

Intege
r

是

cos_heade

rs
资源上传时设置的自定义 header 内容，若未设置则不返回。 Object 否

porn_info 审核场景为涉黄的审核结果信息。 Object 否

ads_info 审核场景为广告引导的审核结果信息。 Object 否

data_id
提交任务时设置了DataId参数时返回，返回原始内容，长度限

制为512字节。
String 否

参数名

称
描述 类型

是否必

选

hit_fla

g

用于返回该审核场景的审核结果，返回值：
0：正常。

1：确认为当前场景的违规内容。

2：疑似为当前场景的违规内容。

Integ

er
是

label 命中的标签名称，目前为空。 String 是

count 命中该审核分类的敏感截图张数。
Integ

er
是

详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "",
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    "Object": "",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "",

        "Text": "",

        "SnapshotTime": 0,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },
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具体的数据内容如下：

JobsDetail 的具体内容如下：

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxx"

    }

  }

}

节点名称（关键字） 描述 类型

JobsDetail 任务的详细结果信息。 Object

EventName 任务的类型，为 ReviewVideo 。 String

节点名称

（关键字）
描述 类型

Code 错误码，只有 State 为 Failed 时返回。详情请查看 错误码列表 。 String

Message 错误描述，只有 State 为 Failed 时返回。 String

JobId 审核任务的 ID。 String

DataId 提交任务时设置了DataId参数时返回，返回原始内容，长度限制为512字节。 String

State

直播审核任务的状态，值为 Submitted（已提交审核）、Snapshoting

（截图中）、Success（审核成功）、Failed（审核失败）、Auditing（审

核中）其中一个。

String

CreationT

ime
直播审核任务的创建时间。 String

Url 本次审核的直播链接。 String

Snapshot

Count

截图的总数量。直播流状态为 Auditing 的回调中该字段为本次回调包含的截

图数量。

Intege

r

https://cloud.tencent.com/document/product/460/42867#.E9.94.99.E8.AF.AF.E7.A0.81.E5.88.97.E8.A1.A8
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PornInfo，AdsInfo 的具体内容如下：

Snapshot 的具体内容如下：

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的

审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

String

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议
您按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议人

工复核）。

Intege

r

PornInfo 审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

Snapshot 该字段用于返回直播中画面截图审核的结果。 Array

AudioSec

tion
该字段用于返回直播中声音审核的结果。如果未检测到声音，则不返回。 Array

BucketId 创建的审核任务所属的存储桶名称。 String

Region 存储桶所在的地域。 String

ForbidSta
te

若您设置了自动冻结，该字段表示视频的冻结状态。0：未冻结，1：已被冻
结，2：已转移文件。

Intege
r

CosHead

ers

资源上传到 COS 时设置的自定义 Header 内容，如果未设置则不返回。

map 结构，key 为自定义 Header 的名称，value 为内容。
Object

UserInfo 用户业务字段。创建任务时未设置 UserInfo 则无此字段。 Object

Type 审核类型，直播流审核返回 live_video。 String

ListInfo 账号黑白名单结果。
Contai

ner

节点名称（关键字） 描述 类型

HitFlag 是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Count 命中该审核分类的截图张数。 Integer

节点名称

（关键

描述 类型
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Snapshot 中 PornInfo，AdsInfo 的具体内容如下：

字）

Url

直播截图的访问地址，您可以通过该地址查看该截图内容，地址格式为标准 

URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请求。

String

Snapsh
otTime

该字段返回当前截图的时间戳，单位为毫秒。例如1649387157000。
Intege
r

Text
该字段用于返回当前截图的图片 OCR 文本识别的检测结果，仅在审核策略开启

文本内容检测时返回。
String

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的审

核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

String

Result

该字段表示本次判定的审核结果，您可以根据该结果，进行后续的操作；建议您

按照业务所需，对不同的审核结果进行相应处理。

有效值：0（审核正常），1 （判定为违规敏感文件），2（疑似敏感，建议人工

复核）。

Intege

r

PornInf

o
审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object

节点名
称（关

键字）

描述 类型

HitFla
g

是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信

息。
例如：色情 99，则表明该内容非常有可能属于色情内容。

Integer

Label
该字段表示该截图的综合结果标签（可能为 SubLabel，可能为人物名字

等）。
String

Categ

ory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字

段可能为空，表示未命中或暂无相关的类别。

注意：该字段可能返回空。

String

SubLa 该字段表示审核命中的具体子标签，例如：Porn 下的 SexBehavior 子标 String
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Container 节点 LibResults 的内容：

OcrResults 的具体内容如下：

ObjectResults 的具体内容如下：

Location 的具体内容如下：

bel 签。

注意：该字段可能返回空，表示未命中具体的子标签。

OcrRe

sults

该字段表示 OCR 文本识别的详细检测结果，包括文本坐标信息、文本识别

结果等信息，有相关违规内容时返回。
Array

LibRes
ults

该字段用于返回基于风险库识别的结果。
注意：未命中风险库中样本时，此字段不返回。

Container 
Array

节点名称
（关键

字）

描述 类型

ImageId 该字段表示命中的风险库中的图片样本 ID。 String

Score

该字段用于返回当前标签下的置信度，取值范围：0（置信度最低）-100

（置信度最高 ），越高代表当前的图片越有可能命中库中的样本；如：色情 

99，则表明该数据非常有可能命中库中的色情样本。

Integer

节点名称（关

键字）
描述 类型

Text 图片 OCR 文本识别出的具体文本内容。 String

Keywords 在当前审核场景下命中的关键词。 Array

Location
该参数用于返回 OCR 检测框在图片中的位置（左上角 xy 坐标、长宽、

旋转角度），以方便快速定位识别文字的相关信息。
Object

节点名称（关键

字）
描述 类型

Name 该标签用于返回所识别出的实体名称，如人名。
Stri

ng

Location
该参数用于返回检测结果在图片中的位置（左上角 xy 坐标、长宽、旋转角
度），以方便快速定位相关信息。

Obj
ect

节点名称 描述 类型
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AudioSection 的具体内容如下：

AudioSection 中 PornInfo，AdsInfo 的具体内容如下：

（关键字）

X
该参数用于返回检测框左上角位置的横坐标（x）所在的像素位置，结合剩余参

数可唯一确定检测框的大小和位置。
Float

Y
该参数用于返回检测框左上角位置的纵坐标（y）所在的像素位置，结合剩余参

数可唯一确定检测框的大小和位置。
Float

Height
该参数用于返回检测框的高度（由左上角出发在 y 轴向下延伸的长度），结合
剩余参数可唯一确定检测框的大小和位置。

Float

Width
该参数用于返回检测框的宽度（由左上角出发在 x 轴向右延伸的长度），结合

剩余参数可唯一确定检测框的大小和位置。
Float

Rotate
该参数用于返回检测框的旋转角度，该参数结合 X 和 Y 两个坐标参数可唯一确

定检测框的具体位置；取值：0 - 360（角度制），方向为逆时针旋转。
Float

节点名称

（关键

字）

描述 类型

Url

直播声音片段的访问地址，您可以通过该地址获取该声音片段的内容，地址格

式为标准 URL 格式。

注意：每次查看数据的有效期为2小时，2小时后如还需查看，请发起查询请
求。

String

Text 该字段用于返回当前直播声音片段的 ASR 文本识别的检测结果。 String

OffsetTi
me

该字段返回当前声音片段的时间戳，单位为毫秒，例如1649387157000。 Integer

Duratio

n
当前声音片段的时长，单位毫秒。 Integer

Label

该字段用于返回检测结果中所对应的优先级最高的恶意标签，表示模型推荐的

审核结果，建议您按照业务所需，对不同违规类型与建议值进行处理。

返回值：Normal：正常，Porn：色情，Ads：广告。

String

Result 供参考的识别结果，0（正常），1（敏感），2（疑似敏感）。 Integer

PornInf

o
审核场景为涉黄的审核结果信息。 Object

AdsInfo 审核场景为广告引导的审核结果信息。 Object
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Container 节点 LibResults 的内容：

UserInfo 的内容：

节点名

称（关

键字）

描述 类型

HitFla

g
是否命中该审核分类，0表示未命中，1表示命中，2表示疑似。 Integer

Score

该字段表示审核结果命中审核信息的置信度，取值范围：0（置信度最

低）-100（置信度最高 ），越高代表该内容越有可能属于当前返回审核信息
例如：色情99，则表明该内容非常有可能属于色情内容。

Integer

Categ

ory

表示命中的具体审核类别。例如 Sexy，表示色情标签中的性感类别。该字段

可能为空，表示未命中或暂无相关的类别。
注意：该字段可能返回空。

String

Keywo

rds
在当前审核场景下命中的关键词，没有时不返回。 Array

LibRes

ults

该字段用于返回基于风险库识别的结果。注意：未命中风险库中样本时，此字

段不返回。

Containe

r Array

节点名称（关键字） 描述 类型

LibType
命中的风险库类型，取值为1（预设黑白库）和2（自定义风险
库）。

Integer

LibName 命中的风险库名称。 String

Keywords
命中的库中关键词。该参数可能会有多个返回值，代表命中的多
个关键词。

String 
Array

节点名称（关键字） 描述 类型 是否必选

TokenId 一般用于表示账号信息，长度不超过128字节。 String 否

Nickname 一般用于表示昵称信息，长度不超过128字节。 String 否

DeviceId 一般用于表示设备信息，长度不超过128字节。 String 否

AppId
一般用于表示 App 的唯一标识，长度不超过128字
节。

String 否

Room 一般用于表示房间号信息，长度不超过128字节。 String 否
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Container 节点 ListInfo 的内容：

Container 节点 ListResults 的内容：

IP 一般用于表示 IP 地址信息，长度不超过128字节。 String 否

Type 一般用于表示业务类型，长度不超过128字节。 String 否

ReceiveTokenId
一般用于表示接收消息的用户账号，长度不超过

128字节。
String 否

Gender 一般用于表示性别信息，长度不超过128字节。 String 否

Level 一般用于表示等级信息，长度不超过128字节。 String 否

Role 一般用于表示角色信息，长度不超过128字节。 String 否

节点名称（关键字） 描述 类型

ListResults 命中的所有名单结果。 Container Array

节点名称（关键字） 描述 类型

ListType 命中的名单类型，取值为0（白名单）和1（黑名单）。 Integer

ListName 命中的名单名称。 String

Entity 命中了名单中的哪条内容。 String

实际案例

案例一：简洁回调（Simple）

{

   "code": 0,

   "data": {

       "event":"ReviewVideo",

       "forbidden_status": 0,

       "porn_info": {

           "hit_flag": 0,

           "label": "",

           "count": 0

       },

       "result": 0,

       "trace_id": "vxzt90jl2dfscxxxxxxxxxxxxxxxxx",

       "url": "https://66665.livepush.myqcloud.com/video.flv",
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       "cos_headers": {

           "x-cos-meta-id": "666666"

       }

   },

   "message": "success"

}

案例二：详细回调（Detail）

{

  "EventName": "ReviewVideo",

  "JobsDetail": {

    "JobId": "xxxxxx",

    "State": "Success",

    "CreationTime": "2021-08-10T21:01:10+08:00",

    "Url": "https://66665.livepush.myqcloud.com/video.flv",

    "Label": "Normal",

    "Result": 0,

    "SnapshotCount": 1,

    "PornInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "AdsInfo": {

      "HitFlag": 0,

      "Count": 0

    },

    "Snapshot": [

      {

        "Url": "https://video-1250000000.cos.ap-chongqing.myqcloud.com/test/0.jpg",

        "Text": "",

        "SnapshotTime": 41,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",

          "SubLabel": ""

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0,

          "Label": "",
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          "SubLabel": ""

        }

      }

    ],

    "AudioSection": [

      {

        "Url": "https://audio-1250000000.cos.ap-guangzhou.myqcloud.com/0.mp3",

        "Text": "",

        "OffsetTime": 0,

        "Duration": 30000,

        "Label": "Normal",

        "Result": 0,

        "PornInfo": {

          "HitFlag": 0,

          "Score": 0

        },

        "AdsInfo": {

          "HitFlag": 0,

          "Score": 0

        }

      }

    ],

    "BucketId": "examplebucket-1250000000",

    "Region": "ap-chongqing",

    "ForbidState": 0,

    "CosHeaders": {

        "x-cos-meta-id": "xxxx"

    }

  }

}
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AI 内容识别

异步服务和队列配置
开通AI 内容识别（异步）服务
最近更新时间：2023-08-01 16:46:25

本接口用于开通AI 内容识别（异步）服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /ai_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 AiBucket 的内容：

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

AiBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.AiBucket 存储桶 ID String

Name Response.AiBucket 存储桶名称，同 BucketId String

Region Response.AiBucket 所在的地域 String

CreateTime Response.AiBucket 创建时间 String

实际案例

请求

POST /ai_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AiBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </AiBucket>

</Response>
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查询AI 内容识别（异步）服务
最近更新时间：2023-08-01 16:46:25

本接口用于查询已经开通AI 内容识别（异步）服务的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /ai_bucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述
默
认

值

是否
必填

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域

以“,”分隔字符串，详情请参见 地域与域名  
无 否

bucketNam

es
存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 无 否

bucketNam 存储桶名称前缀，前缀搜索 无 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

e

pageNumb
er

第几页 1 否

pageSize 每页个数，大于0且小于等于100的整数 10 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AiBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </AiBucketList>

    <AiBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </AiBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 AiBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码 文档。

RequestId Respon

se

请求的唯一 ID String

TotalCount
Respon
se

开通AI 内容识别（异步）的 Bucket 总数 Int

PageNumber
Respon

se
当前页数，同请求中的 pageNumber Int

PageSize
Respon

se
每页个数，同请求中的 pageSize Int

AiBucketList
Respon
se

AI 内容识别（异步） Bucket 详情
Contain
er 数组

节点名称（关

键字）
父节点 描述 类型

BucketId
Response.AiBucket

List
存储桶 ID

Strin

g

Name
Response.AiBucket

List
存储桶名称，同 BucketId

Strin

g

Region
Response.AiBucket
List

所在的地域
Strin
g

CreateTime
Response.AiBucket

List
创建时间

Strin

g

错误码

实际案例

请求

GET /ai_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2021 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AiBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </FileBucketList>

    <FileBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </AiBucketList>

</Response>
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关闭AI 内容识别（异步）服务
最近更新时间：2023-08-01 16:46:27

本接口用于关闭AI 内容识别（异步）服务并删除队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /ai_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

BucketName Response 存储桶名称 String

错误码

实际案例

请求

DELETE /ai_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42867
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</Response>
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查询AI 内容识别（异步）队列
最近更新时间：2023-08-01 16:46:25

本接口用于查询AI 内容识别（异步）队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /ai_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述

类

型

是否

必选

queueIds 队列 ID，以“,”符号分割字符串
Str

ing
否

state

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度执行，队列内的所有作
业状态维持在暂停状态，已经执行中的任务不受影响

Str
ing

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

具体的数据内容如下：

pageNumb
er

第几页，默认值1 Str
ing

否

pageSize 每页个数，默认值10
Str

ing
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-ai</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1207 共1950页

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
队列总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

QueueList
Respons

e
队列数组

Container 数

组

NonExistPIDs
Respons

e
不存在的队列 ID 列表 String 数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi

st
队列名字 String

State
Response.QueueLi

st
当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi

st
队列最大长度 Int

MaxConcurrent
Response.QueueLi

st
当前队列最大并行执行的任务数 Int

Category Response.QueueLi
st

队列类型 String
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UpdateTime
Response.QueueLi

st
更新时间 String

CreateTime
Response.QueueLi

st
创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.Notify

Config
回调地址 String

State
Response.QueueList.Notify
Config

开关状态 String

Type
Response.QueueList.Notify

Config
回调类型 String

Event
Response.QueueList.Notify

Config
回调事件 String

ResultFormat
Response.QueueList.Notify
Config

回调类型 String

MqMode
Response.QueueList.Notify

Config
TDMQ 使用模式 String

MqRegion
Response.QueueList.Notify

Config
TDMQ 所属园区 String

MqName
Response.QueueList.Notify
Config

TDMQ 主题名称 String

错误码

实际案例

请求

GET /ai_queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-ai</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>AIProcess</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>
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更新AI 内容识别（异步）队列
最近更新时间：2023-08-01 16:46:25

本接口用于更新AI 内容识别（异步）的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /ai_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-ai</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值
限
制

Request 无 保存结果的容器
Contain

er
是 无 无

节点名称（关
键字）

父节
点

描述 类型
默
认

值

是否
必选

Name
Req

uest

队列名称，仅支持中文、英文、数字、_、-和

*，长度不超过 128

Strin

g
无 是

State
Req

uest

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度

执行，队列内的所有作业状态维持在暂停状
态，已经执行中的任务不受影响

Strin

g
无 是

NotifyConf

ig

Req

uest
回调配置

Cont

ainer
无 是

节点名称（关
键字）

父节点 描述
类
型

默
认

值

是否必选

State
Request.No
tifyConfig

回调开关

Off

On

Str
ing

Off 否

Event
Request.No
tifyConfig

回调事件

TaskFinish：任务完成

WorkflowFinish：工作流

完成

Str
ing

无
当 State=On 
时，必选

ResultFor
mat

Request.No
tifyConfig

回调格式
XML

JSON

Str
ing

XM
L

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Type
Request.No

tifyConfig

回调类型
Url

TDMQ

Str

ing
无

当 State=On 

时，必选

Url
Request.No

tifyConfig
回调地址，不能为内网地址。

Str

ing
无

当 
State=On，

且 Type=Url 

时，必选

MqMode
Request.No

tifyConfig

TDMQ 使用模式

Topic：主题订阅

Queue: 队列服务

Str

ing
无

当 
State=On，

且 

Type=TDM

Q 时，必选

MqRegion
Request.No

tifyConfig

TDMQ 所属园区，目前支持园

区 sh（上海）、bj（北京）、

gz（广州）、cd（成都）、hk
（中国香港）

Str

ing
无

当 

State=On，

且 
Type=TDM

Q 时，必选

MqName
Request.No

tifyConfig
TDMQ 主题名称

Str

ing
无

当 

State=On，
且 

Type=TDM

Q 时，必选

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-ai</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>AIProcess</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键字） 父节点 描述 类型

QueueId
Response.Queu

e
队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu

e
当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu

e

回调配置，同 

Request.NotifyConfig

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxSize Response.Queu

e

队列最大长度 Int

MaxConcurrent
Response.Queu
e

当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu
e

创建时间 String

错误码

实际案例

请求

PUT /ai_queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-ai</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-ai</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>AIProcess</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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图片上色
最近更新时间：2023-06-19 16:47:02

腾讯云数据万象通过 AIImageColoring 接口对黑白图像进行上色。

操作名称：AIImageCrop。

功能描述

使用限制：

待处理的图片，原图大小不超过5MB，分辨率大于32 x 32像素。

接口携带签名，下载时处理，请求参数需要记入签名内

1. 下载时处理

请求

 原图存储在COS：  

GET /<ObjectKey>?ci-process=AIImageColoring HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=AIImageColoring&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型
是否

必选

Objec

tKey
对象文件名，例如：folder/document.jpg。

Stri

ng
否

ci-
proce

数据万象处理能力，图片上色参固定为AIImageColoring。 Stri
ng

是
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处理后的图片直接返回至响应体。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

ss

detec

t-url

待上色图片url，需要进行urlencode，与ObjectKey二选其一，如果同

时存在，则默认以ObjectKey为准

Stri

ng
否

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

该请求body内容为待上色图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

参数名
称

类
型

是否
必选

描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数

名称
类型

是否

必选
描述

buck

et

Stri

ng
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定

的话默认保存到当前存储桶

fileid
Stri

ng
是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文

件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名
为 test2.jpg 的文件

3.  注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Stri

ng
是 处理参数，固定为：ci-process=AIImageColoring

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

ETag OriginalInfo 原图的Etag值

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 上色后图片文件名 String

Location Object 上色后的图片链接 String

ETag Object 上色后图片的ETag值 String

Size Object 图片大小 Int

示例

请求：

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com. . . .
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Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageColoring"

  

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求语法

POST  /<ObjectKey> HTTP/1.1
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数

名称

类

型

是否

必选
描述

buck

et

Str

ing
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定

的话默认保存到当前存储桶

fileid Str
ing

是 处理后文件的保存路径及名称。名称规则说明：
例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文件

夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 文
件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名为 

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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空

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Str

ing
是 处理参数，固定为：ci-process=AIImageColoring

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

ETag OriginalInfo 原图ETag String

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1223 共1950页

Object 节点内容：

处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 上色后图片文件名 String

Location Object 上色后的图片链接 String

ETag Object 上色后图片的ETag值 String

Size Object 上色后图片大小 Int

示例

请求：

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageColoring"

  

. . . .

{

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

,
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        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

. . . . .

. . . .
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图像超分
最近更新时间：2023-06-19 16:47:02

腾讯云数据万象通过 AISuperResolution 接口对图像进行超分辨率处理，当前默认超分为宽高的2倍。

操作名称：AIImageCrop。

功能描述

使用限制：

待处理的图片，原图大小不超过5MB，分辨率不得超过 1920px * 1080px。

支持处理JPG PNG JPEG格式图片。

1. 下载时处理

请求

 原图存储在COS：  

GET /<ObjectKey>?ci-process=AISuperResolution HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=AISuperResolution&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型
是否

必选

Object

Key
对象文件名，例如：folder/document.jpg。

Stri

ng
否

ci-

proces

数据万象处理能力，只能裁剪参固定为AISuperResolution。 Stri

ng

是
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处理后的图片直接返回至响应体。

s

detect
-url

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

detect-url 时，后台会默认处理 ObjectKey  ，填写了 detect-url 

时，后台会处理 detect-url 链接，无需再填写

 ObjectKey，detect-url 示例：

http://www.example.com/abc.jpg  ，需要进行 UrlEncode ，处理

后为

http%25253A%25252F%25252Fwww.example.com%25252Fab

c.jpg。

Stri
ng

否

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

请求头

https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

该请求body内容为待上色图片原图 

[Image Content]

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数名

称
类型

是否必

选
描述

bucke
t

Strin
g

否
存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不
指定的话默认保存到当前存储桶

fileid
Strin

g
是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 

p2 文件夹中存储了一个文件名为 test2.jpg 的文件 

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个

文件名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为

<ObjectKey>

rule
Strin

g
是 处理参数，固定为：ci-process=AISuperResolution

请求体

https://cloud.tencent.com/document/product/460/42865
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此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 原图路径 String

ETag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 超分后图片文件名 String

Location Object 超分后的图片链接 String

ETag Object 超分后图片的ETag值 String

https://cloud.tencent.com/document/product/460/42866
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Size Object 超分后图片大小 Int

示例

请求

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AISuperResolution"

  

. . . .

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

,

. . . . .

. . . .
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Authorization:Auth String （详情请参见 请求签名  文档）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

</UploadResult>

3.云上数据处理

请求语法

POST  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否必

选
描述

is_pic

_info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不
进行图片处理

参数

名称

类

型

是否必

选
描述

buck
et

Str
ing

否
存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定
的话默认保存到当前存储桶

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/42865


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1231 共1950页

该请求body内容为待上色图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

fileid Str

ing

是 处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg
1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文

件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名
为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Str

ing
是 处理参数，固定为：ci-process=AISuperResolution

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

https://cloud.tencent.com/document/product/460/42866
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ProcessResults 节点内容：

Object 节点内容：

处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

Location OriginalInfo 原图路径 String

ETag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 超分后图片文件名 String

Location Object 超分后的图片链接 String

ETag Object 超分后图片的ETag值 String

Size Object 图片大小 Int

示例

请求：

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AISuperResolution"

  

. . . .

{

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml
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Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .
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图像增强
最近更新时间：2023-06-19 16:47:02

腾讯云数据万象通过 AIEnhanceImage 接口对图像进行增强处理。

操作名称：AIImageCrop。

功能描述

注意

使用限制：待处理的图片，原图大小不超过5MB。

1. 下载时处理

请求

原图存储在COS：  

GET /<ObjectKey>?ci-process=AIEnhanceImage&denoise=<denoise>&sharpen=<sha

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /<ObjectKey>?ci-process=AIEnhanceImage&denoise=<denoise>&sharpen=<sha

Host: <BucketName-APPID> pic <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型
是否

必选

Object

Key
对象文件名，例如：folder/document.jpg。

Stri

ng
是

ci-
proces

s

数据万象处理能力，只能裁剪参固定为 AIEnhanceImage。
Stri
ng

是
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处理后的图片直接返回至响应体。

denois
e

去噪强度值，取值范围为 0 - 5 之间的整数，值为 0 时不进行去噪操作，
默认值为3。

Inte
ger

否

sharpe

n 

锐化强度值，取值范围为 0 - 5 之间的整数，值为 0 时不进行锐化操作，

默认值为3。

Inte

ger
否

detect
-url 

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

detect-url  时，后台会默认处理 ObjectKey  ，填写了 detect-url  

时，后台会处理 detect-url 链接，无需再填写 

ObjectKey ，detect-url  示例：

http://www.example.com/abc.jpg  ，需要进行 UrlEncode，处理

后为  

http%25253A%25252F%25252Fwww.example.com%25252Fab

c.jpg

Stri
ng

否

ignore

-error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而

不报错。

Inte

ger
-

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

. . . .

{

,
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIEnhanceImage"

  

[{

,

}]

}

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

. . . .
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处理后的图片存至存储桶，并以 fileid 字段的值作为对象名称。

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIEnhanceImage"

  

{

[{

,

}]

}

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .
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图像智能裁剪
最近更新时间：2023-06-19 16:47:02

腾讯云数据万象通过 AIImageCrop 接口对图像进行智能裁剪，支持持久化、云上处理及下载时处理。

操作名称：AIImageCrop。

功能描述

使用限制：

待处理的图片，原图大小不超过5MB。

支持处理PNG JPG JPEG格式图片。

输入图片分辨率需大于32 x 32，此功能需携带签名。

1. 下载时处理

请求

 原图存储在COS：  

GET /<ObjectKey>?ci-process=AIImageCrop&width=<width>&height=<height>&fixe

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

 原图来自其他链接：

GET /<ObjectKey>?ci-process=AIImageCrop&width=<width>&height=<height>&fixe

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型
是否

必选

Objec
tKey

对象文件名，例如：folder/document.jpg
Stri
ng

是

ci- 数据万象处理能力，智能裁剪固定为AIImageCrop Stri 是
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处理后的图片直接返回至响应体。

proce

ss

ng

detec

t-url

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

detect-url 时，后台会默认处理 ObjectKey ，填写了 detect-url 
时，后台会处理 detect-url 链接，无需再填写 ObjectKey detect-url 

示例： http://www.example.com/abc.jpg  ，需要进行 UrlEncode，

处理后为

http%25253A%25252F%25252Fwww.example.com%25252Fabc

.jpg

Stri

ng
否

width
需要裁剪区域的宽度，与height共同组成所需裁剪的图片宽高比例；输入

数字请大于0、小于图片宽度的像素值

Inte

ger
是

height

需要裁剪区域的高度，与width共同组成所需裁剪的图片宽高比例；输入数

字请大于0、小于图片高度的像素值；width : height建议取值在[1, 2.5]

之间，超过这个范围可能会影响效果

Inte

ger
是

fixed

是否严格按照 width 和 height 的值进行输出。取值为0时，宽高比例

（width : height）会简化为最简分数，即如果width输入10、height输

入20，会简化为1：2；取值为1时，输出图片的宽度等于width，高度等

于height；默认值为0

Inte

ger
否

ignor

e-

error

当此参数为1时，针对文件过大等导致处理失败的场景，会直接返回原图而

不报错

Inte

ger
否

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求语法
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic_
info

Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数
名称

类型
是否必
选

描述

buck

et

Strin

g
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指

定的话默认保存到当前存储桶

fileid Strin

g

是 处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 

文件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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rule包含的处理参数为：

该请求body内容为待裁剪图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

p1 文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个

文件名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Strin
g

是 处理参数

参数名

称

类

型

是否

必选
描述

ci-

proce
ss

Str
ing

是 数据万象处理能力，智能裁剪参固定为 AIImageCrop

width

Int

eg
er

是
需要裁剪区域的宽度，与height共同组成所需裁剪的图片宽高比例；输入

数字请大于0、小于图片宽度的像素值

height

Int

eg

er

是

需要裁剪区域的高度，与 width 共同组成所需裁剪的图片宽高比例；输入

数字请大于0、小于图片高度的像素值；width : height建议取值在[1, 

2.5]之间，超过这个范围可能会影响效果；

fixed

Int

eg

er

否

是否严格按照 width 和 height 的值进行输出。取值为0时，宽高比例

（width : height）会简化为最简分数，即如果 width 输入10、height

输入20，会简化为1：2；取值为1时，输出图片的宽度等于 width，高度
等于 height；默认值为0

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

Etag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 裁剪后图片文件名 String

Location Object 裁剪后的图片链接 String

ETag Object 裁剪后图片的ETag值 String

Size Object 裁剪后图片大小 Int

示例

请求：

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

. . . .
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处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageCrop&width=<width>&height=<height>&fixed=<fixed>

  

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .

3.云上数据处理

请求语法

POST  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com
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Authorization:Auth String （详情请参见 请求签名  文档）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不
进行图片处理

参数

名称
类型

是否

必选
描述

buck
et

Strin
g

否
存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指
定的话默认保存到当前存储桶

fileid Strin

g

是 处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 
文件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件

名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/42865
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rule包含的处理参数为：

空

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

rule
Strin
g

是 处理参数

参数名

称
类型

是否

必选
描述

ci-
proce

ss

Stri
ng

是 数据万象处理能力，智能裁剪参固定为AIImageCrop。

width
Inte

ger
是

需要裁剪区域的宽度，与height共同组成所需裁剪的图片宽高比例；输入

数字请大于0、小于图片宽度的像素值

height
Inte

ger
是

需要裁剪区域的高度，与width共同组成所需裁剪的图片宽高比例；输入

数字请大于0、小于图片高度的像素值；width : height建议取值在[1, 

2.5]之间，超过这个范围可能会影响效果；

fixed
Inte

ger
否

是否严格按照 width 和 height 的值进行输出。取值为0时，宽高比例

（width : height）会简化为最简分数，即如果 width 输入10、height

输入20，会简化为1：2；取值为1时，输出图片的宽度等于 width，高度

等于 height；默认值为0

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

https://cloud.tencent.com/document/product/460/42866
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OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

Etag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 裁剪后图片文件名 String

Location Object 裁剪后的图片链接 String

ETag Object 裁剪后图片的ETag值 String

Size Object 裁剪后图片大小 Int

示例

请求：

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=AIImageCrop&width=<width>&height=<height>&fixed=<fixed>

  

. . . .

{

[{

,

}]
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处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>ObjectKey</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>exampleobject</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

. . . . .

. . . .
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实时文字翻译
最近更新时间：2023-06-19 16:47:03

腾讯云数据万象通过 AutoTranslationBlock  接口对文字块进行翻译，请求时需要携带签名。

SourceLang、TargetLang 可填参数参考这个：

文本翻译

请求

请求语法

GET /?ci-process=AutoTranslationBlock&InputText=<InputText>&SourceLang=<SourceLa

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 描述 类型 是否必选

ci-

process

数据万象处理能力，文本块翻译固定为 

AutoTranslationBlock。

Strin

g
是

InputText 待翻译的文本
Strin

g
是

SourceLa

ng
输入语言，如 "zh"

Strin

g
是

TargetLa

ng
输出语言，如 "en"

Strin

g
是

TextDom

ain
文本所属业务领域，如: "ecommerce", //缺省值为 general

Strin

g
否

TextStyle 文本类型，如: "title", //缺省值为 sentence
Strin

g
否

https://cloud.tencent.com/document/product/436/7778
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英语 en 阿拉伯语 ar 德语 de 西班牙语 es 法语 fr 印尼语 id 意大利语 it / 日语 ja葡萄牙语 pt 俄语 ru 韩语 ko 高

棉语 km 老挝语 lo

中文 zh 阿拉伯语 ar 德语 de 西班牙语 es 法语 fr 印尼语 id 意大利语 it / 日语 ja葡萄牙语 pt 俄语 ru 韩语 ko 高

棉语 km 老挝语 lo其中，中文除了常规的简体中文（zh）外，还有繁体中文（zh-tr）、中国香港繁体中文（zh-

hk）、中国台湾繁体中文（zh-tw）。

(1) 电商：text_domain=ecommerce

(2) 电商标题: text_domain=ecommerce；text_style=title

(3) 网络文学：text_domain=net-literature

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，具体的数据内容如下：

中文（代码zh）与下列语言之间的双向互译：

英文（代码en）与下列语言之间的双向互译：

我们已开放了数个专业场景，通过text_domain和text_style参数获得相应能力：

请求头

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

TranslationResult 无 翻译结果 StringResponse 的内容

示例

请求

GET /?ci-process=AutoTranslationBlock&InputText=%E6%88%91%E6%98%AF%E6%B5%8

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: xxxxx

Authorization:XXXXXXXXXXXX

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1250 共1950页

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<TranslationResult>I&apos m testing.</TranslationResult>;
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图像修复
最近更新时间：2023-07-06 18:24:46

腾讯云数据万象通过 ImageRepair 接�能检测并擦除图片中常见的标志,并对擦除部分进行智能修复，此功能需携

带签名。

功能概述

说明：

当前图像修复功能的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过5MB，图片宽高

大于32像素 x 32像素。

1.下载时处理

请求

原图存储在COS：

GET /<ObjectKey>?ci-process=ImageRepair HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /<ObjectKey>?ci-process=ImageRepair&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

2.上传时处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

 rules（json 数组）中每一项具体参数如下：

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否必

选
描述

is_pic
_info

Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr

ay
否

处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不

进行图片处理

参数名

称
类型

是否

必选
描述

bucke

t

Stri

ng
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指

定的话默认保存到当前存储桶

fileid
Stri
ng

是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 

文件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 
文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件

名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Stri

ng
是

处理参数，ci-process=ImageRepair&MaskPic=

<MaskPic>&MaskPoly=<MaskPoly>，具体参数描述见下表

https://cloud.tencent.com/document/product/460/42865
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图像修复相关参数如下：

该请求body内容为待修复图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

参数名称 描述
类

型

是否

必选

ci-

proces

s

数据万象处理能�，图像标志擦除固定为 ImageRepair
Str

ing
是

MaskPi
c

遮罩（白色区域为需要去除的水印位置）图片地址，私有图片需携带签

名，需要经过 URL 安全的 Base64 编码 。例如，遮罩图片为 

http://examplebucket-1250000000.cos.ap-

guangzhou.myqcloud.com/shuiyin_2.png

，则该处编码后的字符串为 

aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3M

uYXAtZ3Vhbmd6aG91Lm15cWNsb3VkLmNvbS9zaHVpeWluXzI

ucG5n

Str
ing

否

MaskP
oly

例如： [[[608, 794], [1024, 794], [1024, 842], [608, 842]],

[[1295, 62], [1295, 30], [1597, 32],[1597,64]]] ，顺时针输�多边形

的每个点的坐标,每个多边形: [[x1, y1], [x2, y2]...] , 形式为三维矩阵
（多个多边形： [多边形1,多边形2] ）或�维矩阵（单个多边形），且需

要经过 URL 安全的 Base64 编码。MaskPoly同时与MaskPic填写

时，优先采�MaskPic的值

Str
ing

否

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

https://cloud.tencent.com/document/product/460/42866
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数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1254 共1950页

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 修复后图片文件名 String

Location Object 修复后的图片链接 String

ETag Object 修复后图片的ETag值 String

Size Object 图片大小 Int

示例

请求

PUT /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: "rules": "fileid":"test.jpg","rule":"ci-process=ImageRepair&MaskPic=aH

Content-Length: 64

Image Content

{ [{

[ ]

响应
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

                <OriginalInfo>

                        <Key>456.jpeg</Key>

                        <Location>examplebucket-1250000000.cos.ap-chongqing.myqcloud.com

                </OriginalInfo>

        <ProcessResults>

            <Object>

                <Key>test.jpg</Key>

                <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/test.jp

                <ETag>"eaa4e3d8fd498bbc63be3b71c46b9c61f23e3f0c"</ETag>

            </Object>

        </ProcessResults>

</UploadResult>

3.云上数据处理

请求语法

POST  /<ObjectKey>& HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

参数名称 描述 类型

ObjectKe

y
待修复图片名称，需为存储在COS上的文件名，例如 folder/sample.jpg String

请求头

https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部

Pic-Operations 为 json 格式的字符串，具体参数如下：

 rules（json 数组）中每一项具体参数如下：

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否必

选
描述

is_pic

_info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不
进行图片处理

参数

名称
类型

是否必

选
描述

buck
et

Stri
ng

否
存储结果的目标存储桶名称，格式为 BucketName-APPID，如果不指
定的话默认保存到当前存储桶

fileid
Stri

ng
是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 
文件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件

名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Stri
ng

是
处理参数，ci-process=ImageRepair&MaskPic=
<MaskPic>&MaskPoly=<MaskPoly>，具体参数描述见下表

参数名
称

描述
类
型

是否
必选

ci-

proce

ss

数据万象处理能�，图像标志擦除固定为 ImageRepair
Str

ing
是

https://cloud.tencent.com/document/product/460/42865
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该请求没有请求体

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

Mask

Pic

遮罩（白色区域为需要去除的水印位置）图片地址，私有图片需携带签名，

需要经过 URL 安全的 Base64 编码 。例如，遮罩图片为 

http://examplebucket-1250000000.cos.ap-

guangzhou.myqcloud.com/shuiyin_2.png

，则该处编码后的字符串为 

aHR0cDovL2V4YW1wbGVidWNrZXQtMTI1MDAwMDAwMC5jb3Mu

YXAtZ3Vhbmd6aG91Lm15cWNsb3VkLmNvbS9zaHVpeWluXzIuc

G5n

Str

ing

否

Mask

Poly

例如： [[[608, 794], [1024, 794], [1024, 842], [608, 842]],[[1295, 

62], [1295, 30], [1597, 32],[1597,64]]] ，顺时针输�多边形的每个点
的坐标,每个多边形: [[x1, y1], [x2, y2]...] , 形式为三维矩阵（多个多边

形： [多边形1,多边形2] ）或�维矩阵（单个多边形），且需要经过 URL 

安全的 Base64 编码。MaskPoly同时与MaskPic填写时，优先采�

MaskPic的值

Str

ing
否

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 类型 描述

https://cloud.tencent.com/document/product/460/42866
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ProcessResults 节点内容：

Object 节点内容：

Key String 原图文件名

Location String 图片路径

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 修复后图片文件名 String

Location Object 修复后的图片链接 String

ETag Object 修复后图片的ETag值 String

Size Object 图片大小 Int

示例

请求

POST /filename.jpg HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Wed, 28 Oct 2015 20:32:00 GMT

Authorization:XXXXXXXXXXXX

Pic-Operations: "rules": "fileid":"bigpic_process.jpg","rule":"ci-process=ImageRepair&M

Content-Length: 0

{ [{

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>456.jpeg</Key>
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        <Location>examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/456.jpeg<

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>bigpic_process.jpeg</Key>

            <Location>examplebucket-1250000000.cos.ap-chongqing.myqcloud.com/bigpic_

            <Format/>

            <Size>288132</Size>

            <ETag>"fa2a3d6081c1037f154401a64eec4b19"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>
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Logo 识别
最近更新时间：2023-06-19 16:47:03

腾讯云数据万象通过 RecognizeLogo 接口实现对图片内电商 Logo 的识别，返回图片中 Logo 的名称、坐标、

置信度分值。，返回图片中Logo的名称、坐标、置信度分值。图片Logo识别请求包属于 GET 请求，请求时需要

携带签名。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能概述

说明：

当前Logo识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过5MB，图片宽高大

于32像素 x 32像素，小于7680像素 x 7680像素。

请求语法

GET /?ci-process=RecognizeLogo&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 描述 类型 是否必选

ci-

process
数据万象处理能力，Logo识别固定为RecognizeLogo String 是

detect-url 待检查图片url，需要进行urlencode String 是

请求头

请求体

响应

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，具体的数据内容如下：

Response 的内容：

LogoInfo 节点内容：

Location 节点内容：

响应头

响应体

节点名称（关键字） 父节点 描述 类型

RecognitionResult 无 保存Logo识别结果的容器 Container

节点名称（关键字） 父节点 描述 类型

Status
RecognitionR

esult

Logo识别结果。0表示未识别到，1表示识别

到
Int

LogoInfo
RecognitionR

esult
Logo识别结果，可能有多个

Contain

er

节点名称（关键
字）

父节点 描述 类型

Name
LogoIn

fo
Logo的名称 String

Sorce
LogoIn

fo

Logo的置信度，取值范围为[0-100]。值越高概率越

大。
Int

Location
LogoIn
fo

图中识别到Logo的坐标
Contain
er

节点名称（关键字） 父节点 描述 类型

Point Location Logo坐标点（X坐标,Y坐标） String

示例

请求

https://cloud.tencent.com/document/product/460/42866
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GET /?ci-process=RecognizeLogo&detect-url=xxx HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: xxxxx

Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<RecognitionResult>

    <Status>1</Status>

    <LogoInfo>

      <Name>xxxxxxxx</Name>

      <Sorce>99</Sorce>

      <Location>

        <Point>100,100</Point>

        <Point>100,200</Point>

        <Point>200,200</Point>

        <Point>200,100</Point>

      </Location>

    </LogoInfo>

    <LogoInfo>

      <Name>xxxxxxxx</Name>

      <Sorce>95</Sorce>

      <Location>

        <Point>1000,1000</Point>

        <Point>1000,2000</Point>

        <Point>2000,2000</Point>

        <Point>2000,1000</Point>

      </Location>

    </LogoInfo>

</RecognitionResult>
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图片二维码识别
最近更新时间：2023-08-17 17:55:43

数据万象二维码识别功能可识别图片中有效二维码的位置及内容，输出图像中二维码包含的文本信息（每个二维码对

应的 URL 或文本），并可对识别出的二维码添加马赛克。

图片上传时识别二维码的请求包与 COS 简单上传文件接口一致，只需在请求包头部增加图片处理参数 Pic-

Operations，并将请求 Host 更改为对象存储域名即可。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口无请求参数。

Pic-Operations 为 json 格式的字符串，具体参数如下：

功能描述

请求一：上传时识别

请求

PUT /<ObjectKey> HTTP/1.1 

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date 

Authorization: Auth String 

Pic-Operations: <PicOperations> 

说明

COS 简单上传文件接口，详细请参见 PUT Object 文档 。

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

请求体

参数名

称
描述

类

型
是否必选

is_pic 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0 In 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7749
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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rules（json 数组）中每一项具体参数如下：

使用二维码识别功能需在 rule 中添加二维码识别参数（QRcode），相关内容如下：

示例参数说明如下：

_info t

rules
处理规则，一条规则对应一个处理结果（目前最多支持五条规则），不填

则不进行图片处理

A

rr

a

y

否

参
数

名

称

描述
类

型

是否必

选

bu

ck

et

存储结果的目标存储桶，格式为 BucketName-APPID，如果不指定的话

默认保存到当前存储桶

Str

ing
否

file
id

处理结果的文件路径名称，例如以 / 开头，则存入指定文件夹中，否则存入与

原图文件相同的目录位置

Str
ing

否

rul

e

处理参数，参见数据万象图片处理 API。若按指定样式处理，则以 style/ 开

头，后加样式名，

例如样式名为 test ，则 rule 字段为 style/test

Str

ing
是

QRcode/cover/<mode>

参数 描述
类

型

是否必

选

cover

二维码覆盖功能。可为0或1：

功能开启后，将对识别出的二维码覆盖上马赛克，默认值0

0表示不开启二维码覆盖

1表示开启二维码覆盖
Int 否

bar-

type

二维码/条形码识别功能，将对识别出的二维码/条形码 覆盖马赛克。取值

为0，1，2 ：

0表示都识别，

1表示识别二维码 

2表示识别条形码

Int 否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

响应体具体数据内容如下： 

UploadResult 节点内容： 

OriginalInfo 节点内容： 

ImageInfo 节点内容： 

默认值0  

segme

nt 

 通用的切片开关参数，指定是否需要切片，有效值：

默认值0，需要切片时，后台会根据图片尺寸进行切片识别

0（表示不切片）

1（表示切片）
Int 否

size  
当segment取值为1时生效，默认1000像素，取值范围为大于等于500

的整数。当size指定的数值大于图片像素时，则不进行切片，直接识别
Int 否

响应

响应头

响应体

参数名称 类型 描述

UploadResult Container 原图信息

参数名称 类型 描述

OriginalInfo Container 原图信息

ProcessResults Container 图片处理结果

节点名称 类型 描述

Key String 原图文件名

Location String 图片路径

ImageInfo Container 原图图片信息

节点名称 类型 描述

Format String 格式

https://cloud.tencent.com/document/product/460/42866
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ProcessResults 节点内容： 

Object 节点内容： 

QRcodeInfo 节点内容： 

Width Int 图片宽度

Height Int 图片高度

Quality Int 图片质量

Ave String 图片主色调

Orientation Int 图片旋转角度

节点名称 类型 描述

Object Container 每一个图片处理结果

节点名称 类型 描述

Key String 文件名

Location String 图片路径

Format String 图片格式

Width Int 图片宽度

Height Int 图片高度

Size Int 图片大小

Quality Int 图片质量

codeStatus Int 二维码识别结果。0表示未识别到二维码，1表示识别到二维码

QRcodeInf

o

Containe

r
二维码识别结果，可能有多个

节点名称 类型 描述

codeUrl String 二维码的内容。可能识别不出

codelocation Container 图中识别到的二维码位置坐标
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codelocation 节点内容：

节点名称 类型 描述

point String 二维码坐标点

实际案例

请求

PUT /picture.jpg HTTP/1.1 

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2018 09:06:15 GMT 

Authorization:XXXXXXXXXXXX 

Pic-Operations: "is_pic_info":1,"rules": "fileid":"test.jpg","rule":" QRcode/cover/1"  

Content-Length: 64 

Object  

{ [{ }]}

[ ]

响应

HTTP/1.1 200 OK 

Content-Type: application/xml 

Content-Length: 645 

Date: Tue, 03 Apr 2018 09:06:16 GMT 

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

      <OriginalInfo>

        <Key>picture.jpg</Key>

        <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/picture.jpg<

        <ImageInfo>

               <Format>JPEG</Format>

               <Width>640</Width>

               <Height>427</Height>

               <Quality>100</Quality>
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               <Ave>0xa18454</Ave>

               <Orientation>1</Orientation>

        </ImageInfo>

      </OriginalInfo>

      <ProcessResults>

        <Object>

           <Key>picture-2.jpg</Key>

           <Location>examplebucket-1250000000.cos.ap-chengdu.myqcloud.com/picture-2.

           <Format>png</Format>

           <Width>640</Width>

           <Height>427</Height>

           <Size>463092</Size>

           <Quality>100</Quality>

           <codeStatus>1</codeStatus>

           <QRcodeInfo>

              <codeUrl>xxxxxxxxxxxxx</codeUrl>

              <codelocation>

                  <point>100,100</point>

                  <point>100,200</point>

                  <point>200,200</point>

                  <point>200,100</point>

              </codelocation>

              </QRcodeInfo>

                  <codeUrl>xxxxxxxxxxxxx</codeUrl>

                  <codelocation>

                      <point>1000,1000</point>

                      <point>1000,2000</point>

                      <point>2000,2000</point>

                      <point>2000,1000</point>

                  </codelocation>

        </Object>

    </ProcessResults>

</UploadResult>

请求二：下载时识别

请求

GET /<ObjectKey>?ci-process=QRcode&cover=<cover> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1269 共1950页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名

称
描述

是否

必选
类型

Objec

tKey
对象文件名，例如 folder/sample.jpg 是

Strin

g

ci-

proce
ss

万象处理能力，二维码识别固定为 QRcode 是
Strin
g

cover
二维码覆盖功能，将对识别出的二维码覆盖上马赛克。取值为0或1。0表

示不开启二维码覆盖，1表示开启二维码覆盖，默认值0
否 Int

请求体

响应

响应头

响应体

<Response>

       <CodeStatus>1</CodeStatus>

       <QRcodeInfo>

             <CodeUrl>xxxx</CodeUrl>

             <CodeLocation>

                   <Point>xxx,xxx</Point>

                   <Point>xxx,xxx</Point>

                   <Point>xxx,xxx</Point>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Response 的内容：

QRcodeInfo 节点内容：

CodeLocation 节点内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

                   <Point>xxx,xxx</Point>

             </CodeLocation>

       </QRcodeInfo>

       <ResultImage>

            base64编码的图片

       </ResultImage>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

CodeStatus
Respo

nse

二维码识别结果。0表示未识别到二维码，1表示识别到

二维码
Int

QRcodeInfo
Respo

nse
二维码识别结果，可能有多个

Contain

er

ResultImage
Respo

nse

处理后的图片 base64数据，请求参数 cover 为1时返

回
String

节点名称（关键字） 父节点 描述 类型

CodeUrl QRcodeInfo 二维码的内容。可能识别不到内容 String

CodeLocation QRcodeInfo 图中识别到的二维码位置坐标 Container

节点名称（关键字） 父节点 描述 类型

Point CodeLocation 二维码坐标点（X坐标,Y坐标） String

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

GET /<ObjectKey>?ci-process=QRcode&cover=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

        <CodeStatus>1</CodeStatus>

           <QRcodeInfo>

               <CodeUrl>xxxxxxxxxxxxx</CodeUrl>

               <CodeLocation>

                      <Point>100,100</Point>

                <Point>100,200</Point>

                <Point>200,200</Point>

                <Point>200,100</Point>

               </CodeLocation>

        </QRcodeInfo>

           <QRcodeInfo>

                <CodeUrl>xxxxxxxxxxxxx</CodeUrl>

                <CodeLocation>

                <Point>1000,1000</Point>

                <Point>1000,2000</Point>

                <Point>2000,2000</Point>

                <Point>2000,1000</Point>

             </CodeLocation>

        </QRcodeInfo>

        <ResultImage>

           base64编码的图片

        </ResultImage>

</Response>
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图片二维码生成
最近更新时间：2023-06-19 16:47:03

数据万象二维码生成功能可根据用户指定的文本信息（URL 或文本），生成对应的二维码或条形码。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

GET /?ci-process=qrcode-generate&qrcode-content=<qrcode-content>&mode=<mode>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型
是否必

选

ci-

process
数据万象处理能力，二维码生成参数为 qrcode-generate

Stri

ng
是

qrcode-

content
可识别的二维码文本信息

Stri

ng
是

mode
生成的二维码类型，可选值：0或1。0为二维码，1为条形码，默认

值为0
Int 否

width 指定生成的二维码或条形码的宽度，高度会进行等比压缩
Stri

ng
是

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1274 共1950页

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

<Response>

        <ResultImage>

            base64编码的图片
        </ResultImage>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

ResultImage Response 二维码图片 base64 数据 String

错误码

实际案例

请求

GET /?ci-process=qrcode-generate&qrcode-content=<https://www.example.com>&mode

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Fri, 10 Apr 2020 09:35:16 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0****&q-sign-tim

响应

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Fri, 10 Apr 2020 09:35:16 GMT

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

        <ResultImage>

            base64编码的图片

        </ResultImage>

</Response>
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图片标签
最近更新时间：2023-08-09 17:33:03

图片标签功能通过借助数据万象的持久化处理接口，实现对 COS 存量数据的图片标签识别，返回图片中置信度较

高的主题标签。图片标签识别请求包属于 GET 请求，请求时需要携带签名。

功能概述

注意

当前内容识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过3MB，图片宽高大于

32 x 32像素，小于7680 x 4320像素。

请求语法

原图存储在COS：

GET /<ObjectKey>?ci-process=detect-label&scenes=<scenes> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=detect-label&scenes=<scenes>&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

说明

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 类型
是否必

选
描述

ObjectK

ey
string 是 对象文件名，例如 picture.jpg

ci- string 是 固定值detect-label

https://cloud.tencent.com/document/product/436/7778
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响应包体具体数据内容如下：

RecognitionResult 节点内容：

process

scenes String 否

本次调用支持的识别场景，可选值如下：

支持多场景（scenes）一起检测，以 ， 分隔。例如，使用 

scenes=web，camera 即对一张图片使用两个模型同时检测，

输出两套识别结果。

web，针对网络图片优化；

camera，针对手机摄像头拍摄图片优化；

album，针对手机相册、网盘产品优化；

news，针对新闻、资讯、广电等行业优化；

如果不传此参数，则默认为camera。

detect-
url

String 否

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填

写 detect-url 时，后台会默认处理 ObjectKey ，填写了 

detect-url 时，后台会处理 detect-url 链接，无需再填写 

ObjectKey detect-url 示例：

http://www.example.com/abc.jpg  ，需要进行 UrlEncode，

处理后为

http%25253A%25252F%25252Fwww.example.com%2525

2Fabc.jpg

返回内容

参数名称 类型 描述

RecognitionRe

sult
Container 图片标签识别结果

参数名称 类型 描述

WebLab

els

Contai

ner

Web网络版标签结果数组。如未选择web场景，则不存在该项。此字段可能为

空，表示取不到有效值

Camera
Labels

Contai
ner

Camera摄像头版标签结果数组。如未选择camera场景，则不存在该项。此
字段可能为空，表示取不到有效值

AlbumL

abels

Contai

ner

Album相册版标签结果数组。如未选择album场景，则不存在该项。此字段可

能为空，表示取不到有效值

NewsLa

bels

Contai

ner

News新闻版标签结果数组。如未选择news场景，则不存在该项。此字段可能

为空，表示取不到有效值
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WebLabels，CameraLabels，AlbumLabels，NewsLabels 节点内容：

Labels节点内容：

参数名称 类型 描述

Labels Container 标签信息

参数名称 类型 描述

Confidence Int 该标签的置信度分数，分数越高则该标签准确度越高

Name String 识别出的图片标签

FirstCategory String 标签的一级分类

SecondCategory String 标签的二级分类

示例

请求

GET /picture.jpg?ci-process=detect-label&scenes=web,camera,album,news HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

    <AlbumLabels>

        <Labels>

            <Confidence>72</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>鹿</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>
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    </AlbumLabels>

    <CameraLabels>

        <Labels>

            <Confidence>26</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>羚羊</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>21</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>兔子</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>18</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>鹿</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>10</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>狮子</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>5</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>豹</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

    </CameraLabels>

    <NewsLabels>

        <Labels>

            <Confidence>60</Confidence>

            <FirstCategory>植物及其他生物</FirstCategory>

            <Name>植物</Name>

            <SecondCategory>植物类别</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>38</Confidence>

            <FirstCategory>植物</FirstCategory>

            <Name>树</Name>

            <SecondCategory>树</SecondCategory>
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        </Labels>

    </NewsLabels>

    <WebLabels>

        <Labels>

            <Confidence>97</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>野生动物</Name>

            <SecondCategory>其他</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>82</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>哺乳动物</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>78</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>动物</Name>

            <SecondCategory>其他</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>71</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>鹿</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

        <Labels>

            <Confidence>41</Confidence>

            <FirstCategory>动植物</FirstCategory>

            <Name>白尾鹿</Name>

            <SecondCategory>哺乳动物</SecondCategory>

        </Labels>

    </WebLabels>

</RecognitionResult>
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游戏场景识别
最近更新时间：2023-08-14 17:01:45

游戏标签功能实现游戏图片场景的识别，返回图片中置信度较高的游戏类别标签。游戏标签识别请求包属于 GET 请

求，请求时需要携带签名。

请求：

功能概述

注意

当前内容识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过5MB，图片宽高大于

32 x 32像素，小于7680 x 4320像素。

此功能计费使用图像标签计费项，比例为1:2，即执行1次游戏标签将产生2次图片标签用量，计费详情见  

AI 智能计费 。

请求语法

原图存储在COS：

GET /<ObjectKey>?ci-process=AIGameRec HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=AIGameRec&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

说明

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名

称
类型 是否必选 描述

https://cloud.tencent.com/document/product/460/58118
https://cloud.tencent.com/document/product/436/7778
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响应包体具体数据内容如下：

RecognitionResult 节点内容：

标签信息中包含如下内容：

Object

Key

图片地址 是（与

detect-url

二选一）

String

detect

-url

您可以通过填写 detect-url  对任意公网可访问的图片进行

游戏场景识别。不填写 detect-url  时，后台会默认处理 

ObjectKey  ；填写了 detect-url  时，后台会处理 

detect-url  链接，无需再填写 ObjectKey  ， 

detect-url  示例：

http://www.example.com/abc.jpg。

是 String

返回内容

参数名称 类型 描述

RecognitionResult Container 图片游戏标签识别结果

参数名称 类型 描述

GameLabels Container 游戏标签信息

参数名称 类型 描述

Confidence Int 该标签的置信度分数，分数越高则该标签准确度越高

FirstCategory String 一级标签

SecondCategory String 二级标签

GameName String 识别出的游戏标签名称

示例

请求

GET /ObjectKey?ci-process=AIGameRec HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization:XXXXXXXXXXXX
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<RecognitionResult>

    <GameLabels>

        <Confidence>100</Confidence>

        <FirstCategory>游戏</FirstCategory>

        <SecondCategory>游戏</SecondCategory>

        <GameName>王者荣耀</GameName>

    </GameLabels>

</RecognitionResult>
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图片质量评分
最近更新时间：2023-06-19 16:47:03

图片质量评分功能为同步请求方式，您可以通过本接口对图片文件进行检测，从多方面评估，最终给出综合可观的清

晰度评分和主观的美观度评分。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 图片质量评估费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG。

图片大小：所下载图片经 Base64 编码后不超过4MB。

图片像素：建议大于50*50像素，否则影响识别效果。

长宽比：建议长边与短边的比例小于5:1。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=AssessQuality HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/58118#.E5.9B.BE.E7.89.87.E8.B4.A8.E9.87.8F.E8.AF.84.E4.BC.B0.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1285 共1950页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

ObjectKe

y

对象文件名，例如：folder/document.jpg。 Strin

g

是

ci-

process
数据万象处理能力，图像质量检测固定为 AssessQuality。

Strin

g
是

请求头

请求体

响应

响应头

响应体

<Response>

  <LongImage>FALSE</LongImage>

  <BlackAndWhite>FALSE</BlackAndWhite>

  <SmallImage>FALSE</SmallImage>

  <BigImage>TRUE</BigImage>

  <PureImage>FALSE</PureImage>

  <ClarityScore>89</ClarityScore>

  <AestheticScore>70</AestheticScore>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

参数名称 描述 类型

LongImag 取值为 TRUE 或 FALSE，TRUE 为长图，FALSE 为正常图，长图定义为 Boolea

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

e 长宽比大于等于3或小于等于1/3的图片。 n

BlackAnd

White

取值为 TRUE 或 FALSE，TRUE 为黑白图，FALSE 为否。黑白图即灰度

图，指红绿蓝三个通道都是以灰度色阶显示的图片，并非视觉上的“黑白图
片”。

Boolea

n

SmallIma

ge

取值为 TRUE 或 FALSE，TRUE 为小图，FALSE 为否, 小图定义为最长

边小于179像素的图片。当一张图片被判断为小图时，不建议做推荐和展示，

其他字段统一输出为0或 FALSE。

Boolea

n

BigImage
取值为 TRUE 或 FALSE，TRUE 为大图，FALSE 为否，定义为最短边大

于1000像素的图片

Boolea

n

PureImag

e

取值为 TRUE 或 FALSE，TRUE 为纯色图或纯文字图，即没有内容或只有

简单内容的图片，FALSE 为正常图片。

Boolea

n

ClaritySc
ore

综合评分。图像清晰度的得分，对图片的噪声、曝光、模糊、压缩等因素进行

综合评估，取值为[0, 100]，值越大，越清晰。一般大于50为较清晰图片，标
准可以自行把握。

Intege
r

Aesthetic

Score

综合评分。图像美观度得分，从构图、色彩等多个艺术性维度评价图片，取值

为[0, 100]，值越大，越美观。一般大于50为较美观图片，标准可以自行把
握。

Intege

r

RequestI

d

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请求的 

RequestId。
String

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=AssessQuality HTTP/1.1

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Date: Tue, 03 Apr 2019 09:06:15 GMT

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

https://cloud.tencent.com/document/product/460/42867
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Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<Response>

  <LongImage>FALSE</LongImage>

  <BlackAndWhite>FALSE</BlackAndWhite>

  <SmallImage>FALSE</SmallImage>

  <BigImage>TRUE</BigImage>

  <PureImage>FALSE</PureImage>

  <ClarityScore>89</ClarityScore>

  <AestheticScore>70</AestheticScore>

  <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

</Response>
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人脸识别
人脸检测
最近更新时间：2023-06-19 16:47:04

人脸检测功能为同步请求方式，您可以通过本接口检测图片中的人脸位置。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 人脸检测费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG、BMP。

图片大小：所下载图片经 Base64 编码后不超过5MB。

图片像素：JPG 格式长边像素不可超过4000，其他格式图片长边像素不可超过2000。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=DetectFace&max-face-num=<FaceNum> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型
是否
必选

https://cloud.tencent.com/document/product/460/58118#.E4.BA.BA.E8.84.B8.E8.AF.86.E5.88.AB.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

ObjectKey 对象文件名，例如：folder/document.jpg。
Stri

ng
是

ci-process 数据万象处理能力，人脸特效固定为 DetectFace。
Stri

ng
是

max-face-

num

最多处理的人脸数目。默认值为1（仅检测图片中面积最大的那张
人脸），最大值为120。此参数用于控制处理待检测图片中的人脸

个数，值越小，处理速度越快。

Inte

ger
否

请求头

请求体

响应

响应头

响应体

<Response>

    <ImageWidth>616</ImageWidth>

    <ImageHeight>442</ImageHeight>

    <FaceModelVersion>3.0</FaceModelVersion>

    <RequestId>NjEzZjBlZGRfOTBmYTUwNjRfZWUx****</RequestId>

    <FaceInfos>

        <X>312</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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Response 的内容：

FaceInfos 节点的内容：

以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

节点名称（关键
字）

父节点 描述 类型

ImageWidth
Resp

onse
请求的图片宽度。

Integ

er

ImageHeight
Resp

onse
请求的图片高度。

Integ

er

FaceModelV
ersion

Resp
onse

人脸识别所用的算法模型版本。
Strin
g

RequestId
Resp

onse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请

求的 RequestId。

Strin

g

FaceInfos
Resp

onse
人脸信息列表。包含人脸坐标信息。

Cont

ainer

节点名称

（关键

字）

父节点 描述 类型

X
FaceIn

fos

人脸框左上角横坐标。人脸框包含人脸五官位置并在此基础上进行一

定的扩展，若人脸框超出图片范围，会导致坐标负值。

Integ

er

Y
FaceIn
fos

人脸框左上角纵坐标。人脸框包含人脸五官位置并在此基础上进行一
定的扩展，若人脸框超出图片范围，会导致坐标负值。

Integ
er

Width
FaceIn

fos
人脸框宽度。

Integ

er

Height
FaceIn

fos
人脸框高度。

Integ

er

错误码

错误码 描述

FailedOperation.ConflictOperation 操作冲突，请勿同时操作相同的 Person。

FailedOperation.GroupInDeletedState 当前组正处于删除状态，请等待。

https://cloud.tencent.com/document/product/460/42867
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FailedOperation.GroupPersonMapExist 组中已包含对应的人员 ID。

FailedOperation.GroupPersonMapNotExist 组中不包含对应的人员 ID。

FailedOperation.ImageDecodeFailed 图片解码失败。

FailedOperation.ImageDownloadError 图片下载错误。

FailedOperation.ImageFacedetectFailed 人脸检测失败。

FailedOperation.ImageResolutionExceed 图片分辨率过大。

FailedOperation.ImageResolutionTooSmall 图片短边分辨率小于64。

FailedOperation.ImageSizeExceed
base64编码后的图片数据大小不超过

5MB。

FailedOperation.RequestLimitExceeded 请求频率超过限制。

FailedOperation.RequestTimeout 后端服务超时。

FailedOperation.ServerError 算法服务异常，请重试。

InternalError 内部错误。

InvalidParameter.InvalidParameter 参数不合法。

InvalidParameterValue.AccountFaceNumExcee
d

账号脸数量超出限制。

InvalidParameterValue.FaceModelVersionIllega

l
算法模型版本不合法。

InvalidParameterValue.ImageEmpty 图片为空。

InvalidParameterValue.LimitExceed 返回数量超出限制。

InvalidParameterValue.NoFaceInPhoto 图片中没有人脸。

InvalidParameterValue.UrlIllegal URL 格式不合法。

LimitExceeded.ErrorFaceNumExceed 人脸个数超过限制。

MissingParameter.ErrorParameterEmpty 必选参数为空。

ResourceUnavailable.Freeze 帐号已被冻结。

ResourceUnavailable.InArrears 帐号已欠费。

ResourceUnavailable.LowBalance 余额不足。
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ResourceUnavailable.StopUsing 帐号已停服。

ResourceUnavailable.UnknownStatus 计费状态未知。

ResourcesSoldOut.ChargeStatusException 计费状态异常。

UnsupportedOperation.UnknowMethod 未知方法名。

实际案例

请求

GET /test.jpg?max-face-num=1&ci-process=detect-face HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <ImageWidth>616</ImageWidth>

    <ImageHeight>442</ImageHeight>

    <FaceModelVersion>3.0</FaceModelVersion>

    <RequestId>NjEzZjBlZGRfOTBmYTUwNjRfZWUxXzE=</RequestId>

    <FaceInfos>

        <X>312</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

    <FaceInfos>

        <X>600</X>

        <Y>-5</Y>

        <Width>117</Width>

        <Height>173</Height>

    </FaceInfos>

</Response>
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人脸特效
最近更新时间：2023-06-21 09:18:42

人脸特效，提供人脸美颜、人像变换、人像分割功能。

图片 base64 编码后大小不可超过5M。支持PNG、JPG、JPEG、BMP，不支持 GIF 图片。 

当type为face-segmentation时，图片分辨率须小于2000*2000。

Authorization: Auth String （详情请查阅 请求签名  文档）。

功能描述

使用限制

请求

请求示例

原图存储在COS：

GET /<ObjectKey>?ci-process=face-effect&type=<type> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=face-effect&type=<type>&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

请求参数

参数名称
是否

必选

类

型
描述

ObjectK
ey

是
Str
ing

对象文件名，例如 folder/document.pdf

ci-

process
是

Str

ing
万象处理能力，人脸特效固定为face-effect

https://cloud.tencent.com/document/product/
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该请求操作的实现使用公共请求头，了解公共请求头详情请参阅 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

detect-

url

否 Str

ing

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

detect-url 时，后台会默认处理 ObjectKey ，填写了 detect-url 

时，后台会处理 detect-url 链接，无需再填写 ObjectKey detect-

url 示例： http://www.example.com/abc.jpg  ，需要进行 

UrlEncode，处理后为

http%25253A%25252F%25252Fwww.example.com%25252Fab

c.jpg

。

type 是
Str

ing

人脸特效类型，人脸美颜：face-beautify；人脸性别转换：face-

gender-transformation；人脸年龄变化：face-age-

transformation；人像分割：face-segmentation

whiteni

ng
否

Int

eg

er

type为face-beautify时生效，美白程度，取值范围[0,100]。0不美

白，100代表最高程度。默认值30

smoothi

ng
否

Int

eg

er

type为face-beautify时生效，磨皮程度，取值范围[0,100]。0不磨

皮，100代表最高程度。默认值10

faceLifti

ng
否

Int

eg

er

type为face-beautify时生效，瘦脸程度，取值范围[0,100]。0不瘦

脸，100代表最高程度。默认值70

eyeEnla

rging
否

Int

eg

er

type为face-beautify时生效，大眼程度，取值范围[0,100]。0不大

眼，100代表最高程度。默认值70

gender 否
Int
eg

er

type为face-gender-transformation时生效，选择转换方向，0：男
变女，1：女变男。无默认值，为必选项。限制：仅对图片中面积最大的人

脸进行转换。

age 否
Int
eg

er

type为face-age-transformation时生效，变化到的人脸年龄,
[10,80]。无默认值，为必选项。限制：仅对图片中面积最大的人脸进行转

换。

请求头

公共头部

非公共头部

https://cloud.tencent.com/document/product/
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该请求无请求体。

该响应包含公共响应头，了解公共响应头详情请参阅 公共响应头部  文档。

该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

请求体

响应

响应头

公共响应头

特有响应头

响应体

<Response>

  <ResultImage>

    base64编码的图片

  </ResultImage>

  <ResultMask>

    base64编码的文件

  </ResultMask>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称

（关键
字）

父节点 描述 类型

ResultI

mage

Respons

e
处理后的图片 base64 数据

Strin

g

Result

Mask

Respons

e

人像分割输出参数，一个通过 Base64 编码的文件，解码后文件

由 Float 型浮点数组成。这些浮点数代表原图从左上角开始的每一

Strin

g

https://cloud.tencent.com/document/product/
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常见的错误信息请参阅 错误码  文档。

使用模版ID

行的每一个像素点，每一个浮点数的值是原图相应像素点位于人体
轮廓内的置信度（0-1）转化的灰度值（0-255）

错误码

实际案例

请求

GET /test.jpg?ci-process=face-effect&type=face-beautify&whitening=70&smoothing=80&

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-image

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

  <ResultImage>

    base64编码的图片

  </ResultImage>

</Response>

https://cloud.tencent.com/document/product/


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1298 共1950页

人体识别
最近更新时间：2023-06-19 16:47:04

腾讯云数据万象通过 AIBodyRecognition 接口识别并输出画面中人体，输出其位置（矩形框）和置信度。图片人

体识别请求包属于 GET 请求，请求时需要携带签名。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

功能概述

说明：

当前人体识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过10MB，图片宽高大

于50像素 x 50像素。

请求语法

GET /?ci-process=AIBodyRecognition HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求内容

参数名称 描述 类型 是否必选

ci-

process
数据万象处理能力，人体识别固定为AIBodyRecognition String 是

请求头

请求体

响应

响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，具体的数据内容如下：

Response 的内容：

LogoInfo 节点内容：

Location 节点内容：

响应体

节点名称（关键字） 父节点 描述 类型

RecognitionResult 无 保存Logo识别结果的容器 Container

节点名称（关键字） 父节点 描述 类型

Status
RecognitionRe

sult

人体识别结果。0表示未识别到，1表示识别

到
Int

PedestrianInfo
RecognitionRe

sult
人体识别结果，可能有多个

Contain

er

节点名称（关键

字）
父节点 描述 类型

Name
Pedestrian

Info
识别类型，人体识别默认：person String

Sorce
Pedestrian
Info

人体的置信度，取值范围为[0-100]。值越高概率越
大。

String

Location
Pedestrian

Info
图中识别到人体的坐标

Contai

ner

节点名称（关键字） 父节点 描述 类型

Point Location 人体坐标点（X坐标,Y坐标） String

示例

请求

GET /?ci-process=RecognizeLogo&detect-url=xxx HTTP/1.1

Host: examplebucket-1250000000.cos.ap-chengdu.myqcloud.com

https://cloud.tencent.com/document/product/460/42866
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Date: xxxxx

Authorization:XXXXXXXXXXXX

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: xxxxxx

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<RecognitionResult>

    <Status>1</Status>

    <PedestrianInfo>

        <Name>person</Name>

        <Score>90</Score>

        <Location>

            <Point>162,266</Point>

            <Point>162,716</Point>

            <Point>392,716</Point>

            <Point>392,266</Point>

        </Location>

        <Name>person</Name>

        <Score>89</Score>

        <Location>

            <Point>682,162</Point>

            <Point>682,479</Point>

            <Point>783,479</Point>

            <Point>783,162</Point>

        </Location>

    </PedestrianInfo>

</RecognitionResult>
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宠物识别
最近更新时间：2023-08-01 16:46:27

腾讯云数据万象通过 detect-pet 接口识别并输出画面中宠物，输出其位置（矩形框）和置信度。图片宠物识别请

求包属于 GET 请求，请求时需要携带签名。

请求示例

请求参数

请求头

此接口仅使用公共请求头部。

请求体

该请求无请求体。

响应头

此接口仅返回公共响应头部。

响应体

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能概述

说明：

当前宠物识别的图片限制为：图片格式支持 PNG、JPEG、JPG，图片大小不超过10MB，图片宽高大

于50 x 50像素。

请求

GET /<ObjectKey>?ci-process=detect-pet HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

参数名称 描述 类型 是否必选

ci-process 数据万象处理能力，宠物识别固定为 detect-pet String 是

响应

<Response>

        <ResultInfo>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1302 共1950页

具体的数据内容如下：

Response 的内容：

                <Score>64</Score>

                <Name>dog</Name>

                <Location>

                        <X>59</X>

                        <Y>51</Y>

                        <Height>225</Height>

                        <Width>175</Width>

                </Location>

        </ResultInfo>

        <ResultInfo>

                .

        </ResultInfo>

</Response>

..

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

ResultInfo
Resp
onse

保存结果的容器
Contain
er

Score
Resul

tInfo

分数，范围在0-100之间，值越高，表示目标为相应结果

的可能性越高
int

Name
Resul

tInfo
宠物名称 string

Location
Resul

tInfo
保存宠物位置的容器

Contain

er

X
Locat

ion
x轴坐标 int

Y
Locat

ion
y轴坐标 int

Height
Locat

ion
(x,y)坐标距离高度 int
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错误码

请求

响应

Width Locat

ion

(x,y)坐标距离长度 int

错误码 描述 HTTP状态码

FailedOperation.NoObjectDetected 未检测到目标 400 Bad Request

InternalError 文件下载失败/其他未知错误 400 Bad Request

实际案例

GET /test.jpg?ci-process=detect-pet HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 359

Date: Mon, 26 Apr 2021 02:19:16 GMT

Server: tencent-image

x-ci-request-id: NjA4NjIzMjNfOTBmYTUwNjRfNjAx****

<Response>

        <ResultInfo>

                <Score>64</Score>

                <Name>dog</Name>

                <Location>

                        <X>59</X>

                        <Y>51</Y>

                        <Height>225</Height>

                        <Width>175</Width>

                </Location>

        </ResultInfo>

        <ResultInfo>

                <Score>62</Score>

                <Name>dog</Name>

                <Location>

                        <X>237</X>
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                        <Y>60</Y>

                        <Height>208</Height>

                        <Width>177</Width>

                </Location>

        </ResultInfo>

</Response>
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人脸核身

身份证识别
最近更新时间：2023-07-12 20:11:01

支持中国大陆居民二代身份证正反面所有字段的识别，包括姓名、性别、民族、出生日期、住址、公民身份证号、签

发机关、有效期限；具备身份证照片、人像照片的裁剪功能和翻拍、PS、复印件告警功能，以及边框和框内遮挡告

警、临时身份证告警和身份证有效期不合法告警等扩展功能。

身份证图片上传时识别的请求包与 COS 简单上传文件接口一致，只需增加相关处理参数，即可在图片上传时返回

识别结果，并可将原图存入到 COS。

云上数据处理请求能够对已存储在 COS 的身份证图片进行相应处理操作，返回识别结果。

功能描述

说明

当前身份证识别的图片限制为：要求图片经 Base64 编码后不超过7M，分辨率建议500 × 800以

上，支持 PNG、JPG、JPEG、BMP 格式。建议卡片部分占据图片2/3以上。

身份证识别为付费服务，计费详情请参见 内容识别费用 。

该功能目前仅提供 API 使用方式。

请求

上传时处理

PUT /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HT

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

云上数据处理

GET /<ObjectKey>?ci-process=IDCardOCR&CardSide=<CardSide>&Config=<Config> HT

https://cloud.tencent.com/document/product/460/58118
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型
是否必

选

Object
Key

对象文件名，例如：folder/document.jpg
Strin
g

是

ci-

proces

s

数据万象处理能力，身份证识别固定为 IDCardOCR
Strin

g
是

CardSi

de
该参数如果不填，将为您自动判断身份证正反面

FRONT：身份证有照片的一面（人像面）

BACK：身份证有国徽的一面（国徽面）
Strin

g
否

Config

以下可选字段均为 bool 类型，默认 false：

参数设置方式参考：

Config = {"CropIdCard":true,"CropPortrait":true}

CropIdCard，身份证照片裁剪（去掉证件外多余的边缘、自动

矫正拍摄角度）

CropPortrait，人像照片裁剪（自动抠取身份证头像区域）

CopyWarn，复印件告警

BorderCheckWarn，边框和框内遮挡告警

ReshootWarn，翻拍告警

DetectPsWarn，PS 检测告警

TempIdWarn，临时身份证告警

InvalidDateWarn，身份证有效日期不合法告警

Quality，图片质量分数（评价图片的模糊程度）

MultiCardDetect，是否开启多卡证检测

Strin
g

否

请求头

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

IdInfo身份证识别信息中包含如下内容：

请求体

响应

响应头

响应体

<Response>

  <IdInfo>

    身份证识别信息
  </IdInfo>

  <AdvancedInfo>

    身份证识别信息

  </AdvancedInfo>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

IdInfo Response 身份证识别信息 Container

AdvancedInfo Response
扩展信息，不请求则不返

回
Container

节点名称（关键字） 父节点 描述 类型

Name IdInfo 姓名（人像面） String

Sex IdInfo 性别（人像面） String

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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AdvancedInfo扩展信息中包含如下内容：

Nation IdInfo 民族（人像面） String

Birth IdInfo 出生日期（人像面） String

Address IdInfo 地址（人像面） String

IdNum IdInfo 身份证号（人像面） String

Authority IdInfo 发证机关（国徽面） String

ValidDate IdInfo 证件有效期（国徽面） String

节点名称（关键
字）

父节点 描述 类型

IdCard
Advanced

Info

裁剪后身份证照片的 Base64 编码，设置 

Config.CropIdCard 为 true 时返回

Stri

ng

Portrait
Advanced

Info

身份证头像照片的 Base64 编码，设置 

Config.CropPortrait 为 true 时返回

Stri

ng

Quality
Advanced
Info

图片质量分数，设置  Config.Quality 为 true 时返回（取
值范围：0~100，分数越低越模糊，建议阈值≥50）

Stri
ng

BorderCode

Value

Advanced

Info

身份证边框不完整告警阈值分数，设置 

Config.BorderCheckWarn 为 true 时返回（取值范

围：0~100，分数越低边框遮挡可能性越低，建议阈值
≥50）

Stri

ng

WarnInfos IdInfo

告警信息，Code 告警码列表和释义：

可能存在多个 WarnInfos

9100 身份证有效日期不合法告警

9101 身份证边框不完整告警

9102 身份证复印件告警

9103 身份证翻拍告警

9104 临时身份证告警

9105 身份证框内遮挡告警

9106 身份证 PS 告警

Stri

ng

实际案例

请求
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以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

GET /test.jpg?ci-process=IDCardOCR&CardSide=FRONT&Config={"CropIdCard"：true, "C

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

  <IdInfo>

     <Name>李明</Name>

     <Sex>男</Sex>

     <Nation>汉</Nation>

     <Birth>1987/1/1</Birth>

     <Address>北京市石景山区高新技术园腾讯大楼</Address>

     <IdNum>440524198701010014</IdNum>

  </IdInfo>

  <AdvancedInfo>

     <IdCard>裁剪后身份证照片的 Base64 编码</IdCard>

     <Portrait>身份证头像照片的 Base64 编码</Portrait>

  </AdvancedInfo>

</Response>

错误码

错误码 描述

FailedOperation.DownLoadError 文件下载失败

FailedOperation.EmptyImageError 图片内容为空

FailedOperation.IdCardInfoIllegal 身份证信息不合法（身份证号、姓名字段校验非法等）

FailedOperation.ImageBlur 图片模糊

FailedOperation.ImageDecodeFailed 图片解码失败

FailedOperation.ImageNoIdCard 图片中未检测到身份证

https://cloud.tencent.com/document/product/460/42867
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FailedOperation.ImageSizeTooLarge 图片尺寸过大，请参考输出参数中关于图片大小限制的说

明

FailedOperation.MultiCardError 照片中存在多张卡

FailedOperation.OcrFailed OCR 识别失败

FailedOperation.UnKnowError 未知错误

FailedOperation.UnOpenError 服务未开通

InvalidParameter.ConfigFormatError Config 格式错误

InvalidParameterValue.InvalidParam

eterValueLimit
参数值错误

LimitExceeded.TooLargeFileError 文件内容太大

ResourcesSoldOut.ChargeStatusExc

eption
计费状态异常
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活体人脸核身
最近更新时间：2023-06-19 16:47:04

集成了活体检测和跟权威库进行比对的能力，传入一段视频和姓名、身份证号信息即可进行验证。对录制的自拍视频

进行活体检测，从而确认当前用户为真人，可防止照片、视频、静态3D建模等各种不同类型的攻击。检测为真人

后，再判断该视频中的人与权威库的证件照是否属于同一个人，实现用户身份信息核实。

视频上传时检测的请求包与 COS 简单上传文件接口一致，只需增加相关处理参数，即可在视频上传时返回检测结

果，并可将原视频存入到 COS。

云上数据处理请求能够对已存储在 COS 的人脸视频进行相应识别操作，返回检测结果。

功能描述

说明

当前活体人脸核身的视频片限制为：用于活体检测的视频 BASE64 编码后的大小不超过8M，支持 

mp4、avi、flv 格式。

活体人脸核身为付费服务，计费详情请参见 内容识别费用 。

该功能目前仅提供 API 使用方式。

请求

上传时处理

PUT /<ObjectKey>?ci-process=LivenessRecognition&IdCard=<IdCard>&Name=<Name>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

云上数据处理

GET /<ObjectKey>?ci-process=LivenessRecognition&IdCard=<IdCard>&Name=<Name>

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

https://cloud.tencent.com/document/product/460/58118
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型 是否必选

ObjectKey
对象文件名，例如：folder/document.mp4，
BASE64 编码后的大小不超过8M，支持 mp4、

avi、flv 格式

Stri
ng

是

ci-process
数据万象处理能力，人脸核身固定为 

LivenessRecognition

Stri

ng
是

IdCard 身份证号
Stri

ng
是

Name 姓名。中文请使用 UTF-8编码
Stri

ng
是

LivenessTyp
e

活体检测类型，取值：LIP/ACTION/SILENT

LIP 为数字模式，ACTION 为动作模式，
SILENT 为静默模式，三种模式选择一种传入

Stri
ng

是

ValidateData

数字模式传参：数字验证码（1234），需先调用

接口获取数字验证码

动作模式传参：传动作顺序（2，1 or 1，2），

需先调用接口获取动作顺序

静默模式传参：空

Stri

ng

是。当 

LivenessType 
填的是 SILENT 

时，该参数为可选

项

BestFrameN

um

需要返回多张最佳截图，取值范围1 - 10，不设置默

认返回一张最佳截图
Int 否

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1313 共1950页

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

具体的返回内容如下：

Response 的内容：

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

BestFrameBa
se64

Respon
se

验证通过后的视频最佳截图照片，照片为 BASE64 编码后
的值，JPG 格式

注意：此字段可能返回 null，表示取不到有效值

Strin
g

Sim
Respon

se

相似度，取值范围 [0.00, 100.00]。推荐相似度大于等

于70时可判断为同一人，可根据具体场景自行调整阈值
（阈值70的误通过率为千分之一，阈值80的误通过率是

万分之一）

检测成功返回

Float

BestFrameLis

t

Respon

se

最佳截图列表，仅在配置了返回多张最佳截图时返回

注意：此字段可能返回 null，表示取不到有效值

Strin

g

实际案例

请求

GET /test.mp4?ci-process=LivenessRecognition&IdCard=11204416541220243X&Name=

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

https://cloud.tencent.com/document/product/460/42866
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以下仅列出了接口业务逻辑相关的错误码，其他错误信息请参见 错误码  文档。

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NWY2OWFlYjdfNDQ0NjYzNjRfMTBm****

<Response>

      <BestFrameBase64>/9j/4AAQSkZJRgABAQAAAQA</BestFrameBase64>

      <Sim>100</Sim>

</Response>

错误码

错误码 描述

FailedOperation.ActionCloseEye 未检测到闭眼动作

FailedOperation.ActionFaceClose 脸离屏幕太近

FailedOperation.ActionFaceFar 脸离屏幕太远

FailedOperation.ActionFaceLeft 脸离屏幕太左

FailedOperation.ActionFaceRight 脸离屏幕太右

FailedOperation.ActionFirstAction 未检测到第一个动作

FailedOperation.ActionLightDark 光线太暗

FailedOperation.ActionLightStrong 光线太强

FailedOperation.ActionNodetectFace 未能检测到完整人脸

FailedOperation.ActionOpenMouth 未检测到张嘴动作

FailedOperation.CompareFail 比对失败

FailedOperation.CompareLowSimilarit

y
调用比对引擎接口出错

FailedOperation.FileSaveError 文件存储失败，请稍后重试

FailedOperation.IdFormatError 输入的身份证号有误

FailedOperation.IdNameMisMatch 姓名和身份证号不一致，请核实后重试

https://cloud.tencent.com/document/product/460/42867
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FailedOperation.IdNoExistSystem 库中无此号，请到户籍所在地进行核实

FailedOperation.IdPhotoNoExist 库中无此号照片，请到户籍所在地进行核实

FailedOperation.IdPhotoPoorQuality 证件图片分辨率太低，请重新上传

FailedOperation.IdPhotoSystemNoan

swer
客户库自建库或认证中心返照失败，请稍后再试

FailedOperation.LifePhotoDetectFace

s
检测到多张人脸

FailedOperation.LifePhotoDetectFake 实人比对没通过

FailedOperation.LifePhotoDetectNoF

aces
未能检测到完整人脸

FailedOperation.LifePhotoPoorQuality 传入图片分辨率太低，请重新上传

FailedOperation.LifePhotoSizeError 传入图片过大或过小

FailedOperation.LipFaceIncomplete 脸部未完整露出

FailedOperation.LipMoveSmall 嘴唇动作幅度过小

FailedOperation.LipNetFailed 视频拉取失败，请重试

FailedOperation.LipSizeError 视频为空，或大小不合适，请控制录制时长在6s左右

FailedOperation.LipVideoInvalid 视频格式有误

FailedOperation.LipVideoQuaility 视频像素太低

FailedOperation.LipVoiceDetect 未检测到声音

FailedOperation.LipVoiceLow 视频声音太小

FailedOperation.LipVoiceRecognize 声音识别失败

FailedOperation.LivessBestFrameErr

or
人脸检测失败，无法提取比对照

FailedOperation.LivessDetectFail 活体检测没通过

FailedOperation.LivessDetectFake 疑似非真人录制

FailedOperation.LivessSystemError 调用活体引擎接口出错

FailedOperation.LivessUnknownError 视频实人检测没通过
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FailedOperation.NameFormatError 输入的姓名有误

FailedOperation.RequestLimitExceed

ed
调用次数超出限制

FailedOperation.SilentDetectFail 实人检测失败

FailedOperation.SilentThreshold 实人检测未达到通过标准

FailedOperation.SilentTooShort 视频录制时间过短，请录制2s以上的视频。

FailedOperation.UnKnown 内部未知错误

InvalidParameter 参数错误

InvalidParameter.RuleId RuleId 不存在

InvalidParameterValue 参数取值错误

InvalidParameterValue.BizTokenExpir
ed

BizToken 过期

InvalidParameterValue.RuleIdNotExis

t
RuleId 不存在，请到人脸核身控制台申请

UnauthorizedOperation 未授权操作

UnauthorizedOperation.Arrears 帐号已欠费

UnauthorizedOperation.NonAuthorize 账号未实名

UnauthorizedOperation.Nonactivated 未开通服务

UnsupportedOperation 操作不支持
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获取数字验证码
最近更新时间：2023-06-19 16:47:04

使用数字活体检测模式前，需调用本接口获取数字验证码。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

接口描述

请求

请求示例

GET /?ci-process=GetLiveCode HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型 是否必选

ci-

process
数据万象处理能力，获取数字验证码固定为 GetLiveCode

Strin

g
是

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

<Response>

  <LiveCode>数字验证码</LiveCode>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

LiveCode Response 数字验证码，如：1234 String

实际案例

请求

GET /?ci-process=GetLiveCode HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NWY2OWFlZjVfOTA0MDYzNjRfNjY5Zl8zNQ==

<Response>

  <LiveCode>0521</LiveCode>

</Response>
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获取动作顺序
最近更新时间：2023-06-20 15:10:27

使用动作活体检测模式前，需调用本接口获取动作顺序。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

接口描述

请求

请求示例

GET /?ci-process=GetActionSequence HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型 是否必选

ci-

process
数据万象处理能力，获取动作顺序固定为 GetActionSequence

Strin

g
是

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

<Response>

  <ActionSequence>动作顺序</ActionSequence>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

ActionSequence
Respons

e
动作顺序（2，1 or 1，2），1代表张嘴，2代表闭眼

Strin

g

实际案例

请求

GET /?ci-process=GetActionSequence HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NWY2OWFlZjVfOTA0MDYzNjRfNjY5Zl8zNQ==

<Response>

  <ActionSequence>2,1</ActionSequence>

</Response>
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车辆车牌识别
最近更新时间：2023-06-20 17:32:12

车辆车牌检测功能为同步请求方式，您可以通过本接口检测图片中的车辆，识别出车辆的品牌、颜色、位置、车牌位

置等信息。该接口属于 GET 请求。

功能描述

费用说明

成功调用接口会产生 车辆车牌检测费用  和 COS 读请求费用 。

如果图片属于 COS 上的低频存储类型，成功调用接口会产生 COS 低频数据取回费用 。

不支持对 COS 上的归档存储类型和深度归档存储类型的图片进行处理，如果需要处理此类型图片，请先 恢复归

档文件 。

限制说明

图片支持格式：PNG、JPG、JPEG。

图片大小：所下载图片经 Base64 编码后不超过4MB。

图片像素：建议大于50*50像素，否则影响识别效果。

长宽比：建议长边与短边的比例小于5：1。

调用接口需携带签名，具体规则请参见 请求签名  文档。

请求

请求示例

GET /<ObjectKey>?ci-process=DetectCar HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

参数名称 描述 类型 是否必选

https://cloud.tencent.com/document/product/460/58118#.E6.B1.BD.E8.BD.A6.E8.AF.86.E5.88.AB.E8.B4.B9.E7.94.A8
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

ObjectKey 对象文件名，例如：folder/document.jpg String 是

ci-

process
数据万象处理能力，车辆识别固定为 DetectCar String 是

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId></RequestId>

    <CarTags>

        <Serial></Serial>

        <Brand></Brand>

        <Type></Type>

        <Color><Color>

        <Confidence></Confidence>

        <Year></Year>

        <CarLocation>

            <X></X>

            <Y></Y>

        </CarLocation>

        <PlateContent>

            <Plate></Plate>

            <Color>Color>

            <Type></Type>

            <PlateLocation>

                <X></X>

                <Y></Y>

            </PlateLocation>

        </PlateContent>

    </CarTags>

</Response>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Response 的内容：

CarTags 节点的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

RequestId
Resp

onse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请

求的 RequestId。

Strin

g

CarTags
Resp
onse

车辆属性识别的结果数组，支持返回多个车辆信息
Cont
ainer

节点名称（关键

字）
父节点 描述 类型

Serial
CarT
ags

车系 String

Brand
CarT

ags
车辆品牌 String

Type
CarT

ags
车辆类型 String

Color
CarT
ags

车辆颜色 String

Confidence
CarT

ags
置信度，0 - 100 Int

Year
CarT

ags
年份，识别不出年份时返回0 Int

CarLocation
CarT
ags

车辆在图片中的坐标信息，可能返回多个坐标点的值
Contai
ner

PlateContent
CarT

ags

车牌信息，包含车牌号、车牌颜色、车牌位置。支持返回多

个车牌

Contai

ner
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CarLocation 节点的内容：

PlateContent 节点的内容：

PlateLocation 节点的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

X CarLocation 横坐标 x Int

Y CarLocation 纵坐标 y Int

节点名称（关键字） 父节点 描述 类型

Plate PlateContent 车牌号信息 String

Color PlateContent 车牌的颜色 String

Type PlateContent 车牌的种类，例如普通蓝牌 String

PlateLocation PlateContent 车牌的位置 Container

节点名称（关键字） 父节点 描述
类

型

X
PlateLocat
ion

定位出的车牌左上角、右上角、左下角、右下角的 X 坐
标

Int

Y
PlateLocat

ion

定位出的车牌左上角、右上角、左下角、右下角的 Y 坐

标
Int

错误码

实际案例

请求

GET test.jpg?ci-process=DetectCar HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjE1MzEyMDlfOTBmYTUwNjRfNzUz****</RequestId>

    <CarTags>

        <Serial>奔驰S级</Serial>

        <Brand>奔驰</Brand>

        <Type>轿车</Type>

        <Color>黑</Color>

        <Confidence>98</Confidence>

        <Year>0</Year>

        <CarLocation>

            <X>8</X>

            <Y>364</Y>

        </CarLocation>

        <CarLocation>

            <X>8</X>

            <Y>5</Y>

        </CarLocation>

        <CarLocation>

            <X>637</X>

            <Y>5</Y>

        </CarLocation>

        <CarLocation>

            <X>637</X>

            <Y>364</Y>

        </CarLocation>

        <PlateContent>

            <Plate>陕ASxxxL</Plate>

            <Color>蓝色</Color>

            <Type>普通蓝牌</Type>

            <PlateLocation>

                <X>263</X>

                <Y>309</Y>

            </PlateLocation>

            <PlateLocation>

                <X>263</X>

                <Y>239</Y>

            </PlateLocation>

            <PlateLocation>
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                <X>459</X>

                <Y>239</Y>

            </PlateLocation>

            <PlateLocation>

                <X>459</X>

                <Y>309</Y>

            </PlateLocation>

        </PlateContent>

    </CarTags>

    <CarTags>

        <Serial>五菱宏光</Serial>

        <Brand>五菱</Brand>

        <Type>面包车</Type>

        <Color>白</Color>

        <Confidence>0</Confidence>

        <Year>0</Year>

        <CarLocation>

            <X>0</X>

            <Y>228</Y>

        </CarLocation>

        <CarLocation>

            <X>0</X>

            <Y>81</Y>

        </CarLocation>

        <CarLocation>

            <X>73</X>

            <Y>81</Y>

        </CarLocation>

        <CarLocation>

            <X>73</X>

            <Y>228</Y>

        </CarLocation>

    </CarTags>

</Response>
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图片文字识别(OCR）
最近更新时间：2023-06-20 15:10:28

通用文字识别功能（Optical Character Recognition，OCR）基于行业前沿的深度学习技术，将图片上的文字

内容，智能识别为可编辑的文本，可应用于随手拍扫描、纸质文档电子化、电商广告审核等多种场景，大幅提升信息

处理效率。

本接口属于 GET 请求，为同步请求方式，需携带签名。

Authorization: Auth String （详情请查阅 请求签名  文档）。

功能描述

说明：

图片格式：PNG、JPG、JPEG、BMP，不支持 GIF 图片。

支持PDF

图片大小：所下载图片经Base64编码后不超过7M。

图片像素：建议分辨率在600 x 800以上，限制输入图片最大分辨率为8K（7680 x 4320像素），最

小分辨率为32 x 32像素；

请求

请求示例

原图存储在COS：

GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=ture&pd

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

原图来自其他链接：

GET /?ci-process=OCR&detect-url=<detect-url>&type=general&language-type=zh&is

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

https://cloud.tencent.com/document/product/
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请求参数

参数名称 描述 类型
是否必
选

ObjectKey 对象文件名，例如：folder/document.jpg String 是

ci-

process
数据万象处理能力，图片文字识别固定为OCR String 是

detect-url

您可以通过填写 detect-url 处理任意公网可访问的图片链接。

不填写 detect-url 时，后台会默认处理 ObjectKey ，填写了 
detect-url 时，后台会处理 detect-url 链接，无需再填写 

ObjectKey detect-url 示例：

http://www.example.com/abc.jpg ，需要进行 

UrlEncode，处理后为
http%25253A%25252F%25252Fwww.example.com

%25252Fabc.jpg

String 否

type

ocr的识别类型，有效值为general，accurate，efficient，

fast，handwriting。
general表示通用印刷体识别；accurate表示印刷体高精度

版；efficient表示印刷体精简版；fast表示印刷体高速版；

handwriting表示手写体识别。默认值为general。

String 否

language-

type

type值为general时有效，表示识别语言类型。

支持自动识别语言类型，同时支持自选语言种类，默认中英文混

合(zh)，各种语言均支持与英文混合的文字识别。

可选值：
zh：中英混合

zh_rare：支持英文、数字、中文生僻字、繁体字，特殊符号等

auto：自动

mix：混合语种

jap：日语
kor：韩语

spa：西班牙语

fre：法语

ger：德语
por：葡萄牙语

vie：越语

may：马来语

rus：俄语
ita：意大利语

hol：荷兰语

swe：瑞典语

fin：芬兰语

String 否
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该请求操作的实现使用公共请求头，了解公共请求头详情请参阅 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求无请求体。

该响应包含公共响应头，了解公共响应头详情请参阅 公共响应头部  文档。

该响应无特殊的响应头。

dan：丹麦语

nor：挪威语

hun：匈牙利语

tha：泰语
hi：印地语

ara：阿拉伯语

ispdf
type值为general，fast时有效，表示是否开启PDF识别，有
效值为true和false，默认值为false，开启后可同时支持图片和

PDF的识别。

Boole
an

否

pdf-

pagenumb
er

type值为general，fast时有效，表示需要识别的PDF页面的

对应页码，仅支持PDF单页识别，当上传文件为PDF且ispdf参
数值为true时有效，默认值为1。

Integ
er

否

isword
type值为general，accurate时有效，表示识别后是否需要返

回单字信息，有效值为true和false，默认为false

Boole

an
否

enable-

word-

polygon

type值为handwriting时有效，表示是否开启单字的四点定位坐

标输出，有效值为true和false，默认值为false。

Boole

an
否

请求头

公共头部

非公共头部

请求体

响应

响应头

公共响应头

特有响应头

https://cloud.tencent.com/document/product/
https://cloud.tencent.com/document/product/
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 的内容：

响应体

<Response>

  <TextDetections>

    <DetectedText></DetectedText>

    <Confidence></Confidence>

    <Polygon>

      <X></X>

      <Y></Y>

    </Polygon>

    <ItemPolygon>

      <X></X>

      <Y></Y>

      <Width></Width>

      <Height></Height>

    </ItemPolygon>

    <Words>

      <Confidence></Confidence>

      <Character></Character>

      <WordCoordPoint>

        <WordCoordinate>

          <X></X>

          <Y></Y>

        </WordCoordinate>

      </WordCoordPoint>

    </Words>

  </TextDetections>

  <Language></Language>

  <Angel></Angel>

  <PdfPageSize></PdfPageSize>

  <RequestId></RequestId>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关

键字）

父节点 描述 类型
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TextDetections节点的内容：

Polygon 节点的内容：

TextDetecti
ons

Resp
onse

检测到的文本信息，包括文本行内容、置信度、文本行坐标以及
文本行旋转纠正后的坐标。

Cont
ainer

Language
Resp

onse

检测到的语言类型，目前支持的语言类型参考入参 language-

type 说明。

Strin

g

Angel
Resp

onse

图片旋转角度（角度制），文本的水平方向为0°；顺时针为正，

逆时针为负。
Float

PdfPageSiz
e

Resp
onse

图片为PDF时，返回PDF的总页数，默认为0。
Integ
er

RequestId
Resp

onse

唯一请求 ID，每次请求都会返回。定位问题时需要提供该次请求

的 RequestId。

Strin

g

节点名称
（关键字）

父节点 描述 类型

Detected

Text

TextD

etectio

ns

识别出的文本行内容
Stri

ng

Confiden

ce

TextD

etectio

ns

置信度 0 ~100
Inte

ger

Polygon

TextD

etectio

ns

文本行坐标，以四个顶点坐标表示

注意：此字段可能返回 null，表示取不到有效值。

Con

tain

er

ItemPolyg

on

TextD

etectio

ns

文本行在旋转纠正之后的图像中的像素坐标，表示为（左上角x, 左

上角y，宽width，高height）

Con

tain

er

Words

TextD

etectio

ns

识别出来的单字信息包括单字（包括单字Character和单字置信度

confidence）， 支持识别的接口：general、accurate

Con

tain

er

WordPoly

gon

TextD
etectio

ns

字的坐标数组，以四个顶点坐标表示。注意：此字段可能返回 

null，表示取不到有效值。支持识别的类型：handwriting

Con
tain

er
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ItemPolygon 节点的内容：

Words节点的内容：

WordCoordPoint节点的内容：

WordCoordinate节点的内容：

节点名称（关键字） 父节点 描述 类型

X Polygon 横坐标 Integer

Y Polygon 纵坐标 Integer

节点名称（关键字） 父节点 描述 类型

X ItemPolygon 左上角x Integer

Y ItemPolygon 左上角y Integer

Width ItemPolygon 宽width Integer

Height ItemPolygon 高height Integer

节点名称（关键

字）

父节

点
描述 类型

Confidence
Wor

ds
置信度 0 ~100

Intege

r

Character
Wor

ds
候选字Character String

WordCoordPoi

nt

Wor

ds

单字在原图中的四点坐标， 支持识别的接口：general、

accurate

Contai

ner

节点名称（关键

字）
父节点 描述 类型

WordCoordi
nate

WordCoordP
oint

单字在原图中的坐标，以四个顶点坐标表示，以左上
角为起点，顺时针返回。

Contai
ner

节点名称（关键字） 父节点 描述 类型

X WordCoordinate 横坐标 Integer

Y WordCoordinate 纵坐标 Integer



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1333 共1950页

WordPolygon节点的内容：

LeftTop，RightTop，RightBottom，LeftBottom节点的内容：

常见的错误信息请参阅 错误码  文档。

使用模板ID

节点名称（关键字） 父节点 描述 类型

LeftTop WordPolygon 左上顶点坐标 Container

RightTop WordPolygon 左上顶点坐标 Container

RightBottom WordPolygon 左上顶点坐标 Container

LeftBottom WordPolygon 左上顶点坐标 Container

节点名称（关键字） 父节点 描述 类型

X WordCoordinate 横坐标 Integer

Y WordCoordinate 纵坐标 Integer

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=OCR&type=general&language-type=zh&ispdf=true&iswo

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host:bucket-1250000000.cos.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 414641

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-cos-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <Angel>359.99</Angel>

https://cloud.tencent.com/document/product/
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    <Language>mix</Language>

    <PdfPageSize>0</PdfPageSize>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>你好</DetectedText>

        <ItemPolygon>

            <Height>64</Height>

            <Width>123</Width>

            <X>140</X>

            <Y>167</Y>

        </ItemPolygon>

        <Polygon>

            <X>140</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>167</Y>

        </Polygon>

        <Polygon>

            <X>263</X>

            <Y>231</Y>

        </Polygon>

        <Polygon>

            <X>140</X>

            <Y>231</Y>

        </Polygon>

        <Words>

            <Character>你</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>212</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>
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                    <X>212</X>

                    <Y>231</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>好</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>341</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>167</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>263</X>

                    <Y>231</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>341</X>

                    <Y>230</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

    <TextDetections>

        <Confidence>99</Confidence>

        <DetectedText>再见</DetectedText>

        <ItemPolygon>

            <Height>43</Height>

            <Width>245</Width>

            <X>526</X>

            <Y>1444</Y>

        </ItemPolygon>

        <Polygon>

            <X>526</X>

            <Y>1444</Y>

        </Polygon>

        <Polygon>

            <X>771</X>

            <Y>1444</Y>

        </Polygon>
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        <Polygon>

            <X>771</X>

            <Y>1487</Y>

        </Polygon>

        <Polygon>

            <X>526</X>

            <Y>1487</Y>

        </Polygon>

        <Words>

            <Character>再</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>564</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

        <Words>

            <Character>见</Character>

            <Confidence>99</Confidence>

            <WordCoordPoint>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1444</Y>

                </WordCoordinate>

                <WordCoordinate>

                    <X>641</X>

                    <Y>1487</Y>
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                </WordCoordinate>

                <WordCoordinate>

                    <X>608</X>

                    <Y>1487</Y>

                </WordCoordinate>

            </WordCoordPoint>

        </Words>

    </TextDetections>

</Response>
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商品抠图
最近更新时间：2023-06-20 15:21:01

腾讯云数据万象通过 GoodsMatting 接口检测图片中的商品信息，生成只包含商品信息的图片，支持持久化、云

上处理及下载时处理。

操作名称：GoodsMatting。

功能描述

使用限制：

待处理的图片，原图大小不超过5MB。

宽高不超过7680 x 7680像素。

支持处理JPG JPEG PNG。

1. 下载时处理

请求

 原图存储在COS：  

GET /<ObjectKey>?ci-process=GoodsMatting HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

 原图来自其他链接：

GET /<ObjectKey>?ci-process=GoodsMatting&detect-url=<detect-url> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: <GMT Date>

Authorization: <Auth String>

. . . .

处理参数说明

参数 含义 类型
是否

必选

Object

Key
对象文件名，例如：folder/document.jpg。

Stri

ng
是
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处理后的图片直接返回至响应体。

ci-

proces

s

数据万象处理能力，商品抠图固定为GoodsMatting。 Stri

ng

是

detect

-url

您可以通过填写 detect-url 处理任意公网可访问的图片链接。不填写 

detect-url 时，后台会默认处理 ObjectKey ，填写了 detect-url 

时，后台会处理 detect-url 链接，无需再填写 ObjectKey detect-

url 示例： http://www.example.com/abc.jpg ，需要进行 

UrlEncode，处理后为

http%25253A%25252F%25252Fwww.example.com%25252Fab

c.jpg

。

Stri

ng
否

响应

HTTP/1.1 200 OK

Content-Type: image/png

Content-Length: 98645

Date: Tue  23 Apr 2022 09:06:16 GMT

Server: tencent-ci

Status: 200 OK

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

pic-content

,

[ ]

2.上传时处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

说明：

Authorization:Auth String （详情请参见 请求签名  文档）。

请求

https://cloud.tencent.com/document/product/436/7778
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部。

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

该请求body内容为待裁剪图片原图 

[Image Content]

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否

必选
描述

is_pic_

info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不
进行图片处理

参数

名称
类型

是否

必选
描述

buck

et

Stri

ng
否

存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定

的话默认保存到当前存储桶

fileid
Stri

ng
是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文
件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件

名为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Stri
ng

是 固定为：ci-process=GoodsMatting

请求体

https://cloud.tencent.com/document/product/460/42865
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此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

ProcessResults 节点内容：

Object 节点内容：

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

Key OriginalInfo 原图文件名 String

Location OriginalInfo 图片路径 String

Etag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 抠图后图片文件名 String

Location Object 抠图后的图片链接 String

ETag Object 抠图后图片的ETag值 String

https://cloud.tencent.com/document/product/460/42866
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处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

Size Object 抠图后图片大小 Int

示例

请求：

PUT /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Authorization: Auth String

Pic-Operations: 

  "is_pic_info": 1

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=GoodsMatting"

  

. . . .

{

,

[{

,

}]

}

响应：

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>goods_matting jpg</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>goods_matting_process jpeg</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

,

.

. . . . .

.

. . . .
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Authorization:Auth String （详情请参见 请求签名  文档）。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。 

除公共头部外，还需要传入如下头部。

Pic-Operations 为 json 格式的字符串，具体参数如下：

rules（json 数组）中每一项具体参数如下：

        </Object>

    </ProcessResults>

</UploadResult>

3.云上数据处理

请求语法

PUT  /<ObjectKey> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

Pic-Operations: <PicOperations>

请求

请求头

头部名称 描述 类型

Pic-Operations 对图片进行操作的参数 String

参数名

称

类

型

是否必

选
描述

is_pic

_info
Int 否 是否返回原图信息，0不返回原图信息，1返回原图信息，默认为0

rules
Arr
ay

否
处理规则，一条规则对应一个处理结果（目前支持五条规则），不填则不
进行图片处理

参数名

称

类

型

是否

必选
描述

bucke Str 否 存储结果的目标存储桶名称，格式为 BucketName-AppId，如果不指定

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/42865
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该请求body内容为待裁剪图片原图 

[Image Content]

此接口返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回content-type为 application/xml 数据，具体的数据内容如下：

UploadResult 的内容：

OriginalInfo 节点内容：

t ing 的话默认保存到当前存储桶

fileid
Str

ing
是

处理后文件的保存路径及名称。名称规则说明：

例如源文件的路径及文件名为：/p1/test1.jpg

1. 以/开头为绝对路径，例如 fileid 值为 /p2/test2.jpg 时，表示在 p2 文
件夹中存储了一个文件名为 test2.jpg 的文件

2. 不以/开头为相对路径，例如 fileid 值为 p2/test2.jpg 时，表示在 p1 

文件夹中新建了一个 p2 文件夹，然后在 p2 文件夹中存储了一个文件名

为 test2.jpg 的文件

3. 注意：请不要以/结尾，否则会产生空文件名

4. 如希望修复后的图片覆盖原图，请将fileid字段设置为<ObjectKey>

rule
Str
ing

是 固定为：ci-process=GoodsMatting

请求体

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

UploadResult 无 请求结果 Container

节点名称（关键字） 父节点 描述 类型

OriginalInfo UploadResult 原图信息 Container

ProcessResults UploadResult 请求处理结果 Container

节点名称 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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ProcessResults 节点内容：

Object 节点内容：

处理后的图片存至存储桶，并以fileid字段的值作为对象名称。

Key OriginalInfo 原图文件名 String

Location OriginalInfo 原图路径 String

Etag OriginalInfo 原图ETag值 String

节点名称（关键字） 父节点 描述 类型

Object ProcessResults 每个图片的处理结果 Container

节点名称（关键字） 父节点 描述 类型

Key Object 抠图后图片文件名 String

Location Object 抠图后的图片链接 String

ETag Object 抠图后图片的ETag值 String

Size Object 抠图后图片大小 Int

示例

请求：

POST /<ObjectKey>?image_process HTTP/1.1

Host: <BucketName-APPID> cos <Region> myqcloud com

Date: GMT Date

Content-length: Size

Authorization: Auth String

Pic-Operations: 

  "rules": 

      "fileid": "exampleobject"

      "rule": "ci-process=GoodsMatting"

  

. . . .

{

[{

,

}]

}

响应：
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 645

Date: Tue  23 Apr 2022 09:06:16 GMT

Status: 200 OK

Server: tencent-ci

x-cos-request-id: NWFjMzQ0MDZfOTBmYTUwXzZkZV8z****

<UploadResult>

    <OriginalInfo>

        <Key>goods_matting jpg</Key>

        <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/filename jp

        <ETag>"ed60e3598e6862d8c8443a06acfb2153"</ETag>

    </OriginalInfo>

    <ProcessResults>

        <Object>

            <Key>goods_matting_process jpeg</Key>

            <Location>examplebucket-1250000000 cos ap-chengdu myqcloud com/example

            <Format/>

            <Size>354256</Size>

            <ETag>"521451f63c331becf533e466732c1091"</ETag>

        </Object>

    </ProcessResults>

</UploadResult>

,

.

. . . . .

.

. . . .
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以图搜图
开通以图搜图
最近更新时间：2023-06-20 15:10:28

该接口用于开通 Bucket 搜图功能。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /ImageSearchBucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Request 节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

MaxCapacity Request 图库容量限制 Int 是

MaxQps Request 图库访问限制，默认10 Int 否

说明

 图库容量设置后不允许修改。

响应

响应头

响应体

错误码

实际案例

请求

POST /ImageSearchBucket HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 50

Content-Type: application/xml

<Request>

    <MaxCapacity>10000</MaxCapacity>

    <MaxQps>10</MaxQps>

</Request>

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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添加图库图片
最近更新时间：2023-07-14 18:05:21

该接口用于添加图库图片。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Request节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是

否

必
选

ObjectKe

y

Req

uest
对象文件名，例如：folder/document.jpg。

Stri

ng
是

EntityId
Req

uest

物品 ID，最多支持64个字符。若 EntityId 已存在，则对其

追加图片

Stri

ng
是

CustomC
ontent

Req
uest

用户自定义的内容，最多支持4096个字符，查询时原样带
回

Stri
ng

否

Tags
Req

uest

图片自定义标签，最多不超过10个，json 字符串，格式为 

key:value （例 key1>=1 key1>='aa' ）对

Stri

ng
否

响应

响应头

响应体

错误码

实际案例

请求

POST /<ObjectKey>?ci-process=ImageSearch&action=AddImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 100

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

    <CustomContent>myapple</CustomContent>

    <Tags>{"key1":"val1","key2":"val2"}</Tags>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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图片搜索接口
最近更新时间：2023-07-14 18:05:21

该接口用于检索图片。

参数的具体内容如下：

功能描述

请求

请求示例

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=&O

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

节点名称

（关键字）
描述 类型

是否

必选

ObjectKe

y
对象文件名，例如：folder/document.jpg。

Strin

g
是

MatchThr
eshold

出参 Score 中，只有超过 MatchThreshold 值的结果才会返回。
默认为0

Int 否

Offset 起始序号，默认值为0 Int 否

Limit 返回数量，默认值为10，最大值为100 Int 否

Filter 针对入库时提交的 Tags 信息进行条件过滤。支持>、>=、<、<=、

=、!=，多个条件之间支持 AND 和 OR 进行连接

Strin

g

否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Response 节点的内容：

请求头

请求体

响应

响应头

响应体

<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey1</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7729
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ImageInfos 节点为数组，其中每一项内容为

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

RequestId Response 请求的唯一 ID String

Count Response 数量 Int

ImageInfos Response 图片信息 Container

节点名称（关

键字）
父节点 描述

类

型

EntityId
ImageI

nfos
物品 ID

Str

ing

CustomCo
ntent

ImageI
nfos

图片自定义的内容
Str
ing

Tags
ImageI

nfos

自定义标签信息，最多不超过10个，json 字符串，格式为 

key:value （例 key1>=1 key1>='aa' ）对

Str

ing

PicName
ImageI

nfos
图片名称

Str

ing

Score
ImageI
nfos

相似度 Int

错误码

实际案例

请求

GET /<ObjectKey>?ci-process=ImageSearch&action=SearchImage&MatchThreshold=10&

Authorization: q-sign-algorithm=sha1&q-ak=AKID8A0fBVtYFrNm02oY1g1JQQF0c3JO****&

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 150

https://cloud.tencent.com/document/product/436/7730
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Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <Count>2</Count>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey</PicName>

        <Score>99</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

    <ImageInfos>

        <EntityId>apple</EntityId>

        <PicName>ObjectKey2</PicName>

        <Score>90</Score>

        <CustomContent>XXX</CustomContent>

        <Tags>{"key1":"value1","key2":"value2"}</Tags>

    </ImageInfos>

</Response>
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删除图库图片
最近更新时间：2023-06-20 15:10:28

该接口用于删除图库图片。

此接口无请求参数。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体数据描述如下：

功能描述

请求

请求示例

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

请求头

请求体

<Request>

    <EntityId>apple</EntityId>

</Request>

https://cloud.tencent.com/document/product/436/7728
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Request 节点的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应无响应体。

此接口遵循统一的错误响应和错误码，详情请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关键字） 父节点 描述 类型 是否必选

EntityId Request 物品 ID String 是

响应

响应头

响应体

错误码

实际案例

请求

POST /<ObjectKey>?ci-process=ImageSearch&action=DeleteImage HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: examplebucket-1250000000.cos.ap-beijing.myqcloud.com

Content-Length: 20

Content-Type: application/xml

<Request>

    <EntityId>apple</EntityId>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 0

Connection: keep-alive

Date: Thu, 15 Jun 2017 12:37:29 GMT

Server: tencent-ci

https://cloud.tencent.com/document/product/436/7729
https://cloud.tencent.com/document/product/436/7730
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x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****
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内容翻译
提交任务
最近更新时间：2023-08-01 16:46:25

提交一个翻译任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>

        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：Translation

Stri

ng
是

Input
Req
uest

待操作的对象信息
Con
tain

er

是

Operation
Req
uest

操作规则

Con

tain
er

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Stri

ng
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队

列的回调类型

Stri

ng
否

CallBack Req 任务回调地址，优先级高于队列的回调地址。设置为 no Stri 否
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Container 类型 Input 的具体数据描述如下：

uest 时，表示队列的回调地址不产生回调 ng

CallBackM
qConfig

Req
uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时
必填。详情见 CallBackMqConfig

Con

tain
er

否

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

Object
Request.

Input

源文档文件名

单文件

（docx/xlsx/html/markdown/txt）：

不超过800万字符

有页数的（pdf/pptx）：不超过300页

文本文件（txt）：不超过10MB

二进制文件（pdf/docx/pptx/xlsx）：不

超过60MB

图片文件（jpg/jpeg/png/webp）：不超

过10MB

St
ri

n

g

无 是

Lang
Request.

Input

文档语言类型
zh：简体中文

zh-hk：繁体中文

zh-tw：繁体中文

zh-tr：繁体中文

en：英语

ar：阿拉伯语

de：德语

es：西班牙语

fr：法语

id：印尼语

it：意大利语

ja：日语

pt：葡萄牙语

ru：俄语

ko：韩语

km：高棉语

lo：老挝语

St
ri

n

g

无 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Type Request.

Input

文档类型

pdf

docx

pptx

xlsx

txt

xml

html：只能翻译 HTML 里的文本节点，需

要通过 JS 动态加载的不进行翻译

markdown

jpg

jpeg

png

webp

St

ri

n

g

无 是

BasicType
Request.

Input

原始文档类型

仅在 Type=pdf/jpg/jpeg/png/webp 时

使用，

当值为pdf时，仅支持 docx、pptx

当值为jpg/jpeg/png/webp时，仅支持txt

St

ri

n
g

无 否

Operation

节点名称（关

键字）
父节点 描述 类型

默

认

值

是否

必选

Translatio

n

Request.O

peration
翻译参数

Con

tain

er

无 是

Output
Request.O

peration

结果输出地址，当NoNeedOutput为

true时非必选

Con
tain

er

无 否

UserData
Request.O
peration

透传用户信息，可打印的 ASCII 码，长
度不超过1024

Stri
ng

无 否

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级

别越大任务优先级越高，默认为0

Stri

ng
无 否

NoNeedO

utput

Request.O

peration

仅输出结果，不生成结果文件。取值：

true/false。该参数原文档类型为图片时

有效。默认值 false

Stri

ng

无 否
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Container 类型 Translation 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
父节点 描述

类

型

默

认
值

是否

必选

Lang
Request.Operatio

n.Translation

目标语言类型

源语言类型为 zh/zh-hk/zh-

tw/zh-tr 时支持：en、ar、
de、es、fr、id、it、ja、it、

ru、ko、km、lo、pt

源语言类型为 en 时支持：zh、

zh-hk、zh-tw、zh-tr、ar、
de、es、fr、id、it、ja、it、

ru、ko、km、lo、pt

其他类型时支持：zh、zh-

hk、zh-tw、zh-tr、en

St

ri

n
g

无 是

Type
Request.Operatio

n.Translation

文档类型，源文件类型与目标文件类

型映射关系如下：

docx：docx

pptx：pptx

xlsx：xlsx

txt：txt

xml：xml

html：html

markdown：markdown

pdf：pdf、docx

png：txt

jpg：txt

jpeg：txt

webp：txt

St
ri

n

g

无 是

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.Outp

ut
存储桶的地域

Stri

ng
是

Bucket Request.Operation.Outp 存储结果的存储桶 Stri 是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

ut ng

Object
Request.Operation.Outp

ut
输出结果的文件名

Stri

ng
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义
Stri
ng

JobId
Response.J

obsDetail
创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
创建任务的 Tag：Translation

Stri

ng

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime Response.J 任务的开始时间 Stri
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Container 节点 Operation 的内容：

Container 节点 AITranslateResult 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

obsDetail ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con
tain

er

节点名称（关键

字）
父节点 描述 类型

Translation
Response.JobsDetail.

Operation

同请求中的 

Request.Operation.Translation

Contai

ner

Output
Response.JobsDetail.

Operation

同请求中的 

Request.Operation.Output

Contai

ner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

JobLevel
Response.JobsDetail.
Operation

任务优先级 String

AITranslateR

esult

Response.JobsDetail.

Operation
翻译结果详情

Contai

ner

节点名称（关键字） 父节点 描述 类型

Result Response.JobsDetail.Operation 翻译结果内容 String

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/46487
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请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Translation</Tag>

    <Input>

        <Object>input/en.pdf</Object>

        <Lang>en</Lang>

        <Type>pdf</Type>

        <BasicType>pptx</BasicType>

    </Input>

    <Operation>

        <Translation>

            <Lang>zh</Lang>

            <Type>pdf</Type>

        </Translation>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/zh.pdf</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>
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    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>Translation</Tag>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <Operation>

            <Translation>

                <Lang>zh</Lang>

                <Type>pdf</Type>

            </Translation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-11 17:56:15

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

EventName
Respons
e

固定值，为 TaskFinish String

JobsDetail
Respons

e

同提交翻译任务接口中的 

Response.JobsDetail  

Container 

数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

https://cloud.tencent.com/document/product/460/84799#JobsDetail
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实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>input/en.pdf</Object>

            <Lang>en</Lang>

            <Type>pdf</Type>

            <BasicType>pptx</BasicType>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/zh.pdf</Object>

            </Output>

            <Translation>

                <Lang>en</Lang>

                <Type>txt</Type>

            </Translation>

            <UserData>This is my Translation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>Translation</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

{

,

[{

,
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        "CreationTime": "2022-07-25T16:35:39+0800"

        "EndTime": "2022-07-25T16:35:43+0800"

        "Input": 

            "Object": "input/en.pdf"

            "Lang": "en"

            "Type": "pdf"

            "BasicType": "pptx"

        

        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427"

        "Message": "Success"

        "Operation": 

            "Output": 

                "Region": "ap-chongqing"

                "Bucket": "test-123456789"

                "Object": "output/zh.pdf"

            

            "Translation": 

                "Lang": "en"

                "Type": "txt"

            

            "UserData": "This is my Translation job."

            "JobLevel": 0

        

        "QueueId": "pbde29b842b1b4e2ea4f0b20d264fcec2"

        "StartTime": "2022-07-25T16:35:39+0800"

        "State": "Success"

        "Tag": "Translation"

    

,

,

{

,

,

,

},

,

,

{

{

,

,

},

{

,

},

,

,

},

,

,

,

}]

}
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词性分析
提交任务
最近更新时间：2023-08-01 16:46:25

提交一个分词任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>

    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Requ

est
创建任务的 Tag：WordsGeneralize String 是

Input
Requ

est
待操作的对象信息

Conta

iner
是

Operation
Requ

est
操作规则

Conta

iner
是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式
String 否

CallBackT
ype

Requ
est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高
于队列的回调类型

String 否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调
String 否

CallBackM

qConfig

Requ

est

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Conta

iner
否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 WordsGeneralize 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Operation

节点名称（关
键字）

父节点 描述 类型
是否
必选

WordsGen

eralize

Request.

Operation
指定分词参数

Con

tain
er

是

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

Stri

ng
否

JobLevel
Request.

Operation

任务优先级，级别限制：0 、1 、2。级别越大任务

优先级越高，默认为0

Stri

ng
否

节点名称（关键

字）
父节点 描述

类

型

是否

必选

NerMethod
Request.Operation.W

ordsGeneralize

ner 方式，支持 NerBasic 和 

DL，默认值 DL

St
ri

n

g

否

SegMethod
Request.Operation.W

ordsGeneralize

分词粒度，支持 SegBasic 和 

MIX，默认值 MIX

St

ri

n

g

否

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>

        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J
obsDetail

错误码，只有 State 为 Failed 时有意义
Stri
ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
创建任务的 ID

Stri

ng
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Container 节点 Operation 的内容：

Tag Response.J
obsDetail

创建任务的 Tag：WordsGeneralize Stri
ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变
为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi
me

Response.J
obsDetail

任务的创建时间
Stri
ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J
obsDetail

任务所属的  队列 ID
Stri
ng

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Con

tain
er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键
字）

父节点 描述 类型

WordsGeneral

ize

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.WordsGenera
lize

Conta

iner

UserData
Response.JobsDetail

.Operation
透传用户信息 String

JobLevel
Response.JobsDetail

.Operation
任务优先级 String
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Container 节点 WordsGeneralizeResult 的内容：

Container 节点 WordsGeneralizeLable 的内容：

Container 节点 WordsGeneralizeToken 的内容：

词性详见下标：

WordsGeneral
izeResult

Response.JobsDetail
.Operation

分词结果，任务执行成功时返回 Conta
iner

节点名称（关键字） 父节点 描述 类型

WordsGeneraliz

eLable

Response.JobsDetail.Operation.WordsGe

neralizeResult

智能分类

结果

Containe

r 数组

WordsGeneraliz

eToken

Response.JobsDetail.Operation.WordsGe

neralizeResult

分词详细

结果

Containe

r 数组

节点名称（关键

字）
父节点

描

述

类

型

Category
Response.JobsDetail.Operation.WordsGeneralizeResult.

WordsGeneralizeLable

类

别

Str

ing

Word
Response.JobsDetail.Operation.WordsGeneralizeResult.

WordsGeneralizeLable

词

汇

Str

ing

节点名称（关键
字）

父节点 描述
类
型

Word
Response.JobsDetail.Operation.WordsGeneralizeResu

lt.WordsGeneralizeToken
词汇

Str

ing

Offset
Response.JobsDetail.Operation.WordsGeneralizeResu

lt.WordsGeneralizeToken

偏移

量

Str

ing

Length
Response.JobsDetail.Operation.WordsGeneralizeResu
lt.WordsGeneralizeToken

词汇
长度

Str
ing

Pos
Response.JobsDetail.Operation.WordsGeneralizeResu

lt.WordsGeneralizeToken
词性

Str

ing

英文缩写 含义

A 形容词
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AD 副形词

AN 名形词

B 区别词

C 连词

D 副词

E 叹词

F 方位词

G 语素词

H 前接成分

I 成语

J 简称略语

K 后接成分

L 习用语

M 数词

N 名词

NR 人名

NRF 姓

NRG 名

NS 地名

NT 机构团体

NZ 其他专名

NX 非汉字串

O 拟声词

P 介词

Q 量词
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

R 代词

S 处所词

T 时间词

U 助词

V 动词

VD 副动词

VN 名动词

W 标点符号

X 非语素字

Y 语气词

Z 状态词

AG 形语素

BG 区别语素

DG 副语素

MG 数词性语素

NG 名语素

QG 量语素

RG 代语素

TG 动语素

VG 量语素

YG 语气词语素

ZG 状态词语素

UNK 未知词性

错误码

https://cloud.tencent.com/document/product/460/42867
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实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>WordsGeneralize</Tag>

    <Input>

        <Object>text.txt</Object>

    </Input>

    <Operation>

        <WordsGeneralize>

            <NerMethod>DL</NerMethod>

            <SegMethod>MIX</SegMethod>

        </WordsGeneralize>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>
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        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>WordsGeneralize</Tag>

        <Input>

            <Object>text.txt</Object>

        </Input>

        <Operation>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-10 18:13:43

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>

            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>交通</Category>

                    <Word>打车</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>今天</Word>
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具体的数据内容如下：

Container 节点 Response 的内容：

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>打车</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>花</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>元</Word>

                </WordsGeneralizeToken>

            </WordsGeneralizeResult>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respons
e

固定值，为 TaskFinish String

JobsDetail
Respons

e

同提交分词任务接口中的 

Response.JobsDetail  
Container 数组

https://cloud.tencent.com/document/product/460/84800#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosHe

aders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHe

aders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Tag>WordsGeneralize</Tag>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <Object>text.txt</Object>

            <BucketId>test-123456789</BucketId>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <UserData>This is my WordsGeneralize job.</UserData>
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            <JobLevel>0</JobLevel>

            <WordsGeneralize>

                <NerMethod>DL</NerMethod>

                <SegMethod>MIX</SegMethod>

            </WordsGeneralize>

            <WordsGeneralizeResult>

                <WordsGeneralizeLable>

                    <Category>交通</Category>

                    <Word>打车</Word>

                </WordsGeneralizeLable>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>0</Offset>

                    <Pos>t</Pos>

                    <Word>今天</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>2</Offset>

                    <Pos>v</Pos>

                    <Word>打车</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>4</Offset>

                    <Pos>v</Pos>

                    <Word>花</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>2</Length>

                    <Offset>5</Offset>

                    <Pos>nx</Pos>

                    <Word>60</Word>

                </WordsGeneralizeToken>

                <WordsGeneralizeToken>

                    <Length>1</Length>

                    <Offset>7</Offset>

                    <Pos>q</Pos>

                    <Word>元</Word>

                </WordsGeneralizeToken>

            </WordsGeneralizeResult>

        </Operation>

    </JobsDetail>

</Response>
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案例 2：通过任务触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Tag": "WordsGeneralize"

        "Code": "Success"

        "CreationTime": "2022-07-25T16:35:39+0800"

        "EndTime": "2022-07-25T16:35:43+0800"

        "Input": 

            "Object": "text.txt"

            "BucketId": "test-123456789"

            "Region": "ap-chongqing"

        

        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427"

        "Message": "Success"

        "Operation": 

            "UserData": "This is my WordsGeneralize job."

            "JobLevel": "0"

            "WordsGeneralize": 

                "NerMethod": "DL"

                "SegMethod": "MIX"

            

            "WordsGeneralizeResult": 

                "WordsGeneralizeLable": 

                    "Category": "交通"

                    "Word": "打车"

                

                "WordsGeneralizeToken": 

                        "Length": "2"

                        "Offset": "0"

                        "Pos": "t"

                        "Word": "今天"

                    

                    

                        "Length": "2"

                        "Offset": "2"

                        "Pos": "v"

                        "Word": "打车"

                    

                    

                        "Length": "1"

                        "Offset": "4"

                        "Pos": "v"

                        "Word": "花"

{

,

[{

,

,

,

,

{

,

,

},

,

,

{

,

,

{

,

},

{

{

,

},

[{

,

,

,

},

{

,

,

,

},

{

,

,

,
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                        "Length": "2"

                        "Offset": "5"

                        "Pos": "nx"

                        "Word": "60"

                    

                    

                        "Length": "1"

                        "Offset": "7"

                        "Pos": "q"

                        "Word": "元"

                    

                

            

        

    

},

{

,

,

,

},

{

,

,

,

}

]

}

}

}]

}
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视频目标检测
提交任务
最近更新时间：2023-08-11 17:56:16

提交一个视频目标检测任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoTargetRec</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <UserData>This is my data.</UserData>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag

Req

ues

t

创建任务的 Tag：VideoTargetRec String 是

Operation

Req

ues

t

操作规则
Conta

iner
是

Input

Req

ues

t

待操作的媒体信息
Conta

iner
是

CallBackFo

rmat

Req
ues

t

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式
String 否

CallBackTy

pe

Req
ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型
String 否

CallBack
Req
ues

t

任务回调地址，优先级高于队列的回调地址。设置为 no 
时，表示队列的回调地址不产生回调

String 否

CallBackM
qConfig

Req

ues
t

任务回调TDMQ配置，当 CallBackType 为 TDMQ 
时必填。详情请参见 CallBackMqConfig

Conta
iner

否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关

键字）

父节点 描述 类

型

是否

必选

Object
Reques

t.Input
媒体文件名

St
ri

n

g

否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateId
Request.Op

eration
视频目标检测模板 ID

Stri

ng
否

VideoTarge
tRec

Request.Op
eration

视频目标检测参数, 同创建视频目标检测模板接
口中的 Request.VideoTargetRec  

Con
tain

er

否

UserData
Request.Op

eration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Stri

ng
否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越大

任务优先级越高，默认为0

Stri

ng
否

注意

视频目标检测参数必须设置，可以通过 TemplateId 或 VideoTargetRec 设置， TemplateId 优先级

更高。

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84736#VideoTargetRec
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTargetRec</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>video_target_rec_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J
obsDetail

新创建任务的 ID
Stri
ng

Tag
Response.J

obsDetail
新创建任务的 Tag：VideoTargetRec

Stri

ng

State Response.J 任务状态 Stri
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Container 节点 Operation 的内容：

obsDetail Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的队列 ID

Stri

ng

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键
字）

父节点 描述 类型

TemplateId
Response.JobsDetail.

Operation
任务的模板 ID String

TemplateName
Response.JobsDetail.

Operation

任务的模板名称, 当 TemplateId 存在

时返回
String

VideoTargetRe
c

Response.JobsDetail.
Operation

同请求中的 
Request.Operation.VideoTarget

Rec

Conta
iner

VideoTargetRe

cResult

Response.JobsDetail.

Operation
视频目标检测结果

Conta

iner

UserData
Response.JobsDetail.

Operation
透传用户信息 String

JobLevel Response.JobsDetail. 任务优先级 String



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1395 共1950页

Container 节点 VideoTargetRecResult 的内容：

Container 节点 BodyRecognition 的内容：

Container 节点 PetRecognition 的内容：

Container 节点 CarRecognition 的内容：

Operation

节点名称（关键

字）
父节点 描述 类型

BodyRecogniti

on

Response.JobsDetail.Operation.VideoTa

rgetRecResult

人体识别结

果

Container 

数组

PetRecognitio

n

Response.JobsDetail.Operation.VideoTa

rgetRecResult

宠物识别结

果

Container 

数组

CarRecognitio

n

Response.JobsDetail.Operation.VideoTa

rgetRecResult

车辆识别结

果

Container 

数组

节点名称（关

键字）
父节点 描述 类型

Time
Response.JobsDetail.Operation.VideoTarg

etRecResult.BodyRecognition

截图的时间点，

单位为秒
String

Url
Response.JobsDetail.Operation.VideoTarg
etRecResult.BodyRecognition

截图 URL String

BodyInfo
Response.JobsDetail.Operation.VideoTarg

etRecResult.BodyRecognition

人体识别结果，

可能有多个

Contain

er 数组

节点名称（关
键字）

父节点 描述 类型

Time
Response.JobsDetail.Operation.VideoTar

getRecResult.PetRecognition

截图的时间点，单

位为秒
String

Url
Response.JobsDetail.Operation.VideoTar

getRecResult.PetRecognition
截图 URL String

PetInfo
Response.JobsDetail.Operation.VideoTar

getRecResult.PetRecognition

宠物识别结果结

果，可能有多个

Contain

er 数组

节点名称（关 父节点 描述 类型
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Container 节点 BodyInfo 节点的内容：

Container 节点 Location 节点的内容：

键字）

Time
Response.JobsDetail.Operation.VideoTarg

etRecResult.CarRecognition

截图的时间点，

单位为秒
String

Url
Response.JobsDetail.Operation.VideoTarg

etRecResult.CarRecognition
截图 URL String

CarInfo
Response.JobsDetail.Operation.VideoTarg
etRecResult.CarRecognition

车辆识别结果，
可能有多个

Contain
er 数组

节点名称（关

键字）
父节点 描述 类型

Name
Response.JobsDetail.Operation.
VideoTargetRecResult.BodyRec

ognition.BodyInfo

识别类型
Strin
g

Score

Response.JobsDetail.Operation.

VideoTargetRecResult.BodyRec
ognition.BodyInfo

识别的置信度，取值范围为[0-
100]。值越高概率越大。

Int

Location

Response.JobsDetail.Operation.

VideoTargetRecResult.BodyRec
ognition.BodyInfo

图中识别到人体的坐标
Cont

ainer

节点名称（关

键字）
父节点 描述

类

型

X
Response.JobsDetail.Operation.
VideoTargetRecResult.BodyRec

ognition.BodyInfo.Location

X坐标

St

ri
n

g

Y
Response.JobsDetail.Operation.
VideoTargetRecResult.BodyRec

ognition.BodyInfo.Location

Y坐标

St
ri

n

g

Height Response.JobsDetail.Operation.
VideoTargetRecResult.BodyRec

ognition.BodyInfo.Location

(X,Y)坐标距离高度 St
ri

n

g
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Container 节点 PetInfo 节点的内容：

Container 节点 Location 节点的内容：

Container 节点 CarInfo 节点的内容：

Width

Response.JobsDetail.Operation.

VideoTargetRecResult.BodyRec

ognition.BodyInfo.Location

(X,Y)坐标距离长度

St

ri

n

g

节点名称
（关键

字）

父节点 描述 类型

Name

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco
gnition.PetInfo

识别类型
Strin
g

Score

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco
gnition.PetInfo

识别的置信度，取值范围为[0-

100]。值越高概率越大。
Int

Location

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco

gnition.PetInfo

图中识别到宠物的坐标
Cont

ainer

节点名称（关
键字）

父节点 描述
类
型

X

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco
gnition.PetInfo.Location

X坐标
In

t

Y

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco

gnition.PetInfo.Location

Y坐标
In

t

Height

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco

gnition.PetInfo.Location

(X,Y)坐标距离高度
In

t

Width

Response.JobsDetail.Operation.

VideoTargetRecResult.PetReco

gnition.PetInfo.Location

(X,Y)坐标距离长度
In

t
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Container 节点 Location 节点的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关
键字）

父节点 描述 类型

Name

Response.JobsDetail.Operation.

VideoTargetRecResult.CarReco

gnition.CarInfo

识别类型
Stri

ng

Score

Response.JobsDetail.Operation.

VideoTargetRecResult.CarReco

gnition.CarInfo

识别的置信度，取值范围为[0-

100]。值越高概率越大。
Int

Location

Response.JobsDetail.Operation.

VideoTargetRecResult.CarReco

gnition.CarInfo

图中识别到车辆的坐标

Con

tain

er

节点名称（关

键字）
父节点 描述

类

型

X

Response.JobsDetail.Operation.

VideoTargetRecResult.CarRecog

nition.CarInfo.Location

X坐标
In

t

Y

Response.JobsDetail.Operation.

VideoTargetRecResult.CarRecog

nition.CarInfo.Location

Y坐标
In

t

Height

Response.JobsDetail.Operation.

VideoTargetRecResult.CarRecog

nition.CarInfo.Location

(X,Y)坐标距离高度
In

t

Width

Response.JobsDetail.Operation.

VideoTargetRecResult.CarRecog

nition.CarInfo.Location

(X,Y)坐标距离长度
In

t

错误码

实际案例

请求1：使用视频目标检测模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

https://cloud.tencent.com/document/product/460/42867
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Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoTargetRec</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTargetRec</Tag>

        <Operation>      

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>video_target_rec_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>
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        </Operation>

    </JobsDetail>

</Response>

请求2：使用视频目标检测处理参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VideoTargetRec</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VideoTargetRec>

            <Body>true</Body>

            <Car>true</Car>

            <Pet>true</Pet>

        </VideoTargetRec>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>
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        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VideoTargetRec</Tag>

        <Operation>

            <VideoTargetRec>

                <Body>true</Body>

                <Car>true</Car>

                <Pet>true</Pet>

            </VideoTargetRec>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1402 共1950页

回调信息
最近更新时间：2023-08-18 15:28:02

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-11-21T20:32:44+0800</CreationTime>

        <EndTime>2022-11-21T20:32:54+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/car.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>a993e661c699811ed9588038f7fb96507</JobId>

        <Message>TaskFinish</Message>

        <Operation>

            <JobLevel>0</JobLevel>

            <VideoTargetRec>

                <Body>true</Body>

                <Car>true</Car>

                <Pet>true</Pet>

            </VideoTargetRec>

            <VideoTargetRecResult>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>382</Height>

                            <Width>193</Width>

                            <X>469</X>

                            <Y>67</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>86</Score>
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版权所有：腾讯云计算（北京）有限责任公司 第1403 共1950页

                    </BodyInfo>

                    <Time>1.206000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>349</Height>

                            <Width>198</Width>

                            <X>315</X>

                            <Y>177</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>83</Score>

                    </BodyInfo>

                    <Time>2.413000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>366</Height>

                            <Width>190</Width>

                            <X>322</X>

                            <Y>126</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>85</Score>

                    </BodyInfo>

                    <Time>3.620000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>29</Height>

                            <Width>21</Width>

                            <X>807</X>

                            <Y>195</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>74</Score>

                    </BodyInfo>

                    <Time>9.655000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456
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                </BodyRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>526</Height>

                            <Width>911</Width>

                            <X>48</X>

                            <Y>0</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>72</Score>

                    </CarInfo>

                    <Time>0.000000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>459</Height>

                            <Width>744</Width>

                            <X>9</X>

                            <Y>48</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>87</Score>

                    </CarInfo>

                    <Time>6.034000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>284</Height>

                            <Width>176</Width>

                            <X>781</X>

                            <Y>235</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>92</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>231</Height>

                            <Width>290</Width>

                            <X>0</X>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1405 共1950页

                            <Y>231</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>91</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>132</Height>

                            <Width>165</Width>

                            <X>0</X>

                            <Y>216</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>85</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>84</Height>

                            <Width>107</Width>

                            <X>733</X>

                            <Y>219</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>81</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>457</Height>

                            <Width>525</Width>

                            <X>237</X>

                            <Y>40</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>71</Score>

                    </CarInfo>

                    <Time>8.448000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>233</Height>

                            <Width>270</Width>

                            <X>0</X>

                            <Y>232</Y>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1406 共1950页

                        </Location>

                        <Name>vehicle</Name>

                        <Score>89</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>272</Height>

                            <Width>199</Width>

                            <X>760</X>

                            <Y>234</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>78</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>140</Height>

                            <Width>153</Width>

                            <X>0</X>

                            <Y>214</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <Time>9.655000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>125</Height>

                            <Width>150</Width>

                            <X>189</X>

                            <Y>282</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>90</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>207</Height>

                            <Width>191</Width>

                            <X>0</X>

                            <Y>330</Y>

                        </Location>
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                        <Name>vehicle</Name>

                        <Score>86</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>62</Height>

                            <Width>96</Width>

                            <X>99</X>

                            <Y>288</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>81</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>58</Height>

                            <Width>43</Width>

                            <X>378</X>

                            <Y>282</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>74</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>22</Height>

                            <Width>27</Width>

                            <X>342</X>

                            <Y>271</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>73</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>85</Height>

                            <Width>107</Width>

                            <X>208</X>

                            <Y>229</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>
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                            <Height>43</Height>

                            <Width>31</Width>

                            <X>313</X>

                            <Y>271</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <Time>10.862000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>338</Height>

                            <Width>817</Width>

                            <X>61</X>

                            <Y>144</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>88</Score>

                    </CarInfo>

                    <Time>19.309999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>465</Height>

                            <Width>854</Width>

                            <X>48</X>

                            <Y>15</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>80</Score>

                    </CarInfo>

                    <Time>27.757999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <Duration>33171</Duration>

                <PetRecognition>

                    <PetInfo>

                        <Location>

                            <Height>92</Height>

                            <Width>210</Width>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                            <X>622</X>

                            <Y>148</Y>

                        </Location>

                        <Name>dog</Name>

                        <Score>81</Score>

                    </PetInfo>

                    <Time>19.309999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </PetRecognition>

            </VideoTargetRecResult>

        </Operation>

        <QueueId>p56347f79bc2d4551a4651e01a54a6fce</QueueId>

        <StartTime>2022-11-21T20:32:45+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTargetRec</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称

（关键字）
父节点 描述 类型

EventNam

e

Respon

se
固定值，为 TaskFinish String

JobsDetail
Respon

se
同提交视频目标检测接口中的 Response.JobsDetail  

Contain

er 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value Response.JobsDetail.Input.CosH 自定义 Header 的值 Strin

https://cloud.tencent.com/document/product/436/84801#JobsDetail
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版权所有：腾讯云计算（北京）有限责任公司 第1410 共1950页

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

eaders g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调，格式为 XML

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-11-21T20:32:44+0800</CreationTime>

        <EndTime>2022-11-21T20:32:54+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/car.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>a993e661c699811ed9588038f7fb96507</JobId>

        <Message>TaskFinish</Message>

        <Operation>

            <JobLevel>0</JobLevel>

            <VideoTargetRec>

                <Body>true</Body>

                <Car>true</Car>

                <Pet>true</Pet>

            </VideoTargetRec>

            <VideoTargetRecResult>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>382</Height>

                            <Width>193</Width>
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版权所有：腾讯云计算（北京）有限责任公司 第1411 共1950页

                            <X>469</X>

                            <Y>67</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>86</Score>

                    </BodyInfo>

                    <Time>1.206000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>349</Height>

                            <Width>198</Width>

                            <X>315</X>

                            <Y>177</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>83</Score>

                    </BodyInfo>

                    <Time>2.413000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>366</Height>

                            <Width>190</Width>

                            <X>322</X>

                            <Y>126</Y>

                        </Location>

                        <Name>person</Name>

                        <Score>85</Score>

                    </BodyInfo>

                    <Time>3.620000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <BodyRecognition>

                    <BodyInfo>

                        <Location>

                            <Height>29</Height>

                            <Width>21</Width>

                            <X>807</X>

                            <Y>195</Y>

                        </Location>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1412 共1950页

                        <Name>person</Name>

                        <Score>74</Score>

                    </BodyInfo>

                    <Time>9.655000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </BodyRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>526</Height>

                            <Width>911</Width>

                            <X>48</X>

                            <Y>0</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>72</Score>

                    </CarInfo>

                    <Time>0.000000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>459</Height>

                            <Width>744</Width>

                            <X>9</X>

                            <Y>48</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>87</Score>

                    </CarInfo>

                    <Time>6.034000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>284</Height>

                            <Width>176</Width>

                            <X>781</X>

                            <Y>235</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>92</Score>

                    </CarInfo>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1413 共1950页

                    <CarInfo>

                        <Location>

                            <Height>231</Height>

                            <Width>290</Width>

                            <X>0</X>

                            <Y>231</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>91</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>132</Height>

                            <Width>165</Width>

                            <X>0</X>

                            <Y>216</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>85</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>84</Height>

                            <Width>107</Width>

                            <X>733</X>

                            <Y>219</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>81</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>457</Height>

                            <Width>525</Width>

                            <X>237</X>

                            <Y>40</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>71</Score>

                    </CarInfo>

                    <Time>8.448000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>
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                        <Location>

                            <Height>233</Height>

                            <Width>270</Width>

                            <X>0</X>

                            <Y>232</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>89</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>272</Height>

                            <Width>199</Width>

                            <X>760</X>

                            <Y>234</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>78</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>140</Height>

                            <Width>153</Width>

                            <X>0</X>

                            <Y>214</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <Time>9.655000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>125</Height>

                            <Width>150</Width>

                            <X>189</X>

                            <Y>282</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>90</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>
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                            <Height>207</Height>

                            <Width>191</Width>

                            <X>0</X>

                            <Y>330</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>86</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>62</Height>

                            <Width>96</Width>

                            <X>99</X>

                            <Y>288</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>81</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>58</Height>

                            <Width>43</Width>

                            <X>378</X>

                            <Y>282</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>74</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>22</Height>

                            <Width>27</Width>

                            <X>342</X>

                            <Y>271</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>73</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>85</Height>

                            <Width>107</Width>

                            <X>208</X>

                            <Y>229</Y>

                        </Location>
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                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <CarInfo>

                        <Location>

                            <Height>43</Height>

                            <Width>31</Width>

                            <X>313</X>

                            <Y>271</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>70</Score>

                    </CarInfo>

                    <Time>10.862000</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>338</Height>

                            <Width>817</Width>

                            <X>61</X>

                            <Y>144</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>88</Score>

                    </CarInfo>

                    <Time>19.309999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <CarRecognition>

                    <CarInfo>

                        <Location>

                            <Height>465</Height>

                            <Width>854</Width>

                            <X>48</X>

                            <Y>15</Y>

                        </Location>

                        <Name>vehicle</Name>

                        <Score>80</Score>

                    </CarInfo>

                    <Time>27.757999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </CarRecognition>

                <Duration>33171</Duration>
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                <PetRecognition>

                    <PetInfo>

                        <Location>

                            <Height>92</Height>

                            <Width>210</Width>

                            <X>622</X>

                            <Y>148</Y>

                        </Location>

                        <Name>dog</Name>

                        <Score>81</Score>

                    </PetInfo>

                    <Time>19.309999</Time>

                    <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-123456

                </PetRecognition>

            </VideoTargetRecResult>

        </Operation>

        <QueueId>p56347f79bc2d4551a4651e01a54a6fce</QueueId>

        <StartTime>2022-11-21T20:32:45+0800</StartTime>

        <State>Success</State>

        <Tag>VideoTargetRec</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

  "EventName": "TaskFinish"

  "JobsDetail": 

    

      "Code": "Success"

      "CreationTime": "2022-11-21T20:32:44+0800"

      "EndTime": "2022-11-21T20:32:54+0800"

      "Input": 

        "BucketId": "test-1234567890"

        "Object": "input/car.mp4"

        "Region": "ap-chongqing"

      

      "JobId": "a993e661c699811ed9588038f7fb96507"

      "Message": "TaskFinish"

      "Operation": 

        "JobLevel": "0"

        "VideoTargetRec": 

          "Body": "true"

          "Car": "true"

{

,

[

{

,

,

,

{

,

,

},

,

,

{

,

{

,

,
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          "Pet": "true"

        

        "VideoTargetRecResult": 

          "BodyRecognition": 

            

              "BodyInfo": 

                "Location": 

                  "Height": "382"

                  "Width": "193"

                  "X": "469"

                  "Y": "67"

                

                "Name": "person"

                "Score": "86"

              

              "Time": "1.206000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "BodyInfo": 

                "Location": 

                  "Height": "349"

                  "Width": "198"

                  "X": "315"

                  "Y": "177"

                

                "Name": "person"

                "Score": "83"

              

              "Time": "2.413000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "BodyInfo": 

                "Location": 

                  "Height": "366"

                  "Width": "190"

                  "X": "322"

                  "Y": "126"

                

                "Name": "person"

                "Score": "85"

              

              "Time": "3.620000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

},

{
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{

{

,

,

,

},

,

},

,

},
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,

,

},

,

},

,
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,
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              "BodyInfo": 

                "Location": 

                  "Height": "29"

                  "Width": "21"

                  "X": "807"

                  "Y": "195"

                

                "Name": "person"

                "Score": "74"

              

              "Time": "9.655000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

          

          "CarRecognition": 

            

              "CarInfo": 

                "Location": 

                  "Height": "526"

                  "Width": "911"

                  "X": "48"

                  "Y": "0"

                

                "Name": "vehicle"

                "Score": "72"

              

              "Time": "0.000000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "CarInfo": 

                "Location": 

                  "Height": "459"

                  "Width": "744"

                  "X": "9"

                  "Y": "48"

                

                "Name": "vehicle"

                "Score": "87"

              

              "Time": "6.034000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

},
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,
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,
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              "CarInfo": 

                

                  "Location": 

                    "Height": "284"

                    "Width": "176"

                    "X": "781"

                    "Y": "235"

                  

                  "Name": "vehicle"

                  "Score": "92"

                

                

                  "Location": 

                    "Height": "231"

                    "Width": "290"

                    "X": "0"

                    "Y": "231"

                  

                  "Name": "vehicle"

                  "Score": "91"

                

                

                  "Location": 

                    "Height": "132"

                    "Width": "165"

                    "X": "0"

                    "Y": "216"

                  

                  "Name": "vehicle"

                  "Score": "85"

                

                

                  "Location": 

                    "Height": "84"

                    "Width": "107"

                    "X": "733"

                    "Y": "219"

                  

                  "Name": "vehicle"

                  "Score": "81"

                

                

                  "Location": 

                    "Height": "457"

{
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,
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,
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,
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                    "Width": "525"

                    "X": "237"

                    "Y": "40"

                  

                  "Name": "vehicle"

                  "Score": "71"

                

              

              "Time": "8.448000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "CarInfo": 

                

                  "Location": 

                    "Height": "233"

                    "Width": "270"

                    "X": "0"

                    "Y": "232"

                  

                  "Name": "vehicle"

                  "Score": "89"

                

                

                  "Location": 

                    "Height": "272"

                    "Width": "199"

                    "X": "760"

                    "Y": "234"

                  

                  "Name": "vehicle"

                  "Score": "78"

                

                

                  "Location": 

                    "Height": "140"

                    "Width": "153"

                    "X": "0"

                    "Y": "214"

                  

                  "Name": "vehicle"

                  "Score": "70"

                

              

              "Time": "9.655000"

,

,

},

,

}

],

,

},
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,
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,
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,
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,



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1422 共1950页

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "CarInfo": 

                

                  "Location": 

                    "Height": "125"

                    "Width": "150"

                    "X": "189"

                    "Y": "282"

                  

                  "Name": "vehicle"

                  "Score": "90"

                

                

                  "Location": 

                    "Height": "207"

                    "Width": "191"

                    "X": "0"

                    "Y": "330"

                  

                  "Name": "vehicle"

                  "Score": "86"

                

                

                  "Location": 

                    "Height": "62"

                    "Width": "96"

                    "X": "99"

                    "Y": "288"

                  

                  "Name": "vehicle"

                  "Score": "81"

                

                

                  "Location": 

                    "Height": "58"

                    "Width": "43"

                    "X": "378"

                    "Y": "282"

                  

                  "Name": "vehicle"

                  "Score": "74"

                

                

},
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,

,
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,
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,
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,

},

{

{

,

,

,

},

,

},

{



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1423 共1950页

                  "Location": 

                    "Height": "22"

                    "Width": "27"

                    "X": "342"

                    "Y": "271"

                  

                  "Name": "vehicle"

                  "Score": "73"

                

                

                  "Location": 

                    "Height": "85"

                    "Width": "107"

                    "X": "208"

                    "Y": "229"

                  

                  "Name": "vehicle"

                  "Score": "70"

                

                

                  "Location": 

                    "Height": "43"

                    "Width": "31"

                    "X": "313"

                    "Y": "271"

                  

                  "Name": "vehicle"

                  "Score": "70"

                

              

              "Time": "10.862000"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "CarInfo": 

                "Location": 

                  "Height": "338"

                  "Width": "817"

                  "X": "61"

                  "Y": "144"

                

                "Name": "vehicle"

                "Score": "88"

              

              "Time": "19.309999"

{
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              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

            

              "CarInfo": 

                "Location": 

                  "Height": "465"

                  "Width": "854"

                  "X": "48"

                  "Y": "15"

                

                "Name": "vehicle"

                "Score": "80"

              

              "Time": "27.757999"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

          

          "Duration": "33171"

          "PetRecognition": 

            

              "PetInfo": 

                "Location": 

                  "Height": "92"

                  "Width": "210"

                  "X": "622"

                  "Y": "148"

                

                "Name": "dog"

                "Score": "81"

              

              "Time": "19.309999"

              "Url": "https://test-1234567890.cos.ap-chongqing.myqcloud.com/test-12345678

            

        

      

      "QueueId": "p56347f79bc2d4551a4651e01a54a6fce"

      "StartTime": "2022-11-21T20:32:45+0800"

      "State": "Success"

      "Tag": "VideoTargetRec"
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创建模板
最近更新时间：2023-08-01 15:45:53

创建视频目标检测模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoTargetRec</Tag>

    <Name>TemplateName</Name>

    <VideoTargetRec>

        <Body>true</Body>

        <Pet>false</Pet>

        <Car>true</Car>

    </VideoTargetRec>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键
字）

父节
点

描述 类型
是否必
选

Tag
Requ

est
模板类型：VideoTargetRec String 是

Name
Requ

est

模板名称，仅支持中文、英文、数字、_、-和

*，长度不超过 64
String 是

VideoTargetR
ec

Requ
est

视频目标检测 参数
Conta
iner

是

VideoTargetRec

节点名称（关键

字）
父节点 描述

类

型

默认

值

是否

必选

Body
Request.VideoTa

rgetRec

是否开启人体检测，取值 

true/false

stri

ng

fals

e
否

Pet
Request.VideoTa

rgetRec

是否开启宠物检测，取值 

true/false

stri

ng

fals

e
否

Car
Request.VideoTa

rgetRec

是否开启车辆检测，取值 

true/false

stri

ng

fals

e
否

说明

 Body、Pet、Car 不能同时为 false。

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoTargetRec</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>VideoTargetRec</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoTargetRec>

            <Body>true</Body>

            <Pet>false</Pet>

            <Car>true</Car>

        </VideoTargetRec>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Template Response 保存模板详情的容器 Container

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templ

ate
模板 ID String

Name
Response.Templ

ate
模板名称 String

BucketId
Response.Templ
ate

模板所属存储桶 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Category Response.Templ

ate

模板属性，Custom 或者 Official String

Tag
Response.Templ

ate
模板类型，VideoTargetRec String

UpdateTime
Response.Templ
ate

更新时间 String

CreateTime
Response.Templ

ate
创建时间 String

VideoTargetRec
Response.Templ

ate

同请求体中的 

Request.VideoTargetRec

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoTargetRec</Tag>

    <Name>TemplateName</Name>

    <VideoTargetRec>

        <Body>true</Body>

        <Pet>false</Pet>

        <Car>true</Car>

    </VideoTargetRec>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

https://cloud.tencent.com/document/product/460/42867
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Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>VideoTargetRec</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoTargetRec>

            <Body>true</Body>

            <Pet>false</Pet>

            <Car>true</Car>

        </VideoTargetRec>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-11 17:56:16

更新视频目标检测模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VideoTargetRec</Tag>

    <Name>TemplateName</Name>

    <VideoTargetRec>

        <Body>true</Body>

        <Pet>false</Pet>

        <Car>true</Car>

    </VideoTargetRec>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

节点名称（关键字） 父节点 描述 类型 必选

Request 无
同创建视频目标检测模板接口的 
Request  

Contain
er

是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>VideoTargetRec</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>VideoTargetRec</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoTargetRec>

            <Body>true</Body>

            <Pet>false</Pet>

            <Car>true</Car>

        </VideoTargetRec>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建视频目标检测模板接口的 Response  
Containe

r

错误码

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84736#Request
https://cloud.tencent.com/document/product/460/84736#Response
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VideoTargetRec</Tag>

    <Name>TemplateName</Name>

    <VideoTargetRec>

        <Body>true</Body>

        <Pet>false</Pet>

        <Car>true</Car>

    </VideoTargetRec>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>VideoTargetRec</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VideoTargetRec>

https://cloud.tencent.com/document/product/460/42867
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            <Body>true</Body>

            <Pet>false</Pet>

            <Car>true</Car>

        </VideoTargetRec>

    </Template>

</Response>
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视频人像分割

提交任务
最近更新时间：2023-08-11 18:10:33

提交一个视频人像抠图任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SegmentVideoBody</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <SegmentVideoBody>

            <Mode>Mask</Mode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

        </SegmentVideoBody>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Requ

est
创建任务的 Tag：SegmentVideoBody String 是

Input
Requ

est
待操作的对象信息

Conta

iner
是

Operation
Requ

est
操作规则

Conta

iner
是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式
String 否

CallBackT

ype

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型
String 否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调
String 否

CallBackM

qConfig

Requ

est

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Conta

iner
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 SegmentVideoBody 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

SegmentVi
deoBody

Request.O
peration

视频人像抠图配置
Cont
ainer

否

Output
Request.O

peration
结果输出配置

Cont

ainer
是

UserData
Request.O

peration

透传用户信息，可打印的 ASCII 码，长度不超

过1024

Strin

g
否

JobLevel
Request.O
peration

任务优先级，级别限制：0 、1 、2。级别越大
任务优先级越高，默认为0

Strin
g

否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Mode
Request.Operation.Se

gmentVideoBody

抠图模式
 Mask：输出alpha通道结果

Foreground：输出前景视频

Combination：输出抠图后的前

景与自定义背景合成后的视频

默认值：Mask

Str

ing
否

SegmentT

ype

Request.Operation.Se

gmentVideoBody

抠图类型

HumanSeg：人像抠图

GreenScreenSeg：绿幕抠图

SolidColorSeg：纯色背景抠图

默认值：HumanSeg

Str

ing
否

Backgroun

dRed

Request.Operation.Se

gmentVideoBody

mode为 Foreground 时参数生

效，背景颜色为红色，取值范围 [0, 

255]， 默认值为 0

Str

ing
否

Backgroun

dGreen

Request.Operation.Se

gmentVideoBody

mode为 Foreground 时参数生

效，背景颜色为绿色，取值范围 [0, 

Str

ing

否
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Container 类型 Output 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

255]，默认值为 0

Backgroun

dBlue

Request.Operation.Se

gmentVideoBody

mode为 Foreground 时参数生

效，背景颜色为蓝色，取值范围 [0, 

255]，默认值为 0

Str

ing
否

Backgroun

dLogoUrl

Request.Operation.Se

gmentVideoBody

传入背景文件。mode为 
Combination 时，此参数必填，背

景文件需与源文件在同存储桶下

Str

ing
否

BinaryThre
shold

Request.Operation.Se
gmentVideoBody

调整抠图的边缘位置，取值范围为[0, 
255]，默认值为 0

Str
ing

否

RemoveRe

d

Request.Operation.Se

gmentVideoBody

纯色背景抠图的背景色（红）, 当 

SegmentType 为 

SolidColorSeg 生效，取值范围为 
[0, 255]，默认值为 0

Str

ing
否

RemoveGr
een

Request.Operation.Se
gmentVideoBody

纯色背景抠图的背景色（绿）, 当 

SegmentType 为 
SolidColorSeg 生效，取值范围为 

[0, 255]，默认值为 0

Str
ing

否

RemoveBl

ue

Request.Operation.Se

gmentVideoBody

纯色背景抠图的背景色（蓝）, 当 
SegmentType 为 

SolidColorSeg 生效，取值范围为 

[0, 255]，默认值为 0

Str

ing
否

节点名称（关键字） 父节点 描述 类型
是否

必选

Region
Request.Operation.O

utput
存储桶的地域 String 是

Bucket
Request.Operation.O
utput

存储结果的存储桶 String 是

Object
Request.Operation.O

utput
输出结果的文件名 String 是

响应

响应头

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SegmentVideoBody</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型
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Container 节点  的内容：

JobsDetail Response 任务的详细信息 Container 

数组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
创建任务的 ID

Strin

g

Tag
Response.J

obsDetail
创建任务的 Tag：SegmentVideoBody

Strin

g

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Strin

g

CreationTi

me

Response.J

obsDetail
任务的创建时间

Strin

g

StartTime
Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Strin

g

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Cont

ainer

Operation
Response.J

obsDetail
该任务的规则

Cont

ainer

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关

键字）
父节点 描述 类型

SegmentVi

deoBody

Response.JobsDe

tail.Operation

同请求中的 

Request.Operation.SegmentVideoBody

Cont

ainer

Output
Response.JobsDe
tail.Operation

同请求中的 Request.Operation.Output
Cont
ainer

UserData
Response.JobsDe

tail.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDe

tail.Operation
任务优先级

Strin

g

MediaInfo
Response.JobsDe
tail.Operation

输出文件的媒体信息，任务未完成时不返回，详见 
MediaInfo  

Cont
ainer

MediaResul

t

Response.JobsDe

tail.Operation

输出文件的基本信息，任务未完成时不返回，详见 

MediaResult  

Cont

ainer

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SegmentVideoBody</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <SegmentVideoBody>

            <Mode>Mask</Mode>

        </SegmentVideoBody>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.mp4</Object>

        </Output>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>ac7c990a00bf211ed946af9e0691f2b7a</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T14:44:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <Tag>SegmentVideoBody</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>
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            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

        </Operation>

    </JobsDetail>

</Response>
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回调信息
最近更新时间：2023-08-14 17:01:45

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>
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                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out.mp4</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my SegmentVideoBody job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>SegmentVideoBody</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交视频人像抠图接口中的 

Response.JobsDetail  

Contain

er 数组

节点名称（关键
字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/83973#JobsDetail


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1446 共1950页

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

Key Response.JobsDetail.Input.CosHeader

s

自定义 Header 的

名称

Stri

ng

Value
Response.JobsDetail.Input.CosHeader

s

自定义 Header 的

值

Stri

ng

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-25T16:35:39+0800</CreationTime>

        <EndTime>2022-07-25T16:35:43+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>ac34be3aa0bf411ed9ce39d7cc972e427</JobId>

        <Message>Success</Message>

        <Operation>

            <MediaInfo>

                <Format>

                    <Duration>13</Duration>

                    <NumStream>1</NumStream>

                    <Size>1909389</Size>

                </Format>

                <Stream>

                    <Audio>
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                        <Bitrate>128000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Video>

                        <AvgFps>50.000</AvgFps>

                        <Bitrate>1031968</Bitrate>

                        <CodecLongName>H.265 / HEVC (High Efficiency Video Coding)</CodecL

                        <CodecName>hevc</CodecName>

                        <CodecTag>0x31637668</CodecTag>

                        <CodecTagString>hvc1</CodecTagString>

                        <CodecTimeBase>1/50</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960</Duration>

                        <FieldOrder>Unknown</FieldOrder>

                        <Fps>50/1</Fps>

                        <HasBFrame>4</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>4</Level>

                        <NumFrames>648</NumFrames>

                        <PixFormat>hvc1</PixFormat>

                        <Profile>Main</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>540</Width>

                    </Video>

                </Stream>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1448 共1950页

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>2db78d168edf2f883adce89a1b4ca033</Md5>

                        <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                    <ObjectName>output/out.mp4</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <SegmentVideoBody>

                <Mode>Mask</Mode>

            </SegmentVideoBody>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my SegmentVideoBody job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pbde29b842b1b4e2ea4f0b20d264fcec2</QueueId>

        <StartTime>2022-07-25T16:35:39+0800</StartTime>

        <State>Success</State>

        <Tag>SegmentVideoBody</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-07-25T16:35:39+0800"

        "EndTime": "2022-07-25T16:35:43+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/test.mp4"

            "Region": "ap-chongqing"

        

{

,

[{

,

,

,

{

,

,

},
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        "JobId": "ac34be3aa0bf411ed9ce39d7cc972e427"

        "Message": "Success"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Duration": "13"

                    "NumStream": "1"

                    "Size": "1909389"

                

                "Stream": 

                    "Audio": 

                        "Bitrate": "128000"

                        "Channel": "2"

                        "ChannelLayout": "stereo"

                        "CodecLongName": "AAC (Advanced Audio Coding)"

                        "CodecName": "aac"

                        "CodecTag": "0x6134706d"

                        "CodecTagString": "mp4a"

                        "CodecTimeBase": "1/44100"

                        "Duration": "13.653"

                        "Index": "1"

                        "Language": "und"

                        "SampleFmt": "fltp"

                        "SampleRate": "44100"

                        "StartTime": "0.000000"

                        "Timebase": "1/44100"

                    

                    "Video": 

                        "AvgFps": "50.000"

                        "Bitrate": "1031968"

                        "CodecLongName": "H.265 / HEVC (High Efficiency Video Coding)"

                        "CodecName": "hevc"

                        "CodecTag": "0x31637668"

                        "CodecTagString": "hvc1"

                        "CodecTimeBase": "1/50"

                        "ColorPrimaries": "bt470bg"

                        "ColorRange": "tv"

                        "ColorTransfer": "smpte170m"

                        "Duration": "12.960"

                        "FieldOrder": "Unknown"

                        "Fps": "50/1"

                        "HasBFrame": "4"

                        "Height": "960"

                        "Index": "0"

                        "Language": "und"

,

,

{

{

{

,

,

},

{

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

}],

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,

,
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                        "Level": "4"

                        "NumFrames": "648"

                        "PixFormat": "hvc1"

                        "Profile": "Main"

                        "RefFrames": "1"

                        "Rotation": "0"

                        "StartTime": "0.000000"

                        "Timebase": "1/12800"

                        "Width": "540"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "2db78d168edf2f883adce89a1b4ca033"

                        "ObjectName": "output/out.mp4"

                    

                    "ObjectName": "output/out.mp4"

                    "Region": "ap-chongqing"

                

            

            "SegmentVideoBody": 

                "Mode": "Mask"

            

            "Output": 

                "Region": "ap-chongqing"

                "Bucket": "test-123456789"

                "Object": "output/out.mp4"

            

            "UserData": "This is my SegmentVideoBody job."

            "JobLevel": "0"

        

        "QueueId": "pbde29b842b1b4e2ea4f0b20d264fcec2"

        "StartTime": "2022-07-25T16:35:39+0800"

        "State": "Success"

        "Tag": "SegmentVideoBody"

    

,

,

,

,

,

,

,

,

}]

}

},

{

{

,

[{

,

}],

[ ],

}

},

{

},

{

,

,

},

,

},

,

,

,

}]

}
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文档预览
查询文档预览开通状态
最近更新时间：2023-06-20 17:32:13

DescribeDocProcessBuckets 接口用于查询已经开通文档预览功能的 Bucket。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /docbucket?pageNumber=1&pageSize=2 HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述 类型
是否必

选

regions
地域信息，以“,”分隔字符串，支持 All、ap-shanghai、

ap-beijing

stri

ng
否

bucketNam 存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 stri 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1452 共1950页

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

es ng

bucketNam
e

存储桶名称前缀，前缀搜索
stri
ng

否

pageNumb

er
第几页

stri

ng
否

pageSize 每页个数
stri

ng
否

响应

响应头

响应体

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <DocBucketList>

                <Name>BucketName-APPID</Name>

                <CreateTime>Time</CreateTime>

                <Region>Region</Region>

                <AliasBucketId/>

                <BucketId>BucketName-APPID</BucketId>

        </DocBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

https://cloud.tencent.com/document/product/460/42866
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Container 节点 DocBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

TotalCount Response 文档预览 Bucket 总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

DocBucketList Response 文档预览 Bucket 列表 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.DocBucketList 存储桶 ID String

Name Response.DocBucketList 存储桶名称，同 BucketId String

Region Response.DocBucketList 所在的地域 String

CreateTime Response.DocBucketList 创建时间 String

AliasBucketId Response.DocBucketList 存储桶别名 String

错误码

实际案例

请求

GET /docbucket?regions=ap-chongqing HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:00:43 GMT

Content-Type: application/xml

Content-Length: 843

https://cloud.tencent.com/document/product/460/42867
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Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>3</TotalCount>

        <RequestId>NWYxZTdiOWJfYzc2OTQzNjRfM2Qz****</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>10</PageSize>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-27T10:54:42+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

        <DocBucketList>

                <Name>examplebucket-1250000000</Name>

                <CreateTime>2020-07-24T22:42:26+0800</CreateTime>

                <Region>ap-chongqing</Region>

                <AliasBucketId/>

                <BucketId>examplebucket-1250000000</BucketId>

        </DocBucketList>

</Response>
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文档转码
文档转码同步请求
最近更新时间：2023-07-12 11:42:54

文档预览功能支持对多种文件类型生成图片格式预览，并可对转换后的图片同步进行基础处理操作，可以解决文档内

容的页面展示问题，满足 PC、App 等多个用户端的文档在线浏览需求，适用于在线教育、企业 OA、网站转码等

业务场景。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

使用时您需要在 数据万象控制台  相应的存储桶管理页面下，单击文档处理，找到文档预览配置项，并

通过开启按钮开通服务。开通服务后，对于当前存储桶中的文档资源，使用相应的文档预览 API 接口即

可实现同步或异步文档预览请求。

文档预览为付费功能，具体费用请参见 文档处理费用 。数据万象在每个账户在首次产生文档预览转图片

用量后，将发放一个用量为6000页，有效期为2个月的文档预览转图片免费额度资源包，超出用量或资

源包到期后将正常计费。

文档转码的转换逻辑与本地的打印逻辑相同，如果您需要改变转换方向（例如将列数较多的 excel 文件

横向输出到一页），需要更改源文件打印设置。

请求

请求示例

GET /<ObjectKey>?ci-process=doc-preview&page=<page>&srcType=<srcType>&Image

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

私有存储桶需要携带下载文件的签名。

请求头

https://cloud.tencent.com/document/product/460/42865
https://console.cloud.tencent.com/ci
https://cloud.tencent.com/document/product/460/58121
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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通用请求参数

名称 描述 类型
是否必

选

Objec

tKey
对象文件名，例如 folder/document.pdf String 是

ci-

proce

ss

数据万象处理能力，文档预览固定为 doc-preview String 是

srcTy

pe

源数据的后缀类型，当前文档转换根据 COS 对象的后缀名来确定源数

据类型。当 COS 对象没有后缀名时，可以设置该值
String 否

page
需转换的文档页码，默认从1开始计数；表格文件中 page 表示转换的

第 X 个 sheet 的第 X 张图
Int 否

dstTy

pe

转换输出目标文件类型：

如果传入的格式未能识别，默认使用 jpg 格式

png，转成 png 格式的图片文件

jpg，转成 jpg 格式的图片文件

pdf，转成 pdf 格式文件。 无法选择页码，page 参数不生效

String 否

pass

word
Office 文档的打开密码，如果需要转换有密码的文档，请设置该字段 String 否

com

ment

是否隐藏批注和应用修订，默认为0

0：隐藏批注，应用修订

1：显示批注和修订

Int 否

适用于表格文件（Excel）的参数

名称 描述
类

型

是
否

必

选

sheet 表格文件参数，转换第 X 个表，默认为1 Int 否

excelPaper

Direction

表格文件转换纸张方向，0代表垂直方向，非0代表水平方向，默认为

0
Int 否

excelPaperS

ize
设置纸张（画布）大小，对应信息为： 0 → A4  、 1 → A2  、 

2 → A0  ，默认 A4 纸张 （需配合  excelRow   或  excelCol   一

起使用）

Int 否
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

适用于转码成  png/jpg 图片的参数

名称 描述 类型
是否

必选

ImageP

arams

转换后的图片处理参数，支持 基础图片处理  所有处理参数，多个处理参

数可通过 管道操作符  分隔，从而实现在一次访问中按顺序对图片进行不

同处理

Stri

ng
否

quality
生成预览图的图片质量，取值范围为 [1, 100]，默认值100。 例如取值为

100，代表生成图片质量为100%
Int 否

scale
预览图片的缩放参数，取值范围为 [10, 200]， 默认值100。 例如取值为
200，代表图片缩放比例为200% 即放大两倍

Int 否

imageD

pi

按指定 dpi 渲染图片，该参数与  scale   共同作用，取值范围  

96-600  ，默认值为  96  。转码后的图片单边宽度需小于65500像素
Int 否

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 

表格文件，一张表可能分割为多页转换，生成多张图片。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 

rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200MB 之内。

输入文件页数限制在5000页之内。

同步接口适用于百页内的PDF文件或预览少数页的情况，若文件较大建议使用异步接口。

请求体

响应

响应头

响应参数说明

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/15293
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该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

案例一：普通文档预览

参数名称 描述 类型

X-Total-

Page

在 http header 中返回文档总页数（表格文件表示当前 sheet 转换后的总图片

数），异常时为空
Int

Content-

Type

根据图片实际的格式，返回不同的值，例如 image/jpeg、image/webp，异

常时保持现有值即可

Strin

g

X-ErrNo 当异常时返回错误码，可在 http header 中查看
Strin

g

X-Total-

Sheet
表格文件返回参数，在 http header 中返回文档中总表数 Int

X-Sheet-

Name
表格文件返回参数，在 http header 中返回当前 sheet 名

Strin

g

错误码

实际案例

请求

GET /sample.pdf?ci-process=doc-preview&page=1 HTTP/1.1

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图片 data]

响应2：文件不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

https://cloud.tencent.com/document/product/460/8523
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案例二：文档预览并进行缩放和添加文字水印的图片处理

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

响应3：指定页码不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3013

请求

GET /sample.pdf?ci-process=doc-preview&page=1&ImageParams=imageMogr2/thumbna

Host: examplebucket-1250000000.cos.ap-shanghai.myqcloud.com

响应1：成功预览

HTTP/1.1 200 OK

Content-Type: image/jpeg

Content-Length: 645

Date: Tue, 03 Apr 2018 09:06:16 GMT

X-Total-Page: 100

[转码后图片 data]

响应2：文件不存在

HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3004

响应3：指定页码不存在
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HTTP/1.1 404 OK

Connection: close

Content-Length: 455

Content-Type: application/xml

Date: Thu, 09 Apr 2020 13:44:52 GMT

X-ErrNo: -3015
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异步处理任务接口

提交文档转码任务
最近更新时间：2023-07-12 16:55:02

CreateDocProcessJobs 接口用于提交一个文档转码任务。

功能描述

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。 

 表格文件，一张表可能分割为多页转换，生成多张图片。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 

rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200M 之内。

输入文件页数限制在5000页之内。

任务记录保留一个月，请及时保存任务记录。建议配置回调进行任务结果查询。

请求

请求示例

POST /doc_jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求头

请求体

<Request>

  <Tag></Tag>

  <Input>

    <Object></Object>

  </Input>

  <Operation>

    <Output>

      <Region></Region>

      <Bucket></Bucket>

      <Object></Object>

    </Output>

    <DocProcess>

       <StartPage></StartPage>

       <EndPage></EndPage>

       <TgtType></TgtType>

    </DocProcess>

  </Operation>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）
父节点 描述 类型

是否必

选

Tag
Reques

t
创建任务的 Tag，目前仅支持：DocProcess String 是

Input
Reques

t
待操作的文件对象

Containe

r
是

Operatio Reques 操作规则 Containe 是

https://cloud.tencent.com/document/product/460/42865
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Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

Container 类型 DocProcess 的具体数据描述如下：

n t r

QueueId
Reques

t

任务所在的队列 ID，开通预览服务后自动生

成，请使用 查询队列  获取或前往 万象控制台  

在存储桶中查询 

String 否

节点名称（关键
字）

父节点 描述 类型
是否必
选

Object
Request.I

nput

文件在 COS 上的文件路径，Bucket 由 

Host 指定

Stri

ng
是

节点名称（关键
字）

父节点 描述 类型
是否
必选

DocProcess
Request.Op

eration

当 Tag 为 DocProcess 时有效，指定

该任务的参数

Conta

iner
否

Output
Request.Op

eration
结果输出地址

Conta

iner
是

通用请求参数

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

SrcType
Request.Operation.D

ocProcess

源数据的后缀类型，当前文档转换根据 

cos 对象的后缀名来确定源数据类型，

当 cos 对象没有后缀名时，可以设置该

值

String 否

TgtType Request.Operation.D

ocProcess

转换输出目标文件类型：

jpg，转成 jpg 格式的图片文件；如

果传入的格式未能识别，默认使用 

jpg 格式

png，转成 png 格式的图片文件

String 否

https://cloud.tencent.com/document/product/460/46946
https://console.cloud.tencent.com/ci
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pdf，转成 pdf 格式文件（暂不支持

指定页数）

StartPag

e

Request.Operation.D

ocProcess

从第 X 页开始转换；在表格文件中，一

张表可能分割为多页转换，生成多张图

片。StartPage 表示从指定 SheetId 

的第 X 页开始转换。默认为1

Int 否

EndPag

e

Request.Operation.D

ocProcess

转换至第 X 页；在表格文件中，一张表

可能分割为多页转换，生成多张图片。

EndPage 表示转换至指定 SheetId 

的第 X 页。默认为-1，即转换全部页

Int 否

适用于表格文件（Excel）的参数

节点名称

（关键字）
父节点 描述

类

型

是

否

必

选

SheetId
Request.Operation.

DocProcess

表格文件参数，转换第 X 个表，默认为0；设

置 SheetId 为0，即转换文档中全部表

I

n

t

否

PaperDir

ection

Request.Operation.

DocProcess

表格文件转换纸张方向，0代表垂直方向，非

0代表水平方向，默认为0

I

n

t

否

PaperSiz

e

Request.Operation.

DocProcess

设置纸张（画布）大小，对应信息为： 

0 → A4  、 1 → A2  、 2 → A0  ，默认 

A4 纸张

I

n

t

否

适用于转码成  png/jpg 图片的参数

节点名称

（关键字）
父节点 描述 类型

是

否

必

选

ImagePa

rams

Request.Op

eration.Doc
Process

转换后的图片处理参数，支持 基础图片处理  所有处

理参数，多个处理参数可通过 管道操作符  分隔，从
而实现在一次访问中按顺序对图片进行不同处理

Stri

ng
否

Quality

Request.Op

eration.Doc

Proces

生成预览图的图片质量，取值范围 [1-100]，默认值

100。 例：值为100，代表生成图片质量为100%
Int 否

https://cloud.tencent.com/document/product/460/6924
https://cloud.tencent.com/document/product/460/15293
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Container 类型 Output 的具体数据描述如下：

Zoom

Request.Op

eration.Doc

Proces

预览图片的缩放参数，取值范围[10-200]， 默认值

100。 例：值为200，代表图片缩放比例为200% 即

放大两倍

Int 否

ImageDp

i

Request.Op

eration.Doc

Process

按指定 dpi 渲染图片，该参数与  Zoom   共同作

用，取值范围  96-600  ，默认值为  96  。转码后

的图片单边宽度需小于65500像素

Int 否

PicPagin

ation

Request.Op

eration.Doc

Process

是否转换成单张长图，设置为 1  时，最多仅支持将 

20 标准页面合成单张长图，超过可能会报错，分页范

围可以通过 StartPage、EndPage 控制。默认值

为 0  ，按页导出图片， TgtType="png"/"jpg"  时

生效

Int 否

节点

名称

（关

键
字）

父节点 描述 类型
是否

必选

Regi

on

Request.Operatio

n.Output
存储桶的地域

Strin

g
是

Buck

et

Request.Operatio

n.Output
存储结果的存储桶

Strin

g
是

Obje
ct

Request.Operatio
n.Output

输出文件路径。
非表格文件输出文件名需包含 ${Number} 或 

${Page} 参数。多个输出文件，${Number} 

表示序号从1开始，${Page} 表示序号与预览

页码一致。

表格文件输出路径需包含 ${SheetID} 占位

符，输出文件名必须包含 ${Number} 参数。

${Number} 表示多个输出文件，序号从1

开始，例如输入 abc_${Number}.jpg，

预览某文件5 - 6页，则输出文件名为 

abc_1.jpg，abc_2.jpg

${Page} 表示多个输出文件，序号与预览

页码一致，例如输入 

abc_${Page}.jpg，预览某文件5-6页，

则输出文件名为 abc_5.jpg，abc_6.jpg

例如 

/${SheetID}/abc_${Number}.jpg ，

Strin
g

是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

先根据 excel 转换的表格数，生成对应数

量的文件夹，再在对应的文件夹下，生成对

应数量的图片文件

响应

响应头

响应体

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                    <Object></Object>

                </Input>

                <JobId></JobId>

                <Message/>

                <Operation>

                    <DocProcess>

                        <SrcType></SrcType>

                        <TgtType></TgtType>

                        <StartPage></StartPage>

                        <EndPage></EndPage>

                        <ImageParams></ImageParams>

                    </DocProcess>

                    <Output>

                        <Bucket></Bucket>

                        <Object></Object>

                        <Region></Region>

                    </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

Container 节点 Input 的内容： 

同上面请求中的 Request.Input 节点。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container

节点名称（关

键字）
父节点 描述 类型

Code
Response.Jobs

Detail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.Jobs

Detail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.Jobs

Detail
新创建任务的 ID String

Tag
Response.Jobs

Detail
新创建任务的 Tag：DocProcess String

State
Response.Jobs

Detail

任务的状态，为 Submitted、Running、

Success、Failed、Pause、Cancel 其中一

个

String

CreationTi

me

Response.Jobs

Detail
任务的创建时间 String

QueueId
Response.Jobs

Detail
任务所属的队列 ID String

Input
Response.Jobs

Detail
该任务的输入文件路径

Contain

er

Operation
Response.Jobs

Detail
该任务的规则

Contain

er



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1468 共1950页

Container 节点 Operation 的内容：

Container 节点 DocProcess 的内容： 

同上面请求中的 Request.Operation.DocProcess 节点。

Container 节点 Output 的内容： 

同上面请求中的 Request.Operation.Output 节点。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

DocProcess
Response.JobsDetail.Oper

ation
文档预览任务参数 Container

Output
Response.JobsDetail.Oper

ation
文件的输出地址 Container

错误码

实际案例

请求

POST /doc_jobs HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 546

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>

<Request>

    <Input>

        <Object>1.doc</Object>

    </Input>

    <Operation>

      <Output>

          <Region>ap-chongqing</Region>

          <Object>big/test-${Number}</Object>

          <Bucket>examplebucket-1250000000</Bucket>

      </Output>

https://cloud.tencent.com/document/product/460/42867
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      <DocProcess>

          <TgtType>png</TgtType>

          <StartPage>1</StartPage>

          <EndPage>-1</EndPage>

          <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1MTcwNDcwOC5

      </DocProcess>

    </Operation>

    <Tag>DocProcess</Tag>

</Request>[!http]

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:20:08 GMT

Content-Type: application/xml

Content-Length: 863

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgwMjhfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-27T15:20:08+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d99b3127ecfd911eab5e60dedb7c395dd</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>5001</EndPage>

                                <ImageParams>watermark/1/image/aHR0cDovL3Rlc3QwMDUtMTI1M

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>
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                </Operation>

                <QueueId>p532fdead78444e649e1a4467c1cd19d3</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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查询指定的文档转码任务
最近更新时间：2023-07-12 00:33:51

DescribeDocProcessJob 用于查询指定的文档转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

功能描述

请求

注意

文档预览任务记录保留一个月，请及时保存任务记录。建议配置回调进行任务结果查询。

请求示例

GET /doc_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: GMT Date

Authorization: Auth String

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求参数

参数名称 描述 类型 是否必选

jobId 要查询的任务ID，可通过提交文档预览任务的响应中获取。 String 是

响应

响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应体

<Response>

        <JobsDetail>

                <Code></Code>

                <CreationTime></CreationTime>

                <EndTime></EndTime>

                <Input>

                        <Object></Object>

                </Input>

                <JobId></JobId>

                <Message> </Message>

                <Operation>

                        <DocProcess>

                                <EndPage></EndPage>

                                <ImageParams></ImageParams>

                                <SrcType></SrcType>

                                <StartPage></StartPage>

                                <TgtType></TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount></FailPageCount>

                                <PageInfo>

                                        <PageNo></PageNo>

                                        <TgtUri></TgtUri>

                                </PageInfo>

                                <SuccPageCount></SuccPageCount>

                                <TaskId></TaskId>

                                <TgtType></TgtType/>

                                <TotalPageCount></TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket></Bucket>

                                <Object></Object>

                                <Region></Region>

                        </Output>

                </Operation>

                <QueueId></QueueId>

                <State></State>

                <Tag></Tag>

        </JobsDetail>

</Response>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Operation 的内容：

Container 节点 DocProcessResult 节点的内容

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Resp

onse

任务的详细信息，同 CreateDocProcessJobs  接口的 

Response.JobsDetail 节点

Cont

ainer

NonExistJob

Ids

Resp

onse
查询的 ID 中不存在的任务，所有任务都存在时不返回

Strin

g

节点名称（关键

字）
父节点 描述 类型

DocProcess

Response.Jobs

Detail.Operatio

n

文档预览任务参数，同 

CreateDocProcessJobs  接口的 

Request.Operation.DocProcess 节点

Contai

ner

DocProcess

Result

Response.Jobs

Detail.Operatio
n

在 job 的类型为 DocProcess 且 job 状态为 

success 时，返回文档预览任务结果详情

Contai

ner

Output

Response.Jobs

Detail.Operatio

n

结果输出地址，同 CreateDocProcessJobs  

接口的 Request.Operation.Output 节点

Contai

ner

节点名称（关
键字）

父节点 描述 类型

PageInfo
Response.JobsDetail.Operati

on.DocProcessResult
预览任务产物详情

Contai

ner

TgtType
Response.JobsDetail.Operati

on.DocProcessResult
预览产物目标格式 String

TotalPage
Count

Response.JobsDetail.Operati
on.DocProcessResult

预览任务产物的总数 Int

https://cloud.tencent.com/document/product/460/46942#.E5.93.8D.E5.BA.94
https://cloud.tencent.com/document/product/460/46942#.E8.AF.B7.E6.B1.82
https://cloud.tencent.com/document/product/460/46942#.E8.AF.B7.E6.B1.82
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Container 节点 PageInfo 节点的内容

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

SuccPage

Count

Response.JobsDetail.Operati

on.DocProcessResult
预览任务产物的成功数 Int

FailPageC

ount

Response.JobsDetail.Operati

on.DocProcessResult
预览任务产物的失败数 Int

TotalSheet
Count

Response.JobsDetail.Operati
on.DocProcessResult

预览任务的 Sheet 总数（源文件
为 Excel 特有参数）

Int

节点名称

（关键字）
父节点 描述 类型

PageNo
Response.JobsDetail.Operati
on.DocProcessResult.PageIn

fo

预览产物页码,源文件为 Excel 格式
时表示 SheetId

Conta
iner

TgtUri

Response.JobsDetail.Operati

on.DocProcessResult.PageIn

fo

预览产物生成的 cos 桶路径 Int

X-

SheetPic
s

Response.JobsDetail.Operati

on.DocProcessResult.PageIn
fo

当前 Sheet 生成的图片总数（源文

件为 Excel 特有参数）
Int

PicIndex

Response.JobsDetail.Operati

on.DocProcessResult.PageIn

fo

当前预览产物在整个源文件中的序号

（源文件为 Excel 特有参数）
Int

PicNum

Response.JobsDetail.Operati

on.DocProcessResult.PageIn

fo

当前预览产物在 Sheet 中的序号

（源文件为 Excel 特有参数）
Int

错误码

实际案例

请求

GET /doc_jobs/d13cfd584cd9011ea820b597ad1785a2f HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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1.非 Excel 文档请求响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-24T17:28:47+0800</CreationTime>

                <EndTime>2020-07-24T17:28:49+0800</EndTime>

                <Input>

                        <Object>1.doc</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>0</EndPage>

                                <ImageParams/>

                                <SrcType/>

                                <StartPage>2</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>2</PageNo>

                                        <TgtUri>big/test-1</TgtUri>

                                </PageInfo>

                                <SuccPageCount>1</SuccPageCount>

                                <TaskId/>

                                <TgtType/>

                                <TotalPageCount>2</TotalPageCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>examplebucket-1250000000</Bucket>

                                <Object>big/test-${Number}</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p50882922b848464fadd222d771438328</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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2. Excel 格式响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-12-03T19:54:10+0800</CreationTime>

                <EndTime>2020-12-03T19:54:13+0800</EndTime>

                <Input>

                        <Object>1.xlsx</Object>

                </Input>

                <JobId>d13cfd584cd9011ea820b597ad1785a2f</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <Comments>0</Comments>

                                <DocPassword/>

                                <EndPage>2</EndPage>

                                <ImageParams/>

                                <PaperDirection>0</PaperDirection>

                                <PaperSize>0</PaperSize>

                                <Quality>100</Quality>

                                <SheetId>0</SheetId>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType/>

                                <Zoom>100</Zoom>

                        </DocProcess>

                        <DocProcessResult>

                                <FailPageCount>0</FailPageCount>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>1</PicIndex>

                                        <PicNum>1</PicNum>

                                        <TgtUri>mark2/1/test-1.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <PageInfo>

                                        <PageNo>1</PageNo>

                                        <PicIndex>2</PicIndex>

                                        <PicNum>2</PicNum>

                                        <TgtUri>mark2/1/test-2.jpg</TgtUri>

                                        <X-SheetPics>2</X-SheetPics>

                                </PageInfo>

                                <SuccPageCount>6</SuccPageCount>

                                <TaskId/>
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                                <TgtType/>

                                <TotalPageCount>6</TotalPageCount>

                                <TotalSheetCount>3</TotalSheetCount>

                        </DocProcessResult>

                        <Output>

                                <Bucket>markjrzhang-1251704708</Bucket>

                                <Object>mark/${SheetID}/pic-${Page}.jpg</Object>

                                <Region>ap-chongqing</Region>

                        </Output>

                </Operation>

                <QueueId>p5fdbba9a9b83479f84538d5beb*****</QueueId>

                <State>Success</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

</Response>
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拉取符合条件的文档转码任务
最近更新时间：2023-07-13 14:45:31

DescribeDocProcessJobs 用于拉取符合条件（状态、创建时间等）的文档转码任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

参数的具体内容如下：

功能描述

请求

请求示例

GET /doc_jobs?queueId=<queueId>&tag=DocProcess HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

节点名称（关键

字）

父

节

点

描述 类型

是

否

必

选

tag 无 任务的 Tag：DocProcess String 是

queueId 无 拉取该队列 ID 下的任务，可在任务响应内容或 控制台 中 String 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/46487
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

获取

orderByTim

e
无 Desc 或者 Asc。默认为 Desc String 否

nextToken 无 请求的上下文，用于翻页。上次返回的值 String 否

size 无 拉取的最大任务数。默认为10。最大为100
Integ
er

否

states 无
拉取该状态的任务，以 , 分割，支持多状态：All、

Submitted、Running、Success、Failed、

Pause、Cancel。默认为 All

String 否

startCreatio

nTime
无

拉取创建时间大于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z
String 否

endCreation

Time
无

拉取创建时间小于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z
String 否

响应

响应头

响应体

<Response>

  <JobsDetail></JobsDetail>

  <NextToken></NextToken>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

JobsDetail Respo

nse

任务的详细信息，同 CreateDocProcessJobs  接口中

的 Response.JobsDetail 节点

Contai

ner

NextToken
Respo
nse

翻页的上下文 Token String

错误码

实际案例

请求

GET /doc_jobs/queueId=QueueId&tag=DocProcess HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: examplebucket-1250000000.ci.ap-beijing.myqcloud.com

响应

<Response>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>1.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/46942#.E5.93.8D.E5.BA.94
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                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <JobsDetail>

                <Code>Success</Code>

                <CreationTime>2020-07-20T10:43:17+0800</CreationTime>

                <EndTime>-</EndTime>

                <Input>

                        <Object>test.docx</Object>

                </Input>

                <JobId>JobId</JobId>

                <Message/>

                <Operation>

                        <DocProcess>

                                <EndPage>1</EndPage>

                                <ImageParams>ImageParams</ImageParams>

                                <SrcType/>

                                <StartPage>1</StartPage>

                                <TgtType>png</TgtType>

                        </DocProcess>

                        <Output>

                                <Bucket>BucketId</Bucket>

                                <Object>file/test-${Page}.jpg</Object>

                                <Region>Region</Region>

                        </Output>

                </Operation>

                <QueueId>QueueId</QueueId>

                <State>Submitted</State>

                <Tag>DocProcess</Tag>

        </JobsDetail>

        <NextToken>19193</NextToken>

</Response>
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异步处理队列接口

查询文档转码队列
最近更新时间：2023-06-20 17:32:14

DescribeDocProcessQueues 接口用于查询文档转码队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述 类型

是

否

必

选

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据。

响应体1：当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示如下。

queueId

s

队列 ID，以“,”符号分割字符串 string 否

state

1. Active 表示队列内的作业会被文档预览服务调度执行

2. Paused  表示队列暂停，作业不再会被文档预览服务调度执行，队

列内的所有作业状态维持在暂停状态，已经处于执行中的任务将继续

执行，不受影响

string 否

pageNu

mber
第几页，默认第一页 string 否

pageSiz

e
每页个数，默认10个 string 否

响应

响应头

响应体

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>RequestId</RequestId>

        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>QueueId</QueueId>

                <Name>QueueName</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>url</Url>

                        <Event>Event</Event>

                        <Type/></Type>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>CreateTime</CreateTime>

                <UpdateTime>UpdateTime</UpdateTime>

                <BucketId>BucketId</BucketId>

                <Category>DocProcess</Category>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

        </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 队列总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

QueueList Response 队列数组 Container

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLis

t
队列 ID String

Name
Response.QueueLis

t
队列名字 String

State
Response.QueueLis
t

当前状态，Active 或者 
Paused

String

NotifyConfig
Response.QueueLis

t
回调配置

Contain

er

MaxSize
Response.QueueLis

t
队列最大长度 Int

MaxConcurrent
Response.QueueLis
t

当前队列最大并行执行的任务数 Int

UpdateTime
Response.QueueLis

t
更新时间 String
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Container 节点 NotifyConfig 的内容：

响应体2：当指定 queueIds 时包含完整节点数据的内容展示如下。

具体的数据内容如下：

Container 节点 Response 的内容：

CreateTime Response.QueueLis

t

创建时间 String

节点名称（关键字） 父节点 描述 类型

Url
Response.QueueList.NotifyC

onfig
回调地址

Strin

g

State
Response.QueueList.NotifyC

onfig
开关状态，On 或者 Off

Strin

g

Type
Response.QueueList.NotifyC

onfig
回调类型，Url

Strin

g

Event
Response.QueueList.NotifyC

onfig
触发回调的事件

Strin

g

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <QueueList>

        <QueueId>A</QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url></Url>

        </NotifyConfig>

    </QueueList>

    <NonExistPIDs>

        <QueueID>B</QueueID>

        <QueueID>C</QueueID>

    </NonExistPIDs>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1486 共1950页

Container 节点 NonExistPIDs 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

QueueList Response 队列数组，同上面解释的 QueueList Container

NonExistPIDs Response 不存在的队列 ID 列表 Container

节点名称（关键字） 父节点 描述 类型

QueueID Response.NonExistPIDs 队列 ID String

错误码

实际案例

请求

GET /docqueue?pageNumber=1&pageSize=2 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Authorization: Authorization

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 07:29:28 GMT

Content-Type: application/xml

Content-Length: 677

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZTgyNTdfYzc2OTQzNjRfMzUx****

<?xml version="1.0" encoding="utf-8"?>

<Response>

        <TotalCount>1</TotalCount>

        <RequestId>NWYxZTgyNTdfYzc2OTQzNjRfMzUx****</RequestId>

https://cloud.tencent.com/document/product/460/42867
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        <PageNumber>1</PageNumber>

        <PageSize>2</PageSize>

        <QueueList>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>queue-doc-process-1</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url/>

                        <Event/>

                        <Type/>

                        <State>Off</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-24T22:42:27+0800</UpdateTime>

                <BucketId>examplebucket-1250000000.</BucketId>

                <Category>DocProcessing</Category>

        </QueueList>

</Response>
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更新文档转码队列
最近更新时间：2023-06-20 17:32:14

UpdateDocProcessQueue 接口用于更新文档转码队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /docqueue/p8eb46b8cc1a94bc09512d16c5c4f4d3a HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>Queue Name</Name>

    <QueueID></QueueID>

    <State></State>

    <NotifyConfig>

        <Type></Type>

        <Url></Url>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 NotifyConfig 的具体数据描述如下：

        <Event></Event>

    </NotifyConfig>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键
字）

父节点 描述 类型

是

否

必
选

限制

Name
Requ

est

队列名

称
String 是 长度限制100字符

QueueI

D

Requ

est
队列 ID String 是 无

State
Requ

est

队列状

态
String 是

1.  Active 表示队列内的作业会被文档预览
服务调度转码执行

2. Paused 表示队列暂停，作业不再会被文

档预览服务调度执行，队列内的所有作业

状态维持在已提交状态，已经处于执行中

的任务将继续执行，不受影响     

NotifyC

onfig

Requ

est

通知渠

道

Conta

iner
是 第三方回调 Url

节点名称（关键

字）
父节点 描述

类

型

是否

必选
限制

Url
Request.Notif

yConfig
回调配置

Str

ing
否

长度限制100

字符

Type
Request.Notif

yConfig

回调类型，普通回调：

Url

Str

ing
否

长度限制100

字符
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

Event Request.Notif

yConfig

回调事件，文档预览任

务完成

Str

ing

否 长度限制100

字符

State
Request.Notif

yConfig
回调开关，Off，On

Str

ing
否

长度限制100

字符

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Queue>

        <QueueId></QueueId>

        <Name></Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>mts-topic-1</Url>

            <Type></Type>

            <Event></Event>

        </NotifyConfig>

        <CreateTime></CreateTime>

        <UpdateTime></UpdateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

RequestId Resp 请求的唯一 ID Strin

https://cloud.tencent.com/document/product/460/42866
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

onse g

Queue
Resp

onse

队列信息，详情请参见 DescribeDocProcessQueues  中

的 Response.QueueList

Cont

ainer

错误码

实际案例

请求

PUT /docqueue/p2505d57bdf4c4329804b58a6a5fb1572 HTTP/1.1

Connection: keep-alive

Accept-Encoding: gzip, deflate

Accept: */*

User-Agent: cos-python-sdk-v5.3.2

Host: examplebucket-1250000000.ci.ap-chongqing.myqcloud.com

Content-Type: application/xml

Content-Length: 279

Authorization: Authorization

<?xml version="1.0" encoding="UTF-8" ?>

<Request>

    <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

    <State>Active</State>

    <Name>markjrzhang4</Name>

    <NotifyConfig>

        <Url>http://google.com/</Url>

    <State>On</State>

        <Type>Url</Type>

        <Event>TransCodingFinish</Event>

    </NotifyConfig>

</Request>[!http]

响应

HTTP/1.1 200 OK

Date: Mon, 27 Jul 2020 08:22:41 GMT

Content-Type: application/xml

Content-Length: 641

Connection: keep-alive

Server: tencent-ci

x-ci-request-id: NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/46946
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<?xml version="1.0" encoding="utf-8"?>

<Response>

        <RequestId>NWYxZThlZDBfYzc2OTQzNjRfMzUxYV8x****</RequestId>

        <Queue>

                <QueueId>p2505d57bdf4c4329804b58a6a5fb1572</QueueId>

                <Name>markjrzhang4</Name>

                <State>Active</State>

                <NotifyConfig>

                        <Url>http://example.com/</Url>

                        <Event>TransCodingFinish</Event>

                        <Type>Url</Type>

                        <State>On</State>

                </NotifyConfig>

                <MaxSize>10000</MaxSize>

                <MaxConcurrent>10</MaxConcurrent>

                <CreateTime>2020-07-24T22:42:27+0800</CreateTime>

                <UpdateTime>2020-07-27T16:22:40+0800</UpdateTime>

                <BucketId>test007-1251704708</BucketId>

                <Category>DocProcessing</Category>

        </Queue>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1493 共1950页

支持的功能和效果
最近更新时间：2021-07-09 10:45:42

以下是文档转图片功能支持的功能和效果：

类

型
文件名后缀 支持的功能和效果

演
示

ppt、pptx、pptm、

ppsx、ppsm、pps、
potx、potm、dpt、

dps

幻灯片背景、对象边框/填充、对象阴影/倒影、文本（横/竖向文本框、
占位符、形状）、图片、链接、艺术字、形状、表格、图片、图表、公

式、符号、链接、脑图、流程图

文

字

doc、dot、wps、

wpt、docx、dotx、

docm、dotm

字属性、段属性、图片、文字表、链接、形状、代码块、日期、水印、

评论、页眉页脚

表

格

xls、 xlt、et、xlsx、

xltx、xlsm、xltm
字属性、段属性、自选图形、艺术字、公式、图片、流程图、脑图

P

D

F

pdf
背景、文字（字体、字号、字色、加粗、斜体）、画笔、高亮、下划

线、删除线
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文档转html

文档转html同步请求
最近更新时间：2023-08-04 14:34:52

文档转 HTML 功能支持对多种文档类型的文件生成 HTML 格式预览，满足 PC、App 等多个用户端的文档在线浏

览需求，适用于在线教育、企业 OA、在线知识库、网盘文档预览等业务场景。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

说明

数据万象封装预览 JS SDK，只需要一条 URL 即可接入 HTML 预览服务。

您可在 文档预览接入体验工具  中自行调整参数，体验接入文档预览后的预览效果，同时该工具可以根

据相应配置项生成代码，助力您快速接入文档预览。

如需在小程序内使用，请参考 小程序配置业务域名 。

如需接入 CDN 域名，需要打开 CDN 的高级缓存过期设置，详情请参见 节点缓存过期配置  CDN 文

档。

请求

请求示例

GET /<ObjectKey>?ci-process=doc-preview&dstType=html HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求头

请求参数

名称 描述 类型
是否

必选

Object

Key
对象文件名，例如 folder/document.pdf

Strin

g
是

ci-

proces

s

数据万象处理能力，文档 HTML  预览固定为 doc-preview
Strin

g
是

https://cloud.tencent.com/document/product/460/42865
https://ci-exhibition.cloud.tencent.com/tools/doc-preview/#/
https://cloud.tencent.com/document/product/228/41540
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dstTyp

e

转换输出目标文件类型，文档 HTML 预览固定为 html（需为小写字

母）

Strin

g
是

srcTyp
e

指定目标文件类型，支持的文件类型请见下方
Strin
g

否

sign

对象下载签名，如果预览的对象为私有读时，需要传入签名，详情请参见 

请求签名  文档

注意：需要进行 urlencode

Strin

g
否

copyabl

e
是否可复制。默认为可复制，填入值为1；不可复制，填入值为0

Strin

g
否

htmlPar

ams

自定义配置参数，json结构，需要经过 URL 安全  的 Base64 编码，
默认配置为：{ commonOptions: { isShowTopArea: true, 

isShowHeader: true, language: "zh" }}，支持的配置参考 自定义

配置项说明 。

htmlParams支持的特殊配置：语言切换，通过 commonOptions 的 

language 参数指定预览语言，支持"zh"、"en“，默认为"zh"。

Strin

g
否

htmlwa

terword
水印文字，需要经过 URL 安全  的 Base64 编码，默认为空

Strin

g
否

htmlfills

tyle

水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编

码，默认为：rgba(192,192,192,0.6)

Strin

g
否

htmlfro

nt

水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 

20px Serif

Strin

g
否

htmlrot

ate
水印文字旋转角度，0 - 360，默认315度

Strin

g
否

htmlhor

izontal
水印文字水平间距，单位 px，默认为50

Strin

g
否

htmlver

tical
水印文字垂直间距，单位 px，默认为100

Strin

g
否

注意

目前支持的输入文件类型包含如下格式：

演示文件：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。

文字文件：doc、dot、wps、wpt、docx、dotx、docm、dotm。

表格文件：xls、xlt、et、ett、xlsx、xltx、csv、xlsb、xlsm、xltm、ets。

其他格式文件： pdf、 lrc、 c、 cpp、 h、 asm、 s、 java、 asp、 bat、 bas、 prg、 cmd、 

https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/436/59408#.E8.87.AA.E5.AE.9A.E4.B9.89.E9.85.8D.E7.BD.AE.E9.80.89.E9.A1.B9
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
https://cloud.tencent.com/document/product/460/86595#1b54a43c-d985-441d-9c89-81ac6c4adc39
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

此接口请求的响应体为html预览内容，展示效果可参见下方实际案例。

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT 文件进行在线预览，最终 URL 如

下：

直接在浏览器中打开链接，生成的预览页面如下图所示，对于幻灯片文档，还可进行全屏的幻灯片放映，支持动画、

触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

rtf、 txt、 log、 xml、 htm、 html。

输入文件大小限制在200MB之内。

输入文件页数限制在5000页之内。

请求体

响应

响应头

响应体

错误码

实际案例

案例一：简单预览

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=do

说明

您还可通过 JS-SDK 实现更多功能的定制，详情请参见 自定义配置概述 。

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/59410
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将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT 文件进行在线预览。

1. 设置不可复制（copyable=0）

2. 设置test 水印（通过 URL 安全的 Base64编码得到 htmlwaterword=dGVzdAog）

3. 设置自定义配置参数（htmlParams为 {"mode":"normal","commonOptions":

{"isShowHeader":false,"isShowTopArea":true},"pptOptions":{"isSlidesStatusPlay": true}}，

通过 URL 安全的 Base64编码得到 

htmlParams=eyJtb2RlIjoibm9ybWFsIiwiY29tbW9uT3B0aW9ucyI6eyJpc1Nob3dIZWFkZXIiO

mZhbHNlLCJpc1Nob3dUb3BBcmVhIjp0cnVlfSwicHB0T3B0aW9ucyI6eyJpc1NsaWRlc1N0

YXR1c1BsYXkiOiB0cnVlfX0=）。

则最终 URL 如下：

直接在浏览器中打开链接，生成的预览页面如下图所示，对于幻灯片文档，还可进行全屏的幻灯片放映，支持动画、

触发器等效果，并提供虚拟激光笔、演讲者模式等功能。

案例二：水印 + 自定义配置预览

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=do
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预览链接也可以作为iframe嵌入到业务页面中，如下所示：

<!DOCTYPE html>

<html>

<head>

    <meta charset="utf-8">

    <meta name="viewport"

        content="width=device-width, initial-scale=1.0, maximum-scale=1.0, minimum-sca

    <meta http-equiv="Content-Type" content="text/html; charset=UTF-8">
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将存将存储桶 examples-1258125638 中的 ObjectKey 为 test.pptx 的 PPT 文件进行在线预览。

设置 htmlParams 参数（htmlParams为 {"commonOptions":{"language": "en"}}，通过 URL 安全的 

Base64编码得到 htmlParams=eyJjb21tb25PcHRpb25zIjp7Imxhbmd1YWdlIjoiZW4ifX0）

最终 URL 如下：

直接在浏览器中打开链接，生成的预览页面如下图所示：

    <meta http-equiv="X-UA-Compatible" content="IE=edge,chrome=1">

    <meta http-equiv="Content-Security-Policy" content="upgrade-insecure-requests">

    <meta name="keywords" content="对象存储,文档预览">

    <meta name="description" content="">

    <title>腾讯云-对象存储-文档预览</title>

    <style>

        html,

        body {

            padding: 0;

            margin: 0;

            height: 100%;

            touch-action: manipulation;

        }

    </style>

</head>

<body>

    <iframe src="https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.ppt

</body>

</html>

案例三：切换预览语言为英文

https://examples-1258125638.cos.ap-guangzhou.myqcloud.com/test.pptx?ci-process=do
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自定义配置概述
最近更新时间：2023-06-02 11:24:09

通过使用 JS-SDK，网页开发者可以自定义界面显示、页面状态、监听事件等能力，为用户提供更优质的网页体

验。

功能说明

架构图
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使用环境

平台 支持浏览器

iOS Safari、QQ 内置浏览器、QQ 小程序、微信内置浏览器、微信小程序（仅支持 webview 方



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1503 共1950页

请下载最新版本的 JS-SDK 包 。历史版本前往 更新日志 。

在需要调用的页面引入如下 JS-SDK。示例中 ${version} 表示版本号，请根据下载的实际版本号填写。

通过 JS-SDK（v0.1.1及以上版本）获取在线文档预览地址，示例如下：

配置项说明如下：

式接入）

Android QQ 内置浏览器、QQ 小程序、微信内置浏览器、微信小程序（仅支持 webview 方式接入）

Window

s
Chrome、QQ 浏览器（非兼容模式）、EDGE、火狐、IE11

Mac OS 

X
Chrome、Safari、QQ 浏览器、EDGE、火狐

使用说明

1. 下载

2. 引入 JS-SDK

<script src="sdk-${version}.js"></script>

3. 获取在线文档预览地址

方法一：使用 JS-SDK 获取（支持 sdk-v0.1.1及以上版本）

var url = await COSDocPreviewSDK.getPreviewUrl( {

      objectUrl: 'https://examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/test.p

      credentials: {      // 如果预览文件是私有的，则需要携带访问凭证。

          secretId: '',

          secretKey: '',

          authorization: 'q-sign-algorithmxxxxxxxxxxxxxxx',

      },

      copyable: 0,  // 是否可以复制文件内容

      htmlwaterword: ''  // 水印内容

})

console.log(url)

配置项 说明 是

否

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip
https://cloud.tencent.com/document/product/460/75908
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必

选

objectUrl

需要预览的对象地址，例如：

https://examplebucket-1250000000.cos.ap-

shanghai.myqcloud.com/test.pptx

是

credentials

如果预览的对象是私有，则需要传入 credentials 作为访问凭证。可以传入

计算好的 请求签名  authorization，也可以传入用户的 secretId 和 
secretKey（固定密钥放在前端会有安全风险，不推荐此方式）

否

credentials.aut

horization
对象下载签名，详情请参见 请求签名  文档 否

credentials.sec

retId
用户的 secretId，可前往访问管理控制台中的 API 密钥管理  页面获取 否

credentials.sec
retKey

用户的 secretKey，可前往访问管理控制台中的 API 密钥管理  页面获取 否

copyable 是否可复制。默认为可复制，填入值为1；不可复制，填入值为0 否

htmlwaterword 水印文字，需要经过 URL 安全  的 Base64 编码，默认为空 否

htmlfillstyle
水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编码，默

认为：rgba(192,192,192,0.6)
否

htmlfront
水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 

20px Serif
否

htmlrotate 旋转角度，0 - 360，默认315度 否

htmlhorizontal 水印文字水平间距，单位 px，默认为50 否

htmlvertical 水印文字垂直间距，单位 px，默认为100 否

方法二：直接请求获取

请求示例

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=1&sign=AuthS

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

请求参数

参数名称 描述 是否

https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/6968
https://console.cloud.tencent.com/cam/capi
https://console.cloud.tencent.com/cam/capi
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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必选

ci-process 预览固定参数，值为 doc-preview 是

dstType 预览类型，如需预览生成类型为 html 则填入 html 是

weboffice_

url

是否获取预览链接。填入值为1会返回预览链接和Token信息；填入值为2只返

回Token信息；不传会直接预览
否

tokenuid
是否获取token。根据传入的tokenuid、文件信息等生成Token，返回

Token和有效期；如果不传则不会返回Token信息
否

sign

对象下载签名，如果预览的对象为私有读时，需要传入签名，详情请参见 请求

签名  文档

注意：需要进行 urlencode

否

copyable 是否可复制。默认为可复制，填入值为1；不可复制，填入值为0 否

htmlwaterw

ord
水印文字，需要经过 URL 安全  的 Base64 编码，默认为空 否

htmlfillstyle
水印 RGBA（颜色和透明度），需要经过 URL 安全  的 Base64 编码，默认

为：rgba(192,192,192,0.6)
否

htmlfront
水印文字样式，需要经过 URL 安全  的 Base64 编码，默认为：bold 20px 

Serif
否

htmlrotate 旋转角度，0 - 360，默认315度 否

htmlhorizon

tal
水印文字水平间距，单位 px，默认为50 否

htmlvertical 水印文字垂直间距，单位 px，默认为100 否

响应示例

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 478

Date: Thu, 25 Feb 2021 07:44:37 GMT

Status: 200 OK

x-cos-request-id: NjAzNzU1NjVfY2MxZTIzMDlfNzc5NF8yMDQ5****

{

        "PreviewUrl": "https://prvsh.myqcloud.com/office/p/xxxx?_w_provider=XXX"

https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
https://cloud.tencent.com/document/product/460/32832#.E4.BB.80.E4.B9.88.E6.98.AF-url-.E5.AE.89.E5.85.A8.E7.9A.84-base64-.E7.BC.96.E7.A0.81.EF.BC.9F
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通过初始化配置，JS-SDK 会在配置的 mount 节点下创建一个 iframe，并自动初始化相关数据和事件。

挂载节点指 JS-SDK 插入 iframe 时挂载的节点。在初始化时，JS-SDK 挂载节点为可配置项。

JS-SDK 初始化完成后会自动在挂载节点下面插入一个 iframe。

不使用 Token 时，默认使用文档的签名有效期鉴权，过期则无法预览文件。

使用 Token 鉴权可以在预览期间持续进行 Token 鉴权和 Token 续期，由业务侧自主控制预览授权。

}

4. 初始化

var demo = COSDocPreviewSDK.config({

    url: '在线文档预览地址',  // 步骤3中获取到的在线文档预览地址

})

// 如果需要对 iframe 进行特殊的处理，可以通过以下方式拿到 iframe 的 dom 对象

console.log(demo.iframe)

// 打开文档结果

demo.on('fileOpen', function(data) {

    console.log(data.success)

})

5. 挂载节点

<div class="custom-mount"></div>

var demo = COSDocPreviewSDK.config({

    url: '在线文档预览地址',    // 步骤3中获取到的在线文档预览地址

    mount: document.querySelector('.custom-mount')    // 挂载节点，默认会挂载到 body 下，

})

<div class="custom-mount">

    <iframe src="..."></iframe>

</div>

6. Token 鉴权
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Token 鉴权与续期分为以下三个步骤，详情请参见 demo 示例  。

1. 获取 Token 

请求示例

响应示例

GET /<ObjectKey>?ci-process=doc-preview&dstType=html&weboffice_url=2&tokenuid

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: GMT Date

HTTP/1.1 200 OK

Content-Type: text/html

Content-Length: 108

Date: Tue, 21 Jun 2022 10:41:10 GMT

Status: 200 OK

x-cos-request-id: NjJiMWEwNDZfMTgyMjYyNjRfYmRlYl9iNTAw****

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html
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2. 设置 Token

3. 配置 refreshToken 方法，超时自动续期 Token 

refreshToken 方法需要请求您的服务端封装的更新 Token 的方法，服务端可以封装上述的获取 Token 的

方法（参考 获取 Token ）。 

以服务端方法 http://your.server.com/refreshToken 为例，配置 refreshToken 函数如下：

{

 Token: "ChAJj2vNRiHTc8reToMmJ7T2EJ7FxpUGGhS1mPJanpN03u8PSB17/YKBA/Vo****"

 TokenExpireTime: "1655808670"

}

说明

 避免 Token 刷新过于频繁，推荐设置的超时时间（timeout）为 10 分钟以上。为避免 refresh 请

求超时，JS-SDK 会提前几分钟去更新 Token。

var demo = COSDocPreviewSDK.config({

 url: '在线文档预览地址',  // 步骤3中获取到的在线文档预览地址

})

// 设置Token

demo.setToken({

  token: 'yourToken', // 填入获取到的token

  timeout: 10 * 60 * 1000, // token超时时间，单位为毫秒，避免频繁续期，建议设置 10 分钟及

});

// 获取 Token 函数

const refreshToken = () => {

  // 调用服务端封装的方法，获取token信息

  const tokenInfo = await $.get('http://your.server.com/refreshToken')

  // 可以返回 Promise 或者 return { token, timeout }

  return {

 token: tokenInfo.token, // 必需：你需要设置的 Token

 timeout: 10 * 60 * 1000, //  必需：Token 超时时间，单位毫秒

  };

};

var demo = COSDocPreviewSDK.config({

 url: '在线文档预览地址',  

 refreshToken    // Token自动更新方法

})
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// 设置Token

demo.setToken({

  token: 'yourToken', // 填入获取到的token

  timeout: 10 * 60 * 1000   // token超时时间，单位为毫秒

});

实际案例

文字文件在线预览案例，参考 DOC 预览案例  。

演示文件在线预览案例，参考 PPT 预览案例  。

表格文件在线预览案例，参考 Excel 预览案例  。

PDF 文件在线预览案例，参考 PDF 预览案例  。

Token 鉴权与续期案例，参考 Token 鉴权与续期案例  。

https://github.com/tencentyun/cos-demo/blob/main/doc-preview/doc-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/ppt-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/xls-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/pdf-to-html-preview.html
https://github.com/tencentyun/cos-demo/blob/main/doc-preview/token-refresh-preview.html
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配置项说明
最近更新时间：2022-06-24 17:53:30

通过初始化配置选项类，开启不同的显示模式：

配置选项说明如下：

初始化 JS-SDK 时，通过分别配置不同文档对应的配置选项，可以开启或关闭文档中的特定配置以及控制文档打

开时的状态。

显示模式

var demo = COSDocPreviewSDK.config({

    mode: 'normal', 

})

mode 选项值 说明 是否默认选项

normal 普通模式，展示所有功能界面 是

simple 极简模式，不显示头部和工具栏 否

自定义配置选项

COSDocPreviewSDK.config({

    //通用选项，适用于所有类型的文档。

    commonOptions: {

      isShowTopArea: false, //隐藏顶部区域（头部和工具栏）。
      isShowHeader: false //隐藏头部区域。

    },

    //WORD文档相关配置。

    wordOptions: {

      isShowDocMap: false,

      isBestScale: true

    },

    //PDF文档相关配置。

    pdfOptions: {

      isShowComment: true,

      isInSafeMode: false

    },

    //演示文档相关配置。

    pptOptions: {
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      isShowBottomStatusBar: true

    }

})

通用配置项：commonOptions

配置项 说明 默认值

isShowTopArea 是否显示顶部区域（头部和工具栏） false

isShowHeader 是否显示头部区域 false

isBrowserViewFullscreen 是否在浏览器区域全屏 false

isIframeViewFullscreen 是否在 iframe 区域内全屏 false

文字文件配置项：wordOptions

配置项 说明 默认值

isShowDocMap 是否开启目录功能，默认开启 true

isBestScale 打开文档时，默认以最佳比例显示（适用于 PC） true

isShowBottomStatusBar 是否展示底部状态栏（适用于 PC） false

PDF 配置项：pdfOptions

配置项 说明

默

认

值

isShowComment 是否显示注解，默认显示
tru

e

isInSafeMode
是否处于安全模式（安全模式下不能划选文字，不能复制以及不能通过链

接跳转），默认不是安全模式

fal

se

isShowBottomSt

atusBar
是否展示底部状态栏（适用于 PC）

fal

se

演示文件配置项：pptOptions

配置项 说明 默认值

isShowBottomStatusBar 是否展示底部状态栏（适用于 PC） false
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可以通过 commandBars 选项来隐藏或禁用页面的组件。

目前可用的组件列表如下：

组件状态设置

COSDocPreviewSDK.config({

    //通用选项，适用于所有类型的文档。

    commandBars: [

      {

        cmbId: 'Print', // 组件ID

        attributes: {

          visible: false, // 组件是否显示，默认为true。false：隐藏组件；true：显示组件

          enable: false, // 禁用或者开启组件，默认为true

        },

      },

    ]

})

组件ID 说明 适用范围

Print 打印功能，和 ctrl+P 打印快捷键 所有文档

MobileHeader 客户端的顶部工具栏 所有文档

WriterHoverToolbars 客户端的底部工具栏 文字文件

DownloadImg 双击图片下载按钮图标 演示文件

PlayComponentToolbar 全屏播放时右上角工具栏 演示文件

PlayContextCheckImage 播放时右键 - 查看原图 演示文件

FloatMenuCheckImage 选中图片时浮动菜单栏 - 查看原图 演示文件

WPPMobileCommentButton 客户端底部工具栏的评论按钮 演示文件

PDFMobilePageBar 客户端的页码 PDF文件
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高级功能
最近更新时间：2022-06-24 17:53:34

JS-SDK 提供了高级功能可直接对文档进行操作，以下是高级功能的调用流程。

以下对文字文件、表格文件、演示文件、PDF 文件等类型使用高级功能进行列举介绍，如需了解上述类型支持的文

件格式，请参见 规则与限制 。

1. 等待文档加载完成

await demo.ready() // 务必等待 demo ready 之后再调用高级 api，demo 对象是指 JS-SDK 实例

2. 获取文档对象

// 文字

const wordApp = demo.WordApplication()

// 表格

const excelApp = demo.ExcelApplication()

// 演示

const pptApp = demo.PPTApplication()

// PDF

const pdfApp = demo.PDFApplication()

// 自动识别

const app = demo.Application

3. 使用高级功能

文字文件

展开全部

获取总页数

获取当前页

跳转到指定页

设置评论显示

https://cloud.tencent.com/document/product/460/36620
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设置目录显示

视图缩放

表格文件

展开全部

获取所有sheet名称

获取当前sheet名称

切换到指定sheet

视图缩放

演示文件

展开全部

获取总页数

获取当前页

跳转到指定页

播放幻灯片

退出播放

幻灯片下一步动画

幻灯片上一动画

获取播放状态

视图播放
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PDF 文件

展开全部

获取总页数

获取当前页

跳转到指定页

设置页面渲染模式

设置目录显示

视图缩放

事件监听
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支持的字体和动画
最近更新时间：2021-05-17 09:44:59

文档转 HTML 功能支持预览多种字体，并可预览演示文件中的动画效果，具体请参见下方的字体支持表和动画支持

表。

文档预览支持如下所示的字体，部分字体仅支持 Word 文档。不支持的字体会在展示时匹配相近字体，可能会出现

字体效果与本地不符的情况。

简介

说明

 使用文档转 HTML 功能，实际的预览效果可能因文档格式的不同而有所差异。

支持的字体

中文字体（简/繁）

仅支持 Word 文档

字体名称 字体名称 字体名称

幼圆 华文行楷 方正姚体

新宋体 华文仿宋 方正舒体

微软雅黑 华文彩云 等线

微软雅黑 Light 黑体 等线 Light

腾讯体 W3 汉仪智楷繁 PMingLiU-ExtB  （新�明�-ExtB）

腾讯体 W7 汉仪智草繁 MingLiU-ExtB  （�明�-ExtB）

宋体 汉仪赵楷繁 MingLiU_HKSCS-ExtB  （�明�_HKSCS-ExtB）

隶书 汉仪王行繁 Microsoft YaHei UI

楷体 汉仪唐隶繁 Microsoft YaHei UI  Light

华文中宋 汉仪欧行繁 Microsoft JhengHei UI

华文新魏 汉仪陆行繁 Microsoft JhengHei UI  Light

华文细黑 汉仪柳楷繁 Microsoft JhengHei
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华文宋体 汉仪衡方碑繁 Microsoft JhengHei  Light

华文隶书 汉仪褚楷繁 Adobe 宋体 Std

华文楷体 汉仪曹隶繁 -

华文琥珀 仿宋 -

支持全部文档类型

字体名称 字体名称

汉仪中黑 KW 汉仪楷体 KW

汉仪中等线 KW 汉仪君黑 KW 55J

汉仪书宋二 KW 汉仪君黑 KW   85J

汉仪旗黑 KW 85S 汉仪仿宋 KW

汉仪旗黑 KW 55S -

其他语言字体

仅支持 Word 文档

字体名称 字体名称 字体名称

Agency FB Gadugi Palatino Linotype

Algerian Garamond Papyrus

Arial Black Gigi Parchment

Arial Narrow Gill Sans MT Perpetua

Arial Rounded MT 

Bold
Gill Sans MT  Condensed Perpetua Titling MT

Bahnschrift
Gill Sans MT Ext  Condensed 

Bold
Playbill

Baskerville Old Face Gill Sans Ultra Bold Poor Richard

Bauhaus 93
Gill Sans Ultra Bold  

Condensed
Pristina

Bell MT Gloucester MT Extra  Rage Italic
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Condensed

Berlin Sans FB Goudy Old Style Raleway

Berlin Sans FB Demi Goudy Stout Raleway Black

Bernard MT 

Condensed
Haettenschweiler Raleway ExtraBold

Blackadder ITC Harlow Solid Italic Raleway ExtraLight

Bodoni MT Harrington Raleway Light

Bodoni MT Black High Tower Text Raleway Medium

Bodoni MT 

Condensed
HoloLens MDL2 Assets Raleway SemiBold

Bodoni MT Poster  

Compressed
Impact Raleway Thin

Book Antiqua Imprint MT Shadow Ravie

Bookman Old Style Informal Roman Roboto

Bookshelf Symbol 7 Ink Free Roboto Black

Bradley Hand ITC Javanese Text Roboto Light

Britannic Bold Jokerman Roboto Medium

Broadway Juice ITC Roboto Thin

Brush Script MT Kristen ITC Roboto Slab

C059 Kunstler Script Rockwell

Calibri Leelawadee Rockwell Condensed

Calibri Light Leelawadee UI Rockwell Extra Bold

Californian FB Leelawadee UI  Semilight Script MT Bold

Calisto MT Lucida Bright Segoe MDL2 Assets

Cambria Lucida Calligraphy Segoe Print

Cambria Math Lucida Console Segoe Script

Candara Lucida Fax Segoe UI
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Candara Light Lucida Handwriting Segoe UI Black

Castellar Lucida Sans Segoe UI Light

Centaur Lucida Sans  Typewriter Segoe UI Semibold

Century Lucida Sans Unicode Segoe UI Semilight

Century Gothic Magneto Segoe UI Emoji

Century Schoolbook Maiandra GD Segoe UI Historic

Chiller Malgun Gothic (�� ��) Segoe UI Symbol

Colonna MT
Malgun Gothic  Semilight (�� 

�� Semilight)
Showcard Gothic

Consolas Matura MT Script  Capitals SimSun-ExtB

Constantia Merriweather Sitka Banner

Cooper Black Merriweather Black Sitka Display

Copperplate Gothic  

Bold
Merriweather Light Sitka Heading

Copperplate Gothic  

Light
Microsoft Himalaya Sitka Small

Corbel Microsoft New Tai Lue Sitka Subheading

Corbel Light Microsoft PhagsPa Sitka Text

Courier Microsoft Sans Serif Small Fonts

Curlz MT Microsoft Tai Le Snap ITC

D050000L Microsoft Uighur Standard Symbols PS

DejaVu Sans Microsoft Yi Baiti Stencil

DejaVu Sans 

Condensed
Mistral Sylfaen

DejaVu Sans Light Modern No. 20 Symbol

Dubai Mongolian Baiti Symbol Tiger

Dubai Light Monotype Corsiva Symbol Tiger Expert
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Dubai Medium MS Gothic (ＭＳ ゴシック) System

Ebrima MS Outlook Tahoma

Edwardian Script ITC MS Pgothic (ＭＳ Ｐゴシック) Tempus Sans ITC

Elephant MS Reference Sans  Serif
TencentSans Korean W3  

(���� W3)

Engravers MT MS Reference  Specialty
TencentSans Korean W7  

(���� W7)

Eras Bold ITC MS Sans Serif Terminal

Eras Demi ITC MS Serif Tiger

Eras Light ITC MS UI Gothic Tiger Expert

Eras Medium ITC MT Extra Trebuchet MS

Euclid MT Extra Tiger Tw Cen MT

Euclid Extra MV Boli Tw Cen MT Condensed

Euclid Fraktur Myanmar Text
Tw Cen MT Condensed  

Extra Bold

Euclid Math One Niagara Engraved URW Bookman

Euclid Math Two Niagara Solid URW Gothic

Euclid Symbol Nimbus Mono PS Viner Hand ITC

Felix Titling Nimbus Roman Vivaldi

Fences Nimbus Sans Vladimir Script

Fixedsys Nimbus Sans Narrow Wide Latin

Footlight MT Light Nirmala UI Wingdings

Forte Nirmala UI Semilight Wingdings 2

Franklin Gothic Book OCR A Extended Wingdings 3

Franklin Gothic Demi Old English Text MT Yu Gothic (游ゴシック)

Franklin Gothic Demi  

Cond
Onyx

Yu Gothic Light  (游ゴシック 

Light)
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Franklin Gothic Heavy Open Sans Yu Gothic Medium  (游ゴシ

ック Medium)

Franklin Gothic  

Medium
Open Sans Extrabold Yu Gothic UI

Franklin Gothic  

Medium Cond
Open Sans Light Yu Gothic UI Light

Freestyle Script Open Sans Semibold Yu Gothic UI Semibold

French Script MT P052 Yu Gothic UI  Semilight

Gabriola Palace Script MT Z003

支持全部文档类型

字体名称 字体名称 字体名称

Arial Noto Sans Gujarati UI
Noto Sans 
Shavian

Comic Sans MS Noto Sans Gurmukhi Noto Sans Sinhala

Courier New Noto Sans Gurmukhi UI
Noto Sans Sinhala 

UI

Georgia Noto Sans Hanunoo
Noto Sans 

Sundanese

Kingsoft Confetti Noto Sans Hebrew
Noto Sans Syloti 

Nagri

Kingsoft Extra
Noto Sans Imperial Aramaic 

(Noto Sans ImpAramaic)

Noto Sans 

Symbols

Kingsoft Mark

Noto Sans Inscriptional 

Pahlavi (Noto Sans 
InsPahlavi)

Noto Sans 

Symbols2

Kingsoft Math

Noto Sans Inscriptional 

Parthian (Noto Sans 

InsParthi)

Noto Sans Syriac 

Eastern

Kingsoft Sign Noto Sans Javanese
Noto Sans Syriac 

Estrangela

Kingsoft Stress Noto Sans Kaithi Noto Sans Syriac 
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Western

Noto Emoji Noto Sans Kannada
Noto Sans 

Tagalog

Noto Kufi Arabic Noto Sans Kannada UI
Noto Sans 

Tagbanwa

Noto Mono Noto Sans Kayah Li Noto Sans Tai Le

Noto Naskh Arabic Noto Sans Kharoshthi
Noto Sans Tai 

Tham

Noto Naskh Arabic UI Noto Sans Khmer Noto Sans Tai Viet

Noto Nastaliq Urdu Noto Sans Khmer UI Noto Sans Tamil

Noto Sans Noto Sans Lao
Noto Sans Tamil 

UI

Noto Sans Adlam Noto Sans Lao UI Noto Sans Telugu

Noto Sans Adlam Unjoined Noto Sans Lepcha
Noto Sans Telugu 

UI

Noto Sans Anatolian 
Hieroglyphs (Noto Sans 

AnatoHiero)

Noto Sans Limbu Noto Sans Thaana

Noto Sans Arabic Noto Sans Linear B Noto Sans Thai

Noto Sans Arabic UI Noto Sans Lisu Noto Sans Thai UI

Noto Sans Armenian Noto Sans Lycian Noto Sans Tibetan

Noto Sans Avestan Noto Sans Lydian
Noto Sans 
Tifinagh

Noto Sans Balinese Noto Sans Malayalam
Noto Sans 

Ugaritic

Noto Sans Bamum Noto Sans Malayalam UI Noto Sans Vai

Noto Sans Batak Noto Sans Mandaic Noto Sans Yi

Noto Sans Bengali Noto Sans Meetei Mayek Noto Serif

Noto Sans Bengali UI Noto Sans Mongolian
Noto Serif 

Armenian
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Noto Sans Brahmi Noto Sans Mono Noto Serif Bengali

Noto Sans Buginese Noto Sans Myanmar Noto Serif CJK SC

Noto Sans Buhid Noto Sans Myanmar UI Noto Serif CJK TC

Noto Sans Canadian Aboriginal Noto Sans New Tai Lue
Noto Serif 

Devanagari

Noto Sans Carian
Noto Sans Nko (Noto Sans 

N'Ko)

Noto Serif Display 

(Noto Serif Disp)

Noto Sans Chakma Noto Sans Ogham Noto Serif Ethiopic

Noto Sans Cham Noto Sans Ol Chiki
Noto Serif 

Georgian

Noto Sans Cherokee Noto Sans Old Italic Noto Serif Gujarati

Noto Sans Coptic Noto Sans Old Persian Noto Serif Hebrew

Noto Sans Cuneiform
Noto Sans Old South Arabian 
(Noto Sans OldSouArab)

Noto Serif 
Kannada

Noto Sans Cypriot Noto Sans Old Turkic Noto Serif Khmer

Noto Sans Deseret Noto Sans Oriya Noto Serif Lao

Noto Sans Devanagari Noto Sans Oriya UI
Noto Serif 

Malayalam

Noto Sans Devanagari UI Noto Sans Osage
Noto Serif 
Myanmar

Noto Sans Display (Noto Sans 

Disp)
Noto Sans Osmanya Noto Serif Sinhala

Noto Sans Egyptian 

Hieroglyphs (Noto Sans 

EgyptHiero)

Noto Sans Phags Pa Noto Serif Tamil

Noto Sans Ethiopic Noto Sans Phoenician Noto Serif Telugu

Noto Sans Georgian Noto Sans Rejang Noto Serif Thai

Noto Sans Glagolitic Noto Sans Runic
Times New 

Roman

Noto Sans Gothic Noto Sans Samaritan Verdana
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演示文件包含的格式有：pptx、ppt、pot、potx、pps、ppsx、dps、dpt、pptm、potm、ppsm。以下表

中的动画，除随机效果外，均支持播放时机、速度、重复和延迟的调节。

Noto Sans Gujarati Noto Sans Saurashtra Webdings

支持的演示文件动画

进入和退出动画

动画名称 属性 动画名称 属性 动画名称 属性

百叶窗 支持方向 圆形扩展
支持方

向
放大 不支持

擦除 支持方向 渐变 不支持 飞旋 不支持

出现 不支持 渐变式回旋 不支持 浮动 不支持

飞入、飞出 支持方向 渐变式缩放 不支持 光速 不支持

盒状 支持方向 展开-细微型 不支持 滑翔 不支持

缓慢进入、缓慢退

出
支持方向

翻转式由远及

近
不支持 挥鞭式 不支持

阶梯状 支持方向 回旋 不支持 挥舞 不支持

菱形 支持方向 渐入,渐出 不支持 空翻 不支持

轮子
支持辐射

状
上升 不支持

螺旋飞入、螺旋飞

出
不支持

劈裂 支持方向 伸展
支持方

向
曲线向上 不支持

棋盘 支持方向 升起 不支持 投掷 不支持

切入 支持方向 缩放
支持缩

放
玩具风车 不支持

闪烁一次 不支持 下降 不支持 线形 不支持

扇形展开 不支持 压缩 不支持 旋转
支持方

向

十字形扩展 支持方向 颜色打字机 不支持 折叠 不支持

随机线条 支持方向 展开-温和型 不支持 字幕式 不支持
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随机效果 不支持 中心旋转 不支持 - -

向内溶解 不支持 弹跳 不支持 - -

强调动画

动画名称 属性 动画名称 属性

放大/缩小 尺寸 忽明忽暗 不支持

更改填充颜色 充填色 混色 颜色

更改线条颜色 线条色 加粗闪烁 不支持

更改字号 字号 加深 不支持

更改字体 字体 添加下划线 不支持

更改字体颜色 字体颜色 着色 颜色

更改字形 字形 温和型 不支持

透明 数量 彩色延伸 颜色

陀螺旋 数量 跷跷板 不支持

细微型 不支持 闪动 颜色

变淡 不支持 闪现 不支持

补色 不支持 华丽型 不支持

补色2 不支持 爆炸 颜色

不饱和 不支持 波浪型 不支持

彩色波纹 颜色 加粗展示 不支持

垂直突出显示 颜色 闪烁 不支持

对比色 不支持 样式强调 颜色
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更新日志
最近更新时间：2022-06-24 17:53:38

下载地址： sdk-v0.2.1.zip

下载地址： sdk-v0.1.1.zip

V0.2.1

支持 COS V5 签名鉴权

支持 token 鉴权和续期

支持监听 PPT 中的视频播放状态

V0.1.1

支持在线预览

支持 COS V4 签名鉴权

https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.2.1.zip
https://cos-doc-preview-js-sdk-1253960454.file.myqcloud.com/sdk-v0.1.1.zip


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1527 共1950页

文件处理

服务和队列配置

开通文件处理服务
最近更新时间：2023-08-01 15:45:53

本接口用于开通文件处理服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /file_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 FileBucket 的内容：

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <FileBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </FileBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

FileBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.FileBucket 存储桶 ID String

Name Response.FileBucket 存储桶名称，同 BucketId String

Region Response.FileBucket 所在的地域 String

CreateTime Response.FileBucket 创建时间 String

实际案例

请求

POST /file_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <FileBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </FileBucket>

</Response>
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查询文件处理服务
最近更新时间：2023-08-01 15:45:52

本接口用于查询已经开通文件处理功能的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /file_bucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述

默

认

值

是否

必填

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域
以“,”分隔字符串，详情请参见 地域与域名  

无 否

bucketN

ames
存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 无 否

bucketN 存储桶名称前缀，前缀搜索 无 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

ame

pageNu
mber

第几页 1 否

pageSiz

e
每页个数，大于0且小于等于100的整数 10 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <FileBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </FileBucketList>

    <FileBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </FileBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 FileBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码 文档。

RequestId
Respon

se
请求的唯一 ID String

TotalCount
Respon

se
开通文件处理的 Bucket 总数 Int

PageNumber
Respon
se

当前页数，同请求中的 pageNumber Int

PageSize
Respon

se
每页个数，同请求中的 pageSize Int

FileBucketList
Respon

se
文件处理 Bucket 详情

Contain

er 数组

节点名称（关

键字）
父节点 描述 类型

BucketId
Response.FileBuck

etList
存储桶 ID String

Name
Response.FileBuck

etList
存储桶名称，同 BucketId String

Region
Response.FileBuck

etList
所在的地域 String

CreateTime
Response.FileBuck

etList
创建时间 String

错误码

实际案例

请求

GET /file_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2021 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <FileBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </FileBucketList>

    <FileBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </FileBucketList>

</Response>
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关闭文件处理服务
最近更新时间：2023-08-01 15:45:52

本接口用于关闭文件处理服务并删除队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /file_bucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

BucketName Response 存储桶名称 String

错误码

实际案例

请求

DELETE /file_bucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42867
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</Response>
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查询文件处理队列
最近更新时间：2023-08-01 15:45:54

本接口用于查询文件处理队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /file_queue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述

类

型

是否

必选

queueIds 队列 ID，以“,”符号分割字符串
Str

ing
否

state

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度执行，队列内的所有作

业状态维持在暂停状态，已经执行中的任务不受影响

Str
ing

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

具体的数据内容如下：

pageNumb

er

第几页，默认值1 Str

ing

否

pageSize 每页个数，默认值10
Str

ing
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>FileProcess</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons
e

队列总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

QueueList
Respons
e

队列数组
Container 数
组

NonExistPIDs
Respons

e
不存在的队列 ID 列表 String 数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi

st
队列名字 String

State
Response.QueueLi

st
当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi

st
队列最大长度 Int

MaxConcurrent
Response.QueueLi

st
当前队列最大并行执行的任务数 Int

Category Response.QueueLi

st

队列类型 String
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UpdateTime
Response.QueueLi

st
更新时间 String

CreateTime
Response.QueueLi

st
创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.Notify

Config
回调地址 String

State
Response.QueueList.Notify
Config

开关状态 String

Type
Response.QueueList.Notify

Config
回调类型 String

Event
Response.QueueList.Notify

Config
回调事件 String

ResultFormat
Response.QueueList.Notify
Config

回调类型 String

MqMode
Response.QueueList.Notify

Config
TDMQ 使用模式 String

MqRegion
Response.QueueList.Notify

Config
TDMQ 所属园区 String

MqName
Response.QueueList.Notify
Config

TDMQ 主题名称 String

错误码

实际案例

请求

GET /file_queue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>FileProcess</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>
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更新文件处理队列
最近更新时间：2023-08-01 16:46:26

本接口用于更新文件处理的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /file_queue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-file</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值
限

制

Request 无 保存结果的容器
Contain

er
是 无 无

节点名称（关

键字）

父节

点
描述 类型

默
认

值

是否

必选

Name
Req

uest

队列名称，仅支持中文、英文、数字、_、-和

*，长度不超过 128

Strin

g
无 是

State
Req

uest

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度

执行，队列内的所有作业状态维持在暂停状
态，已经执行中的任务不受影响

Strin

g
无 是

NotifyConf

ig

Req

uest
回调配置

Cont

ainer
无 是

节点名称（关

键字）
父节点 描述

类

型

默
认

值

是否必选

State
Request.No

tifyConfig

回调开关

Off

On

Str

ing
Off 否

Event
Request.No

tifyConfig

回调事件
TaskFinish：任务完成

WorkflowFinish：工作流

完成

Str

ing
无

当 State=On 

时，必选

ResultFor

mat

Request.No

tifyConfig

回调格式

XML

JSON

Str

ing

XM

L

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Type
Request.No

tifyConfig

回调类型
Url

TDMQ

Str

ing
无

当 State=On 

时，必选

Url
Request.No

tifyConfig
回调地址，不能为内网地址。

Str

ing
无

当 

State=On，

且 Type=Url 

时，必选

MqMode
Request.No

tifyConfig

TDMQ 使用模式

Topic：主题订阅

Queue: 队列服务

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

MqRegion
Request.No
tifyConfig

TDMQ 所属园区，目前支持园

区 sh（上海）、bj（北京）、
gz（广州）、cd（成都）、hk

（中国香港）

Str
ing

无

当 

State=On，

且 
Type=TDM

Q 时，必选

MqName
Request.No

tifyConfig
TDMQ 主题名称

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>FileProcess</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键字） 父节点 描述 类型

QueueId
Response.Queu

e
队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu
e

当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu

e

回调配置，同 

Request.NotifyConfig

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxSize Response.Queu

e

队列最大长度 Int

MaxConcurrent
Response.Queu

e
当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /file_queue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-file</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-file</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>FileProcess</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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文件哈希值计算

哈希值计算同步请求
最近更新时间：2023-07-14 14:47:02

以同步请求的方式进行文件哈希值计算，实时返回计算得到的哈希值，该接口属于 GET 请求。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

费用说明

调用接口会产生 哈希值计算费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持处理 COS 上的归档存储类型和深度归档存储类型的文件，如果需要处理此类型文件，请先 恢复归档文

件 。

限制说明

文件大小：支持计算小于 128 MB 大小的文件，更大文件请使用 哈希值计算异步接口 。

请求超时时间：10秒。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

GET /<ObjectKey>?ci-process=filehash&type=<type> HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/83085
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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参数说明如下：

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

请求参数

节点名称（关

键字）
描述 类型

是否

必选

ci-process 操作类型，哈希值计算固定为：filehash
Stri

ng
是

type 支持的哈希算法类型，有效值：md5、sha1、sha256
Stri
ng

是

addtohead

er

是否将计算得到的哈希值，自动添加至文件的自定义header，格式

为：x-cos-meta-md5/sha1/sha256；

有效值： true、false，不填则默认为false

Stri

ng
否

请求体

响应

响应头

响应体

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 FileHashCodeResult 的内容：

Container 节点 Input 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

FileHashCodeResult Response 文件哈希值的结果。 Container

Input Response 输入文件的基本信息。 Container

节点名称

（关键

字）

父节点 描述 类型

MD5
Response.FileHash

CodeResult
请求时 type 为 md5 时返回

Stri

ng

SHA1
Response.FileHash

CodeResult
请求时 type 为 sha1 时返回

Stri

ng

SHA256
Response.FileHash

CodeResult
请求时 type 为 sha256 时返回

Stri

ng

FileSize
Response.FileHash

CodeResult
文件的大小 Int

LastMod

ified

Response.FileHash

CodeResult
对象的最近一次修改的时间

Stri

ng

Etag
Response.FileHash

CodeResult

ETag 全称为 Entity Tag，是对象被创建时标识对

象内容的信息标签，可用于检查对象的内容是否发生
变化

Stri

ng

节点名称（关键字） 父节点 描述 类型

Region
Response.JobsDetail.Inp

ut
存储桶所在地域

Strin

g

Bucket
Response.JobsDetail.Inp

ut
输入文件所在的存储桶

Strin

g

Object
Response.JobsDetail.Inp

ut
输入文件在存储桶中的名称

Strin

g
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

GET /for-test.mp4?ci-process=filehash&type=md5 HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileHashCodeResult>

        <MD5>0fe771ba515b0525552f59290a50c0ef</MD5>

        <FileSize>1048576</FileSize>

        <LastModified>2022-06-27T15:23:12+0800</LastModified>

        <Etag>"ee8de918d05640145b18f70f4c3aa602"</Etag>

    </FileHashCodeResult>

    <Input>

        <Bucket>test-1234567890</Bucket>

        <Object>wg.txt</Object>

        <Region>ap-chongqing</Region>

    </Input>

</Response>

https://cloud.tencent.com/document/product/436/53983
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提交哈希值计算任务
最近更新时间：2023-08-01 16:46:26

以提交任务的方式进行文件哈希值计算，异步返回计算得到的哈希值，该接口属于 POST 请求。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

费用说明

调用接口会产生 哈希值计算费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持计算 COS 上的归档存储类型和深度归档存储类型的文件哈希值，如果需要计算此类型文件的哈希值，请

先 恢复归档文件 。

限制说明

文件大小支持：支持计算小于 50 GB 大小的文件。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、中国香港、新加坡、硅谷。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1553 共1950页

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求体

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://test.test.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest

表示任务的类型，哈希值计算默认为：

FileHashCode。

Strin

g
是

Input
Req

uest
包含待操作的文件信息。

Cont

ainer
是

Operation
Req

uest
包含哈希值计算的处理规则。

Cont

ainer
是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式。

Strin

g
否

CallBackT

ype

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型。

Strin

g
否
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 FileHashCodeConfig 的具体数据描述如下：

CallBack Req

uest

任务回调的地址，优先级高于队列的回调地址。 Strin

g

否

CallBackM

qConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig 。

Cont

ainer
否

节点名称（关键

字）
父节点 描述 类型

是否必

选

Object
Request.I

nput

文件名，取值为文件在当前存储桶中的完整

名称。

Stri

ng
是

Operation

节点名称（关键

字）
父节点 描述 类型

是否

必选

FileHashCod

eConfig

Request.Op

eration
指定哈希值计算的处理规则。

Conta

iner
是

UserData
Request.Op

eration

透传用户信息, 可打印的 ASCII 码，长度

不超过1024。
String 否

节点名称（关
键字）

父节点 描述
类
型

是否
必选

Type
Request.Operation.File

HashCodeConfig

哈希值的算法类型，支持：MD5、

SHA1、SHA256

St

ri

n

g

是

AddToHea

der

Request.Operation.File

HashCodeConfig

是否将计算得到的哈希值添加至文件

自定义header，有效值：true、
false，默认值为 false。

自定义header根据 Type 的值变

化，例如 Type 值为MD5时，自定

义header为 x-cos-meta-

md5。

St

ri

n

g

否

响应

响应头

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。
Container 数

组

https://cloud.tencent.com/document/product/460/42866
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Container 节点  的内容：JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义。

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义。

Stri

ng

JobId
Response.J

obsDetail
创建任务的 ID。

Stri

ng

Tag
Response.J

obsDetail
表示任务的类型，哈希值计算默认为：FileHashCode。

Stri

ng

State
Response.J
obsDetail

任务状态

Submitted：已提交，待执行。

Running：执行中。

Success：执行成功。

Failed：执行失败。

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态。

Cancel：任务被取消执行。

Stri
ng

Progress
Response.J

obsDetail
任务进度百分比，范围为[0, 100]。 Int 

CreationTi

me

Response.J

obsDetail
任务的创建时间。

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间。

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间。

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID 。

Stri

ng

Input
Response.J

obsDetail
被计算哈希值的文件信息。

Con

tain

er

https://cloud.tencent.com/document/product/460/46487
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Container 节点 FileHashCodeResult 的内容：

Operation Response.J

obsDetail

哈希值计算的处理规则。 Con

tain

er

节点名称（关键字） 父节点 描述 类型

Region
Response.JobsDetail.Inp
ut

存储桶所在地域。 String

Bucket
Response.JobsDetail.Inp

ut
文件所在的存储桶。 String

Object
Response.JobsDetail.Inp

ut
被计算哈希值的文件名。 String

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetai

l.Operation
透传用户信息。 String

FileHashCod
eConfig

Response.JobsDetai
l.Operation

同请求中的 
Request.Operation.FileHashCodeC

onfig。

Conta
iner

FileHashCod

eResult

Response.JobsDetai

l.Operation

计算得到的文件 hash 值信息，任务未完

成时不返回。

Conta

iner

节点名称（关键
字）

父节点 描述 类型

MD5
Response.JobsDetail.Operation.FileHa

shCodeResult
MD5 计算结果。

Stri

ng

SHA1
Response.JobsDetail.Operation.FileHa

shCodeResult
SHA1 计算结果。

Stri

ng

SHA256
Response.JobsDetail.Operation.FileHa
shCodeResult

SHA256 计算结
果。

Stri
ng

FileSize Response.JobsDetail.Operation.FileHa 文件大小。 Int
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

shCodeResult

LastModified
Response.JobsDetail.Operation.FileHa

shCodeResult

文件的最后修改时

间。

Stri

ng

Etag
Response.JobsDetail.Operation.FileHa
shCodeResult

文件的Etag。
Stri
ng

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileHashCode</Tag>

    <Input>

        <Object>input/test.mp4</Object>

    </Input>

    <Operation>

        <FileHashCodeConfig>

            <Type>MD5</Type>

            <AddToHeader>true</AddToHeader>

        </FileHashCodeConfig>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

https://cloud.tencent.com/document/product/436/53983
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Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/deer.jpg</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询哈希值计算结果
最近更新时间：2023-08-11 17:56:17

本接口用于主动查询指定的文件哈希值计算任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail
Respon

se

同提交哈希值计算接口中的 

Response.JobsDetail  

Contain

er 数组

NonExistJobIds
Respon

se

查询的 ID 中不存在任务，所有任务都存在时不返

回。

String 

数组

https://cloud.tencent.com/document/product/460/83085#JobsDetail
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

错误码

实际案例

请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileHashCode</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileHashCodeConfig>

                <Type>MD5</Type>

https://cloud.tencent.com/document/product/460/42867
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                <AddToHeader>true</AddToHeader>

            </FileHashCodeConfig>

            <FileHashCodeResult>

                <MD5>xxxxxxxx</MD5>

                <FileSize>123</FileSize>

                <LastModified>2022-06-27T15:23:11+0800</LastModified>

                <Etag>xxxxxx</Etag>

            </FileHashCodeResult>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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文件解压
提交文件解压任务
最近更新时间：2023-08-11 17:56:17

以提交任务的方式进行文件解压缩，异步返回压缩包内被解压出来的文件，该接口属于 POST 请求。

功能描述

费用说明

调用接口会产生 文件解压费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持解压 COS 上的归档存储类型和深度归档存储类型的文件，如果解压需要此类型文件，请先 恢复归档文

件 。

限制说明

文件大小支持：支持解压小于5TB 的压缩包文件。

文件解压的处理方式为流式解压，会边解压边输出解压文件，如果解压过程中有部分文件损坏导致解压操作中

止，会保留已解压的部分文件。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求头

请求体

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

            <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req
ues

t

表示任务的类型，文件解压默认为：
FileUncompress。

String 是

Input Req

ues

包含待操作的文件信息。 Conta

iner

是

https://cloud.tencent.com/document/product/460/42865
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 FileUncompressConfig 的具体数据描述如下：

t

Operation

Req

ues
t

包含文件解压的处理规则。
Conta

iner
是

CallBackFo

rmat

Req

ues

t

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式。
String 否

CallBackTy

pe

Req

ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型。
String 否

CallBack

Req

ues

t

任务回调的地址，优先级高于队列的回调地址。 String 否

CallBackM

qConfig

Req

ues

t

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig 。

Conta

iner
否

节点名称（关键

字）
父节点 描述

类

型

是否必

选

Object
Request.I

nput

文件名，取值为文件在当前存储桶中的完整名

称。

Str

ing
是

Operation

节点名称（关键

字）
父节点 描述 类型

是否

必选

FileUncompre

ssConfig

Request.Op

eration
指定文件解压的处理规则。

Conta

iner
是

UserData
Request.Op
eration

透传用户信息，可打印的 ASCII 码，长
度不超过1024。

String 否

Output
Request.Op

eration
指定解压后的文件保存的存储桶信息。

Conta

iner
是

节点名称（关 父节点 描述 类 是否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Output 的具体数据描述如下：

键字） 型 必选

Prefix

Request.Ope

ration.

FileUncompr

essConfig

指定解压后输出文件的前缀，不填则默认保存在存

储桶根路径。

St

ri

n

g

否

UnCompre
ssKey

Request.Ope

ration.
FileUnCompr

essConfig

解压密钥，传入时需先经过 base64 编码。

St

ri
n

g

否

PrefixRepl
aced

Request.Ope

ration.
FileUncompr

essConfig

指定解压后的文件路径是否需要替换前缀，有效

值：

0：不添加额外的前缀，解压缩将保存在

Prefix指定的路径下（不会保留压缩包的名

称，仅将压缩包内的文件保存至指定的路径）

1：以压缩包本身的名称作为前缀，解压缩将保
存在Prefix指定的路径下

2：以压缩包完整路径作为前缀，此时如果不

指定Prefix，就是解压到压缩包所在的当前路

径（包含压缩包本身名称）

默认值为0。

St

ri
n

g

否

示例：

假设压缩包名为 test.zip，压缩包内的文件为“图片.jpg”，存储在了存储桶 A 的 123 目录下，则压缩包

的完整路径为：123/test.zip。 

对该压缩包进行解压缩，指定解压缩到存储桶A，并指定 Prefix  为 456，则不同的 PrefixReplaced 值

对应解压后的文件保存情况如下：

0：“图片.jpg”会保存在 456 目录下，“图片.jpg”的完整路径为 456/图片.jpg； 

1：“图片.jpg”会以 test 为前缀保存在 456 目录下，“图片.jpg”的完整路径为 456/test/图片.jpg； 

2：“图片.jpg”会以 123/test 为前缀保存在 456 目录下，“图片.jpg”的完整路径为 456/123/test/

图片.jpg。

节点名称（关键字） 父节点 描述 类型
是否必

选

Region
Request.Operation.O

utput
存储桶的地域。

Stri

ng
是

Bucket Request.Operation.O 保存解压后文件的存储 Stri 是
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

utput 桶。 ng

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

                <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点  的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义。

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义。

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID。

Strin

g

Tag
Response.J

obsDetail
表示任务的类型，文件解压默认为：FileUncompress。

Strin

g

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Strin

g

Progress
Response.J

obsDetail
任务进度百分比，范围为[0, 100]。 Int

CreationTi

me

Response.J

obsDetail
任务的创建时间。

Strin

g

StartTime
Response.J

obsDetail
任务的开始时间。

Strin

g
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Container 节点 FileUncompressResult 的内容：

EndTime Response.J

obsDetail

任务的结束时间。 Strin

g

QueueId
Response.J

obsDetail
任务所属的 队列 ID 。

Strin

g

Input
Response.J

obsDetail
被解压文件的信息。

Cont

ainer

Operation
Response.J

obsDetail
文件解压的处理规则。

Cont

ainer

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶所在地域。 String

Bucket Response.JobsDetail.Input 文件所在的存储桶。 String

Object Response.JobsDetail.Input 被解压文件的文件名。 String

节点名称（关键
字）

父节点 描述 类型

UserData
Response.JobsDeta

il.Operation
透传用户信息。

Strin

g

Output
Response.JobsDeta

il.Operation

同请求中的 

Request.Operation.Output。

Cont

ainer

FileUncompr
essConfig

Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.FileUncompress

Config。

Cont
ainer

FileUncompr

essResult

Response.JobsDeta

il.Operation
文件解压的结果，任务未完成时不返回。

Cont

ainer

节点名称（关键
字）

父节点 描述
类
型

Region
Response.JobsDetail.Operation.File

UncompressResult

解压后文件保存的存储桶

的地域。

Str

ing

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Bucket Response.JobsDetail.Operation.File

UncompressResult

解压后文件保存的存储

桶。

Str

ing

FileCount
Response.JobsDetail.Operation.File
UncompressResult

解压后文件的个数。
Str
ing

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileUncompress</Tag>

    <Input>

        <Object>input/test.zip</Object>

    </Input>

    <Operation>

        <FileUncompressConfig>

            <Prefix>output/</Prefix>

            <PrefixReplaced>1</PrefixReplaced>

            <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

        </FileUncompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/460/42867
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Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

                <UnCompressKey>MTIzNDU2Nzg5MA==</UnCompressKey>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询文件解压结果
最近更新时间：2023-08-18 15:28:02

本接口用于主动查询指定的文件解压任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail
Respon

se

同提交文件解压任务接口中的 

Response.JobsDetail  

Contain

er 数组

NonExistJobIds
Respon

se
查询的 ID 中不存在任务，所有任务都存在时不返回

String 

数组

错误码

https://cloud.tencent.com/document/product/460/83087#JobsDetail
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileUncompress</Tag>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.zip</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <FileUncompressConfig>

                <Prefix>output/</Prefix>

                <PrefixReplaced>1</PrefixReplaced>

            </FileUncompressConfig>

https://cloud.tencent.com/document/product/460/42867
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            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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多文件打包压缩

提交多文件打包压缩任务
最近更新时间：2023-08-01 16:46:26

多文件打包压缩功能可以将您的多个文件，打包为 zip 等压缩包格式，以提交任务的方式进行多文件打包压缩，异

步返回打包后的文件，该接口属于 POST 请求。

功能描述

费用说明

调用接口会产生 多文件打包压缩费用  和 COS 读请求费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持打包 COS 上的归档存储类型和深度归档存储类型的文件，如果打包需要此类型文件，请先 恢复归档文

件 。

限制说明

文件数量支持：最多支持打包 1 万个文件；

文件大小支持：打包压缩后总大小小于 50GB；

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization：Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

https://cloud.tencent.com/document/product/436/82325
https://cloud.tencent.com/document/product/436/53861#.E8.AF.B7.E6.B1.82.E6.AC.A1.E6.95.B0.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1578 共1950页

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

请求头

请求体

<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

            <Type>better</Type>

            <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器。 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest

表示任务的类型，多文件打包压缩默认为：

FileCompress。

Strin

g
是

Operation
Req

uest
包含文件打包压缩的处理规则。

Cont

ainer
是

https://cloud.tencent.com/document/product/460/42865
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Container 类型  的具体数据描述如下：

Container 类型 FileCompressConfig 的具体数据描述如下：

CallBackFo

rmat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式。

Strin

g

否

CallBackTy

pe

Req

uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型。

Strin

g
否

CallBack
Req

uest
任务回调的地址，优先级高于队列的回调地址。

Strin

g
否

CallBackM

qConfig

Req

uest

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填。详情请参见 CallBackMqConfig 。

Cont

ainer
否

Operation

节点名称（关键

字）
父节点 描述 类型

是否

必选

FileCompres

sConfig

Request.Op

eration
指定文件打包压缩的处理规则。

Conta

iner
是

UserData
Request.Op
eration

透传用户信息，可打印的 ASCII 码，长度
不超过1024。

String 否

Output
Request.Op

eration
指定打包压缩后的文件保存的地址信息。

Conta

iner
是

节点名称（关
键字）

父节点 描述 类型
是否
必选

Flatten

Request.O

peration.Fi

leCompres
sConfig

文件打包时，是否需要去除源文件已有的目录结

构，有效值：

例如：源文件 URL 为 

https://domain/source/test.mp4 ，则源文件

路径为 source/test.mp4，如果为 1，则 ZIP 

包中该文件路径为 test.mp4；如果为0， ZIP 

包中该文件路径为 source/test.mp4。

0：不需要去除目录结构，打包后压缩包中的

文件会保留原有的目录结构；

1：需要，打包后压缩包内的文件会去除原有的

目录结构，所有文件都在同一层级。
Strin

g
是

Format Request.O

peration.Fi

打包压缩的类型，有效值：zip、tar、tar.gz。 Strin

g

是

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Output 的具体数据描述如下：

leCompres

sConfig

Type

Request.O

peration.Fi

leCompres

sConfig

压缩类型，仅在Format为tar.gz或zip时有效。

faster：压缩速度较快

better：压缩质量较高，体积较小

default：适中的压缩方式

默认值为default

Strin

g
否

Compress

Key

Request.O

peration.Fi

leCompres

sConfig

压缩包密钥，传入时需先经过 base64 编码，编

码后长度不能超过128。当 Format 为 zip 时生

效。

Strin

g
否

UrlList

Request.O

peration.Fi

leCompres

sConfig

支持将需要打包的文件整理成索引文件，后台

将根据索引文件内提供的文件 url，打包为一
个压缩包文件。

索引文件需要保存在当前存储桶中，本字段需

要提供索引文件的对象地址，例

如：/test/index.csv。

索引文件格式：仅支持 CSV 文件，一行一条 

URL（仅支持本存储桶文件），如有多列字

段，默认取第一列作为URL。最多不超过

10000个文件, 总大小不超过50G，否则会导
致任务失败。

Strin

g
否

Prefix

Request.O

peration.Fi

leCompres

sConfig

支持对存储桶中的某个前缀进行打包，如果需要对

某个目录进行打包，需要加/，例如test目录打

包，则值为：test/。最多不超过10000个文件，

总大小不超过50G，否则会导致任务失败。

Strin

g
否

Key

Request.O

peration.Fi
leCompres

sConfig

支持对存储桶中的多个文件进行打包，个数不能超

过 1000，总大小不超过50G，否则会导致任务
失败。

Strin

g 数
组

否

注意

UrlList、Prefix、Key 三者仅能选择一个，不能都为空，也不会同时生效。如果填了多个，会按优先级 

UrlList > Prefix > Key 取最高优先级执行。

节点名称（关键字） 父节点 描述 类型 是否必

选
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Region
Request.Operation.O

utput
存储桶的地域。

Stri

ng
是

Bucket
Request.Operation.O
utput

保存压缩后文件的存储
桶。

Stri
ng

是

Object
Request.Operation.O

utput
压缩后文件的文件名

Stri

ng
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

                <Type>better</Type>

                <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息。
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义。

Strin

g

Message
Response.J
obsDetail

错误描述，只有 State 为 Failed 时有意义。
Strin
g

JobId
Response.J

obsDetail
新创建任务的 ID。

Strin

g

Tag
Response.J

obsDetail

表示任务的类型，多文件打包压缩默认为：

FileCompress。

Strin

g

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行。

Running：执行中。

Success：执行成功。

Failed：执行失败。

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态。

Cancel：任务被取消执行。

Strin

g

Progress Response.J 任务进度百分比，范围为[0, 100]。 Int
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Container 节点 Operation 的内容：

Container 节点 FileCompressResult 的内容：

obsDetail

CreationTi

me

Response.J

obsDetail
任务的创建时间。

Strin

g

StartTime
Response.J

obsDetail
任务的开始时间。

Strin

g

EndTime
Response.J

obsDetail
任务的结束时间。

Strin

g

QueueId
Response.J

obsDetail
任务所属的 队列 ID 。

Strin

g

Operation
Response.J

obsDetail
多文件打包压缩的处理规则。

Cont

ainer

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetail

.Operation
透传用户信息。 String

Output
Response.JobsDetail

.Operation

同请求中的 

Request.Operation.Output。

Conta

iner

FileCompres

sConfig

Response.JobsDetail

.Operation

同请求中的 

Request.Operation.FileCompressC

onfig。

Conta

iner

FileCompres
sResult

Response.JobsDetail
.Operation

多文件打包压缩的结果，任务未完成时不返
回。

Conta
iner

节点名称（关键

字）
父节点 描述

类

型

Region
Response.JobsDetail.Operation.Fi

leCompressResult

打包压缩后文件保存的存储桶

的地域。

Str

ing

Bucket
Response.JobsDetail.Operation.Fi

leCompressResult

打包压缩后文件保存的存储

桶。

Str

ing

Object Response.JobsDetail.Operation.Fi 打包压缩后文件的名称。 Str

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

leCompressResult ing

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>FileCompress</Tag>

    <Operation>

        <FileCompressConfig>

            <Prefix>test/</Prefix>

            <Format>zip</Format>

            <Flatten>0</Flatten>

            <Type>better</Type>

            <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

        </FileCompressConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/test.zip</Object>

        </Output>

        <UserData>This is my data.</UserData>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

                <Type>better</Type>

                <CompressKey>MTIzNDU2Nzg5MA==</CompressKey>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>
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查询多文件打包压缩结果
最近更新时间：2023-08-11 17:56:17

本接口用于主动查询指定的多文件打包压缩任务结果。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /file_jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器。 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail
Respon
se

同提交多文件打包任务接口中的 
Response.JobsDetail  

Contain
er 数组

NonExistJobIds
Respon

se

查询的 ID 中不存在任务，所有任务都存在时不返

回。

String 

数组

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/83091#JobsDetail
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请求

GET /file_jobs/f93984788066911ed89ed352d4d9d2084 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 18 Jul 2022 19:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>f93984788066911ed89ed352d4d9d2084</JobId>

        <State>Submitted</State>

        <Progress>0</Progress>

        <CreationTime>2022-07-18T15:16:43+0800</CreationTime>

        <EndTime>-</EndTime>

        <StartTime>-</StartTime>

        <QueueId>p2911917386e148639319e13c285cc774</QueueId>

        <Tag>FileCompress</Tag>

        <Operation>

            <FileCompressConfig>

                <Prefix>test/</Prefix>

                <Format>zip</Format>

                <Flatten>0</Flatten>

            </FileCompressConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/test.zip</Object>

            </Output>

            <UserData>This is my data.</UserData>

        </Operation>

    </JobsDetail>
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</Response>
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压缩包预览
最近更新时间：2023-08-01 16:46:26

该接口可以在不解压文件的情况下预览压缩包内的内容，包含文件数量、名称、文件时间等，接口为同步请求方式。

功能描述

费用说明

调用接口会产生 文件解压费用 。

如果文件为 COS 上的低频存储类型，调用会产生 COS 低频数据取回费用 。

不支持处理 COS 上的归档存储类型和深度归档存储类型的文件，如果需要处理此类型文件，请先 恢复归档文

件 。

限制说明

支持预览的压缩包格式：zip、tar、gz、7zip、rar。

预览压缩包大小限制：zip/7zip无大小限制，tar/gz/rar需小于128MB。

预览压缩包内的文件数限制：仅支持预览内部文件数量小于1000的压缩包。

请求超时时间：10秒。

调用接口需携带签名，具体规则请参见 请求签名  文档。

本接口当前支持以下地域：北京、上海、广州、成都、南京、重庆、中国香港、新加坡、硅谷。

请求

请求示例

GET /for-test.zip?ci-process=zippreview HTTP/1.1

Host: <BucketName-APPID>.cos.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

该请求为 cos 域名。

请求头

https://cloud.tencent.com/document/product/460/82333#.E6.96.87.E4.BB.B6.E5.A4.84.E7.90.86.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/53862#.E6.95.B0.E6.8D.AE.E5.8F.96.E5.9B.9E.E5.AE.9A.E4.BB.B7
https://cloud.tencent.com/document/product/436/12633
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/460/41741
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

参数说明如下：

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

请求参数

节点名称（关键字） 描述 是否必选

ci-process 操作类型，压缩包预览计算固定为：zippreview 是

请求体

响应

响应头

响应体

<Response>

    <FileNumber>2</FileNumber>

    <Contents>

        <Key>test1.jpg</Key>

        <LastModified>2021-11-21T12:30:42+0000</LastModified>

        <UncompressedSize>46743</UncompressedSize>

    </Contents>

    <Contents>

        <Key>test2.mp3</Key>

        <LastModified>2021-11-22T12:11:26+0000</LastModified>

        <UncompressedSize>733318</UncompressedSize>

    </Contents>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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Container 节点 Contents 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

FileNumber Response 压缩包中的文件数量 Int

Contents Response 保存文件信息的容器 Container 数组

节点名称（关键字） 父节点 描述 类型

Key Response.Contents 文件名称 String

LastModified Response.Contents 文件的最近一次修改的时间 String

UncompressedSize Response.Contents 文件压缩前的大小 Int

错误码

实际案例

请求

GET /for-test.zip?ci-process=zippreview HTTP/1.1

Host: test-1234567890.cos.ap-beijing.myqcloud.com

Authorization: q-sign-algorithm=sha1&q-ak=AKIDWtTCBYjM5OwLB9CAwA1Qb2ThTSUjfG*

Content-Length: 0

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-cos

x-cos-request-id: NTg3NzRiMjVfYmRjMzVfMTViMl82ZGZmNw==

<Response>

    <FileNumber>2</FileNumber>

    <Contents>

        <Key>test1.jpg</Key>

        <LastModified>2021-11-21T12:30:42+0000</LastModified>

        <UncompressedSize>46743</UncompressedSize>

https://cloud.tencent.com/document/product/460/8523
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    </Contents>

    <Contents>

        <Key>test2.mp3</Key>

        <LastModified>2021-11-22T12:11:26+0000</LastModified>

        <UncompressedSize>733318</UncompressedSize>

    </Contents>

</Response>
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智能语音
服务和队列配置

开通智能语音服务
最近更新时间：2023-08-01 16:46:28

本接口用于开通智能语音服务并生成队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

POST /asrbucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 AsrBucket 的内容：

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <AsrBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </AsrBucket>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

AsrBucket Response 存储桶信息 Container

节点名称（关键字） 父节点 描述 类型

BucketId Response.AsrBucket 存储桶 ID String

Name Response.AsrBucket 存储桶名称，同 BucketId String

Region Response.AsrBucket 所在的地域 String

CreateTime Response.AsrBucket 创建时间 String

实际案例

请求

POST /asrbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x</RequestId>

    <AsrBucket>

        <BucketId>test-1234567890</BucketId>

        <Name>test-1234567890</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2022-08-09T16:23:11+0800></CreateTime>

    </AsrBucket>

</Response>
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查询智能语音服务
最近更新时间：2023-08-01 16:46:26

本接口用于查询已经开通智能语音功能的存储桶。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /asrbucket HTTP/1.1

Host: ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

名称 描述
默
认

值

是否

必填

regions
地域信息，例如 ap-shanghai、ap-beijing，若查询多个地域

以“,”分隔字符串，详情请参见 地域与域名  
无 否

bucketNam

es
存储桶名称，以“,”分隔，支持多个存储桶，精确搜索 无 否

bucketNam 存储桶名称前缀，前缀搜索 无 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
https://cloud.tencent.com/document/product/460/31066
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此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

e

pageNumb

er
第几页 1 否

pageSize 每页个数，大于0且小于等于100的整数 10 否

响应

响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AsrBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </AsrBucketList>

    <AsrBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </AsrBucketList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 AsrBucketList 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码 文档。

RequestId Respon

se

请求的唯一 ID String

TotalCount
Respon
se

开通智能语音的 Bucket 总数 Int

PageNumber
Respon

se
当前页数，同请求中的 pageNumber Int

PageSize
Respon

se
每页个数，同请求中的 pageSize Int

AsrBucketList
Respon
se

智能语音 Bucket 详情
Contain
er 数组

节点名称（关

键字）
父节点 描述 类型

BucketId
Response.AsrBuck
etList

存储桶 ID
Strin
g

Name
Response.AsrBuck

etList
存储桶名称，同 BucketId

Strin

g

Region
Response.AsrBuck

etList
所在的地域

Strin

g

CreateTime
Response.AsrBuck
etList

创建时间
Strin
g

错误码

实际案例

请求

GET /asrbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 15 Jun 2021 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <AsrBucketList>

        <BucketId>examplebucket-1250000000</BucketId>

        <Name>examplebucket-1250000000</Name>

        <Region>ap-beijing</Region>

        <CreateTime>2019-11-15T12:12:12+0800</CreateTime>

    </AsrBucketList>

    <AsrBucketList>

        <BucketId>examplebucket-1-1250000000</BucketId>

        <Name>examplebucket-1-1250000000</Name>

        <Region>ap-chongqing</Region>

        <CreateTime>2020-11-16T14:13:15+0800</CreateTime>

    </AsrBucketList>

</Response>
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关闭智能语音服务
最近更新时间：2023-08-01 16:46:28

本接口用于关闭智能语音服务并删除队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /asrbucket HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

BucketName Response 存储桶名称 String

错误码

实际案例

请求

DELETE /asrbucket HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMzRlZGZfOTBmYTUwNjRfNzI0MV8x

<Response>

    <RequestId>NjJmMzYxMDlfOTBmYTUwNjRfNGE2YV83</RequestId>

    <BucketName>test-1234567890</BucketName>

https://cloud.tencent.com/document/product/460/42867
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</Response>
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查询智能语音队列
最近更新时间：2023-08-08 14:20:52

本接口用于查询智能语音队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /asrqueue HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述

类

型

是否

必选

queueIds 队列 ID，以“,”符号分割字符串
Str

ing
否

state

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度执行，队列内的所有作

业状态维持在暂停状态，已经执行中的任务不受影响

Str

ing
否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，当指定 pageNumber 和 pageSize 时包含完整节点数据的内容展示

如下：

具体的数据内容如下：

pageNumb

er

第几页，默认值1 Str

ing

否

pageSize 每页个数，默认值10
Str

ing
否

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-asr</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Speeching</Category>

    </QueueList>

</Response>

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 QueueList 的内容：

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

TotalCount
Respons

e
队列总数 Int

PageNumber
Respons

e
当前页数，同请求中的 pageNumber Int

PageSize
Respons

e
每页个数，同请求中的 pageSize Int

QueueList
Respons

e
队列数组

Container 数

组

NonExistPIDs
Respons

e
不存在的队列 ID 列表 String 数组

节点名称（关键字） 父节点 描述 类型

QueueId
Response.QueueLi

st
队列 ID String

Name
Response.QueueLi
st

队列名字 String

State
Response.QueueLi

st
当前状态，Active 或者 Paused String

NotifyConfig
Response.QueueLi

st
回调配置

Contain

er

MaxSize
Response.QueueLi
st

队列最大长度 Int

MaxConcurrent
Response.QueueLi

st
当前队列最大并行执行的任务数 Int

Category Response.QueueLi

st

队列类型 String
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Container 节点 NotifyConfig 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

UpdateTime
Response.QueueLi
st

更新时间 String

CreateTime
Response.QueueLi

st
创建时间 String

节点名称（关键

字）
父节点 描述 类型

Url
Response.QueueList.Notify

Config
回调地址 String

State
Response.QueueList.Notify

Config
开关状态 String

Type
Response.QueueList.Notify

Config
回调类型 String

Event
Response.QueueList.Notify

Config
回调事件 String

ResultFormat
Response.QueueList.Notify

Config
回调类型 String

MqMode
Response.QueueList.Notify

Config
TDMQ 使用模式 String

MqRegion
Response.QueueList.Notify

Config
TDMQ 所属园区 String

MqName
Response.QueueList.Notify

Config
TDMQ 主题名称 String

错误码

实际案例

请求

GET /asrqueue?queueIds=p4a17eeea29334bf499b7e20e2fbfd99d,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <QueueList>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-asr</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:23:11+0800</CreateTime>

        <Category>Speeching</Category>

    </QueueList>

    <NonExistPIDs>A</NonExistPIDs>

    <NonExistPIDs>B</NonExistPIDs>

</Response>
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更新智能语音队列
最近更新时间：2023-08-01 16:46:26

本接口用于更新智能语音的队列。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有以下请求体。

功能描述

请求

请求示例

PUT /asrqueue/<queueId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>My-Queue-asr</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1610 共1950页

具体的数据内容如下：

Container 节点 Request 的内容：

Container 节点 NotifyConfig 的内容：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选 默认值
限

制

Request 无 保存结果的容器
Contain

er
是 无 无

节点名称（关

键字）

父节

点
描述 类型

默

认

值

是否

必选

Name
Req
uest

队列名称，仅支持中文、英文、数字、_、-和
*，长度不超过128

Strin
g

无 是

State
Req

uest

Active 表示队列内的作业会被调度执行

Paused 表示队列暂停，作业不再会被调度

执行，队列内的所有作业状态维持在暂停状

态，已经执行中的任务不受影响

Strin

g
无 是

NotifyConf

ig

Req

uest
回调配置

Cont

ainer
无 是

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否必选

State
Request.No
tifyConfig

回调开关
Off

On

Str
ing

Off 否

Event
Request.No

tifyConfig

回调事件

TaskFinish：任务完成

WorkflowFinish：工作流

完成

Str

ing
无

当 State=On 

时，必选

ResultFor

mat

Request.No

tifyConfig

回调格式

XML

JSON

Str

ing

XM

L

否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。 

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

Type
Request.No

tifyConfig

回调类型

Url

TDMQ

Str

ing
无

当 State=On 

时，必选

Url
Request.No

tifyConfig
回调地址，不能为内网地址。

Str

ing
无

当 
State=On，

且 Type=Url 

时，必选

MqMode
Request.No

tifyConfig

TDMQ 使用模式

Topic：主题订阅

Queue: 队列服务

Str

ing
无

当 

State=On，

且 

Type=TDM
Q 时，必选

MqRegion
Request.No

tifyConfig

TDMQ 所属园区，目前支持园

区 sh（上海）、bj（北京）、

gz（广州）、cd（成都）、hk

（中国香港）

Str

ing
无

当 

State=On，

且 

Type=TDM

Q 时，必选

MqName
Request.No

tifyConfig
TDMQ 主题名称

Str

ing
无

当 
State=On，

且 

Type=TDM

Q 时，必选

响应

响应头

响应体

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-asr</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 Queue 的内容：

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>Speeching</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

Queue Response 队列信息 Container

节点名称（关键字） 父节点 描述 类型

QueueId
Response.Queu

e
队列 ID String

Name
Response.Queu

e
队列名字 String

State
Response.Queu

e
当前状态，Active 或者 Paused String

NotifyConfig
Response.Queu

e

回调配置，同 

Request.NotifyConfig

Contain

er
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

MaxSize Response.Queu

e

队列最大长度 Int

MaxConcurrent
Response.Queu

e
当前队列最大并行执行的任务数 Int

Category
Response.Queu

e
队列类型 String

UpdateTime
Response.Queu

e
更新时间 String

CreateTime
Response.Queu

e
创建时间 String

错误码

实际案例

请求

PUT /asrqueue/p4a17eeea29334bf499b7e20e2fbfd99d HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 162

Content-Type: application/xml

<Request>

    <Name>My-Queue-asr</Name>

    <State>Active</State>

    <NotifyConfig>

        <State>On</State>

        <Url>http://callback.demo.com</Url>

        <Type>Url</Type>

        <Event>TaskFinish,WorkflowFinish</Event>

        <ResultFormat>JSON</ResultFormat>

    </NotifyConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867
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Content-Length: 100

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85

<Response>

    <RequestId>NjJmNDczY2RfOTBmYTUwNjRfNTA4ZV85</RequestId>

    <Queue>

        <QueueId>p4a17eeea29334bf499b7e20e2fbfd99d</QueueId>

        <Name>My-Queue-asr</Name>

        <State>Active</State>

        <NotifyConfig>

            <Url>http://callback.demo.com</Url>

            <Event>TaskFinish,WorkflowFinish</Event>

            <Type>Url</Type>

            <State>On</State>

            <ResultFormat>JSON</ResultFormat>

            <MqMode/>

            <MqName/>

            <MqRegion/>

        </NotifyConfig>

        <MaxSize>10000</MaxSize>

        <MaxConcurrent>10</MaxConcurrent>

        <Category>Speeching</Category>

        <UpdateTime>2022-08-09T16:23:11+0800</UpdateTime>

        <CreateTime>2022-08-09T16:13:05+0800</CreateTime>

    </Queue>

</Response>
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人声分离

提交任务
最近更新时间：2023-08-08 17:34:11

提交一个人声分离任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.${ext}</Object>

            <AuObject>output/audio.${ext}</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Requ

est
创建任务的 Tag：VoiceSeparate

Strin

g
是

Input
Requ

est
待操作的文件信息

Cont

ainer
是

Operation
Requ

est
操作规则

Cont

ainer
是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式

Strin

g
否

CallBackT

ype

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型

Strin

g
否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM

qConfig

Requ

est

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型  的具体数据描述如下：

Container 类型 VoiceSeparate 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateI
d

Request.Operat
ion

人声分离模板 ID String 否

VoiceSepa

rate

Request.Operat

ion
人声分离模板参数

Contai

ner
否

Output
Request.Operat

ion
结果输出配置

Contai

ner
是

JobLevel
Request.Operat
ion

任务优先级，级别限制：0 、1 、2 。
级别越大任务优先级越高，默认为0

String 否

注意

人声分离参数必须设置，可以通过 TemplateId 或 VoiceSeparate 设置， TemplateId 优先级更高。

节点名称（关

键字）
父节点 描述 类型

是否

必选

AudioMod

e

Request.Operation.

VoiceSeparate

同创建人声分离模板接口中的 

Request.AudioMode  

Strin

g
是

AudioConfi

g

Request.Operation.

VoiceSeparate

同创建人声分离模板接口中的 

Request.AudioConfig  

Cont

ainer
是

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Region
Request.Operatio

n.Output
存储桶的地域

Str

ing
是

Bucket Request.Operatio 存储结果的存储桶 Str 是

https://cloud.tencent.com/document/product/460/84500#Request
https://cloud.tencent.com/document/product/460/84500#AudioConfig
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Request.Operation.Output.Object、Request.Operation.Output.AuObject、

Request.Operation.Output.AuObject、Request.Operation.Output.AuObject 支持的通配符如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

n.Output ing

Object
Request.Operatio

n.Output
背景音结果文件名

Str

ing
否

AuObject
Request.Operatio

n.Output
人声结果文件名

Str

ing
否

BassObject
Request.Operatio

n.Output
Bass声结果文件名

Str

ing
否

DrumObject
Request.Operatio

n.Output
鼓声结果文件名

Str

ing
否

注意：

Object、AuObject、BassObject、DrumObject 不可以同时为空

通配符 含义

${ext} 封装格式

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>

                <AuObject>output/audio.${ext}</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId Response.J

obsDetail

新创建任务的 ID String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

Tag
Response.J

obsDetail
新创建任务的 Tag：VoiceSeparate String

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会

变为暂停状态

Cancel：任务被取消执行

String

CreationTi

me

Response.J

obsDetail
任务的创建时间 String

StartTime
Response.J

obsDetail
任务的开始时间 String

EndTime
Response.J

obsDetail
任务的结束时间 String

QueueId
Response.J

obsDetail
任务所属的 队列 ID  String

Input
Response.J

obsDetail
该任务的输入资源地址

Conta

iner

Operation
Response.J

obsDetail
该任务的规则

Conta

iner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关
键字）

父节点 描述 类型

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

TemplateId Response.JobsDet

ail.Operation

任务的模板 ID String

TemplateN

ame

Response.JobsDet

ail.Operation
任务的模板名称, 当 TemplateId 存在时返回 String

VoiceSepar

ate

Response.JobsDet

ail.Operation

同请求中的 

Request.Operation.VoiceSeparate

Conta

iner

Output
Response.JobsDet

ail.Operation
同请求中的 Request.Operation.Output

Conta

iner

MediaInfo
Response.JobsDet

ail.Operation

转码输出视频的信息，任务未完成时不返回，详

见 MediaInfo  

Conta

iner

MediaResul
t

Response.JobsDet
ail.Operation

输出文件的基本信息，任务未完成时不返回，详
见 MediaResult  

Conta
iner

UserData
Response.JobsDet

ail.Operation
透传用户信息 String

JobLevel
Response.JobsDet

ail.Operation
任务优先级 String

错误码

实际案例

请求1：使用人声分离模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.${ext}</Object>

            <AuObject>output/audio.${ext}</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>voiceseparate_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>
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                <AuObject>output/audio.${ext}</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2：使用人声分离参数

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <VoiceSeparate>

            <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

            </AudioConfig>

            <AudioMode>AudioAndBackground</AudioMode>

        </VoiceSeparate>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/backgroud.${ext}</Object>

            <AuObject>output/audio.${ext}</AuObject>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>VoiceSeparate</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <VoiceSeparate>

                <AudioConfig>

                    <Bitrate>500</Bitrate>

                    <Channels>2</Channels>

                    <Codec>mp3</Codec>

                    <Samplerate>44100</Samplerate>

                </AudioConfig>

                <AudioMode>AudioAndBackground</AudioMode>

            </VoiceSeparate>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>

                <AuObject>output/audio.${ext}</AuObject>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>
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    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-08-18 15:28:02

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>
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                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.${ext}</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <JobLevel>0</JobLevel>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交人声分离任务接口中的 

Response.JobsDetail  

Contain

er 数组

节点名称（关键字） 父节点 描述 类型

Key Response.JobsDetail.Input.CosH 自定义 Header 的名 Strin

https://cloud.tencent.com/document/product/460/84794#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

eaders 称 g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>
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                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>
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                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.${ext}</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <JobLevel>0</JobLevel>

            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-07-01T10:12:26+0800</CreationTime>

        <EndTime>2022-07-01T10:12:32+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>video/mp3</Value>
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            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1326515</Value>

            </CosHeaders>

        </Input>

        <JobId>j40644e92f8e311ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format>

                    <Bitrate>128.147000</Bitrate>

                    <Duration>13.688163</Duration>

                    <FormatLongName>MP2/3 (MPEG audio layer 2/3)</FormatLongName>

                    <FormatName>mp3</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>1</NumStream>

                    <Size>219263</Size>

                    <StartTime>0.025057</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>
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                    <Audio>

                        <Bitrate>128.000000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>MP3 (MPEG audio layer 3)</CodecLongName>

                        <CodecName>mp3</CodecName>

                        <CodecTag>0x0000</CodecTag>

                        <CodecTagString>[0][0][0][0]</CodecTagString>

                        <CodecTimeBase>1/14112000</CodecTimeBase>

                        <Duration>13.688163</Duration>

                        <Index>0</Index>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.025057</StartTime>

                        <Timebase>1/14112000</Timebase>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>3b883c0462ba845acdf3eb7e30db1a1c</Md5>

                        <ObjectName>output/audio.mp3</ObjectName>

                    </Md5Info>

                    <Md5Info>

                        <Md5>62de6bb513d6105eeeb1a6ab0077cb5a</Md5>

                        <ObjectName>output/backgroud.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>output/audio.mp3</ObjectName>

                    <ObjectName>output/backgroud.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <AuObject>output/audio.${ext}</AuObject>

                <Bucket>test-123456789</Bucket>

                <Object>output/backgroud.${ext}</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my VoiceSeparate job.</UserData>

            <JobLevel>0</JobLevel>
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            <TemplateId>t1f6ac18da8bdc403fa27ac4ffnd7a6sa1</TemplateId>

            <TemplateName>videoseparate_12654</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-07-01T10:12:27+0800</StartTime>

        <State>Success</State>

        <Tag>VoiceSeparate</Tag>

        <Workflow>

            <Name>VoiceSeparate_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-07-01T10:12:26+0800"

        "EndTime": "2022-07-01T10:12:32+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp3"

            "Region": "ap-chongqing"

            "CosHeaders": 

                    "Key": "Content-Type"

                    "Value": "video/mp3"

                

                

                    "Key": "x-cos-request-id"

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                

                

                    "Key": "EventName"

                    "Value": "cos:ObjectCreated:Put"

                

                

                    "Key": "Size"

                    "Value": "1326515"

                

{

,

[{

,

,

,

{

,

,

,

[{

,

},

{

,

},

{

,

},

{

,

}
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        "JobId": "j40644e92f8e311ecb90d0b03267ce0e5"

        "Operation": 

            "MediaInfo": 

                "Format": 

                    "Bitrate": "128.147000"

                    "Duration": "13.688163"

                    "FormatLongName": "MP2/3 (MPEG audio layer 2/3)"

                    "FormatName": "mp3"

                    "NumProgram": "0"

                    "NumStream": "1"

                    "Size": "219263"

                    "StartTime": "0.025057"

                

                "Stream": 

                    "Audio": 

                            "Bitrate": "128.000000"

                            "Channel": "2"

                            "ChannelLayout": "stereo"

                            "CodecLongName": "MP3 (MPEG audio layer 3)"

                            "CodecName": "mp3"

                            "CodecTag": "0x0000"

                            "CodecTagString": "[0][0][0][0]"

                            "CodecTimeBase": "1/14112000"

                            "Duration": "13.688163"

                            "Index": "0"

                            "SampleFmt": "fltp"

                            "SampleRate": "44100"

                            "StartTime": "0.025057"

                            "Timebase": "1/14112000"

                        

                        

                            "Bitrate": "128.000000"

                            "Channel": "2"

                            "ChannelLayout": "stereo"

                            "CodecLongName": "MP3 (MPEG audio layer 3)"

                            "CodecName": "mp3"

                            "CodecTag": "0x0000"

                            "CodecTagString": "[0][0][0][0]"

                            "CodecTimeBase": "1/14112000"

                            "Duration": "13.688163"

                            "Index": "0"

                            "SampleFmt": "fltp"

                            "SampleRate": "44100"

]

},

,

{

{

{

,

,

,

,

,

,

,

},

{

[{

,

,

,

,

,

,

,

,

,

,

,

,

,

},

{

,

,

,

,

,

,

,

,

,

,

,

,
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                            "StartTime": "0.025057"

                            "Timebase": "1/14112000"

                        

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                            "Md5": "3b883c0462ba845acdf3eb7e30db1a1c"

                            "ObjectName": "output/audio.mp3"

                        

                        

                            "Md5": "62de6bb513d6105eeeb1a6ab0077cb5a"

                            "ObjectName": "output/backgroud.mp3"

                        

                    

                    "ObjectName": 

                        "output/audio.mp3"

                        "output/backgroud.mp3"

                    

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "AuObject": "output/audio.${ext}"

                "Bucket": "test-123456789"

                "Object": "output/backgroud.${ext}"

                "Region": "ap-chongqing"

            

            "UserData": "This is my VoiceSeparate job."

            "JobLevel": 0

            "TemplateId": "t1f6ac18da8bdc403fa27ac4ffnd7a6sa1"

            "TemplateName": "videoseparate_12654"

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-07-01T10:12:27+0800"

        "State": "Success"

        "Tag": "VoiceSeparate"

        "Workflow": 

            "Name": "VoiceSeparate_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

,

}

]

}

},

{

{

,

[{

,

},

{

,

}

],

[

,

],

}

},

{

,

,

,

},

,

,

,

},

,

,

,

,

{

,

,

,
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}

}]

}
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创建模板
最近更新时间：2023-08-08 17:34:11

创建人声分离模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称

（关键

字）

父节

点
描述 类型

是否

必选

Tag

Req

ues

t

模板类型: VoiceSeparate String 是

Name

Req

ues

t

模板名称，仅支持中文、英文、数字、_、-和*，长度不

超过 64
String 是

AudioM

ode

Req

ues

t

输出音频

IsAudio：输出人声

IsBackground：输出背景声

AudioAndBackground：输出人声和背景声

MusicMode：输出人声、背景声、Bass声、鼓声

String 是

AudioC

onfig

Req

ues
t

音频配置
Contain

er
是

AudioConfig

节点名称（关

键字）
父节点 描述

类

型
默认值

是否

必选

Codec
Request.Au

dioConfig

编解码格式，取值 aac、mp3、

flac、amr。当 
Request.AudioMode 为 

MusicMode 时，仅支持 mp3、

wav、acc

Str

ing
aac 否

Samplerat

e

Request.Au

dioConfig

采样率

单位：Hz

Str

ing

44100 否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

可选 8000、11025、22050、

32000、44100、48000、
96000

当 Codec 设置为 aac/flac 

时，不支持 8000

当 Codec 设置为 mp3 时，不

支持 8000 和 96000

当 Codec 设置为 amr 时，只支

持 8000

当 Request.AudioMode 为 

MusicMode 时，该参数无效

Bitrate
Request.Au

dioConfig

音频码率

单位：Kbps

值范围：[8，1000]

当 Request.AudioMode 为 

MusicMode 时，该参数无效

Str

ing

原始音

频码率
否

Channels
Request.Au

dioConfig

声道数

当 Codec 设置为 aac/flac，支

持1、2、4、5、6、8

当 Codec 设置为 mp3，支持

1、2 

当 Codec 设置为 amr，只支持

1

当 Request.AudioMode 为 

MusicMode 时，该参数无效

Str

ing

原始音

频声道

数

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa

te
模板 ID String

Name
Response.Templa

te
模板名称 String

BucketId
Response.Templa
te

模板所属存储桶 String

Category
Response.Templa

te
模板属性，Custom 或者 Official String
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Container 节点 VoiceSeparate 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Tag Response.Templa

te

模板类型，VoiceSeparate String

UpdateTime
Response.Templa
te

更新时间 String

CreateTime
Response.Templa

te
创建时间 String

VoiceSeparate
Response.Templa

te
详细的模板参数

Contain

er

节点名称（关键

字）
父节点 描述 类型

AudioMode
Response.Template.Voic

eSeparate

同请求体中的 

Request.AudioMode
String

AudioConfig
Response.Template.Voic
eSeparate

同请求体中的 
Request.AudioConfig

Contai
ner

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

https://cloud.tencent.com/document/product/460/42867
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    </AudioConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-08 17:34:11

更新人声分离转码模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>2</Channels>

    </AudioConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建人声分离模板接口的 Request  
Contain

er
是

响应

响应头

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

https://cloud.tencent.com/document/product/460/84500#Request
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 同创建人声分离模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>VoiceSeparate</Tag>

    <Name>TemplateName</Name>

    <AudioMode>IsAudio</AudioMode>

    <AudioConfig>

        <Codec>aac</Codec>

        <Samplerate>44100</Samplerate>

        <Bitrate>128</Bitrate>

        <Channels>4</Channels>

    </AudioConfig>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>VoiceSeparate</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84500#Response
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        <Name>TemplateName</Name>

        <VoiceSeparate>

            <AudioMode>IsAudio</AudioMode>

            <AudioConfig>

                <Codec>mp3</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>12</Bitrate>

                <Channels>2</Channels>

            </AudioConfig>

        </VoiceSeparate>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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音频降噪

提交任务
最近更新时间：2023-08-11 17:56:17

提交一个音频降噪任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <NoiseReduction>

            <Format>wav</Format>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <SampleRate>16000</SampleRate>

        </NoiseReduction>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选

Tag
Reques

t
创建任务的 Tag：NoiseReduction

Strin

g
是

Input
Reques

t
待操作的文件信息

Cont

ainer
是

Operation
Reques

t
操作规则

Cont

ainer
是

CallBackFo

rmat

Reques

t

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式

Strin

g
否

CallBackTy

pe

Reques

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级

高于队列的回调类型

Strin

g
否

CallBack
Reques

t

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM

qConfig

Reques

t

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Object

Reque

st.Inpu

t

执行音频降噪任务的文件路径

目前只支持文件大小在10M之内的音频 

如果输入为视频文件或者多通道的音频，只会保留

单通道的音频流 

目前暂不支持m3u8格式输入

Str

ing
是

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateI
d

Request.O
peration

降噪模板ID
Stri
ng

否

NoiseRedu

ction

Request.O

peration

降噪任务参数，同创建降噪模板接口中的 

Request.NoiseReduction  

Con

tain

er

否

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Stri

ng
否

UserData
Request.O
peration

透传用户信息，可打印的 ASCII 码，长度不超过
1024

Stri
ng

否

Output
Request.O

peration
结果输出配置

Con

tain

er

是

说明

降噪参数必须设置，可以通过 TemplateId 或 NoiseReduction 设置， TemplateId 优先级更高。

节点名称（关键字） 父节点 描述 类型 是否必选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket Request.Operation.Out 存储结果的存储桶 Strin 是

https://cloud.tencent.com/document/product/460/94315#NoiseReduction
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

put g

Object
Request.Operation.Out

put
输出结果的文件名

Strin

g
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <NoiseReduction>

                <Format>wav</Format>

                <SampleRate>16000</SampleRate>

            </NoiseReduction>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数
组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.J

obsDetail
新创建任务的 ID String

Tag
Response.J

obsDetail
新创建任务的 Tag：NoiseReduction String

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会

变为暂停状态

Cancel：任务被取消执行

String

CreationTi

me

Response.J

obsDetail
任务的创建时间 String

EndTime
Response.J

obsDetail
任务的结束时间 String
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Container 节点 Input 的内容：

Container 节点 Operation 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

QueueId Response.J

obsDetail

任务所属的 队列 ID  String

Input
Response.J

obsDetail
该任务的输入资源地址

Conta

iner

Operation
Response.J

obsDetail
该任务的操作规则

Conta

iner

节点名称（关键字） 父节点 描述 类型

Region Response.JobsDetail.Input 存储桶的地域 String

Bucket Response.JobsDetail.Input 存储结果的存储桶 String

Object Response.JobsDetail.Input 输出结果的文件名 String

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDetail.Op

eration
降噪模板ID String

TemplateNa

me

Response.JobsDetail.Op

eration

任务的模板名称, 当 TemplateId 存在

时返回
String

NoiseReucti

on

Response.JobsDetail.Op

eration

同请求中的 

Request.Operation.NoiseReduc

tion

Conta

iner

Output
Response.JobsDetail.Op

eration

同请求中的 

Request.Operation.Output

Conta

iner

UserData
Response.JobsDetail.Op

eration
透传用户信息 String

JobLevel
Response.JobsDetail.Op

eration
任务优先级 String

错误码

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/46487
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实际案例

请求1，使用降噪模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd<TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>
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        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd<TemplateId>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求2，使用降噪参数

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Input>

        <Object>input/demo.mp3</Object>

    </Input>

    <Operation>

        <NoiseReduction>

            <Format>wav</Format>

            <SampleRate>16000</SampleRate>

        </NoiseReduction>

        <Output>

            <Region>ap-chongqing</Region>
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            <Bucket>test-123456789</Bucket>

            <Object>output/out.wav</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>NoiseReduction</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <NoiseReduction>

                <Format>wav</Format>

                <SampleRate>16000</SampleRate>

            </NoiseReduction>            

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>
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                <Object>output/out.wav</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-08-14 17:01:45

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

具体的数据内容如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>
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Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

EventName
Respon

se
固定值，为 TaskFinish String

JobsDetail
Respon

se

同提交音频降噪任务接口中的 

Response.JobsDetail  
Container 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

https://cloud.tencent.com/document/product/460/84796#JobsDetail
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    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T18:47:18+0800</CreationTime>

        <EndTime>2022-06-30T18:47:30+0800</EndTime>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>j035aca66f86211ec8a5a87e016101404</JobId>

        <Message>SUCCESS</Message>

        <Operation>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/nr.wav</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <UserData>This is my NoiseReduction job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T18:47:20+0800</StartTime>

        <State>Success</State>

        <Tag>NoiseReduction</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T18:47:18+0800"

        "EndTime": "2022-06-30T18:47:30+0800"

        "Input": 

            "BucketId": "test-123456789"

            "Object": "input/demo.mp3"

            "Region": "ap-chongqing"

        

        "JobId": "j035aca66f86211ec8a5a87e016101404"

        "Message": "SUCCESS"

        "Operation": 

            "Output": 

{

,

[{

,

,

,

{

,

,

},

,

,

{

{
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                "Bucket": "test-123456789"

                "Object": "output/nr.wav"

                "Region": "ap-chongqing"

            

            "UserData": "This is my NoiseReduction job."

            "JobLevel": "0"

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T18:47:20+0800"

        "State": "Success"

        "Tag": "NoiseReduction"

    

,

,

},

,

},

,

,

,

}]

}
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创建模板
最近更新时间：2023-08-01 16:46:27

创建音频降噪模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体。

具体数据描述如下：

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>NoiseReduction</Tag>

    <Name>TemplateName</Name>

    <NoiseReduction>

        <Format>wav</Format>

        <Samplerate>16000</Samplerate>

    </NoiseReduction>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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Container 类型  的具体数据描述如下：

Container 类型 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键

字）

父节

点
描述 类型

是否必

选

Tag
Req

uest
NoiseReduction String 是

Name
Req

uest

模板名称，仅支持中文、英文、数字、_、-和

*，长度不超过 64。
String 是

NoiseReductio

n

Req

uest
降噪参数

Conta

iner
是

NoiseReduction 

节点名称

（关键

字）

父节点 描述
类

型

默

认

值

是否

必选

Format
Request.Noise

Reduction
封装格式，支持 mp3、m4a、wav

Str

ing

w

a

v

否

Sampl

erate

Request.Noise

Reduction

采样率

单位：Hz

可选 8000、12000、16000、

24000、32000、44100、48000

Str

ing

16

0

0

0

否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

        <Tag>NoiseReduction</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>NoiseReduction</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <NoiseReduction>

            <Format>wav</Format>

            <Samplerate>16000</Samplerate>

        </NoiseReduction>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器
Contain

er

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templ

ate
模板 ID String

Name
Response.Templ

ate
模板名称 String

BucketId
Response.Templ

ate
模板所属存储桶 String

Category
Response.Templ

ate
模板属性，Custom 或者 Official String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

Tag Response.Templ

ate

模板类型，NoiseReduction String

UpdateTime
Response.Templ

ate
更新时间 String

CreateTime
Response.Templ

ate
创建时间 String

NoiseReduction
Response.Templ

ate

同请求体中的 

Request.NoiseReduction

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Name>TemplateName</Name>

    <NoiseReduction>

        <SampleRate>16000</SampleRate>

        <Format>wav</Format>

    </NoiseReduction>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

https://cloud.tencent.com/document/product/460/42867
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<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>NoiseReduction</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <NoiseReduction>

            <SampleRate>16000</SampleRate>

            <Format>wav</Format>

        </NoiseReduction>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-14 17:01:45

更新音频降噪模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>NoiseReduction</Tag>

    <Name>TemplateName</Name>

    <NoiseReduction>

        <Format>wav</Format>

        <Samplerate>16000</Samplerate>

    </NoiseReduction>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 同创建音频降噪模板接口的 Request  
Contain

er
是

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>NoiseReduction</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>NoiseReduction</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <NoiseReduction>

            <Format>wav</Format>

            <Samplerate>16000</Samplerate>

        </NoiseReduction>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建音频降噪模板接口的 Response  Container

错误码

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/94315#Request
https://cloud.tencent.com/document/product/460/94315#Response
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实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>NoiseReduction</Tag>

    <Name>TemplateName</Name>

    <NoiseReduction>

        <Format>wav</Format>

        <Samplerate>16000</Samplerate>

    </NoiseReduction>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <Template>

        <Tag>NoiseReduction</Tag>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>NoiseReduction</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <NoiseReduction>

            <Format>wav</Format>

            <Samplerate>16000</Samplerate>

        </NoiseReduction>
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    </Template>

</Response>
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语音合成

提交任务
最近更新时间：2023-08-11 18:10:33

提交一个语音合成任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>

            <Input>床前明月光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型  的具体数据描述如下：

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关
键字）

父节点 描述 类型
是否
必选

Tag
Requ

est
创建任务的 Tag：Tts

Strin

g
是

Operation
Requ

est
操作规则

Cont

ainer
是

CallBackF
ormat

Requ
est

任务回调格式，JSON 或 XML，默认 XML，优先级
高于队列的回调格式

Strin
g

否

CallBackT

ype

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型

Strin

g
否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 

no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM
qConfig

Requ
est

任务回调TDMQ配置，当 CallBackType 为 TDMQ 
时必填。详情见 CallBackMqConfig

Cont
ainer

否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 TtsTpl 的具体数据描述如下：

TemplateId Request.Op
eration

语音合成模板 ID String 否

TtsTpl
Request.Op

eration
语音合成参数

Conta

iner
否

TtsConfig
Request.Op

eration
语音合成任务参数

Conta

iner
是

Output
Request.Op
eration

结果输出配置
Conta
iner

是

UserData
Request.Op

eration

透传用户信息，可打印的 ASCII 码，长度不

超过1024
String 否

JobLevel
Request.Op

eration

任务优先级，级别限制：0 、1 、2 。级别越

大任务优先级越高，默认为0
String 否

注意

 语音合成参数必须设置，可以通过 TemplateId 或 TtsTpl设置， TemplateId 优先级更高。

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Mode
Request.Opera

tion.TtsTpl

同创建语音合成模板接口中的 

Request.Mode  

St
ri

n

g

否

Codec
Request.Opera

tion.TtsTpl

同创建语音合成模板接口中的 

Request.Codec  

St

ri

n

g

否

VoiceType
Request.Opera

tion.TtsTpl

同创建语音合成模板接口中的 

Request.VoiceType  

St

ri

n

g

否

Volume
Request.Opera

tion.TtsTpl

同创建语音合成模板接口中的 

Request.Volume  

St

ri

n
g

否

https://cloud.tencent.com/document/product/460/84499#Request
https://cloud.tencent.com/document/product/460/84499#Request
https://cloud.tencent.com/document/product/460/84499#Request
https://cloud.tencent.com/document/product/460/84499#Request
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Container 类型 TtsConfig 的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

Speed Request.Opera

tion.TtsTpl

同创建语音合成模板接口中的 

Request.Speed  

St

ri

n

g

否

Emotion
Request.Opera
tion.TtsTpl

同创建语音合成模板接口中的 
Request.Emotion  

St

ri
n

g

否

节点名称（关

键字）
父节点 描述 类型

是否

必选

InputType
Request.Operati

on.TtsConfig
输入类型，Url/Text String 是

Input
Request.Operati

on.TtsConfig

当 InputType 为 Url 时， 必须是合

法的 COS 地址，文件必须是utf-8

编码，且大小不超过 10M。如果合成

方式为同步处理，则文件内容不超过 

300 个 utf-8 字符；如果合成方式

为异步处理，则文件内容不超过 
10000 个 utf-8 字符。

当 InputType 为 Text 时, 输入必须

是 utf-8 字符, 且不超过 300 个字

符。

String 是

节点名称（关键字） 父节点 描述 类型
是否必
选

Region
Request.Operation.Out

put
存储桶的地域

Strin

g
是

Bucket
Request.Operation.Out

put
存储结果的存储桶

Strin

g
是

Object
Request.Operation.Out
put

结果文件名
Strin
g

是

响应

响应头

https://cloud.tencent.com/document/product/460/84499#Request
https://cloud.tencent.com/document/product/460/84499#Request
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>床前明月光，疑是地上霜</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点  的内容：

Container 节点 Operation 的内容：

JobsDetail Response 任务的详细信息 Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J

obsDetail
新创建任务的 ID

Stri

ng

Tag
Response.J

obsDetail
新创建任务的 Tag：Tts

Stri

ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Operation
Response.J
obsDetail

该任务的规则

Con

tain
er

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关

键字）
父节点 描述 类型

TemplateId
Response.JobsDeta

il.Operation
任务的模板 ID

Strin

g

TemplateN

ame

Response.JobsDeta

il.Operation
任务的模板名称, 当 TemplateId 存在时返回

Strin

g

TtsTpl
Response.JobsDeta

il.Operation
请求中的 Request.Operation.TtsTpl

Cont

ainer

TtsConfig
Response.JobsDeta

il.Operation
请求中的 Request.Operation.TtsConfig

Cont

ainer

Output
Response.JobsDeta

il.Operation
请求中的 Request.Operation.Output

Cont

ainer

MediaInfo
Response.JobsDeta

il.Operation

输出文件的媒体信息，任务未完成时不返回，详

见 MediaInfo  

Cont

ainer

MediaResul

t

Response.JobsDeta

il.Operation

输出文件的基本信息，任务未完成时不返回，详

见 MediaResult  

Cont

ainer

UserData
Response.JobsDeta

il.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDeta

il.Operation
任务优先级

Strin

g

错误码

实际案例

请求1：使用语音合成模板 ID

POST /jobs HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-si

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Operation>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/49284#MediaInfo
https://cloud.tencent.com/document/product/460/78927#MediaResult
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        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <TtsConfig>

            <Input>床前明月光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>tts_demo</TemplateName>

            <TtsConfig>

                <Input>床前明月光，疑是地上霜</Input>

                <InputType>Text</InputType>
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            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

请求1：使用语音合成参数

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Operation>

        <TtsTpl>

            <Codec>mp3</Codec>

            <Mode>Sync</Mode>

            <Speed>100</Speed>

            <VoiceType>aixiaonan</VoiceType>

            <Volume>0</Volume>

        </TtsTpl>

        <TtsConfig>

            <Input>床前明月光，疑是地上霜</Input>

            <InputType>Text</InputType>

        </TtsConfig>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>demo.mp3</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>
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</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Tts</Tag>

        <Operation>

            <TtsTpl>

                <Codec>mp3</Codec>

                <Mode>Sync</Mode>

                <Speed>100</Speed>

                <VoiceType>aixiaonan</VoiceType>

                <Volume>0</Volume>

            </TtsTpl>

            <TtsConfig>

                <Input>床前明月光，疑是地上霜</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/tts.mp3</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>
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</Response>
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任务回调
最近更新时间：2023-08-14 17:01:45

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>你好，我是爱晓楠，很高兴认识你。</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

            <UserData>This is my Tts job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo
nse

同提交语音合成任务接口中的 
Response.JobsDetail  

Contain
er 数组

节点名称（关键字） 父节点 描述 类型

Key Response.JobsDetail.Input.CosH 自定义 Header 的名 Strin

https://cloud.tencent.com/document/product/460/84797#JobsDetail
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如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

eaders 称 g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>
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                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>你好，我是爱晓楠，很高兴认识你。</Input>

                <InputType>Text</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

            <UserData>This is my tts job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-06-30T19:33:18+0800</CreationTime>

        <EndTime>2022-06-30T19:33:24+0800</EndTime>

        <JobId>j707f4864f86811ecb90d0b03267ce0e5</JobId>

        <Message/>

        <Operation>

            <Input>

                <CosHeaders>

                    <Key>Content-Type</Key>
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                    <Value>application/octet-stream</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>x-cos-request-id</Key>

                    <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>EventName</Key>

                    <Value>cos:ObjectCreated:Put</Value>

                </CosHeaders>

                <CosHeaders>

                    <Key>Size</Key>

                    <Value>265</Value>

                </CosHeaders>

            </Input>

            <MediaInfo>

                <Format/>

                <Stream>

                    <Audio>

                        <CodecName>mp3</CodecName>

                        <SampleRate>16000</SampleRate>

                    </Audio>

                    <Subtitle/>

                    <Video/>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Md5Info>

                        <Md5>5b2ca33cd7357abb1e0ea29f57544df9</Md5>

                        <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    </Md5Info>

                    <ObjectName>/output/aixiaonan.mp3</ObjectName>

                    <ObjectPrefix/>

                    <Region>ap-chongqing</Region>

                </OutputFile>

            </MediaResult>

            <Output>

                <Bucket>test-123456789</Bucket>

                <Object>output/aixiaonan.mp3</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TtsConfig>

                <Input>https://test-123456789.cos.ap-chongqing.myqcloud.com/input/text.txt



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1687 共1950页

                <InputType>Url</InputType>

            </TtsConfig>

            <TemplateId>t1f1ae1dfsdc9ds41dsb31632d457ds6s2a</TemplateId>

            <TemplateName>template_tts</TemplateName>

            <UserData>This is my Tts job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-06-30T19:33:19+0800</StartTime>

        <State>Success</State>

        <Tag>Tts</Tag>

        <Workflow>

            <Name>Tts_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-06-30T19:33:18+0800"

        "EndTime": "2022-06-30T19:33:24+0800"

        "JobId": "j707f4864f86811ecb90d0b03267ce0e5"

        "Operation": 

            "Input": 

                "CosHeaders": 

                        "Key": "Content-Type"

                        "Value": "application/octet-stream"

                    

                    

                        "Key": "x-cos-request-id"

                        "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                    

                    

                        "Key": "EventName"

                        "Value": "cos:ObjectCreated:Put"

                    

                    

{

,

[{

,

,

,

,

{

{

[{

,

},

{

,

},

{

,

},

{
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                        "Key": "Size"

                        "Value": "265"

                    

                

            

            "MediaInfo": 

                "Stream": 

                    "Audio": 

                        "CodecName": "mp3"

                        "SampleRate": "16000"

                    

                

            

            "MediaResult": 

                "OutputFile": 

                    "Bucket": "test-123456789"

                    "Md5Info": 

                        "Md5": "5b2ca33cd7357abb1e0ea29f57544df9"

                        "ObjectName": "/output/aixiaonan.mp3"

                    

                    "ObjectName": "/output/aixiaonan.mp3"

                    "Region": "ap-chongqing"

                

            

            "Output": 

                "Bucket": "test-123456789"

                "Object": "output/aixiaonan.mp3"

                "Region": "ap-chongqing"

            

            "TtsConfig": 

                "Input": "https://test-123456789.cos.ap-chongqing.myqcloud.com/input/text.txt

                "InputType": "Url"

            

            "TemplateId": "t1f1ae1dfsdc9ds41dsb31632d457ds6s2a"

            "TemplateName": "template_tts"

            "UserData": "This is my Tts job."

            "JobLevel": 0

        

        "QueueId": "p2242ab62c7c94486915508540933a2c6"

        "StartTime": "2022-06-30T19:33:19+0800"

        "State": "Success"

        "Tag": "Tts"

        "Workflow": 

            "Name": "Tts_1581665960537"

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f"

,

}

]

},

{

{

[{

,

}

}

},

{

{

,

[{

,

}],

[ ],

}

},

{

,

,

},

{

},

,

,

,

},

,

,

,

,

{

,

,
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            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9"

            "WorkflowName": "workflow-test"

        

    

,

}

}]

}
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创建模板
最近更新时间：2023-08-01 16:46:27

创建语音合成模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>aixiaoxing</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

    <Emotion>arousal</Emotion>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

支持的音色

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关

键字）

父节

点
描述

类

型
默认值

是否

必选

Tag
Req

uest
模板类型：Tts

Str

ing
无 是

Name
Req

uest

模板名称，仅支持中文、英文、数字、

_、-和*，长度不超过 64

Str

ing
无 是

Mode
Req

uest

处理模式

Asyc（异步合成）

Sync（同步合成）

Str

ing
Asyc 否

Codec
Req
uest

音频格式，支持 wav、mp3、pcm 
Str
ing

当 Mode= 

Sync 时， 

默认值为 

wav

当 Mode= 

Asyc 时，

默认值为 

pcm

否

VoiceType
Req

uest
音色，取值和限制介绍请见下表

Str

ing
ruxue 否

Volume
Req

uest
音量，取值范围 [-10,10]

Str

ing
0 否

Speed
Req

uest
语速，取值范围 [50,200]

Str

ing
100 否

Emotion
Req

uest

情绪，不同音色支持的情绪不同，详见

下表

Str

ing
无 否

名称 Voice 参数值 Sync（同步合成） Asyc（异步合成）
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音色说明

茹雪 ruxue 支持 支持

爱小楠 aixiaonan 不支持 支持

爱小星 aixiaoxing 支持 支持

爱小诚 aixiaocheng 支持 支持

爱小雪 aixiaoxue 支持 支持

爱小璐 aixiaolu 支持 支持

爱小栋 aixiaodong 支持 支持

爱小聊 aixiaoliao 不支持 支持

爱小倩 aixiaoqian 支持 支持

爱小阳 aixiaoyang 支持 支持

Alice alice 支持 支持

名称 Voice 参数值 类型 适用场景 支持语言 声音品质

茹雪 ruxue 标准女声 通用场景 中文及中英文混合 标准版

爱小楠 aixiaonan 甜美女声 通用/社交场景 中文及中英文混合 精品版

爱小星 aixiaoxing 元气男声 通用/解说场景 中文及中英文混合 精品版

爱小诚
aixiaochen
g

标准男声 通用场景 中文及中英文混合 标准版

爱小雪 aixiaoxue 标准女声 通用/客服场景 中文及中英文混合 标准版

爱小璐 aixiaolu 阅读女声 通用/有声书场景 中文及中英文混合 标准版

爱小栋 aixiaodong 新闻男声 通用/新闻播报场景 中文及中英文混合 标准版

爱小聊 aixiaoliao 情绪女声 通用/社交场景 中文及中英文混合 精品版

爱小倩 aixiaoqian 元气女声 通用/社交场景 中文及中英文混合 精品版

爱小阳 aixiaoyang 广播男声 通用/新闻播报场景 中文及中英文混合 标准版

Alice alice 英文女声 通用场景 英文 标准版
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音色支持情绪说明

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

名称 Voice 参数值 情绪分类

爱小星 aixiaoxing neutral(中性)、arousal(兴奋)

爱小诚 aixiaocheng neutral(中性)、newscast(广播)

爱小雪 aixiaoxue neutral(中性)、newscast(广播)、customer-service(客服)

爱小璐 aixiaolu neutral(中性)、story(故事)、customer-service(客服)

爱小栋 aixiaodong neutral(中性)、newscast(广播)

爱小阳 aixiaoyang neutral(中性)、newscast(广播)

响应

响应头

响应体

<Response>

    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>aixiaoxing</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

            <Emotion>arousal</Emotion>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

Container节点 TtsTpl 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Templa

te
模板 ID String

Name
Response.Templa

te
模板名称 String

BucketId
Response.Templa
te

模板所属存储桶 String

Category
Response.Templa

te
模板属性，Custom 或者 Official String

Tag
Response.Templa

te
模板类型，Tts String

UpdateTime
Response.Templa
te

更新时间 String

CreateTime
Response.Templa

te
创建时间 String

TtsTpl
Response.Templa

te
详细的模板参数

Contain

er

节点名称（关键字） 父节点 描述

Mode Response.Template.TtsTpl 同请求体中的 Request.Mode
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Codec Response.Template.TtsTpl 同请求体中的 Request.Codec

VoiceType Response.Template.TtsTpl 同请求体中的 Request.VoiceType

Volume Response.Template.TtsTpl 同请求体中的 Request.Volume

Speed Response.Template.TtsTpl 同请求体中的 Request.Speed

Emotion Response.Template.TtsTpl 同请求体中的 Request.Emotion

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

https://cloud.tencent.com/document/product/460/42867
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    <RequestId>NjQ0NGNlNDZfMThhYTk0MGFfY*********</RequestId>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>aixiaoxing</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

            <Emotion>arousal</Emotion>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-14 17:01:45

更新语音合成模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字）
父节

点
描述 类型 是否必选

Request 无 同创建语音合成模板接口的 Request  
Contain

er
是

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建语音合成模板接口的 Response  Container

错误码

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84499#Request
https://cloud.tencent.com/document/product/460/84499#Response
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实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>Tts</Tag>

    <Name>TemplateName</Name>

    <Mode>Sync</Mode>

    <Codec>pcm</Codec>

    <VoiceType>ruxue</VoiceType>

    <Volume>2</Volume>

    <Speed>200</Speed>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>Tts</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <TtsTpl>

            <Mode>Sync</Mode>

            <Codec>pcm</Codec>

            <VoiceType>ruxue</VoiceType>

            <Volume>2</Volume>

            <Speed>200</Speed>

        </TtsTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>
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        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </Template>

</Response>
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语音识别

提交任务
最近更新时间：2023-08-14 17:01:45

提交一个语音识别任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

极速ASR仅支持100 MB以内且时长不超过2小时的音频文件

普通ASR的音频时长不能长于5小时，文件大小不超过512MB

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Requ

est
创建任务的 Tag：SpeechRecognition

Strin

g
是

Input
Requ

est
待操作的对象信息

Cont

ainer
是

Operation
Requ

est
操作规则

Cont

ainer
是

CallBackF

ormat

Requ

est

任务回调格式，JSON 或 XML，默认 XML，优先级

高于队列的回调格式

Strin

g
否

CallBackT

ype

Requ

est

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于

队列的回调类型

Strin

g
否

CallBack
Requ

est

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Strin

g
否

CallBackM

qConfig

Requ

est

任务回调TDMQ配置，当 CallBackType 为 TDMQ 

时必填。详情见 CallBackMqConfig

Cont

ainer
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Input 的具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 Output 的具体数据描述如下：

节点名称（关

键字）
父节点 描述

类

型

是否

必选

Object
Reques

t.Input
文件路径

St

ri

n

g

否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

TemplateI

d

Request.O

peration
语音识别模板 ID

Stri

ng
否

SpeechRe
cognition

Request.O
peration

语音识别参数，同创建语音识别模板接口中的 
Request.SpeechRecognition  

Con

tain
er

否

Output
Request.O

peration
结果输出配置

Con

tain

er

是

UserData
Request.O

peration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Stri

ng
否

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Stri

ng
否

注意

语音识别参数必须设置，可以通过 TemplateId 或 SpeechRecognition 设置， TemplateId 优先级

更高。

节点名称（关键

字）
父节点 描述 类型

是否必

选

Region
Request.Operation.O

utput
存储桶的地域

Stri

ng
是

Bucket Request.Operation.O 存储结果的存储桶 Stri 是

https://cloud.tencent.com/document/product/460/84498#SpeechRecognition
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

utput ng

Object
Request.Operation.O

utput
结果文件的名称

Stri

ng
是

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>speech_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 

数组

JobsDetail 

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

Tag
Response.J

obsDetail
新创建任务的 Tag：SpeechRecognition

Strin

g

State
Response.J

obsDetail

任务状态
Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Strin

g

CreationTi

me

Response.J

obsDetail
任务的创建时间

Strin

g

StartTime
Response.J

obsDetail
任务的开始时间

Strin

g

EndTime Response.J 任务的结束时间 Strin
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Container 节点 Operation 的内容：

Container 节点 SpeechRecognitionResult 的内容：

obsDetail g

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Strin

g

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Cont

ainer

Operation
Response.J

obsDetail
该任务的规则

Cont

ainer

节点名称（关键

字）
父节点 描述 类型

TemplateId
Response.JobsDeta

il.Operation
任务的模板 ID

Strin

g

TemplateName
Response.JobsDeta

il.Operation

任务的模板名称, 当 TemplateId 存在时

返回

Strin

g

SpeechRecogni

tion

Response.JobsDeta

il.Operation

同请求中的 

Request.Operation.SpeechRecog

nition

Cont

ainer

Output
Response.JobsDeta
il.Operation

同请求中的 
Request.Operation.Output

Cont
ainer

UserData
Response.JobsDeta

il.Operation
透传用户信息

Strin

g

JobLevel
Response.JobsDeta

il.Operation
任务优先级

Strin

g

SpeechRecogni

tionResult

Response.JobsDeta

il.Operation
语音识别任务结果，没有时不返回

Cont

ainer

节点名称（关

键字）
父节点 描述 类型

AudioTime

Response.JobsDe

tail.Operation.Spe
echRecognitionRe

sult

音频时长(秒) String

https://cloud.tencent.com/document/product/460/46487
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Container 节点 FlashResult 的内容：

Container 节点 sentence_list 的内容：

Result Response.JobsDe

tail.Operation.Spe

echRecognitionRe

sult

语音识别结果 String

FlashResu

lt

Response.JobsDe
tail.Operation.Spe

echRecognitionRe

sult

极速语音识别结果
Contain

er 数组

ResultDet

ail

Response.JobsDe

tail.Operation.Spe

echRecognitionRe

sult

识别结果详情，包含每个句子中的词时间偏移，

一般用于生成字幕的场景。(语音识别请求中

ResTextFormat=1时该字段不为空)

注意：此字段可能为空，表示取不到有效值。

Contain

er 数组

节点名称（关

键字）
父节点 描述 类型

channel_id

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult

声道标识，从0开始，对应

音频声道数
Int

text

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult

声道音频完整识别结果 String

sentence_

list

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult

句子/段落级别的识别结果

列表

Contain

er 数组

节点名称（关

键字）
父节点 描述 类型

text

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult.sentence_list

句子/段落级别文本 String

start_time

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult.sentence_list

开始时间 Int

end_time Response.JobsDetail.Operation.S 结束时间 Int
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Container 节点 word_list 的内容：

Container 节点 ResultDetail 的内容：

peechRecognitionResult.FlashRes

ult.sentence_list

speaker_i

d

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes

ult.sentence_list

说话人 Id（请求中如果设

置了 

speaker_diarization，

可以按照 speaker_id 来

区分说话人）

Int

word_list

Response.JobsDetail.Operation.S

peechRecognitionResult.FlashRes
ult.sentence_list

词级别的识别结果列表
Contain

er 数组

节点名称（关

键字）
父节点 描述

类

型

word

Response.JobsDetail.Operation.SpeechRe

cognitionResult.FlashResult.sentence_list.
word_list

词级别文本
Str

ing

start_time

Response.JobsDetail.Operation.SpeechRe

cognitionResult.FlashResult.sentence_list.

word_list

开始时间 Int

end_time

Response.JobsDetail.Operation.SpeechRe

cognitionResult.FlashResult.sentence_list.

word_list

结束时间 Int

节点名称（关

键字）
父节点 描述 类型

FinalSente

nce

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai
l

单句最终识别结果 String

SliceSente

nce

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句中间识别结果，使用

空格拆分为多个词
String

StartMs

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句开始时间（毫秒） String
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Container 节点 Words 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

EndMs Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句结束时间（毫秒） String

WordsNu

m

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句中词个数 String

SpeechSp

eed

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句语速，单位：字数/秒 String

SpeakerId

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

声道或说话人 Id（请求中

如果设置了 

speaker_diarization

或者ChannelNum为双

声道，可区分说话人或声
道）

String

Words

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l

单句中词详情
Contain

er 数组

节点名称（关

键字）
父节点 描述

类

型

Word

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l.Words

词文本
Str

ing

OffsetStar

tMs

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai
l.Words

在句子中的开始时间偏移量
Str

ing

OffsetEnd

Ms

Response.JobsDetail.Operation.Sp

eechRecognitionResult.ResultDetai

l.Words

在句子中的结束时间偏移量
Str

ing

错误码

实际案例

请求：使用语音识别模板 ID

https://cloud.tencent.com/document/product/460/42867
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POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>
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        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <TemplateName>speech_demo</TemplateName>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>

请求2：使用语音识别参数

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <SpeechRecognition>

            <EngineModelType>16k_zh_video</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <FilterDirty>1</ChannelNum>

            <FilterModal>1</ChannelNum>

        </SpeechRecognition>

        <Output>

            <Region>ap-chongqing</Region>
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            <Bucket>test-123456789</Bucket>

            <Object>output/asr.txt</Object>

        </Output>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s58ccb634149211ed84ce2b1cd7fbb14a</JobId>

        <Message/>

        <Operation>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>output/asr.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognition>

                <ChannelNum>1</ChannelNum>

                <ConvertNumMode>0</ConvertNumMode>

                <EngineModelType>16k_zh_video</EngineModelType>

                <FilterDirty>0</FilterDirty>
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                <FilterModal>0</FilterModal>

                <FilterPunc>0</FilterPunc>

                <OutputFileType>txt</OutputFileType>

                <ResTextFormat>0</ResTextFormat>

                <SpeakerDiarization>0</SpeakerDiarization>

                <SpeakerNumber>0</SpeakerNumber>

            </SpeechRecognition>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SpeechRecognition</Tag>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-01-31 14:09:55

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <QueueId>pe91d0af11fc14337987ff0c34f8b0886</QueueId>

        <Message/>

        <Operation>

            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒
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                <ResultDetail>

                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>
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                        <OffsetStartMs>3825</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>
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                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>

                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容： 

同提交语音识别任务接口中的 Response.JobsDetail  

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response 任务的详细信息 Container数组

节点名称（关键

字）
父节点 描述 类型

Key
Response.JobsDetail.Input.CosHead

ers

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosHead

ers
自定义 Header 的值

Strin

g

https://cloud.tencent.com/document/product/460/84798#jobsDetail
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节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <QueueId>pe91d0af11fc14337987ff0c34f8b0886</QueueId>

        <Message/>

        <Operation>

            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                <ResultDetail>
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                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>

                        <OffsetStartMs>3825</OffsetStartMs>
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                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>

                    </Words>
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                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>

                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>
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                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

    </JobsDetail>

</Response>

案例 2：通过工作流触发的任务回调

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-09-02T10:25:38+0800</CreationTime>

        <EndTime>2022-09-02T10:25:46+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>minnong.mp3</Object>

            <Region>ap-chongqing</Region>

            <CosHeaders>

                <Key>Content-Type</Key>

                <Value>Audio/mp3</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>x-cos-request-id</Key>

                <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>EventName</Key>

                <Value>cos:ObjectCreated:Put</Value>

            </CosHeaders>

            <CosHeaders>

                <Key>Size</Key>

                <Value>1424687</Value>

            </CosHeaders>

        </Input>

        <JobId>s886c0a7c2a6611ed847a618901112dcf</JobId>

        <Message/>

        <Operation>
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            <UserData>This is my SpeechRecognition job.</UserData>

            <JobLevel>0</JobLevel>

            <Output>

                <Bucket>test-1234567890</Bucket>

                <Object>/example.txt</Object>

                <Region>ap-chongqing</Region>

            </Output>

            <SpeechRecognitionResult>

                <AudioTime>19.7124</AudioTime>

                <DetailObjectName>/example.txt.detail</DetailObjectName>

                <ObjectName>/example.txt</ObjectName>

                <Result>[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                <ResultDetail>

                    <EndMs>19712</EndMs>

                    <FinalSentence>悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    <SliceSentence>悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ， 

                    <SpeakerId>0</SpeakerId>

                    <SpeechSpeed>2.4</SpeechSpeed>

                    <StartMs>3320</StartMs>

                    <Words>

                        <OffsetEndMs>2190</OffsetEndMs>

                        <OffsetStartMs>0</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>悯</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>农</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>2625</OffsetEndMs>

                        <OffsetStartMs>2190</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3060</OffsetEndMs>

                        <OffsetStartMs>2625</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>李</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>
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                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>绅</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>3825</OffsetEndMs>

                        <OffsetStartMs>3060</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5040</OffsetEndMs>

                        <OffsetStartMs>3825</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>锄禾</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>5475</OffsetEndMs>

                        <OffsetStartMs>5040</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>日</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>当午</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>6390</OffsetEndMs>

                        <OffsetStartMs>5475</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7365</OffsetEndMs>

                        <OffsetStartMs>6390</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>汗滴</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>7755</OffsetEndMs>

                        <OffsetStartMs>7365</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>禾</Word>
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                    </Words>

                    <Words>

                        <OffsetEndMs>8130</OffsetEndMs>

                        <OffsetStartMs>7755</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>下</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>土</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>8850</OffsetEndMs>

                        <OffsetStartMs>8130</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>9915</OffsetEndMs>

                        <OffsetStartMs>8850</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>谁知</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>盘中餐</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>11130</OffsetEndMs>

                        <OffsetStartMs>9915</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>，</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12045</OffsetEndMs>

                        <OffsetStartMs>11130</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>粒粒</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>12540</OffsetEndMs>
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                        <OffsetStartMs>12045</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>皆</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>0</VoiceType>

                        <Word>辛苦</Word>

                    </Words>

                    <Words>

                        <OffsetEndMs>14745</OffsetEndMs>

                        <OffsetStartMs>12540</OffsetStartMs>

                        <VoiceType>1</VoiceType>

                        <Word>。</Word>

                    </Words>

                    <WordsNum>22</WordsNum>

                </ResultDetail>

            </SpeechRecognitionResult>

            <TemplateId>t14aea553bb55c468b963fafa472afc538</TemplateId>

            <TemplateName>test</TemplateName>

        </Operation>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <StartTime>2022-09-02T10:25:39+0800</StartTime>

        <State>Success</State>

        <Tag>SpeechRecognition</Tag>

        <Workflow>

            <Name>SpeechRecognition_1581665960537</Name>

            <RunId>ic90edd59f84f11ec9d4f525400a3c59f</RunId>

            <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

            <WorkflowName>workflow-test</WorkflowName>

        </Workflow>

    </JobsDetail>

</Response>

案例 3：通过工作流触发的任务回调, 格式为 JSON

{

    "EventName": "TaskFinish",

    "JobsDetail": [{

        "Code": "Success",

        "CreationTime": "2022-09-02T10:25:38+0800",

        "EndTime": "2022-09-02T10:25:46+0800",

        "Input": {
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            "BucketId": "test-1234567890",

            "Object": "minnong.mp3",

            "Region": "ap-chongqing",

            "CosHeaders": [{

                    "Key": "Content-Type",

                    "Value": "Audio/mp3"

                },

                {

                    "Key": "x-cos-request-id",

                    "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

                },

                {

                    "Key": "EventName",

                    "Value": "cos:ObjectCreated:Put"

                },

                {

                    "Key": "Size",

                    "Value": "1424687"

                }

            ]

        },

        "JobId": "s886c0a7c2a6611ed847a618901112dcf",

        "Operation": {

            "UserData": "This is my SpeechRecognition job.",

            "JobLevel": "0",

            "Output": {

                "Bucket": "test-1234567890",

                "Object": "/example.txt",

                "Region": "ap-chongqing"

            },

            "SpeechRecognitionResult": {

                "AudioTime": "19.7124",

                "DetailObjectName": "/example.txt.detail",

                "ObjectName": "/example.txt",

                "Result": "[0:3.320,0:19.712]  悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒

                "ResultDetail": {

                    "EndMs": "19712",

                    "FinalSentence": "悯农，李绅，锄禾日当午，汗滴禾下土。谁知盘中餐，粒粒皆辛苦。

                    "SliceSentence": "悯 农 ， 李 绅 ， 锄禾 日 当午 ， 汗滴 禾 下 土 。 谁知 盘中餐 ，

                    "SpeakerId": "0",

                    "SpeechSpeed": "2.4",

                    "StartMs": "3320",

                    "Words": [{

                            "OffsetEndMs": "2190",

                            "OffsetStartMs": "0",
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                            "VoiceType": "0",

                            "Word": "悯"

                        },

                        {

                            "OffsetEndMs": "2625",

                            "OffsetStartMs": "2190",

                            "VoiceType": "0",

                            "Word": "农"

                        },

                        {

                            "OffsetEndMs": "2625",

                            "OffsetStartMs": "2190",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "3060",

                            "OffsetStartMs": "2625",

                            "VoiceType": "0",

                            "Word": "李"

                        },

                        {

                            "OffsetEndMs": "3825",

                            "OffsetStartMs": "3060",

                            "VoiceType": "0",

                            "Word": "绅"

                        },

                        {

                            "OffsetEndMs": "3825",

                            "OffsetStartMs": "3060",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "5040",

                            "OffsetStartMs": "3825",

                            "VoiceType": "0",

                            "Word": "锄禾"

                        },

                        {

                            "OffsetEndMs": "5475",

                            "OffsetStartMs": "5040",

                            "VoiceType": "0",

                            "Word": "日"

                        },
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                        {

                            "OffsetEndMs": "6390",

                            "OffsetStartMs": "5475",

                            "VoiceType": "0",

                            "Word": "当午"

                        },

                        {

                            "OffsetEndMs": "6390",

                            "OffsetStartMs": "5475",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "7365",

                            "OffsetStartMs": "6390",

                            "VoiceType": "0",

                            "Word": "汗滴"

                        },

                        {

                            "OffsetEndMs": "7755",

                            "OffsetStartMs": "7365",

                            "VoiceType": "0",

                            "Word": "禾"

                        },

                        {

                            "OffsetEndMs": "8130",

                            "OffsetStartMs": "7755",

                            "VoiceType": "0",

                            "Word": "下"

                        },

                        {

                            "OffsetEndMs": "8850",

                            "OffsetStartMs": "8130",

                            "VoiceType": "0",

                            "Word": "土"

                        },

                        {

                            "OffsetEndMs": "8850",

                            "OffsetStartMs": "8130",

                            "VoiceType": "1",

                            "Word": "。"

                        },

                        {

                            "OffsetEndMs": "9915",

                            "OffsetStartMs": "8850",
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                            "VoiceType": "0",

                            "Word": "谁知"

                        },

                        {

                            "OffsetEndMs": "11130",

                            "OffsetStartMs": "9915",

                            "VoiceType": "0",

                            "Word": "盘中餐"

                        },

                        {

                            "OffsetEndMs": "11130",

                            "OffsetStartMs": "9915",

                            "VoiceType": "1",

                            "Word": "，"

                        },

                        {

                            "OffsetEndMs": "12045",

                            "OffsetStartMs": "11130",

                            "VoiceType": "0",

                            "Word": "粒粒"

                        },

                        {

                            "OffsetEndMs": "12540",

                            "OffsetStartMs": "12045",

                            "VoiceType": "0",

                            "Word": "皆"

                        },

                        {

                            "OffsetEndMs": "14745",

                            "OffsetStartMs": "12540",

                            "VoiceType": "0",

                            "Word": "辛苦"

                        },

                        {

                            "OffsetEndMs": "14745",

                            "OffsetStartMs": "12540",

                            "VoiceType": "1",

                            "Word": "。"

                        }

                    ],

                    "WordsNum": "22"

                }

            },

            "TemplateId": "t14aea553bb55c468b963fafa472afc538",

            "TemplateName": "test"
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        },

        "QueueId": "p2242ab62c7c94486915508540933a2c6",

        "StartTime": "2022-09-02T10:25:39+0800",

        "State": "Success",

        "Tag": "SpeechRecognition",

        "Workflow": {

            "Name": "SpeechRecognition_1581665960537",

            "RunId": "ic90edd59f84f11ec9d4f525400a3c59f",

            "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

            "WorkflowName": "workflow-test"

        }

    }]

}
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创建模板
最近更新时间：2023-08-01 16:46:27

创建语音识别模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>2</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型  的具体数据描述如下：

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键

字）

父节

点
描述 类型

是否必

选

Tag
Req

uest
模板类型：SpeechRecognition String 是

Name
Req

uest

模板名称，仅支持中文、英文、数字、_、-和

*，长度不超过 64
String 是

SpeechRecog

nition

Req

uest
语音识别参数

Conta

iner
是

SpeechRecognition

节点名称（关

键字）
父节点 描述

类

型

默

认

值

是否

必选

FlashAsr
Request. 
SpeechRe

cognition

开启极速ASR，取值 true/false

St
ri

n

g

fal

se
否

EngineMo

delType

Request.

SpeechRe

cognition

引擎模型类型，分为电话场景和非电话场

景。

电话场景：

8k_zh：电话 8k 中文普通话通用（可

用于双声道音频）

8k_zh_s：电话 8k 中文普通话话者分

离（仅适用于单声道音频）

St

ri

n

g

无 是
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 非电话场景：

8k_en：电话 8k 英语

 6k_zh：16k 中文普通话通用

16k_zh_video：16k 音视频领域

16k_en：16k 英语

16k_ca：16k 粤语

16k_ja：16k 日语

16k_zh_edu：中文教育

16k_en_edu：英文教育

16k_zh_medical：医疗

16k_th：泰语

16k_zh_dialect：多方言，支持23种
方言

极速 ASR 支持8k_zh、16k_zh、

16k_en、16k_zh_video、

16k_zh_dialect、16k_ms（马来

语）、16k_zh-PY（中英粤）

ChannelN

um

Request. 

SpeechRe

cognition

语音声道数：

1 表示单声道。EngineModelType为
非电话场景仅支持单声道

2 表示双声道（仅支持 8k_zh 引擎模

型 双声道应分别对应通话双方）

仅支持非极速ASR，为非极速ASR时，

该参数必填

St

ri

n

g

无 否

ResTextFo

rmat

Request. 

SpeechRe

cognition

识别结果返回形式：

0：识别结果文本（含分段时间戳）

1：词级别粒度的详细识别结果，不含标

点，含语速值（词时间戳列表，一般用于

生成字幕场景）

2：词级别粒度的详细识别结果（包含标

点、语速值）

3：标点符号分段，包含每段时间戳，特

别适用于字幕场景（包含词级时间、标

点、语速值）

仅支持非极速ASR

St

ri

n

g

无 否

FilterDirty Request. 

SpeechRe

cognition

是否过滤脏词（目前支持中文普通话引擎）

0：不过滤脏词

1：过滤脏词

2：将脏词替换为 *

St

ri

n

g

0 否
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FilterModa

l

Request. 

SpeechRe

cognition

是否过滤语气词（目前支持中文普通话引
擎）：

0 表示不过滤语气词

1 表示部分过滤

2 表示严格过滤 

St

ri

n

g

0 否

ConvertNu
mMode

Request. 
SpeechRe

cognition

是否进行阿拉伯数字智能转换（目前支持中

文普通话引擎）

0：不转换，直接输出中文数字

1：根据场景智能转换为阿拉伯数字

3 ：打开数学相关数字转换

仅支持非极速ASR

St

ri
n

g

0 否

SpeakerDi
arization

Request. 

SpeechRe
cognition

是否开启说话人分离

0：不开启

1：开启(仅支持8k_zh，16k_zh，

16k_zh_video，单声道音频)

8k电话场景建议使用双声道来区分通话

双方，设置ChannelNum=2即可，不

用开启说话人分离。

St

ri
n

g

0 否

SpeakerN

umber

Request. 

SpeechRe

cognition

说话人分离人数（需配合开启说话人分离

使用），取值范围：[0, 10]

0 代表自动分离（目前仅支持≤6个人）

1-10代表指定说话人数分离

仅支持非极速ASR

St

ri

n
g

0 否

FilterPunc

Request. 

SpeechRe

cognition

是否过滤标点符号（目前支持中文普通话引

擎）

0：不过滤。

1：过滤句末标点

2：过滤所有标点

St

ri

n

g

0 否

OutputFile

Type

Request. 

SpeechRe

cognition

输出文件类型，可选txt、srt

极速ASR仅支持txt

非极速Asr且ResTextFormat为3时

仅支持txt

St

ri

n

g

txt 否

Format Request. 

SpeechRe

cognition

极速ASR音频格式，支持 wav、pcm、

ogg-opus、speex、silk、mp3、

m4a、aac
极速ASR时，该参数必填

St

ri

n
g

无 否
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

FirstChan

nelOnly

Request. 

SpeechRe

cognition

是否识别首个声道

0：识别所有声道

1：识别首个声道

仅支持极速ASR

St

ri

n

g

1 否

WordInfo

Request. 

SpeechRe

cognition

是否显示词级别时间戳
0：不显示

1：显示，不包含标点时间戳

2：显示，包含标点时间戳

仅支持极速ASR

St

ri

n

g

0 否

Sentence
MaxLengt

h

Request. 
SpeechRe

cognition

单标点最多字数，取值范围：[6，40]

默认值为 0 表示不开启该功能

该参数可用于字幕生成场景，控制单行字
幕最大字数

当FlashAsr为false时，仅

ResTextFormat为3时参数有效

St

ri
n

g

0 否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <Tag>SpeechRecognition</Tag>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>2</ChannelNum>

            <ResTextFormat>1</ResTextFormat>

            <FilterDirty>0</FilterDirty>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点  的内容：

Container 节点  的内容：

            <FilterModal>1</FilterModal>

            <ConvertNumMode>0</ConvertNumMode>

            <SpeakerDiarization>1</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <OutputFileType>txt</OutputFileType>

            <SentenceMaxLength>0</SentenceMaxLength>

        </SpeechRecognition>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

Template Response 保存模板详情的容器 Container

RequestId Response 请求的唯一 ID String

Template

节点名称（关键字） 父节点 描述 类型

TemplateId
Response.Tem

plate
模板 ID String

Name
Response.Tem

plate
模板名称 String

BucketId
Response.Tem

plate
模板所属存储桶 String

Category
Response.Tem

plate
模板属性，Custom 或者 Official String

Tag
Response.Tem

plate
模板类型，SpeechRecognition String

UpdateTime
Response.Tem

plate
更新时间 String
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

CreateTime Response.Tem

plate

创建时间 String

SpeechRecognit

ion

Response.Tem

plate

同请求体中的 

Request.SpeechRecognition

Contain

er

错误码

实际案例

请求

POST /template HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>1</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

        <SentenceMaxLength>0</SentenceMaxLength>

    </SpeechRecognition>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

https://cloud.tencent.com/document/product/460/42867
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Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

            <SentenceMaxLength>0</SentenceMaxLength>

        </SpeechRecognition>

    </Template>

</Response>
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更新模板
最近更新时间：2023-08-14 17:01:46

更新语音识别模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

PUT /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>1</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1742 共1950页

具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

节点名称（关键字） 父节点 描述 类型 必选

Request 无 同创建语音识别模板接口的 Request  
Containe

r
是

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84498#Request
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具体的数据内容如下：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

        </SpeechRecognition>

    </Template>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 同创建语音合成模板接口的 Response  Container

错误码

实际案例

请求

PUT /template/t1460606b9752148c4ab182f55163ba7cd HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 1666

Content-Type: application/xml

<Request>

    <Tag>SpeechRecognition</Tag>

    <Name>TemplateName</Name>

    <SpeechRecognition>

        <EngineModelType>16k_zh</EngineModelType>

        <ChannelNum>1</ChannelNum>

        <ResTextFormat>1</ResTextFormat>

        <FilterDirty>0</FilterDirty>

        <FilterModal>1</FilterModal>

        <ConvertNumMode>0</ConvertNumMode>

        <SpeakerDiarization>1</SpeakerDiarization>

        <SpeakerNumber>0</SpeakerNumber>

        <FilterPunc>0</FilterPunc>

        <OutputFileType>txt</OutputFileType>

    </SpeechRecognition>

</Request>

响应

HTTP/1.1 200 OK

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84498#Response
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Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <Template>

        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        <Name>TemplateName</Name>

        <State>Normal</State>

        <Tag>SpeechRecognition</Tag>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <SpeechRecognition>

            <EngineModelType>16k_zh</EngineModelType>

            <ChannelNum>1</ChannelNum>

            <ResTextFormat>0</ResTextFormat>

            <FilterDirty>1</FilterDirty>

            <FilterModal>0</FilterModal>

            <ConvertNumMode>1</ConvertNumMode>

            <SpeakerDiarization>0</SpeakerDiarization>

            <SpeakerNumber>0</SpeakerNumber>

            <FilterPunc>0</FilterPunc>

        </SpeechRecognition>

    </Template>

</Response>
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听歌识曲

提交任务
最近更新时间：2023-08-17 11:05:46

提交一个听歌识曲任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Tag>SoundHound</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称

（关键字）

父节

点
描述 类型

是否必

选

Tag

Req

ues

t

创建任务的 Tag：SoundHound String 是

Input

Req

ues

t

待操作的对象信息
Contai

ner
是

Operation

Req

ues

t

操作规则
Contai

ner
是

CallBackF

ormat

Req

ues

t

任务回调格式，JSON 或 XML，默认 XML，优先

级高于队列的回调格式
String 否

CallBackT

ype

Req

ues

t

任务回调类型，Url 或 TDMQ，默认 Url，优先级高

于队列的回调类型
String 否

CallBack
Req
ues

t

任务回调地址，优先级高于队列的回调地址。设置为 
no 时，表示队列的回调地址不产生回调

String 否

CallBack

MqConfig

Req

ues

t

任务回调TDMQ配置，当 CallBackType 为 

TDMQ 时必填。详情见 CallBackMqConfig

Contai

ner
否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig
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Container 类型 Operation 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

节点名称（关
键字）

父节点 描述
类
型

是否
必选

UserData
Request.

Operation

透传用户信息，可打印的 ASCII 码，长度不超过

1024

St

ri

n

g

否

JobLevel
Request.
Operation

任务优先级，级别限制：0 、1 、2 。级别越大任务优
先级越高，默认为0

St

ri
n

g

否

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s03f2ff944ece11edb780e50b111e7626</JobId>

        <Message/>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SoundHound</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息
Container 数

组

JobsDetail

节点名称（关

键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义 String

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义 String

JobId
Response.J

obsDetail
新创建任务的 ID String

Tag
Response.J

obsDetail
新创建任务的 Tag：SoundHound String

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务

会变为暂停状态

Cancel：任务被取消执行

String
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Container 节点 Operation 的内容：

Container 节点 SoundHoundResult 的内容：

Container 节点 SongList 的内容：

CreationTi
me

Response.J
obsDetail

任务的创建时间 String

StartTime
Response.J

obsDetail
任务的开始时间 String

EndTime
Response.J

obsDetail
任务的结束时间 String

QueueId
Response.J
obsDetail

任务所属的 队列 ID  String

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Contai

ner

Operation
Response.J

obsDetail
该任务的规则

Contai

ner

节点名称（关键字） 父节点 描述 类型

UserData
Response.JobsDetail.Op

eration
透传用户信息 String

JobLevel
Response.JobsDetail.Op

eration
任务优先级 String

SoundHoundRe

sult

Response.JobsDetail.Op

eration

听歌识曲任务结果，没有时不返

回

Contai

ner

节点名称（关键

字）
父节点 描述 类型

SongList
Response.JobsDetail.Operation.Sound

HoundResult

识别结果详

情

Container 

数组

节点名称（关键

字）
父节点 描述 类型

Inlier
Response.JobsDetail.Operation.SoundHoundR
esult.SongList

识别置信
度

Int

https://cloud.tencent.com/document/product/460/46487
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

SingerName Response.JobsDetail.Operation.SoundHoundR

esult.SongList

歌手姓名 Stri

ng

SongName
Response.JobsDetail.Operation.SoundHoundR

esult.SongList
歌曲名

Stri

ng

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Tag>SoundHound</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON<CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1751 共1950页

        <Code>Success</Code>

        <CreationTime>2021-08-05T15:43:50+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s03f2ff944ece11edb780e50b111e7626</JobId>

        <Message/>

        <Operation>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>SoundHound</Tag>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-08-17 11:05:46

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-10-18T18:22:05+0800</CreationTime>

        <EndTime>2022-10-18T18:22:10+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>sb6b64de84ece11eda7ff3f95cf53fd82</JobId>

        <Message/>

        <Operation>

            <JobLevel>1</JobLevel>

            <SoundHoundResult>

                <SongList>

                    <Inlier>0.98</Inlier>

                    <SingerName>周杰伦</SingerName>

                    <SongName>青花瓷</SongName>

                </SongList>

            </SoundHoundResult>

            <UserData>This is my SoundHound job.</UserData>

        </Operation>

        <QueueId>p4986e06c00fe4ead808bd7e4942089e1</QueueId>

        <StartTime>2022-10-18T18:22:06+0800</StartTime>

        <State>Success</State>

        <Tag>SoundHound</Tag>

    </JobsDetail>

</Response>
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具体的数据内容如下：

Container 节点 Response 的内容：

如果任务是通过工作流触发的，Response.JobsDetail.Input 还会包含 CosHeaders 节点，类型为 

Container 数组。

Container 节点 CosHeaders 的内容：

如果任务是通过工作流触发的，Response.JobsDetail 还会包含 Workflow 节点，类型为 Container。

Container 节点 Workflow 的内容：

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

EventName
Respo

nse
固定值，为 TaskFinish String

JobsDetail
Respo

nse

同提交听歌识曲任务接口中的 

Response.JobsDetail  

Container 

数组

节点名称（关键字） 父节点 描述 类型

Key
Response.JobsDetail.Input.CosH

eaders

自定义 Header 的名

称

Strin

g

Value
Response.JobsDetail.Input.CosH

eaders
自定义 Header 的值

Strin

g

节点名称（关键字） 父节点 描述 类型

RunId Response.Workflow 工作流实例 ID String

WorkflowId Response.Workflow 工作流 ID String

WorkflowName Response.Workflow 工作流名称 String

Name Response.Workflow 工作流节点名称 String

实际案例

案例 1：通过任务接口触发的任务回调

https://cloud.tencent.com/document/product/460/84795#JobsDetail
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<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2022-10-18T18:22:05+0800</CreationTime>

        <EndTime>2022-10-18T18:22:10+0800</EndTime>

        <Input>

            <BucketId>test-1234567890</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>sb6b64de84ece11eda7ff3f95cf53fd82</JobId>

        <Message/>

        <Operation>

            <JobLevel>1</JobLevel>

            <SoundHoundResult>

                <SongList>

                    <Inlier>0.98</Inlier>

                    <SingerName>周杰伦</SingerName>

                    <SongName>青花瓷</SongName>

                </SongList>

            </SoundHoundResult>

            <UserData>This is my SoundHound job.</UserData>

        </Operation>

        <QueueId>p4986e06c00fe4ead808bd7e4942089e1</QueueId>

        <StartTime>2022-10-18T18:22:06+0800</StartTime>

        <State>Success</State>

        <Tag>SoundHound</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName": "TaskFinish"

    "JobsDetail": 

        "Code": "Success"

        "CreationTime": "2022-10-18T18:22:05+0800"

        "EndTime": "2022-10-18T18:22:10+0800"

        "Input": 

            "BucketId": "test-1234567890"

            "Object": "input/test.mp3"

            "Region": "ap-chongqing"

        

{

,

[{

,

,

,

{

,

,

},
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        "JobId": "sb6b64de84ece11eda7ff3f95cf53fd82"

        "Operation": 

            "JobLevel": "1"

            "SoundHoundResult": 

                "SongList": 

                    "Inlier": "98"

                    "SingerName": "周杰伦"

                    "SongName": "青花瓷"

                

            

            "UserData": "This is my SoundHound job."

        

        "QueueId": "p4986e06c00fe4ead808bd7e4942089e1"

        "StartTime": "2022-10-18T18:22:06+0800"

        "State": "Success"

        "Tag": "SoundHound"

    

,

{

,

{

{

,

,

,

}

},

},

,

,

,

}]

}
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音乐评分
提交任务
最近更新时间：2023-08-08 17:34:01

提交一个音乐评分任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部 文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明：

Authorization: Auth String（详情请参见 请求签名  文档）

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情 文档

请求头

请求体

<Request>

    <Tag>VocalScore</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <VocalScore>

            <StandardObject>input/base.mp3</StandardObject>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

        </VocalScore>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Tag
Req

uest
创建任务的 Tag：VocalScore

Stri

ng
是

Input
Req

uest
待操作的对象信息

Con

tain

er

是

Operation
Req

uest
操作规则

Con

tain

er

是

CallBackF

ormat

Req

uest

任务回调格式，JSON 或 XML，默认 XML，优先级高

于队列的回调格式

Stri

ng
否

CallBackT
ype

Req
uest

任务回调类型，Url 或 TDMQ，默认 Url，优先级高于队
列的回调类型

Stri
ng

否

CallBack
Req

uest

任务回调地址，优先级高于队列的回调地址。设置为 no 

时，表示队列的回调地址不产生回调

Stri

ng
否

CallBackM

qConfig

Req

uest

任务回调TDMQ配置，当 CallBackType 为 TDMQ 时

必填。详情见 CallBackMqConfig 

Con

tain

er

否

节点名称（关 父节点 描述 类 是否

https://cloud.tencent.com/document/product/460/78927#CallBackMqConfig


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1758 共1950页

Container 类型  的具体数据描述如下：

Container 类型 VocalScore 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部 文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

键字） 型 必选

Object

Reque

st.Inpu
t

文件路径

St

ri

n
g

否

Operation

节点名称（关

键字）
父节点 描述 类型

是否

必选

VocalScor
e

Request.O
peration

音乐评分参数配置
Con
tain

er

是

UserData
Request.O

peration

透传用户信息, 可打印的 ASCII 码, 长度不超过

1024

Stri

ng
否

JobLevel
Request.O

peration

任务优先级，级别限制：0 、1 、2 。级别越大任

务优先级越高，默认为0

Stri

ng
否

节点名称（关

键字）
父节点 描述

类

型

是否

必选

StandardO

bject

Request.O

peration
比对基准文件路径

Str

ing
否

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2000-07-18T10:54:49+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点  的内容：

            <BucketId>test-1234567890</BucketId>

            <Object>test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s76520462251611eeb22df1c8c02341ac</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <VocalScore>

                <StandardObject>test.mp3</StandardObject>

            </VocalScore>

        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>VocalScore</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

JobsDetail

节点名称（关
键字）

父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Stri

ng

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Stri

ng

JobId
Response.J
obsDetail

新创建任务的 ID
Stri
ng
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Container 节点 Operation 的内容：

Tag Response.J

obsDetail

新创建任务的 Tag：VocalScore Stri

ng

State
Response.J

obsDetail

任务状态

Submitted：已提交，待执行

Running：执行中

Success：执行成功

Failed：执行失败

Pause：任务暂停，当暂停队列时，待执行的任务会变

为暂停状态

Cancel：任务被取消执行

Stri

ng

CreationTi

me

Response.J

obsDetail
任务的创建时间

Stri

ng

StartTime
Response.J

obsDetail
任务的开始时间

Stri

ng

EndTime
Response.J

obsDetail
任务的结束时间

Stri

ng

QueueId
Response.J

obsDetail
任务所属的 队列 ID  

Stri

ng

Input
Response.J

obsDetail
同请求中的 Request.Input 节点

Con

tain

er

Operation
Response.J

obsDetail
该任务的规则

Con

tain

er

节点名称（关键

字）
父节点 描述 类型

UserData
Response.JobsDetail.Op

eration
透传用户信息 String

JobLevel
Response.JobsDetail.Op
eration

任务优先级 String

VocalScore
Response.JobsDetail.Op

eration

同请求中的 

Request.Operation.VocalS

core

Contai

ner

https://cloud.tencent.com/document/product/460/46487
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Container 节点 VocalScoreResult 的内容：

Container 节点 PitchScore 的内容：

Container 节点 SentenceScores 的内容：

VocalScoreRes

ult

Response.JobsDetail.Op

eration

音乐评分任务结果，没有时不返

回

Contai

ner

节点名称（关键

字）
父节点 描述 类型

PitchScore
Response.JobsDetail.Operation.VocalS

coreResult

音调评分结果详

情

Contai

ner

RhythemScore
Response.JobsDetail.Operation.VocalS

coreResult

节奏评分结果详

情

Contai

ner

节点名称（关键

字）
父节点 描述 类型

SentenceSc
ores

Response.JobsDetail.Operation.VocalScore
Result.PitchScore

句子评分
详情

Container 
数组

TotalScore
Response.JobsDetail.Operation.VocalScore

Result.PitchScore
音调总分 Int

节点名称（关
键字）

父节点 描述
类
型

StartTime
Response.JobsDetail.Operation.VocalScoreResult.Pitch

Score.SentenceScores

句子开

始时间

F

l

o

a

t

EndTime
Response.JobsDetail.Operation.VocalScoreResult.Pitch

Score.SentenceScores

句子结

束时间

F
l

o

a

t

Score
Response.JobsDetail.Operation.VocalScoreResult.Pitch

Score.SentenceScores

句子评

分

I

n

t
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Container 节点 RhythemScore 的内容：

Container 节点 SentenceScores 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码 文档。

节点名称（关键

字）
父节点 描述 类型

SentenceSco

res

Response.JobsDetail.Operation.VocalScor

eResult.RhythemScore

句子评分

详情

Containe

r 数组

TotalScore
Response.JobsDetail.Operation.VocalScor

eResult.RhythemScore
音调总分 Int

节点名称（关

键字）
父节点 描述

类

型

StartTime
Response.JobsDetail.Operation.VocalScoreResult.Rhyt

hemScore.SentenceScores

句子开

始时间

F
l

o

a

t

EndTime
Response.JobsDetail.Operation.VocalScoreResult.Rhyt

hemScore.SentenceScores

句子结

束时间

F

l

o
a

t

Score
Response.JobsDetail.Operation.VocalScoreResult.Rhyt

hemScore.SentenceScores

句子评

分

I

n

t

错误码

实际案例

请求

POST /jobs HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1763 共1950页

<Request>

    <Tag>VocalScore</Tag>

    <Input>

        <Object>input/test.mp3</Object>

    </Input>

    <Operation>

        <VocalScore>

            <StandardObject>base.mp3</StandardObject>

        </VocalScore>

        <UserData>This is my data.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-07-18T16:14:36+0800</CreationTime>

        <EndTime>-</EndTime>

        <Input>

            <BucketId>testpic-1253960454</BucketId>

            <Object>input/test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s229aa658254311eeaf90856735d7e87d</JobId>

        <Message/>

        <Operation>

            <JobLevel>0</JobLevel>

            <VocalScore>

                <StandardObject>test.mp3</StandardObject>

            </VocalScore>
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        </Operation>

        <QueueId>pcd463e1467964d39ad2d3f66aacd8199</QueueId>

        <StartTime>-</StartTime>

        <State>Submitted</State>

        <Tag>VocalScore</Tag>

    </JobsDetail>

</Response>
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任务回调
最近更新时间：2023-08-18 15:28:01

数据万象支持自定义设置回调 URL，在任务完成后，系统向该 URL 发送 HTTP POST 请求，请求体中包含通知

内容。您可通过配置的回调地址及时了解任务处理的进展和状态，以便进行其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，包含完整节点数据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-07-18T16:14:36+0800</CreationTime>

        <EndTime>2023-07-18T16:15:54+0800</EndTime>

        <Input>

            <BucketId>testpic-1253960454</BucketId>

            <Object>test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s229aa658254311eeaf90856735d7e87d</JobId>

        <Message>Success</Message>

        <Operation>

            <JobLevel>0</JobLevel>

            <VocalScore>

                    <StandardObject>test.mp3</StandardObject>

                    <StandardUrl/>

            </VocalScore>

            <VocalScoreResult>

                <PitchScore>

                    <SentenceScores>

                            <EndTime>200.811</EndTime>

                            <Score>100</Score>

                            <StartTime>0.572727</StartTime>

                    </SentenceScores>

                    <SentenceScores>

                            <EndTime>210.4</EndTime>

                            <Score>100</Score>

                            <StartTime>200.811</StartTime>

                    </SentenceScores>
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具体的数据内容如下：

Container 节点 Response 的内容：

                    <TotalScore>100</TotalScore>

                </PitchScore>

                <RhythemScore>

                    <SentenceScores>

                        <EndTime>200.811</EndTime>

                        <Score>100</Score>

                        <StartTime>0.572727</StartTime>

                    </SentenceScores>

                    <SentenceScores>

                        <EndTime>210.4</EndTime>

                        <Score>100</Score>

                        <StartTime>200.811</StartTime>

                    </SentenceScores>

                    <TotalScore>100</TotalScore>

                </RhythemScore>

            </VocalScoreResult>

        </Operation>

        <QueueId>p6617fd4048fa41faxxxxxxxxxxxx</QueueId>

        <QueueType>Speeching</QueueType>

        <StartTime>2023-07-18T16:14:37+0800</StartTime>

        <State>Success</State>

        <Tag>VocalScore</Tag>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 TaskFinish String

JobsDetail Response
同提交音乐评分任务接口中的 

Response.JobsDetail  

Contain

er 数组

实际案例

案例 1：通过任务接口触发的任务回调

<Response>

https://cloud.tencent.com/document/product/460/96095#JobsDetail
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    <EventName>TaskFinish</EventName>

    <JobsDetail>

        <Code>Success</Code>

        <CreationTime>2023-07-18T16:14:36+0800</CreationTime>

        <EndTime>2023-07-18T16:15:54+0800</EndTime>

        <Input>

            <BucketId>testpic-1253960454</BucketId>

            <Object>test.mp3</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <JobId>s229aa658254311eeaf90856735d7e87d</JobId>

        <Message>Success</Message>

        <Operation>

            <JobLevel>0</JobLevel>

            <VocalScore>

                    <StandardObject>test.mp3</StandardObject>

                    <StandardUrl/>

            </VocalScore>

            <VocalScoreResult>

                <PitchScore>

                    <SentenceScores>

                            <EndTime>200.811</EndTime>

                            <Score>100</Score>

                            <StartTime>0.572727</StartTime>

                    </SentenceScores>

                    <SentenceScores>

                            <EndTime>210.4</EndTime>

                            <Score>100</Score>

                            <StartTime>200.811</StartTime>

                    </SentenceScores>

                    <TotalScore>100</TotalScore>

                </PitchScore>

                <RhythemScore>

                    <SentenceScores>

                        <EndTime>200.811</EndTime>

                        <Score>100</Score>

                        <StartTime>0.572727</StartTime>

                    </SentenceScores>

                    <SentenceScores>

                        <EndTime>210.4</EndTime>

                        <Score>100</Score>

                        <StartTime>200.811</StartTime>

                    </SentenceScores>

                    <TotalScore>100</TotalScore>

                </RhythemScore>
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            </VocalScoreResult>

        </Operation>

        <QueueId>p6617fd4048fa41faxxxxxxxxxxxx</QueueId>

        <QueueType>Speeching</QueueType>

        <StartTime>2023-07-18T16:14:37+0800</StartTime>

        <State>Success</State>

        <Tag>VocalScore</Tag>

    </JobsDetail>

</Response>

案例 2：通过任务接口触发的任务回调, 格式为 JSON

    "EventName":"TaskFinish"

    "JobsDetail":

        "Code":"Success"

        "CreationTime":"2023-07-18T16:14:36+0800"

        "EndTime":"2023-07-18T16:15:54+0800"

        "Input":

            "BucketId":"testpic-1253960454"

            "Object":"test.mp3"

            "Region":"ap-chongqing"

        

        "JobId":"s229aa658254311eeaf90856735d7e87d"

        "Message":"Success"

        "Operation":

            "JobLevel":"0"

            "VocalScore":

                "StandardObject":"test.mp3"

                "StandardUrl":""

            

            "VocalScoreResult":

                "PitchScore":

                    "SentenceScores":

                        

                            "EndTime":"200.811"

                            "Score":"100"

                            "StartTime":"0.572727"

                        

                        

                            "EndTime":"210.4"

                            "Score":"100"

                            "StartTime":"200.811"

                        

{

,

[{

,

,

,

{

,

,

},

,

,

{

,

{

,

},

{

{

[

{

,

,

},

{

,

,

}



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1769 共1950页

                    

                    "TotalScore":"100"

                

                "RhythemScore":

                    "SentenceScores":

                        

                            "EndTime":"200.811"

                            "Score":"100"

                            "StartTime":"0.572727"

                        

                        

                            "EndTime":"210.4"

                            "Score":"100"

                            "StartTime":"200.811"

                        

                    

                    "TotalScore":"100"

                

            

        

        "QueueId":"p6617fd4048fa41faxxxxxxxxxxxx"

        "QueueType":"Speeching"

        "StartTime":"2023-07-18T16:14:37+0800"

        "State":"Success"

        "Tag":"VocalScore"

    

],

},

{

[

{

,

,

},

{

,

,

}

],

}

}

},

,

,

,

,

}]

}
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任务与工作流

工作流接口

创建工作流
最近更新时间：2023-08-17 17:55:43

创建工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

对于输入的视频文件进行截图和转码处理。视频转码后, 同时进行转封装处理和生成智能封面, 然后对生成的封

面进行图片处理。

功能描述

请求

请求示例

POST /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求体1 请求体2

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCove

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteOb

                        </Output>
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                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>
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具体数据描述如下：

Container 类型  的具体数据描述如下：

Container 类型 MediaWorkflow 的具体数据描述如下：

Container 类型  的具体数据描述如下：

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

Request

节点名称（关键字） 父节点 描述 类型 是否必选

MediaWorkflow Request 工作流节点 Container 是

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

Name
Request.Medi

aWorkflow

工作

流名

称

Stri

ng
是

支持中文、英文、数字、—和_，

长度限制128字符

State
Request.Medi

aWorkflow

工作

流状

态

Stri

ng
否 Paused/Active

Topology
Request.Medi

aWorkflow

拓扑

信息

Con

tain

er

是 无

Topology

节点名称（关键

字）
父节点 描述 类型

是否必

选
限制

Dependencies Request.MediaWor 节点依赖关 Contai 是 无
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Container 类型 Nodes 的具体数据描述如下：

kflow.Topology 系 ner

Nodes
Request.MediaWor

kflow.Topology
节点列表

Contai

ner
是 无

节点名称（关键

字）
父节点 描述 类型

是

否

必
选

限制

Start

Request.Medi

aWorkflow.

Topology.Nod

es

开始节点

Con

tain

er

是 只有唯一一个开始节点

Animation_**
*

Request.Medi

aWorkflow.
Topology.Nod

es

动图类型节
点

Con

tain
er

否
节点名称以 Animation 为
前缀，可能有多个动图节点

Snapshot_**

*

Request.Medi

aWorkflow.

Topology.Nod

es

截图类型节

点

Con

tain

er

否
节点名称以 Snapshot 为

前缀，可能有多个截图节点

SmartCover

_***

Request.Medi
aWorkflow.

Topology.Nod

es

智能封面节

点

Con
tain

er

否
节点名称以 SmartCover 
为前缀，可能有多个智能封

面节点

Transcode_*

**

Request.Medi

aWorkflow.

Topology.Nod

es

转码节点

Con

tain

er

否
节点名称以 Transcode 为

前缀，可能有多个转码节点

Concat_***

Request.Medi

aWorkflow.

Topology.Nod

es

音视频拼接

节点

Con

tain

er

否

节点名称以 Concat 为前

缀，可能有多个音视频拼接

节点

VoiceSepara

te_***

Request.Medi

aWorkflow.

Topology.Nod

es

人声节点

Con

tain

er

否

节点名称以 

VoiceSeparate 为前缀，

可能有多个人声分离节点



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1775 共1950页

VideoMonta

ge_***

Request.Medi

aWorkflow.

Topology.Nod

es

精彩集锦节

点

Con

tain

er

否 节点名称以 

VideoMontage 为前缀，

可能有多个精彩集锦节点

StreamPack

Config_***

Request.Medi
aWorkflow.

Topology.Nod

es

自适应码流

节点

Con

tain

er

否

节点名称以 

StreamPackConfig 为
前缀，只能有一个 自适应码

流节点。只能在 start 节点

之后，后面只能是视频子流

节点，可以有多个视频子流

节点

VideoStream
_***

Request.Medi

aWorkflow.
Topology.Nod

es

视频子流节
点

Con
tain

er

否

节点名称以 VideoStream 

为前缀，可能有多个视频子

流节点 ，只能在 
StreamPackConfig 节

点之后，后面只能是 

StreamPack 节点

StreamPack

_***

Request.Medi

aWorkflow.

Topology.Nod

es

自适应码流

打包节点

Con

tain

er

否

节点名称以 StreamPack 

为前缀，只能有一个自适应

码流打包节点 ，只能在视频

子流节点之后，后面只能是 
End 节点

SDRtoHDR_*

**

Request.Medi

aWorkflow.

Topology.Nod

es

SDRtoHD

R 节点

Con

tain

er

否

节点名称以 SDRtoHDR 

为前缀，可能有多个 

SDRtoHDR 节点

VideoProces
s_***

Request.Medi

aWorkflow.
Topology.Nod

es

视频处理节
点

Con

tain
er

否

节点名称以 

VideoProcess 为前缀，
可能有多个视频处理节点

SCF_***

Request.Medi

aWorkflow.

Topology.Nod

es

SCF 函数节

点

Con

tain

er

否
节点名称以 SCF 为前缀，

可能有多个 SCF 函数节点

SuperResolu

tion_***

Request.Medi
aWorkflow.

Topology.Nod

es

超分辨率节

点

Con
tain

er

否

节点名称以 
SuperResolution 为前

缀，可能有多个超分辨率节

点

Segment_*** Request.Medi 音视频转封 Con 否 节点名称以 Segment 为
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aWorkflow.

Topology.Nod

es

装节点 tain

er

前缀，可能有多个音视频转

封装节点

PicProcess_

***

Request.Medi

aWorkflow.

Topology.Nod

es

图片处理节

点

Con

tain

er

否

节点名称以 PicProcess 

为前缀，可能有多个图片处

理节点

Tts_***

Request.Medi

aWorkflow.

Topology.Nod
es

语音合成节

点

Con

tain

er

否
节点名称以 Tts 为前缀，可

能有多个语音合成节点

SpeechReco

gnition_***

Request.Medi

aWorkflow.

Topology.Nod

es

语音识别节

点

Con

tain

er

否

节点名称以 

SpeechRecognition 为

前缀，可能有多个语音识别

节点

VideoEnhan
ce_***

Request.Medi

aWorkflow.
Topology.Nod

es

画质增强节
点

Con

tain
er

否

节点名称以 

VideoEnhance 为前缀，
可能有多个语音识别节点

Condition_**

*

Request.Medi

aWorkflow.

Topology.Nod

es

条件判断节

点

Con

tain

er

否

节点名称以 Condition 为

前缀，可能有多个条件判断

节点

MediaInfo_**

*

Request.Medi
aWorkflow.

Topology.Nod

es

媒体信息获

取节点

Con
tain

er

否
节点名称以 MediaInfo 为
前缀，可能有多个媒体信息

获取节点

AIRecognitio

n_***

Request.Medi

aWorkflow.

Topology.Nod

es

AI识别节点

Con

tain

er

否
节点名称以 

AIRecognition 为前缀

SegmentVid

eoBody_***

Request.Medi

aWorkflow.

Topology.Nod

es

视频人像抠

图节点

Con

tain

er

否

节点名称以 

SegmentVideoBody 为

前缀

NoiseReduct

ion_***

Request.Medi

aWorkflow.

音频降噪节

点

Con

tain

er

否 节点名称以 

NoiseReduction 为前缀
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Container 类型 Start 的具体数据描述如下：

Container 类型 Animation_*** 的具体数据描述如下：

Container 类型 Snapshot_*** 的具体数据描述如下：

Topology.Nod

es

FileInfo_***

Request.Medi

aWorkflow.

Topology.Nod

es

文件信息节

点

Con

tain

er

否
节点名称以 FileInfo 为前

缀

ImageInspec

t_***

Request.Medi
aWorkflow.

Topology.Nod

es

异常图片检

测节点 

Con

tain

er

否
节点名称以 

ImageInspect 为前缀

节点名称

（关键字）
父节点 描述 类型

是否

必选

限

制

Type
Request.MediaWorkflow.T

opology.Nodes.Start
节点类型 String 是

St

art

Input
Request.MediaWorkflow.T

opology.Nodes.Start

输入信息，详情见 

Input  

Contai

ner
是 无

节点名称

（关键

字）

父节点 描述 类型
是否

必选
限制

Type

Request.MediaWorkflo

w.

Topology.Nodes.Anima

tion_***

节点类型
Strin

g
是

Ani

mati

on

Operatio

n

Request.MediaWorkflo

w.

Topology.Nodes.Anima

tion_***

操作规则，详情见 

Animation  

Cont

ainer
是 无

节点名称
（关键字）

父节点 描述 类型
是否
必选

限制

Type Request.MediaWorkflo 节点类型 String 是 Snapsh

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Start_Input
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Animation_Operation
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Container 类型 SmartCover_*** 的具体数据描述如下：

Container 类型 Transcode_*** 的具体数据描述如下：

w.

Topology.Nodes.Snap

shot_***

ot

Operatio

n

Request.MediaWorkflo
w.

Topology.Nodes.Snap

shot_***

操作规则，详情见 

Snapshot  

Conta

iner
是 无

节点名称

（关键

字）

父节点 描述 类型
是否

必选
限制

Type

Request.MediaWorkflo

w.

Topology.Nodes.Smart

Cover_***

节点类型
Strin

g
是

Smart

Cover

Operati

on

Request.MediaWorkflo

w.

Topology.Nodes.Smart
Cover_***

操作规则，详情见 

SmartCover  

Cont

ainer
是 无

节点名称

（关键

字）

父节点 描述 类型
是否

必选
限制

Type

Request.MediaWorkflo

w.

Topology.Nodes.Trans

code_***

节点类型 String 是
Trans

code

Operatio

n

Request.MediaWorkflo

w.

Topology.Nodes.Trans

code_***

操作规则，详情见 

Transcode  

Contai

ner
是 无

Input

Request.MediaWorkflo

w.

Topology.Nodes.Trans

code_***

输入配置
Contai

ner
否 无

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Snapshot_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SmartCover_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Transcode_Operation
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Container 类型 MediaWorkflow_Topology_Nodes_Transcode_***_Operation.Input 的具体数据描

述如下：

Container 类型 Concat_*** 的具体数据描述如下：

Container 类型 VoiceSeparate_*** 的具体数据描述如下：

Container 类型 VideoMontage_*** 的具体数据描述如下：

节点名称（关键字） 描述 类型 必选 限制

SpeedTranscodingQueueId 倍速转码队列 String 否 无

节点名称
（关键字）

父节点 描述 类型
是否
必选

限制

Type

Request.MediaWor

kflow.

Topology.Nodes.C

oncat_***

节点类型 String 是 Concat

Operation

Request.MediaWor

kflow.
Topology.Nodes.C

oncat_***

操作规则，详情见 
Concat  

Contai
ner

是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必
选

限制

Type

Request.MediaWorkflow.

Topology.Nodes.VoiceSe

parate_***

节点类型
Strin

g
是

VoiceSepa

rate

Operati

on

Request.MediaWorkflow.

Topology.Nodes.VoiceSe

parate_***

操作规则，详情

见 

VoiceSepar
ate  

Cont

ainer
是 无

节点名称

（关键

字）

父节点 描述 类型
是否

必选
限制

Type Request.MediaWorkflo
w.

节点类型 Strin
g

是 VideoM
ontage

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Concat_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VoiceSeparate_Operation
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Container 类型 StreamPackConfig_*** 的具体数据描述如下：

Container 类型 VideoStream_*** 的具体数据描述如下：

Container 类型 StreamPack_*** 的具体数据描述如下：

Topology.Nodes.Vide

oMontage_***

Operati

on

Request.MediaWorkflo

w.

Topology.Nodes.Vide

oMontage_***

操作规则，详情见 

VideoMontage  

Cont

aine

r

是 无

节点名

称（关

键字）

父节点 描述 类型

是

否

必

选

限制

Type

Request.MediaWorkflow
.

Topology.Nodes.Stream

PackConfig_***

节点类型 String 是
StreamPack

Config

Operat

ion

Request.MediaWorkflow

.

Topology.Nodes.Stream

PackConfig_***

操作规则，详情

见 

StreamPack

Config  

Contai

ner
是 无

节点名称

（关键

字）

父节点 描述 类型

是

否

必

选

限制

Type

Request.MediaWork
flow.

Topology.Nodes.Vid

eoStream_***

节点类型
Strin

g
是

VideoStrea

m

Operati

on

Request.MediaWork

flow.

Topology.Nodes.Vid

eoStream_***

操作规则，详情见 

VideoStream  

Cont

ainer
是 无

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoMontage_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_StreamPackConfig_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoStream_Operation
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Container 类型 SDRtoHDR_*** 的具体数据描述如下：

Container 类型 VideoProcess_*** 的具体数据描述如下：

Container 类型 SCF_*** 的具体数据描述如下：

Type

Request.MediaWor

kflow.

Topology.Nodes.Str
eamPack_***

节点类型
Strin

g
是

Stream

Pack

Operation

Request.MediaWor

kflow.

Topology.Nodes.Str

eamPack_***

操作规则，详情见 

StreamPack  

Cont

aine

r

是 无

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

Type

Request.MediaWork

flow.

Topology.Nodes.SD

RtoHDR_***

节点类型
Strin

g
是

SDRt

oHD

R

Operation

Request.MediaWork
flow.

Topology.Nodes.SD

RtoHDR_***

操作规则，详情见 

SDRtoHDR  

Cont

ainer
是 无

节点名称

（关键
字）

父节点 描述 类型
是否

必选
限制

Type

Request.MediaWorkflow.

Topology.Nodes.VideoPr

ocess_***

节点类型 String 是
VideoPro

cess

Operati

on

Request.MediaWorkflow.

Topology.Nodes.VideoPr
ocess_***

操作规则，详

情见 

VideoProce
ss  

Contai

ner
是 无

节点名称

（关键字）

父节点 描述 类型 是

否

限制

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_StreamPack_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SDRtoHDR_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoProcess_Operation
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Container 类型 SuperResolution_*** 的具体数据描述如下：

Container 类型 Segment_*** 的具体数据描述如下：

Container 类型 PicProcess_*** 的具体数据描述如下：

必

选

Type

Request.MediaWorkflow

.

Topology.Nodes.SCF_**

*

节点类型 String 是 SCF

Operation

Request.MediaWorkflow
.

Topology.Nodes.SCF_**

*

操作规则，详情见 

SCF  

Contain

er
是 无

节点名

称（关

键字）

父节点 描述 类型
是否必

选
限制

Type

Request.MediaWorkflow.

Topology.Nodes.SuperR

esolution_***

节点类型 String 是

SuperR

esolutio

n

Operat

ion

Request.MediaWorkflow.

Topology.Nodes.SuperR

esolution_***

操作规则，详情

见 

SuperResolu
tion  

Contai

ner
是 无

节点名称

（关键字）
父节点 描述 类型

是

否

必

选

限制

Type

Request.MediaWorkflow.

Topology.Nodes.Segment_

***

节点类型
Strin

g
是

Segmen

t

Operatio

n

Request.MediaWorkflow.

Topology.Nodes.Segment_

***

操作规则，详

情见 

Segment  

Cont

ainer
是 无

节点名称 父节点 描述 类型 是 限制

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SCF_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SuperResolution_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Segment_Operation
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Container 类型 Tts_*** 的具体数据描述如下：

Container 类型 SpeechRecognition_*** 的具体数据描述如下：

Container 类型 VideoEnhance_*** 的具体数据描述如下：

（关键

字）

否

必

选

Type

Request.MediaWorkflow.

Topology.Nodes.PicProces
s_***

节点类型
Strin
g

是
PicProc
ess

Operatio

n

Request.MediaWorkflow.

Topology.Nodes.PicProces

s_***

操作规则，详情

见 

PicProcess  

Cont

ainer
是 无

节点名称

（关键字）
父节点 描述 类型

是否

必选
限制

Type
Request.MediaWorkflow.

Topology.Nodes.Tts_***
节点类型 String 是 Tts

Operation
Request.MediaWorkflow.

Topology.Nodes.Tts_***

操作规则，详

情见 Tts  

Contai

ner
是 无

节点名称

（关键字）
父节点 描述 类型

是

否

必

选

限制

Type

Request.MediaWork

flow.
Topology.Nodes.Sp

eechRecognition_***

节点类型
Stri
ng

是
SpeechRecog
nition

Operatio

n

Request.MediaWork

flow.

Topology.Nodes.Sp

eechRecognition_***

操作规则，详情见 

SpeechRecog

nition  

Con

tain

er

是 无

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

Type Request.MediaWork 节点类型 Stri 是 VideoE

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_PicProcess_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Tts_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SpeechRecognition_Operation
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Container 类型 Condition_*** 的具体数据描述如下：

Container 类型 MediaInfo_*** 的具体数据描述如下：

Container 类型 FileInfo_*** 的具体数据描述如下：

flow.

Topology.Nodes.Vid
eoEnhance_***

ng nhance

Operation

Request.MediaWork

flow.

Topology.Nodes.Vid

eoEnhance_***

操作规则，详情见 

VideoEnhance  

Con

tain

er

是 无

节点名称（关键

字）
父节点 描述 类型

是否

必选
限制

Type

Request.MediaWor

kflow.

Topology.Nodes.C

ondition_***

节点类型 String 是

Con

ditio

n

Operation

Request.MediaWor

kflow.

Topology.Nodes.C

ondition_***

操作规则，详情见 

Condition  

Conta

iner
是 无

节点名称（关键字） 父节点 描述 类型
是否必

选
限制

Type

Request.MediaWorkflow.

Topology.Nodes.MediaIn

fo_***

节点类

型

Stri

ng
是

MediaIn

fo

节点名称（关键
字）

父节点 描述 类型
是否
必选

限制

Type

Request.MediaWor

kflow.

Topology.Nodes.Fil

eInfo_***

节点类型
Strin

g
是

FileI

nfo

Operation Request.MediaWor

kflow.

操作规则，详情见 

FileInfo  

Cont

ainer

是 无

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_VideoEnhance_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_Condition_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_FileInfo
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Container 类型 AIRecognition_*** 的具体数据描述如下：

Container 类型 SegmentVideoBody_*** 的具体数据描述如下：

Container 类型 NoiseReduction_*** 的具体数据描述如下：

Container 类型 ImageInspect_*** 的具体数据描述如下：

Topology.Nodes.Fil

eInfo_***

节点名称（关键

字）
父节点 描述 类型

是否

必选
限制

Type

Request.MediaWorkflow.

Topology.Nodes.AIRecog

nition_***

节点类

型

Stri

ng
是

AIRecogn

ition

节点名称
（关键字）

父节点 描述 类型

是

否
必

选

限制

Type

Request.MediaWorkf

low.

Topology.Nodes.Seg

mentVideoBody_***

节点类型 String 是
SegmentVi

deoBody

Operation

Request.MediaWorkf

low.

Topology.Nodes.Seg

mentVideoBody_***

操作规则，详情见 

SegmentVide

oBody  

Conta

iner
是 无

节点名称（关

键字）
父节点 描述 类型

是否

必选
限制

Type

Request.MediaWorkf

low.

Topology.Nodes.Noi

seReduction_***

节点类型
Stri

ng
是

NoiseR

eductio

n

Operation

Request.MediaWorkf

low.

Topology.Nodes.Noi
seReduction_***

操作规则，详情见 

NoiseReduction  

Con

tain
er

是 无

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_SegmentVideoBody_Operation
https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_NoiseReduction_Operation
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工作流节点依赖关系如下：

节点名称（关

键字）

父节点 描述 类型 是否

必选

限制

Type

Request.MediaWork
flow.

Topology.Nodes.Ima

geInspect_***

节点类型
Stri

ng
是

ImageIn

spect

Operation

Request.MediaWork

flow.

Topology.Nodes.Ima

geInspect_***

操作规则，详情见 

ImageInspect  

Con

tain

er

是 无

工作流节点类型 后面可连接的节点类型

Start

Snapshot,Animation,SmartCover,Transcode,Concat,VoiceSeparate,Vi

deoMontage,StreamPackConfig,SDRtoHDR,VideoProcess,SCF,Super

Resolution,Segment,PicProcess,Tts,SpeechRecognition,VideoEnhanc

e,MediaInfo,AIRecognition,VideoEnhance,SegmentVideoBody,NoiseR
eduction,FileInfo

Snapshot PicProcess,SCF,FileInfo,End

Animation PicProcess,SCF,FileInfo,End

SmartCover PicProcess,SCF,FileInfo,End

Transcode

Snapshot,Animation,SmartCover,Concat,VideoMontage,SDRtoHDR,Vi

deoProcess,SCF,Segment,SpeechRecognition,VideoEnhance,MediaI
nfo,SegmentVideoBody,NoiseReduction,FileInfo,End

Concat

Transcode,Snapshot,Animation,SmartCover,SDRtoHDR,VideoProces

s,SCF,Segment,VideoEnhance,MediaInfo,SegmentVideoBody,NoiseR

eduction,FileInfo,End

VoiceSeparat

e
SCF,SpeechRecognition,End

VideoMontag

e

Snapshot,Animation,SDRtoHDR,VideoProcess,SCF,SuperResolution,

VideoEnhance,Segment,MediaInfo,SegmentVideoBody,NoiseReducti

on,FileInfo,End

StreamPackC

onfig
VideoStream

VideoStream StreamPack

https://cloud.tencent.com/document/product/460/78927#MediaWorkflow_Topology_Nodes_ImageInspect_Operation
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StreamPack End

SDRtoHDR
Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animati

on,VideoProcess,SCF,SuperResolution,SegmentVideoBody,End

VideoProcess

Transcode,Concat,VideoMontage,VoiceSeparate,SmartCover,Animati

on,SDRtoHDR,SCF,Segment,SuperResolution,MediaInfo,SegmentVid

eoBody,End

SCF
SDRtoHDR,Snapshot,Transcode,Concat,VideoMontage,VoiceSeparat

e,SmartCover,Animation,VideoProcess,End

SuperResoluti

on

VideoMontage,Transcode,SmartCover,Animation,Snapshot,SCF,Seg

ment,SDRtoHDR,VideoProcess,MediaInfo,SegmentVideoBody,End

Segment VideoEnhance,SegmentVideoBody,End

PicProcess SCF,PicProcess,FileInfo,End

Tts SCF,Transcode,FileInfo,End

SpeechRecog

nition
SCF,Tts,End

VideoEnhanc

e

Transcode,VideoMontage,SmartCover,Animation,Snapshot,SCF,Seg

ment,SpeechRecognition,VoiceSeparate,MediaInfo,FileInfo,End

MediaInfo Condition,End

FileInfo Condition,End

Condition

Transcode,SuperResolution,VideoProcess,Animation,Snapshot,Video

Montage,SmartCover,Concat,VideoEnhance,SpeechRecognition,Voic

eSeparate,Segment,SDRtoHDR,SCF,End

NoiseReducti
on

Transcode,Segment,MediaInfo,Concat,SpeechRecognition,FileInfo,SC
F,End

AIRecognition End

SegmentVide

oBody
FileInfo,End

ImageInspect End

说明

当 Condition 类型节点前为 FileInfo 类型节点时，后续能连接的节点根据 FileInfo 前置的节点能连
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工作流支持的通配符：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点  的内容：

接的节点来判断（FileInfo 、 MediInfo 类型除外，Condition 类型节点后续不能连接 FileInfo 、 

MediaInfo 节点）。

通配符 含义

${InputPath} 输入文件的路径(不包括文件名)

${InputName} 输入文件的文件名(不包括后缀)

${InputNameAndE

xt}
输入文件的文件名(包括后缀)

${RunId} 实例 Id

${Ext} 封装格式后缀

${Jobid} 任务Id

${Number} 产物索引, 从0开始计数，仅支持 Snapshot、SmartCover、Segment 节点

${Time} 截图时间点(单位:毫秒)，仅支持 Snapshot 节点

响应

响应头

响应体

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

Response

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

MediaWorkflow Response 工作流数组 Container

https://cloud.tencent.com/document/product/460/42866
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Container节点 MediaWorkflow 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

对于输入的视频文件进行截图和转码处理。视频转码后, 同时进行转封装处理和生成智能封面, 然后对生成的封

面进行图片处理。

节点名称（关键

字）
父节点 描述 类型

Name
Response.Medi

aWorkflow
工作流名称 String

WorkflowId
Response.Medi

aWorkflow
工作流 ID String

State
Response.Medi

aWorkflow
工作流状态 String

CreateTime
Response.Medi

aWorkflow
创建时间 String

UpdateTime
Response.Medi

aWorkflow
更新时间 String

Topology
Response.Medi

aWorkflow

拓扑信息，同请求中的 

Request.MediaWorkflow.Topology

Contai

ner

错误码

实际案例

请求1 响应1 请求2 响应2

POST /workflow HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR***

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

https://cloud.tencent.com/document/product/460/42867
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            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_15

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCove

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteOb

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>
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                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>
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        </Topology>

    </MediaWorkflow>

</Request>
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查询工作流
最近更新时间：2023-06-20 17:32:16

查询工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /workflow HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关键字） 描述 类型 是否必选

ids 工作流 ID，以 , 符号分割字符串 string 否

name 工作流名称 string 否

pageNumber 第几页 string 否

pageSize 每页个数 string 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZiZTFfOTBmYTUwNjRfNjVmNl8x</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

https://cloud.tencent.com/document/product/460/42866
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                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

{ }

{ }
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                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

{ }

{ }
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                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Object>

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>
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具体的数据内容如下：

Container 节点 Response 的内容：

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 工作流总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int
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Container节点 MediaWorkflowList 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

PageSize Response 每页个数，同请求中的 pageSize Int

MediaWorkflowList Response 工作流数组 Container

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

限制

Name
Response.Media

WorkflowList

工作流

名称

St

ri

n

g

是
支持中文、英文、数字、—和_，长

度限制128字符

Workflo

wId

Response.Media

WorkflowList

工作流 

ID

St

ri

n

g

是 工作流唯一 ID

State
Response.Media

WorkflowList

工作流

状态

St

ri

n

g

是
1. Active 

2. Paused

CreateTi

me

Response.Media

WorkflowList

创建时

间

St

ri

n
g

是 无

UpdateT

ime

Response.Media

WorkflowList

更新时

间

St

ri

n

g

是 无

Topolog

y

Response.Media

WorkflowList

拓扑信

息

C

o
nt

ai

n

er

是 同创建工作流接口的 Topology  

错误码
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实际案例

请求1：工作流 ID

GET /workflow?ids=wc666d0b9f9dd47ae9137a096252d49f7,A,B HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

        <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce
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                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

{ }
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                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <NonExistIDs>A</NonExistIDs>

    <NonExistIDs>B</NonExistIDs>

</Response>

{ }

{ }

{ }

请求2：工作流列表

GET /workflow?pageNumber=1&pageSize=10 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-sig

Host: test-1234567890.ci.ap-chongqing.myqcloud.com
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Content-Length: 0

Content-Type: application/xml

响应2

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <MediaWorkflowList>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>
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                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans. Ext </Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>20</Duration>

                        </Segment>

                        <Output>

{ }
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}. Ext </Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic. Ext </Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

    <MediaWorkflowList>

        <Name>workflow-2</Name>

        <State>Active</State>

        <WorkflowId>w93aa43ba105347169fa093ed857b2a90</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>StreamPackConfig_1581665960532</Start>

                <StreamPackConfig_1581665960532>VideoStream_1581665960536,VideoStre

                <VideoStream_1581665960536>StreamPack_1581665960538</VideoStream_

                <VideoStream_1581665960537>StreamPack_1581665960538</VideoStream_

                <StreamPack_1581665960538>End</StreamPack_1581665960538>

{ }

{ }

{ }
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            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>input/workflow-2</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish,WorkflowStart</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <StreamPackConfig_1581665960532>

                    <Type>StreamPackConfig</Type>

                    <Operation>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${InputPath}/${InputName}._${RunId}.${ext}</Object>

                        </Output>

                        <StreamPackConfig>

                            <PackType>HLS</PackType>

                            <IgnoreFailedStream>true</IgnoreFailedStream>

                        </StreamPackConfig>

                    </Operation>

                </StreamPackConfig_1581665960532>

                <VideoStream_1581665960536>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>
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                            <Object>${RunId}_Substream_1/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960536>

                <VideoStream_1581665960537>

                    <Type>VideoStream</Type>

                    <Operation>

                        <TemplateId>t1460606bgfdg2148c4ab182f55163ba7bj</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>${RunId}_Substream_2/video.m3u8</Object>

                        </Output>

                    </Operation>

                </VideoStream_1581665960537>

                <StreamPack_1581665960538>

                    <Type>StreamPack</Type>

                    <Operation>

                        <StreamPackInfo>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960536</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                            <VideoStreamConfig>

                                <VideoStreamName>VideoStream_1581665960537</VideoStreamN

                                <BandWidth>200000000</BandWidth>

                            </VideoStreamConfig>

                        </StreamPackInfo>

                    </Operation>

                </StreamPack_1581665960538>

            </Nodes>

        </Topology>

    </MediaWorkflowList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1808 共1950页

删除工作流
最近更新时间：2023-06-20 17:32:16

删除工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

DELETE /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>A</WorkflowId>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

WorkflowId Response 被删除的工作流 ID String

错误码

实际案例

请求

DELETE /workflow/we59a9648e62e48ffb25e4b41f3721799 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <WorkflowId>we59a9648e62e48ffb25e4b41f3721799</WorkflowId>

<Response>

https://cloud.tencent.com/document/product/460/42867
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更新工作流
最近更新时间：2023-06-20 17:32:17

更新工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体: 

功能描述

请求

请求示例

PUT /workflow/<WorkflowId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>
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                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>
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具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

</Request>

节点名称

（关键

字）

父

节

点

描述 类型
是否

必选

Reques

t
无 同创建工作流接口的 Request  

Containe

r
是

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/76856#Request
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                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>
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具体的数据内容如下：

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

节点名称

（关键

字）

父

节

点

描述 类型

是

否

必

选

Respon 无 同创建工作流接口的 Response  Conta 是

https://cloud.tencent.com/document/product/460/76856#Response
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

se iner

错误码

实际案例

请求1：更新工作流配置

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

https://cloud.tencent.com/document/product/460/42867
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                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>
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                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>

                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Request>

响应1

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x

<Response>

    <RequestId>NjJmMWQxYjNfOTBmYTUwNjRfNWYyY18x</RequestId>

    <MediaWorkflow>

        <Name>workflow-1</Name>

        <State>Active</State>

        <WorkflowId>wc666d0b9f9dd47ae9137a096252d49f7</WorkflowId>

        <BucketId>test-1234567890</BucketId>

        <CreateTime>2022-07-14T12:37:28+0800</CreateTime>

        <UpdateTime>2022-07-14T12:37:28+0800</UpdateTime>
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        <Topology>

            <Dependencies>

                <Start>Snapshot_1581665960536,Transcode_1581665960538</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960538>Segment_15816659605667,SmartCover_158166

                <Segment_15816659605667>End</Segment_15816659605667>

                <SmartCover_1581665960539>PicProcess_15816659605668</SmartCover_15

                <PicProcess_15816659605668>End</PicProcess_15816659605668>

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                        <ObjectPrefix>input/workflow-1</ObjectPrefix>

                        <NotifyConfig>

                            <State>On</State>

                            <Url>http://www.callback.com</Url>

                            <Event>TaskFinish,WorkflowFinish</Event>

                            <Type>Url</Type>

                            <ResultFormat>JSON</ResultFormat>

                        </NotifyConfig>

                        <ExtFilter>

                            <State>On</State>

                            <Video>true</Video>

                            <Audio>false</Audio>

                            <Image>false</Image>

                            <Custom>false</Custom>

                            <AllFile>false</AllFile>

                        </ExtFilter>

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/snapshot-${number}.${Ext}</Object>

                            <SpriteObject>abc/${RunId}/sprite-${number}.${Ext}</SpriteObject>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>
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                <Transcode_1581665960538>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/trans.{Ext}</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960538>

                <Segment_15816659605667>

                    <Type>Segment</Type>

                    <Operation>

                        <Segment>

                            <Format>mkv</Format>

                            <Duration>25</Duration>

                        </Segment>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>test-trans${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </Segment_15816659605667>

                <SmartCover_1581665960539>

                    <Type>SmartCover</Type>

                    <Operation>

                        <TemplateId>t16e81a29fe48c4e23acefc247a7792b63</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>abc/${RunId}/cover-${Number}.{Ext}</Object>

                        </Output>

                    </Operation>

                </SmartCover_1581665960539>

                <PicProcess_15816659605668>

                    <Type>PicProcess</Type>

                    <Operation>

                        <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>bcd/${RunId}/pic.{Ext}</Object>

                        </Output>
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                    </Operation>

                </PicProcess_15816659605668>

            </Nodes>

        </Topology>

    </MediaWorkflow>

</Response>

请求2：停用工作流

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?paused HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应2

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80

请求3：启用工作流

PUT /workflow/wc666d0b9f9dd47ae9137a096252d49f7?active HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应3

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWRiMDlfOTBmYTUwNjRfNWYzMl80
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测试工作流
最近更新时间：2023-06-21 10:22:02

测试工作流。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

功能描述

请求

请求示例

POST /triggerworkflow?workflowId=xxx&object=xxx HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

名称 描述 类型
是否必

选

workfl
owId

需要触发的工作流 ID
Stri
ng

是

object 需要进行工作流处理的对象名称, 需要进行 url 编码
Stri

ng
是

name
存量触发任务名称，支持中文、英文、数字、—和_，长度限制128字

符，默认为空

Stri

ng
否

请求头

请求体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

响应

响应头

响应体

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

InstanceId Response 实例 ID String

错误码

实际案例

请求

POST /triggerworkflow?workflowId=we59a9648e62e48ffb25e4b41f3721799&object=test

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1825 共1950页

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x

<Response>

    <RequestId>NjJmMWZmMzRfOTBmYTUwNjRfNjVmOF8x</RequestId>

    <InstanceId>i6fc78ca77d6011eba0ac5254008618d9=</InstanceId>

<Response>
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工作流回调
最近更新时间：2023-05-08 19:40:20

数据万象支持自定义设置回调 URL，在工作流开启状态下，每执行一个实例后，系统会向该 URL 发送 HTTP 

POST 请求，请求体中包含通知内容。您可通过配置的回调地址及时了解工作流实例处理的进展和状态，以便进行

其他业务操作。

任务完成后，系统会向您设置的回调地址发送回调内容，该响应体返回为 application/xml 数据，包含完整节点数

据的内容展示如下：

功能说明

回调内容

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 WorkflowExecution 的内容：

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

EventName Response 固定值，为 WorkflowFinish String

WorkflowExecution Response 工作流的详细信息 Container

节点名称

（关键

字）

父节点 描述 类型

Workflo

wId

Response.Workflo

wExecution
工作流 ID String

Workflo
wName

Response.Workflo
wExecution

工作流的名称 String

RunId
Response.Workflo

wExecution
工作流实例的 ID String

State
Response.Workflo

wExecution

实例的状态，值为 Success、Failed 其中一

个。Tasks 存在一个 Failed，则此实例视为 

Failed

String

BucketId Response.Workflo 被处理文件所属的存储桶 String
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Container 节点 CosHeaders 的内容：

Container 节点 Tasks 的内容：

wExecution

Object
Response.Workflo

wExecution
该实例处理的文件名 String

CreateTi

me

Response.Workflo

wExecution
实例的创建时间 String

CosHea

ders

Response.Workflo

wExecution

该 Object 上传时设定的自定义 Header 列

表，没有设置时无此内容

Contain

er 数组

Tasks
Response.Workflo

wExecution
任务信息列表

Contain

er 数组

节点名称（关键字） 父节点 描述 类型

Key
Response.WorkflowExecution.Cos

Headers

自定义 Header 的名

称

Strin

g

Value
Response.WorkflowExecution.Cos

Headers
自定义 Header 的值

Strin

g

节点名称（关键

字）
父节点 描述 类型

Type
Response.WorkflowExecut

ion.Tasks
任务类型 String

Createtime
Response.WorkflowExecut

ion.Tasks
任务的创建时间 String

StartTime
Response.WorkflowExecut

ion.Tasks
任务开始时间 String

EndTime
Response.WorkflowExecut

ion.Tasks
任务的完成时间 String

State
Response.WorkflowExecut

ion.Tasks

任务的状态，值为 Success、

Failed 等
String

JobId
Response.WorkflowExecut

ion.Tasks
任务的 ID String

Name Response.WorkflowExecut 任务在工作流中的节点名称 String
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Container 节点 ResultInfo 的内容：

Container 节点 SpriteObjectInfo 的内容：

Container 节点 ObjectInfo 的内容：

ion.Tasks

TemplateId
Response.WorkflowExecut

ion.Tasks
任务使用的模板 ID String

TemplateNam

e

Response.WorkflowExecut

ion.Tasks
任务使用的模板名称 String

ResultInfo
Response.WorkflowExecut

ion.Tasks
任务结果详情

Contai

ner

节点名称（关键

字）
父节点 描述 类型

SpriteObjectInf

o

Response.WorkflowExecution.Task

s.ResultInfo

雪碧图对象详

情

Container 

数组

ObjectInfo
Response.WorkflowExecution.Task

s.ResultInfo
输出对象详情

Container 

数组

节点名称（关键字） 父节点 描述 类型

ObjectName
Response.WorkflowExecution.Tasks.ResultInfo.

SpriteObjectInfo
对象名

Stri

ng

ObjectUrl
Response.WorkflowExecution.Tasks.ResultInfo.
SpriteObjectInfo

对象
Url

Stri
ng

节点名称（关键

字）
父节点 描述

类

型

ObjectName
Response.WorkflowExecution.

Tasks.ResultInfo.ObjectInfo
对象名

Str

ing

ObjectUrl
Response.WorkflowExecution.

Tasks.ResultInfo.ObjectInfo
对象Url

Str

ing

InputObject

Name

Response.WorkflowExecution.

Tasks.ResultInfo.ObjectInfo
输入对象名

Str

ing

Code Response.WorkflowExecution. InputObjectName对应错误码， Str
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Tasks.ResultInfo.ObjectInfo O为处理成功，非0处理失败 ing

Message
Response.WorkflowExecution.

Tasks.ResultInfo.ObjectInfo

InputObjectName对应错误信

息，处理失败时有效

Str

ing

实际案例

案例 1 (XML)

<Response>

    <EventName>WorkflowFinish</EventName>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <WorkflowName>workflow-3</WorkflowName>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <State>Success</State>

        <BucketId>test-1234567890</BucketId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09 14:54:17+0800</CreateTime>

        <CosHeaders>

            <Key>Content-Type</Key>

            <Value>video/mp4</Value>

        </CosHeaders>

        <CosHeaders>

            <Key>x-cos-request-id</Key>

            <Value>NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5</Value>

        </CosHeaders>

        <Tasks>

            <Type>Snapshot</Type>

            <CreateTime>2022-08-09 14:54:40+0800</CreateTime>

            <EndTime>2022-08-09 14:54:42+0800</EndTime>

            <State>Success</State>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <Name>Snapshot_1581665960536</Name>

            <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

            <TemplateName>snapshot_1280*720_3</TemplateName>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <CreateTime>2022-08-09 14:54:18+0800</CreateTime>

            <EndTime>2022-08-09 14:54:39+0800</EndTime>

            <State>Success</State>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <Name>Transcode_1581665960537</Name>

            <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>
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            <TemplateName>MP4-265-SD</TemplateName>

        </Tasks>

    </WorkflowExecution>

</Response>

案例 2 (JSON)

{

    "EventName": "WorkflowFinish",

    "WorkflowExecution": {

        "WorkflowId": "web6ac56c1ef54dbfa44d7f4103203be9",

        "WorkflowName": "workflow-3",

        "RunId": "i166ee19017b011eda8a5525400c540df",

        "State": "Success",

        "BucketId": "test-1234567890",

        "Object": "wk-test/game.mp4",

        "CreateTime": "2022-08-09 14:54:17+0800",

        "CosHeaders": [{

                "Key": "Content-Type",

                "Value": "video/mp4"

            },

            {

                "Key": "x-cos-request-id",

                "Value": "NjJiZDYwYTFfNjUzYTYyNjRfZjEwZl8xMmZhYzY5"

            }

        ],

        "Tasks": [{

                "Type": "Snapshot",

                "CreateTime": "2022-08-09 14:54:40+0800",

                "EndTime": "2022-08-09 14:54:42+0800",

                "State": "Success",

                "JobId": "j23c11e1e17b011edaab4ab15ec33d076",

                "Name": "Snapshot_1581665960536",

                "TemplateId": "t07740e32081b44ad7a0aea03adcffd54a",

                "TemplateName": "snapshot_1280*720_3"

            },

            {

                "Type": "Transcode",

                "CreateTime": "2022-08-09 14:54:18+0800",

                "EndTime": "2022-08-09 14:54:39+0800",

                "State": "Success",

                "JobId": "j168668b217b011ed8efb27bb229e2d11",

                "Name": "Transcode_1581665960537",

                "TemplateId": "t01e57db1c2d154d2fb57aa5de9313a897",
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                "TemplateName": "MP4-265-SD"

            }

        ]

    }

}
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工作流实例

获取工作流实例详情
最近更新时间：2023-07-25 09:06:34

获取工作流实例详情。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /workflowexecution/<RunId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

为工作流实例id

请求头

请求体

响应

响应头

响应体

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_1581665

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>
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具体的数据内容如下：

Container 节点 Response 的内容：

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container
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Container 节点 WorkflowExecution 的内容：

Container 节点 Tasks 的内容：

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求 ID String

WorkflowExecution Response 工作流实例详细信息 Container

节点名称（关

键字）
父节点 描述 类型

WorkflowId
Response.WorkflowE

xecution
工作流 ID String

WorkflowN

ame

Response.WorkflowE

xecution
工作流名称 String

RunId
Response.WorkflowE

xecution
工作流实例 ID String

CreateTime
Response.WorkflowE

xecution
创建时间 String

Object
Response.WorkflowE

xecution
COS 对象地址 String

State
Response.WorkflowE

xecution
工作流实例状态 String

Topology
Response.WorkflowE

xecution
同创建工作流接口的 Topology  Container

Tasks
Response.WorkflowE
xecution

工作流实例任务
Container
数组

节点名称

（关键字）
父节点 描述 类型

Type
Response.WorkflowExe
cution.Tasks

任务所属节点类型 String

State
Response.WorkflowExe

cution.Tasks

任务状态，当该节点为判断节点时，

PartialSuccess 表示部分输入文件

通过判断

String

https://cloud.tencent.com/document/product/460/76856#Topology
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Container 节点 ResultInfo 的内容：

Container 节点 SpriteObjectInfo 的内容：

JobId Response.WorkflowExe

cution.Tasks

任务 ID String

CreateTi

me

Response.WorkflowExe

cution.Tasks
任务创建时间 String

StartTime
Response.WorkflowExe

cution.Tasks
任务开始时间 String

EndTime
Response.WorkflowExe

cution.Tasks
任务结束时间 String

Code
Response.WorkflowExe

cution.Tasks
任务的错误码 String

Message
Response.WorkflowExe

cution.Tasks
任务的错误信息 String

Name
Response.WorkflowExe

cution.Tasks
工作流节点name String

ResultInf

o

Response.WorkflowExe

cution.Tasks
任务结果详情 Container

Judgeme

ntInfo

Response.WorkflowExe

cution.Tasks

判断节点结果详情，当节点为判断节点

时返回
Container

FileInfo
Response.WorkflowExe

cution.Tasks

判断节点结果详情，当节点为判断节点

时返回

Container

数组

节点名称（关

键字）
父节点 描述 类型

ObjectCoun

t

Response.WorkflowExecution.T

asks.ResultInfo
任务生成对象文件个数 String

SpriteObjec

tCount

Response.WorkflowExecution.T

asks.ResultInfo

仅在截图生成雪碧图有

效，表示生成雪碧图个数
String

ObjectInfo
Response.WorkflowExecution.T

asks.ResultInfo
任务生成对象详情

Container

数组

SpriteObjec

tInfo

Response.WorkflowExecution.T

asks.ResultInfo
任务生成雪碧图对象详情

Container

数组
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Container 节点 ObjectInfo 的内容：

Container 节点 JudgementInfo 的内容：

Container 节点 JudgementResult 的内容：

节点名称（关键字） 父节点 描述 类型

ObjectName
Response.WorkflowExecution.Tasks.ResultInfo.

SpriteObjectInfo
对象名

Stri

ng

ObjectUrl
Response.WorkflowExecution.Tasks.ResultInfo.

SpriteObjectInfo

对象

Url

Stri

ng

节点名称（关

键字）
父节点 描述

类

型

ObjectNa

me

Response.WorkflowExecution.Tasks.R

esultInfo.ObjectInfo
对象名

Str

ing

ObjectUrl
Response.WorkflowExecution.Tasks.R

esultInfo.ObjectInfo
对象Url

Str

ing

InputObjec

tName

Response.WorkflowExecution.Tasks.R

esultInfo.ObjectInfo
输入对象名

Str

ing

Code
Response.WorkflowExecution.Tasks.R

esultInfo.ObjectInfo

InputObjectName对应

错误码，O为处理成功，非

0处理失败

Str

ing

Message
Response.WorkflowExecution.Tasks.R

esultInfo.ObjectInfo

InputObjectName对应

错误信息，处理失败时有效

Str

ing

节点名称（关

键字）
父节点 描述 类型

ObjectCount
Response.WorkflowExecution.Ta

sks.JudgementInfo

判断节点输入对象文件个

数
Int

Judgement

Result

Response.WorkflowExecution.Ta

sks.JudgementInfo

判断节点输入对象具体判

断结果

Contain

er数组

节点名称

（关键字）
父节点 描述 类型

ObjectNa Response.WorkflowExecution. 对象名 String
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Container 节点 InputObjectInfo 的内容：

me Tasks.JudgementInfo.Judgeme

ntResult

ObjectUrl
Response.WorkflowExecution.
Tasks.JudgementInfo.Judgeme

ntResult

对象链接 String

State

Response.WorkflowExecution.

Tasks.JudgementInfo.Judgeme

ntResult

判断结果状态，Success 表示通

过条件判断，Failed 表示未通过

条件判断

String

InputObje

ctInfo

Response.WorkflowExecution.

Tasks.JudgementInfo.Judgeme
ntResult

输入文件的判断参数
Conta

iner

节点名称

（关键字）
父节点 描述 类型

Width
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

视频

宽

Stri

ng

Height
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

视频

高

Stri

ng

Dar
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

视频

宽高

比

Stri

ng

Duration
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

音视
频时

长

Stri

ng

Size
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

文件

大小

Stri

ng

ImageWid

th

Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

图片

宽

Stri

ng

ImageHei

ght

Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

图片

高

Stri

ng

ImageDar
Response.WorkflowExecution.Tasks.JudgementInfo.Ju

dgementResult.InputObjectInfo

图片

宽高

比

Stri

ng



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1840 共1950页

Container 节点 FileInfo 的内容：

Container 节点 BasicInfo 的内容：

Container 节点 MediaInfo 的内容：

Container 节点 Video 的内容：

节点名称（关键字） 父节点 描述 类型

BasicInfo
Response.WorkflowExecution.Tasks.

FileInfo
文件基础信息

Contain

er

MediaInfo
Response.WorkflowExecution.Tasks.

FileInfo
音视频信息

Contain

er

ImageInfo
Response.WorkflowExecution.Tasks.

FileInfo
图片信息

Contain

er

节点名称（关键字） 父节点 描述 类型

ContentType
Response.WorkflowExecution.Tasks.FileI
nfo.BasicInfo

文件类型
Stri
ng

Size
Response.WorkflowExecution.Tasks.FileI

nfo.BasicInfo
文件大小

Stri

ng

ETag
Response.WorkflowExecution.Tasks.FileI

nfo.BasicInfo
文件Etag

Stri

ng

LastModified
Response.WorkflowExecution.Tasks.FileI
nfo.BasicInfo

文件上修改时
间

Stri
ng

Object
Response.WorkflowExecution.Tasks.FileI

nfo.BasicInfo
文件名

Stri

ng

节点名称（关键字） 父节点 描述 类型

Video
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo

视频信

息

Contain

er

Audio
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo

音频信

息

Contain

er

Format
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo

格式信

息

Contain

er
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Container 节点 Audio 的内容：

Container 节点 Formt 的内容：

Container 节点 ImageInfo 的内容：

节点名称（关键

字）

父节点 描述 类

型

Height
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo.Video
视频高

Str

ing

Width
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo.Video
视频宽

Str

ing

Dar
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo.Video
视频宽高比

Str

ing

Duration
Response.WorkflowExecution.Tasks.FileInf

o.MediaInfo.Video

视频时长，单位

秒

Str

ing

节点名称（关键

字）
父节点 描述

类

型

Duration
Response.WorkflowExecution.Tasks.FileInfo

.MediaInfo.Audio

音频时长，单

位秒

Str

ing

节点名称（关键

字）
父节点 描述 类型

Duration
Response.WorkflowExecution.Tasks.FileInfo.

MediaInfo.Format

时长，单位

秒

Stri

ng

节点名称（关键

字）
父节点 描述 类型

Format
Response.WorkflowExecution.Tasks.

FileInfo.ImageInfo
图片高

Stri

ng

Height
Response.WorkflowExecution.Tasks.

FileInfo.ImageInfo
图片宽

Stri

ng

Width
Response.WorkflowExecution.Tasks.

FileInfo.ImageInfo
图片宽

Stri

ng

Md5 Response.WorkflowExecution.Tasks.

FileInfo.ImageInfo

图片Md5 Stri

ng
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

FrameCount
Response.WorkflowExecution.Tasks.

FileInfo.ImageInfo

图片帧数，静态图为1，

动图为对应的帧数

Stri

ng

错误码

实际案例

请求

GET /workflowexecution/i166ee19017b011eda8a5525400c540df HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NjJmMjA5MjZfZWM0YTYyNjRfN2U3ZF8yNzk1</RequestId>

    <WorkflowExecution>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Name>workflow-1</Name>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <Object>wk-test/game.mp4</Object>

        <State>Success</State>

        <Topology>

            <Dependencies>

                <Start>Transcode_1581665960537</Start>

                <Snapshot_1581665960536>End</Snapshot_1581665960536>

                <Transcode_1581665960537>Snapshot_1581665960536</Transcode_1581665

            </Dependencies>

            <Nodes>

                <Start>

                    <Type>Start</Type>

                    <Input>

https://cloud.tencent.com/document/product/460/42867
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                        <QueueId>p09d709939fef48a0a5c247ef39d90cec</QueueId>

                        <ObjectPrefix>/wk-test</ObjectPrefix>

                        <ExtFilter>

                            <State>On</State>

                            <Video>false</Video>

                            <Audio>false</Audio>

                            <ContentType>false</ContentType>

                            <Custom>true</Custom>

                            <CustomExts>mp4</CustomExts>

                            <AllFile>false</AllFile>

                            <Image>false</Image>

                        </ExtFilter>

                        <PicProcessQueueId>p2911917386e148639319e13c285cc774</PicProce

                    </Input>

                </Start>

                <Snapshot_1581665960536>

                    <Type>Snapshot</Type>

                    <Operation>

                        <TemplateId>t07740e32081b44ad7a0aea03adcffd54a</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>snapshot-${number}.jpg</Object>

                        </Output>

                    </Operation>

                </Snapshot_1581665960536>

                <Transcode_1581665960537>

                    <Type>Transcode</Type>

                    <Operation>

                        <TemplateId>t01e57db1c2d154d2fb57aa5de9313a897</TemplateId>

                        <Output>

                            <Region>ap-chongqing</Region>

                            <Bucket>test-1234567890</Bucket>

                            <Object>trans1.mp4</Object>

                        </Output>

                    </Operation>

                </Transcode_1581665960537>

            </Nodes>

        </Topology>

        <Tasks>

            <Type>Snapshot</Type>

            <JobId>j23c11e1e17b011edaab4ab15ec33d076</JobId>

            <CreateTime>2022-08-09T14:54:40+08:00</CreateTime>

            <Name>Snapshot_1581665960536</Name>

            <State>Success</State>
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            <StartTime>2022-08-09T14:54:40+08:00</StartTime>

            <EndTime>2022-08-09T14:54:42+08:00</EndTime>

            <Code>Success</Code>

            <Message></Message>

        </Tasks>

        <Tasks>

            <Type>Transcode</Type>

            <JobId>j168668b217b011ed8efb27bb229e2d11</JobId>

            <CreateTime>2022-08-09T14:54:18+08:00</CreateTime>

            <Name>Transcode_1581665960537</Name>

            <State>Success</State>

            <StartTime>2022-08-09T14:54:18+08:00</StartTime>

            <EndTime>2022-08-09T14:54:39+08:00</EndTime>

            <Code>Success</Code>

            <Message>success</Message>

        </Tasks>

    </WorkflowExecution>
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获取工作流实例详情列表
最近更新时间：2023-06-20 17:32:17

获取工作流实例列表。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

功能描述

请求

请求示例

GET /workflowexecution HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

参数名称（关

键字）
描述 类型

是否

必选

workflowId 工作流 ID String 否

name 文件名称 String 否

orderByTim

e
Desc 或者 Asc。默认为 Desc String 否

size 拉取的最大任务数。默认为10。最大为100 String 否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

states 工作流实例状态，以 , 分割支持多状态

 All，Success，Failed，Running，Cancel。默认为 All

String 否

startCreati

onTime

拉取创建时间大于等于该时间。格式为：

%Y-%m-%dT%H:%m:%S%z
String 否

endCreatio

nTime

拉取创建时间小于等于该时间。格式为：

%Y-%m-%dT%H:%m:%S%z
String 否

nextToken 请求的上下文，用于翻页。下一页输入 token String 否

jobId
批量触发工作流任务 ID，用于扫描出批量触发任务 ID 对应执行

的工作流实例
String 否

响应

响应头

响应体

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

Container 节点 WorkflowExecutionList 的内容：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

WorkflowExecutionList Response 工作流实例详细信息 Container

RequestId Response 请求 ID String

NextToken Response 翻页的上下文 Token String

节点名称（关键字） 父节点 描述 类型

RunId
Response.WorkflowExecutionLi

st
工作流实例 ID String

WorkflowId
Response.WorkflowExecutionLi

st
工作流 ID String

State
Response.WorkflowExecutionLi

st
工作流实例状态 String

CreateTime
Response.WorkflowExecutionLi

st
创建时间 String

Object
Response.WorkflowExecutionLi

st
COS 对象地址 String

错误码

实际案例

请求

GET /workflowexecution?workflowId=web6ac56c1ef54dbfa44d7f4103203be9 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Thu, 09 Aug 2022 16:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0

<Response>

    <RequestId>NjJmMjEyMmFfZWM0YTYyNjRfN2U2NV8yNmI0</RequestId>

    <WorkflowExecutionList>

        <RunId>i166ee19017b011eda8a5525400c540df</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:54:17+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <WorkflowExecutionList>

        <RunId>i769bd26517af11ed917f525400a3c59f</RunId>

        <WorkflowId>web6ac56c1ef54dbfa44d7f4103203be9</WorkflowId>

        <Object>wk-test/game.mp4</Object>

        <CreateTime>2022-08-09T14:49:49+08:00</CreateTime>

        <State>Success</State>

    </WorkflowExecutionList>

    <NextToken>115716</NextToken>

</Response>
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任务接口

取消任务
最近更新时间：2023-06-20 17:32:23

取消一个任务，只有未执行的任务才可以被取消。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无响应体。

功能描述

请求

请求示例

PUT /jobs/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

PUT /jobs/jb57da17e29c111eda218713081fe2b05?cancel HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

https://cloud.tencent.com/document/product/460/42867
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提交多任务处理
最近更新时间：2023-06-21 10:35:31

提交多个任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体：

功能描述

请求

请求示例

POST /jobs HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   

        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是
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Container 类型 Input 的具体数据描述如下：

对于不同的任务类型，Operation 的内容不同，请参照以下链接：

媒体处理：

图片处理：

智能语音：

节点名称（关键字） 父节点 描述 类型 是否必选

Input Request 待操作的文件信息 Container 是

Operation Request 操作规则，个数不超过6个 Container 是

QueueId Request 任务所在的队列 ID String 否

节点名称（关键字） 父节点 描述 类型 是否必选

Object Request.Input 文件路径 String 是

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

智能封面

SDR to HDR  

图片处理

人声分离

https://cloud.tencent.com/document/product/460/84774#jobsDetail
https://cloud.tencent.com/document/product/460/84775#jobsDetail
https://cloud.tencent.com/document/product/460/84776#jobsDetail
https://cloud.tencent.com/document/product/460/84777#jobsDetail
https://cloud.tencent.com/document/product/460/84778#jobsDetail
https://cloud.tencent.com/document/product/460/84779#jobsDetail
https://cloud.tencent.com/document/product/460/84780#jobsDetail
https://cloud.tencent.com/document/product/460/84781#jobsDetail
https://cloud.tencent.com/document/product/460/84782#jobsDetail
https://cloud.tencent.com/document/product/460/84783#jobsDetail
https://cloud.tencent.com/document/product/460/84784#jobsDetail
https://cloud.tencent.com/document/product/460/84785#jobsDetail
https://cloud.tencent.com/document/product/460/84786#jobsDetail
https://cloud.tencent.com/document/product/460/84787#jobsDetail
https://cloud.tencent.com/document/product/460/84788#jobsDetail
https://cloud.tencent.com/document/product/460/84789#jobsDetailhttps://cloud.tencent.com/document/product/460/84789#jobsDetail
https://cloud.tencent.com/document/product/460/84790#jobsDetail
https://cloud.tencent.com/document/product/460/84791#jobsDetail
https://cloud.tencent.com/document/product/460/84792#jobsDetail
https://cloud.tencent.com/document/product/460/84793#jobsDetail
https://cloud.tencent.com/document/product/460/84794
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AI 内容识别

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

视频拆条

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/84795#jobsDetail
https://cloud.tencent.com/document/product/460/84796#jobsDetail
https://cloud.tencent.com/document/product/460/84797#jobsDetail
https://cloud.tencent.com/document/product/460/84798#jobsDetail
https://cloud.tencent.com/document/product/460/84799#jobsDetail
https://cloud.tencent.com/document/product/460/84800#jobsDetail
https://cloud.tencent.com/document/product/460/84801#jobsDetail
https://cloud.tencent.com/document/product/460/84802#jobsDetail
https://cloud.tencent.com/document/product/460/90888#jobsDetail


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1855 共1950页

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>transcode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

媒体处理：

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>

            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container 数组

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

https://cloud.tencent.com/document/product/460/84774
https://cloud.tencent.com/document/product/460/84775
https://cloud.tencent.com/document/product/460/84776
https://cloud.tencent.com/document/product/460/84777
https://cloud.tencent.com/document/product/460/84778
https://cloud.tencent.com/document/product/460/84779
https://cloud.tencent.com/document/product/460/84780
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图片处理：

智能语音：

AI 内容识别

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

智能封面

SDR to HDR  

图片处理

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

视频拆条

错误码

实际案例

使用多个模板 ID

请求

POST /jobs HTTP/1.1

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84781
https://cloud.tencent.com/document/product/460/84782
https://cloud.tencent.com/document/product/460/84783
https://cloud.tencent.com/document/product/460/84784
https://cloud.tencent.com/document/product/460/84785
https://cloud.tencent.com/document/product/460/84786
https://cloud.tencent.com/document/product/460/84787
https://cloud.tencent.com/document/product/460/84788
https://cloud.tencent.com/document/product/460/84789
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84791
https://cloud.tencent.com/document/product/460/84792
https://cloud.tencent.com/document/product/460/84793
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84795
https://cloud.tencent.com/document/product/460/84796
https://cloud.tencent.com/document/product/460/84797
https://cloud.tencent.com/document/product/460/84798
https://cloud.tencent.com/document/product/460/84799
https://cloud.tencent.com/document/product/460/84800
https://cloud.tencent.com/document/product/460/84801
https://cloud.tencent.com/document/product/460/84802
https://cloud.tencent.com/document/product/460/90888
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Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Input>

        <Object>input/demo.mp4</Object>

    </Input>

    <Operation>

        <Tag>Animation</Tag>

        <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/animation.gif</Object>

        </Output>

        <UserData>This is my Animation job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>Transcode</Tag>

        <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/transcode.mp4</Object>

        </Output>

        <UserData>This is my Trancode job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <Operation>

        <Tag>SmartCover</Tag>

        <SmartCover>

            <Format>jpg</Format>

            <Width>1280</Width>

            <Height>960</Height>

            <Count>5</Count>

            <DeleteDuplicates>true</DeleteDuplicates>

        </SmartCover>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-123456789</Bucket>

            <Object>output/smartcover-${Number}.jpg</Object>

        </Output>   
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        <UserData>This is my SmartCover job.</UserData>

        <JobLevel>0</JobLevel>

    </Operation>

    <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

    <CallBack>http://callback.demo.com</CallBack>

    <CallBackFormat>JSON</CallBackFormat>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j682b9662f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Animation</Tag>

            <TemplateId>t1f16e1dfbdc994105b31292d45710642a</TemplateId>

            <TemplateName>animation_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/animation.gif</Object>

            </Output>

            <UserData>This is my Animation job.</UserData>

            <JobLevel>0</JobLevel>
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        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j68427030f84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>Transcode</Tag>

            <TemplateId>t1995d523e42df4c5e858f244b4174360c</TemplateId>

            <TemplateName>trancode_demo</TemplateName>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/transcode.mp4</Object>

            </Output>

            <UserData>This is my Trancode job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <JobId>j6842765cf84611ecb8546d80f2baf56f</JobId>

        <State>Submitted</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <Tag>SmartCover</Tag>
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            <SmartCover>

                <Format>jpg</Format>

                <Width>1280</Width>

                <Height>960</Height>

                <Count>5</Count>

                <DeleteDuplicates>true</DeleteDuplicates>

            </SmartCover>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/smartcover-${Number}.jpg</Object>

            </Output>   

            <UserData>This is my SmartCover job.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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查询指定任务
最近更新时间：2023-06-20 17:32:24

查询指定的任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /jobs/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

jobId 为提交任务时返回的任务Id，支持传多个，以逗号分隔，最多传10个。

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

媒体处理：

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

JobsDetail
Respons

e
任务的详细信息

Container数

组

NonExistJobId

s

Respons

e

查询的 ID 中不存在任务，所有任务都存在时不

返回
String

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

https://cloud.tencent.com/document/product/460/84774#jobsDetail
https://cloud.tencent.com/document/product/460/84775#jobsDetail
https://cloud.tencent.com/document/product/460/84776#jobsDetail
https://cloud.tencent.com/document/product/460/84777#jobsDetail
https://cloud.tencent.com/document/product/460/84778#jobsDetail
https://cloud.tencent.com/document/product/460/84779#jobsDetail
https://cloud.tencent.com/document/product/460/84780#jobsDetail
https://cloud.tencent.com/document/product/460/84781#jobsDetail
https://cloud.tencent.com/document/product/460/84782#jobsDetail
https://cloud.tencent.com/document/product/460/84783#jobsDetail
https://cloud.tencent.com/document/product/460/84784#jobsDetail
https://cloud.tencent.com/document/product/460/84785#jobsDetail
https://cloud.tencent.com/document/product/460/84786#jobsDetail
https://cloud.tencent.com/document/product/460/84787#jobsDetail
https://cloud.tencent.com/document/product/460/84788#jobsDetail
https://cloud.tencent.com/document/product/460/84789#jobsDetailhttps://cloud.tencent.com/document/product/460/84789#jobsDetail
https://cloud.tencent.com/document/product/460/84790#jobsDetail
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图片处理：

智能语音：

AI 内容识别

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

智能封面

SDR to HDR  

图片处理

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

视频拆条

错误码

实际案例

请求1：查询一个音视频转码任务，该任务正在执行中

GET /jobs/j8d121820f5e411ec926ef19d53ba9c6f HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/84791#jobsDetail
https://cloud.tencent.com/document/product/460/84792#jobsDetail
https://cloud.tencent.com/document/product/460/84793#jobsDetail
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84795#jobsDetail
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<Response>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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请求2：查询一个音视频转码任务，该任务执行成功

GET /jobs/j9c0a4726f6ac11ec96aaa9b64ab18d00 HTTP/1.1

Accept: */*

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:25:22 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjY=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>
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            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC (Advanced Audio Coding)</CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

                    </Audio>

                    <Subtitle/>
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                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

</Response>
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获取符合条件的任务列表
最近更新时间：2023-06-20 17:32:24

获取符合条件的任务列表。

参数的具体内容如下：

功能描述

请求

请求示例

GET /jobs?size=&states=&queueId=&startCreationTime=&endCreationTime= HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求参数

节点名称（关键
字）

父
节

点

描述 类型

是

否
必

选

queueId 无 拉取该队列 ID 下的任务
Strin

g
否

queueType 无
拉取队列类型下的任务，和 queueId 不同时生效，同时

存在时 queueId 优先

Strin

g
否

tag 无 任务的 Tag
Strin

g
是

workflowId 无 触发该任务的工作流ID
Strin

g
否

inventoryTrigg 无 触发该任务的存量触发任务ID Strin 否

https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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queueType 支持以下几种类型：

tag 支持以下几种类型:

erJobId g

inputObject 无 该任务的输入文件名，暂仅支持精确匹配
Strin

g
否

orderByTime 无 Desc 或者 Asc。默认为 Desc
Strin

g
否

nextToken 无 请求的上下文，用于翻页。上次返回的值
Strin

g
否

size 无 拉取的最大任务数。默认为10。最大为100
Integ

er
否

states 无
拉取该状态的任务，以 , 分割，支持多状态：All、

Submitted、Running、Success、Failed、

Pause、Cancel。默认为 All

Strin

g
否

startCreationT
ime

无

拉取创建时间大于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z ，示例：2001-01-

01T00:00:00+0800

Strin
g

否

endCreationTi

me
无

拉取创建时间小于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z ，示例：2001-01-

01T23:59:59+0800

Strin

g
否

队列类型

媒体处理 Transcoding

智能语音 Speeching

图片处理 PicProcess

AI 内容识别 AIProcess

倍速转码 SpeedTranscoding

任务类型 tag

媒体处理 音视频转码 Transcode
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视频转动图 Animation

视频截图 Snapshot

智能封面 SmartCover

音视频拼接 Concat

精彩集锦 VideoMontage

SDR to HDR SDRtoHDR

视频增强 VideoProcess

超分辨率 SuperResolution

音视频转封装 Segment

数字水印 DigitalWatermark

提取数字水印 ExtractDigitalWatermark

视频标签 VideoTag

获取媒体信息 MediaInfo

音视频流分离 StreamExtract

视频质量分析 QualityEstimate

视频明水印 Watermark

图片处理 图片处理 PicProcess

智能语音

语音识别 SpeechRecognition

音频降噪 NoiseReduction

人声分离 VoiceSeparate

语音合成 Tts

听歌识曲 SoundHound

AI 内容识别 翻译 Translation

分词 WordsGeneralize

视频目标检测 VideoTargetRec
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此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的任务类型，JobsDetail 的内容不同，请参照以下链接：

媒体处理：

视频人像抠图 SegmentVideoBody

视频拆条 SplitVideoParts

请求头

请求体

响应

响应头

响应体

<Response>

    <JobsDetail>

        .

    </JobsDetail>

    <NextToken></NextToken>

</Response>

..

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

JobsDetail Response 任务的详细信息 Container数组

NextToken Response 翻页的上下文 Token String

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
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图片处理

智能语音：

AI 内容识别

超分辨率

画质增强

获取媒体信息

极速高清转码

精彩集锦

视频标签

视频截图

视频明水印

视频增强

视频质量评分

视频转动图

数字水印

提取数字水印

音视频流分离

音视频拼接

音视频转封装

音视频转码

智能封面

SDR to HDR  

图片处理

人声分离

听歌识曲

音频降噪

语音合成

语音识别

翻译

分词

视频目标检测

视频人像抠图

视频拆条

错误码

https://cloud.tencent.com/document/product/460/84774#jobsDetail
https://cloud.tencent.com/document/product/460/84775#jobsDetail
https://cloud.tencent.com/document/product/460/84776#jobsDetail
https://cloud.tencent.com/document/product/460/84777#jobsDetail
https://cloud.tencent.com/document/product/460/84778#jobsDetail
https://cloud.tencent.com/document/product/460/84779#jobsDetail
https://cloud.tencent.com/document/product/460/84780#jobsDetail
https://cloud.tencent.com/document/product/460/84781#jobsDetail
https://cloud.tencent.com/document/product/460/84782#jobsDetail
https://cloud.tencent.com/document/product/460/84783#jobsDetail
https://cloud.tencent.com/document/product/460/84784#jobsDetail
https://cloud.tencent.com/document/product/460/84785#jobsDetail
https://cloud.tencent.com/document/product/460/84786#jobsDetail
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https://cloud.tencent.com/document/product/460/84790#jobsDetail
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https://cloud.tencent.com/document/product/460/84795#jobsDetail
https://cloud.tencent.com/document/product/460/84796#jobsDetail
https://cloud.tencent.com/document/product/460/84797#jobsDetail
https://cloud.tencent.com/document/product/460/84798#jobsDetail
https://cloud.tencent.com/document/product/460/84799#jobsDetail
https://cloud.tencent.com/document/product/460/84800#jobsDetail
https://cloud.tencent.com/document/product/460/84801#jobsDetail
https://cloud.tencent.com/document/product/460/84802#jobsDetail
https://cloud.tencent.com/document/product/460/90888#jobsDetail
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

实际案例

请求

GET /jobs?queueId=p2242ab62c7c94486915508540933a2c6&tag=Transcode HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0**********&q-s

Host: test-1234567890.ci.ap-chongqing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjMxMDJhYTNfMThhYTk0MGFfYmU1OV8zZjc=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j8d121820f5e411ec926ef19d53ba9c6f</JobId>

        <State>Running</State>

        <Progress>30</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>-</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

https://cloud.tencent.com/document/product/460/42867
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                <Dx>150</Dx>

                <Dy>150</Dy>

                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        </Message>

        <JobId>j9c0a4726f6ac11ec96aaa9b64ab18d00</JobId>

        <State>Success</State>

        <Progress>100</Progress>

        <CreationTime>2022-06-27T15:23:12+0800</CreationTime>

        <StartTime>2022-06-27T15:23:13+0800</StartTime>

        <EndTime>2022-06-27T15:24:33+0800</EndTime>

        <QueueId>p2242ab62c7c94486915508540933a2c6</QueueId>

        <Tag>Transcode</Tag>

        <Input>

            <BucketId>test-123456789</BucketId>

            <Object>input/demo.mp4</Object>

            <Region>ap-chongqing</Region>

        </Input>

        <Operation>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe22</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe23</WatermarkTem

            <WatermarkTemplateId>t1318c5f428d474afba1797f84091cbe24</WatermarkTem

            <RemoveWatermark>

                <Dx>150</Dx>

                <Dy>150</Dy>
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                <Width>75</Width>

                <Height>75</Height>

            </RemoveWatermark>

            <DigitalWatermark>

                <Type>Text</Type>

                <Message>123456789ab</Message>

                <Version>V1</Version>

                <IgnoreError>false</IgnoreError>

                <State>Running</State>

            </DigitalWatermark>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-123456789</Bucket>

                <Object>output/out.mp4</Object>

            </Output>

            <UserData>This is my data.</UserData>

            <JobLevel>0</JobLevel>

            <MediaInfo>

                <Format>

                    <Bitrate>834.736000</Bitrate>

                    <Duration>13.654000</Duration>

                    <FormatLongName>QuickTime / MOV</FormatLongName>

                    <FormatName>mov,mp4,m4a,3gp,3g2,mj2</FormatName>

                    <NumProgram>0</NumProgram>

                    <NumStream>2</NumStream>

                    <Size>1424687</Size>

                    <StartTime>0.000000</StartTime>

                </Format>

                <Stream>

                    <Audio>

                        <Bitrate>104.047000</Bitrate>

                        <Channel>2</Channel>

                        <ChannelLayout>stereo</ChannelLayout>

                        <CodecLongName>AAC Advanced Audio Coding </CodecLongName>

                        <CodecName>aac</CodecName>

                        <CodecTag>0x6134706d</CodecTag>

                        <CodecTagString>mp4a</CodecTagString>

                        <CodecTimeBase>1/44100</CodecTimeBase>

                        <Duration>13.653311</Duration>

                        <Index>1</Index>

                        <Language>und</Language>

                        <SampleFmt>fltp</SampleFmt>

                        <SampleRate>44100</SampleRate>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/44100</Timebase>

( )
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                    </Audio>

                    <Subtitle/>

                    <Video>

                        <AvgFps>25.000000</AvgFps>

                        <Bitrate>763.774000</Bitrate>

                        <CodecLongName>H.264 / AVC / MPEG-4 AVC / MPEG-4 part 10</CodecLo

                        <CodecName>h264</CodecName>

                        <CodecTag>0x31637661</CodecTag>

                        <CodecTagString>avc1</CodecTagString>

                        <CodecTimeBase>1/12800</CodecTimeBase>

                        <ColorPrimaries>bt470bg</ColorPrimaries>

                        <ColorRange>tv</ColorRange>

                        <ColorTransfer>smpte170m</ColorTransfer>

                        <Duration>12.960000</Duration>

                        <Fps>25.000000</Fps>

                        <HasBFrame>0</HasBFrame>

                        <Height>960</Height>

                        <Index>0</Index>

                        <Language>und</Language>

                        <Level>10</Level>

                        <NumFrames>324</NumFrames>

                        <PixFormat>yuv420p</PixFormat>

                        <Profile>High</Profile>

                        <RefFrames>1</RefFrames>

                        <Rotation>0.000000</Rotation>

                        <StartTime>0.000000</StartTime>

                        <Timebase>1/12800</Timebase>

                        <Width>544</Width>

                    </Video>

                </Stream>

            </MediaInfo>

            <MediaResult>

                <OutputFile>

                    <Bucket>test-123456789</Bucket>

                    <Region>ap-chongqing</Region>

                    <ObjectName>output/out.mp4</ObjectName>

                    <Md5Info>

                            <Md5>3df1f845d2ffd20a525a93ec40014d90</Md5>

                            <ObjectName>output/out.mp4</ObjectName>

                    </Md5Info>

                </OutputFile>

            </MediaResult>

        </Operation>

    </JobsDetail>

    <NextToken>225508</NextToken>
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</Response>
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模板接口

删除模板
最近更新时间：2023-06-20 17:32:27

删除模板。

该请求操作的实现使用公共请求头，了解公共请求头详情请参见 公共请求头部  文档。

该请求操作无特殊的请求头部信息。

该请求的请求体为空。

功能描述

请求

请求实例

DELETE /template/<TemplateId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

公共头部

非公共头部

请求体

响应

响应头

公共响应头

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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该响应包含公共响应头，了解公共响应头详情请参见 公共响应头部  文档。

该响应无特殊的响应头。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

Container 节点 Response 的内容：

该请求无特有错误信息，常见的错误信息请参见 错误码  文档。

特有响应头

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TemplateId>A</TemplateId>

<Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TemplateId Response 被删除的模板的 ID String

错误码

实际案例

请求

DELETE /template/t143ae6e040af6431aa772c9ec3f0a3f36 HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR98****-s

Host:test-1234567890.ci.ap-chongqing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=

<Response>

    <RequestId>NjJjYmU0YmRfOTBmYTUwNjRfODhjXzE=</RequestId>

    <TemplateId>t143ae6e040af6431aa772c9ec3f0a3f36</TemplateId>

<Response>
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查询模板
最近更新时间：2023-06-20 15:23:41

查询模板。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

参数的具体内容如下：

功能描述

请求

请求示例

GET /template HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

说明

Authorization: Auth String （详情请参见 请求签名  文档）。

请求头

请求体

请求参数

节点名称（关键

字）

父节

点
描述 类型

必

选

tag 无 模板类型，默认值: All
Strin

g
否

category 无
Official(系统预设模板)，Custom(自定义模板)，默认

值: Custom

Strin

g
否

ids 无 模板 ID，以 , 符号分割字符串 Strin

g

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
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tag 支持以下几种类型:

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

name 无 模板名称前缀
Strin

g
否

pageNumber 无 第几页，默认值:1
Integ

er
否

pageSize 无 每页个数，默认值:10
Integ

er
否

模板类型 tag

音视频转码 Transcode

视频转动图 Animation

视频截图 Snapshot

智能封面 SmartCover

音视频拼接 Concat

人声分离 VoiceSeparate

精彩集锦 VideoMontage

视频增强 VideoProcess

超级分辨率 SuperResolution

图片/文字水印 Watermark

语音合成 Tts

音视频转码Pro TranscodePro

极速高清 HighSpeedHd

图片处理 PicProcess

语音识别 SpeechRecognition

响应

响应头

https://cloud.tencent.com/document/product/460/42866
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该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应体

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhfMjc=</RequestId>

    <TotalCount>1</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>A</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

</Response>



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1885 共1950页

具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的模板类型，TemplateList 内容同创建模板接口的 Response，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

案例一：按照模板 ID 维度查询

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

TotalCount Response 模板总数 Int

PageNumber Response 当前页数，同请求中的 pageNumber Int

PageSize Response 每页个数，同请求中的 pageSize Int

TemplateList Response 模板数组 Container 数组

音视频转码

视频转动图

视频截图

智能封面

音视频拼接

人声分离

精彩集锦

视频增强

超级分辨率

图片/文字水印  

语音合成

音视频转码Pro  

极速高清

错误码

实际案例

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/77093
https://cloud.tencent.com/document/product/460/77088
https://cloud.tencent.com/document/product/460/77091
https://cloud.tencent.com/document/product/460/84734
https://cloud.tencent.com/document/product/460/77089
https://cloud.tencent.com/document/product/460/77098
https://cloud.tencent.com/document/product/460/77096
https://cloud.tencent.com/document/product/460/77097
https://cloud.tencent.com/document/product/460/77092
https://cloud.tencent.com/document/product/460/77099
https://cloud.tencent.com/document/product/460/77095
https://cloud.tencent.com/document/product/460/77094
https://cloud.tencent.com/document/product/460/77090
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请求

GET /template?ids=t1847cd4ca57f543e89f551dbe68169eb9,t1a30a323f55434a29b25bf2

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>

                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>
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            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad.mp4<

            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>

                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>
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案例二：按照分页列表维度查询

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

    <NonExistTIDs>

        <TemplateId>C</TemplateId>

    </NonExistTIDs>

</Response>

请求

GET /template?pageSize=10&pageNumber=1 HTTP/1.1

Authorization: q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-

Host: test-1234567890.ci.ap-beijing.myqcloud.com

Content-Length: 0

Content-Type: application/xml

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 100

Connection: keep-alive

Date: Thu, 14 Jul 2022 12:37:29 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzhf****

<Response>

    <RequestId>NTk0MjdmODlfMjQ4OGY3XzYzYzhf****</RequestId>

    <TotalCount>2</TotalCount>

    <PageNumber>1</PageNumber>

    <PageSize>10</PageSize>

    <TemplateList>

        <TemplateId>t1847cd4ca57f543e89f551dbe68169eb9</TemplateId>

        <Name>TemplateName</Name>

        <Tag>Transcode</Tag>

        <TransTpl>

            <Container>

                <Format>mp4</Format>

            </Container>

            <Video>

                <Codec>H.264</Codec>

                <Profile>high</Profile>

                <Bitrate>1000</Bitrate>
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                <Width>1280</Width>

                <Fps>30</Fps>

                <Preset>medium</Preset>

            </Video>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate>44100</Samplerate>

                <Bitrate>128</Bitrate>

                <Channels>4</Channels>

            </Audio>

            <TransConfig>

                <AdjDarMethod>scale</AdjDarMethod>

                <IsCheckReso>false</IsCheckReso>

                <ResoAdjMethod>1</ResoAdjMethod>

            </TransConfig>

            <TimeInterval>

                <Start>0</Start>

                <Duration>60</Duration>

            </TimeInterval>

        </TransTpl>

        <CreateTime>2020-08-05T11:35:24+0800</CreateTime>

        <UpdateTime>2020-08-31T16:15:20+0800</UpdateTime>

    </TemplateList>

    <TemplateList>

        <TemplateId>t140325e8918ac423da53b7d78dbbab564</TemplateId>

        <Name>template_name3544697</Name>

        <Tag>Concat</Tag>

        <BucketId>test-1234567890</BucketId>

        <Category>Custom</Category>

        <ConcatTemplate>

            <ConcatFragment>

                <Mode>Start</Mode>

                <Url>https://test-1234567890.cos.ap-chongqing.myqcloud.com/input/ad.mp4<

            </ConcatFragment>

            <Audio>

                <Codec>aac</Codec>

                <Samplerate/>

                <Bitrate/>

                <Channels/>

                <Remove>false</Remove>

            </Audio>

            <Video>

                <Codec>H.264</Codec>

                <Width>1280</Width>

                <Height>960</Height>
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                <Fps>15</Fps>

                <Remove>false</Remove>

                <Crf>25</Crf>

            </Video>

            <Container>

                <Format>mp4</Format>

            </Container>

            <DirectConcat>false</DirectConcat>

        </ConcatTemplate>

        <CreateTime>2022-06-29T14:37:44+0800</CreateTime>

        <UpdateTime>2022-06-29T14:37:44+0800</UpdateTime>

    </TemplateList>

</Response>
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批量任务接口

触发任务（独立节点）
最近更新时间：2023-08-11 18:10:33

通过独立任务参数触发批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Name
Req
ues

t

存量触发任务名称，支持中文、英文、数字、—和_，长

度限制128字符

Strin

g
是

Type

Req

ues

t

批量处理任务类型：Job
Strin

g
是

Input

Req

ues
t

待操作的文件信息
Cont
ainer

是

Operation

Req

ues

t

操作规则
Cont

ainer
是
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Container 类型 Operation 的具体数据描述如下：

节点名称（关键
字）

父节点 描述
类
型

是否
必选

Manifest
Reques

t.Input

COS 清单列表文件名，COS 清单生成的 

manifest.json 文件

Str

ing
否

UrlFile
Reques

t.Input

URL 文件名，文件中每行的 URL 为一个 COS 中

对象的访问地址

Str

ing
否

Prefix
Reques
t.Input

Object 前缀
Str
ing

否

Object
Reques

t.Input
文件路径

Str

ing
否

节点名称（关键

字）
父节点 描述 类型

是
否

必

选

TimeInterval
Request.O

peration
按时间过滤的触发范围

Cont

ainer
否

Tag
Request.O

peration
创建的媒体任务类型 Tag

Strin

g
是

Output
Request.O

peration

输出地址信息 

 当媒体任务类型不为 VideoTag 、 

ExtractDigitalWatermark 、 

MediaInfo 、 QualityEstimate 时，该参

数必选

Cont

ainer
否

JobParam
Request.O

peration
任务参数

Cont

ainer
是

QueueId
Request.O

peration
队列 ID

Strin

g
否

QueueType
Request.O

peration

队列类型，限制为 SpeedTranscoding ，当 

Tag 为 Transcode 且 QueueId 为空时生

效，表示为开启倍速转码

Strin

g
否

UserData
Request.O
peration

用户信息
Strin
g

否
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Container 类型 CallBackMqConfig 的具体数据描述如下：

Operation.Tag 支持的类型如下：

JobLevel Request.O

peration

任务优先级，级别限制：0 、1 、2。级别越大任

务优先级越高，默认为0

Strin

g

否

CallBackFor

mat

Request.O

peration

任务回调格式，JSON 或 XML，默认 XML，

优先级高于队列的回调格式

Strin

g
否

CallBackTyp
e

Request.O
peration

任务回调类型，Url 或 TDMQ，默认 Url，优先
级高于队列的回调类型

Strin
g

否

CallBack
Request.O

peration

任务回调地址，优先级高于队列的回调地址。设

置为 no 时，表示队列的回调地址不产生回调

Strin

g
否

CallBackMq

Config

Request.O

peration

任务回调 TDMQ 配置，当 CallBackType 为 

TDMQ 时必填

Cont

ainer
否

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

MqRegi
on

Request.Operation.Cal
lBackMqConfig

消息队列所属园区，目前支持园区 sh（上

海）、bj（北京）、gz（广州）、cd（成
都）、hk（中国香港）

St

ri
n

g

是

MqMod

e

Request.Operation.Cal

lBackMqConfig

消息队列使用模式，默认 Queue ：

主题订阅：Topic 

 队列服务: Queue

St

ri

n

g

是

MqNam

e

Request.Operation.Cal

lBackMqConfig
TDMQ 主题名称

St
ri

n

g

是

任务类型 Tag

视频转动图 Animatin

智能封面 SmartCover

音视频转码 Transcode
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Container 类型 TimeInterval 的具体数据描述如下：

视频截图 Snapshot

语音识别 SpeechRecognition

音视频拼接 Concat

精彩集锦 VideoMontage

SDR to HDR SDRtoHDR

人声分离 VoiceSeparate

视频增强 VideoProcess

超级分辨率 SuperResolution

音视频转封装 Segment

视频标签 VideoTag

图片处理 PicProcess

数字水印 DigitalWatermark

提取数字水印 ExtractDigitalWatermark

异步获取媒体信息 MediaInfo

音视频流分离 StreamExtract

语音合成 Tts

音频降噪 NoiseReduction

视频质量分析 QualityEstimate

异常图片检测 ImageInspect

节点名称（关

键字）
父节点 描述

类

型

是否

必选

默认

值
限制

Start
Request.Operatio

n.TimeInterval

开始

时间

St

ri

n

g

否 0

扫描对象的上传时

间 

%Y-%m-

%dT%H:%m:%

S%z 
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Container 类型 Output 的具体数据描述如下：

End Request.Operatio

n.TimeInterval

结束

时间

St

ri

n

g

否 当前

时间

扫描对象的上传时

间

%Y-%m-

%dT%H:%m:%

S%z 

节点名称

（关键

字）

父节点 描述 类型
是否

必选
限制

Region
Request.Opera

tion.Output
存储桶的地域

Strin

g
是 无

Bucket
Request.Opera
tion.Output

存储桶的名称
Strin
g

是 无

Object
Request.Opera

tion.Output
结果文件名称

Strin

g
否

当媒体任务类型不为 

Snapshot 、 

VoiceSeparate 、 

StreamExtract 时，

该参数必选

当媒体任务类型为

SmartCover，且
Request.Operation

.JobParam.Smart

Cover.Count 大于1

时，必须包含 

${Number} 参数

当媒体任务类型为 

Snapshot，且 

Snapshot.Count 大
于1时，必须包含  

${Number} 参数

AuObje

ct

Request.Opera

tion.Output

人声结果文件

名

Strin

g
否

当媒体任务类型为 

VideoSeParete 时，该

参数有效，且不能和 

Object 同时为空

SpriteO
bject

Request.Opera
tion.Output

雪碧图名 Strin
g

否 当媒体任务类型为 
Snapshot 时，该参

数有效，且不能和 

Object 同时为空
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Container 类型 StreamExtract 的具体数据描述如下：

Container 类型 JobParam 的具体数据描述如下：

当 

Snapshot.Count 大

于1时，必须包含 

${Number} 参数

仅支持 jpg

Stream

Extract

Request.Opera

tion.Output

流分离结果文

件配置信息，

当媒体任务类

型为 

StreamExtr

act 时该参数

有效，且必选

Cont

aine

r

是 无

节点

名称

（关

键

字）

父节点 描述
类

型

是

否

必

选

Inde

x

Request.Operation.Outp

ut.StreamExtract

流的编号，对应媒体信息中的 

Response.MediaInfo.Stream.Video.In

dex 和 

Response.MediaInfo.Stream.Audio.In

dex，详见 获取媒体信息接口 ，当输入媒体格

式为 mxf 格式时，只支持提取 video 流

St

ri

n

g

是

Obje

ct

Request.Operation.Outp

ut.StreamExtract
结果输出文件名

St
ri

n

g

是

节点名称（关键

字）
父节点 描述 类型

是

否

必
选

TemplateId
Request.Operatio

n.JobParam
模板 ID

Strin

g
否

TranscodeTe

mplateId

Request.Operatio

n.JobParam

转码模板 ID，当媒体任务类型为 

VideoProcess 、SuperResolution 

Cont

ainer

否

https://cloud.tencent.com/document/product/460/49284
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、 SDR2HDR 时有效

Animation
Request.Operatio

n.JobParam

动图任务参数，当媒体任务类型为 

Animation 时有效

Cont

ainer
否

Transcode
Request.Operatio

n.JobParam

转码任务参数，当媒体任务类型为 

Transcode 、VideoProcess 、

SuperResolution 、 SDR2HDR 时

该参数有效

Strin

g
否

SmartCover
Request.Operatio

n.JobParam

智能封面任务参数，当媒体任务类型为 

SmartCover 时有效

Cont

ainer
否

DigitalWater

mark

Request.Operatio

n.JobParam

数字水印参数，当媒体任务类型为 

Transcode 、VideoProcess 、

SuperResolution 、 

DigitalWatermark 时该参数有效

Cont

ainer
否

Watermark
Request.Operatio

n.JobParam

水印模板参数，同创建水印模板 
CreateMediaTemplate 接口的 

Request.Watermark，当媒体任务类

型为 Transcode 、 SDR2HDR 、 

VideoProcess 、 

SuperResolution 时该参数有效

Cont

ainer
否

WatermarkTe
mplateId

Request.Operatio
n.JobParam

水印模板参数，同创建水印模板 

CreateMediaTemplate 接口的 

Request.Watermark ，当媒体任务
类型为 Transcode 、 SDR2HDR 、 

VideoProcess 、 

SuperResolution 时该参数有效

Cont
ainer

否

RemoveWate

rmark

Request.Operatio

n.JobParam

去除水印参数，当媒体任务类型为 

Transcode 时有效

Cont

ainer
否

Subtitles
Request.Operatio

n.JobParam

字幕参数，当媒体任务类型为 

Transcode 时有效

Cont

ainer
否

Snapshot
Request.Operatio

n.JobParam

截图任务参数，当媒体任务类型为 

Snapshot 时有效

Cont

ainer
否

SpeechReco

gnition

Request.Operatio

n.JobParam

语音识别任务参数，当媒体任务类型为 

SpeechRecognition 时有效

Cont

ainer
否

ConcatTempl

ate

Request.Operatio

n.JobParam

拼接任务参数，当媒体任务类型为 

Concat 时有效

Cont

ainer
否

VoiceSeparat Request.Operatio 人声分离任务参数，当媒体任务类型为 Cont 否
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Container 类型 DigitalWatermark 的具体数据描述如下：

e n.JobParam VoiceSeparate 时有效 ainer

VideoMontag

e

Request.Operatio

n.JobParam

精彩集锦任务参数，当媒体任务类型为 

VideoMontage 时有效

Cont

ainer
否

SDRtoHDR
Request.Operatio

n.JobParam

SDR2HDR 任务参数，当媒体任务类型

为 SDRtoHDR 时有效

Cont

ainer
否

VideoProcess
Request.Operatio

n.JobParam

视频增强任务参数，当媒体任务类型为 

VideoProcess 时有效

Cont

ainer
否

SuperResolut

ion

Request.Operatio

n.JobParam

超分辨率任务参数，当媒体任务类型为 

SuperResolution 时有效

Cont

ainer
否

Segment
Request.Operatio

n.JobParam

转封装任务参数，当媒体任务类型为 

Segment 时有效

Cont

ainer
否

ExtractDigital

Watermark

Request.Operatio

n.JobParam

提取数字水印任务参数，当媒体任务类型

为 ExtractDigitalWatermark 时有效

Cont

ainer
否

VideoTag
Request.Operatio

n.JobParam

视频标签任务参数，当媒体任务类型为 

VideoTag 时有效

Cont

ainer
否

TtsTpl
Request.Operatio

n.JobParam

语音合成模板参数，当媒体任务类型为 

Tts 时有效

Cont

ainer
否

NoiseReducti

on

Request.Operatio

n.JobParam

音频降噪模板参数，当媒体任务类型为 

NoiseReduction 时有效

Cont

ainer
否

注意

 优先使用 TemplateId，无 TemplateId 时使用对应任务类型的参数。

节点名称

（关键

字）

父节点 描述
类

型

是

否

必

选

Messag

e

Request.Operation.

JobParam.DigitalWa
termark

数字水印嵌入的字符串信息，长度不超过64个

字符，仅支持中文、英文、数字、_、-和*

Str

ing
是

Type

Request.Operation.

JobParam.DigitalWa

termark

水印类型，当前仅可设置为 Text
Str

ing
是
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Container 类型 Animation 的内容： 

同 提交动图任务  的 Request.Operation.Animation

Container 类型 Transcode 的内容： 

同 提交音视频转码任务  的 Request.Operation.Transcode

Container 类型 Watermark 的内容： 

同 提交音视频转码任务  的 Request.Operation.Watermark

Container 类型 RemoveWatermark 的内容： 

同 提交音视频转码任务  的 Request.Operation.RemoveWatermark

Container 类型 SmartCover 的内容： 

同 提交智能封面任务  的 Request.Operation.SmartCover

Container 类型 Snapshot 的内容： 

同 提交截图任务  的 Request.Operation.Snapshot

Container 类型 SpeechRecognition 的内容： 

同 提交语音识别任务  的 Request.Operation.SpeechRecognition

Container 类型 ConcatTemplate 的内容： 

同 提交拼接任务  的 Request.Operation.ConcatTemplate

Container 类型 VoiceSeparate 的内容： 

同 提交人声分离任务  的 Request.Operation.VoiceSeparate

Container 类型 VideoMontage 的内容： 

同 提交精彩锦集任务  的 Request.Operation.VideoMontage

Container 类型 SDRtoHDR 的内容： 

同 提交SDRtoHDR任务  的 Request.Operation.SDRtoHDR

Container 类型 VideoProcess 的内容： 

同 提交视频增强任务  的 Request.Operation.VideoProcess

Container 类型 SuperResolution 的内容： 

同 提交超分辨率任务  的 Request.Operation.SuperResolution

Container 类型 Segment 的内容： 

同 提交转封装任务  的 Request.Operation.Segment

Container 类型 ExtractDigitalWatermark 的内容： 

同 提交提取数字水印任务  的 Request.Operation.ExtractDigitalWatermark

Version Request.Operation.

JobParam.DigitalWa

termark

水印版本，当前仅可设置为 V1 Str

ing

是

IgnoreE

rror

Request.Operation.

JobParam.DigitalWa

termark

 当添加水印失败是否忽略错误继续执行任

务，限制为 true/false，默认为false

 当 Request.Operation.Tag 为 

DigitalWatermark 时，该参数无效，添

加水印失败任务失败

Str

ing
否

https://cloud.tencent.com/document/product/460/84784
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84781
https://cloud.tencent.com/document/product/460/84790
https://cloud.tencent.com/document/product/460/84791
https://cloud.tencent.com/document/product/460/84780
https://cloud.tencent.com/document/product/460/84798
https://cloud.tencent.com/document/product/460/84788
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84794
https://cloud.tencent.com/document/product/460/84792
https://cloud.tencent.com/document/product/460/84782
https://cloud.tencent.com/document/product/460/84774
https://cloud.tencent.com/document/product/460/84789
https://cloud.tencent.com/document/product/460/84786
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Container 类型 VideoTag 的内容： 

同 提交智能视频标签任务  的 Request.Operation.VideoTag

Container 类型 TtsTpl 的内容： 

同 提交语音合成任务  的 Request.Operation.TtsTpl

Container 类型 NoiseReduction 的内容： 

同 提交音频降噪任务  的 Request.Operation.NoiseReduction

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

响应

响应头

响应体

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

https://cloud.tencent.com/document/product/460/84779
https://cloud.tencent.com/document/product/460/84797
https://cloud.tencent.com/document/product/436/85045
https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container

节点名称（关

键字）
父节点 描述 类型

Code
Response.

JobsDetail
错误码，只有 State为 Failed 时有意义

Stri

ng

Message
Response.

JobsDetail
错误描述，只有 State为 Failed 时有意义

Stri

ng

Type
Response.

JobsDetail
批量处理任务类型，Job

Stri

ng

Name
Response.

JobsDetail
新创建任务的名称

Stri

ng

JobId
Response.

JobsDetail
新创建任务的 ID

Stri

ng

State
Response.

JobsDetail

任务的状态，为 Submitted、Running、Success、

Failed、Pause、Cancel 其中一个

Stri

ng

CreationTi Response. 任务的创建时间 Stri
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

me JobsDetail ng

StartTime
Response.

JobsDetail
任务的开始时间

Stri

ng

EndTime
Response.

JobsDetail
任务的结束时间

Stri

ng

Input
Response.

JobsDetail
该任务的输入资源地址，同请求中的 Request.Input 节点

Con

tain

er

Operation
Response.

JobsDetail

该任务的操作规则，同请求中的 Request.Input 

Operation

Con

tain

er

错误码

实际案例

请求

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Job</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <UserData>this is my inventorytriggerjob</UserData>

        <CallBack>https://www.callback.com</CallBack>

        <Tag>Transcode</Tag>

        <JobParam>

            <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

https://cloud.tencent.com/document/product/460/42867
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        </JobParam>

        <Output>

            <Region>ap-chongqing</Region>

            <Bucket>test-1234567890</Bucket>

            <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

        </Output>

        <JobLevel>0</JobLevel>

    </Operation>

</Request>

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18x****

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18x****<RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <Tag>Transcode</Tag>
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            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>

                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

</Response>
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触发任务（工作流）
最近更新时间：2023-06-20 17:32:27

通过工作流触发批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求操作的实现需要有如下请求体。

功能描述

请求

请求示例

POST /inventorytriggerjob HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

Content-Length: <length>

Content-Type: application/xml

<body>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

<Request>

    <Name>demo</Name>

    <Type>Workflow</Type>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据描述如下：

Container 类型 Request 的具体数据描述如下：

Container 类型 Input 的具体数据描述如下：

Container 类型 Operation 的具体数据描述如下：

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

节点名称（关键字） 父节点 描述 类型 是否必选

Request 无 保存请求的容器 Container 是

节点名称（关

键字）

父节

点
描述 类型

是否

必选

Name
Requ

est

批量触发任务名称，支持中文、英文、数字、—和_，

长度限制128字符
String 是

Type
Requ

est
批量处理任务类型: Workflow String 否

Input
Requ

est
待操作的媒体信息

Contai

ner
是

Operation
Requ

est
操作规则

Contai

ner
是

节点名称（关
键字）

父节点 描述 类型
是否
必选

Manifest
Request.I

nput

COS 清单列表文件名，COS 清单生成的 

manifest.json 文件

Stri

ng
否

UrlFile
Request.I

nput

URL 文件名，文件中每行的 URL 为一个 COS 

中对象的访问地址

Stri

ng
否

Prefix
Request.I
nput

Object 前缀
Stri
ng

否

Object
Request.I

nput
媒体文件名

Stri

ng
否
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Container 类型 TimeInterval 的具体数据描述如下：

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

节点名称（关键字） 父节点 描述 类型 是否必选

WorkflowIds Request.Operation 触发的工作流 ID String 是

TimeInterval Request.Operation 按时间过滤的触发范围 Container 否

节点名称

（关键
字）

父节点
描
述

类型

是

否
必

选

默认
值

限制

Start

Request

.TimeInt

erval

开

始

时

间

String 否 0
扫描对象的上传时间 

%Y-%m-%dT%H:%m:%S%z 

End

Request

.TimeInt

erval

结
束

时

间

String 否
当前

时间

扫描对象的上传时间 

%Y-%m-%dT%H:%m:%S%z 

响应

响应头

响应体

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Message/>

        <Type>Workflow</Type>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

https://cloud.tencent.com/document/product/460/42866
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具体的数据内容如下：

Container 节点 Response 的内容：

Container 节点 JobsDetail 的内容：

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container

节点名称

（关键字）
父节点 描述 类型

Code
Response.J

obsDetail
错误码，只有 State 为 Failed 时有意义

Strin

g

Message
Response.J

obsDetail
错误描述，只有 State 为 Failed 时有意义

Strin

g

Type
Response.J

obsDetail
批量处理任务类型

Strin

g

Name
Response.J

obsDetail
新创建任务的名称

Strin

g

JobId
Response.J

obsDetail
新创建任务的 ID

Strin

g

State Response.J 任务的状态，为 Submitted、Running、Success、 Strin
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该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

obsDetail Failed、Pause、Cancel 其中一个 g

Creation

Time

Response.J

obsDetail
任务的创建时间

Strin

g

StartTim

e

Response.J

obsDetail
任务的开始时间

Strin

g

EndTime
Response.J

obsDetail
任务的结束时间

Strin

g

Input
Response.J

obsDetail
同请求中的 Request.Input

Cont

ainer

Operatio

n

Response.J

obsDetail
同请求中的 Request.Operation

Cont

ainer

错误码

实际案例

请求

POST /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

Content-Length: 166

Content-Type: application/xml

<Request>

    <Name>demo</Name>

    <Type>Workflow</Name>

    <Input>

        <Prefix>input</Prefix>

    </Input>

    <Operation>

        <TimeInterval>

            <Start>2022-02-01T12:00:00+0800</Start>

            <End>2022-05-01T12:00:00+0800</End>

        </TimeInterval>

        <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

    </Operation>

</Request>

https://cloud.tencent.com/document/product/460/42867
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响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 230

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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取消任务
最近更新时间：2023-06-20 17:32:28

取消批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该请求无响应体。

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

功能描述

请求

请求示例

PUT /inventorytriggerjob/<jobId>?cancel HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

错误码

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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实际案例

请求

PUT /inventorytriggerjob/b-xxx-xxx-xxx-xxxx?cancel HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Length: 0

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=
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查询任务
最近更新时间：2023-06-20 17:32:28

查询批量数据处理任务。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求的请求体为空。

此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

功能描述

请求

请求示例

GET /inventorytriggerjob/<jobId> HTTP/1.1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

响应

响应头

响应体

<Response>

    <RequestId><RequestId>

    <JobsDetail>

    ...

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/460/42866
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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具体的数据内容如下：

Container 节点 Response 的内容：

对于不同的触发方式，JobsDetail 的内容不同，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

    </JobsDetail>

    <NonExistJobIds></NonExistJobIds>

</Response>

节点名称（关键字） 父节点 描述 类型

Response 无 保存结果的容器 Container

节点名称（关键

字）
父节点 描述 类型

RequestId
Respons

e
请求的唯一 ID String

JobsDetail
Respons

e
任务的详细信息

Containe

r

NonExistJobId

s

Respons

e

查询的 ID 中不存在的任务，所有任务都存在时不返

回
String

工作流

独立任务

错误码

实际案例

请求

GET /inventorytriggerjob/b3deffea2f84911ec9cb15254008618d9 HTTP/1.1

Accept: */*

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76887#jobsDetail
https://cloud.tencent.com/document/product/460/80155#jobsDetail
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HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

</Response>
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批量拉取任务
最近更新时间：2023-06-20 17:32:28

拉取批量数据处理任务列表。

此接口仅使用公共请求头部，详情请参见 公共请求头部  文档。

该请求无请求体。

参数的具体内容如下：

功能描述

请求

请求示例

GET /inventorytriggerjob?size=&states=&startCreationTime=&endCreationTime= HTTP/1

Host: <BucketName-APPID>.ci.<Region>.myqcloud.com

Date: <GMT Date>

Authorization: <Auth String>

说明

Authorization: Auth String（详情请参见 请求签名  文档）。

通过子账号使用时，需要授予相关的权限，详情请参见 授权粒度详情  文档。

请求头

请求体

请求参数

节点名称（关

键字）

父

节

点

描述
类

型

必

选

nextToken 无 请求的上下文，用于翻页。上次返回的值
Str

ing
否

size 无 拉取的最大任务数。默认为10。最大为100

Int

eg

er

否

https://cloud.tencent.com/document/product/460/42865
https://cloud.tencent.com/document/product/436/7778
https://cloud.tencent.com/document/product/460/41741
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此接口仅返回公共响应头部，详情请参见 公共响应头部  文档。

该响应体返回为 application/xml 数据，包含完整节点数据的内容展示如下：

具体的数据内容如下：

type 无 拉取批量任务类型，工作流类型 Workflow 、任务类型 Job
Str

ing
否

orderByTi

me
无 Desc 或者 Asc。默认为 Desc

Str

ing
否

states 无

拉取该状态的任务，以,分割支持多状态 

 All，Submitted，Running，Success，Failed，Pause，

Cancel。默认为 All

Str

ing
否

startCreati
onTime

无
拉取创建时间大于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z 

Str
ing

否

endCreati

onTime
无

拉取创建时间小于等于该时间的任务。格式为：

%Y-%m-%dT%H:%m:%S%z

Str

ing
否

workflowId 无 工作流 ID
Str

ing
否

jobId 无 批量触发任务 ID
Str

ing
否

name 无 批量触发任务名称
Str

ing
否

响应

响应头

响应体

<Response>

    <RequestId></RequestId>

    <JobsDetail>

    .

    </JobsDetail>

    <NextToken></NextToken>

</Response>

..

节点名称（关键字） 父节点 描述 类型

https://cloud.tencent.com/document/product/460/42866
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Container 节点 Response 的内容：

对于不同的触发方式，JobsDetail 的内容不同，请参照以下链接：

该请求操作无特殊错误信息，常见的错误信息请参见 错误码  文档。

Response 无 保存结果的容器 Container

节点名称（关键字） 父节点 描述 类型

RequestId Response 请求的唯一 ID String

JobsDetail Response 任务的详细信息 Container 数组

NextToken Response 翻页的上下文 Token String

工作流

独立任务

错误码

实际案例

请求

GET /inventorytriggerjob HTTP/1.1

Authorization:q-sign-algorithm=sha1&q-ak=AKIDZfbOAo7cllgPvF9cXFrJD0a1ICvR****&q-s

Host:bucket-1250000000.ci.ap-beijing.myqcloud.com

响应

HTTP/1.1 200 OK

Content-Type: application/xml

Content-Length: 666

Connection: keep-alive

Date: Mon, 28 Jun 2022 15:23:12 GMT

Server: tencent-ci

x-ci-request-id: NTk0MjdmODlfMjQ4OGY3XzYzYzh****=

<Response>

    <RequestId>NjJiZDU1ZmZfOTBmYTUwNjRfNzdjY18xYQ==</RequestId>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Workflow</Type>

https://cloud.tencent.com/document/product/460/42867
https://cloud.tencent.com/document/product/460/76887
https://cloud.tencent.com/document/product/460/80155
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        <Message/>

        <Name>demo</Name>

        <JobId>b3deffea2f84911ec9cb15254008618d9</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>-</StartTime>

        <EndTime>-</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <WorkflowIds>w7476ff3564ee45b7b490d64bccaba6cc</WorkflowIds>  

        </Operation>

    </JobsDetail>

    <JobsDetail>

        <Code>Success</Code>

        <Type>Job</Type>

        <Message/>

        <Name>demo</Name>

        <JobId>be8f65004eb8511eaaed4f377124a303c</JobId>

        <State>Running</State>

        <CreationTime>2022-06-27T15:23:10+0800</CreationTime>

        <StartTime>2022-06-27T15:23:11+0800</StartTime>    

        <EndTime>2022-06-27T15:25:10+0800</EndTime>

        <Input>

            <Prefix>input</Prefix>

        </Input>

        <Operation>

            <TimeInterval>

                <Start>2022-02-01T12:00:00+0800</Start>

                <End>2022-05-01T12:00:00+0800</End>

            </TimeInterval>

            <QueueId>p893bcda225bf4945a378da6662e81a89</QueueId>

            <UserData>this is my inventorytriggerjob</UserData>

            <CallBack>https://www.callback.com</CallBack>

            <JobParam>

                <TemplateId>t1460606b9752148c4ab182f55163ba7cd</TemplateId>

            </JobParam>

            <Output>

                <Region>ap-chongqing</Region>

                <Bucket>test-1234567890</Bucket>
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                <Object>output/${InventoryTriggerJobId}/out.mp4</Object>

            </Output>

            <JobLevel>0</JobLevel>

        </Operation>

    </JobsDetail>

    <NextToken>25</NextToken>

</Response>
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错误码
最近更新时间：2023-07-14 14:47:02

图片下载失败时，返回包 Headers 中的 X-ErrNo 为错误码字段，请参考下表进行处理。

功能说明

说明

 其他透传自 COS 下载侧错误码详见 COS 错误码 。

错误码列表

下载时处理错误码

错误

码
说明 处理措施

-103 无效的请求；请求报文无法识别。 请检查请求内容。

-104
无效的 APPID，URL 中包含的 APPID 无效，或
者域名没有和 APPID 绑定。

请检查 APPID 是否正确。

-105
无效的样式名，URL 中指定的样式名或者别名没

有配置。
请检查样式配置或样式名内容。

-106 无效的 URL，URL 格式不符合格式要求。 请检查 URL 格式。

-107 无效的 Host 头域。 请检查 Host 是否正确。

-108 无效的 Referer。 请检查相关 Referer 配置。

-109

无效的样式名 ID。没有找到该样式名对应的图片。

可能是上传该图片后，新增的样式名， 因此图片上

传时不能生成该样式名对应的数据。

-

-110 该图片在黑名单中。 -

-113 该文档的类型不支持
文档预览目前所支持的输入文件类型，请

参见 规则与限制

-120
回源到源站获取数据时，源站返回的数据有异常，

无法正常获取到图片数据。
请检查源站数据。

-124 下载偏移错误。HTTP 请求的 Range 断点续传偏

移量可能设置错误。

请检查断点续传偏移量的相关配置。

https://cloud.tencent.com/document/product/436/8432
https://cloud.tencent.com/document/product/460/36620
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-154 原图保护机制禁止该 URL 下载。 请使用样式访问。

-156 强制执行302流程。 -

-162 业务配置为欠费，禁止下载图片。 请及时充值。

-163 业务配置不存在。 请检查相关配置项。

-164 热图下载，限制。
请降低请求频率，或 提交工单  联系我们

处理。

-165 攻击性下载请求，限制。 -

-166 消息格式错误。 -

-167 文件太大，无法支持图片下载。 请降低图片大小。

-441 图片格式不符，无法进行压缩。

请使用数据万象支持的图片格式进行图片

处理操作。具体支持格式为 jpg、bmp、

gif、png、webp。

-442 图片超过限制大小。 请将图片长宽限制在9999像素以内。

-443 图片格式不满足处理限制。
请使用支持的图片格式进行处理，详情请

参见 规则与限制

-447 图片分辨率超出限制或动图帧数过多。
请将图片长宽限制在9999像素以内（动

图请限制帧数）。

-901 压缩超时。 -

-902
回源超时，镜像存储功能把请求转发到开发商源

站，但没有收到响应，超时了。
请检查源站数据或回源配置。

-300

6
该文档被加密，无法解析。 -

-300
8

该文件为空文件，无法解析。 -

-301

1
该文档的类型不支持。

文档预览目前所支持的输入文件类型，请

参见 规则与限制

-301

5
请求的页码不存在。 -

-307

5
该文档超过100MB，无法解析。 输入文件大小需限制在100MB之内

https://console.cloud.tencent.com/workorder/category
https://cloud.tencent.com/document/product/460/36620
https://cloud.tencent.com/document/product/460/36620
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-506

2

图片涉嫌违禁。 请检查图片内容是否违规。

-610

1
图片不存在、图片没有上传或者图片已经删除。 请检查请求源数据。

-290

33
下载请求无有效的 range。 -

-290

34
下载的 offset 大于文件 size。 -

-292

14
触发频控。

请降低请求频率，或 提交工单  联系我们

处理。

-401

68
原图为空数据。 请检查请求源数据。

-461

52
非法的 bucketName。 请检查存储桶名称是否正确。

-461

54
非法的 APPID。 请检查 APPID 是否正确。

-466

14
文件尚未上传完成，禁止下载。 请等待文件上传成功后请求。

-466

17
命中黑名单。 请检查图片内容是否违规。

-466

18
签名校验失败。 请检查签名是否准确。

-466

19
签名过期。 请更新签名。

-466

20
Bucket 被封禁。

您的 Bucket 已被封禁，请 提交工单  联

系我们处理。

-466

21
文件被封禁。

您的资源已被封禁，请 提交工单  联系我

们处理。

-466

27
用户目前在黑名单中。

您的账号已被封禁，请 提交工单  联系我

们处理。

-466

28
文件不存在。 请确认请求下载的文件是否真实存在。

https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
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-466

42

APPID 不存在。 请检查 APPID 是否正确。

-466
46

文件已封禁。
文件已被封禁，请检查文件内容是否违
规。

-466

61
无权访问 请联系资源所有者授予权限。

持久化处理错误码

错误码 说明 处理措施

-6099

8

图片处理参数无

效。
请检查图片处理规则是否正确。

-6099

7

图片处理规则过

多。
持久化处理当前最多支持五条规则，请控制在五条以内。

-6099

6

文件太大，无法处

理。
请将文件控制在32MB以内。

-6098

7
图片获取失败。 请检查图片 URL。

-6098

3
无效的 Host。 请检查 Host。

-6097

2
无效地域。

请检查请求地域是否支持数据万象服务。数据万象现有地域详见 地域与

域名 。

-6096

7
图片样式不存在。 请检查图片样式。

-6095

7

样式数量超过上

限。
当前样式数量上限为100条，如需更多样式请 提交工单  联系我们。

-6095

5
无效的 URL。 请检查 URL 是否正确。

-6095

0
未指定文件。 请在请求中指定需要处理的文件。

-6094

9
请求频率过高。 请放缓请求频率。如有需要请 提交工单  联系我们提升频率限制。

-6094

8

账号涉嫌违规。 您的 APPID 已被封禁，请 提交工单  联系我们处理。

https://cloud.tencent.com/document/product/460/31066
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category
https://console.cloud.tencent.com/workorder/category


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1926 共1950页

-6093

8
签名信息不完整。 请检查签名信息中的必选项。

-6093

6
请求被拒绝。 AccessDenied。

-6093

2
签名错误。 签名无效，请检查签名信息是否匹配。

-6299

9
无效的图片格式。 请检查图片格式是否正确。

文档预览错误码

错误

码
说明 处理措施

-30

06
文档为加密文件 建议使用已解密的文档。

-30

08
文档长度为0 请确认文档是否正常。

-30

11
文档类型不支持

请确认文档是否在支持范围内，支持的文档类型详情请参见 规则与

限制 。

-30
15

请求的页数超过了文档总
页数

请检查请求页数是否正确。

内容审核错误码

错误

码
错误码 错误信息 说明

-65
001

InternalError
internal error, please try 
again.

内部错误

-65

002

InvalidArgum

ent
invalid params 参数/消息体解析失败。

-65

003

InvalidArgum

ent

invalid params 参数不合法。

missing Object

invalid DetectType

Param CallbackVersion is 

https://cloud.tencent.com/document/product/460/36620
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illegal

No such bucket

The image is empty file

Param is illegal

-65

004

AuditingJobN

otFound
JobId not found 任务不存在。

-65

006
SlowDown RequestLimitExceeded 请求频率过高。

-65
007

ResourceNot
Supported

Decode file failed
文件解码失败，请检查文件是否损
坏。

-65

010

InvalidArgum

ent

Download file failed 下载文件失败，请检查文件是否损

坏。
url unreachable

-65

011

InvalidArgum

ent

File is too large
文件过大，不支持审核。

File is too large or empty

-65

012

InvalidArgum

ent
Resolution is too small 图片分辨率过低，不支持审核。

-65

014

CIRoleNotExi

st

No permission for 

CI_QCSRole

审核失败，请先开通数据万象角色。 

(万象角色不存在/未授权)

-65

015

InvalidArgum

ent

There is not any label 

opened

未使用审核策略，请添加审核策略后

重试。

-65

016

InvalidArgum

ent

The bizType provided does 

not exist

提供的BizType不存在，请检查后

重试。

-65

019

AccessDenie

d
No permission to do this 鉴权失败, 没有passrole权限。

-65

020

ResourceNot

Found

The file does not exist

文件不存在。No such key

No such object

-65

023

InvalidArgum

ent
File size is too small 文件大小太小。



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1928 共1950页

-65

024

InvalidArgum

ent

Image aspect ratio is too 

large

图片宽高比过大。

媒体处理错误码

错误码 错误信息 说明

1007 InternalError 内部错误

1010 InvalidUrl 无效的 url

1011 InvalidContent 无效的请求体

1012 MissingAuthorization 缺失签名

1013 InvalidAuthorization 无效的签名

1014 SignatureExpired 签名已过期

1015 InvalidArgument 无效的参数

1016 MissingContent 缺失请求体

1017 InvalidHost 无效的 host

1018 AccessDenied 拒绝访问

1019 SecretidNotExist 密钥不存在

1020 SlowDown 频率控制

1021 InvalidContentType 请求体类型无效

1100 BucketAlreadyBinded 存储桶已绑定

1103 ResourceNotFound 资源未找到

1106 QueueNotFound 队列未找到

1107 TemplateNotFound 模板未找到

1109 BindedBucketNumLimit 绑定的存储桶数量超过上限

1110 CreatedTemplateNumLimit 创建的模板数量超过上限

1111 MediaBucketUnBinded 存储桶未绑定

1112 TemplateNameDuplicate 模板命名重复
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1114 ActiveWorkflowForbiddenUpdate 开启的工作流禁止更新

1120 WorkFlowNumLimit 创建的工作流数量超过上限

1124 WriteTargetBucketDenied 禁止写入存储桶

1145 QueueNumLimit 创建的队列数量超过上限
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请求签名
最近更新时间：2023-07-12 16:17:52

腾讯云数据万象服务通过签名来验证请求的合法性。开发者通过将签名授权给客户端，使其具备上传下载及管理指定

资源的能力。

使用数据万象服务时，可通过 RESTful API 发起 HTTP 匿名请求或 HTTP 签名请求，对于签名请求，服务器端

将会对请求发起者进行身份验证。

数据万象基于 对象存储（Cloud Object Storage，COS） ，当前签名算法与 COS 保持一致，基于密钥 

HMAC（Hash Message Authentication Code）的自定义方案进行身份验证。

数据万象已实现和 COS 域名的合并，使用 COS 域名即可实现图片处理操作。对于数据万象域名和 COS 域名，

在使用上有所区别，需要分别使用不同的签名版本：

生成签名所需信息包括 APPID（例如1250000000），Bucket 名称（例如 examplebucket-ci），项目的 

SecretID 和 SecretKey。

匿名请求：HTTP 请求不携带任何身份标识和鉴权信息，通过 RESTful API 进行 HTTP 请求操作。

签名请求：HTTP 请求时携带签名，服务器端收到消息后，即可进行身份验证，验证成功则可接受并执行请求，

否则将会返回错误信息并丢弃此请求。

签名算法

数据万象域名：形式为 <BucketName-APPID>.<picture region>.myqcloud.com/<picture name> ，

例如 examplebucket-1250000000.picsh.myqcloud.com/picture.jpeg ，操作需使用 JSON 版本签名，

可参阅 JSON 版本 请求签名 。

COS 域名：形式为 <BucketName-APPID>.cos.<Region>.myqcloud.com ，例如 

examplebucket-1250000000.cos.ap-shanghai.myqcloud.com/picture.jpeg ，操作需使用 XML 版本

签名，可参见 XML 版本 请求签名 。

签名适用场景

场景 适用签名

下载时数据处理
无防盗链 不验证签名

开启防盗链 验证签名

上传时数据处理 持久化处理 XML 版本签名

Bucket 接口操作 查询、开通、删除等 XML 版本签名

内容识别 鉴黄、违法违规 XML 版本签名

签名工具

https://cloud.tencent.com/document/product/436
https://cloud.tencent.com/document/product/436/6054
https://cloud.tencent.com/document/product/436/7778


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1931 共1950页

获取这些信息的方法如下：

1. 登录 数据万象控制台 ，单击左侧菜单栏存储桶管理。

2. 单击需要管理的存储桶，进入存储桶管理页面。

3. 单击【存储桶配置】，即可查看存储桶名称和 Bucket ID 。若当前项目无存储桶，您可参考 创建存储桶  文档

进行创建。

4. 进入 访问管理  API 密钥管理页面，获取 SecretID 和 SecretKey。

数据万象签名计算过程与 COS 一致，您可以根据签名适用场景，使用 COS 提供的 在线签名工具  生成所需版本签

名。

通过 RESTful API 发起的 HTTP 签名请求，可以通过以下几种方式传递签名：

1. 通过标准的 HTTP Authorization 头，如

Authorization: q-sign-algorithm=sha1&q-ak=...&q-sign-time=1557989753;1557996953&...&q-

signature=...

2. 作为 HTTP 请求参数，请注意 UrlEncode，如

/exampleobject?q-sign-algorithm=sha1&q-ak=...&q-sign-

time=1557989753%3B1557996953&...&q-signature=...

签名使用

注意

上述示例中使用 ...  省略了部分具体签名内容。

https://console.cloud.tencent.com/ci/index
https://cloud.tencent.com/document/product/460/10637
https://console.cloud.tencent.com/cam/capi
https://cloud.tencent.com/document/product/436/30442
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附录

公共请求头部
最近更新时间：2022-12-12 16:24:21

此篇文档将为您介绍在使用 API 时候会使用到的公共请求头部（Request Header），下文提到的头部在之后的

具体 API 文档中不再赘述。

描述

请求头部列表

Header 名称 描述 类型 是否必选

Authorizati

on

携带鉴权信息，用以验证请求合法性的签名信息。针对

公有读的对象可不携带此头部，如通过请求参数传递鉴

权信息也无需携带此头部，详情请参见 请求签名  文

档。

stri

ng
是。

Content-

Length
RFC 2616 中定义的 HTTP 请求内容长度（字节）。

inte

ger

否。针对 PUT 和 

POST 请求，此头
部是必选项。

Content-

Type

RFC 2616 中定义的 HTTP 请求内容类型

（MIME），例如 application/xml 。

stri

ng

否。针对有请求体

的 PUT 和 POST 

请求，此头部是必

选项。

Content-
MD5

RFC 1864 中定义的经过 Base64 编码的请求体内容 

MD5 哈希值，例如 

ZzD3iDJdrMAAb00lgLLeig== 。此头部用于完整

性检查，验证请求体在传输过程中是否发生变化。

stri
ng

否。

Date
RFC 1123 中定义的 GMT 格式当前时间，例如 

Wed, 29 May 2019 04:10:12 GMT 。

stri

ng
否。

Host

请求的主机，形式为 

<BucketName-APPID>.ci.

<Region>.myqcloud.com

stri

ng
是。

x-ci-

security-

token

使用临时安全凭证时需要传入的安全令牌字段，数据万

象可复用对象存储 临时安全凭证方法，详情请参见 临

时安全凭证  相关说明。

stri

ng

否。当使用临时密

钥并通过 

Authorization 

https://cloud.tencent.com/document/product/460/6968
https://cloud.tencent.com/document/product/436/31315#.E4.B8.B4.E6.97.B6.E5.AE.89.E5.85.A8.E5.87.AD.E8.AF.81
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携带鉴权信息时，

此头部为必选项。
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公共响应头部
最近更新时间：2020-03-24 16:48:00

此篇文档将为您介绍在使用 API 时候会出现的公共返回头部（Response Header），下文提到的头部会在之后

的具体 API 文档中不再赘述。

描述

响应头部列表

Header 名

称
描述

类

型

Content-

Length
RFC 2616 中定义的 HTTP 响应内容长度（字节）。

str

ing

Content-

Type
RFC 2616 中定义的 HTTP 响应内容类型（MIME）。

str

ing

Connecti

on

RFC 2616 中定义，表明响应完成后是否会关闭网络连接。枚举值：keep-

alive，close。

En

um

Date
RFC 1123 中定义的 GMT 格式服务端响应时间，例如

Wed, 29 May 2019 04:10:12 GMT 。

str

ing

Server 接受请求并返回响应的服务器的名称，默认值： tencent-ci 。
str

ing

x-ci-

request-

id

每次请求发送时，服务端将会自动为请求生成一个 ID。
str

ing

x-ci-
trace-id

每次请求出错时，服务端将会自动为这个错误生成一个 ID。仅当请求出错时才会在
响应中包含此头部。

str
ing
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结构体
最近更新时间：2023-08-10 18:13:43

Container 类型  的具体数据描述如下：

MediaWorkflow_Topology_Nodes_Start_Input

节点名称（关键

字）
描述 类型

是否必

选
限制

ObjectPrefix Object 前缀 String 是 无

NotifyConfig 回调信息，如果不设置，则使用队列的回调信息
Contai
ner

否 无

ExtFilter 文件后缀过滤器
Contai

ner
否 无

NotifyConfig

节点名称（关
键字）

描述
类
型

是

否
必

选

默
认

值

限制

Url 回调地址
Str

ing
是 无 不能为内网地址

Type 回调类型
Str

ing
是 无

Url：url 回调

TDMQ：tdmq 消息回调

Event 回调信息
Str

ing
是 无

TaskFinish：任务完成 

WorkflowFinish：工作流完成 

支持多种事件，以逗号分隔

ResultForm

at
回调格式

Str

ing
否

X

ML

XML：xml 格式 

JSON：json 格式

MqRegion
TDMQ 所

属园区

Str

ing
否 无

当回调类型为 TDMQ 时必填，支持园区详见 

TDMQ请求地域说明 文档

MqMode
TDMQ 使

用模式

Str

ing
否 无

当回调类型为 TDMQ 时必填。

Topic：主题订阅 

Queue：队列服务 

https://cloud.tencent.com/document/product/406/12667
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Container 类型  的具体数据描述如下：

MqName TDMQ 主
题名称

Str
ing

否 无 当回调类型为 TDMQ 时必填。

ExtFilter

节点名称

（关键字）
描述

类

型

是否

必选

默认

值
限制

State 开关
Str

ing
否 Off On/Off

Video
打开视频后缀限

制

Str

ing
否 false false/true

Audio
打开音频后缀限

制

Str

ing
否 false false/true

Image
打开图片后缀限

制

Str

ing
否 false false/true

ContentT

ype

打开 

ContentType 

限制

Str

ing
否 false false/true

Custom
打开自定义后缀

限制

Str

ing
否 false false/true

CustomE

xts
自定义后缀

Str

ing
否 无

多种文件后缀以/分隔，后缀个数
不超过10个

当 Custom 为 true 时，该参数

必填

AllFile 所有文件
Str

ing
否 false false/true

MediaWorkflow_Topology_Nodes_***_Operation_Output

节点名称（关

键字）
描述

类

型

是否

必选
限制

Region
存储桶的地

域

Stri

ng
是 无

Bucket
存储桶的名
称

Stri
ng

是 无

Object 结果文件名 Stri 是 当工作流节点类型为 Snapshot 或 
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称 ng SmartCover，且结果文件不止一个时，必须包

含 ${Number} $ 

当工作流节点类型为 Segment，设置了 

Duration，且 Format 不为 HLS 或 m3u8 

时，必须包含 ${Number} 

SpriteObje

ct

雪碧图的名

称

Stri

ng
否

当工作流节点类型为 Snapshot，且打开了雪碧图

时，该字段必填

AuObject
人声结果文

件名称

Stri

ng
否

当工作流节点类型为 VoiceSeparate，且有人声输

出时，该字段必填

MediaWorkflow_Topology_Nodes_Snapshot_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

TemplateId 截图模板 ID String 是 无

Output 输出地址 Container，详情请参见 Output 是 无

MediaWorkflow_Topology_Nodes_Animation_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

TemplateId
视频转动图模板 

ID
String 是 无

Output 输出地址 Container，详情请参见 Output 是 无

MediaWorkflow_Topology_Nodes_SmartCover_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

TemplateId 智能封面模板 ID String 否 无

SmartCover 智能封面参数
Container，详情请参见 

SmartCover
否 无

Output 输出地址 Container，详情请参见 Output 是 无

说明
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Container 类型 MediaWorkflow_Topology_Nodes_Transcode_***_Operation.Input 的具体数据描

述如下：

 TemplateId 和 SmartCover 都可以不设置，默认以原视频大小生成3张封面。如果同时设置 

TemplateId 和 SmartCover，TemplateId 优先生效。

MediaWorkflow_Topology_Nodes_Transcode_***_Operation

节点名称（关键

字）
描述 类型

是否

必选
限制

TemplateId
音视频转码模

板 ID
String 否 无

WatermarkTe

mplateId
水印模板 ID String 数组 否

可以使用多个水

印模板，不超过

3个

RemoveWate

rmark
去除水印参数

Container，详情请参见 

RemoveWatermark
否 无

DigitalWater

mark
数字水印参数

Container，详情请参见 

DigitalWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

Input 输入配置 Container 否 无

节点名称（关键字） 描述 类型 必选 限制

SpeedTranscodingQueueId 倍速转码队列 String 否 无

MediaWorkflow_Topology_Nodes_Concat_***_Operation

节点名称（关键字） 描述 类型
是否必

选

限

制

TemplateId 拼接模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_VoiceSeparate_***_Operation
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Container 类型 SDRtoHDR 的具体数据描述如下：

节点名称（关键字） 描述 类型 是否必

选

限

制

TemplateId 人声分离模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_VideoMontage_***_Operation

节点名称（关键

字）
描述 类型

是否必

选

限

制

TemplateId 精彩集锦模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SDRtoHDR_***_Operation

节点名称（关键字） 描述 类型
是否

必选
限制

SDRtoHDR
SDRtoHDR 配

置
Container 是 无

TranscodeTemplat

eId

音视频转码模板 

ID
String 是 无

WatermarkTemplat

eId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

Output 输出地址
Container，详情

请参见 Output
是 无

节点名称（关键字） 描述
类

型

是否

必选
限制

HdrMode
HDR 

标准

St

ri

n
g

是
HLG

HDR10 

MediaWorkflow_Topology_Nodes_VideoProcess_***_Operation
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Container 类型 SCF 的具体数据描述如下：

节点名称（关键字） 描述 类型
是否

必选
限制

TemplateId
视频增强
模板 ID

String 是 无

TranscodeTemplat

eId

音视频转

码模板 ID
String 是 无

WatermarkTemplat

eId

水印模板 

ID
String 数组 否

可以使用多个水印模

板，不超过3个

DigitalWatermark
数字水印
参数

Container，详情请参见 
DigitalWatermark

否 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SCF_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

SCF SCF 函数信息 Container 是 无

节点名称（关键字） 描述 类型 是否必选 限制

Region 函数地域 String 是 无

FunctionName 函数名称 String 是 无

Namespace 命名空间 String 否 无

Alias 函数别名 String 否 无

MediaWorkflow_Topology_Nodes_SuperResolution_***_Operati

on

节点名称（关键

字）
描述 类型

是否

必选
限制

TemplateId
超级分辨率

模板 ID
String 是 无

TranscodeTe 音视频转码 String 是 无
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Container 类型 FileInfo 的具体数据描述如下：

mplateId 模板 ID

WatermarkT

emplateId
水印模板 ID String 数组 否

可以使用多个水印模板，

不超过3个

DigitalWater

mark

数字水印参

数

Container，详情请参见 

DigitalWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_VideoEnhance_***_Operation

节点名称（关键

字）
描述 类型

是否

必选
限制

TemplateId
超级分辨率模

板 ID
String 是 无

WatermarkTem

plateId
水印模板 ID String 数组 否

可以使用多个水印模

板，不超过3个

DigitalWaterma

rk
数字水印参数

Container，详情请参

见 DigitalWatermark
否 无

Output 输出地址
Container，详情请参

见 Output
是 无

MediaWorkflow_Topology_FileInfo_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

FileInfo 文件信息节点参数 Container 是 无

节点名称（关键字） 描述 类型 是否必选 限制

AdvancedInformati

on
启用高级信息 String 否 false/true，默认为false

MediaWorkflow_Topology_Nodes_Segment_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

Segment 音视频转封装参数 Container 是 无
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Container 类型 Segment 的具体数据描述如下：

Output 输出地址
Container，详情请参见 

Output
是 无

节点名称（关键
字）

描述 类型
是否
必选

限制

Format 封装格式
Strin

g
是

aac、mp3、flac、mp4、ts、mkv、

avi、hls、m3u8

Duration
转封装时长,单

位:秒

Strin

g
否 不小于5的整数

HlsEncrypt hls 加密配置
Cont
ainer

否
只有当封装格式为 hls 时生效，详情请参见 
HlsEncrypt

MediaWorkflow_Topology_Nodes_PicProcess_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 图片处理模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_Tts_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 语音合成模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_SpeechRecognition_***_Oper

ation

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 语音识别模板 ID String 是 无

Output 输出地址
Container，详情请参见 

Output
是 无
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Container 类型 StreamPackConfig 的具体数据描述如下：

Container 类型 StreamPackInfo 的具体数据描述如下：

MediaWorkflow_Topology_Nodes_StreamPackConfig_***_Opera

tion

节点名称（关键字） 描述 类型 是否必选 限制

StreamPackConfig 打包配置 Container 否 无

节点名称（关键

字）
描述 类型

是否必

选
限制

PackType 打包类型。默认值：HLS
Stri

ng
否

HLS/DA

SH

IgnoreFailedStr

eam

忽略转码失败的子流，继续打包。默认值：

true

Stri

ng
否

true/fal

se

MediaWorkflow_Topology_Nodes_VideoStream_***_Operation

节点名称（关键字） 描述 类型
是否

必选
限制

TemplateId
音视频转码

模板 ID
String 否 无

WatermarkTemp

lateId

水印模板 

ID
String 数组 否

可以使用多个水印模

板，不超过3个

RemoveWaterm

ark

去除水印参

数

Container，详情请参见 

RemoveWatermark
否 无

Output 输出地址
Container，详情请参见 

Output
是 无

MediaWorkflow_Topology_Nodes_StreamPack_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

StreamPackInfo 打包规则 Container 否 无

节点名称（关键字） 描述 类型 是否必选 限制
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Container 类型 VideoStreamConfig 的具体数据描述如下：

Container 类型 SegmentVideoBody 的具体数据描述如下：

VideoStreamConfig 视频子流配置 Container 否 无

节点名称（关键

字）
描述 类型

是否

必选
限制

VideoStream
Name

视频子流名称
Stri
ng

是
必须和存在的视频
节点对应

BandWidth
视频子流带宽限制，单位b/s，范围[0, 

2000000000]，0表示不限制

Stri

ng
否

大于等于0，默认

值是0

MediaWorkflow_Topology_Nodes_Condition_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

Condition 条件配置,详情请参见 Condition
Containe

r
是 无

MediaWorkflow_Topology_Nodes_SegmentVideoBody_***_Oper

ation

节点名称（关键字） 描述 类型 是否必选 限制

SegmentVideoBo

dy
视频人像抠图配置 Container 否 无

Output 输出地址
Container，详情请参见 

Output  
是 无

节点名称（关键字） 描述 类型 是否必选

Mode 抠图模式，当前只支持 Mask (输出alpha通道结果)
Strin

g
否

MediaWorkflow_Topology_Nodes_NoiseReduction_***_Operatio

n

节点名称（关键字） 描述 类型 是否必选 限制

TemplateId 音频降噪模板 ID String 否 无



数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1945 共1950页

Container 类型 ImageInspect 的具体数据描述如下：

Output 输出地址 Container，详情请参见 

Output

是 无

MediaWorkflow_Topology_Nodes_ImageInspect_***_Operation

节点名称（关键字） 描述 类型 是否必选 限制

ImageInspect
异常图片检测处理

规则
Container 否 无

节点名称（关键
字）

描述 类型
是否
必选

限
制

AutoProcess

是否开启识别到图片异常后自动对图片进行如移动到其

他目录、设置为私有权限、删除等动作。取值：

true/false，默认为false

Stri

ng
否 无

ProcessType

指定检测到异常图片后的处理动作

BackupObject：将图片移动 

abnormal_images_backup下，该目录由后台
自动创建

SwitchObjectToPrivate：将图片权限设置为私

有

DeleteObject：删除图片

默认值：BackupObject

当 AutoProcess 为 true 时，该参数生效

Stri

ng
否 无

AudioMix

节点名称

（关键字）
描述 类型

必

选

默

认

值

限制

AudioSou

rce

需要被混音的音轨媒体地址, 

需要做 URLEncode
String 是 无

需与 Input 媒体文件存储于

同一 bucket

MixMode 混音模式 String 否

Re

pe

at

Repeat: 混音循环

Once: 混音一次播放

Replace
是否用混音音轨媒体替换

Input媒体文件的原音频
String 否

fal

se
true/false
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Container 类型 EffectConfig 的具体数据描述如下：

AudioMixArray是数组，每一个子项内容同 AudioMix  

EffectCon
fig

混音淡入淡出配置 Conta
iner

否 fal
se

无

节点名称（关键字） 描述 类型 必选 默认值 限制

EnableStartFadei

n
开启淡入

Strin

g
否 false true/false

StartFadeinTime 淡入时长
Strin

g
否 无 大于0, 支持浮点数

EnableEndFadeou

t
开启淡出

Strin

g
否 false true/false

EndFadeoutTime 淡出时长
Strin

g
否 无 大于0, 支持浮点数

EnableBgmFade 开启 bgm 转换淡入
Strin

g
否 false true/false

BgmFadeTime bgm 转换淡入时长
Strin

g
否 无 大于0, 支持浮点数

AudioMixArray

说明

仅第一个 Replace 生效

CallBackMqConfig

节点名称（关
键字）

描述 类型
是否必
选

MqRegion
消息队列所属园区，目前支持园区 sh（上海）、bj（北京）、

gz（广州）、cd（成都）、hk（中国香港）

Stri

ng
是

MqMode

消息队列使用模式，默认 Queue ：

主题订阅：Topic

队列服务: Queue

Stri

ng
是

MqName TDMQ 主题名称 Stri 是

https://cloud.tencent.com/document/product/460/78927#AudioMix
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ng

DigitalWatermark

节点名称

（关键
字）

描述 类型
是否

必选
限制

Messag

e
嵌入数字水印的水印信息

Strin

g
是

长度不超过64个字符，

仅支持中文、英文、数

字、_、-和*

Type 数字水印类型
Strin

g
是 当前仅可设置为 Text

Version 数字水印版本
Strin

g
是 当前仅可设置为 V1

IgnoreE

rror

当添加水印失败是否忽略错误继续执行

任务

Strin

g
是 限制为 true/false

State

添加水印是否成功，执行中为

Running，成功为 Success，失败为 

Failed

Strin

g
否

该字段不能主动设置，当

任务提交成功时，会返回

该字段

DashEncrypt

节点名称（关

键字）
描述

类

型

是否

必选

默

认

值

限制

IsEncrypt 是否开启 DASH 加密

St
ri

n

g

否
fal

se
true/false

UriKey DASH 加密的 key

St

ri

n

g

否 无
当 IsEncrypt 为 true 时，该

参数才有意义

HlsEncrypt

节点名称（关

键字）

描述 类

型

是否

必选

默

认

限制
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值

IsEncrypt 是否开启 HLS 加密

St
ri

n

g

否
fal

se
true/false

UriKey HLS 加密的 key

St

ri

n

g

否 无
当 IsEncrypt 为 true 时，该

参数才有意义

RemoveWatermark

节点名称

（关键字）
描述 类型

是

否

必

选

限制

Dx
距离左上角原点 x 
偏移

String 是
值范围：[0, 4096]

单位：px

Dy
距离左上角原点 y 

偏移
String 是

值范围：[0, 4096]

单位：px

Width 水印的宽度 String 是
值范围：(0, 4096]

单位：px

Height 水印的高度 String 是
值范围：(0, 4096]

单位：px

SmartCover

节点名称（关键

字）
描述

类

型

是否

必选
默认值 限制

Format
图片

格式

St

ri

n

g

否 jpg jpg、png  、webp

Width 宽 St

ri

n

g

否 视频原始

宽度

值范围：[128，4096]

单位：px

若只设置 Width 时，按照视频原始
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Express 表达式中的参数内容：

比例计算 Height

Height 高

St

ri

n

g

否
视频原始

高度

值范围：[128，4096]

单位：px

若只设置 Height 时，按照视频原始

比例计算 Width

Count
截图

数量

St
ri

n

g

否 3 [1,10]

DeleteDuplic

ates

封面

去重

St

ri

n

g

否 false true/false

Condition

节点名称（关键字） 描述 类型 是否必选 限制

Express 表达式详情
Strin

g
是 详情请参见 jsonLogic

Express

参数 描述 是否必选 限制

Duration 音视频时长 否 无

Height 音视频高 否 无

Width 音视频宽 否 无

Dar 音视频宽高比 否 无

ImageHeight 图片高 否 无

ImageWidth 图片音视频宽 否 无

ImageDar 图片宽高比 否 无

Size 文件大小 否 无

https://jsonlogic.com/


数据万象

版权所有：腾讯云计算（北京）有限责任公司 第1950 共1950页

Container 节点 MediaResult 的内容：

Container 节点 OutputFile 的内容：

Container 节点 Md5Info 的内容：

MediaResult

节点名称（关键字） 描述 类型

OutputFile 输出文件的基本信息 Container

节点名称（关键字） 描述 类型

Bucket 输出文件所在的存储桶 String

Region 输出文件所在的存储桶所在的园区 String

ObjectName 输出文件名，可能有多个 String 数组

Md5Info 输出文件的 MD5 信息 Container 数组

节点名称（关键字） 描述 类型

ObjectName 输出文件名 String

Md5 输出文件的 MD5 值 String


